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यह लाइसेंस तर्ी तक क्रकसी व्यजतत को व्यावसाययक उद्देश्यों के ललए र्ी आपके कायभ में 
लमश्रण, थोडा बदलने व यनमाभण करने क्रक आज्ञा देता है, जब तक क्रक व ेआपको शे्रय देते हैं 
और समान शतों के तहत अपनी नई रचनाओं का लाइसेंस देते हैं। इस लाइसेंस की तुलना 
अतसर " कॉपीराइट" फ्री और ओपन-सोसभ सॉफ्टवेयर लाइसेंस स ेकी जाती है। आपके कायभ 
के आधार पर यनलमभत सर्ी नए कायों का एक ही लाइसेंस होगा, इसललए यह क्रकसी र्ी 
व्युत्पन्न कायभ के व्यावसाययक उपयोग की र्ी अनुमयत देगा। यह ववक्रकपीडडया द्वारा उपयोग 
क्रकया जाने वाला लाइसेंस है और उन सामग्रियों के ललए अनुशंलसत है जो ववक्रकपीडडया और 
इसी तरह के लाइसेंस प्राप्त पररयोजनाओं से ली गई हैं।  
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निष्कर्ष 

इस मॉड्यलू के अंत में, आप निम्न में सक्षम होंगे:

1.	 मीडिया एंड एंटरटेनमेंट क्षेत्र की महत्ता के बारे  में जानने में।

2.	र ोटो आर्टिस्ट की भमूिका तथा दायित्वों की पहचान करें ।

3.	 एनिमेशन/Rotoscoping से जुड़े  तकनीकी शब्दों की व्याख्या करें ।
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यूनिट के उद्देश्य  

यूनिट 1.1: मीडिया एंड एंटरटनेमेंट क्षेत्र से परिचय 

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 मीडिया एंड एंटरटेनमेंट क्षेत्र की महत्ता के बारे  में जानने में।

2.	र ोटो आर्टिस्ट की भमूिका तथा दायित्वों की पहचान करें ।

भारतीय मीडिया एंड एंटरटेनमेंट (M&E) क्षेत्र, विश्व का 14वां सबसे बड़ा मीडिया एंड एंटरटेनमेंट 

क्षेत्र ह ैऔर यह भारत की GDP में लगभग 1.7% का योगदान देता ह।ै देश के कुल रोज़गार में इस 

क्षेत्र का योगदान लगभग ~9.3 प्रतिशत ह ैऔर उम्मीद की जा रही ह ैकि यह योगदान वर्ष  2017 तक 

लगभग ~14 प्रतिशत पर पहँुच जाएगा।

एक आकलन के अनुसार, भारतीय मीडिया एंड एंटरटेनमेंट बाज़ार में 13.9% के CAGR (चक्रवदृ्धि 

वार्षिक वदृ्धि दर) से वदृ्धि होने की उम्मीद ह ैऔर यह वर्ष  2014 में रु. 1026 अरब के स्तर से उठ कर 

वर्ष  2019 में रु. 1964 अरब के स्तर पर पहँुच जाएगा। यह वदृ्धि दर वशै्विक मीडिया एंड एंटरटेनमेंट 

उद्योग की वदृ्धि दर से लगभग दोगुनी ह।ै

1.1.1 भारत में मीडिया एंड एंटरटनेमेंट क्षेत्र

1.1.2 मीडिया एंड एंटरटनेमेंट क्षेत्र में रोज़गार-योग्यता 

वर्ष 2014 के दौरान, डिजिटल एडवर्टाइजि़ंग में वर्ष  2013 के मुकाबले 44.5 प्रतिशत की वदृ्धि देखी गई। इस प्रकार डिजिटल मीडिया की लोकप्रियता में 

उछाल लगातार बना रहा। वर्ष  2014 में विज्ञापनों से होने वाली आय में वर्ष  2013 के स्तर से 14.2% की वदृ्धि हुई ह ैऔर यह रु. 414 अरब के स्तर पर पहँुच 

गई ह।ै इसमें प्रिंट (43%) और टेलीविज़न (37%) का हिस्सा सबसे अधिक रहा ह।ै

हमारे  देश में दुनिया के सबसे बड़े प्रसारण उद्योगों में से एक ह ैजिसमें लगभग 800 उपग्रह टेलीविज़न चनैल, 242 FM चनैल और 100 से भी अधिक सक्रिय 

सामुदायिक रेडिय ो नेटवर्क  हैं। भारतीय फिल्म उद्योग, वशै्विक स्तर पर फिल्मों का सबसे बड़ा निर्माता ह।ै यहाँ फिल्म निर्माण के कार्य  में 400 निर्माण एवं 

कॉर्पोरे ट घराने संलग्न हैं।

भारत सरकार ने विभिन्न पहल करके मीडिया एंड एंटरटेनमेंट उद्योग की वदृ्धि में सहयोग दिया ह,ै जसेै अधिक संस्थागत वित्तपोषण आकर्षित करने के 

लिए केबल वितरण क्षेत्र का डिजिटलीकरण करना, केबल और DTH सेटेलाइट प्लेटफॉर्म  में FDI की सीमा को 74 प्रतिशत से बढ़ाकर 100 प्रतिशत करना, 

और संस्थागत वित्त तक सरल पहँुच हेतु फिल्म उद्योग को उद्योग का दर्जा  देना।

उद्योग मुख्यतः विज्ञापन से होने वाली आय पर निर्भर करता ह ैऔर इस उद्योग का प्रदर्शन मुख्यतः अर्थव्यवस्था के समग्र परिदृश्य पर निर्भर करता ह।ै 

वर्तमान में, वर्ष  2013 के आंकड़ों के अनुसार, उद्योग में 4 लाख लोगों को रोज़गार मिला हुआ ह ैजिसकी वर्ष  2022 तक 13 लाख तक पहंुच जाने की उम्मीद 

ह,ै यानि 2013-22 की अवधि में इससे रोज़गार के 9 लाख अतिरिक्त अवसर पदैा होंगे।

•	 परूे  भारत में, M&E क्षेत्र में कार्य  करने वाले कुल लोगों में से लगभग 25 प्रतिशत फिल्म क्षेत्र में कार्य  करते हैं। 

चित्र 1.1.1: TV उद्योग के लिए विज्ञापन से होने वाली आय
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•	 एक आकलन के अनुसार मीडिया एंड एंटरटेनमेंट क्षेत्र में कुल वर्तमान रोज़गार लगभग 

~4.6 लाख ह ैऔर इसमें 13 प्रतिशत की CAGR से वदृ्धि होकर, वर्ष  2017 में यह आँकड़ा 

7.5 लाख तक पहँुचने की उम्मीद की जा रही ह।ै

•	भ ारतीय मीडिया एंड एंटरटेनमेंट क्षेत्र से 14.2 प्रतिशत की CAGR से वदृ्धि करके वर्ष 

2018 तक रु. 1,786 अरब तक पहँुच जाने की उम्मीद की जा रही ह ैऔर इसके प्रत्येक 

उप-क्षेत्र में कुशल पेशेवरों की भारी मांग ह।ै 

•	फि ल्म और टेलीविज़न क्षेत्र में कार्यबल के बड़े अंश को रोज़गार मिलता ह।ै फिल्म और 

टेलीविज़न, दोनों ही क्षेत्रों में डिजिटलीकरण गतिविधियों से और विभिन्न शलैियों के 

चनैल आरंभ होने से इस मांग को उछाल मिलता ह।ै

उप-क्षेत्र रोज़गार (लाख में)

2013 2017 2022

टेलीविज़न 0.14 0.28 0.64

प्रिंट 0.06 0.07 0.13

रेडिय ो 0.02 0.03 0.04

एनिमेशन, VFX और गेमिग 0.02 0.03 0.04

फिल्में 0.16 0.24 0.44

संपरू्ण  क्षेत्र 0.4 0.65 1.3

1.1.3 मीडिया एंड एंटरटनेमेंट क्षेत्र का विकास
•	भ ारत में रेडिय ो प्रसारण की शुरूआत ब्रिटिश भारत में वर्ष  1923 में रेडिय ो क्लब ऑफ बॉम्बे के साथ हुई थी

•	 ऑल इंडिया रेडिय ो (AIR) की स्थापना वर्ष  1936 में हुई थी जो विश्व के सबसे बड़े नेटवर्कों में से एक है

•	भ ारत में टेलीविज़न का आगमन 15 सितंबर, 1959 को दूरदर्शन (DD) के रूप में हुआ था

•	 वर्ष  1990 तक भारतीय अर्थव्यवस्था एक बंद अर्थव्यवस्था थी, और इसमें किसी निजी खिलाड़ी को प्रवेश करने की अनुमति नहीं थी। 1990 के दशक 

में भारतीय फिल्म उद्योग परूी तरह खंडित अवस्था में था

•	 BBC ने अपनी राष्ट्रीय सेवा वर्ष  1995 में आरंभ की

•	 वर्ष  1999 में सरकार ने परू्णतः स्वामित्वाधीन भारतीय कंपनियों को लाइसेंस शुल्क आधार पर निजी FM स्टेशन स्थापित करने की अनुमति देने का 

निर्णय लिया

•	 मई 2000 में, रेडिय ो प्रसारण लाइसेंसिग के प्रथम चरण के भाग के रूप में नीलामी की गई और 37 लाइसेंस जारी किए गए, जिनमें से 21 लाइसेंस 14 

शहरों में प्रचालनरत हैं।

चित्र 1.1.2: वर्ष 2013 में मीडिया एंड एंटरटेनमेंट क्षेत्र में रोज़गार

चित्र 1.1.3: मीडिया एंड एंटरटेनमेंट क्षेत्र के विभिन्न उप-क्षेत्रों में रोज़गार
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1.1.4 प्रमुख उपक्षेत्र एवं खंड

•	भ ारतीय मीडिया एंड एंटरटेनमेंट (M&E) उद्योग कई उप-क्षेत्रों से मिलकर बना ह,ै जसेै टेलीविज़न, रेडिय ो, प्रिंट मीडिया (जिसमें समाचार-पत्र एवं 

पत्रिकाएं शामिल हैं), फिल्में, संगीत तथा एनिमेशन एवं विज़ुअल इफैक्ट्स  (VFX)।

•	य ह उद्योग मुख्यतः विज्ञापन से होने वाली आय पर निर्भर करता ह ैऔर इस क्षेत्र की वदृ्धि एवं प्रदर्शन संपरू्ण  अर्थव्यवस्था के उत्थान में एक 

महत्वपरू्ण  भमूिका निभाते हैं।

•	य ह उद्योग निर्यात-अभिमुख नहीं ह,ै और इसका अधिकांश उत्पादन घरे ल ूबाज़ार में उपभुक्त होता ह।ै हालांकि, आयात इस उद्योग का उल्लेखनीय 

भाग हैं जिनमें अखबारी कागज, सेट-टॉप बॉक्स एवं एंटीना शामिल हैं।

•	य ह उद्योग सांस्कृति क एवं पारम्परिक पषृ्ठभमूियों में सीमित ह ैऔर किसी जनखंड विशेष के लिए निर्माण करने वाले विशिष्ट कें द्रों के इर्द -गिर्द 

संगठित ह।ै उदाहरण के लिए, मंुबई फिल्म उद्योग (बॉलीवुड), देश का एक मुख्य फिल्म कें द्र ह।ै ऐसा ही एक कें द्र दक्षिण भारत में भी ह।ै

चित्र 1.1.4: मीडिया एंड एंटरटेनमेंट क्षेत्र

चित्र 1.1.5: वर्ष 2013 में मीडिया एंड एंटरटेनमेंट क्षेत्र की वृद्धि दरें
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1.1.5 एक रोटो आर्टिस्ट की भूमिका  
एक रोटो आर्टिस्ट उन लाइव एक्शन फ्रे मों की ट्रेसिग/अनुरे खण करता ह,ै जहां कम्प्यूटर ग्राफिक्स लाइव इमेज के साथ ओवरलपै/इंटरैक्ट करें गे। रोटो 

आर्टिस्ट फ्रे म के भीतर स्पष्ट क्षेत्र (मट्ैस) भी तयैार करता ह,ै जिससे कम्पोज़ीटर सीन/दृश्य के सभी एलीमेंट्स/तत्वों को प्रभावकारी ढंग से लेयर/

व्यवस्थित कर सके। मीडिया एवं एंटरटेन्मेंट उद्योग में रोटो आर्टिस्ट को Rotoscopy आर्टिस्ट/पेंट आर्टिस्ट भी कहते हैं।

जॉब का संक्षिप्त वर्णन

यह काम करने वाले व्यक्ति को कंटेंट को अलग-अलग फ्रे म्स/एलीमेंट्स में तोड़ना होता ह ैऔर ज़रूरत के हिसाब से कंटेंट में कांट-छांट करनी होती ह/ै

कंटेंट री-क्रिएट करना होता ह।ै

व्यक्तिगत गुण

इस काम के लिए व्यक्ति को फिल्म-निर्माण के मूल-तत्वों तथा सिद्धांतों की अच्छी समझ होनी चाहिए। व्यक्ति डेप्थ के मूल-तत्वों से अवगत होना चाहिए 

और उसमें अच्छा ड्रॉइंग तथा इलस्ट्रेशन कौशल होना चाहिए। उसे Nuke, After Effects, Silhouette इत्यादि सहित rotoscopy सॉफ्टवेयर की अच्छी काम-

काज़ी जानकारी होनी चाहिए।

पहली आवश्यकता 

•	 उनके पास कम्प्यूटर और ऑपरेटि ग सिस्टम का कार्यकारी ज्ञान होना चाहिए।

•	 माउस, मानक मेन्यूज़ और कमांड्स का उपयोग कैसे करें , साथ ही फाइलें कैसे खोलें, बंद करें  और सेव करें ।

इस प्रशिक्षण कार्यक्रम में आप:

•	 आवश्यकताओ ंको समझना और कार्य-प्रवाह/वर्क फ्लो की योजना बनाना

•	 उपकरणों और सामग्रियों का प्रबंधन करना

•	 Rotoscoping फुटेज

•	 कार्यस्थल में स्वास्थ्य एवं सुरक्षा बनाये रखना

उस पेशे में प्रशिक्षित व्यक्ति के लिए निम्न प्रकार की जॉब्स /नौकरियाँ उपलब्ध होती ह:ै 

•	 एनिमेशन निर्देशक

•	 एनिमेटर

•	 कला निर्देशक

•	 बकैग्राउंड पेंटर

•	 कार्टूनि  स्ट

•	 कैरेक्टर  एनिमेटर

•	 कैरेक्टर  रिगर

•	 कलर-की आर्टिस्ट

•	 कम्पोज़िटिग आर्टिस्ट‍

•	 कॉन्सेप्ट आर्टिस्ट‍ 

•	डिजि टल पेंटर

•	निर् देशक

•	 इफैक्ट्स  एनिमेटर

•	फि ल्मे एवं वीडियो संपादक/एडिटर

•	 फ्लैश एनिमेटर
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•	 फोरें सिक एनिमेटर

•	ग्राफिक्स  डिज़ाइनर

•	 इन बिटवीनर

•	 स्वतंत्र फिल्म–निर्माता

•	 की एनिमेटर

•	 प्रकाश/लाइटिग तकनीशियन

•	 मथेैमेटिकल मॉडलर

•	र ें डर रैं ग्लर

•	 Stop Motion एनिमेटर

•	र ोटो आर्टिस्ट

•	 स्टोरी बोर्ड  आर्टिस्ट

•	 स्टोरी बोर्ड  सहायक

•	 टेक्सचर आर्टिस्ट

•	 वीडियो गेम डिज़ाइनर

•	 विजुअल डेवलपमेंट आर्टिस्ट

अभ्यास 
1.	भ ारतीय मीडिया एंड एंटरटेनमेंट (M&E) क्षेत्र विश्व में .........सबसे बड़ा है

a)	 14वां

b)	 15वां 

c)	 16वां 

d)	 इनमें से कोई नहीं

2.	 वर्ष  2013 में मीडिया एंड एंटरटेनमेंट क्षेत्र में लोग (मिलियन/दस लाख में) कार्यरत थे:

a)	 0.3

b)	 0.4

c)	 0.5

d)	 इनमें से कोई नहीं

3.	नि म्न में से कौन-सा मीडिया एंड एंटरटेनमेंट क्षेत्र का हिस्सा नहीं ह:ै

a)	प्रिं ट

b)	 टेलीविज़न

c)	रेडिय  ो

d)	र ोबोटिक्स
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यूनिट 1.2: मुख्य शब्द

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 एनिमेशन से जुड़े तकनीकी शब्दों की व्याख्या करें

1.2.2 पुस्तक में प्रयुक्त सामान्य मुख्य शब्द

•	 एनीमटैिक: एनीमटैिक, एनिमेशन का स्टोरी बोर्ड  होता ह ैजिसमें संवादों और ध्वनियों के साथ संपादित चित्रों की एक श ्रृंखला होती ह।ै

•	क म्पोज़िटिंग: चित्रों/घटकों की विभिन्न पर्तों को एक अकेले फ्रे म में संयुक्त करने की प्रक्रिया को कम्पोज़िटिग कहा जाता ह।ै

•	 कम्पोज़ीशन: पषृ्ठभमूि और कैमरा के सापेक्ष चरित्र की स्थिति निर्धा रित करने को कम्पोज़ीशन कहते हैं।

•	क्रि एटिव ब्रीफ: क्रिएटिव ब्रीफ एक दस्तावेज़ होता ह ैजिसमें ऐसे मुख्य प्रश्न होते हैं जो निर्माण के लिए एक गाइड का कार्य  करते हैं, इनमें विज़न, 

प्रोजेक्ट का उद्देश्य, लक्ष्य दर्शकगण, समय-सीमाएं, बजट, मुख्य पड़ाव, हितधारक आदि शामिल होते हैं।

•	 की फ्रे म: की फ्रे म मुख्य मुद्राएं होते हैं, आमतौर पर ये किसी एनिमेशन सीक्वेंस की आरंभिक और अंत मुद्राएं होती हैं।

•	 मॉडलिंग: एक विशेष सॉफ्टवेयर एप्लिकेशन का उपयोग करके एनिमेशन के लिए त्रिआयामी मॉडल बनाने की प्रक्रिया को मॉडलिग कहा जाता ह।ै

•	 रेन्डरिंग: त्रिआयामी मॉडलों को 3D प्रभावों के साथ द्विआयामी चित्रों में बदलने की प्रक्रिया को रे न्डरिंग कहते हैं।

•	 रिगिग: किसी मुद्रा विशेष में प्रस्तुत करने के दौरान गति करने में सहायता देने के लिए किसी स्थिर त्रिआयामी मॉडल में जोड़ डालने की प्रक्रिया 

को रिगिग कहा जाता ह।ै

•	 2D एनिमेशन: द्विआयामी परिवेश, जसेै कम्प्यूटरीकृत एनिमेशन सॉफ्टवेयर में गतिमान चित्रों का निर्माण।

•	 3D एनिमेशन: इस एनिमेशन में गहराई होने का एहसास होता ह।ै यह देखने में अधिक यथार्थवादी या सजीव लगता ह।ै हालो और मेडेन (Halo and 

Madden) फुटबॉल जसेै वीडियो गेम्स इसके उदाहरण हैं।

•	 एनिमेशन:  स्थिर चित्रों की एक श ्रृंखला को तेज़ी से प्रदर्शित करने के द्वारा गति को सिमुलेट करना या गति की अनुभतूि कराना।

•	 एंटीसिपेशन: एक एनिमेटर एक्शन कार्र वाई की तयैारी के माध्यम से एंटीसिपेशन (परू्वानुमान) पदैा करता ह।ै

•	 आस्पेक्ट रेशियो: टीवी चित्र की चौड़ाई का ऊंचाई से अनुपात।

•	 बकैग्राउंड पेंटिंग: किसी एनिमेशन की पषृ्ठभमूि के लिए प्रयुक्त पेंटिग।

•	 CGI (Computer Generated Imagery): डिजिटल सॉफ्टवेयर सिस्टम का उपयोग करके फ्रे म में आकृति, सेटिग या अन्य सामग्री बनाना।

•	 क्लीन-अप: इसका अर्थ 2D एनिमेशन के रफ आर्टवर्क  के परिशोधन की प्रक्रिया से ह।ै

•	 कम्प्यूटर एनिमेशन: कम्प्यूटर पर एनिमेशन बनाना। 3D या 2D हो सकता ह।ै एनिमेशन की प्रक्रिया में चरण जोड़ता ह।ै

•	 फ्रे म: फिल्में या एनिमेशन बनाने में प्रयोग होने वाली फिल्म की पट्टी पर स्थिर पारदर्शी फोटोग्राफ की एक श ्रृंखला।

•	 फ्रे म रेट: किसी एनिमेशन में फ्रे म्स के आगे बढ़ने की चाल। आमतौर पर इसे फ्रे म्स पर सेकंड (fps) में मापा जाता ह।ै

यूनिट के उद्देश्य  
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•	 ग्राफिक्स टबैलटे: इस पर आप स्केच  और ड्रॉइंग बना सकते हैं जिसे मॉनिटर पर दिखाया जाता ह।ै

•	 Pixel: (कम्प्यूटर विज्ञान) CRT स्क्रीन पर किसी छवि या चित्र का सबसे छोटा, पथृक घटक (आमतौर पर एक रंगीन बिदु)।

•	 Raster: pixels से बनी क्षैतिज रे खाओ ंके समूह से निर्मित रचना जिसका उपयोग CRT पर चित्र बनाने के लिए किया जाता ह।ै

•	 Rotoscoping: जब मनै्युअली या कम्प्यूटर ऑटोमेशन द्वारा किसी दृश्य की पषृ्ठभमूि में एक बार में एक फ्रे म के हिसाब से कोई वीडियो या फिल्म के 

चित्र रखे जाते हैं।

•	 टाइटल कार्ड्स: शुरूआती फिल्मों, जिनमें आवाज़ नहीं होती थी, में स्क्रीन पर दिखने वाले शब्द। इससे लोगों को कथानक समझने में आसानी  

होती थी।

•	 Tween: मुख्य फ्रे म्स के बीच होने वाली एनिमेशन की प्रक्रिया।

•	 Vector: इस शब्द का अर्थ एनिमेशन के उस प्रकार से ह ैजिसमें कला या गति का नियत्रण pixels की बजाए वेक्टरों द्वारा होता ह।ै Vector एनिमेशन 

से अक्सर अधिक स्पष्ट और निर्बाध एनिमेशन बनता ह,ै क्योंकि छवियों का प्रदर्शन और/या उनका आकार बदलने का कार्य  भंडारित pixel मानों की 

बजाए गणितीय मानों का उपयोग करके किया जाता ह।ै

•	 CEL: CEL एक प्लास्टिक शीट होती ह ैजो cellulose acetate या cellulose nitrate की बनी होती ह।ै इस पर एनीमेटेड कैरेक्टर  प्रिंट किए जाते हैं। 

व्यवहार में, CEL का अर्थ प्लास्टिक शीट और कैरेक्टर , वस्तु और/या स्पेशल इफेक्ट्स   के आउटलाइन और कलरिंग, इन सभी के संयोजन से लिया 

जाने लगा ह।ै आउटलाइन या तो हाथ से बनाई गई हो सकती ह ैया फिर ज़ेरोग्राफिक विधि से प्लास्टिक शीट पर ट्रांसफर की गई हो सकती ह।ै सेल 

को परू्ण  करने के लिए उन आउटलाइंस को फिर, हैंड-पेंटिग या सेरिग्राफिक प्रक्रिया द्वारा, रंग से भरा जाता ह।ै

•	 Rotoscoping: यह वह एनिमेशन प्रक्रिया ह,ै जिसका प्रयोग किसी रोटो आर्टिस्ट या एनिमेटर द्वारा किसी मोशन पिक्चर फुटेज को फ्रे म-दर-फ्रे म ट्रेस 

करने के लिए तब किया जाता ह,ै जब बिल्कु ल असली/वास्तविक/सजीव एक्शन की आवश्यकता हो।

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________

टिप्पणियां 
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2. आवश्यकता को समझना

यनूिट 2.1- एनिमेशन का आधार तथा सिद्धांत

यनूिट 2.2- लाइफ ड्रॉइंग्स: मानव शरीर रचना विज्ञान का आधारभतू सिद्धांत

यनूिट 2.3 परू्व -निर्माण कार्य

MES/N 3501
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इस मॉड्यलू के अंत में, आप निम्न में सक्षम होंगे:

1.	 अंत-उत्पाद के उन विभिन्न मापदंडों से अवगत होना, जो निर्माण/प्रोडक्शन आवश्यकताओ ंको प्रभावित करते हैं (उदाहण के लिए: अवधि, शलैी, पात्रों 

की संख्या, विषय तथा कथानक, वह संस्कृति  तथा ज़माना/कालावधि जिस पर कहानी आधारित ह,ै अपेक्षित इफैक्ट्स , फॉर्मेट, संगीत इत्यादि)।

2.	 आउटपुट, जिसका निर्माण किया जाना ह,ै के ट्रीटमेंट तथा फाइनल आउटपुट के वॉल्यूम की व्याख्या करना।

3.	 शॉट सीक्वेंस (हाइ-लेवल/उच्च-स्तरीय) तथा अपेक्षित निरन्तरता/सामंजस्यता की व्याख्या करना।

4.	 आउटपुट की मांग पर आधारित सटीक एनिमेशन तकनीक का चयन। इसमें शामिल ह:ै 2D एनिमेशन, 3D एनिमेशन।

निष्कर्ष 
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यूनिट 2.1: एनिमेशन का आधार एवं सिद्धांत

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 एनिमेशन के सिद्धांतों से अवगत होना।

2.1.1 एनिमेशन के मौलिक सिद्धांत
एनिमेशन एक समयातंराल में वस्तु/पात्र की हरकतों में आने वाले बदलाव का चित्रण ह।ै एनिमेशन मंच पर किसी बक्से को इधर से उधर, एक फ्रे म से 

अगले फ्रे म पर ले जाने जसैा सरल हो सकता ह।ै यह बहुत ज़्यादा जटिल भी हो सकता ह।ै 

सब कुछ किसी न किसी तरीके से गति करता ह,ै तेज़ी से मंडराते जुगन ूसे लेकर अनादिकाल से खड़े जीर्ण  पर्वतों तक, जो अपने अस्तित्व के घटनाक्रम 

में सरकते, चरमतराते और अपना रास्ता बनाते रहे हैं।  गति सब चीज़ो को जोड़ती ह ैऔर गति सब चीज़ों को परिभाषित करती ह।ै खासतौर से इंसान, इसी 

बात से परिभाषित किए जाते हैं, कि गति के ज़रिए वे किस तरह स्वय को अभिव्यक्त करते हैं।   घबराए हुए से लेकर आक्रामक तक, दब्बू से लेकर अहंकारी 

तक, तंदरुस्त से लेकर रोगी तक सभी तरह के मानव स्वभाव मनुष्य की मुद्राओ ं(पोज़) तथा क्रिया-कलापों (एक्शंस) द्वारा स्वय को प्रस्तुत करने के 

तरीके से ही अभिव्यक्त होते हैं।  एनिमेटर के लिए यह कहावत बिल्कु ल उपयुक्त ह ै‘‘एक्शन स्पीक लाउडर दनै वर्ड्स (करनी कथनी से बलवान होती ह)ै’’। 

हालांकि, सभी एक्शंस व्यक्तियों के अपने-अपने होते हैं/ हालांकि भिन्न-भिन्न व्यक्त्यिों के एक्शंस भी भिन्न-भिन्न हो सकते हैं, किन्तु मूवमेंट/गति की 

वास्तविक प्रक्रिया विशिष्ट नियमों तथा सिद्धांतों से परिभाषित ह,ै जो अपरिवर्तनीय/अडिग व सार्वभौमिक हैं। मूवमेंट/गति के यही सिद्धांत वह बुनियाद हैं, 

जिन पर एनिमेशन आधारित ह/ैटिकी हुई ह,ै यह मूवमेंट चाहे हाथ से ड्रॉ की गई हो, मिट्टी में ढाली गई हो या कम्प्यूटर से जेनरे ट की गई हो। एनीमेटिड 

एक्शन का निर्माण विभिन्न मुद्राओ ंकी एक श्रृंखला के तेज़ और निरन्तर प्रस्तुतीकरण से गति का भ्रम पदैा करके किया जाता ह।ै  एनिमेशन का असली 

राज़ हर मूमेंट/क्षण को इस तरह से पोज़ीशन करने/रखने में छिपा ह,ै कि देखने वालों को यह भ्रम वास्तविक, प्रभावपरू्ण  और विश्वास करने योग्य/मुमकिन 

पात्रों से सराबोर लगे। यह सच में इतना ही सरल ह,ै और सच में इतना ही कठिन!

इन कई वर्षों के दौरान एनिमेशन ने स्वय भी अपने कई सिद्धांत परिभाषित कर लिए हैं। यद्यपि इनमें से अधिकांश सिद्धांत एनिमेशन के परम्परागत 2D 

जगत से उपजे हैं, मूवमेंट की अधिकांश परिभाषायें, शब्दावलियां तथा सिद्धांत एनिमेशन की सभी शाखाओ ंपर लाग ू किए जा सकते हैं। 2D तथा 3D 

एनिमेशन के विभागों में इनमें से कई सिद्धांतों पर अधिक विशिष्ट रूप से चर्चा  की जाएगी, लेकिन यहां इन दोनों के तत्वों तथा घटकों पर एक समीक्षा की 

जाएगी। ये सिद्धांत हैं: 

1.	 स्क्वैश एंड स्ट्रेच 

2.	 एंटीसिपेशन 

3.	 स्टेजिग 

4.	स् ट्रेट अहेड एक्शन तथा पोज़-टु-पोज़ एक्शन करना 

5.	 फॉलो-थ्रू और ओवरलपैिग एक्शन 

6.	 ईज़ इन एंड आउट (या स्लो इन एंड आउट) 

7.	 आर्क्स 

8.	 सेकें डरी एक्शन 

9.	 टाइमिग 

10.	 अतिशयोक्ति 

11.	 सॉलिड ड्रॉइंग्स

12.	 अपील/आकर्षण  

यूनिट के उद्देश्य  
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स्क्वैश एंड स्ट्रेच

यह एक्शन कैरेक्टर  के मूव करने पर, उसमें वेट/वज़न तथा वॉल्यूम/विस्तार होने का भ्रम कराता ह।ै संवाद एनीमटैिक करने तथा भाव-भंगिमाएं रचने में 

भी स्क्वैश एंड स्ट्रेच उपयोगी होता ह।ै स्क्वैश एंड स्ट्रेच किस हद तक उपयोग किया जायेगा, यह इस बात पर निर्भर करता ह,ै कि एनिमेटिग दृश्य की मांग 

क्या ह।ै आमतौर पर यह पिक्चर की शॉर्ट  स्टाइल/लघु शलैी में व्यापक होता ह ैऔर किसी 

फीचर में अपेक्षाकृत सौम्य/सकू्ष्म। किसी बॉल के उछलने/बाउंस होने से लेकर किसी चलते 

हुए व्यक्ति के शरीर के वज़न तक, यह कैरेक्टर  एनिमेशन की हर फॉर्म  में प्रयोग होता ह।ै यह 

काफी महत्वपरू्ण  अवयव ह,ै जिसमें आपको दक्षता हासिल करनी होगी और यह अक्सर 

प्रयोग होगा। 

•	 उदाहरण के लिए – बॉल का उछलने (टकरा कर) के दौरान सपाट हो जाना।

•	भ ाव-भंगिमा – मुस्कुर ाने के दौरान गाल भींचना/पिचकाना
चित्र 2.1.1: स्क्वै श एंड स्ट्रेच

चित्र 2.1.2: एंटीसिपेशन/पूर्वानुमान के उदाहरण

कीज़:

•	 वॉल्यूम कांस्टेंट

•	 विभिन्न वस्तुएं भिन्न-भिन्न प्रतिक्रिया देती हैं

•	 विकृत करने की ज़रूरत नहीं

•	 फास्ट एक्शन से झिलमिलाहट को हटाने के लिए स्ट्रेचिग का उपयोग करें

पद्धति:

•	 वॉल्यूम को संरक्षित रखने के लिए स्के ल का उपयोग कर सकते हैं (एक डायमेंशन में ‘अप’ और दूसरी में ‘डाउन’)

एंटीसिपेशन

यदि कोई एक्शन अपनी मूवमेंट्स तथा पोज़िज़ में ऊर्जा  से भरपरू ह,ै तो एंटिसिपेशन प्रक्रिया महत्वपरू्ण  हो जाती ह।ै एंटीसिपेशन का नियम कहता ह,ै कि 

यदि किसी वस्तु को आगे की ओर जाना ह ैतो इसे पहले थोड़ा पीछे  जाना होगा। या दाई ंओर मूव करने से पहले, इसे थोड़ा बार्इं  ओर मूव करके इसे एंटिसिपेट 

करना चाहिये। इसी तरह, यदि किसी कैरेक्टर  को ऊपर की ओर उछलना ह,ै तो इसे पहले थोड़ा नीचे की ओर झुकना होगा। 

जसेै कोई कैरेक्टर  यदि किसी रस्सी से नीचे लटकता ह,ै तो नीचे की ओर इस बड़े एक्शन की प्रत्याशा में वह पहले इसे थोड़ा ऊपर उठाता ह।ै

एंटीसिपेशन हमेशा प्रमुख एक्शन को एक महत्वपरू्ण  विषमता प्रदान करता ह।ै यह दर्शकों को ऐसा विश्वास दिलाकर, उनसे ठिठोली करता ह,ै कि कोई 

वस्तु‍ या किरदार उस दिशा में मूव कर रहे हैं/जा रहे हैं, जबकि वे अन्तत: विपरीत दिशा में जा रहे होते हैं। इस तरकीब से मूवमेंट की असल दिशा में और भी 

रोमांच आ जाता ह।ै

एंटीसिपेशन की टाइमिग भी महत्वपरू्ण  ह।ै सर्वोत्तम एंटीसिपेशन कभी-कभी आश्चर्यजनक रूप से बहुत तेज़ी से हो जाती ह,ै लेकिन कभी-कभी उतनी ही 

धीरे । कई बार आपने देखा ह,ै कि कोई कार्टू न कैरेक्टर , यों ही अनमने ढंग से बेहद धीरे -धीरे  चलता ह,ै फिर अचानक ही तेज़ी से स्क्रीन के दूसरी तरफ 

पहंुच जाता ह?ै यहां तक कि, कभी-कभी हमें वह दौड़ता हुआ भी नहीं दिखाई देता, बस धंुधलापन या स्पीड लाइंस, या धलू का एक बादल, जो पीछे  उठता 

हुआ दिखता ह।ै

सोचें, कि एक कैरेक्टर  स्वय को अपनी डेस्क से दूर धकेल रहा ह,ै जसैा कि नीचे दिखाया गया ह।ै एक्शन का अंत इस तरह होगा, कि वह एंटीसिपेशन 

मूमेंट के अंत में स्लो-इन करेग ा, जहां उसका शरीर आगे की तरफ मूव करता ह ैऔर उसके परै कस कर घुमाये हुए स्प्रिंग की तरह मुड़े हुए होते हैं। उसके 
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बाद वह अचानक खुद को, डेस्क से दूर, परैों पर ज़ोर का दबाव डालते हुए, पीछे  की ओर धकेलता ह,ै ऐसा करते हुए स्लोर–आउट करता ह।ै एंटीसिपेशन 

पोज़ीशन में उसकी स्लोइंग स्क्वीज़ के चलते ये इफैक्ट और भी सशक्त तथा विश्वसनीय/यथार्थपरू्ण  हो जाते हैं, बजाय कि वह तेज़ और तेज़ गति बढ़ाता 

हुआ स्वय को डेस्क से दूर धकेलता। आखिरकार, यह टाइमिग तथा एंटीसिपेशन ही ह,ै जिसके चलते यह सब इतना बखबूी हो जाता ह।ै

एंटीसिपेशन कहता ह,ै कि यदि किसी कैरेक्टर  को पीछे  की तरफ मूव करना ह,ै तो उसे पहले आगे की ओर मूव करना होगा।

चित्र 2.1.3

स्टेजिग

जब एक ही विशाल लोकेशन से कई शॉट स्टेज करने हों, तो मैं सबसे पहले उस परूी लोकेशन का, सारी चित्रों के साथ, एक मास्टर शॉट स्कैच  आउट कर 

लेना पसंद करता हँू। इससे मैं इसके लेआउट, आकार और रिलेशनशिप या विभिन्न सेटिग्स तथा शामिल किरदारों से परूी तरह से अवगत हो जाता हँू (पषृ्ठ 

276 में ऊपर दी गई चित्र को देखें)। मेरा मानना ह ैकि एनिमेशन की सबसे बड़ी कमी यह ह ैकि एक शानदार बकैग्राउंड डिज़ाइन तयैार किया जाता ह ैऔर 

फिर इसमें शलैी, फ्रेमि ग या लोकेशन के बारे  में सोचे बिना ही, बस यों ही फिगर्स/चित्रों को डाल दी जाती हैं। इसी तरह, जब अलग-अलग तरह के शॉट्स 

चाहिये हों, तो कैमरा भी बिल्कु ल नीरस ढंग से इस्तेमाल कर लिया जाता ह।ै सब कुछ का एक मास्टर स्कैच  पहले बना लेने से आप देख पाएंगे, कि आप 

किन-किन तत्वों से प्रभाव डाल सकते हैं। साथ ही, आप उन सभी कैमरा एंगल्स पर भी गौर कर सकते हैं, जो एक ही व्यूप्वाइंट से, बस एक वाइड शॉट, 

मिड शॉट तथा क्लोज़-अप से बेहतर होंगे। इसे 3D एनिमेशन में करना कहीं आसान होता ह,ै क्योंकि जब परिवेश तथा कैरेक्टर  मॉडल स्थापित हो जाते हैं, 

आप बस उन कैरेक्टर  को स्थित कर देते हैं और कैमरे  को मुक्त रूप से मूव करते रहते हैं, जब तक हर दृश्य के लिए परफेक्ट  शॉट न मिल जाये।

चित्र 2.1.4: एंटीसिपेशन कहता है, कि यदि किसी कैरेक्टर को पीछे की तरफ मूव करना है, तो उसे पहले आगे की ओर मूव करना होगा।
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चित्र 2.1.5

यदि एक जटिल सेटिग में खासतौर से बड़ी संख्या में दृश्यों के लिए एनिमेशन की जा रही हो, तो मैं सेट तथा इसके कैरेक्टर ों का एक साधारण कार्डबोर्ड  

कट-आउट वर्ज़न भी बना सकता हँू। एक्शन दृश्यों की स्टेजिग तथा फ्रेमि ग के दिलचस्प तरीके खोजते समय यह संदर्भ का एक मलू्यवान स्रोत बन जाता 

ह,ै जिसका मैं हर कोण से अध्ययन कर सकता हँू। किसी लोकेशन पर नये तथा क्रिएटिव शॉट की खोज करते हुए, खासतौर से दो या दो से अधिक इंटरैक्टिंग 

कैरेक्टर्स  के साथ, आपको ज़रूरी फिल्म तकनीकें  नहीं भलूनी चाहिएं, जसेै लाइन क्रॉस न करना और एक्शन की निरन्तरता बनाये रखना, इत्यादि

एक ही एक्शन को कई अलग-अलग तरीकों से फ्रे म किया जा सकता ह;ै अपने एक्शन को स्टेज करने के अनठेू तथा दिलचस्प तरीके खोजें।

स्ट्रेट अहेड तथा पोज-टू-पोज एनिमेशन

स्ट्रेट अहेड एनिमेशन पहली ड्रॉइंग पर शुरू होती ह ैऔर सीन के अंत तक ड्रॉइंग-दर-ड्रॉइंग चलती ह।ै इस पद्धति से साइज़, वॉल्यूम तथा प्रपोर्शन खराब हो 

सकते हैं, लेकिन इसमें सहजता तथा नयापन ह।ै फास्ट, वाइल्ड एक्शन इसी विधि से किये जाते हैं। पोज-टू-पोज एनिमेशन अधिक नियोजित तथा चार्टेड 

होती ह,ै जिसमें की ड्रॉइंग्स (फ्रे म्स) परूे  सीन के दौरान इंटरवेल्स में होती हैं/की जाती हैं। इस तरीक से साइज़, वॉल्यूम तथा प्रपोर्शन पर बेहतर नियत्रण 

रहता ह,ै और उसी तरह एक्शन पर भी। लीड/प्रमुख एनिमेटर चार्टिंग तथा कीज़ अपने सहायक/असिस्टेंट को सौंप देगा। इस पद्धति में सहायक का बेहतर 

उपयोग किया जा सकता ह,ै इसलिए एनिमेटर को सीन में हर ड्रॉइंग खुद ड्रॉ नहीं करनी पड़ती। इस तरह एनिमेटर कई सीन कर सकता ह ैऔर एनिमेशन 

की प्लानिग/नियोजन पर ध्यान कें द्रित कर सकता ह।ै कई दृश्यों में एनिमेशन की दोनों ही विधियों का उपयोग किया जाता ह।ै

फॉलो-थ्रू और ओवरलपैिग एक्शन

जब किरदार का शरीर (मुख्य हिस्सा) रुक जाता ह,ै तो अन्य हिस्सों की हरकत भी उसी के हिसाब से रुकना शुरू होती ह,ै जसेै बाहें, लम्बे बाल, कोट की 

तनियाँ, ड्रेस, लटकते कान या लम्बी पूंछ (ये भी इसी एक्शन (रुकने की क्रिया) का अनुसरण करने हैं)। सब कुछ एक साथ ही अचानक नहीं रुक जाता। 

इसे फॉलो थ्रू कहते हैं। ओवरलपैिग एक्शन तब होता ह,ै जब पात्र अपनी दिशा बाल लेता ह,ै लेकिन उसके कपड़े या बाल पहले वाली दिशा में ही मूव करते 

रहते हैं। पात्र एक नई दिशा में जा रहा ह,ै लेकिन इस दिशा में उसके शरीर का अनुसरण उसके कपड़े कई फ्रे म्स के बाद करना शुरू करें गे। एनिमेशन में 

‘‘DRAG’’ का उदाहरण ह,ै कि जब गफूी दौड़ना शुरू करता ह,ै लेकिन उसका सिर, कान, शरीर का ऊपरी हिस्सा तथा कपड़े उसके परैों का अनुसरण 

नहीं करते/ उसके परैों के हिसाब से मूव नहीं करते। फीचर्स में इस तरह का एक्शन काफी बारीकी से किया जाता ह।ै उदाहरण: जब स्नो व्हाइट डांस शुरू 

करती ह,ै तो उसकी पोशाक तुरंत ही उसके साथ मूव करना शुरू नहीं करती, लेकिन कुछ फ्रे म्स के बाद मूव करना शुरू कर देती ह।ै लम्बे बाल तथा 

जानवरों की पूँछों को भी इसी तरह से हैंडल किया जाता ह।ै ड्रैग और ओवरलपैिग एक्शन की प्रभावशीलता में टाइमिग की बेहद महत्वपरू्ण  भमूिका ह।ै

उदाहरण के लिए:

•	 बॉल फें कता हुआ हाथ, बॉल फें कने के बाद भी एक्शन में रहता ह।ै

•	 दरवाज़ा खोलने जाते वक्त, आप अभी चल ही रहे होते हैं, और आपका हाथ दरवाज़े तक पहँुच जाता ह।ै

कीज़:

•	चित्रः  एनिमेशन: लीड एवं ड्रैग प्वाइंट्स

•	 अगला एक्शन शुरू होने से पहले चल रहे एक्शन को परूी तरह से कभी भी रोकना नहीं चाहिए।
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चित्र 2.1.6: ओवरलैपिंग एक्शन

हरकतों/मूवमेंट में लचक/लचीलापन केवल किरदार की संरचना और क्षमता का ही विषय नहीं ह।ै सकैें ड्री ऑब्जैक्ट्स , जसेै कपड़े, बाल या प्रॉप्स, की 

मूवमेंट से जुड़े  घटक एक्शन को अधिक वास्तविकता प्रदान कर सकते हैं। उदाहरणार्थ , जब लम्बे बालों वाला कोई कोई अपना सिर घुमा/घुमाता ह,ै तो 

बालों की गति में किसी न किसी प्रकार का विरूपण या विलंब अवश्य होगा। (TV एंकर के मामले को छोड़ कर, क्योंकि उनके बाल हेयर स्प्रे से बिल्कु ल 

सेट किये हुए होते हैं/चिपकाये हुए होते हैं।) सामान्यत:, जब सिर घमूता ह,ै तो बाल कुछ पल बाद ही हरकत में आते हैं। फिर, जब सिर का घमूना रुक जाता 

ह,ै तो बाल उनका अनुसरण तो करते ही हैं, बल्कि अधिकतर सिर के स्थिर अवस्था में आ जाने के बाद भी उनमें मूवमेंट ज़ारी रहती ह ैऔर अन्तत: वे भी 

सिर की पोज़ीशन में ही सेटल हो जाते हैं, जसेै बिल्कु ल नीचे वाली आकृति में दिखाया गया ह।ै बाल जितने अधिक लम्बे, ढीले और लचीले होंगे, उनमें 

आगे-पीछे  होने का, धीरे -धीरे  कम होता एक्शन उतना ही अधिक होगा। । यह ओवरलपैिग एक्शन के नाम से जाना जाता ह।ै

यहां पात्र का सिर तथा शरीर की मूवमेंट बस अभी-अभी बंद हुई ह,ै लेकिन एक फ्ल्यूड, ओवरलपैिग मूवमेंट के प्रयोग से बालों का झलूना (स्विंग करना) 

और फिर सेटल होना ज़ारी रहता ह।ै इससे दृश्य अधिक सजीव तथा वास्तविक लगता ह।ै

चित्र 2.1.7 (a) कैरेक्टर मूव्ज़

ओवरलैंपिग एक्शन पोशाक पर भी होता ह।ै फिर वही बात ह,ै कि कैरेक्टर  के कपड़े भी उसके शरीर की गति के साथ ही तुरंत स्थिर हो जाएं, यह बेहद 

अवास्तविक लगेगा। एक सटीक उदाहरण यहां देखें, सोचें कि लम्बा, लहराता हुआ कोट पहने कोई किरदार भाग रहा ह,ै जसेै नीचे दिखाया गया ह।ै जब 

तक पात्र गति में ह,ै कोट उसके पीछे  लहराता रहेगा। हालांकि, जब पात्र रुक जाता ह,ै कोट दौड़ की ही दिशा में मूवमेंट करना ज़ारी रखता ह,ै स्वय को 

पात्र के चारों ओर लपेटता ह ैऔर आगे को झलूता ह,ै फिर पीछे  होता ह ैऔर अन्तत: स्थिर पोज़ीशन पर सेटल हो जाता ह।ै
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यहां पात्र के कदमों की मूवमेंट के साथ उसके चोगे में पड़ रहे खिचाव पर गौर करें । फिर जब पात्र आगे की मूवमेंट रोकता ह ैऔर अगला कदम बढ़ाने की 

तयैारी करता ह,ै तो यह इकट्ठा हो जाता ह।ै

ओवरलपैिग एक्शन प्रॉप्स के साथ भी हो सकता ह।ै जसेै कोई पात्र जाती हुई ट्रेन में किसी की तरफ रुमाल हिला रहा ह।ै लहराता हुआ हाथ, जब नीचे आता 

ह,ै तो रुमाल भी इसके पीछे  ड्रैग होगा। हालांकि, जब हाथ फिर से उठता ह,ै रुमाल तब भी नीचे की तरफ ड्रैग होता ह,ै गुरुत्व के प्रभाव और हाथ के आवेग 

की वजह से। फिर, जब हाथ दोबारा नीचे की ओर आता ह,ै तो रुमाल इसे पीछे  छोड़ दोबारा ऊपर की ओर उठता ह,ै हमेशा हाथ के एक्शन से एक कदम 

पीछे , और इसी तरह से आगे भी। कोड़े मारते वक्त कोड़े पर और घोड़े के दौड़ते वक्त उसकी पूंछ पर भी यही ओवलपैिग प्रभाव होगा।

इस अधिक सकू्ष्म उदाहरण में, ड्रम मेजर के हटै पर हुए हल्के  से ओवलपैिग एक्शन पर गौर करें ।

चित्र 2.1.9 (c): कैरेक्टर मूव्ज़

चित्र 2.1.8 (b): कैरेक्टर मूव्ज़
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स्लो-आउट और स्लो-इन 

ज़्यादातर मूवमेंट को अपने एक्शन में एक्सेलेरे शन (गति बढ़ने) या डिसेलेरे शन (गति कम होने) की आवश्यकता पड़ती ह,ै क्योंकि वास्त्व में तो, मशीनों 

के अलावा, कोई भी चीज़ समान गति से नहीं चलती। आपको इसके बारे  में चार्ट-वाइज़ सोचने और एनिमेशन-वाइज़ परूा करने की योग्यता विकसित 

करनी होगी। इस प्रकिया को समझाने का क्लासिक बाउंसिग बॉल से बेहतर तरीका कोई दूसरा नहीं ह।ै विश्व का लगभग हर एनिमेशन ट्यटूोरियल 

बाउंसिग बॉल सिद्धांत से शुरुआत करता ह।ै हालांकि, जीवन की हर घिसी-पिटी बात/पुरानी पड़ चुकी बात की ही तरह इस सिद्धांत के श्रेष्ठतम मूल्य भी 

इसकी परू्णता और बात में निहित हैं, कि इससे हर कोई परिचित होता ह।ै बाउंसिग बॉल में एक ऐसे एक्शन - जो कि पहले तेज़ होता ह,ै फिर धीमा पड़ता 

जाता ह ै- के वे सभी तत्व आ जाते हैं, जिन्हें जानने की ज़रूरत हर एनिमेटर को होती ह।ै रबर की इस गेंद में टाइमिग के चार अन्य घटक - स्ट्रक्चर, शेप, 

वॉल्यूम तथा फ्लेक्सिबिलिटी - भी कवर हो जाते हैं और साथ ही एक अन्य सबसे महत्वपरू्ण  घटक भी, जो सभी चीज़ों की गति को प्रभावित करता ह,ै गुरुत्व।

बाउंसिग बॉल इफैक्ट, जो कि नीचे दिये गये चित्र में समझाया गया ह,ै व्याख्या करने में आसान ह।ै रबर की गेंद ऊपर उछालती ह,ै या नीचे आती ह ैऔर 

ज़मीन से टकरा कर ऊपर उछलती ह,ै फिर नीचे आती ह ैऔर फिर ज़मीन से टकरा कर ऊपर उछलती ह,ै पर इस बार पहली बार जितनी ऊंची नहीं, फिर 

नीचे आती ह,ै ज़मीन से टकराकर उछलती ह ैऔर अबकी बार उससे भी कम ऊपर इत्यादि, जब तक कि इसकी सारी ऊर्जा  खत्म नहीं हो जाती और यह 

स्थिर नहीं हो जाती। इस साधारण से एक्शन में बताये गये सिद्धांत ही एनिमेशन को काफी हद तक परिभाषित कर देते हैं।

जब गेंद उछाली जाती ह,ै वह हवा में तेज़ गति से ऊपर की ओर जाती ह,ै फिर धीरे -धीरे  हवा में ही बीच में लगभग रुक सी जाती ह,ै क्योंकि गुरुत्वाकर्षण 

बल इस पर अपना प्रभाव डालने लगता ह ै(1)। मुश्किल से क्षण भर के लिए ही यह रुकती होगी, गुरुत्वाकर्षण बल इसे नीचे की ओर खींच लाता ह,ै और 

वह भी तेज़ी के साथ। फिर, सख्त मदैान से टकरा कर (11) गेंद दबती/पिचकती ह ैऔर फिर से ऊपर उछल जाती ह।ै यह पहली बार जितनी ऊंची नहीं 

उछलती, क्योंकि ज़मीन से टकराने की वजह से इसका कुछ वेग खत्म हो चुका होगा, और गुरुत्व इसे पहली बार के जितना ऊपर उछलने या एक्सेलेरे ट 

नहीं होने देगा। यह फिर से धीमी होकर रुकती ह ै(19) और फिर तेज़ी से नीचे की ओर आती ह,ै जहां यह टकरायेगी (29) और फिर से उछल जायेगी (37), 

दरअसल ऐसा कई बार होगा और हर उछाल पहले से कम और कम होता जायेगा, जब तक कि अन्तत: गेंद स्थिर न हो जाये।

चित्र 2.1.10: मानक/स्टैंडर्ड बाउंसिंग बॉल

अब चार्ट  में इसे कैसे परिभाषित किया जा सकता ह?ै सबसे पहले हमें प्रमुख पोज़ीशंस को अलग करना होगा, उछाल के उच्च तथा निम्न (हिट) बिदु। गौर 
करें , कि अपने उच्च बिदुओ ंपर गेंद परूी तरह से गोल ह,ै लेकिन हिट प्वाइंट्स पर/ज़मीन से टकराते 

वक्‍़त विरूपित ह,ै जसैा कि नीचे दाई ंओर देखा जा सकता ह।ै जब नरम रबर की गेंद सख्त ज़मीन से 

टकराती ह,ै तो इसका वेग इसे एक तरफ से दबा कर दूसरी तरफ से फैला देता ह।ै (याद रखें, वस्तु को 

चाहे किसी भी तरह से विरूपित किया जाये, उसका आयतन नहीं बदलता, आयतन केवल तभी कम 

होता ह,ै जब चीज़ गिर कर फैल जाये या फिर टूट जाये।)

ज़मीन से टकराने पर रबर की गेंद में होने वाले विरूपण को स्क्वैश कहा जाता ह।ै चित्र 2.1.11 में दर्शाया 

गया ह।ै

चित्र 2.1.11 स्क्वै श
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अब, यदि यह गेंदबाज़ी की गेंद होती और ट्रैम्पोलीन या नरम घास से टकराती, तो इससे उलट होता, जसैा आकृति में दर्शाया गया ह,ै सतह दब जायेगी और 

गेंद बिल्कु ल ज्यों की त्यों रहेगी।

चित्र 2.1.12 बाउलिंग बॉल हिटिंग अ ट्रॅम्‍पोलीन/एक 
ट्रैम्पोलीन को हिट करती बाउलिंग बॉल

यदि टकराने वाली वस्तु सतह, जिससे यह टकरा रही ह,ै से कठोर होती ह,ै तो वस्तु की बजाय सतह 

विरूपित होती ह/ैदबती ह।ै

अब गेंद के ऊपर जाने और नीचे आने की गति पर विचार करें । जब बॉल अपनी उच्चतम स्थिति से नीचे की ओर आती ह,ै तो यह तेज़ गति से आती ह।ै उस 

उच्चतम स्थिति पर अनिवार्य  रूप से यह तेज़ी से उछली हुई गेंद रुकती ह,ै क्योंकि गुरुत्व इसे तेज़, बुहत तेज़ ज़मीन की ओर खींचता ह।ै

कार्टू न बनाने की पुरानी परंपरा में वस्तु के पीछे  लंबी रे खाएं खींचकर गति दर्शाया जाता था (जो ‘‘स्पीड लाइन’’ कहलाती थीं) लेकिन एनिमेटरों ने पाया, 

कि वस्तु को उसके एक्शन पाथ में स्ट्रेच करने से स्पीड का इफैक्ट बेहतर आता ह,ै क्योंकि यह उस ब्लर के जसैा लगता ह,ै जो आप फ्रोज़न लाइव-एक्शन 

फिल्म फ्रे म में देखेंगे।

एनिमेशन को डिस्टॉर्ट  करके ब्लर करने के इस प्रयास को स्ट्रेच कहते हैं। पुराने कई कार्टू नों में स्क्वैश तथा स्ट्रेच के प्रचंड/गहन उदाहरण दिखाये जाते 

थे, यद्वपि आज के समय में यह काफी कम हो गया ह,ै खासतौर से कम्प्यूटर से बने 3D एक्शन के अधिक स्वाभाविक दृष्टिकोण के चलते।

स्ट्रेचिग वस्तु की गति को दर्शाता ह,ै क्योंकि वस्तु उस दिशा में मूव कर रही होती ह।ै

चित्र 2.1.13

चित्र 2.1.14 वेग में कोई बदलाव नहीं

चित्र 2.1.15 बाउंसिंग सीन

यदि वेग में कोई बदलाव न हो, तो चार्ट  इस तरह दिखेगा।

स्क्वैश तथा स्ट्रेच दिखाने के लिए बॉल में इन बिटवीनिग करने से बाउंसिग सीन अधिक 

स्वाभाविक तथा विश्वसनीय लगेगा।

यदि गेंद का वेग एक समान ह ैऔर न बढ़ रहा ह ैन घट रहा ह ै(जो कि संभव नहीं ह)ै, तो चार्टिंग, ऊपर बाएं दिये गये चार्ट  के समान दिखेगी। लेकिन सच्चाई 

यह ह,ै कि जब गेंद नीचे की ओर तेज़ी से आ रही ह,ै तो इसकी गति एक समान नहीं ह।ै ऊपर दाई ं ओर दिया चार्ट  अधिक वास्तविक दिखने वाली 

इनबिटवीन पोज़ीशंस दर्शा  रहा ह।ै

ड्रॉइंग्स जितनी अधिक होंगी, एक्शन उतना ही धीमा लगेगा। इसलिए, गेंद जब सबसे ऊपर हो, तो कई सारी पोज़ीशंस को इस तरह से स्पेस्ड आउट करने 

(बराबर अंतर पर लगाने) से इफैक्ट ऐसा आयेगा, कि जसेै बॉल धीरे  शुरू हुई और फिर तेज़ होती गई, क्योंकि पोज़ीशंस फैल जाती हैं।

यदि गेंद का वेग एक समान ह ैऔर न बढ़ रहा ह ैन घट रहा ह ै(जो कि संभव नहीं ह)ै, तो चार्टिंग, ऊपर बाएं दिये गये चार्ट  के समान दिखेगी। लेकिन सच्चाई 

यह ह,ै कि जब गेंद नीचे की ओर तेज़ी से आ रही ह,ै तो इसकी गति एक समान नहीं ह।ै ऊपर दाई ं ओर दिया चार्ट  अधिक वास्तविक दिखने वाली 

इनबिटवीन पोज़ीशंस दर्शा  रहा ह।ै

ड्रॉइंग्स जितनी अधिक होंगी, एक्शन उतना ही धीमा लगेगा। इसलिए, गेंद जब सबसे ऊपर हो, तो कई सारी पोज़ीशंस को इस तरह से स्पेस्ड आउट करने 

(बराबर अंतर पर लगाने) से इफैक्ट ऐसा आयेगा, कि जसेै बॉल धीरे  शुरू हुई और फिर तेज़ होती गई, क्योंकि पोज़ीशंस फैल जाती हैं।
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चित्र 2.1.16: एक्शन के अंत में अपेक्षाकृत कम इनबिटवींस प्रयोग 
करने से गति धीमी हो जाती है।

गेंद जब एक बार ज़मीन से टकरा चुकी हो और यह अगली ऊंची पोज़ीशन तक उछले, और ऐसा 

करते हुए इसकी गति धीमी पड़ती जाये, तो चार्ट  दाई ंओर दिये गये चार्ट  जसैा दिखेगा। इस बार, 

इनबिटवीन पोज़ीशंस एक्शन के अंत में इकट्ठी हो गई हैं, यह सुनिश्चित करती हुई, कि एक्शन की 

गति कम होती जाती ह,ै जसेै-जसेै यह अपनी पराकाष्ठा/चरम सीमा पर पहँुचना शुरू होता ह।ै

इस पाज़ीशंस से एक नया चार्ट  बनाया जायेगा, जो गेंद को तेज़ी से उसकी अगली हिट पोज़ीशन की 

ओर बढ़ता हुआ दिखायेगा, यद्वपि, चूँकि, हर उछाल के दौरान गेंद की ऊँचाई लगातार कम होती 

जा रहा ह ैऔर हर अगला उछाल पिछले उछाल से कम समय ले रहा ह,ै इन बिटवींस की कुल संख्या 

हर चार्ट  में कम, और कम होती चली जायेगी।

टूज़ में एनीमेट किया गया, नीचे चित्र में दिखाया गया एक्शन बाउंस/उछाल अचानक/एकाएक कटता हुआ दिखता ह ैऔर कुछ हद तक इसका हवा में 

मंडराना भी। हालांकि, अगर इसे वन्स पर एनीमेट करके अधिक स्मूथ बनाया गया होता, तो मैं 11 से 13 और 27 से 29 तक के मूव इन्‍बिट्वीन डालने को 

तयैार न होता, क्योंकि ग्राउंड से स्क्वैश पोज़ीशन

और ऊपर हवा में अगली पोज़ीशन से रिज़ल्टेंट स्नैप गेंद में एक मज़बतू हिट के लिए अपेक्षित गति/ऊर्जा  बनाए रखेगा, जब यह ज़मीन पर आएगी।

चित्र 2.1.17: फुल बाउंसिंग इलस्ट्रेशन

चित्र 2.1.18: बाउंसिंग एक्शन के लिए फाइनल चार्ट

ऊपर फुल बाउंसिग इलस्ट्रेशन पर आधारित और टूज़ में एनीमेट की गई, एक परूी बाउंसिग सीक्वेंस ऐसे चार्ट  की जायेगी, जसेै ऊपर दिखाई गई ह।ै

एनिमेशन की शब्दावली में, एक की पोज़ीशन से दूसरी की पोजीशन की ओर एक्सेलेरे ट करती मूवमेंट की चार्टिंग को स्लोइंग-आउट कहते हैं और एक 

ऐसी मूवमेंट की चार्टिंग, जिसमें ऑब्जेक्ट अगली की पोज़ीशन की ओर धीमा पड़ता जा रहा हो (डिसेलेरे ट), को स्लोइंग-इन कहते हैं।

आर्क्स

वास्तविक दुनिया में लगभग सभी एक्शन एक आर्क  में मूव करते हैं। जब एनिमेशन तयैार की जा रही हो, तो आपको कोशिश करनी चाहिये कि गति कर्व्ड  

(वक्र) पाथ का अनुसरण करे , बजाय लीनियर (रे खीय) पाथ के। कोई किरदार या किरदार का कोई हिस्सा एक सीधी रे खा में शायद ही कभी मूव करता 
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हो। यहां तक कि शरीर की स्थूल गति, जब आप कहीं चलते हैं, भी परूी तरह से सीधी नहीं होती। जब हाथ/बांह कुछ पकड़ने के लिए आगे बढ़ता ह,ै तो यह 

आर्क  में मूव करता ह।ै सामान्य उदाहरण – गेंद किक करना 

चित्र 2.1.19: गेंद किक करना

सेकें डरी एक्शन

यह एक्शन प्रमुख एक्शन को और भी समदृ्ध बनाता ह ैऔर प्रमुख एक्शन को परू्णता और/या बल प्रदान करके कैरेक्टर  एनिमेशन को और भी विस्तार दे 

देता ह।ै उदाहरण: एक पात्र गुस्से से दूसरे  पात्र की ओर जा रहा ह।ै उसकी चाल सशक्त, आक्रामक और आगे की ओर झुकी हुई ह।ै टांगों का एक्शन परैों को 

घसीट कर चलने जसैा ह।ै सकैें ड्री एक्शन, चलते हुए हिल रही बाज़ुओ ंसे कुछ सख्त भाव व्यक्त करने जसैा ह।ै यह भी संभव ह ैकि, चाल तथा संवाद को 
अधिक स्पष्ट करने के लिए, उसी समय सिर को इधर-उधर हिलाकर डायलॉग भी डिलीवर किये 

जा रहे हों, लेकिन इतने ज़्यादा नहीं, कि चलने के एक्शन से ध्यान बंट जाये। ये सभी एक्शन एक-

दूसरे  को सपोर्ट  करते हुए, एक साथ काम करने चाहिएं। चलने को प्राइमरी एक्शन के रूप में लें 

और बाज़ुएं झलूने, सिर हिलने तथा शरीर के अन्य एक्शनों को सकैें ड्री एक्शन के रूप में।

उदाहरण के लिए:

•	 कॉर्ड  मूवमेंट

•	भ ाव-भंगिमा

कीज़

•	प्रा थमिक एक्शन को समर्थन/सपोर्ट  देते हुए होने चाहिये।

चित्र 2.1.20: कॉर्ड मूवमेंट
टाइमिग

टाइमिग ही एनिमेशन का मूलतत्व/सार ह।ै किसी चीज़ के मूव करने की गति से यह पता लगता ह,ै वह वस्तु क्या ह,ै उसका वज़न कितना ह ैऔर वह मूव 

क्यों कर रही ह।ै जसेै पलक झपकना तेज़ भी हो सकता ह ैऔर धीमा भी । यदि यह तेज़ झपकती हैं, तो कैरेक्टर  सतर्क  व सजग लगेगा। यदि ये धीरे  झपकती 

हैं, तो कैरेक्टर  थका हुआ या सुस्त लगेगा।

उदाहरण के लिए: 

सिर जो दाएं और बाएं घमूता हो। 

•	सिर  यदि बहुत ही धीरे  आगे-पीछे  घमूता हो: तो ऐसा लग सकता ह,ै कि कैरेक्टर  अपनी गर्दन स्ट्रेच कर रहा ह ै(कई सारे  इन बिटवीन फ्रे म्स) 

•	 थोडा तेज़ हो तो लगेगा कि वह ''नहीं'' कह रहा ह ै(कुछ ही इन बिटवीन फ्रे म्स)। 

•	 बहुत ही तेज़, कैरेक्टर  बेसबॉल के बल्ले से चोट खाने पर प्रतिक्रिया दे रहा हो (लगभग कोई इन बिटवीन फ्रे म 

नहीं)।

चित्र 2.1.21: सिर
अतिशयोक्ति

एग्ज़ैजरे शन हर समय किसी ड्रॉइंग का बेहद डिस्टॉर्शन (विरूपण) या बिल्कु ल ही अवास्तविक दिखने वाला हिसक एक्शन नहीं होता। यह मुखाकृति, 

अभिव्यक्ति, मुद्रा या रवयैे या एक्शन की एक हास्यास्पद नकल बनाने जसैा ह।ै लाइव एक्शन फिल्म का एक्शन बिल्कु ल सही हो सकता ह,ै लेकिन यह 

रूखा और मशीनी लगता ह।ै फीचर एनिमेशन में किरदार को स्वाभाविक दिखने के लिए ज़्यादा खुल कर मूव करना पड़ता ह।ै यही बात भाव-भंगिमाओ ं

पर भी लाग ूहोती ह,ै लेकिन एक्शन इतना अस्वाभाविक भी नहीं होना चाहिये, जसैा किसी शॉर्ट  कार्टू न स्टाइल (शलैी) में होता ह।ै चाल या आँखों की 
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हरकत, यहां तक कि सिर घुमाने में भी, यदि एग्ज़ैजरे शन कर दिया जाये, तो यह आपकी फिल्म को और अधिक आकर्षक बना देता ह।ै अत्यधिक नाटकीय 

तथा कुछ ज़्यादा ही एनिमेटेड होने से बचने के लिए अपनी अच्छी अभिरूचि तथा व्यावहारिक ज्ञान का प्रयोग करें ।

सॉलिड ड्रॉइंग्स

शकै्षिक ड्रॉइंग की तरह एनिमेशन में भी ड्रॉइंग का यही सिद्धांत लाग ूहोता ह,ै कि ड्रॉइंग में वेट (वज़न), वॉल्यूम सॉलिडिटी तथा त्रिआयामी होने का भ्रम 

हो। जसेै आप कार्टू न ड्रॉ करते हैं, आप जीवन/अस्तित्व की पुनरुत्पत्ति के लिए रूढ़िगत तरीके से पेंसिल स्कैच  तथा ड्रॉइंग्स का प्रयोग करके ड्रॉ करते हैं। 

आप किरदारों को तीन तथा चार आयामों का भ्रम देते हुए इन्हें रंगों तथा हरकतों (मूवमेंट) में परिवर्तित करते हैं। स्पेस/रिक्त स्थान में मूवमेंट त्रिआयामी ह।ै 

चौथा आयाम ह ैसमय में हरकत (मूवमेंट इन टाइम)।

अपील/आकर्षण

एक लाइव परफॉमर में ज़बरदस्त आकर्षण होता ह।ै एक एनिमेटेड चरित्र मनमोहक/आकर्षक 

होता ह।ै अपीलिग/आकर्षक एनिमेशन का तात्पर्य  केवल प्यारा और मनमोहक होने से ही नहीं 

ह।ै सभी पात्रों में अपील होनी ही चाहिये, चाहे वे नायक हों, खलनायक हों हास्य हों या प्यारे । 

अपील, जिस अर्थ में आप इसे लेते हैं, में समझने में आसान डिज़ाइन, स्पष्ट ड्रॉइंग तथा व्यक्तित्व 

विकास शामिल ह,ै जो देखने वालों का ध्यान खींचे और उनकी दिलचस्पी बनाये रखे। 

आरंभिक दौर के कार्टू न, दरअसल किसी प्रमुख विषय पर बनी, एक हास्य-श ्रृंखला होती थी। 

इन वर्षो के दौरान निर्माता ये समझ चुके हैं, कि फीचर बनाने के लिए कहानी में एक 

निरन्तरता, पात्र विकास (कैरेक्टर  डिवलपमेंट) और परूे  निर्माण के दौरान आर्टवर्क  की उच्च 

गुणवत्ता की आवश्यकता होती ह।ै कथा वााचन के अन्य रूपों की ही तरह फीचर में भी मन 

तथा आँखें, दोनों को बाँधें रखने की क्षमता होनी चाहिये।
चित्र 2.1.22: अपील/आकर्षण

स्क्वैश और स्ट्रेच के उपयोग से इस किरदार को अपेक्षित वेट देने में मदद मिली। फॉलो थ्रू तथा ओवरलपैिग एक्शन के चलते उसका पेट अपने ही इनर्शिया 

से/अपनी ही गति से हिलता -उठता रहता ह,ै और इसकी मूवमेंट प्रमुख एक्शन की मूवमेंट से कुछ पीछे  रहती ह।ै शेरिफ के कोट, हटै तथा मूछों के लिए भी 

फॉलो थ्रू प्रयोग किया गया ह।ै सशक्त एंटीसिपेशन पात्र के उठने/राइज़ की गति/मूवमेंट को उसकी परूी ऊँचाई तक जाने से रोकती ह,ै साथ ही, सॉलिड 

ड्रॉइंग के सिद्धांत तथा अपील भी इस समदृ्ध एनिमेटेड सीक्वेंस में ज़ाहिर होते हैं।
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यूनिट 2.2: लाइफ ड्रॉइंग्स: मानव शरीर रचना विज्ञान का आधारभूत सिद्धांत

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 मानवी देह के गठन, भाव, क्रिया-कलाप/एक्शन तथा अभिव्यक्तियों की लाइफ ड्रॉइंग (किसी इंसान को देखकर उसका चित्र बनाना) कीजिये।

2.2.1 भाव-भंगिमा
हाइरार्की/पदक्रम में सबसे पहले आता ह,ै इंसान का चेहरा, जिस पर आँखें सबसे पहले जाकर टिकती हैं: यदि किसी कृति में चेहरा नज़र आ रहा ह,ै तो जो 

चीज़ हम सबसे पहले देखते हैं, वे हैं उसकी अभिव्यक्तियां।  देह हमारे  क्रिया-कलापों को अभिव्यक्त करती ह,ै लेकिन चेहरा हमारे  आंतरिक जीवन का दर्पण 

होता ह ैऔर किसी किरदार में इसी आंतरिक जीवन की अभिव्यक्ति एक कुशल, पनैी नज़र वाले आर्टिस्ट (या लेखक) और एक भावशनू्य आर्टिस्ट के बीच 

अन्तर पदैा करती ह।ै

यूनिट के उद्देश्य  

चित्र 2.2.1: भाव-भंगिमा

आंखें

सिर्फ  आंखों से ही काफी कुछ किया जा सकता ह।ै पलकों, आँख की पुतली तथा पुतली के बीच स्थित तारे  (प्यूपल) की परस्पर-क्रियाएं अभिव्यक्ति में सकू्ष्म 

किन्तु बिल्कु ल स्पष्ट अन्तर पदैा करती हैं, क्योंकि आँखें ही चेहरे  पर ध्यान का मुख्य कें द्र होती हैं। आँखें परूी अभिव्यक्ति में प्रमुख होती हैं, इसलिए बाकी 

चीज़ों पर ध्यान देने से पहले सुनिश्चित कर लें, कि आँखें बिल्कु ल सही हों। 
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चित्र 2.2.2: भौंहें

भौंहें बेहद संवेदी होती हैं। मुझे लगता ह,ै कि भौंहों में लाया गया मामूली सा बदलाव भी उस अभिव्यक्ति में बदलाव ले आता ह,ै जो मैं ड्रॉ कर रहा होता हँू। 

अपने उद्धेश्य के अनुसार हम भौहों को दो हिस्सों में बांट सकते हैं, जो अर्ध-स्वतन्त्र रूप से गति कर सकें : सिरा और वक्र।

मुँह

अभिवव्यक्ति के लिए आँखों के क्षेत्र के बाद आता ह,ै मँुह का क्षेत्र। होंठों की स्थिति (और डिपल, दांत....इत्यादि अतिरिक्त अभिव्यंजक विशिष्टताओ)ं की 

विस्तृत जानकारी आपको इमोशन ट्री के भीतर मिल जायेगी, लेकिन यहां मँुह के आकार के विषय में चर्चा  की गई ह,ै जो हरे क होंठ के वक्र के संयोजन 

से बनाये जाते हैं।

1.	 दोनों होंठ ऊपर की ओर मुड़े हुए: खिसियानी हँसी, सामान्य खुशी (खुले) वाला मँुह का आकार

2.	 ऊपरी होंठ नीचे और निचला होंठ ऊपर की ओर मुड़ा हुआ: कुछ ज़्यादा ही खुश - मँुह सामान्य से अधिक खुला ह,ै शायद चिल्लाने के लिए।

3.	 दोनों ओठों नीचे की ओर झुके हुए: निराशा, भय (किनारे  शिथिल हैं, लेकिन निचला होंठ वेदना से ऊपर को ठेलता हुआ)। 

4.	 ऊपरी होंठ नीचे को मुड़ा हुआ, निचला ऊपर की ओर, लेकिन इस बार ऊपरी हिस्सा बड़ा ह:ै विस्मित/अवाक दोनों होंठ शिथिल पड़े/लटके हुए हैं।

5.	 ऐसा लगता ह,ै मानों होंठ बीच में आना चाहते हैं: किनारों की वजह से जो झगड़ें में उठे हुए हैं: यह गुस्से में खुला हुआ मँुह ह।ै

नाक

नाक बहुत ज़्यादा अभिव्यक्त करनेवाला अंग नहीं होता ह,ै लेकिन कुछ भावों (गुस्सा, रोना, घणृा, उत्तेजना) में यह भी फूलती/फैलती हैं और बेहद गुस्से या 

घणृा से मूल/बेस से सिकुड़ भी जाती ह।ै

चित्र 2.2.3: होंठों की हरकत
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भावनाएं 

शांत चेहरा 

इसमें नाक-नक्श की स्थिति क्षैतिजीय होती ह ैऔर इसमें कुछ भी बहुत अधिक नहीं होता - चेहरा विरूपित 

नहीं होता।

आश्चर्यचकित चेहरा 

यह शेष की तुलना में एक छोटा क्षेत्र ह,ै क्योंकि आश्चर्य आमतौर पर अन्य भावों के साथ शामिल होता ह,ै 

लेकिन यहां हम सिर्फ  ''शुद्ध'' आश्चर्य की बात कर रहे हैं, न सकारात्मक न नकारात्मक। इसकी कुल मिलाकर 

यह विशेषता इसका खुलापन और गोलाई होती ह:ै पहले आँखों की और फिर बाकी नाक-नक्श की।

चित्र 2.2.4: शांत चेहरा

चित्र 2.2.5: आश्चर्यचकित चेहरा

मुस्कु राता चेहरा 

चेहरे  पर नीचे की ओर उभरने वाली मुड़कियों से अभिव्यक्त विशिष्ट भाव।

चित्र 2.2.6: मुस्कु राता चेहरा



2726

प्रतिभागी पुस्तिका रोटो आर ट्िस्ट

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

क्रोधित चेहरा 

इसकी विशेषता इसका सिकुड़ना ह,ै खासतौर से भौहों के बीच का क्षेत्र, जिसमें निम्न कुछ भावों के तहत सबसे ज़्यादा शिकन आते हैं।

उदास चेहरा 

नाक-नक्श के नीचे की तरफ ढलके होना इसकी विशेषता ह।ै भावों की इस परूी शाखा में कंधों में भी कुछ झुकाव रहता ह।ै

चित्र 2.2.7: क्रोधित चेहरा

चित्र 2.2.6: उदास चेहरा

शारीरिक हाव-भाव

हम बिरले ही अपनी भावनाएं केवल चेहरे  से व्यक्त करते हैं: हमारी परूी देह ही हमारे  भावों की अचेतन अभिव्यक्ति कर रही होती ह।ै इनके प्रयोग से आपके 

कैरेक्टर  रूखे/नकली कम और स्वाभाविक ज़्यादा लगेंगे। हाथ खासतौर से काफी अभिव्यंजक होते हैं और हाथों की अभिव्यंजनाओ ं का जिक्र अन्य 

प्रासंगिक अभिव्यक्तियों के साथ किया गया ह।ै यहां कुछ आम तथा प्रसिद्ध/प्रचलित शारीरिक मुद्राएं दी गई हैं, जिन्हें निश्चित रूप से प्रयोग करना चाहिये:
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नितंब पर हाथ:

हथेलियां नितंब पर, अँगुलियां आगे की ओर, कोहिनियां झुकी, बाहर को निकली हुई

•	 आत्म-विश्वास का एक उत्कृ ष्ट संकेत

•	 दर्शाता ह,ै कि शरीर एक्शन में आने के लिए बिल्कु ल तयैार ह,ै जसेै काम शुरू करने के लिए इत्यादि।

•	 शरीर के ऊपरी हिस्से का बड़ा होना/फैलना, जिससे वह आमना-सामना/मुकाबला होने की स्थिति में अधिक शक्तिशाली तथा भयानक लगता ह ै(या 

जब बच्चों को कुछ सिखा रहे हों)।

•	 इसका यह भी मतलब होता ह ै‘‘मुझ से दूर ही रहो, जानते नहीं मैं बहुत बड़ा गंुडा हँू’’

•	 ध्यान रहे, जब अँगठेू आगे की ओर हों, तो यह मुद्रा अधिक स्त्रियोचित् लगती ह ैऔर आक्रामकता की बजाय अनिश्चितता का संकेत देती ह।ै

बाहें बँधी हुई:

उत्कृ ष्ट रक्षात्मक रूख

•	 असहमति, अपना मत न रखने का मन बनाना, अहंकार, नापसंद। महिलाएं उन पुरुषों के सामने बाँहें बाँधे नहीं रहती, जिन्हें वे पसंद करती हैं।

•	 स्वय को तसल्ली देने वाली मुद्रा, चिन्ता या सामाजिक तनाव कम करने के लिए प्रयोग की जाती ह।ै

•	 कसकर शरीर की ओर खिचे हुई बाँहें तथा कोहिनी बेहद घबराहट का संकेत देती ह।ै

खुद को छूना:

हम अनजाने ही स्वय को तसल्ली देने या तनाव कम करने के लिए अपने शरीर को छूते हैं। अँगुलियों से होंठों को छूने का अर्थ ह,ै व्यग्रता, असहमति, 

निराशा, अनिश्चित, हाथ सिर खुजा रहे हों, गर्दन पकड़ रहे हों, इयरलोब (कान का निचला हिस्सा) पकड़ रहे हों, गाल मसल रहे हों, दूसरे  हाथ की मालिश 

कर रहे हों इत्यादि। तनाव तथा असहमति के साथ सेल्फ-मनैिपुलेशन बढ़ जाते हैं ।

•	 इन संकेतों के ज़रिये दबे हुए गुस्से को दिखाना खासतौर से एक प्रभावी तरीका ह,ै क्योंकि ये अक्सर गुस्सा निकालने के तरीके होते हैं।

•	य हां ध्यान दें, कि छोटे बच्चे सिर के पीछे  हाथ रखकर ईर्ष्या  व्यक्त करते हैं।

एक्शन/क्रिया-कलाप

चित्र 2.2.7: शारीरिक हाव-भाव
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चरण 1: विभिन्न मुद्राओ ंका पता लगाने के लिए कई ड्रॉइंग्स बनाएं। शारीरिक लक्षणों/विशिष्टताओ ंपर निर्भर

चरण 2: अब अपने थम्बनेल्स लें और उन्हें सामान्य आकार/नॉर्मल साइज़ तक ब्लो करें । याद रखें, अपनी लाइन ऑफ एक्शन से शुरू करें  और एग्ज़ैजरें ट करने की कोशिश 

करें । जो भावना आप व्यक्त करना चाहते हैं उसे हमेशा मन में रखें। चित्रों/ड्रॉइंग्स की ऐसी श ्रृंखला बनाएं जो दृश्य/सीन की कहानी बयां करती हो। 

चरण 3: लाइन ऑफ एक्शन के आस-पास अपने कैरेक्टर  पोज़ निर्मित करें । अपनी ड्रॉइंग्स को लजू़ तथा स्पोंटेनियस रखें और ड्रॉइंग्स को एग्ज़ैजरे ट या पुश करने की 

कोशिश करते रहें। 

चरण 4: अच्छी पोज़िग के सबसे महत्वपरू्ण  तत्वों में से एक ह,ै रोचक छायाचित्र। भावना एक ग्राफिक की तरह पढ़ी जानी चाहिये - कमरे , या हमारे  मामले में थिएटर के 

बिल्कु ल पीछे  से भी बिल्कु ल स्पष्ट समझ आये। 
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Rotoscoping अक्सर लाइव-एक्शन मूवीज़ में विज़ुअल इफैक्ट्स  के लिए एक टूल के रूप में प्रयोग की जाती ह।ै एक ऑब्जेक्ट को ट्रेस करके आर्टिस्ट एक 

सिलुएट (जिसे मटै कहते हैं) तयैार करता ह,ै जिसे उस ऑब्जेक्ट को किसी अन्य बकैग्राउंड पर प्रयोग करने हेतु उस दृश्य में से निकालने के लिए प्रयोग 

किया जा सकता ह।ै जहां एक ओर, ब्लू तथा ग्रीन स्क्रीन तकनीकों ने सीन में सब्जेक्ट्स  को लेयर करने की प्रक्रिया आसान बना दी ह,ै Rotoscoping 

अब भी विज़ुअल इफैक्ट्स  इमेजरी के निर्माण में एक अपेक्षाकृत बड़ी भमूिका निभाती ह।ै डिजिटल डोमेन में अक्सर मोशन ट्रैकिग तथा अनियन-स्किनिग 

सॉफ़्टवेयर Rotoscoping के सहायक होते हैं। Rotoscoping अक्सर अन्य मटै-पुलिग प्रक्रियाओ ंके लिए गार्बेज मटै तयैार करने हेतु प्रयोग की जाती ह।ै

Rotoscoping, मटै अथवा रोटोस्कोप्ड लाइन से निर्देशित हो, स्पेशियल विज़ुअल इफैक्ट्स  (जसेै ग्लो/चमक) डालने के लिए भी प्रयोग की जाती ह।ै पहली 

तीन स्टार वार मूवीज़ में प्रयोग हुई परम्परागत Rotoscoping का एक विख्यात प्रयोग ह,ै जहां यह कलाकारों द्वारा पकड़ी हुई छड़ियों पर मटै क्रिएट करके 

एक चमकदार लाइटसेबर इफैक्ट पदैा करने के लिए प्रयोग की गई थी। यह इफैक्ट हासिल करने के लिए इफैक्ट तक्नीशियनों ने प्रत्येक फ्रे म के ऊपर प्रॉप 

के ज़रिए एक लाइन ट्रेस की, फिर हर लाइन को बड़ा किया और ग्लो एड किया।

2.2.2 Rotoscoping

चरण 5:  जब आप लाइन ऑफ एक्शन और छायाचित्र एग्ज़ैजरे ट कर चुके हों, तो अन्य तत्व तलाशें, जो भावना को और सशक्त तरीके से अभिव्यक्त कर सकते हों। बाल, 

हाथ, परै (वज़न) और कपड़े आपकी मुद्राओ ंको और बेहतर बना सकते हैं।
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यूनिट 2.3: एनिमेशन निर्माण प्रक्रिया 

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	प्रो डक्शन/निर्माण की अवधारणाओ ंऔर हर प्रोजेक्ट के लिए उनकी उपयोगिता की व्याख्या करने में।

2.	 ऑब्जेक्ट्स  को एनीमेट करने हेतु उपलब्ध विभिन्न तकनीकों की जानकारी में।

3.	 बौद्धिक संपदा अधिकारों की विवेचना करने में, अंतिम उत्पाद, एलीमेंट्स/तत्व, आर्टवर्क  सुनिश्चित करने के लिए।

2.3.2 पूर्व-निर्माण कार्य (प्री-प्रोडक्शन)

2.3.1 परिचय
एनिमेशन एक मीडिया स्टेपल ह ै(एनीमेश मीडिया में बेहद आम ह)ै टीवी देखते हुए, कोई मूवी देखते हुए या कोई वेबसाइट विजिट करते हुए, एनिमेशन से 

आपका पाला पड़ेगा ही। कभी यह केवल एक शब्द होता ह,ै जो किसी वेबपेज पर मूव करता दिखाई देता ह।ै कभी यह एक कार्टू न मछली होती ह,ै जो बच्चों 

को स्पेलिग्स सिखा रही होती ह।ै कभी-कभी किसी महाकाव्य/पौराणिक युद्ध चल रहा होता ह ैऔर युद्ध में जुटी सेनाएं इतनी वास्तविक लगती हैं, कि 

आपको पता ही नहीं लगता कि ये एनिमेशन ह।ै 

स्थिति चाहे जो भी हो, एनिमेशन बनाने की प्रक्रिया हमेशा एक ही तरह से शुरू होती ह:ै कोई इसे चाहता ह ै और इसके लिए भुगतान करने को भी  

तयैार ह।ै 

एनिमेशन कई प्रकार की होती हैं और इनकी लागत कई घटकों पर निर्भर करती ह।ै मूल्य इस पर निर्भर करता ह,ै कि कितना प्रोड्यजू़ करने की ज़रूरत 

ह,ै कितने लोग प्रोडक्शन में योगदान कर रहे हैं, इसके निर्माण में लगने वाली प्रौद्योगिकी कितनी महंगी ह ैऔर इसमें शामिल लोगों का निर्माण के क्षेत्र 

में अनुभव कितना ह।ै

 इसके बाद आता ह,ै एनिमेशन निर्माण के कई चरणों का संक्षिप्त ब्यौरा और साथ ही, कौन-कौन सी बातें लगने वाले समय और लागत पर प्रभाव डालेंगी।

प्रोडक्शन के असल में शुरू होने से पहले कई कदम उठाये जाते हैं। इस ''समस्या-समाधान'' चरण को प्री-प्रोडक्शन कहा जाता ह।ै एक परूा उद्योग ह,ै जो 

इन चरणों को समर्पित को समर्पित ह/ैजो यही काम करता ह,ै चूंकि, एनिमेशन (और फिल्म-मेकिग) कला का एक लम्बे समय तक चलने वाला और महंगा 

रूप ह।ै कहावत ह ैकि ‘‘समय ही पसैा ह’ै’। 

यूनिट के उद्देश्य  

परिकल्पना/आइडिया: उम्मीद करें , कि यह अच्छा हो!  आमतौर पर, व्यक्ति अपने आइडिया के लिए 

एनिमेशन के माध्यम पर तभी निर्भर करता ह,ै जब इसे क्रियान्वित करने का कोई और तरीका न हो...जसेै 

कि काउबॉएज़ राइडिग डायनासॉर्स/काउबॉएज़ डायनासॉर की सवारी करते हुए ... एनिमेशन से कुछ भी 

संभव ह!ै ज़ाहिर ह,ै यह व्यक्ति के बजट पर निर्भर करेग ा कि प्रोडक्शन में CG डायनासॉर्स के साथ लाइव 

एक्टर फिल्माये जाएंगे या फिर Flash कार्टूं स से ही काम चलाना पड़ेगा। लगने वाला समय: आइडिया तो 

क्षण भर में भी आ सकता ह।ै अच छ्े  आइडिया विकसित होने में सालों लग सकते हैं। लगने वाली लागत: 

आइडिया मुफ्त होते हैं, और कोई भी एकदम से उन पर अपना हक नहीं जता सकता/और कोई भी एकदम 

से उनका मालिक नहीं बन सकता।  

चित्र 2.3.1: विचार

स्क्रिप्ट: आमतौर पर, आइडिया को कागज़ पर एक लेखक उतारता ह,ै जिसे स्क्रिप्ट कहते हैं। स्क्रिप्ट में सेटिग्स, कैरेक्टर  एक्शंस, संवाद तथा कैमरा 

फ्रेमि ग के ज़रिये कहानी का वर्णन होता ह।ै इससे निर्देशक कहानी की जानकारी को सीन तथा शॉट में तोड़ सकता ह।ै एक सीन (जिसे एक सीक्वेंस भी 

कहते हैं) कई शॉट से मिलकर बनता ह ैऔर ये सेटिग से लेकर कहानी के किसी कथानक/परिदृश्य तक, कुछ भी हो सकता ह।ै एक शॉट, बिना किसी 
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रुकावट के लिया गया इकहरा कैमरा कट होता ह।ै लगने वाला समय: प्रोडक्ट के आधार पर एक दिन या फिर एक सप्ताह। मोशन पिक्चर स्क्रिप्ट में महीनों 

लग सकते हैं। लगने वाली लागत: आमतौर पर प्रोडक्शन बजट का 5 से 10 प्रतिशत राइटिग/लेखन को समर्पित होता ह।ै

स्टोरीबोर्ड: अब स्क्रिप्ट को विज़ुअली प्रस्तुत करने की ज़रूरत होती ह।ै इसे स्टोरीबोर्ड  करना सबसे तीव्र और सबसे अधिक लागत-प्रभावी प्रणाली होती 

ह।ै स्टोरीबोर्ड  एक कॉमिक्स की तरह होता ह,ै इसमें सीक्वेंशियल ड्रॉइंग्स के कई पनैल स्टोरी का खाका तयैार करते हैं। यहां पर, सीन ब्लॉकिग, कैमरा 

मूव्स और यहां तक कि कैरेक्टर  की पर्फोर्मेंस की भी पहले व्याख्या की जाती ह।ै चूंकि एनिमेशन एक बेहदखर्चीली तथा समय लेने वाली प्रक्रिया ह,ै 

प्रोडक्शन तब तक शुरू नहीं की जाती, जब तक क्लाइंट स्टोरीबोर्ड  को अप्रूव/मंज़ूर न कर ले। स्टोरीबोर्डिंग का परूे  प्रोडक्शन के दौरान चलते रहना कोई 

असामान्य बात नहीं ह,ै क्योंकि स्टोरी में कुछ चीज़ें बदली जा सकती हैं। स्टोरीबोर्ड  के बिना कुछ नहीं किया जाता। लगने वाला समय: 30 सेकंड के एक 

विज्ञापन में एक सप्ताह या इससे कम समय लगता ह ैऔर एक मूवी में महीनों लग सकते हैं। लगने वाली लागत: प्रति पषृ्ठ, प्रति पनैल या काम के प्रति घंटे 

के आधार पर शुल्क।

चित्र 2.3.2: स्टोरीबोर्ड

एनिमेटिक: जब स्टोरीबोर्ड  परूा हो जाता ह,ै तो अलग-अलग पनैलों को संवाद, संगीत तथा साउंड इफैक्ट्स  के साथ एडिट किया जाता ह,ै यह देखने के 

लिए कि एक मूवी के रूप में इसका प्रवाह कैसा बन रहा ह।ै इसे एनिमेटिक कहा जाता ह।ै यहां तक भी, कहानी में कुछ सुधार या बदलाव करना महँगा 

नहीं पड़ता। एनिमेटिक फाइनल एडिट के लिए ब्लूप्रिन्ट का काम करता ह ैऔर यह निर्धा रित करता ह,ै कि प्रत्येक शॉट के लिए कितनी वास्तविक 

एनिमेशन प्रोड्यजू़ करनी होगी। लगने वाला समय: पनैल्स तयैार करने और एडिट निर्माण में, मात्रा के आधार पर, कुछ दिन से लेकर कई सप्ताह लग 

सकते हैं। लगने वाली लागत: फिल्म के प्रति सेकंड/मिनट या कार्य  प्रति घंटे के शुल्क पर निर्भर ह।ै 
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चित्र 2.3.3: एनीमैटिक

पूर्व-दृश्यांकन (प्री-विजुअलाइजेशन): इसे ‘‘प्रीविज’’ भी कहा जाता ह।ै यह लागत-प्रभावी तकनीक 3D एनिमेशन, स्पेशियल इफैक्ट्स  तथा लाइव 

एक्शन फिल्म के लिए व्यापक रूप से प्रयोग की जाती ह।ै शुरूआत में ही तयैार एलीमेंट्स और फुटेज डिवलप या शटू करने की बजाय 3D स्पेस में कैमरा 

पोज़ीशंस, टाइमिग तथा मूवमेंट का सही-सही पता लगाने के लिए डिजिटल स्टैंडिग्स प्रयोग की जाती हैं। कोई भी बाधा, जो शॉट में आ सकती ह,ै उसे  

कहीं पहले ही निबटा लिया जाता ह,ै इससे पहले कि फाइनल प्रोडक्ट में उस पर बेहद थकाऊ प्रयास किये जाएं। लगने वाला समय: 30 सेकंड के एक 

विज्ञापन के लिए 2 सप्ताह से लेकर एक महीने तक का समय लग सकता ह।ै लगने वाली लागत: फिल्म के प्रति सेकंड/मिनट या कार्य  प्रति घंटे के शुल्क 

पर निर्भर ह।ै 

प्रारूप (डिजाइन): इस बिन्दु पर प्रोजेक्ट के लिए एक सिग्नेचर स्टाइल विकसित की जाती ह।ै प्री-प्रोडक्शन के चरण में डिज़ाइन कभी भी किया जा 

सकता ह ैऔर यह कैरेक्टर  से लेकर माहौल, कपड़ों, प्रॉप्स तथा वाहनों तक के लिए की जा सकती ह।ै । गाइड्स (कैरेक्टर  बाइबल की ही तरह) क्रिएट 

किये जाते हैं, जिससे आर्टिस्ट डिज़ाइन परैामीटर्स के भीतर ही एलीमेंट्स ड्रॉ या डिजिटल स्कल्प्ट कर सके। माहौल का डिज़ाइन स्थापित करने तथा 

परिवेश सेट करने के लिए कॉन्सैप्च्युअल पेंटिग की जाती हैं। लगने वाला समय: क्लाइंट द्वारा फाइनल कर दिये जाने तक ज़ारी रहता ह।ै लगने वाली 

लागत: प्रति पेज तथ्य या प्रति पेंटिग अथवा काम के प्रति घंटे के शुल्क के आधार पर 

मॉडलिंग: 2D (सीमित): सीमित 2D एनिमेशन में, कैरेक्टर  के मूल पोज़िज तयैार किये जाते हैं और फिर उन्हें कई परतों वाले एलीमेंट्स में विच छ्ेदि त किया 

जाता ह,ै जसेै सिर, मँुह, आँखें, बाँहें, टाँगें इत्यादि। ये एलीमेंट्स इस तरह से डिज़ाइन किये गये होने चाहिये, कि जब इनसे काम लिया जाये, तो ये बिल्कु ल 

सही ढंग से ओवरलपै/अतिच्छादित हों, जिससे 2D आर्टवर्क  में वास्तव में आयाम नज़र आएं। 3D: यदि प्रोडक्शन में कोई 3D एलीमेंट्स हों, तो उन्हें 3D 

सॉफ्टवेयर पकेैज के प्रयोग से मॉडल किया जाना चाहिये। मॉडल करने के कई तरीके हैं: असेंबल करके या मौज़ूदा ज्योमटै्री को नये आकारों में मोल्ड 

करके, वायर फ्रे मवर्क  तयैार करके फिर इसके ऊपर सर्फे स वबै करके/बुन कर या असली स्कल्प्चर्स को 3D स्कै नर से स्कै न करके आदि...। Stop Motion: 

स्टॉप-मोशन के लिए मॉडल्स बनाने के कई तरीके हो सकते हैं। कैरेक्टर्स  के लिए क्ले (चिकनी मिट्टी) तथा फॉर्म  की कठपुतलियां (पपेट्स) बनाई जाती 

हैं। इसके बाद फाइनल पपेट्स पर कपड़े, बाल तथा अन्य दुनियावी सामग्रियां जोड़ी जा सकती हैं। परिवेश के लिए कार्डबोर्ड  से लेकर बालसा लकड़ी और 

कुट्टी (papier mache) तक कुछ भी प्रयोग किया जा सकता ह।ै लगने वाला समय: छोटा-मोटा परिवेश तयैार करने में एक या दो सप्ताह लग सकते हैं, लेकिन 

यदि बड़ा हो तो एक महीना या इससे अधिक भी लग स‍कता ह।ै लगने वाली लागत: प्रति मॉडल या काम के प्रति घंटे के आधार पर शुल्क।
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2.3.3 प्रोडक्शन
जब एक बार स्टोरी तयैार हो जाए, डिज़ाइन परूे  हो जाएं और मॉडल्स बन जाएं, तो असल प्रोडक्शन शुरू हो सकती ह।ै यह चरण शुरू में धीमा चलता ह ैऔर 

फिर अंत तक पहंुचते-पहंुचते बहुत तेज़ हो जाता ह।ै अगर प्री-प्रोडक्शन पर पर्याप्त ध्यान दिया गया हो, तो प्रोडक्शन निर्माण के सभी चरणों के दौरान अपनी 

समय-सीमा तथा बजट संबंधी अपेक्षाओ ंपर खरा उतरेग ा।

लआेउट (खाका)

सीन लेआउट अपने स्टोरीबोर्ड  पनैल्स पर हल्के  तौर पर और अपने कॉन्सेप्चुअल इलुस्ट्रेशंस/वचैारिक चित्रणों पर निकट रूप से आधारित होते हैं। 

•	 2D: सेटिग तथा कैरेक्टर  ब्लॉकिग, दोनों के लेआउट के लिए एक हाथ से ड्रॉ किया गया बकैग्राउंड प्रयोग किया जाता ह।ै एनिमेशन, बकैग्राउंड - जो 

कि बाद में पेंट किया जाता ह ै- के परैामीटर/दायरे  के भीतर ही रहती ह।ै 

•	 3D: 3D स्पेस में एक कैमरा और स्टैंड-इन-मॉडल्स (या तयैार मॉडल्स, यदि उपलब्ध हों तो) व्यवस्थित किये जाते हैं। एनीमेटरों के लिए मज़बतू 

कम्पोज़ीशन स्थापित करने के लिए कैमरा मूव्ज़ व इसका हिलना-डुलना रोक लिया जाता ह।ै यह चरण आमतौर पर प्रीविज़ुअलाइज़ेशन के दौरान 

होता ह।ै 

•	 Stop Motion: चूंकि, कठपुतलियां वास्तविक सेट के भीतर मौज़ूद होती हैं, इसलिए उन्हें वसेै ही मंचित तथा प्रकाशित किया जाना चाहिये, जसेै किसी 

लाइव फिल्म के लिए किया जायेगा। जटिल कैमरा मूव्ज़ महँगे हो सकते हैं और इन्हें मोशन कंट्रोल सिस्टम के ज़रिये हासिल किया जाता ह।ै जब एक 

बार कैमरा पाथ तय हो जाता ह,ै तो कम्प्यूटर-नियत्रित रिग लाइव कैमरे  को, एक बार में एक फ्रे म के हिसाब से, मूव करती ह।ै यह एक Stop Motion 

सेट के भीतर डायनामिक एंगल्स उपलब्ध कराता ह।ै 

रिगिग: 

•	 2D (सीमित): कैरेक्टर  के अलग-अलग टुकड़ों मे बने अवयव (बाहें, टाँगे इत्यादि) कठपुतली की तरह सेट करने पड़ सकते हैं। उदाहरण के लिए, परै 

को टाँग के निचले हिस्से से जोड़ा जाता ह,ै जिसे फिर ऊपरी टाँग से जोड़ा जाता ह ैऔर फिर इसे पेडू (पेल्विस) से जोड़ा जाता ह।ै इन जोड़े गये अंगों में 

चलू/कीला (पिवट प्वाइंट) होना चाहिये, जिससे ये उचित बिन्दु पर घमू सकें , रोटेट कर सकें । 

•	 3D: कैरेक्टर  मॉडल जब अस्तित्व में आ जाये/तयैार हो जाये, तो इसमें हड्डियों तथा अन्य रिगिग सिस्टम सेट करने की ज़रूरत होती ह,ै जिससे इसे 

प्रयोग किया जा सके। यह सुनिश्चित करना कि 3D मेश वांछित तरीके से बेंड और फोल्ड हो, काफी पेचीदा और मेहनत का काम हो सकता ह।ै अन्य 

अवयव, जिन्हें रिगिग की ज़रूरत हो सकती ह,ै वे हैं मांस-पेशियां, बाल, कपड़े और आंखें भी। Stop Motion: क्ले या फॉर्म  से बने कैरेक्टर  को सपोर्ट 

देने के लिए मुड़ने वाली तारें  या मशीन से बने एल्यूमिनियम स्के लेटन, जिन्हें आर्मेचर्स कहा जाता ह,ै का निर्माण किया जाता ह।ै कैरेक्टर  के परैों के 

नीचे आमतौर पर नट्स लगे होते हैं, जिन्हें फिर सेट से बोल्ट कर दिया जाता ह,ै जिससे वे आराम से खड़े हो सकें  और चलते हुए संतुलित रह सकें । 

लगने वाला समय: प्री-प्रोडक्शन का यह सबसे पेचीदा पहल ूहो सकता ह,ै खासतौर से जहां बात 3D की हो। साधारण कैरेक्टर ों का ढाँचा (रिग) बनने 

में लगभग एक सप्ताह लगता ह,ै लेकिन किसी जटिल कैरेक्टर  के मामले में महीने भर से भी ज़्यादा समय लग सकता ह।ै लगने वाली लागत: प्रति 

मॉडल या काम के प्रति घंटे के आधार पर शुल्क

टकै्स्चरिंग: 

•	 2D: यह आमतौर पर सामान्य/एक सा (फ्लैट) या उतार/चढ़ाव (ग्रेडिएंट) वाला रंग होता ह,ै लेकिन कुछ एनिमेशन में कई बार, मॉडल्स के अनुरूप 

जटिल टकै्स्चर हो सकते हैं।

•	 3D: डिजिटल मॉडल्स के कई टकै्स्चर्ड  लुक हो सकते हैं। यहां तक कि इनका लुक ग्राफिक 2D भी हो सकता ह।ै टकै्सचरिंग, सॉलिड कलर से हैंड-

पेंटिड या फोटोग्राफिक इमेजरी तक, कुछ भी हो सकती ह।ै यह इमेजरी, जिसे मपै कहा जाता ह,ै को किसी भी संभाव्य सतह को सिमुलेट करने हेतु 

3D मॉडल पर प्रोजेक्ट किया जा सकता ह।ै सतह पर प्रकाश की प्रतिक्रिया (जसेै प्रतिबिब और पारभासी) कैसी रहेगी, इसे भी टकै्स्चरिंग द्वारा ही 

नियत्रित किया जाता ह।ै

•	 Stop Motion: स्टॉप-मोशन पपेट्स तथा सेट्स के लिए टकै्स्चर आमतौर पर स्कल्प्ट किया जाता ह ैया हाथ से सीधे उन्हीं पर पेंट किया जाता ह।ै

•	 लगने वाला समय: साधारण टकै्स्चरिंग, जिसमें बस चंद रंगों का ही काम होता ह,ै कुछेक मिनटों में ही बन जाती ह।ै लेकिन जटिल टकै्स्चरिंग, जसेै 

वास्तविक दिखने वाली डायनासौर की त्वचा, बनने में कई दिन लग सकते हैं।

•	 लगने वाली लागत: प्रति मॉडल या काम के प्रति घंटे के आधार पर शुल्क।
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•	 लगने वाला समय: बकैग्राउंड की जटिलता तथा कैमरा मूव्ज़ के आधार पर कुछ घंटों से लेकर कई दिनों तक का समय लग सकता ह।ै 

•	 लगने वाली लागत: प्रति ड्राइंग या प्रति घंटा कार्य  के शुल्क के आधार पर।

एनिमेशन 

•	 2D (क्लासिकल): जब एक बार सेटिग के भीतर कैरेक्टर  की पोजीशन ब्लॉक हो जाती ह,ै तो की फ्रे म ड्रॉइंग्स परूी हो जाती हैं। ये वे मुख्य पोज़िज़ 

हैं, जो कैरेक्टर  के एक्शन के चरम बिदुओ ं को स्थापित/तय करते हैं। जब इनका समय परूा हो जाता ह,ै तो मोशन को सुचारू बनाने के लिए 

इनबिटवीन्स ड्रॉ किये जाते हैं। इस स्केच  वाले एनिमेशन को “पेंसिल टेस्ट” कहा जाता ह।ै  फिर रफ एनिमेशन रे खाओ ंको साफ (स्याही से भरना) 

कर दिया जाता ह,ै पेंट किया जाता ह ैऔर उन्हें बकैग्राउंड के साथ संयोजित कर दिया जाता ह।ै शेडो व हाइलाइट्स जसैी इफैक्ट्स  एनिमेशन से इस 

प्रक्रिया में काफी समय लग सकता ह।ै क्लासिकल एनिमेशन अपनी व्यापक गति व तरलता के लिए जाना जाता ह।ै 

•	 2D (सीमित): मिनिमल ड्रॉइंग्स (कभी कभी सिर्फ  एक) को डिजिटल रूप में इस तरह से बदला जाता ह,ै जसेै कि क्लासिकल एनिमेशन की नकल 

हो। कैरेक्टर  के चेहरे  पर कई माउथ पोज़ीशंस/मौखिक मुद्राएं चिपकाई जाती हैं और लिप सिक पदैा करने के लिए इन्हें परस्पर बदला जाता ह।ै अलग-

अलग अंगुलियां शरीर से जोड़ी जाती हैं, किसी कठपुतली की तरह और फिर किरदार का अभिनय/प्रदर्शन तयैार करने के लिए इनमें कम्प्यूटर में 

हेर-फेर  की जाती ह।ै इनबिटवीन्स सॉफ्टवेयर में स्वचालित/ऑटोमटैिक ढंग से बना लिए जाते हैं, जिससे यह प्रक्रिया परम्परागत प्रक्रिया के मुकाबले 

कहीं अधिक तेज़ हो जाती ह।ै लिमिटेड एनिमेशन अपने तेज़ प्रोडक्शन समय व लागत-प्रभावशीलता के लिए जानी जाती ह।ै 

•	 3D: जब 3D कैरेक्टर  मॉडल रिग हो जाता ह,ै तो एक एनिमेटर आभासी कठपुतली की तरह इसमें हेर-फेर  करके गति पदैा कर ला सकता ह।ै 3D 

एनिमेशन में कठपुतली को नियत्रित करने के लिए XYZ कोआर्डि नेट व न्यूमेरिक स्लाइडर्स जसैी तकनीकी अवधारणाएं प्रयोग की जाती हैं। मुख्य/

की पोज़ीशंस के बीच में सॉफ्टवेयर द्वारा स्वचालित रूप से इनबिटवीन्स डाल दिये जाते हैं। 3D एनिमेशन अपनी आयामी छवि और बिल्कु ल असली 

लगने वाली क्वालिटी के लिए जानी जाती ह।ै 

•	 Stop Motion: बिल्कु ल जसेै परम्परागत एनिमेशन में एक बार में एक ही फ्रे म ड्रॉ की जाती ह,ै Stop Motion पपेट छोटी-छोटी बढ़त से चलती ह ैऔर 

एक बार में एक ही फ्रे म शॉट करती ह।ै चूंकि, यह तकनीक असल दुनिया की भौतिकी की सीमाओ ंमें बंधी ह,ै वास्तविक भौमिकी से जुड़ी ह,ै अक्सर 

किसी रिगिग या वायर को हटाना ज़रूरी हो जाता ह,ै जो किरदार को गुरुत्वाकर्षण की उपेक्षा करने वाले एक्शन कर पाने में मदद करते हैं।

•	 लगने वाला समय: आखिरकार, मोशन के जितने ज़्यादा फ्रे म होंगे, एनिमेशन को परूा होने में उतना ही समय लगेगा। यहां तक कि लागत-सक्षम 

एनिमेशन प्रोडक्शन का सबसे ज़्यादा समय लेने वाला हिस्सा हो सकती ह।ै 

•	 लगने वाली लागत: आमतौर पर फिल्म के प्रति सेकंड शुल्क के आधार पर होती ह,ै हालांकि, लिमिटेड 2D एनिमेशन प्रति ड्रॉइंग के आधार पर भी 

हो सकती हैं

रें डरिंग 

रें डरिंग का मतलब कम्प्यूटर के जरिए डिज़िटल फ्रे म्स बनाना ह।ै भले ही ज़्यादातर वीडियो-मीडिया सॉफ्टवेयर में किसी न किसी तरह की रें डरिंग की 

ज़रूरत पड़ती ह,ै मगर इस विभाग का तात्पर्य  विशिष्ट रूप से 3D एनिमेशन की रें डरिंग से ह।ै यह चरण इस बात पर निर्भर करते हुए जल्दी से हो सकता 

ह,ै कि फाइनल इमेज बनाने के लिए कम्प्यूटर को कितनी गणनाएं करनी पड़ेंगी। भारी प्रक्रियाओ ंके लिए, कम्प्यूटरों से भरी परूी की परूी बिल्डिंगें होती 

हैं जिन्हें रें डर फार्म्स कहते हैं। यह असामान्य बात नहीं ह ैकि हाई-डेफिनेशन 3D एनिमेशन के एक अकेले फ्रे म को बनाने में एक हफ्ते से भी ज़्यादा का 

समय लग जाता ह।ै 

•	 लगने वाला समय: सेकंडों से लेकर हफ्तों तक कुछ भी, जोकि इस बात पर निर्भर ह ैकि 3D सीन की गणना कितनी जटिल ह ैया तयैार इमेजेस 

कितनी बड़ी हैं। 

•	 लगने वाली लागत: प्रति GHzh शुल्क पर निर्भर ह।ै

2.3.4 पोस्ट – प्रोडक्शन
जब एनिमेशन रें डर और फिल्म प्रिंट हो जाती ह,ै तो यह फिनिशिग टच के लिए तयैार हो जाती ह।ै यह स्पेशियल इफैक्ट्स  से लेकर इमेज इन्हांस्मेंट और 

कलर करैक्शन तक कुछ भी हो सकता ह।ै फाइनल साउंड व म्यूजिक भी इसी चरण का एक हिस्सा हैं।
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इफैक्ट्स

भले ही यह ख़्याली धलू हो, एक चमकती तलवार या एक परमाणु विस्फोट, स्पेशियल इफैक्ट्स  अविश्वसनीय को हकीकत जसैा बना सकते हैं। हालांकि, 

ज़्यादातर इफैक्ट्स  आमतौर पर साधारण ही होते हैं; जसेै कि एक छोटे सेट को विस्तार देना कि वह भव्य दिखे या दिन में किये गये शटू में रात का समय 

दिखाना। 2D एनिमेशन में, आग, धुएं व पानी जसेै तत्व इफैक्ट्स  माने जाते हैं, लेकिन ऐसे ही बुनियादी शेडो व हाइलाइट्स भी हैं। इफैक्ट्स  आमतौर पर 

कम्पोज़ीटिग के साथ-साथ ही डाले जाते हैं।

•	 लगने वाला समय: कई बार 2D एनिमेशन इफैक्ट्स  ,उससे भी कम समय में ड्रॉ, इंक और कलर किये जा सकते हैं, जितना समय 3D इफैक्ट्स  को 

सेट अप तथा रें डर करने में लगता ह।ै यह वाकई में इस बात पर निर्भर करता ह ैकि इफैक्ट्स  कितने जटिल हैं और उनमें से कितनों को बनाने की 

ज़रूरत ह।ै 

•	 लगने वाली लागत: फिल्म की प्रति सेकंड या कार्य  के प्रति घंटे शुल्क पर निर्भर ह।ै

कम्पोज़ीटिंग

कम्पोज़ीटिग, आखिरकार, कई अलग-अलग इमेजेस की एक तयैार कम्पोज़ीशन में लेयरिंग करना ह।ै हालांकि, इसमें बहुत सी चीज़ें शामिल हैं। ग्रीन 

स्क्रीन रिमूवल, रोटोस्कोप मास्किंग  तथा कलर करैक्शन वे कुछ काम हैं, जो कम्पोज़ीटिग स्टेज के दौरान किये जाते हैं। चाहे आपको प्राचीन चीन के 

एक शॉट में से Volkswagen हटानी हो या हाई-डेफिनेशन फुटेज को 1930 के दशक की श्वेत-श्याम (ब्लैक एंड व्हाइट) फिल्म की तरह दिखाना हो, प्रोजेक्ट 

की फाइनल इमेज कम्पोज़ीटिग कलाकार पर निर्भर ह।ै 

•	 लगने वाला समय: अच्छी तरह प्रकाशित ग्रीन स्क्रीन फुटेज के सामने शॉट किये गये सब्जेक्ट्स  को तेज़ी से मास्क आउट किया जा सकता है

एडिटिंग

एडिटिग यह सुनिश्चित करने के लिए एनीमटैिक चरण पर शुरू होती ह ैकि शॉट्स फ्लो एक आकर्षक गति पर हो। जसेै-जसेै प्रोडक्शन आगे बढ़ती ह,ै एडिट 

को भी शॉट्स के प्रीविज़ुअलाइज़ेशन से रफ एनिमेशन, फिर फाइनल रें डर और फिर फाइनल कम्पोज़िट की ओर बढ़ने के साथ-साथ लगातार अपडेट किया 

जाता रहता ह।ै इस चरण में विज़ुअल्स के साथ साउंड इफैक्ट्स  और म्यूजि़क भी संयोजित कर दिये जाते हैं।

•	 लगने वाला समय: शुरुआत में काफी तेज़ी से होती ह ैमगर फिर भी एडिटिग परूे  प्रोडक्शन के दौरान होती रह सकती ह।ै रॉ लाइव फूटेज के कई घंटों 

को एडिट करने में कई महीने लग सकते हैं। 

•	 लगने वाली लागत: फिल्म के प्रति सेकंड/मिनट या कार्य  प्रति घंटे के शुल्क पर निर्भर ह।ै

ऑडियो

हालांकि, फाइनल ऑडियो पोस्ट तक नहीं डाला जाता, लेकिन आमतौर पर अस्थायी साउंड तथा म्यूजि़क, जिसे स्क्रैच  ऑडियो कहते हैं, एनीमटैिक में 

शामिल कर दिये जाते हैं, जिससे एडिट के लिए मूड तथा पेस (गति) सेट करने में मदद मिले। ऐसा कहा जाता ह ैकि साउंड मूवी का आधा हिस्सा होती ह ै

और इस क्षेत्र में दक्ष पेशेवरों को हायर करने से अंतिम उत्पाद की सम्पन्नता दस गुणा बढ़ जाती ह।ै फोले कलाकार साउंड इफैक्ट्स  खोजने या रचने के 

लिए उत्त‍रदायी होते हैं, कंपोज़र्स म्यूज़िकल स्कोर लिखते व बजाते हैं, और साउंड इंजीनियर्स इन सभी को सामंजस्यपरू्ण  संतुलन में मिश्रित करते हैं। 

•	 लगने वाला समय: कोई साउंड जितनी ज़्यादा निराली या दुर्लभ होती ह,ै उसे खोजने या बनाने में उतना ही ज़्यादा वक्त लगता ह।ै लिखने व  

प्रदर्शन में म्यूज़िक को घंटो से लेकर हफ्तों तक का समय लग सकता ह,ै यह कंपोज़ीशन की लंबाई व आवश्यक म्यूज़िशियनों की संख्या पर निर्भर 

करता ह।ै 

•	 लगने वाली लागत: साउंड- प्रति साउंड या कार्य  प्रति घंटे के शुल्क पर निर्भर होती ह।ै म्यूज़िक- कार्य  प्रति घंटे के शुल्क पर निर्भर होता ह।ै साउंड 

इंजीनियरिंग- कार्य  प्रति घंटे के शुल्क‍ पर निर्भर होती ह।ै कुछ सेकंड का अंतराल ताकि आप यह बेहतर ढंग से जान सकें  कि कहानी जम रही ह ै 

या नहीं।

2.3.5 एक एनिमेशन मीडियम चुनना
एनिमेशन के ज़रिये कोई भी कहानी कही जा सकती ह।ै इसका मतलब यह नहीं ह,ै कि हर कहानी एनिमेशन के जरिए ही कही जाए। यह एक समय खाने 

वाली व महंगी प्रक्रिया ह ैजिसमें सकैड़ों व्यक्ति शामिल होते हैं। इसलिए यह सुनिश्चित कर लें, कि एनिमेशन ही आपके प्रोजेक्ट को प्रस्तुत करने के लिए 

सर्वोत्तम ज़रिया ह।ै 
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एनिमेशन का माध्यम आमतौर पर तब अपनाया जाता ह ैजब किसी प्रोजेक्ट को विज़ुअलाइज़ करने का कोई और ज़रिया न हो। यह तब भी आदर्श ह ैजब 

किसी एक खास लुक की अखंडता को बरकरार रखने की कोशिश की जा रही हो, जसेै कि बच्चों की किताब में सचित्र व्याख्याएं या किसी कार्टू न 

कैरेक्टर  की सनक। जब एक बार मीडियम चुन लिया जाता ह,ै हालांकि, एनिमेशन के भीतर भी कुछ शलैियां होती हैं, जिन पर विचार किया जाना चाहिये। 

यह लघु मार्गदर्शिका ऐसी जानकारी उपलब्ध करायेगी, जिससे कुछ अन्य भ्रमित करने वाले विकल्पी छट जाएंगे।

2D- क्लासिकल: जब कोई ग्राफिक लुक पाने की कोशिश में हो, तो हाथ से बनाई या क्लासिकल 2D एनिमेशन आदर्श ह।ै कैरेक्टर  मोशन व प्रदर्शन 

हासिल करना परूी तरह से कलाकार पर निर्भर होता ह।ै चूंकि, मोशन का हरे क फ्रे म हाथ से बना होता ह,ै एनिमेशन में कुदरती एहसास आता ह ैऔर यह 

तकनीकी बाधाओ ंकी दया पर निर्भर नहीं रहती। क्लासिकल एनिमेशन के लिए प्रोडक्शन किसी अन्य स्टाइल/शलैी के मुकाबले कहीं तेज़ी से शुरू होता 

ह,ै क्योंकि कैरेक्टर  ड्रॉ किए जाते हैं, न कि निर्मित या रिग किये जाते हैं। प्रोडक्शन धीमा हो जायेगा, हालांकि, इनबिटवीन, इंक तथा पेंट के चरणों के 

दौरान। क्लासिकल एनिमेशन समय खाने वाली प्रक्रिया ह ैऔर इसमें कई लोग शामिल होते हैं, इसलिए इसे बनाना महंगा ह।ै 

लिमिटडे: जब किसी प्रोजेक्ट का बजट सीमित होता ह ैऔर इसे कार्टू नी स्टाइल की ज़रूरत होती ह,ै तो लिमिटेड 2D एनिमेशन आदर्श ह।ै कलाकारों के 

लिए कम्प्यूटर सॉफ्टवेयर स्वचालित ढंग से इनबिटवीन की गई सिगल ड्रॉइंग्स में हेर-फेर  करना संभव बना देता ह,ै जिससे ये क्लासिकल एनिमेशन का 

आभास दें। क्योंकि यह तकनीक परूी तरह से सिगल ड्रॉइंग के आकर्षण पर निर्भर करती ह,ै इसलिए व्यक्तिगत कला तत्वों पर आमतौर से ज़्यादा समय 

खर्च होता ह।ै लिमिटेड एनिमेशन के लिए प्रोडक्शन क्लासिकल एनिमेशन के मुकाबले काफी धीमे शुरू होता ह।ै कैरेक्टर ों को आमतौर पर एनिमेशन शुरू 

करने से पहले इंक, कलर तथा रिग करने की ज़रूरत पड़ती ह ैऔर इसमें शामिल कला के लिए ढेर सारी योजनाओ ंऔर आयोजनों की ज़रूरत होती ह,ै 

जिससे इससे अधिकतम लाभ हो। जब एक बार तत्व परूे  व संगठित हो जाते हैं, तो प्रोडक्शन क्लासिकल एनिमेशन के मुकाबले काफी तेज़ी से चलेगा। 

लिमिटेड एनिमेशन में कुछ ड्रॉइंग्स की ज़रूरत पड़ती ह ैजिनमें डिज़िटल तौर पर हेर-फेर  की जा सकती ह,ै इसलिए इसे बनाना तेज़ व लागत-सक्षम ह।ै 

किसी भी 2D एनिमेशन की रें डरिंग आमतौर पर 3D के मुकाबले काफी तेज़ी से होती ह ैक्योंकि इसमें कोई भी जटिल ज्यामितीय गणनाएं शामिल नहीं 

होती। हालांकि, कभी-कभी कई 2D इमेज लेयर्स कम्पोज़िट रें डर को किसी 3D सीन के मुकाबले काफी देर तक उलझा सकती हैं।

2.3.6 एनिमेशन की तकनीकें

स्थिर इमेजों के क्रम, जोकि एक दूसरे  से मामूली रूप से ही भिन्न होती हैं, के त्वरित प्रदर्शन के माध्यम से मोशन और आकार परिवर्तन का भ्रम पदैा करने 

की प्रक्रिया एनिमेशन ह।ै भावनाओ ंके मुख्य प्रकार: 

1.	 ट्रेडिशनल एनिमेशन

2.	 2D Vector आधारित एनिमेशन

3.	 3D कम्प्यूटर एनिमेशन

4.	 मोशन ग्राफिक्स

5.	 Stop Motion

6.	क्ले मोशन 

7.	 कठपुतलियां

8.	 कटआउट्स

9.	 Silhouette

10.	 एक्शन चित्र/लेगो

11.	 Pixelation

ट्रेडिशनल एनिमेशन 

परम्परागत एनिमेशन में, एनिमेटर, स्टैंड पर जुड़े एक पारदर्शी कागज के टुकड़े पर रंगीन पेंसिल से इमेजेस ड्रॉ करें गे, एक बार में एक फ्रे म। एनिमेटर 
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चित्र 2.3.4: ट्रेडिशनल एनिमेशन

आमतौर पर बहुत रफ कैरेक्टर्स  के साथ एनिमेशन का परीक्षण करें गे यह देखने के लिए कि 

एक्शन को अच्छी तरह से समझाने के लिए उन्हें कितने फ्रे म ड्रॉ करने की ज़रूरत पड़ेगी। 

परम्परागत एनिमेशन में, टाइमिग बेहद महत्वपरू्ण  ह,ै क्योंकि फ्रे म्स को साउंडट्रैक्स के साथ 

एकदम फिट बठैना होता ह,ै इस तरह परम्परागत एनिमेशन की एनिमेशन प्रक्रिया लंबी व 

महंगी हो सकती ह।ै जब क्लीन-अप व इनबिटवीन परूा हो जाता ह,ै तो प्रोडक्शन, हरे क पथृक 

फ्रे म की फोटोग्राफिग वाले चरण में चली जाएगी। 

परम्परागत एनिमेशन मूवीज़: स्नो व्हाइट एंड दि सेवन ड्वार्फ्स, पीटर पनै, और स्लीपिग 

ब्यूटी, अलादीन

2D एनिमेशन

2D एनिमेशन से तात्पर्य  ज़्यादातर किसी की फ्रे म एनिमेशन से होता ह,ै जो किसी समतल 

सतह पर बनी हो, लेकिन इसका तात्पर्य  vector एनिमेशन से भी हो सकता ह,ै जिसमें 

परम्परागत एनिमेशन की तकनीकें  अपनाई गई हों।

Vector आधारित एनिमेशन, अर्थात् कम्प्यूटर से तयैार 2D एनिमेशन, में बिल्कु ल परम्परागत 

एनिमेशन जसैी ही तकनीकें  प्रयोग की जाती हैं, बस फायदा यह ह,ै कि इसमें परम्परागत 2D 

एनिमेशन की तरह कम्प्यूटर के अलावा कोई और भौतिक वस्तुएं नहीं चाहिये होती।

3D एनिमेशन (CGI, कम्प्यूटर एनिमेशन)

3D एनिमेशन परम्परागत एनिमेशन के मुकाबले बिल्कु ल अलग तरह से काम करती ह।ै इन 

दोनों में ही मूवमेंट व कंपोज़ीशन के समान सिद्धांतों की समझ की ज़रूरत पड़ती ह,ै लेकिन 

प्रत्येक काम के लिए आवश्यक तकनीकी योग्यता बिल्कु ल भिन्न ह।ै जहां एक ओर पहले 

आपको एनिमेटर होने के लिए एक अच्छा ड्राफ्ट्स मनै होना बेहद ज़रूरी था, कम्प्यूटर 

एनिमेशन के साथ अब ऐसा कोई ज़रूरी नहीं ह।ै 3D एनिमेशन ड्रॉइंग की बजाय कठपुतलियों 

को नचाने से ज़्यादा मिलती-जुलती ह।ै

मोशन ग्राफिक्स (टाइपोग्राफी, एनीमेटिड लोगो)

हालांकि इसे अभी भी एनिमेशन की एक फॉर्म  माना जाता ह,ै मोशन ग्राफिक्स अन्य प्रकार की 

एनिमेशन से बिल्कु ल अलग ह।ै ज़्यादातर इसलिए क्योंकि हमारी सचूी की अन्य प्रकारों से 

अलग, यह कैरेक्टर  या स्टोरी से नहीं चलती। यह ग्राफिक्स तत्वों या टेक्स्ट की रचनात्मक 

ढंग से चलाने की कला ह,ै आमतौर पर ऐसा वाणिज्यिक या प्रचार के उद्धेश्य से किया जाता 

ह।ै एनीमेटिड लोगोज़, एक्सप्लेनर वीडियोज़, एप कमर्शियल, टेलीविज़न प्रोमोज़ या यहां तक 

कि फिल्म के शुरुआती टाइटल्स के बारे  में सोचें।

मोशन ग्राफिक्स समतल-आधार वाली इमेज या 3D ऑब्जेक्ट मात्र होते हैं, जिनमें म्यूजिक तथा साउंड इफैक्ट्स  के साथ गति का भ्रम पदैा किया जाता ह।ै 

यह तकनीक अक्सर मल्टीमीडिया प्रोजेक्टस के लिए इस्तेमाल की जाती ह।ै

चित्र 2.3.5: 2D एनिमेशन

चित्र 2.3.6: 3D एनिमेशन

चित्र 2.3.7: मोशन ग्राफिक्स
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Stop Motion 

Stop Motion किसी वस्तु (ऑब्जेक्ट) की फोटो लेकर, फिर इसे थोड़ा सा सरका-कर फिर से फोटो लेने की प्रक्रिया ह।ै यह प्रक्रिया दोहराई जाती ह ैऔर जब 

इन फोटो को एक के बाद प्ले, किया जाता ह,ै तो ये मूवमेंट/गति होने का भ्रम पदैा करती हैं। यह परम्परागत एनिमेशन के समान ही ह,ै लेकिन इनमें ड्रॉइंग 

की बजाए असली सामग्रियों/वस्तुओ ंका इस्तेमाल किया जाता ह।ै

Stop Motion एनिमेशन का तात्पर्य  किसी भी उस एनिमेशन से ह,ै जिसमें एनीमेटिड एक्शन 

पदैा करने के लिए वस्तुओ ंकी एक क्रम में तसवीरे  ली जाती हैं। 

Stop Motion एनिमेशन की प्रक्रिया बहुत लंबी ह,ै क्योंकि हरे क वस्तु को सावधानीपरू्वक इंच 

दर इंच सरकाना पड़ता ह,ै और एनिमेशन का प्रवाह क्रम रचने के लिए हर बदलाव की फोटो 

ली जाती ह।ै

क्लेमेशन

क्लेमेशन बेहद लोकप्रिय फॉर्म  में से एक ह।ै क्ले या प्ले-डो कैरेक्टर , जिनमें एनिमेशन के लिए 

आसानी से हेर-फेर /जोड़-तोड़ की जा सकती ह,ै के साथ काम करना। एडवांस क्लेमेशन, 

(जसेै द नेवरहुड या आर्मिक्रॉग) में, अधिक ठोस रिग्स के लिए, धातु के ढांचों का इस्तेमाल 

किया जाता ह,ै जिन पर फिर क्ले चढ़ाई जाती ह।ै

कठपुतलियां

कुछ एनिमेटर क्ले वाली कठपुतलियों की आम/नियमित कठपुतलियां इस्तेमाल करते हैं, ये 

भी आमतौर पर किसी प्रकार स्कै लेटन रिग ठोस पर निर्मित होती हैं। अभिव्यक्ति के आधार पर 

कैरेक्टर ों के चेहरे  बदले, या रिग के भीतर ही नियत्रित किए जा सकते हैं।

कट-आउट

Stop Motion की एक और लोकप्रिय फॉर्म  ह,ै कट-आउट। कंस्ट्रक्शन पेपर या कार्डबोर्ड  

कैरेक्टर्स  का इस्तेमाल करके, उन्हें पेपर पर रख कर ऊपर से एनिमेशन शटू की जाती ह ै

(कम्प्यूटर के प्रयोग में आने से पहले साउथ पार्क  इसी तरह बनाई गई थी)। फिर कार्डबोर्ड  को 

हरे क फ्रे म में थोड़ा सा सरकाया जाता ह,ै जिससे मूवमेंट/गति का भ्रम हो। 

चित्र 2.3.9: क्लेमेशन

चित्र 2.3.10: कठपुतलियां

चित्र 2.3.11: कट-आउट

चित्र 2.3.8: Stop Motion 
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Silhouette

कट-आउट एनिमेशन के समान ही, silhouette एनिमेशन में कार्डबोर्ड  या किसी तरह की 

समतल सामग्री का इस्तेमाल होता ह,ै मगर वस्तुएं परूी काली होती हैं और शॉट सिर्फ  

silhouette से लिए जाते हैं। यह Stop Motion की प्राचीनतम फॉर्म  में से एक ह ैऔर आज 

विरले ही इस्तेमाल होती ह।ै

2.3.7 पर्यवेक्षण/गौर करना, अभिनय और भाव प्रकट करना

विश्वसनीय एनिमेशन बनाने के लिए स्वाभाविक तथा विश्वसनीय भावनाएं रचना आवश्यक ह।ै  अच्छा एनिमेटिड भाव दृश्य में कहीं अधिक नाटकीयता 

भर सकता ह,ै और एनिमेटिड फिल्म देखने वाले लोगों में रुचि पदैा कर सकती ह।ै भावना सिर्फ  कार्टू न कैरेक्टर  की भाव-भंगिमाओ ंमें ही निहित नहीं होती 

ह ैबल्कि हाव-भावों में भी निहित होती ह।ै

एनिमेशन में भावना का संचार करने का एक तरीका यह सुनिश्चित करना ह,ै कि हम एक विचारशील कैरेक्टर  बना रहे हैं। यह धारणा दर्शकों तक 

पहँुचाना बेहद महत्वपरू्ण  ह,ै कि एनिमेटिड कैरेक्टर  के एक्शन तथा मूवमेंट उसके विचारों से ही प्रेरित होते हैं। क्लासिकल कार्टू न एनिमेशन का एंटीसिपेशन 

सिद्धांत 2D के साथ-साथ 3D परिवेश में भी विश्वसनीय तथा भावनात्म्‍क एनिमेशन तयैार करने के लिए प्रयोग किया जा सकता ह।ै

•	य ह ज़रूरी ह,ै कि बॉडी मूवमेंट क्रिएट करने से पहले आंख व सिर मूवमेंट प्रिपरे शन क्रिएट की जाएं। आंखें पहले मूव होनी चाहिएं, क्योंकि यही शरीर 

की आगामी हरकत के लिए जवाबदेह होती हैं/ क्योंकि यही शरीर की आगामी हरकत का इशारा देती हैं और किरदार के मन, विचार तथा भावनाओ ं

का आईना होती हैं। 

•	 दूसरे  नम्बर पर आती ह,ै सिर की मूवमेंट। अगर एनिमेशन के इस सिद्धांत का पालन नहीं किया जाता, और ब़ॉडी, सिर व आंखों से पहले हिलती ह,ै 

तो action कैरेक्टर  द्वारा शुरू किया हुआ नहीं लगेगा बल्कि किसी और ताकत द्वारा किया हुआ लगेगा और यह कैरेक्टर  के शुरुआती विचारों का 

विरोध करता प्रतीत होगा। एक विचारशील पात्र का सजृन, किसी किरदार में जान डालने का पहला कदम ह।ै 

चित्र 2.3.14: Pixelation

चित्र 2.3.12: Silhouette

एक्शन चित्र/लगेो

कुछ एनिमेशन के लिए एक्शन चित्र या Lego कैरेक्टर्स  का भी इस्तेमाल करते हैं। यह शलैी 

YouTube पर काफी लोकप्रिय ह ैऔर कई चनैल Lego कैरेक्टर्स  के साथ मज़ेदार बनाते हैं। 

Robot Chicken इसका एक बढ़िया उदाहरण ह।ै वे पॉप कल्चर का मजाक उड़ाने के लिए 

मशहूर एक्शन चित्र का इस्तेमाल करते हैं।
चित्र 2.3.13: एक्शन चित्र

Pixelation

Pixelation, Stop Motion की एक फॉर्म  ह ैजिसमें काल्पनिक वीडियो बनाने के लिए असल 

लोगों व असल माहौल का इस्तेमाल होता ह।ै यह स्टिल फोटो लेने, चीज़ों के इर्द -गिर्द  घमूने, 

और फिर अन्य फोटो लेने वाले, Stop Motion तरीके का इस्तेमाल करता ह,ै मगर subject 

matter आमतौर पर कठपुतलियों की बजाए असल व्यक्ति होते हैं।
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•	भ ावनाएं हरे क एक्शन के होने में लगने वाले समय को भी तय कर सकती हैं। एक खुश कैरेक्टर  एक उदास व्यक्ति के मुकाबले हरे क मूवमेंट व 

एक्शन तेज़ गति से करेग ा।

•	भ ाव-भंगिमाएं एनिमेशन में भावनाएं व्यक्त/सम्प्रेषित करने में एक अहम भमूिका भी निभाती हैं। भावनाओ ं की अभिव्यक्ति में चेहरे  के जो हिस्से 

शामिल होते हैं इस प्रकार हैं: आंखें, भौहें व मंुह।

•	 ज़्यादा यथार्थवादी व जीवंत आंखें रचने के लिए यह याद रखना महत्वपरू्ण  ह ै कि उनकी सतह हमेशा नम हो और उनमें चमक हो/ वे प्रकाश को 

प्रावर्तित करें  और यह बात आंखों की सतह के लिए प्रयोग की गई सामग्री ह या आंखों की ड्रॉइंग में झलकनी ज़रूरी ह।ै

•	भ ौहें भी सम्प्रेषण व भावनात्मक अभिव्यक्ति में एक महत्वपरू्ण  भमूिका निभाती हैं। उठी हुई भौहें अक्सर आश्चर्य व विस्मय के साथ-साथ अनिश्चितता 

व भ्रम की संकेतक होती हैं।

•	 झुकी हुई भौहें कपट या नाराजगी की संकेतक होती हैं। भौहें गुस्सा, उदासी, डर व अन्य विभिन्न भावनाएं, जिन्हें मानव शरीर सम्प्रेषित कर सकता 

ह,ै को ज़ाहिर कर सकती हैं।

यह समझना महत्वपरू्ण  ह ैकि जिस दुनिया में हम रहते हैं उसमें अधिकतर संवाद मौखिक नहीं होता। एक एनिमेटर एनिमेशन में भावनाओ ंकी भमूिका को 

समझने के लिए बाध्य ह,ै याद रखें कि शरीर का लगभग हरे क हिस्सा सम्प्रेषण/भावनाओ ंकी अभिव्यक्ति के लिए इस्तेमाल किया जा सकता ह ैऔर कार्टू न 

कैरेक्टर्स  को एनीमेट करने की प्रक्रिया में इस ज्ञान का इस्तेमाल करें ।

2.3.8 बौद्धिक संपदा अधिकार

बौद्धिक संपदा (IP) का संदर्भ दिमाग की रचनाओ ंसे ह,ै जसेै खोजें; साहित्यिक या कलात्मक कार्य; डिज़ाइन और वाणिज्य में प्रयोग होने वाले चिन्ह, नाम 

तथा छवियाँ/तस्वीरें । बौद्धिक संपदा में 2 भिन्न रूप शामिल हैं: 

•	 वह संपदा जो मानव बुद्धि से पनपती ह।ै

•	 मानव रचना व कलात्मक कार्य  का उत्पाद  

साहित्यिक व कलात्मक कार्य: ये हैं किताबें, पेंटिग, म्यूज़िकल कंपोज़ीशन, नाटक, मूवी, रेडिय ो/टीवी प्रोग्राम, प्रदर्शन तथा अन्य कलात्मक कार्य  और ये 

कॉपीराइट द्वारा सुरक्षित रखे जाते हैं।

औद्योगिक संपदा: यह एक भौतिक पदार्थ  को व्याख्यायित करता ह ैजो वाणिज्यिक उद्देश्य के लिए किसी विचार या धारणा का उत्पाद ह।ै ये निम्न द्वारा 

सुरक्षित हैं:

•	 पेटेंटेड वस्तुएं 

•	 ट्रेडमार्क

•	 औद्योगिक डिज़ाइन

•	 ट्रेड सीक्रे ट 

•	 लेआउट-डिज़ाइन 

•	भ ौगोलिक संकेत।  

यह सजृनकर्ता  या स्वामी के अधिकारों की रक्षा इस प्रकार करता ह,ै कि दूसरे  उनके कार्य/कृतियों को बिना उनकी आज्ञा के इस्तेमाल नहीं कर सकते। 

इन सभी से जुड़े  अधिकारों को लाइसेंस, हस्तांतरित या दस्तावेज़ीकरण करने की आवश्यकता होती ह,ै जिससे निर्माता/प्रोड्यजू़र - सजृनात्मक विचारों/

क्रिएटिव आइडियाज़ को एक विपणन योग्य अवधारणा में बदलने के लिए उत्तरदायी व्यक्ति फिल्म के स्वामित्व का दावा कर सके, फिल्म बनाने के लिए 

आवश्यक धन जुटा सके और वितरण अधिकार लाइसेंस कर सके।

यह एक अच्छी स्टोरी या स्क्रिप्ट की तलाश से शुरू होता ह।ै आदर्श तौर पर, निर्माता को एक स्क्रिप्ट मिलेगी, जो कि शटू के लिए तयैार होगी, तगर 

आमतौर पर स्क्रीनप्ले बनाने के लिए एक पेशेवर स्क्रीनराइटर की सेवाएं ली जाती हैं। स्क्रिप्ट कोई नया काम हो सकती ह ैया किसी मौज़ूदा कृति, जसेै 

कोई उपन्यास, नाटक या कॉमिक बुक पर आधारित हो सकती ह।ै

स्क्रिप्ट को अपने आप में हमेशा एक मूल रचना माना जाता ह ैजिससे IP अधिकार जुड़े होते हैं। निर्माता फिल्म के लिए एक छोटा कथात्मक चित्रफलक 

रचने के लिए और एक पहला ड्राफ्ट तयैार करने के लिए किसी पटकथा लेखक/स्क्रिप्ट राइटर को काम पर रखता ह।ै अग्रीमेंट/सहमति पत्र में यह भी स्पष्ट 
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टिप्पणियां 
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___________________________________________________________________________________

किया हुआ हो सकता ह,ै तय किये गये शुल्क पर कितने और ड्राफ्ट, री-राइट्स या परिष्करण होंगे। लेखक के अनुबंध की काननूी स्थिति मौज़ूदा 

कॉपीराइट और संबंधित अधिकार काननूों के हिसाब से अलग-अलग हो सकती ह।ै

अगर मूवी या एनिमेशन किसी मौजदूा काम पर आधारित ह,ै तो निर्माता आगे बढ़ने से पहले इस सामग्री को प्रयोग करने के अधिकार हासिल करने हेतु 

एक विकल्प इकरारनामा निकालेगा। एक विकल्प इकरारनामा कहता ह ैकि उल्लिखित काम - स्क्रिप्ट, पुस्तक, लेख या लघु कथा - का स्वामी प्रोड्यजू़र 

को एक निर्धा ारित समय के लिए एक फिल्म अथवा एनिमेशन का निर्माण करने हेतु अधिकार प्रदान करता ह।ै

अगर फिल्म या एनिमेशन बनती ह ै(और विकल्प पर अमल होता ह)ै तो उस काम को फिल्म में उपयोग करने के ज़ारी/चाल ूअधिकारों के लिए कॉपीराइट 

मालिक को एक तय किये गये शुल्क का भुगतान किया जाता ह।ै एक अधिकार क्रय इकरारनामे पर आमतौर से उसी समय स्क्रीनप्ले अधिकारों, टीवी 

अधिकारों को सुरक्षित करने के लिए और होम वीडियो व न्यू मीडिया जसेै सहायक बाजारों में रिलीज़ करने के अधिकार हासिल करने के लिए शर्तें तय 

करने हेतु भी मोलभाव हो जाता ह।ै
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3. उपकरणों और सामग्रियों 
का प्रबंधन करना

यनूिट 3.1- Hookup Poses व एनिमेशन क्रिएट करें /रचें

यनूिट 3.2 - प्रदर्शन निखारने के लिए कैमरा एंगल्स का इस्तेमाल करें

MES/N 3502
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इस मॉड्यलू के अंत में, आप निम्न में सक्षम होंगे:

1.	 रिसर्च करने ऐसे कैरेक्टर  संदर्भ प्राप्त करने में, जो डिज़ाइन के लिए सहायक व प्रेरक साबित हों।

2.	 विज़ुअलाइज़ेशन तथा डिज़ाइनरों द्वारा तयैार कॉन्सेप्ट आर्ट वर्क , कल्पना से बनी ड्रॉइंग्स, अभिनय तथा प्रदर्शन से मिले संदर्भों का प्रयोग करके 

प्रोडक्शन के लिए क्रिएटिव कॉन्सेप्ट तथा आइडियाज़ तयैार करने में।

3.	 ऐसी कार्य-उत्पाद शलैी पर सहमत होने में, जो कार्यक्रम व शो की आवश्यकताओ ंके साथ परूे  तालमेल में हो और लक्ष्य दर्शक वर्ग को सर्वाध िक 

आकर्षक लगे।

निष्कर्ष 
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यूनिट 3.1: Hookup Poses व एनिमेशन रचें/क्रिएट करें

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 अभिनय व भाव प्रकट करने में।

2.	 Hookup poses व एनिमेशन की रचना करने में।

3.1.1 एनिमेशन के मौलिक सिद्धांत

हूक-अप पोज़ वह गोंद ह ैजो कार्टू नों को एक साथ जोड़े रखता ह।ै । लेकिन जब आप किसी एक (या एक से ज़्यादा) कैरेक्टर  के साथ एक सीन परूा करके 

उन्हीं कैरे टर्स के साथ दूसरे  सीन में जाते हैं, तब आप पोज़िज़ को हूक-अप (जोड़ते) करते हैं। इसका मतलब यह ह,ै कि पहले सीन के आखिरी फ्रे म में 

कैरेक्टर  का पोज़ और अगले सीन के पहले फ्रे म में उस कैरेक्टर  का पोज़ आपस में मेल खाना चाहिये।

कार्टू न में, हम एनीमेट करने से पहले एडिट करते हैं। यह सुनिश्चित करना स्टोरीबोर्ड  का काम होता ह ैकि कार्टू न में निरतरता संबंधी कोई त्रुटि न हो। 

इनकी बार-बार समीक्षा की जाती ह ैऔर ये कई विभिन्न लोगों द्वारा देखे जाते हैं। जब एनिमेशन शुरू हो (हम उम्मीद करते हैं) तो कोई भी गलती नहीं 

होनी चाहिए।

एक एनिमेटेड सीरीज़ में, कई अलग-अलग सीनों पर कई अलग-अलग एनिमेटर काम करते हैं। वे उन पर पंक्तिबद्ध रूप से (क्रोनोलॉजिकल ऑर्डर) में काम 

नहीं करते हैं या क्या वे एक दूसरे  के सहारे  रहते हैं, कि कैसे परूा शो बिना किसी त्रुटि के तयैार हो जाये/या क्या वे यह देखने के लिए एक-दूसरे  की कमियां 

निकालते रहते हैं, कि शो बिना किसी कमी के परूा हो पायेगा कि नहीं। यहीं पर ‘हूक-अप’ काम आता ह।ै हूक-अप पोज़ वह गोंद ह ैजो कार्टू नों को एक 

साथ जोड़े रखता ह।ै अगर एक (या अधिक) कैरेक्टर  एक बिल्कु ल अलग सीन से आते हैं, तो हूक-अप की ज़रूरत नहीं होती। लेकिन जब एक (या अधिक) 

कैरेक्टर  के साथ एक सीन परूा होता ह ैऔर अगला सीन भी उन्हीं कैरेक्टर्स  के साथ ह,ै तो हूक-अप की ज़रूरत होती ह।ै इसका मतलब यह ह,ै कि पहले 

सीन के आखिरी फ्रे म में कैरेक्टर  का पोज़ और अगले सीन के पहले फ्रे म में उस कैरेक्टर  का पोज़ आपस में मेल खाना चाहिये।

उदाहरण के लिए कार्टू न मूवी ‘The Little Mermaid’ का हूक-अप पोज़ दिया गया ह:ै सबसे पहले निरतरता संबंधी त्रुटियों से बचें जो कि live-action फिल्मों 

के समान ही होती हैं। जसेै कि:

चित्र 3.1.1(a): हूक-अप पोज़ चित्र 3.1.1(b): हूक-अप पोज़ - त्रुटियां

यूनिट के उद्देश्य  
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उसके नंगे परैों को करीब से दिखाते हैं/सीन समाप्त हुआ तो वह नंगे परै ह।ै अगले सीन में 

जहां लोग प्रतिक्रिया दे रहे हैं, उसकी आवाज़ वापस आ जाती है

जतेू! इसके लिए कोई भी तार्कि क बहाना नहीं ह।ै यह बस एक गलती ह।ै 

सीखने लायक पाठ: हमेशा सीन के क्रम में किसी भी मॉडल/वार्डरोब के बदलाव को 

स्टोरीबोर्ड  में अंकित करें । इसकी बड़ी आसानी से अनदेखी हो सकती ह।ै यहां एक और 

उदाहरण ह।ै

यहां इस खास सीन का अंत ह।ै Ariel और Ursula के पोज़ पर ध्यान दें।

यह अगले सीन का पहला पोज़ ह।ै यह बढ़िया हूक-अप नहीं ह,ै मगर करीबी ह।ै Ursula दांत 

पीसती हुई होनी चाहिए और Ariel की आंखे बंद होनी चाहिए। यह इतना तेज़ी से होता ह ैकि 

आप ध्यान नहीं देते।

सीन जारी रहता ह ैऔर Ursula समुद्र में कूदने के लिए हरकत करती ह।ै ध्यान दें, कि Ariel 

कपड़े पहने हुए ह ै(लेकिन एक जलपरी ह)ै।

इसके अगले सीन में में Erik रे ल के पास जा रह ह ैऔर झुकता ह।ै

चित्र 3.1.1(c): हूक-अप पोज़ - त्रुटियां

चित्र 3.1.1(d): हूक-अप पोज़ - त्रुटियां

चित्र 3.1.1(e): हूक-अप पोज़ - त्रुटियां

चित्र 3.1.1(f): हूक-अप पोज़ - त्रुटियां

चित्र 3.1.1(g): हूक-अप पोज़ - त्रुटियां

चित्र 3.1.1(h): हूक-अप पोज़ - त्रुटियां
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फिर अगले सीन में पानी के नीचे Ursula Ariel को अपने पीछे  खींच रही ह।ै ध्यान दें, कि Ariel ने अब कपड़े नहीं पहने हुए ह।ै यहां इसका एक तार्कि क 

कारण हो सकता ह,ै कि उसने कपड़े नहीं पहने।  हो सकता ह,ै वे पानी में उतरने के दौरान गिर गए होंगे, जब हमारा ध्यान Erik पर था। आदर्श तौर पर, 

अगर वे कपड़ों को स्क्रीन के बाएं शीर्ष  पर तरै कर दूर जाते हुए दिखा देते, तो सीन बहुत अच्छा बन पड़ता। कपड़ों को छोड़ ही देना एक अच्छा ‘धोखा’ ह।ै 

सीखने लायक पाठ: ‘तार्कि क धोखे’ अच छ्े  हैं जब वे सही ढंग से किए गए हों।

अधिक हूक-अप्स

Ariel पहली बार महससू करती ह ैकि उसके पास पैंट्स नहीं ह,ै टांगे हैं

वह अपना परै उठाना शुरू करती ह।ै

यहां एक हूक-अप पोज़ ह ै(एक्शन नोट्स में इसे आप ‘स्टार्ट  पोज़’ भी कह सकते हैं)। फिर से यह 

बढ़िया नहीं ह ै(हम पंजे देखते हैं) लेकिन इससे बस काम चल जाता ह।ै

यहां सीन का असल एक्शन ह ै– उसका अपना परै उठाना पर अगर हम यहां शुरू करते हैं, तो 

यह पहले के विस्तारित शॉट से मेल नहीं खाएगा। समझ आ रहा ह?ै

वह अपने पंजे हिलाती ह ैहंसती ह,ै फलां फलां फलां और फिर Scuttle की आवाज पर स्क्रीन से 

बाहर की ओर देखती ह।ै

सीन खत्म होता ह ैऔर देखें कि उसके पोज़ कैसे हूक-अप करते हैं। दो अन्य छोटे शख्स मायने 

नहीं रखते क्योंकि वे पहले की सीन में नहीं थे। हमें सिर्फ  Ariel के पोज़ से मतलब ह।ै यह सिर्फ  

चंद फ्रे मों के लिए ह।ै

चित्र 3.1.2(b): हूक-अप पोज़ - त्रुटियां

चित्र 3.1.2(c): हूक-अप पोज़ - त्रुटियां

चित्र 3.1.2(d): हूक-अप पोज़ - त्रुटियां

चित्र 3.1.2(e): हूक-अप पोज़ - त्रुटियां

चित्र 3.1.2(f): हूक-अप पोज़ - त्रुटियां

चित्र 3.1.2(a): हूक-अप पोज़ - त्रुटियां
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फिर Scuttle उसकी ओर उड़ता हुआ आता ह।ै

कैमरा थोड़ा सा सरकता ह ैक्योंकि वह उसकी टांग पर उतरना *शुरू* करता ह।ै

हूक-अप /स्टार्ट  पोज़ देखें। ध्यान दें, कैसे Ariel और Scuttle वास्तव में समान अवस्था में हैं।

और इसलिए वह उतरता ह।ै ज़्यादा एक्शन, ज़्यादा फलां फलां। दोबारा, यह पहला pose नहीं हो सकता क्योंकि पिछले सीन में वह अभी तक उतरा नहीं था। 

तो, लीजिये आपके सामने आता ह,ै हूक-अप. उम्मीद करता हँू, इसका कोई तुक बना होगा। अगर आपके मन में कोई सवाल ह,ै तो उन्हें बेझिझक टिप्पणियों 

में लिख छोड़ें ।

टिप्पणियां 

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________

चित्र 3.1.2(g): हूक-अप पोज़ - त्रुटियां

चित्र 3.1.2(h): हूक-अप पोज़ - त्रुटियां

चित्र 3.1.2(i): हूक-अप पोज़ - त्रुटियां
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यूनिट 3.2: प्रदर्शन निखारने के लिए कैमरा एंगल्स का इस्तेमाल करें

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 प्रदर्शन निखारने के लिए कैमरा एंगल्स का इस्तेमाल करना सीखने में

2.	 विभिन्न प्रकार के कैमरा शॉट्स को पहचानने में।

3.2.1 कैमरा पोज़ीशन

यूनिट के उद्देश्य  

किसी स्क्रिप्ट को प्रस्तुत/व्याख्या करने के दौरान सबसे पहली चीज़, जो किसी फिल्म-निर्माता को ध्यान में रखनी चाहिये, वह ह ैकैमरा की प्लेसिग तथा 

फ्रेमि ग। तीन बुनियादी कैमरा पोज़ीशंस होती हैं - वाइड शॉट, मिड शॉट तथा क्लोज़-अप इनके सकैें ड्री शॉट्स हैं - अल्ट्रा वाइड शॉट तथा एक्स्ट्रीम क्लोज़-

अप। इन बुनियादी अवधारणाओ ंको ध्यान में रख कर एक फिल्म-निर्माता एक सीक्वेंस को काफी नाटकीय तथा सशक्त बना सकता ह।ै

3.2.1.1 अल्ट्रा-वाइड शॉट
कभी कभी, एक फिल्म या एक नई सीक्वेंस की ओपनिग/शुरुआत में, यह आवश्यक होता ह ैकि कैरेक्टर  के संबंध में स्के ल/माप तथा प्रोपोर्शन/अनुपात 

का एक अतिरजित भाव देना पड़ता ह।ै उदाहरण के लिए,पश्चिम की ओपनिग, ज़्यादा प्रभावशाली ह ैअगर हम देखें कि मुख्य कैरेक्टर  घास के मदैानों, 

जंगलों व बर्फ  से ढके पहाड़ों विशाल भभूाग से होकर गुजरता ह ैजसेै कि वह बमुश्किल ही अहमियत रखता हो। एक अति-विस्तारित शॉट में, हमें लगता 

ह,ै कि सेटिग कैरेक्टर  पर हावी हो रही ह ैऔर इसके चलते कैरेक्टर  बौना प्रतीत होता ह।ै डायरेक्टर  डेविड लीन की कुछ शानदार महाकाव्य मूवीज़ में 

बेहतरीन अल्ट्रा-वाइड शॉट दिखाई देते हैं, जहां उसकी फिगर्स/उसके कैरेक्टर्स  अपने व्यापक रूप से विस्तृत परिवेश से इस हद तक डॉमिनेट हो रहे थे/दब 

रहे थे, कि कभी-कभी तो वे लेंस पर लगा कोई धब्बा मात्र प्रतीत हो रहे थे। इसीलिए अल्ट्रा-वाइड शॉट, बड़े पमैाने व आयाम का संबद्ध/रिलेटिग शॉट होता 

ह ै(अगले पेज पर ऊपरी फोटो देखें)।

चित्र 3.2.1: अल्ट्रा-वाइड शॉट
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3.2.1.2 वाइड शॉट

वाइड शॉट पारंपरिक तौर पर, किसी नई सीक्वेंस का शुरुआती शॉट होता ह,ै इसे अक्सर एस्टाब्लिशिग शॉट कहकर परिभाषित किया जाता ह।ै वाइड शॉट 

का उद्देश्य सीन सेट करना होता ह,ै जिससे दर्शकों को लोकेशन, इसकी विषय-वस्तु तथा इसके मुख्य पात्र तथा पात्रों के साथ इसके संबंध के बारे  में 

तत्काल एक अंदाज़ा मिल जाये। यही कारण ह ैकि क्यों ज़्यादातर फिल्म-निर्माता अपनी फिल्म की ओपनिग/शरुआती सीक्वेंस या सीक्वेंस के भीतर ही 

किसी नये सेट-अप, जिसमें नई लोकेशन की ज़रूरत हो, के लिए एस्टैब्लिशिग शॉट के रूप में वाइड शॉट को ही क्यों पसंद करते हैं। ज़्यादातर ओपनिग्स 

के लिए, वाइड शॉट ही पसंदीदा शॉट होना चाहिए, मगर कुछ ओपनिग्स या ट्रांज़ीशन्स काम करती हैं।

एक वाइड शॉट, वाइड तभी कहलाता ह,ै जब शॉट में फुल-साइज्‍़ड कैरेक्टर  हों, क्योंकि शॉट का विस्तार/की वाइडनेस परूी तरह से इस बात पर निर्भर 

करती ह,ै कि कलाकारों के साथ इसका क्या संबंध बन रहा ह।ै कोई भी शॉट जो दृश्य में दिखाई दे रहे कैरेक्टर  से बड़ा हो – हम सिर से लेकर परै तक परूे  

कैरेक्टर  और उसके आस-पास की काफी जगह देख पा रहे हों - तो इसे वाइड शॉट का नाम दिया जा सकता ह।ै

अल्ट्रा-वाइड शॉट में काफी ज़्यादा बकैग्राउंड/पषृ्ठभमूि दिखाई देता ह ैऔर इसमें सबजेक्ट/कैरेक्टर  (इस मामले में, स्टॉप साइन/रुकने का संकेत) इस परूे  

व्यू का एक बेहद छोटा सा हिस्स होता ह।ै

चित्र 3.2.2: वाइड शॉट

वाइड शॉट परूे  कैरेक्टर  को तो दिखाता ही ह,ै साथ ही सीन की तात्कालिक सेटिग को भी दिखाता ह।ै

3.2.1.3 मध्य शॉट
मिड शॉट में कैमरा इतना नजदीक लाना पड़ता ह ैकि कैरेक्टर  परूा नहीं दिखाई देता। आमतौर पर, कैमरा कैरेक्टर  को कमर से लेकर उनके सिरे  के ऊपरी 

हिस्से तक दिखाता ह,ै यद्वपि कैरेक्टर  की कमर से उसके परैों के नीचे तक का मिड शॉट भी आप ले सकते हैं, अगर इससे उद्देश्य की परू्ति  होती ह ैतो। मिड 

शॉट दर्शकों को कैरेक्टर  के थोड़ा नजदीक ले आता ह,ै बिना उसे असहज किये।
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एक मिड शॉट का तब इस्तेमाल किया जाता ह ैजब कैरेक्टर  कुछ ऐसा करता ह ैजिसे हमें साफ तौर पर देखने की ज़रूरत होती ह ै(कुछ ऐसा जिस पर वाइड 

शॉट में संभवत दर्शकों की नज़र न पड़े) या अगर वे अपने आस-पास की किसी चीज़ पर प्रतिक्रिया देते हैं या एक तरह से उसका जिक्र कर रहे हों, जिसे 

हमें अधिक स्पष्ट रूप से देखने की ज़रूरत ह।ै कैरेक्टर  दूसरे  कैरेक्टर  की छवि के बारे  में कुछ ध्यान दे रहा हो सकता ह ैया वे कुछ ऐसा देख सकते हैं, जो 

उन्हें अपने बिल्कु ल पीछे  चाहिये। यह परूी तरह से इस पर निर्भर करता ह,ै कि कैरेक्टर  क्या कर रहा ह ैऔर उसके उस विशिष्ट एक्शन में उसके आस-पास 

की क्या चीज़ शामिल ह।ै इस तरह, वाइड शॉट और मिड शॉट दोनों ही ''रिलेटिग/संबद्धता'' के शॉट हैं। वाइड शॉट में कैरेक्टर  अपने आस-पास के विस्तृत 

परिवेश से संबद्ध होता ह ै और मिड शॉट में ऐसी किसी चीज़/अन्य कैरेक्टर  से संबद्ध होता ह,ै जो उसके काफी नज़दीक ह।ै इसलिए ये शॉट्स अधिक 

अव्यक्तिगत/औपचारिक होते हैं और यह बात दर्शकों को भी सम्प्रेषित हो जाती ह,ै चाहे अचेतन में ही सही।

चित्र 3.2.3: मिड शॉट

3.2.1.4 क्लोज़-अप
क्लोज़-अप वह शॉट होता ह ैजिसका इस्तेमाल हम सिर्फ  और सिर्फ  उस एक्शन को शॉट करने 

के लिए करते हैं, जिसे हम दर्शक को विशिष्ट रूप से बिना कहीं ध्यान बँटाये दिखाना चाहते 

हैं। कई बार, यह कैरेक्टर  के चेहरे  का क्लोज़ शॉट होता ह,ै जब वे किसी अलग तरीके से बात 

कर रहे हों, या प्रतिक्रिया दे रहे हों। एक क्लोज़-अप शॉट हमें कैरेक्टर  की गर्दन से लेकर सिर 

के ऊपरी हिस्से तक दिखार्द  देता ह।ै हालांकि, क्लोज़-अप शॉट हाथ से कुछ उठाने, किसी 

उछाली गई चाबी के आकर खुली दराज़ में गिरने, महज़ विस्फोट से पहले प्यूज़ के बम तक 

पहँुचने या और किसी दृश्य का हो सकता ह,ै जिसे काफी नज़दीक से दिखाने की ज़रूरत हो। 

क्लोज़-अप में कैरेक्टर  स्वय को अपने शरीर की हरकतों की बजाय, भाव-भंगिमाओ ं से 

अभिव्यक्त करता ह।ै यह दर्शकों को किसी ऐसी बात/चीज़ का बिल्कु ल स्पष्ट, असंदिग्ध दृश्य 

दिखाता ह,ै जो दर्शकों की नज़र से छूटना नहीं चाहिये, यदि वे कहानी की स्थिति को परूी तरह से समझना चाहते हैं तो। डरावनी/हॉरर शलैी में, यह दर्शकों 

को भौचक्का करने के लिए भी सेट किया जा सकता ह,ै जिसमें कैमरा एक डरे  हुए चेहरे  के क्लोज़-अप पर आकर ठहर जाता ह,ै फिर इसी सीन के एक 

वाइड शॉट में एक मॉन्स्टर, जो कि पहले सीन में नहीं था, एक बेखबर विक्टिम/शिकार के पीछे  खड़ा दिखाई देता ह।ै क्लोज़-अप को बेहद व्यक्तिगत शॉट 

माना जाता ह,ै इसलिए, क्योंकि इसमें हमें केवल व्यक्ति या किसी बात/चीज़ पर उसकी प्रतिक्रिया या कुछ विशिष्ट जो वे कर रहे हैं, ये ही देखने की ज़रूरत 

होती ह।ै

चित्र 3.2.4: क्लोज़-अप (क्लोज़-अप शॉट सबजेक्ट, उनके एक्शन या 
रिएक्शन पर फोकस करता है।)
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3.2.1.5 एक्स्ट्रीम क्लोज़-अप
एक्स्ट्रीम क्लोज़-अप बिल्कु ल वहीं होता ह,ै जो इसके नाम से जाहिर होता ह;ै कैमरा इतना 

नजदीक मूव करता ह,ै कि स्क्रीन बारीक से बारीक वर्णन से भर जाती ह,ै जसैा कि नीचे वाली 

आकृति में ह।ै यह आंख झपकना या घरूना हो सकता ह।ै यह सिगरे ट के सिरे  को जलाने वाली 

माचिस की तीली का सिरा हो सकता ह।ै या यह बेहद धीमी गति में धरती पर आकर गिरने 

वाली बारिश की बूंद हो सकती ह।ै शॉट की जो भी आवश्यकता हो, कैमरा दर्शकों को इसके 

बेहद नजदीक व करीबी बारीकियों में ले जाता ह ैऔर दर्शकों के लिए इसे अनदेखा करना 

नामुमकिन बना देता ह।ै एक एक्स्ट्रीम क्लोज़-अप वह चीज़ ह ैजो किसी एक्शन, या एक्शन्स 

की सीरीज़, को परूा करती ह,ै एक शॉट जो किसी सीन या सीक्वेंस की छोड़े न जा सकने वाले 

लमहे को रिकॉर्ड  करता ह।ै । बेहद व्यक्तिगत शॉट होने के नाते, क्लोज़-अप के मुकाबले कहीं 

अधिक व्यक्तिगत, यह दर्शकों के मन में इस बात का कोई संदेह नहीं छोड़ता, कि फिल्म-

निर्माता उन्हें इस क्षण में क्या दिखाना चाहता ह।ै

चित्र 3.2.5: एक्स्ट्रीम क्लोज़-अप (यह दर्शकों को किसी खास एक्शन में 
डुबो देता है, इस मामले में बुलेट दिखाने में)

चित्र 3.2.6: एनिमेशन में सीन की फ्रेमि ग पर काम कर रहे होते हैं तो एक बढ़िया सुझाव यह है, कि हाथों से स्क्रीन का आकार बनाएं और उसे आस-पास मूव करते रहें, जब तक उस आर्टवर्क  की 
बेहतरीन फ्रेमि ग पर न पहुँच जाएं।

3.2.2 कैमरे के लेंस
चार तरह के बुनियादी लेंस हैं: स्टैंडर्ड  लेंस, वाइड एंगल लेंस, लांग लेंस, तथा ज़ूम लेंस। दरअसल एक पांचवा लेंस भी होता ह,ै फिशआई, जिसका उल्लेख 

भी ज़रूरी ह।ै हालांकि इमेज पर इसका प्रभाव, अन्य लेंस के मुकाबले काफी सख्त होता ह,ै इसलिए इन्हें काफी किफायत से/कम ही प्रयोग करना चाहिये, 

और तभी प्रयोग करना चाहिये, जब प्रोजेक्ट को इनकी ज़रूरत हो। हरे क लेंस में सीन लेने की एक खास योग्यता होती ह ैजो अन्यों में नहीं होती और 

इसीलिए जब किसी सीन की विषय-वस्तु, प्रभाव तथा मूड पर विचार किया जा रहा हो, तो प्रत्येक फिल्म-निर्माता को कुछ विशिष्ट विकल्प ऑफर करता 

ह।ै “प्राइम लेंस” एक सामान्य शब्द ह,ै जो इस तरह के ज़्यादातर लेंसों का वर्णन करता ह,ै जो कैमरा तथा ऑब्जेक्ट के बीच एक पक्का रिश्ता कायम कर 

लेते हैं। दूसरी ओर, ज़ूम लेंस, फिल्मिंग के दौरान व्यू के प्वाइंट को बाहर भीतर की ओर मूव कर सकते हैं। सभी लेंस एक माप के आधार पर परिभाषित किये 

जाते हैं, जिसे फोकल लेंथ कहा जाता ह,ै जिस पर हरे क लेंस का मगै्नीफिकेशन तथा फील्ड एरिया निर्भर करता ह।ै किसी अन्य के मुकाबले 3D एनिमेटर 

के लिए लेंस चयन ज़्यादा महत्वपरू्ण  होता ह,ै यद्वपि 2D एनिमेटर अपने आर्टवर्क  के अन्दर ही एलीमेंट्स का पर्सपेक्टिव तथा स्के ल डिस्टॉर्ट  करके समान 

इफैक्ट प्राप्त कर लेते हैं।
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3.2.2.1 स्टैंडर्ड लेंस (50-100मिमी. फोकल लेंथ)
स्टैंडर्ड  (या सामान्य) लेंस वे हैं जो ज़्यादातर स्टिल कैमरों में इस्तेमाल होते हैं। ये काफी निष्ठा से तसवीर लेते हैं (नीचे देखें), बिल्कु ल मामूली या बिना 

किसी डिस्टॉर्शन के और इनका व्यूइंग एरिया काफी विस्तृत होता ह।ै ज़्यादातर एनीमेटेड फिल्म-निर्माता स्वाभाविक रूप से अपनी फिल्मों में अधिकतर 

स्टैंडर्ड  लेंस व्यूप्वाइंट इस्तेमाल करते हैं।

चित्र 3.2.7: स्टैंडर्ड लेंस इमेज में को स्पेश्यिल इफैक्ट नहीं लाता।

3.2.2.2 वाइड-एंगल लेंस (20-35मिमी.)
वाइड-एंगल लेंस तस्वीर में ज़्यादा गहराई लाते हैं और इसे एक एक्ज़ैजरेटि ड 3D पर्सपेक्टिव लुक देते हैं। इस लेंस की ज़रूरत तब पड़ती ह,ै जब किसी स्ट्रांग 

चित्र 3.2.8: वाइड-एंगल लेंस आस-पास की पृष्ठभूमि को ज़्यादा से ज़्यादा पेश करते हैं।
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फोरग्राउंड कैरेक्टर  या ऑब्जेक्ट पर बहुत नज़दीक से फोकस करना हो और साथ ही उसी शॉट में आस-पास का परूा बकैग्राउंड एन्वायरन्मेंट भी नज़र 

आना चाहिये। वाइड-एंगल लेंस सबसे निकट की चीज़ों पर फोकस कर सकता ह ैऔर इसके व्यू का एंगल स्टैंडर्ड  लेंस के मुकाबले कहीं बड़ा होता ह।ै

विज़ुअल इफैक्ट्स , के मामले में, लेंस जितना विस्तृत होगा, सेंट्रल इमेज उतनी ही डिस्टॉर्टिड (विरूपित) होगी और बकैग्राउंड के साथ इसका संबंध भी 

उतना ही विरूपित होगा। बुनियादी प्रवतृि यह होगी कि कैमरे  के नजदीक की चीजें कृत्रिम रूप से नज़दीक लगेंगी और दूर की चीज़ें और भी ज़्यादा दूर 

लगेंगी। वाइड-एंगल लेंस पत्रकारों तथा फैशन फोटोग्राफरों द्वारा पसंद किये जाते हैं, क्योंकि इन्हें अपनी इमेज में जितना संभव हो सके उतना कैप्चर 

करना होता ह,ै और अक्सर बहुत ही सीमित जगह में । यदि ऑब्जेक्ट्स  के फोरग्राउंड तथा बकैग्राउंड के बीच विशेष रूप से एग्ज़ैजरेटि ड इफैक्ट की 

आवश्यकता हो, तो वाइड-एंगल लेंस के ज़रिये वाइड शॉट के साथ-साथ, मिड शॉट तथा क्लोज़-अप भी देखे जा सकते हैं।

3.2.2.3 लाँग लेंस (85-600मिमी.)
जब कैमरा काफी दूर हो, तो लाँग लेंस मुख्य रूप से किसी विशाल शॉट का विस्तृत हिस्स फीचर करने के लिए प्रयोग किये जाते हैं। लाँग लेंस टेलीस्कोप 

की तरह काम करते हैं और बहुत दूर वाली वस्तु को बेहद नजदीक लाते हैं। लाँग लेंस का व्यूइंग एंगल बेहद संकरा होता ह,ै तो ध्यान रहे, आस-पास का 

ज़्यादातर बकैग्राउंड कैप्चर नहीं हो पायेगा। यह वस्तु के पीछे  की हरे क चीज़ को चपटा कर देता ह,ै , जिससे शॉट के भीतर संबद्ध तत्वों (एलीमेंट्स) में 

परिप्रेक्ष्य/यथार्थ  का भाव अनिवार्य  रूप से कम हो जाता ह।ै

लाँग लेंस इफैक्ट ज़्यादातर वाइल्डलाइफ डॉक्यूमेंट्री में देखा जा सकता ह,ै जहां जानवर बहुत ज़्यादा दूरी से फिल्माए जाते हैं। हालांकि, क्लोज़-अप पोट्रेट 

शॉट के लिए अक्सर अपेक्षाकृत छोटे लाँग लेंस (85-135मिमी.) प्रयोग किये जाते हैं, क्योंकि ये मुखाकृतियों का अधिक स्वाभाविक परिप्रेक्ष्य प्रदान करते 

हैं। (इसलिए इसके उल्ट, का मतलब ह ैकि क्लोज़-अप पोर्टरे ट शॉट में इस्तेमाल होने वाले वाइड-एंगल लेंस नाक को इस कद्र बड़ा व विरूपित कर देंगे कि 

ज़्यादातर इसे देखना सख्त नापसंद करें गे!) लाँग लेंस से परिप्रेक्ष्य के सपाट दिखने से किसी भीड़-भाड़ वाले शॉट में अवास्तविक तथा क्लॉस्ट्रफोबिक 

(बंद जगहों का डर) निकटता (क्लोज़नेस) आ जायेगी, जसेै किसी फुटबॉल मचै में गाता हुआ/ शोर करता हुआ प्रशंसकों हुज़ूम या बिज़ी आर्स /व्यस्त सड़कों 

पर भीड़-भाड़ के बीच कैरेक्टर  के पीछे -पीछे  कैमरा ले जाने के मामले में। क्षेत्र की गहराई लाँग लेंस में बेहद सीमित होती ह,ै जिसका मतलब ह ैकि, सबजेक्ट 

एरिया के आस-पास फोकस की दूरी बहुत ज़्यादा नहीं होगी। दृश्य में कें द्रीय ऑब्जेक्ट तो बिल्कु ल स्पष्ट/शार्प  होगा, लेकिन उसके एकदम पीछे  का और 

दूर का बकैग्राउंड उत्तरोत्तर और धंुधला होता जायेगा।

3.2.2.4 ज़ूम लेंस (28-80मिमी.; 18-35 मिमी.; 70-300 मिमी.)

ज़ूम लेंस तब उपयोगी होता ह ैजब सीन चलने के दौरान कैमरा शॉट के अंदर व बाहर आता 

जाता ह।ै प्राइम लेंसों से अलग, ज़ूम लेंस क्लोज़-अप से स्टैंडर्ड  लेंस और स्टैंडर्ड  लेंस से लाँग लेंस 

के बीच बदले जा सकते हैं। किसी शॉट में कोई कैरेक्टर  आगे या पीछे  चलता हुआ हो सकता ह ै

और फिल्म-निर्माता को परूा वक्त उसकी भाव-भंगिमाओ ंपर ध्यान देना ह।ै ज़ूम लेंस सीन के 

एक्शन के साथ-साथ चलते हैं, इसलिए शॉट में कैरेक्टर  का चेहरा लगभग एक जसैा ही रहता 

ह,ै चाहे कैमरे  के संदर्भ  में उसकी स्थिति कुछ भी हो।

चित्र 3.2.9: वाइड-एंगल लेंस आस-पास की पृष्ठभूमि ज़्यादा पेश करते हैं

एक और इफैक्ट जो ज़ूम लेंस ऑफ़र करते हैं, वह ह ैपुल्ड फोकस यह वह प्रक्रिया ह ैजहां सीन का शुरुआती हिस्सा सामने वाली (फोरग्राउंड) किसी चीज़ 

पर शार्प  फोकस करता ह,ै जबकि बकैग्राउंड धंुधला रहता ह।ै हालांकि, फिल्म-निर्माता अचानक ही बकैग्राउंड से दर्शकों को कोई चीज़ दिखाना चाह सकते 

हैं, तो लेंस अचानक उस चीज़ पर री-फोकस करेग ा और यह एक दूरी पर उभर की आयेगी, और फोरग्राउंड फोकस से बाहर हो जायेगा (नीचे)।
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चित्र 3.2.10: पुल्ड फोकस शॉट के पहले और बाद में। यह फोरग्राउंड पर शार्प फोकस और धुंधले बैकग्राउंड से शुरू होता है और धुंधले फोरग्राउंड और शार्प बैकग्राउंड पर खत्म होता है।

3.2.2.5 फिशआई लेंस (6-16मिमी.)
फिशआई लेंस, कैमरे  के व्यूप्वाइंट से, सीन के 180 डिग्री तक बेहद एग्ज़ैजरेटि ड वाइड एंगल लेंस का इफैक्ट देता ह ै(नीचे)। लेंसों के विज़ुअल इफैक्ट्स  शॉट 

को बड़ा ही विरूपित, वतृाकार घुमाव देते हैं, जसेै कि हम किसी अत्यधिक परावर्तक सिल्‍वर बॉल पर दृश्य का प्रतिबिम्ब देख रहे हों। फिशआई लेंस बेहद 

और, तंग/सिकुड़़े  परिवेश में प्रयोग करना सर्वोत्तम रहता ह,ै जहां कोई वाइड एंगल लेंस भी परूे  सीन को नहीं समेट पायेगा। वकैल्पिक तौर पर, फिशआई 

लेंस सीन को एक परिवर्तित सचेतन एहसास दे सकता ह,ै जसेै मुख्य किरदार, पिए हुए, ड्रग लिए हुए, या स्वप्निल हो। फिशआई लेंस दर्शकों के लिए बहुत 

परे शानी वाला हो सकता ह ैऔर इसलिए यह कम से कम इस्तेमाल किया जाना चाहिए, जब तक इफैक्ट में कोई असल उद्देश्य न हो।

चित्र 3.2.11: फिशआई लेंस सीन को नाटकीय तौर पर विरूपित कर देता है।
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3.2.3 लाइटिंग व फिल्टर्स
हम शॉट में लाइटिग व फिल्टर्स के इस्तेमाल की बात किए बिना लेंसों की बात नहीं कर सकते। फिल्टर्स रंगीन जलै होते हैं, जो दिखाई देने वाले रंग, टोन, 

या कंट्रास्ट को अतिरजित/एग्ज़ैजरे ट कर देते हैं। आज के दौर में आधुनिक डिज़िटल इमेज मनैिपुलेशन तकनीकों के चलते हम इमेज कैप्चर करने के 

काफी दिन बाद भी इसमें हर तरह के चमत्कारी बदलाव कर सकते हैं। , हालांकि, हर कोई मानता ह ैकि, कम से कम live-action फोटोग्राफी में, इच्छित 

प्रभाव पाने का बेहतरीन तरीका यह ह ैकि इमेज, जब भी संभव हो, वास्तव में लेंस के ज़रिये ही कैप्चर की गई हो। फिल्टर्स हमें कैमरे  द्वारा दिखने वाले 

दृश्य को सीमित करने का विकल्प देते हैं। ये लाइटिग हॉट स्पॉट्स (सरूज या लैंप आदि कि किरणें व परावर्तित प्रकाश) को कम कर सकते हैं, ये छाया को 

बढ़ा सकते हैं, और ये सतह की संरचना को भी निखार सकते हैं जिसे कि मानवीय आंखें देख नहीं सकती। फिल्टर्स और इनका प्रयोग विषय एक परूी 

किताब भर सकते हैं और अभी इन सबके बारे  में बताने के लिए पर्याप्त जगह नहीं ह,ै लेकिन इतना कहना पर्याप्त होगा, कि उदाहरण के लिए, एक कलर 

फिल्टर दृश्य को एक मूड या टोन दे सकता ह,ै जो वहां वास्तव में मौज़ूद नहीं थे और इस तरह दृश्य की नाटकीयता बढा सकते हैं।

चित्र 3.2.12: ऊपरी-बायां हिस्सा शॉट का मूल रंग है मगर इसके कुछ रंग हटाए गए हैं, जिससे यह बुनियादी ब्लैक एंड व्हाइट शॉट के ज़्यादा नजदीक हो गया है। ऊपरी-दायां हिस्सा कंट्रास्ट बढ़ाता 
है और इसमें सेच्यूरेशन शामिल करता है। निचला-बायां भाग एक शीत नीले रंग का फिल्टर ट्रीटमेंट देता है, जबकि निचला-दायां, लाल रंग के फिल्टर जुड़ जाने से, कहीं ज़्यादा ऊष्ण है।

3.2.4 कैमरा मूव्ज़
ज़्यादातर शॉट स्थिर या स्थिर के नजदीक होते हैं, जो फिल्म की प्रकृति पर निर्भर करते हैं। हालांकि, यह अक्सर जरूरी होता ह,ै कि कैमरे  को एक्शन के 

साथ मूव किया जाये, यह बताने के लिए कि क्या चल रहा ह।ै उदाहरण के लिए, एक आदमी गली में चल रहा ह,ै और खिड़कियों से देखता हुआ कोई चीज़ 

तलाश रहा ह।ै यदि कैमरा एक ही जगह स्थित हो, तो यह कोई दिलचस्प या सचूनात्मक शॉट शायद नहीं बन पायेगा और हम उस आदमी को दूर से गली 

में जाते हुए देखेंगे। आदमी के साथ-साथ कैमरे  को चलाना ज़्यादा रूचिकर होगा, वास्तव में उसे हर खिड़की से झांकता हुआ देखना और बल्कि कैमरे  को 

और स्विंग करके खिड़की से वह देखना, जो वह आदमी देख रहा ह।ै इस दृश्य को परूा करने के लिए फिल्म-निर्माता के पास कई तरह के कैमरा मूव्ज़ 

उपलब्ध हैं।
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चित्र 3.2.13: सावधानीपूर्वक किया गया शॉट चयनदर्शकों को सीधे विषयवस्तु के भीतर ले जाता है।

3.2.4.1 स्थाई (Locked Down) शॉट
जसैा कि नाम से जाहिर ह,ै यहां कैमरा नहीं चलता; यह स्थिर अवस्था में रहता ह ैऔर इसके सामने एक्शन होता ह।ै Live-action में, कैमरा स्थिरता के 

लिए संभवत एक तिपाई पर स्थिर रहेगा, या एक डॉली पर भी हो सकता ह ैजिसके पहिए लॉक किए गए हों। कैमरा स्थिर शॉट में हाथ में पकड़ा हुआ भी हो 

सकता ह ै(हैंड-हेल्ड) (कैमरामनै द्वारा, बिना किसी तिपाई सा डॉली के प्रयोग से), यद्यपि, इससे निस्संदेह शॉट को हल्की सी मूवमेंट मिलेगी, जो वांछित 

हो सकती ह।ै कई टीवी कॉप ड्रामा शोज़, एक्शन में अधिक वास्तविक मानव उपस्थिति दिखाने के लिए खासतौर से हैंड-हेल्ड इफैक्ट का प्रयोग करते हैं, 

चाहे कैमरा फिक्स्ड या मूविंग पोज़ीशन में ही क्यों न हो।

चित्र 3.2.14: एक locked-down वाइड शॉट

3.2.4.2 Tracking (Panning) शॉट
Live action में, tracking शॉट वह होता ह ैजिसमें कैमरा एक्शन के साथ साथ चलता ह,ै जसेै हमारे  आदमी के साथ, जब वह खिड़कियों से झाँकता हुआ 

गली से गुज़रता ह।ै इसे पाने के लिए, कैमरा असल में डॉली पर फिट किया जाता ह ैजो कि एक रे लरोड जसेै ट्रैक के ऊपर सीधी स्थिर होती ह ैऔर यह 

एक्शन के समानांतर बिछाई गई होती ह।ै जसेै आदमी चलता ह,ै कैमरा उसके पीछे , ट्रैक के साथ साथ चलता ह,ै यह दर्शकों को उसके द्वारा की गई हरे क 

चीज़ देखने में सक्षम बनाता ह।ै ट्रेडिशनल एनिमेशन में, एक्शन के साथ-साथ चलने के समान इफैक्ट या किसी बकैग्राउंड आर्टवर्क  के वाइड पीस, जो कि 
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स्क्रीन विड्थ से भी ज़्यादा चौड़ा हो, पर मूव करने को पनैिग कहा जाता ह।ै Panning क्षैतिज हो सकती ह ैया लंबवत, जसेै किसी ऊंची बिल्डिंग में ऊपर 

की ओर चढ़ते हुए, या ऊँचाई से गिरकर ज़मीन की ओर आते हुए, आदि।

चित्र 3.2.15: पेड़ों के झुरमुट से होते हुए एक संकरे रास्ते का एक पूर्ण 360-डिग्री tracking/panning शॉट। यह ऊपरी-दाएं भाग में शुरू होता है, ऊपरी लेयर के साथ दाएं से बाएं पैन होता है, 
और फिर निचली लेयर के साथ दाएं से बाएं। आखिरकार, एक्शन निचले-बाई ओर के भाग में वापस अपनी मूल अवस्था में लौट आता है।

3.2.4.3 ज़ूम शॉट
ज़ूम शॉट वह होता ह ैजिसमें कैमरा एक्शन के अंदर या बाहर आता जाता ह।ै यह ज़ूम लेंस के इस्तेमाल के जरिए किया जा सकता ह ै(जसैा कि पहले चर्चा 

की जा चुकी ह)ै या असल में सीधे एक्शन की दिशा में बिछाये गये ट्रैक पर कैमरा डॉली करके। कैमरा ट्रैक के एक हिस्से से शुरू हो सकता ह ैजोकि सीन 

चित्र 3.2.16: पहली बार में, हमारे मुख्य कैरेक्टर, Kermik का कोई निशान नहीं है। हालांकि, जैसे कैमरा ज़ूम इन होता है, आपका ध्यान उसकी छिपने की जगह पर जाता है।
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से बेहद दूर हो, और फिर इसे एक्शन की ओर मूव किया जा सकता ह,ै यह इफैक्ट देते हुए कि एक्शन नज़दीक आ रहा ह ैऔर इसलिए स्क्रीन पर बड़ा 

दिखाई देने लगता ह।ै ये भी हो सकता ह,ै कि किसी शॉट के ज़ूम इन या ज़ूम आउट में कोई एक्शन हो ही ना। यह एक बड़े सीन के भीतर किसी खास प्रॉप 

या वस्तु का पता लगाने के लिए भी इस्तेमाल हो सकता ह,ै जो या तो पहले से ही दिख रही हो और कैमरा ज़ूम आउट हो, या फिर एक दूरी पर हो और कैमरा 

ज़ूम इन करे ।

3.2.4.4 डॉली (क्रे न) शॉट
डॉली (या क्रे न) शॉट अनिवार्य  रूप से ट्रैक व ज़ूम शॉट का एक संयोजन ह,ै फिर भी यह इससे कहीं ज़्यादा हो सकता ह।ै गली में चलते हमारे  आदमी का 

उदाहरण फिर से लेते हैं, कैमरा पीछे  से एक वाइड शॉट से उसे देख सकता ह ै(एक बड़े शॉट में उसे व गली को एस्टैब्लिश करते हुए), और आगे बढ़कर मिड 

शॉट लेते हुए उसके साथ-साथ और फिर आखिरी में उसके सामने, उसका चेहरा और उस खिड़की के भीतर, जिसमें वह झांक रहा ह,ै का एक क्लोज़-अप 

लेते हुए। इसे हासिल करने के लिए, ओपनिग शॉट के लिए कैमरा लेंस को अनिवार्य  रूप से वाइड ज़ूम करता ह,ै जब यह उस आदमी के पीछे  भागते हुए (फिर 

चित्र 3.2.17: यहॉं एस्टैब्लिशिंग व्यू में Kermik स्पष्ट दिखाई दे रहा है, और साथ ही, वह पूरी लोकेशन भी जिसमें वह मौज़ूद है। दर्शकों का ध्यान आस-पास के 
परिवेश से हटाकर उसकी मुखाकृतियों पर कें द्रित करने के लिए कैमरा उसके चहरे और उसके आस-पास डॉली करता है।
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भी उसके एक्शन के समांतर) ट्रैक के सिरे  पर होता ह।ै ज़ूम इन करता ह,ै जब कैमरा डॉली ट्रैक में उसके साथ-साथ मूव करती ह,ै फिर और नज़दीक ज़ूम 

इन करता ह,ै जब कैमरा उस आदमी और खिड़की के आगे ट्रैक पर अपनी फाइनल पोज़ीशन पर मूव करता ह।ै ज़ूम शॉट, निश्चित तौर पर इससे भी आगे 

जा सकते हैं। वास्तव में ये सबजेक्ट के इर्द -गिर्द  परूा 360 डिग्री घमू सकते हैं और तब तक घमूते रह सकते हैं, जब तक उनका रुकना ज़रूरी न हो।

खासतौर से एक सीन चरण बद्ध तरीके से इन शॉट्स से होकर गुजरता ह,ै एस्टैब्लिशिग शॉट से शुरु होते हुए, मीडियम शॉट पर, फिर मीडियम क्लोज़-अप 

और फिर क्लोज़-अप तक। ऐसा पटैर्न  ज़ाहिर ह,ै इफैक्ट्स  के लिए बदला जा सकता ह ैऔर अक्सर बदला भी जाता ह।ै कुछ अन्य शॉट्स भी स्टैंडर्ड  पटैर्न  के 

होते हैं:

सीन दर सीन ट्रांज़ीशन

हरे क शॉट, किसी न किसी तरीके से, दूसरे  शॉट पर जाता ह।ै आम तरीका एक कट के साथ का ह,ै लेकिन ऐसा नहीं भी हो सकता ह।ै अन्य ट्रांज़ीशन भी 

ह,ै जो उपलब्ध हैं, जिनमें से प्रत्येक सीन परिवर्तन की एक अलग व्याख्या पेश करता ह।ै यहां बेहद लोकप्रिय में से कुछ दिए जा रहे हैं और उन्हें इस्तेमाल 

करने के संभावित कारण भी।

कट

चित्र 3.2.18: यहां, एनिमेटर के लाइटबॉक्स पर लाइट धीरे धीरे धुंधली पड़ती है।

चित्र 3.2.19: कट ट्राँज़ीशन।

फिल्म-निर्माण में कट इतना आम ह,ै कि इसे शायद ही परिभाषित करने की आवश्यकता हो। कट सरल तौर पर, एक सीन को समाप्त कर दूसरे  सीन पर 

जाना ह,ै बीच में कुछ नहीं। एक सीन का आखिरी फ्रे म सीधे अगले सीन के प्रथम फ्रे म से मिलता ह।ै इसलिए कट सबसे सरल और सीधाा ट्रांज़ीशन ह ैऔर 

संभवत: 90 प्रतिशत से ज़्यादा समय ये ही इस्तेमाल किया जाता ह।ै

Dissolve

इस दृष्टि से Dissolve थोड़ा सौम्‍य ट्रांज़ीशन देता ह,ै क्योंकि इसमें कई फ्रे म्स में पहला सीन धीरे -धीरे  जाता ह ै और अगला सीन धीरे -धीरे  उभरता ह।ै 

Dissolve बहुत थोड़े फ्रे मों पर हो सकता ह ै(अक्सर “सॉफ्ट कट” के नाम से जाना जाता ह)ै या यह ट्रांज़ीशन के प्रकार के हिसाब से, परूा होने में कुछ 

सकैें ड्स ले सकता ह।ै उदाहरण के लिए, एक summer country setting, एक समान शॉट में dissolve हो सकती ह ै(एक “match dissolve”) जिसे अब पतझड़ 

या सर्दियों में देखा जा सकता ह।ै जहां कट एक घूंसा मारने जसैा ह,ै वहीं dissolve दुलारने जसैा।

चित्र 3.2.20: एक सीन से अगले में dissolve होना।
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3.2.4.5 Fade
Fade एक ऐसा उपकरण ह ैजो एक ईवेंट को समाप्त करता ह,ै एक बिल्कु ल नये ईवेंट की शुरुआत के लिए Fade तब इस्तेमाल किया जाता ह ैजब एक सीन 

से दूसरे  में परिवर्तन एक सौम्‍य तथा काव्यात्मक ढंग से चाहिये हो, जहां मूड तथा पेस (लय) में बदलाव चाहिये हो या जहां समय को आगे बढ़ाकर दिखाना 

हो। Fade में, तस्वीर पहले धीरे  धीरे  ब्लैक या व्हाइट में dissolve होती ह,ै फिर उसी व्हाइट या ब्लैक में से अगला सीन निकल कर आता ह/ैdissolves होता 

ह।ै दर्शकों के मन में निश्चित रूप से मौज़ूदा दृश्य की जो कुछ अनुभतूियां शेष रह गई होती हैं, इस तरह से उन्हें, अगले दृश्य के उनकी चेतना में आने से 

पहले, इन अनुभतूियों से निकलकर अपनी तंद्रा में लौटने का समय मिल जाता ह।ै बेशक, यह ब्लैक (या व्हाइट) के साथ कट करके अधिक शीघ्रता से किया 

जा सकता ह,ै बजाय सीधे नये सीन में कट करने के। हालांकि, fade परूी तरह से एक मूड या भावना की दूसरी में ट्रांज़ीशन की कोरियोग्राफिग ह ैऔर 

इसलिए यह ज़्यादा काव्यात्मक तकनीक ह।ै

ब्लैक या व्हाइट के बीच चयन थोड़ा जटिल ह ैऔर यह इच्छानुसार हो सकता ह।ै सबसे आम पसंद ब्लैक ह।ै मेरी समझ ह ैकि ब्लैक में fade ज़्यादा धीमा, 

प्रावर्तित, और अचेतन अहसास वाला होता ह,ै जबकि व्हाइट में fade ज़्यादा प्रत्यक्ष होता ह ैऔर इसलिए इसमें ज़्यादा चेतना,सक्रियता, व ऊर्जा  का अहसास 

होता ह।ै

चित्र 3.2.21: fade ट्रांज़ीशन

3.2.4.6 Wipe
wipe इन दिनों कम इस्तेमाल होने वाला एक ट्रांज़ीशन ह,ै हालांकि यह फिल्ममेकिग के शुरुआती दिनों में बेहद आम था। बुनियादी तौर पर, wipe तब आता 

ह ैजब आनेवाले सीन की इमेज स्क्रीन को साफ (wipe) करती चलती ह,ै आखिरकार पिछले सीन की इमेज को मिटा डालती ह।ै Wipe क्षैतिज, लंबवत, वतृ 

में, सर्पिल, और कई पटैर्न  में हो सकते हैं, जसेै चकैरबोर्ड  ज़्यादातर डिज़िटल एडिटिग सॉफ्टवेयर, जसेै कि Apple Final Cut और Adobe Premiere, में चुनने 

के लिए कई built-in wipes ह,ै मगर wipe अक्सर एक्शन में दखल देने वाले होते हैं और बिना खास वजह के इस्तेमाल किए जाने पर बनावटी लग सकते 

हैं, जसेै कोई विशिष्ट शलैी (genre) की मूवी जो 1920 की मूवी का मूड रीक्रिएट करने का प्रयास करे ।

चित्र 3.2.22: वाइप ट्रांज़ीशन

3.2.4.7 Ripple और अन्य स्पेशल इफैक्ट्स Dissolves
यह एक और कम इस्तेमाल होने वाला ट्रांज़ीशन ह,ै जिसका उल्लेख किया जाना चाहिये, क्योंकि कुछ परिस्थितियों में इसकी एक cliché value (घिसा-

पिटा मूल्य) ह।ै रिपल डिज़ॉल्व इफैक्ट में एक सामान्य डिज़ॉल्व जसैा होता ह,ै अंतर केवल इतना ह,ै कि जब ट्रांज़िशन होता ह ैतो इसमें रिपलिग वाटर इफैक्ट 

पदैा होता ह।ै रिपल डिज़ॉल्व का इस्तेमाल तब होता ह ैजब फिल्म किसी ड्रीम सिक्वेंस या किसी हलै्यूसिनेट्री (भ्रमित करने वाली आवाज़ें अथवा दृश्य) 

सीक्वेंस में प्रवेश करती ह ैया एक्शन पानी में नीचे की ओर जा रहा हो। वाइप की तरह ही रिपल डिज़ॉल्व भी कई मामलों में एक प्रिडिक्टेबल ट्रांज़ीशन 

डिवाइस बन गया ह,ै हालांकि यदि इसका इस्तेमाल किफायत और समझदारी से किया जाये, तो यह प्रभावी हो सकता ह।ै
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चित्र 3.2.23: प्रीमियर में बना एक रिपल डिज़ॉल्व

3.2.5 स्क्रीन आस्पैक्ट रेशियो
अन्तत: फिल्म निर्माण के वास्तविक रचनात्मक पहल ूमें प्रवेश करने से पहले एक आखिरी चीज़ जो फिल्म निर्माता को अवश्य ध्यान में रखनी चाहिए, 

वह ह ैफॉर्मेट या स्क्रीन रे श्यो (अनुपात)। फिल्म देखते समय, हम स्क्रीन रे श्यो को कोई महत्त्व ही नहीं देते, चाहे यह कोई सिनेमा फिल्म हो, टीवी शो हो, 

डीवीडी मूवी हो अथवा वेब आधारित एनिमेशन। हालांकि, स्क्रीन माप अनुपात के लिहाज़ से प्रत्येक को सख्ती से परिभाषित किया गया ह ैऔर इसलिए 

यह आवश्यक ह,ै कि आप हरे क के लाभों तथा हानियों से अवगत हों।

स्टैंडर्ड  एकेडमी (इसे 4:3 या 1.33:1 फॉर्मेट भी कहा जाता ह)ै वह फॉर्मेट ह,ै जिसका इस्तेमाल फिल्म तथा टेलीविज़न प्रोडक्शन में सर्वाध िक होता ह।ै स्टैंडर्ड  

एकेडमी स्क्रीन आकार की बुनियादी ज़रूरत यह ह ैकि इसे 4 यनूिट्स चौड़ा और 3 यनूिट्स ऊँचा होना चाहिए, जिसका अर्थ यह ह ैकि, फ्रे म आयाम की हर 

चार इकाई चौड़ाई के लिए इसे तीन इकाई ऊँचा होना चाहिए। स्टैंडर्ड  एकेडमी को TV एकेडमी भी कहा जाता ह।ै

फिल्म एकेडमी देखने में बहुत कुछ स्टैंडर्ड  एकेडमी aspect ratio के समान ही होता ह,ै सिवाय इसके, कि इसका 

वास्तविक स्क्रीन रे श्यो 1.37:1 होता ह।ै वास्तव में, इसके स्टैंडर्ड  एकेडमी फॉर्मेट के समान होने का आभास होता ह।ै 

हालांकि, यदि आपको कोई संदेह हो, तो हमेशा 1.37:1/ स्टैंडर्ड  एकेडमी आकार के लिए ही काम करें , इसमें ज़्यादा से 

ज़्यादा बुरा यह हो सकता ह,ै कि जब इसे टीवी पर दिखाया जायेगा, तो छवियों/तस्वीरों का ऊपर का एक हिस्सा गायब 

हो जायेगा।

वाइडस्क्रीन में 1.85:1 का रे श्यो होता ह ैऔर इसमें फिल्मकार के लिए दोनों एकेडमी फॉर्मेट्स के मुकाबले एक निश्चित 

लाभ होता ह,ै क्योंकि इसमें अधिक लैंडस्के प शेप होती ह,ै जो फिल्मी लैंडस्के प्स और विहंगम/ पनैोरैमिक दृश्यों में स्वय 

को अधिक सौंदर्य के साथ प्रस्तुत करता ह।ै इसका अर्थ यह ह ै कि वाइडस्क्रीन फॉर्मेट के साथ, तस्वीरों में अधिक 

व्यापकता तथा आयाम समेकित किये जा सकते हैं, जिससे एनिमेटिड फिल्म-निर्माता के लिए चीज़ों की छवि और 

बेहतर हो जाती ह।ै वाइडस्क्रीन एक काफी लोकप्रिय फॉर्मेट ह,ै जिसे आसानी से कहीं भी स्क्रीन किया जा सकता ह।ै 

वाइडस्क्रीन फिल्म की यह खामी ह ैकि जब उन्हें TV पर दिखाया जाता ह,ै तो उन्हें या तो लेटरबॉक्स्ड किया जाता ह ै

(स्क्रीन के ऊपर और नीचे एक काली पट्टी होती ह,ै जो इसे एकेडमी फॉर्मेट स्क्रीन पर देखने योग्य बनाती हैं) या इमेज 

क्रॉप कर दी जाती हैं (जिससे फिल्म इमेज टीवी स्क्रीन पर वर्टिकली फिट हो जाये, लेकिन दाई ंतथा बाई ंओर से इसकी 

कुछ इमेज गायब हो ही जाती हैं)। किसी वाइडस्क्रीन इमेज को एकेडमी फॉर्मेट में स्क्वीज़ करने का कोई उपयुक्त 

तरीका नहीं ह,ै पर मेरा सुझाव ह ैकि, एक फिल्मकार के नज़रिए से, पहला विकल्प, दूसरे  के मुकाबले कहीं अधिक 

उपयुक्त ह।ै

सिनेमास्कोप (जिसे “स्कोप” भी कहा जाता ह)ै अन्य सभी फिल्म फॉर्मेट्स के मुकाबले एक बिल्कु ल अलग प्रणाली का 

प्रयोग करता ह।ै स्कोप मटैीरियल एक विशेष लेंस के ज़रिये शॉट तथा प्रोजेक्ट होता ह,ै जिसे एनामॉर्फि क लेंस कहते 

हैं। यह लेंस अगल-बगल से फिल्म इमेज को स्क्वीज़ करता ह,ै जिसका नतीजा यह होता ह ैकि जब कोई एकल इमेज 

को नंगी आँखों से देखता ह ैतो पिक्चर क्षैतिज रूप से पिचक जाएगी। हालांकि, किसी एनामॉर्फि क लेंस से होकर 
चित्र.3.2.24: स्टैंडर्ड एकेडमी आस्पेक्ट 
रेशियो 
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सेकें ड पास के बाद, स्क्रीन पर प्रदर्शित होते समय फिल्म इमेज फिर से फैल जाती ह।ै स्कोप एनिमेशन का स्क्रीन रे श्यो वाइडस्क्रीन के मुकाबले और भी 

चौड़ा विहंगम दृश्य उपलब्ध कराता ह।ै किसी स्कोप स्क्रीन साइज़ का आधिकारिक फॉर्मेट 2.35:1 होता ह,ै जिसका अर्थ ह ैकि आर्टवर्क  की प्रत्येक यनूिट 

ऊँचाई के लिए इसे 2.35 यनूिट चौड़ा होना चाहिये।

प्रदर्शित होने पर स्कोप सर्वाध िक आकर्षक, एपिक-स्टाइल पिक्चर बनाता ह।ै हालांकि टेलीविज़न प्रयोग के लिए यह बिल्कु ल भी उपयुक्त नहीं ह,ै क्योंकि 

इसमें वाइडस्क्रीन के मुकाबले और भी ज़्यादा लेटरबॉक्सिंग तथा क्रॉपिग करनी पड़ती ह।ै

हाई डेफिनेशन फॉर्मेट हाई डेफिनेशन TV की शुरुआत सभी फॉर्मेट में मानकीकरण लाने के प्रयास स्वरूप की गई ह ैजिसमें वाइडस्क्रीन फॉर्मेट के कई 

विज़अल फायदे मिलते हैं, पर इसके लिए अत्यधिक लेटरबॉक्सिंग या क्रॉपिग की ज़रूरत नहीं होती, जो किसी टीवी स्क्रीन पर दिखाने के दौरान एकेडमी 

में करना करना पड़ता ह।ै हाई डेफिनेशन के लिए अपेक्षित रेशिय ो 1.78:1 (या 16:9) होता ह,ै जिसका अर्थ ह ैकि हर एक यनूिट ऊँचाई के लिए चौड़ाई 1.78 

यनूिट्स होगी।



6564

प्रतिभागी पुस्तिका

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए



6564

प्रतिभागी पुस्तिका रोटो आर ट्िस्ट

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

4. Rotoscoping फुटजे

यनूिट 4.1 – Rotoscoping एनिमेशन बनाना

यनूिट 4.2- एनिमेशन के लिए प्रयुक्त टूल्स

MES/N 3506
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इस मॉड्यलू के अंत में, आप निम्न में सक्षम होंगे:

1.	 Rotoscoping एनिमेशन बनायें

2.	 बाज़ार में प्रोडक्शन के लिए उपलब्ध विभिन्न प्रकार के सॉफ्टवेयर टूल्स से परिचित होने में।

3.	प्रो डक्शन के लिए सर्वोत्तम टूल की खोज करने और सुझाव देने में।

4.	प्रो डक्शन के लिए प्रोडक्शन शेड्यलू के अनुसार समय-सीमाओ ंका मूल्यांकन करने में।

निष्कर्ष 
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यूनिट 4.1: Rotoscoping एनिमेशन बनाना

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 Rotoscoping क्या ह,ै विस्तार से बतायें

2.	 Rotoscoping एनिमेशन बनायें

यूनिट के उद्देश्य  

4.1.2 कीफ्रे म इंटरपोलशेन
आरंभ में एनिमेशन, समग्र रूप में शेप के लिए ट्रांसलेशन, रोटेशन, स्के ल तथा स्क्यू परिभाषित करने के लिए, हैंडल्स का प्रयोग करके रिजिट बॉडी 

ट्रांसफॉर्मेशन के प्रयोग से की जाती ह।ै  फिर अलग-अलग कंट्रोल प्वाइंट्स सिलेक्ट तथा ट्रांसफॉर्म  करके नॉन-रिजिड डिफॉर्मेशन तयैार किया जाता ह।ै 

जहां संभव हो, यह प्वांट्स के समूह मॉडिफाई करके भी किया जा सकता ह।ै एनिमेशन क्रिएट करने की दो मानक विधियां हैं, या तो शॉट पर की पोज़िज 

का मिलान करके और फिर जहां ज़रूरत हो इंटरमीडिएट कीफ्रे म्स की बारी-बारी से सबडिवाइडिग तथा एडिग से या फिर एक शॉट में क्रमानुसार आगे बढ़ 

कर हर आखिरी (nth) फ्रे म पर एक कीफ्रे म क्रिएट करते हुए। शॉट के शेष फ्रे म फिर अपने आस-पड़ोस के कीफ्रे म से एक पंक्ति बनाते हुए बिठा दिए जाते हैं 

(लीनियर इंटरपोलेशन)।

4.1.3 ट् रैकिग के साथ एक्सीलरेेशन
यदि शॉट में किसी प्रकार की ट्रैकिग की जा सके, तो वर्क फ्लो में सक्षमता (एफिशिएंसी) हासिल की जा सकती ह।ै एक मचै-मूव्ड कैमरा द्वारा ऑब्ज़र्व किए 

गए रिजिड सीन के एक आदर्श मामले में, ज्योमटै्रिक कंस्ट्रेंट्स/अवरोधों को रोटो-शेप्स को सही तरीके से मूव कराने हेतु काम में लाया जा सकता ह।ै इन 

दृश्यों को आसान शॉट माना जाता ह ैऔर इन पर यहां आगे विचार नहीं किया गया ह।ै अधिक वास्तविक सिनेरियो/परिदृश्य एक मूविंग एलीमेंट का ह,ै जो 

शॉट में बिल्कु ल अलग ह।ै इस मामले में, यह संभव हो सकता ह।ै

कंट्रोल प्वाइंट्स के ग्रुप को संचालित करने के लिए 2D का प्रयोग या प्लानर ट्रैकिग का प्रयोग करके रिजिड बॉडी एनिमेशन परिभाषित की जा  

सकती ह।ै

ट्रैकिग में आमतौर पर सारे  इमेज फ्रे म्स में इमेज अपीयरें स का मिलान करने के लिए ग्रेडिएंट-डिसेंट आधारित ऑप्टिमाइज़ेशन का प्रयोग किया जाता ह।ै 

प्लानर ट्रैकिग में इसी तरह का फ्रे मवर्क  प्रयोग किया जाता ह,ै जिसमें एक मास्क के भीतर pixels के लिए फ्रे म्स के बीच में परैामीटराइज़्ड वार्प  के आधार 

pixel रिज़न ट्रैक किए जाते हैं। ये पद्धतियां सर्च रें ज को विस्तृत कर सकती हैं और इमेज पिरामिड्स में कॉर्स-टु-फाइन pixels का मिलान करके ट्रैकिग को 

एक्सीलेरे ट कर सकती हैं। यदि वीडियो में स्पष्ट रूप से परिभाषित एजिज़ उपलब्ध हों, तो डायरेक्ट  कर्व ट्रैकिग एक प्रभावी विकल्प ह।ै

4.1.1 मानक कार्य-प्रवाह/स्टैंडर्ड वर्क फ्लो
किसी शॉट में एक एलीमेंट को रोटोस्कोप करने के लिए आर्टिस्ट क्लोज़्ड स्प्लाइंस का एक सेट तयैार करता ह,ै जो एलीमेंट के लिए कम्पोनेंट शेप्स 

परिभाषित करते हैं। उदाहरण के लिए, किसी व्यक्ति को रोटोस्कोप करने के लिए, प्रत्येक आर्टिक्यूलेटिड एलीमेंट के लिए रोटो-शेप्स तयैार की जाती हैं, 

जसेै ऊपरी तथा निचली बाहें, हाथ, अँगुलियां तथा चेहरा। फिर शॉट की मूवमेंट से तालमेल बिठाने के लिए आर्टिस्ट इन शेप्स को स्वतंत्र रूप से मनैिपुलेट 

करता ह।ै Rotoscoping का काम, मूवमेंट को समझने तथा यह देखने के लिए कि सीन/दृश्य को अलग-अलग मूवमेंट में कैसे तोड़ना ह,ै शॉट के विश्ले षण 

से शुरू होता ह।ै

फिर एक की पोज़ चुन लिया जाता ह,ै जो प्रत्येक शेप की आउटलाइन को परिभाषित करता ह,ै फिर आर्टिस्ट शेप को एनीमेट करने के लिए बाहर से/

आउटवार्ड  काम करता ह।ै
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4.1.4 Rotoscoping एनिमेशन बनाना

4.1.5 स्पेशल इफैक्ट (2D और 3D)
प्रोडक्शन यदि काफी बड़ा होता ह,ै वहाँ एनिमेटर के काम को मदद करने के लिए निश्चित रूप 

से एक स्पेशल इफैक्ट विभाग होगा। स्पेशल इफैक्ट में किसी शॉट में आग लगने या बिजली 

कड़कने के इफैक्ट से लेकर, ज़बर्दस्त तफूान पदैा करने या 3D मूवीज में ज्वालामुखी फटने के 

इफैक्ट तक कुछ भी हो सकता ह।ै खासतौर से 3D एनिमेशन में इतनी सारी परस्पर-व्याप्त 

(ओवरलपैिग) विशिष्टताएं होती हैं, कि यह जानना कठिन हो जाता ह,ै कि कहाँ "एनिमेशन’’ 

खत्म होता ह ैऔर कहॉ ं"स्पेशियल इफैक्ट्स ’’ शुरू होते हैं। उदाहरण के लिए डायनोसोर्स को 

एनिमेट करने का मतलब केवल एक भीमकाय जीव मॉडल को स्क्रीन पर मूव करना भर नहीं 

ह।ै आजकल, दर्शक खाल के अंदर मांसपेशियों की हरकत और तो और गतिशील मांस-पेशियों 

पर खाल का उतार-चढ़ाव भी देखने की अपेक्षा रखते हैं। इसे अलग-अलग विशेषज्ञ प्रदर्शित 

करते हैं, पर क्या उन्हें एनिमेटर या स्पेशल इफैक्ट आर्टिस्ट कहा जाता ह?ै

चित्र 4.1.1: एनिमेटिड इफैक्ट्स: स्पीड लाइंस तथा डस्ट क्लाउड्स (धूल 
के बादल) जैसे बेहद सादा तथा परम्परागत से लेकर आधुनिक हॉलीवुड 
एक्शन मूवीज जैसे बेहद परिष्कृत  तक विस्तृत हैं।

4.1.6 (2D) की जाँच करना
जब 2D प्रोडक्शन में सारा एनिमेशन परूा हो जाये, तो काम के कलरिंग, स्कैनि ग या फिल्मिंग 

में आगे जाने से पहले यह जाँच लेना बेहद ज़रूरी ह,ै कि सब कुछ बिल्कु ल सही ह ै कि नहीं। 

किसी काम को दोबारा करने में लगने वाली लागत से हर कीमत पर बचना चाहिये। इसलिए 

यह जाँचना कि सभी ड्रॉइंग मौजदू हों; अन्य विभागों के लिए एनिमेटर द्वारा दिये गये निर्देश 

सटीक और स्पष्ट हों; और यहाँ तक कि सभी आर्टवर्क  डिजिटल स्कैनि ग, कलरिंग या फिल्मिंग 

के लिए उपयुक्त हों, सभी 2D प्रोडक्शन के लिए एक महत्त्वपरू्ण  चरण ह।ै विशेषज्ञ ये सब 

व्यवस्थित (हैंडल) कर लेंगे, लेकिन उन्हें एनिमेटर कहा जाता ह ैया स्पेशियल इफैक्ट आर्टिस्ट?

चित्र 4.1.2 निरीक्षण (2D)

चरण 1: शुरुआती रोटो-कर्व्स चरण 2: एनिमेटर सबसे बाई ंओर के कीफ्रे म पर ब्रश स्ट्रोक ड्रॉ करता 

ह,ै जो रोटो-कर्व के साथ एसोसिएट हो जाता ह ैऔर इस एसोसिएशन से 

अगले फ्रे म्स के लिए नए स्ट्रोक क्रिएट किए जा सकते हैं।

चरण 3: (b) के समान ही, केवल स्ट्रोक पीछे  की ओर प्रसारित होते हैं चरण 4: कीफ्रे म्स के बीच के स्ट्रोक ब्लैंड कर दिए जाते हैं।
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4.1.7 स्कैनि ग (2D)
जब सभी ड्रॉइंग परूे  हो जाते हैं, तो उनकी अलग-अलग स्कैनि ग और नम्बरिंग की जाती ह।ै आज कल डिजिटल स्कैनि ग ज़्यादा से ज़्यादा पसंदीदा विकल्प 

हो गया ह ै(रोस्ट्रम कैमरा का इस्तेमाल करने वाली पारंपरिक फिल्मिंग के मुकाबले), क्योंकि ज़्यादातर स्कैं ड फाइलें अधिक क्लीन होती हैं और डिजिटल 

प्रोडक्शन प्रक्रिया में उन्हें प्रबंधित करना अधिक आसान होता ह।ै (हालांकि व्यावसायिक डिजिटल रोस्ट्रम कैमरा महंगा होता ह,ै पर यह कैमरा स्कै न 

इमेजिज को टक्कर दे सकता ह ैऔर प्रोड्यजू़/निर्माण में काफी तेज़ होता ह।ै)

लाइन क्वालिटी यदि पर्याप्त गहरी हो और लाइन में कुछ ही ब्रेक्स या पेपर ग्रेन हों, तो ओरिजिनल पेंसिल ड्रॉइंग्स को स्कै न करना और डिजिटल तौर पर 

कलर करना संभव ह।ै हालांकि, स्कैनि ग के लिए काली लाइन सबसे अच्छी होती ह,ै जिसका अर्थ ह ैकि पेंसिल ड्रॉइंग्स का जब परीक्षण हो जाता ह ैऔर 

मंजरूी मिल जाती ह,ै तो उसे स्कैनि ग प्रक्रिया आरंभ होने से पहले क्लीन-अप और इंक इन (जसेै कि आरंभिक पेंसिल स्के च्ड लेआउट परूा हो जाने के बाद 

चित्रकथा की किताब को इंक इन किया जाता ह)ै करना चाहिए। स्कै नर पर प्राइमरी कलर फिल्टर के साथ अंतिम स्कै न से सभी नीली पेंसिल की 

कंस्ट्रक्शन लाइंस को (नीचे दिया चित्र देखें) हटाया जा सकता ह।ै इससे बेसिक इंक्ड-इन ड्रॉइंग्स सॉलिड-लाइन फिनिश्ड कैरेक्टर  में बदल जाती हैं, जो 

डिजिटल कलरिंग के लिए तयैार होती हैं।

चित्र 4.1.3: प्राइमरी कलर फिल्टर से स्कै न करने पर ही कोई इंक्ड-इन ड्रॉइंग कलरिग के लिए तैयार होता है।

4.1.8 कलरिंग (2D)

जब परूा आर्टवर्क  डिजिटल फॉर्म  में आ जाये, तो डिजिटल पेंट प्रोग्राम के साथ कलर डालना 

अपेक्षाकृत आसान होता ह।ै हालांकि इन दिनों डिजिटल एनिमेशन के दो बेसिक फॉर्म  चल रहे हैं: 

vector तथा raster। Vector एनिमेशन वबै तथा Flash एनिमेशन के लिए अधिक उपयुक्त होता ह,ै 

हालांकि 2D के लिए पेंसिल ड्रॉइंग क्षमताओ ंवाले डेस्कटॉप एनिमेटर्स ।

चित्र 4.1.4: होल्डिंग लाइंस हटने से इस ब्लैक एंड व्हाइट 
कैरेक्टर पर शेष बचे फ्लैट कलर अपनी तरह का एक दिलचस्प 
डिजाइन बनाते हैं।
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4.1.9 कम्पोज़िटिंग (2D तथा 3D)
2D एनिमेशन के लिए पुरानी पारंपरिक विधि के विपरीत, 2D तथा 3D एनिमेशन में आधुनिक डिजिटल एनिमेशन तकनीकें  बहुत हद तक इमेज की 

कम्पोज़िटिग, कई एनिमेशन स्तरों या परतों के संयोजन से एक पिक्चर बनाने पर टिकी हुई होती हैं।

डिजिटल आर्टिस्ट असीमित संख्या में लेयर्स कम्पोजिट कर सकता ह ैऔर उन्हें कभी डस्ट, कलर खराब होने या विभिन्न लेयरों के बीच कलरिंग की 

असमानता की कोई समस्या नहीं होती।

डिजिटल कम्पोज़िटिग अलग-अलग माध्यमों के आसान मिश्रण की सुविधा भी उपलब्ध कराती ह,ै जसेै कि 2D एनिमेशन, 3D एनिमेशन, लाइव-एक्शन 

फिल्म, फोटोग्राफ्स, इलस्ट्रेशंस तथा ग्राफिक आर्टवर्क  इत्यादि जिसकी मदद से एक सिगल फिल्म इमेज बनाई जा सकती ह।ै हॉलिवुड फिल्म, ख़ासकर 

(लाइव एक्शन तथा एनिमेटेड दोनों) डिजिटल कम्पोज़िटिग द्वारा प्रदान किए जाने वाले विकल्पों से कामयाब होती हैं। दरअसल, इन दिनों ज़्यादातर 

हॉलीवुड फिल्में डिजिटल कम्पोज़िटिग तकनीकों का इस्तेमाल किए बिना तो बनाई ही नहीं जा सकती थीं!

चित्र 4.1.5: गतिमान तथा स्थित तत्त्वों को अलग-अलग करने से हरेक फ्रे म के लिए रीड्रॉइंग की मात्रा कम हो जाती है।

4.1.10 एडिटिंग (2D तथा 3D)

लाइव-एक्शन एडिटिग बेहद रचनात्मक प्रक्रिया होती ह,ै क्योंकि निर्देशक तथा एडिटर फिल्म के हरे क सीन के लिए ढेर सारे  शॉट लेते हैं और ट्रायल व 

एरर विधि का इस्तेमाल करते हैं और साथ ही फिल्म सामग्री की सबसे बेहतरीन व्याख्या करता एक संतोषजनक एडिट तयैार करने हेतु उन विकल्पों को 

हटा देते हैं, जिनकी आवश्यकता सबसे कम ह।ै फिल्म का एक भी सीन एनीमेट करने से पहले ही एनिमेशन/एनिमेटर सभी फैसले ले चुका होता ह ैऔर 

इसलिए, जब तक कि ओरिजिनल स्टोरीबोर्ड  या एनीमटैिक अप फ्रं ट के साथ कोई बहुत बड़ी चकू न हो गई हो या जब तक कि परूी ही सीक्वेंस पुन: 

डिजाइन न की जानी हो, तयैार एनीमटैिड सीन काफी हद तक मौज़ूदा एनीमटैिक में ड्रॉप किये जाते रहेंगे, जसै ही वे उपलब्ध हों, जब तक कि परूा 

एनीमटैिक फिनिश्‍ड, कलर्ड  तथा कम्पोज़िटिड एनिमेशन फुटेज से न बदल जाये।
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चित्र 4.1.6: सॉफ्टवेयर, जैसे Premiere, जो एनिमेटर के लिए एनिमेशन में एडिटिंग के पहलुओं को 
बेहद आसान बना देता है!

4.1.11 फाइनल डब (2D और 3D)

जब फाइनल पेंसिल एनिमेशन परूा हो जाता ह,ै तब साउंड एडिटर और फिल्म स्कोर कम्पोज़र फाइनल ऑडियो मटैीरियल बनाएंगे। (लाइव-एक्शन 

फिल्मिंग के साथ, यह प्रायः फिल्म एडिट होने तक नहीं हो सकता ह।ै) यह अक्सर Foley साउंड की रिकॉर्डिंग तथा फिल्म स्कोर कम्पोज़र के लिए 

म्यूजिकल इंटरल्यूड्स की कम्पोज़िग तथा रिकॉर्डिंग की सरल प्रक्रिया मात्र होती ह।ै

चित्र 4.1.7: डब

4.1.12 डिज़िटल से फिल्म ट्रांसफर (2D और 3D)

डिज़िटल रूप से बनी फिल्म को यदि थिएटर में दिखाया जाना हो तो, इसे फिल्म में बदला जाना होता ह।ै यह काम पेशेवर रूप से किया जाना होता ह,ै 

जिसके लिए ऐसे विशिष्ट फिल्म रिकॉर्डिंग उपकरण चाहिये होते हैं, जो अधिकांश स्वतंत्र फिल्म-निर्माताओ ंकी पहँुच से बाहर होते हैं।
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यूनिट 4.2: Rotoscoping के लिए प्रयोग किए जाने वाल ेटूल्स

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 2D तथा 3 D एनिमेशन के प्रोडक्शन में प्रयोग किे  जाने वाले सॉफ्टवेयर/टूल्स की पहचान करने में।

4.2.1 2D एनिमेशन टूल्स

एनिमेशन बनाना हमेशा से ही ग्राफिक डिज़ाइन का सबसे जटिल पहल ूमाना जाता रहा ह,ै जिसके लिए विशेष सॉफ्टवेयर तथा तकनीकी विशेषज्ञता की 

आवश्यकता होती ह।ै यह समय खपाने वाला काम होता ह ैजिसक लिए भारी-भरकम सॉफ्टवेयर तथा हाई स्पीड कम्प्यूटर की आवश्यकता होती ह।ै

हालांकि पिछले कुछ वर्षों के दौरान कई प्रकार के ऑनलाइन प्रेज़ेंटेशन तथा एनिमेशन टूल आ जाने के के बाद से एनिमेशन बनाने की प्रक्रिया काफी 

सरल हो गई ह।ै इनमें से ज़्यादातर वेब-आधारित टूल्स का परिचालन काफी आसान होता ह ैऔर उनसे ऐसे एनिमेशन बनाए जा सकते हैं जो रोज़मर्रा  के 

अनुप्रयोगों के लिए बिल्कु ल उपयुक्त होते हैं।

चित्र 4.2.1: लाइट बॉक्स

चित्र 4.2.3: Photoshop

यूनिट के उद्देश्य  

लाइट बॉक्स/एनिमेशन डेस्क

एनिमेट करने के लिए आपकी जो सबसे बुनियादी ज़रूरत होती ह,ै वह ह ैएनिमेशन डेस्क या लाइटबॉक्स।

Adobe Flash Professional CS6

Adobe® Flash® Professional CS6 सॉफ्टवेयर एनिमेशन और मल्टीमीडिया कंटेट बनाने के लिए एक 

शक्तिशाली ऑथरिंग एंवायरन्मेंट होता ह।ै डिज़ाइन से भरपरू रोचक एहसास जो डेस्कटॉप तथा टबै्लेट्स, 

स्मार्टफोन तथा टेलीविज़न जसेै कई सारे  डिवाइसों पर निरतर रूप से मौजदू होते हैं।

चित्र 4.2.2: Flash

Photoshop

किसी एनिमेशन सॉफ्टवेयर पर विचार करते समय Photoshop को कभी-कभी नज़रअंदाज़ कर दिया जाता ह,ै 

पर वास्तव में इसकी शक्तिशाली ड्रॉइंग क्षमता इसे फ्रे म बाय फ्रे म डिज़्नी-स्टाइल एनिमेशन के लिए सबसे अच्छा 

विकल्प बनाती ह।ै Photoshop की टाइमलाइन कार्यात्मकता फ्रे म बाय फ्रे म ड्रॉइंग की मदद से ओनियम स्किनिग 

का उपयोग कर एनिमेशन करना सुगम बनाती ह ैऔर यह काफी कारगर होता ह ै।
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4.2.2 3D एनिमेशन सॉफ्टवेयर

चित्र 4.2.5: Monkeyjam

चित्र 4.2.8: 3ds मैक्स

चित्र 4.2.4: Toon Boom Harmony

Toon Boom Harmony

Toon Boom का एनीमेट सॉफ्टवेयर पेशेवरों के लिए या उनके लिए डिजाइन किया गया ह,ै जो उच्च-स्तरीय 

टूल्स तथा इफैक्ट्स  चाहते हैं। इसे Flash के एक गंभीर प्रतिस्पर्धी के रूप में डिजाइन तथा मार्के ट किया  

गया ह।ै 

MonkeyJam

MonkeyJam एक कमाल का एनिमेशन प्रोग्राम ह ै जिसे मूल रूप से पेंसिल तथा पेपर से बने ड्रॉइंग्स को गति 

प्रदान करने के लिए डिज़ाइन किया गया था। इसके अत्याधनिक संस्करण में कई नए फीचर्स शामिल हैं, जसेै कि 

Stop Motion तथा कैप्चरिंग मोड्स. मूल रूप से यह आपको किसी वीडियो से कैप्चर किए ड्रॉइंग्स और इमेज़ों से 

एनिमेशन बनाने में मदद करता ह,ै जहाँ इसके पास पसंदीदा एनिमेशन पाने के लिए कंफिगर करने के कई सारे  

विकल्प मौज़दू रहते हैं।

ऑटोडेस्क Maya

Maya इस इंडस्ट्री का मानक 3D सॉफ्टवेयर ह,ै जिसका इस्तेमाल अधिकतर बड़े स्टूडिय ो में किया जाता ह।ै 

Maya, सॉफ्टइमेज तथा 3D मकै्स दरअसल ये सभी ऑटोडेस्क के पार्टृस होते हैं और ये एक ही तरीके से काम 

करते हैं। 

चित्र 4.2.6: ऑटोडेस्क Maya

ZBrush

ZBrush एक डिज़िटल स्कल्पटिग तथा पेंटिग प्रोग्राम होता ह ैजो आपको किसी 2D या 3D कंसेप्ट को झटपट 

स्केच  आउट करने के लिए आवश्यक टूल्स प्रदान करता ह ैऔर फिर उस आडिया को परू्णतातक लेकर जाता ह।ै 

आप लाइटिग तथा ऐटमोस्फे रिक इफैक्ट के साथ सीधा ZBrush में रियलिस्टिक रें डर्स बना सकते हैं।

3ds मकै्स

ऑटोडेस्क 3ds मकै्स गेम डेवलपर्स, विज़अल इफैक्ट आर्टिस्टों तथा ग्राफिक डिज़ाइनरों को एक व्यापक, 

एकीकृत 3D मॉडलिग, एनिमेशन तथा रें डरिंग सोल्यूशन प्रदान करता ह।ै परूी तरह से एकीकृत Character 

Animation Toolkit (CAT) अनोखा उन्नत रिगिग तथा एनिमेशन सिस्टम प्रदान करता ह।ै 

चित्र 4.2.7: ZBrush
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Blender

ब्लेंडर एक मुफ्त तथा ओपन सोर्स खुला स्रोत वाला 3D एनिमेशन सुईट होता ह।ै यह सपरू्ण  3D पाइपलाइन को 

सपोर्ट  करता ह:ै मॉडलिग, रिगिग, एनिमेशन, सिम्युलेशन, रें डरिंग,कम्पोज़िटिग तथा मोशन ट्रैकिग, यहाँ 

तक कि वीडियो एडिटिग और गेम क्रिएशन को भी। उन्नत प्रयोक्ता Python scripting हेतु ब्लेंडर के API का 

इस्तेमाल करता ह ैऔर इसके जरिए ऐप्लिकेशन कस्टमाइज़ करता और विशेष टूल राइट करता ह।ै 

चित्र 4.2.9: Blender

4.2.3 कम्पोज़िटिंग सॉफ्टवेयर तथा VFX

Adobe After Effects CS3

After Effects CS3 की मदद से आप मूविंग इमेजरी, स्टिल इमेजों तथा ग्राफिक्स, टेक्स्ट और 2D या 3D स्पेस में 

साउंड के संयोजन से उच्च प्रभाव वाले कम्युनिकेशन बना सकते हैं और फिर वस्तुत: प्रत्येक एलीमेंट के किसी 

भी पहल ूको एनिमेट कर सकते हैं। आप जाने-पहचाने Adobe टूल्स इस्तेमाल करके After Effects में टेक्स्ट और 

vector ग्राफिक्स भी बना सकते हैं और फिर देखने में बिल्कु ल नए मोशन ग्राफिक्स के निर्माण के लिए इन 

एलीमेंट्स को एनिमेट कर सकते हैं।

चित्र 4.2.10: Adobe After Effects CS3

NUKE

Nuke एक नोड-आधारित डिज़िटल कम्पोज़िटिग ऐप्लिकेशन ह ैजिसका विकास The Foundry द्वारा किया गया 

ह ै और इसका इस्तेमाल फिल्म तथा टेलीविज़न पोस्ट-प्रोडक्शन के लिए किया जाता ह।ै NUKE, Microsoft 

Windows, OS X, तथा Linux के लिए उपलब्ध ह।ै

चित्र 4.2.11: Nuke

Realflow

RealFlow इस उद्योग का एक मानक, अनोखा फ्लुइड सिमुलेशन सॉफ्टवेयर ह।ै यह बेहद तेज़ ह ैऔर इसे 

इस्तेमाल करना तेज़ और आसान ह,ै यह सभी बड़े 3D प्लेटफॉर्म  के साथ उपयुक्त (कम्पैटिबल) होता ह।ै

चित्र 4.2.12: Realflow
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4.2.4 एडिटिंग सॉफ्टवेयर 

Final Cut Pro

Apple Final Cut Pro उद्योग स्तरीय नॉन-लीनियर एडिटिग सॉफ्टवेयर ह।ै इसका प्रयोक्ता अनुकूल इंटरफेस, 

इसे गुणवत्तापरू्ण  एनिमेशन, मोशन ग्राफिक्स तथा साउंड इनपुट्स बनाने के लिए पसंदीदा विकल्प बनाता ह।ै 

Final Cut Pro का इस्तेमाल टेलीविज़न, फिल्मों तथा विज्ञापनों में किया जाता ह।ै फिल्मों के काम में Final Cut 

Pro के इस्तेमाल के उदाहरणों में शामिल ह ै The Cold Mountain, The Curious Case of Benjamin Button 

इत्यादि।

चित्र 4.2.13: Final Cut Pro

Adobe Premiere

Adobe Premiere का इस्तेमाल 3D एनिमेशन तथा ग्राफिक्स के एडिटिग (टाइटल जोड़ना तथा विज़अल 

इफैक्ट्स  देना, इत्यादि) में किया जाता ह।ै इसका इस्तेमाल कई लोकप्रिय टीवी शो तथा मूवीज़ में किया  

जाता ह।ै

चित्र 4.2.14: Adobe Premiere



7776

प्रतिभागी पुस्तिका

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए



7776

प्रतिभागी पुस्तिका रोटो आर ट्िस्ट

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

5. 2 D एनिमेशन बनाएँ

यनूिट 5.1 - Photoshop पर कार्य  करना

यनूिट 5.2 - Flash पर कार्य  करना
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इस मॉड्यलू के अंत में, आप निम्न में सक्षम होंगे:

1.	 कम्पोजिशन के लिए स्टोरीबोर्ड  का पालन करने में, अर्थात बकैग्राउंड और कैमरा के नज़रिए से कैरेक्टर  की पोजिशनिग कर, वांछित एनिमेशन 

बनाने में।

2.	 स्ट्राँग पोज़िज़ Incorporate audio/music assets के लिए एक संदर्भ बिदु स्थापित करने हेतु की फ्रे म ड्रॉइंग्स ड्रॉ/सोर्स करने में

3.	य ह ध्यान रखने में कि एक सीन से दूसरे  में हुक-अप/ट्राज़िशन बिल्कु ल सही तरीके से संपन्न किया जाता हो।

4.	 लेयर्स के साथ काम करने तथा अच्छा पर्सपेक्टिव व्यू पाने में

5.	 टीम के भीतर तथा असेट्स, लाइटिग व इफैक्ट जसेै विभागों के साथ मिलकर प्रभावी रूप से काम करने में।

6.	डिज़ ाइन विनिर्देशों तथा प्रोड्यसूर ब्रीफ को ध्यान में रखते हुए बने हुए एनिमेशन का समीक्षात्मक रूप से मूल्यांकन करने में।

7.	य ह ध्यान में रखने में कि वर्क -प्रोडक्ट गुणवत्तापरू्ण  मानकों पर खरे  उतरते हों (ताकि उन्हें न्यूनतम इटरे शन के साथ स्वीकृत किया जा सके) और 

तय टाइमलाइन के भीतर परूा किया जाए।

8.	सिक्व ेंस तथा सीन/शॉट्स तयैार करने में डिजाइन, 2D एनिमेशन तथा फिल्म-मेकिग के सिद्धांतों को अपनाने में।

निष्कर्ष 
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यूनिट 5.1: Photoshop पर कार्य करना

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 समीक्षा के लिए एक प्रोटोटाइप 2D कार्य  उत्पाद/प्री-विज़ुअलाइज़ेशन तयैार करने में

2.	 Photoshop सॉफ्टवेयर पर कार्य  करने में

5.1.1 Photoshop टूल बार

यूनिट के उद्देश्य  

स्क्रीन में सबसे ऊपर मेन्यू बार पर विंडो पर क्लिक करें , फिर टूल्स पर क्लिक करें । इससे टूल बार दिखने लगेगी। Photoshop CS3 में टूल बार दो प्रकार 

से दिखाई जा सकती ह।ै नीचे दिए गए चित्र उनके अंतर दर्शा एंगे:

चित्र 5.1.1: Photoshop के विंडो
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कॉम्पैक्ट टूल बार

एक्सटेंडेड टूल बार

टूलबार के ऊपर, बाई ंओर तीरों का एक छोटा सा जोड़ा कॉम्पैक्ट और एक्सटेंडेड प्रदर्शन इंगित करता ह:ै

चित्र 5.1.2: कॉम्पैक्ट टूल बार

चित्र 5.1.3: एक्सटेंडेड और कॉम्पैक्ट प्रदर्शन
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चित्र 5.1.4: टूल्स के नाम

टूल बार पर मौजदू कई बटनों में एक से अधिक टूल या एक ही टूल के अलग-अलग मोड शामिल होते हैं। उदाहरण के लिए, Lasso टूल में Polygonal टूल 

और Magnetic Lasso टूल के बटन छिपे होते हैं। नीचे दिए गए चित्र में अतिरिक्त टूल या मोड दर्शाए गए हैं:
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चित्र 5.1.5: अतिरिक्त टूल्स
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5.1.1.2 टूल पलैटे

1.	 टूल जानकारी मेन्यू: टूल बार मेन्यू में से चुने गए टूल का साइज और उससे संबंधित अन्य विकल्प बदलता ह।ै

2.	 History पलैटे: अपने चरणों को परू्ववत (अनडू) करें । Photoshop आपकी क्रियाओ ंके लगभग 30 चरण (स्टेप्स) मेमोरी में रखता ह।ै आप जब चाहें तब 

मेन ऑप्शन में से हिस्टरी स्टेप्स की संख्या बदल सकते हैं।

3.	 Tool presets: वर्तमान टूल्स के लिए परिभाषित जानकारी

4.	 Brushes और Clone source: ब्रश चुनें और विकल्प बदलें। Clone source विकल्पों का उपयोग करें ।

5.	 Character एवं Paragraph: टेक्स्ट का साइज़, कलर, फ़ॉन्ट आदि चुनें। अपने टेक्स्ट को अलाइन (संरेखि त) करें । स्पेस और अन्य विकल्प बदलें।

6.	 Navigator एवं Info: अपनी स्क्रीन पर इमेज के विभिन्न भागों में/पर जाएं। ज़ूम इन और ज़ूम आउट का नियत्रण करें । इन्फ़ो के साथ किसी कलर या 

किसी ऑब्जेक्ट (वस्तु) की सटीक स्थिति पता करें ।

7.	 Color सलके्शन: कोई कलर चुनें या ग्रेडिएंट बनाएं।

8.	 Layer पलैटे: Photoshop की कुछ सबसे शक्तिशाली विशेषताओ ंमें से एक ह ैलेयर्स का उपयोग। Photoshop डॉक्युमेंट में हर लेयर एक अलग इमेज 

होती ह ैजिसे बाकी लेयर्स से अलग करके एडिट किया जा सकता ह।ै आप लेयर की कल्पना किसी पारदर्शी मटैीरियल की शीट पर रखे किसी चित्र 

के रूप में कर सकते हैं। 

लेयर्स का प्रबंधन Layers पलेैट (ऊपर वाले चित्र में देखें) के साथ किया जाता ह।ै Layers पलेैट हर लेयर का एक छोटा थंबनेल दृश्य दिखाता ह ैजिससे उसे 

पहचानने में आसानी होती ह।ै 

आप लेयर की दृश्यता (विज़िबिलिटी) को ऑन व ऑफ कर सकते हैं और किसी एक भी pixel को स्थायी रूप से प्रभावित किए बिना इमेज की परूी अपीयरें स 

(दिखावट, रूप-रंग आदि) बदल सकते हैं। हर लेयर के बाई ंओर मौजदू आँख वाला आइकन उसकी दृश्यता को नियत्रित करता ह।ै लेयर के आँख वाले 

आइकन (नीचे देखें) पर क्लिक करके लेयर को दृश्य (विज़िबिल) या अदृश्य (हिडन) बना सकते हैं। नतीजे में हमें वही पहले वाला Photoshop डॉक्युमेंट 

मिलता ह,ै बस एक अपवाद होता ह ैकि उसकी एक लेयर को छिपा दिया गया ह ैजिससे उसके नीचे की सफेद पषृ्ठभमूि दिखने लगी ह।ै 

किसी लेयर को मिटाने के लिए, Layers पलेैट (नीचे देखें) में उस पर क्लिक करें  और खींचते हुए Trash बटन तक ले आएं। परिणाम नीचे दाई ंओर दिखाया 

गया ह।ै

चित्र 5.1.8: टूल पैलेट
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ध्यान दें: डॉक्युम ेंट विडंो की दिखावट (अपीयरें स) म ें कोई बदलाव नहीं हुआ ह।ै कौन-सी लयेर एक्टिव ह ैयह देखन ेके लिए हमशेा Layers पलैटे को देखें, 
डॉक्युम ेंट विडंो को नहीं।

5.1.1.3 इमेज कैप्चर करना

आप अपनी इमेज में फेर बदल करने के लिए Photoshop का उपयोग कर सकते हैं। आप डिजिटल कैमरा, मोबाइल फोन कैमरा, स्कै नर और/या इंटरनेट से 

अपनी इमेज इम्पोर्ट  कर सकते हैं।

डिजिटल कैमरा: अपने USB डिजिटल कैमरा को कनेक्ट करें  और अपनी सारी इमेज अपनी हार्ड  ड्राइव में किसी ऐसे फोल्डर में कॉपी कर दें जहां आप 

बाद में उन्हें ढंूढ सकें । इसके बाद Photoshop में जाएं, File > Open> पर क्लिक करें  और जो इमेज आप खोलना चाहते हैं उन तक जाएं।

ध्यान दें: सुनिश्चित करें  कि आप सशंोधित इमजे को नए नाम स ेसवे करें , ताकि यदि आप मलू इमजे को दोबारा उपयोग करना चाहें तो वह आपके पास 

उपलब्ध हो।

चित्र 5.1.3(a): Layers पैलेट चित्र.5.1.3(b): Layers पैलट

चित्र 5.1.4: इमेज खोलें
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5.1.1.4 Photoshop में इमेज को विभिन्न फाइल प्रकारों में सेव करना

मोबाइल कैमरा: USB केबल से मोबाइल फोन के कैमरे  को अपने PC / MAC से उसी प्रकार जोड़ें जसेै ऊपर (डिजिटल कैमरा के लिए) बताया गया ह।ै

इंटरनेट से इमेज: इंटरनेट पर अपनी इमेज ढंूढें  और उन्हें हार्ड  ड्राइव पर किसी फोल्डर में सेव कर लें। सुनिश्चित करें  कि आप फोल्डर को कोई ऐसा नाम 

दें जिससे आप बाद में फोल्डर ढंूढ सकें  और अपनी इमेज खोल सकें । (प्रोजेक्ट दिशा-निर्देशों की मदद लें)

अपनी इमेज स्कै न करें : अपनी इमेज को स्कै नर के काँच की ओर करके रखें और File > Import > में जाएं और स्कै नर स्रोत चुन लें। कुछ मामलों में एक 

नयी पॉप अप विंडो दिखेगी। यह इस पर निर्भर करता ह ैकि आपके पास कौन-सा स्कै नर ह।ै और आपको अपनी इमेज के परैामीटरों में फेर -बदल करने 

की ज़रूरत पड़ेगी।

ध्यान दें: जो इमजे आप प्र िंट क्वालिटी की चाहत ेहैं उनके लिए: 150-300 dpi चनु ें। [dot (pixel) per inch] जो इमजे आप स्क्रीन के लिए प्रयोग करना चाहत े

हैं उनके लिए 72 dpi चनु ें।

ऊपर दिखाए गए चित्र में स्कै नर स्रोत से इमेज स्कै न करने के लिए की जाने वाली क्रियाएं दिखाई गई हैं।

Photoshop में आप अपनी फाइलों को विभिन्न प्रकारों में सेव कर सकते हैं। सबसे अधिक जाने-माने फाइल फॉर्मेट निम्नांकित हैं।

•	 JPEG: यह फोटोग्राफिक इमेज स्टोर करने और भेजने का सबसे आम फॉर्मेट ह।ै

•	 PSD: .PSD (Photoshop Document) फॉर्मेट Photoshop में उपलब्ध अधिकांश इमेजिग विकल्पों के समर्थन के साथ इमेज को स्टोर करता ह।ै इसमें 

मास्क्स के साथ लेयर्स, कलर स्पेस, ICC प्रोफाइल्स, ट्रांसपरे न्सी, टेक्स्ट, अल्फा चनैल और स्पॉट कलर्स, क्लिपिग पाथ्स, तथा डुओटोन सेटिग्स 

चित्र 5.1.4: इमेज इम्पोर्ट करना
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शामिल हैं। ऐसा कई अन्य फॉर्मेट्स (जसेै .EPS या .GIF) के विपरीत ह ैजो धाराप्रवाह, निर्बाध कार्यशीलता प्रदान करने के लिए विषय-वस्तु को 

सीमित कर देते हैं। Photoshop की लोकप्रियता का अर्थ ह ैकि .PSD फॉर्मेट का व्यापक उपयोग किया जाता ह ैऔर अधिकांश प्रतिस्पर्धा  सॉफ्टवेयर 

भी इसे कुछ हद तक समर्थित करते हैं।

•	 GIF: GIF सीमित संख्या में रंगों के साथ पनेै किनारों वाली रे खा कलाकृतियों (जसेै लोगो) के लिए उपयुक्त होता ह।ै इसमें फॉर्मेट के लॉसलसै 

कंप्रेशन का लाभ उठाया जाता ह।ै यह फॉर्मेट सुपरिभाषित किनारों के साथ एकसमान रंगों वाले क्षेत्रों के अनुकूल ह,ै जबकि इसके उलट JPEG फॉर्मेट, 

स्मूद ग्रेडिएंट्स तथा अधिक नर्म  इमेज के अनुकूल होता ह।ै GIF फाइलों को छोटे-छोटे एनिमेशन और कम रिज़ोल्यूशन वाली फिल्म क्लिप्स के लिए 

प्रयोग किया जा सकता ह।ै

ध्यान दें: आपको हमारा सझुाव ह ैकि आप अपनी सशंोधित इमजे (जिनमें लयेर्स शामिल हैं) को PSD फाइलों के रूप में सवे करें । ऐसा करन ेस ेआप जब 

भी चाहेंग ेतब इमजे म ें या इमजे म ें मौजूद टेक्स्ट में बदलाव कर पाएंग।े

5.1.1.5 कलर फॉर्मेट

5.1.1.6 साइज़ और रिज़ोल्यूशन

RGB

कलर मॉडल एक ऐडिटिव कलर मॉडल होता ह ैजिसमें लाल, हरी तथा नीली लाइट्स को कई तरह से साथ मिलाकर रंगों का एक व्यापक समूह बनाया 

जाता ह।ै इस मॉडल को अपना एडिटिव नाम तीन योगज प्राथमिक रंगों, रे ड, ग्रीन और ब्लू के पहले अक्षरों से मिला ह।ै आम RGB इनपुट डिवाइसों के 

उदाहरण हैं रंगीन TV और वीडियो कैमरा, इमेज स्कै नर और डिजिटल कैमरा।

CMYK

(स्यान, मेजेंटा, येलो तथा की (ब्लैक) का संक्षिप्त रूप और प्रायः इसे प्रोसेस कलर या चार रंग के रूप में जाना जाता ह)ै, एक सब्ट्रैक्टिव कलर मॉडल ह,ै 

जो कलर प्रिंटिग में प्रयोग होता ह ैऔर साथ ही,प्रिंटिग प्रक्रिया का वर्णन करने में भी। आमतौर पर स्याहियों को संक्षिप्त नाम के क्रम में ही लगाया जाता 

ह,ै हालांकि अलग-अलग प्रिंट घरानों, प्रिंट ऑपरे टरों, प्रेस निर्माता और प्रेस रन इस क्रम में बदलाव कर सकते हैं।

अपने प्रोजेक्ट की शुरूआत से ही अपनी फाइलों और 

फोल्डरों को व्यवस्थित करके रखना बहुत महत्वपरू्ण 

होता ह।ै

इमेजों को स्क्रीन रिज़ोल्यूशन (72 dpi) में सेव किया 

जाना चाहिए ताकि आप अपने Flash प्रोजेक्ट के साथ 

आसानी से कार्य  कर सकें । आपका Flash प्रोजेक्ट 

डिफॉल्ट साइज़ 400 x 550 पिक्सल पर आधारित होगा। 

इसलिए यदि आपकी इमेज का साइज़ अधिकतम 

800x600 पिक्सल हो तो इससे मदद मिलेगी।

•	 अपनी इमेजों का साइज़ और रिज़ोल्यूशन बदलें

•	 Photoshop में सबसे ऊपर वाले मेन्यू में इमेज में 

जाएं और इमेज साइज़ चुनें
चित्र 5.1.5: साइज़ और रिज़ोल्यूशन बदलें
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5.1.1.6 अपनी फाइलों को Adobe Flash के लिए उपयुक्त बनाना

अब जो विंडो दिखेगी उसमें आप इमेज की विमाएं और रिज़ोल्यूशन बदल सकते हैं। सुनिश्चित करें  कि Constrain Proportion बॉक्स में निशान लगा  

हुआ हो।

Adobe Flash के लिए अपनी फाइलों को उपयुक्त बनाने और सेव करने के कुछ तरीके 

मौजदू हैं। आपके लिए एक सरल तरीका यहां दिया जा रहा ह।ै

•	 जसैा कि हमने ऊपर बताया था, जब आप किसी इमेज को परूा करते हैं (टेक्स्ट, 

इफेक्ट  आदि), तो आप लेयर्स आदि शामिल करने के लिए उसे .psd फाइल के रूप 

में सेव करते हैं।

•	च ूंकि Flash .psd फाइल नहीं खोल पाएगा इसलिए हमें आगे लिखे चरणों का 

पालन करना होगा।

•	 सबसे ऊपर वाले मेन्यू बार पर जाएं और File > Save for the web & devises 

चुनें।

एक नयी विंडो खुलेगी जिसमें कुछ विकल्प होंगे। चित्र 5.1.6: फाइल सेव करें

चित्र 5.1.7: फाइल सेव करें
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Bitmaps

कम्प्यूटर ग्राफिक में एक bitmap या pixmap एक प्रकार की मेमोरी ऑर्गेनाइज़ेशन अथवा इमेज फाइल फॉर्मेट ह,ै जिसे डिजिटल इमेज्स को स्टोर करने के 

लिए प्रयोग किया जाता ह।ै bitmap शब्द की उत्पत्ति कम्प्यूटर प्रोग्रामिग की शब्दावली से हुई ह,ै अर्थात बिट्स का एक मानचित्र, बिट्स की एक स्थानिक 

मानचित्रित सारणी। अब, pixmap के साथ, इसका तात्पर्य  आमतौर पर पिक्सल्स की एक स्थानिक मानचित्रित सारणी से होता ह।ै Raster इमेज को 

आमतौर पर bitmaps या pixmaps के रूप में संदर्भित किया जा सकता ह,ै चाहे सिन्थेटिक हो या फोटोग्राफिक, फाइल में हों या मेमोरी में। जसेै कि 

Photoshop केवल bitmaps का प्रयोग करती ह,ै जो कि डिजिटल कैमरा या स्कै नर जसेै बाह्य स्रोतों की इमेज होती ह।ै

Vector

दाई ंओर आप चुन सकते हैं कि आप अपनी इमेज के लिए कौन-सा फॉर्मेट चाहते हैं। दो 

विंडोज में से बाई ंवाली में मूल इमेज होगी और दाई ंवाली में वह नई इमेज जिसे कलर 

रिज़ोल्यूशन के अनुसार सेव किया जाएगा।

जब आप कलर रिज़ोल्यूशन चुनें, तो save पर क्लिक करें  तथा इमेज को एक नए 

फोल्डर में सेव करें  (प्रोजेक्ट दिशा-निर्देशों को देखें)

ध्यान दें: यदि आपकी इमजे बकैग्राउंड म ें ट्रासपरेन्सी हो तो आपको क्लिक करके 

ट्रासपरेन्सी बटन का चयन करना होगा। उसके बाद आपकी इमजे .gif फाइल के रूप में 

सहेजी जाएगी।

कम्प्यूटर ग्राफिक्स में इमेज दर्शाने के लिए Vector ग्राफिक्स में जियोमटै्रिकल 

प्रिमिटिव्स - जसेै कि बिन्दु, रे खाएं, कर्व्स तथा आकृति अथवा पोलीगन(न्स) - का 

प्रयोग किया जाता ह,ै जो कि गणितीय समीकरणों पर आधारित होते हैं। Vector ग्राफिक 

फॉर्मेट raster ग्राफिक्स के संपरूक होते हैं। raster ग्राफिक्स, जो कि पिक्सेल की एक 

सारणी के रूप में इमेज का निरूपण होते हैं, जिन्हें आमतौर पर फोटोग्राफिक इमेज्स के 

निरूपण हेतु प्रयोग किया जाता ह।ै कई ऐसे अवसर आते हैं जब Vector टूल तथा फॉर्मेट्स 

के साथ कार्य  करना सबसे अच्छा होता ह,ै वहीं कई ऐसे अवसर भी आते हैं जब raster 

टूल तथा फॉर्मेट्स के साथ कार्य  करना सर्वोत्तम होता ह।ै कई बार दोनों फॉर्मेट्स का एक 

साथ भी प्रयोग किया जाता ह।ै दोनों प्रौद्योगिकियों के लाभों व सीमाओ,ं तथा दोनों के 

बीच के संबंध की समझ होने से संभावित तौर पर इन टूल्स का कुशलतापरू्वक एवं 

प्रभावी तरीके से उपयोग किया जा सकता ह।ै जसेै कि Flash एवं Illustrator, दोनों में 

bitmaps एवं vector इमेज्स, का प्रयोग किया जा सकता ह।ै

चित्र 5.1.8: फाइल सेव करें

चित्र 5.1.9: Vector

5.1.7 Abobe Illustrator पर कार्य करना

अपने bitmaps को Vector में परिवर्तित कीजिये

Adobe illustrator खोलें तथा चुनें कि आप किस प्रकार का डॉक्यूमेंट खोलना चाहते हैं। आप हाल ही में खोला गया कोई आइटम को चुन सकते हैं  

अथवा कोई नई फाइल बना सकते हैं। उपरोक्त चित्र में “print document” सलेक्ट किया गया ह।ै हम डॉक्यूमेंट स्पैसिफिकेशंस खोलते हैं तथा ok पर क्लिक 

करते हैं।
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इसके टूल, पलेैट तथा लेआउट काफी हद तक Photoshop के जसेै ही हैं, लेकिन फिर भी आपके लिए नये होंगे। 

टॉप मनै्यू बार पर live trace का विकल्प चुनकर आप अपनी पसंद का live trace विकल्प चुन सकते हैं।

चित्र 5.1.10(a): bitmap को Vector में

चित्र 5.1.10 (b): bitmap को Vector में
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निम्नलिखित उदाहरण में हमने live trace: color 6 चुना ह,ै आप अंतर देख सकते हैं।

चित्र 5.1.11: live trace

चित्र 5.1.12: इम्पोर्टिंग

ऊपर स्थित इमेज एक bitmap ह,ै तथा नीचे की इमेज एक Vector ग्राफिक ह।ै अब आप निचली इमेज को चुन सकते हैं तथा इसे एक Vector के रूप में 

प्रयोग करने के लिए इसे Flash में प्रयोग कर सकते हैं, अथवा आप इसे एक *swf फाइल (Flash मूवी) के रूप में एक्सपोर्ट  कर सकते हैं, ताकि आप इसे बाद 

में Flash में एक Flash मूवी (केवल एक फ्रे म) के रूप में इम्पोर्ट  कर सकें ।
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यूनिट 5.2: Flash पर कार्य करना

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 2D एनिमेशन की तकनीकों के प्रयोग के बारे  में जानने में

2.	 Flash सॉफ्टवेयर पर कार्य  करने में ।

5.2.1 Adobe Flash से परिचय

Flash: 

•	 खासतौर से वेब पर इस्तेमाल करने के लिए एक मल्टीमीडिया ग्राफिक्स प्रोग्राम ह।ै

•	 Flash आपको वेब पर रोचक "मूवीज" बनाने में सक्षम बनाता है

•	 Flash, vector ग्राफिक्स का इस्तेमाल करता ह,ै जिसका अर्थ होता ह ैग्राफिक्स को स्पष्टता/गुणवत्ता खोए बिना किसी भी आकार तक बढ़ाया जा 

सकता है

•	 Flash के लिए किसी प्रोग्रामिग कुशलता की आवश्यकता नहीं होती और इसे सीखना आसान होता ह।ै

जब आप Flash लॉन्च करते हैं तो आपको एक वेलकम स्क्रीन दिखाई पड़ता ह।ै यह स्क्रीन कुछ शॉर्टकट पेश करता ह।ै यह ऐसा दिखता ह:ै

चित्र 5.2.1: स्टार्टिंग विंडो

यूनिट के उद्देश्य  
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किसी Flash फाइल पर काम शुरू करने के लिए, आप अब फाइल मेन ूका इस्तेमाल कर सकते हैं या वेलकम स्क्रीन पर किसी आइटम पर क्लिक कर 

सकते हैं। जसेै

•	 File >Open का इस्तेमाल कर आप *.fla फाइल खोलें जिसपर आप काम कर रहे हों

•	 फाइल मेन्यू से या बटन से आप "recent" आइटम खोलें।

•	 एक नई Flash फाइल बनाएँ

5.2.2 Flash डेस्कटॉप का लआेउट

चित्र 5.2.2: Flash डेस्कटॉप



9392

प्रतिभागी पुस्तिका रोटो आर ट्िस्ट

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

5.2.3 Adobe Flash Library

Flash में काम करते समय आप खुद ही कई प्रकार के सिबल्स/संकेत 

खोज सकते हैं जसेै कि मूवी क्लिप्स, बटन तथा ग्राफिक्स। इतने सारे  

संकेतों पर नज़र रखना कठिन हो सकता ह,ै पर Flash आपको एक ऐसी 

सुविधा प्रदान करता ह ै जो इसे आसान बनाता ह ै - वह ह,ै लाइब्रेरी। 

Library एक कें द्रीकृत लोकेशन होता ह,ै जहाँ आप संकेतों को उसी तरह 

से देख सकते हैं, ब्राउज़ कर सकते हैं, जोड़ सकते हैं, डिलीट कर सकते 

हैं तथा व्यवस्थित कर सकते हैं जसेै कि आप अपने कम्प्यूटर पर फाइल 

मूव और एडिट करते हैं।

Window | Library में नेविगेट करने के लिए Ctrl + L दबाएँ। आपको 

Library पनैल दिखाई पड़ता ह।ै निम्नलिखित ग्राफिक बताता ह ै कि 

हरे क आइकन और Library का हर खंड क्या निरूपित करता ह।ै

Library में कोई आइटम जोड़ना

जब किसी संकेत का निर्माण होता ह ैआपका लाइब्रेरी अपने आप इसमें आइटम जोड़ देता ह।ै क्लिक कर या चयन कर अपने ड्रॉइंग एरिया पर एक टेक्स्ट 

बनाएँ। टेक्स्ट चुनने के बाद, F8 दबाएँ या Modify > Convert to Symbolसिबल पर जाएँ। 

कंवर्ट टु सिबल डायलॉग बॉक्स दिखाई देगा । ग्राफिक का ऑप्शन सिलेक्ट करें  और नाम के फील्ड में एक नाम “text” एंटर करें :

OK दबाएं। कंवर्ट टु सिबल डायलॉग बॉक्स गायब हो जाएगा और आपका टेक्स्ट 

ऑब्जेक्ट अब एक ग्राफिक हो जाता ह।ै पर Library पर एक गैंडर लें। आप देखेंगे, कि 

अब आपको आइटम लिस्ट में नेम टेक्स्ट के साथ एक ग्राफिक सिबल दिखाई देता ह:ै

चित्र 5.2.3: Flash डेस्कटॉप

चित्र 5.2.4: सिंबल/संकेत में रूपांतरित करें/बदलें

चित्र 5.2.5



9594

प्रतिभागी पुस्तिका

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

एक दूसरा तरीका भी ह ैजिसके जरिए आप अपने Library मे आइटम जो‌ड़ सकते हैं। न्यू सिबल आइकन पर क्लिक करें , क्रिएट न्यू सिबल डायलॉग बॉक्स 

में जानकारी भरें  और सिबल को बिना पहले चरण में प्रदर्शित किए, सीधा अपने Library में जोड़ें।

हालांकि दोनों ही तरीके से आप जो भी संकेत बनाते या कंवर्ट करते हैं वह आपकी लाइब्रेरी में एड/जुड़ हो जाते हैं। जब Library में कोई आइटम होता ह,ै तो 

ज़रूरी नहीं ह,ै कि इस आइटम का इस्तेमाल होता ह।ै वास्तव में, हमारे  उदाहरण में हमारी Library में तीन आइटम हैं, तब भी उनमें से कोई स्टेज पर प्रदर्शित 

नहीं ह।ै हालांकि, आप इत्मिनान रखें। आपकी Library से आइटम प्रदर्शित करना काफी सरल होता ह।ै

आपकी Library से आइटम प्रदर्शित करना

आपके स्टेज पर आपकी Library से कोई आइटम प्रदर्शित करना उतना ही सरल होता ह ै

जितना कि ड्रैग और ड्रॉप करना। बस एक आइटम चुनें, यानी अपनी Library से सर्क ल मूवी 

क्लिप चुनें और उसे अपने स्टेज पर ड्रैग करें । आपको अब अपने स्टेज पर घेरा दिखाई पड़ेगा:

आप समान आइटम के कई इंस्टेंसेस को ड्रैग कर सकते हैं। फिर से लाइब्रेरी में एकसर्क ल 

मूवी क्लिप पर क्लिक कर उसे स्टेज पर ड्रैग करें । आप देखेंगे, कि आपके स्टेज पर अब 

आपके सर्क ल मूवी क्लिप की दो कॉपीज़/ प्रतियाँ हैं।

यदि आप निर्णय लेते हैं कि आपके स्टेज पर दो सर्क ल्स होंगे या कोई भी सर्क ल नहीं होगा, 

तो बस अपने सर्क ल/सर्क ल्स चुनें और डिलीट-की दबाएँ। अपने स्टेज से कोई आइटम डिलीट 

करने से वह आपकी Library से डिलीट नहीं होता ह,ै पर इसके विपरीत- आपकी Library से 

कोई आइटम डिलीट करने से वह स्टेज से डिलीट हो जाता ह।ै

अपनी Library से आइटम डिलीट करना

अपनी Library से कोई आइटम डिलीट करने के लिए सबसे पहले Library में आइटम चुनें। 

आइटम का जब चयन हो जाता ह,ै तो Library में Delete बटन दबाएँ।

5.2.3 मूवी क्लिप्स

मूवी क्लिप्स को 'मूवीज़ के भीतर मूवीज़ के रूप में परिभाषित 

किया जाता ह,ै जिसकी प्रॉपर्टीज़ तथा टाइमलाइन मुख्य मूवी 

से स्वतंत्र होते हैं।' आप जितना चाहें अपने मुख्य मूवी में उतने 

मूवी इंस्टेंसेस पा सकते हैं और यहाँ तक कि आप उस इम्पोर्ट 

की हुई मूवी क्लिप को अपनी मर्ज़ी से अपने मेन स्टेज पर कई 

बार ड्रैग कर सकते हैं। ये 'टाइमलाइन स्वतंत्र’ होते हैं। आप 

उनका सॉर्ट्स के टेम्प्लेट्स के रूप में फिर से इस्तेमाल कर 

सकते हैं और हर नई मूवी, जिसमें भी आप उन्हें पुल करते हैं, 

के लिए उन्हें विशिष्ट तौर पर एडिट कर सकते हैं, मूल क्लिप्स में बिना कोई बदलाव किए। जरा सोचें कि यह आपके लोड टाइम के लिए क्या कर सकता 

ह ैऔर मूवी क्लिप्स का इस्तेमाल करने से आपके पास कितनी लोचशीलता/फ्लेक्सिबिलिटी होती ह।ै मूवी क्लिप्स का इस्तेमाल करने से आप समय की 

बचत कर सकते हैं।

चित्र 5.2.6: आइटम प्रदर्शित करना

चित्र 5.2.7: आइटम डिलीट करना

चित्र 5.2.8: मूवी क्लिप्स
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निश्चित रूप से आपने अब तक .flaʼs के बारे  में जान लिया होगा, जो हरे क लेयर के लिए केवल एक फ्रे म का इस्तेमाल करता ह,ै तब भी मूवी जटिल चीज़ 

होती ह,ै क्योंकि हरे क लेयर की क्लिप्स की अपनी प्रॉपर्टीज़ और टाइमलाइंस होती हैं। ये काफी आसान लगता ह,ै लेकिन मूवी क्लिप्स और ये कैसे काम 

करती ह,ै यह समझना असंभव तो नहीं, पर मुश्किल ज़रूर हो सकता ह,ै अगर आपके लिए Flash नई चीज़ ह ैतो।

मूवी क्लिप्स को मुख्य मूवी के Library 'Ctrl + L’ पर उनके ऊपर डबल क्लिक करके या 'Control | Test Movie’ का इस्तेमाल कर प्रिव्यूड करके मूवी 

को एडिट किया जा सकता ह।ै

अपनी मौजदूा मूवी के भीतर एक मूवी क्लिक बनाने के लिए 'Insert | New Symbol’ का इस्तेमाल करें  और 'movie clip' सिलेक्ट करें  और उसे कोई नाम 

दें। OK दबाएं।

अब आपके पास आपकी मूवी क्लिप बनाने के लिए एक नया स्टेज और टाइमलाइन ह।ै यदि आप इस नई मूवी को अपने मेन टाइमलाइन में इस्तेमाल करना 

चाहते हैं तो लेयर्स और ग्राफिक्स जोड़ें। परूा हो जाने पर, सीन 1 पर वापस जाएँ, क्लिक के लिए एक नया लेयर बनाएँ और इसे लाइब्रेरी से स्टेज पर ड्रैग 

करें । अब उसे अपनी मुख्य मूवी में प्ले करवाने के लिए 'Control | Test Movie’ का इस्तेमाल करें । आप स्टेज पर मूवी क्लिप्स को प्रभावित किए बिना किसी 

भी चीज़ को अपनी मुख्य मूवी में जोड़ सकते हैं। मूवी क्लिप्स का बकैग्राउंड्स तब तक पारदर्शक होगा जब तक कि आप उनमें एक बकैग्राउंड इमेज न 

डाल देते हैं।

चित्र 5.2.10: सिम्बल एडिट करना

चित्र 5.2.9: मूवी क्लिप बनाएँ

अपने सिबलों/ संकेतों को एडिट करने के लिए अपनी टाइमलाइन में सबसे ऊपर दाई ंओर दिए आइकन पर क्लिक करें ।

पर यदि आपने पहले ही अपनी मुख्य मूवी के बाहर कुछ मूवी बनाई हो जिसे आप मूवी क्लिप्स के रूप में इस्तेमाल करना चाहते हों तो। 

.fla सर्च कर इम्पोर्ट  करने के लिए जिसे आप इस्तेमाल में लाना चाहते हैं, 'File | Open as Library' का इस्तेमाल करें । अब यह Library में इस सिबल/संकेत 

के रूप में प्रकट होता ह ैजिसे आप जितनी बार चाहें उतनी बार स्टेज पर ड्रैग आउट कर सकते हैं। आप जिस भी मूवी क्लिप को इम्पोर्ट  करते हैं, या बनाते 

हैं उसमें से प्रत्येक के लिए नया लेयर बनाना न भलूें, और अपनी मूवी देखने के लिए आप 'Control | Test Movie' का इस्तेमाल करें । अब मूवी क्लिप को 

समझना उतना कठिन नहीं रहा या उतना रहस्यमय नहीं रहा जितना यह दिखाई पड़ती ह।ै

कीफ्रे म्स की व्याख्या

•	 ब्लैंक कीफ्रे म्स: ब्लैंक कीफ्रे म टाइमलाइन पर एक ओपन सर्क ल के रूप में दिखाई पड़ता ह।ै इसका अर्थ ह ैकि उस कीफ्रे म के स्टेज पर कोई आर्टवर्क  

नहीं ह।ै

•	 कीफ्रे म: कीफ्रे म टाइमलाइन पर एक सोलिड सर्क ल के रूप में दिखाई पड़ता ह।ै इसका अर्थ ह ैकि स्टेज पर कोई कंटेंट ह।ै

•	 फ्रे म: आप विभिन्न लेयर्स पर ढेर सारे  फ्रे म्स रख सकते हैं।

•	 क्लीयर कीफ्रे म्स: यह कीफ्रे म को टाइमलाइन से मिटा देता ह।ै यह सभी कंटेट को स्टेज रिमूव फ्रे म्स से हटाता ह:ै उन फ्रे म्स का चयन करें  जिन्हें आप 

हटाना चाहते हैं और Insert>Remove Frames.Timeline का चयन करें

•	 टाइमलाइन: लेयर्स और फ्रे म्स का इस्तेमाल करते हुए समय के साथ टाइमलाइन मूवी कंटेट को नियत्रित और व्यवस्थित करता ह।ै जब टाइमलाइन 

में लेयर्स की संख्या उससे अधिक हो जिनती कि डिस्प्ले की जा सकती ह,ै तो स्क्रॉलबार उपलब्ध हो जाते हैं।
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5.2.4 फ्रे म बाय फ्रे म एनिमेशन

1.	 ध्यान रहे दें कि आपका mymovie.fla अभी भी ओपन हो। आप 'My Frog Movie' फ्रे ज़ लिखने जा रहे हैं, 

ताकि यह एक बार में एक ही फ्रे म दिखे, तो ब्रश टूल (कोई भी आकार और कोई भी रंग) पिक करें ।

2.	 स्टेज पर एक M. Notice ड्रॉ करें  कि आपकी टाइमलाइन पर आपका ब्लैंक कीफ्रे म अब कीफ्रे म में बदल 

चुका ह।ै

चित्र 5.2.11: कीफ्रे म

चित्र 5.2.12: फ्रे म 1 पर M

3.	 टाइमलाइन पर फ्रे म 2 चुनें और एक नया कीफ्रे म इंसर्ट करें । My शब्द बनाने के लिए Y जोड़ें।

चित्र 5.2.13: फ्रे म 2 पर Y

चित्र 5.2.14: अन्य अक्षर

4.	 हरे क वर्ण के लिए नया कीफ्रे म इंसर्ट करना जारी रखें, जब तक कि फ्रे ज़ परूा 

न हो जाये: My Frog Movie 

•	 स्टेज: यह वह स्थान होता ह ैजहाँ आपकी रचना जीवित हो उठती ह ैऔर एडिट करने के लिए प्रदर्शित की जाती ह।ै मेन्यू से Modify | Movie का 

चयन कर स्टेज का आकार बदलें और अपनी मर्ज़ी से चौड़ाई और ऊँचाई की सेटिग बदलें।

•	 Onion Skinning बटन: ओनियन स्किं स टाइमलाइन में पोजिशनिग के लिए कई लेयरों में आपके एनिमेशन के सभी लेयर्स को देखने की अनुमति 

देता ह।ै डिम्ड लेयर्स एडिट नहीं किए जा सकते हैं।

•	 कीफ्रे म: स्टेज पर मौजदू हर चीज़ में, जहां कोई चीज़ बदलती ह ैवह ह ैकीफ्रे म। कीफ्रे म एनिमेशन में बदलावों को परिभाषित करता ह।ै हरे क लेयर में 

पहला फ्रे म स्वतः ही एक कीफ्रे म होता ह।ै निर्मित कीफ्रे म Flash में एक सॉलिड सर्क ल के रूप में दिखाई पड़ता ह।ै खाली कीफ्रे म खोखले सर्क ल के 

रूप में दिखाई पड़ते हैं।

•	 प्लेहेड: टाइमलाइन पर मौजदू प्लेहेड आपकी परूी मूवी के लिए एक मूवेबल शुरुआती तथा समापन बिदु होता ह।ै आप अपनी मूवी को देखने के लिए 

और एडिटिग के लिए फ्रे म बदलावों की पहचान में मदद पाने के लिए प्लेहेड को टाइमलाइन पर क्लिक तथा मूव कर सकते हैं। अपनी मूवी को उसके 

निर्माण और एडिटिग स्टेज के दौरान किसी भी समय चलाने के लिए, 'enter’ की पर क्लिक करें ।
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5.	 टाइमलाइन देखें - आपके पास 11 फ्रे म्स होने चाहिए- लगभग एक सेकंड की एनिमेशन! - प्लेहेड को वापस अपने पहले कीफ्रे म पर ड्रैग करें ।

6.	 Control > Play के तहत अपनी मूवी प्ले करें ।

5.2.4 मोशन tween

Flash में एनिमेशन टाइमलाइन के चारों ओर घमूता ह।ै अपनी टाइमलाइन में आप किसी विशेष ईवेंट के लिए एक आरंभ बिदु और एक समापन बिदु 

विनिर्देशित कर सकते हैं। मैं टाइम के स्थान पर प्वाइंट शब्द का इस्तेमाल करता हंू, क्योंकि Flash में टाइम की अवधारणा वास्तविक दुनिया से अलग 

होती ह।ै वास्तविक दुनिया में, आप टाइम की गणना किसी चीज़ के करने में लगे सेकंड या मिनट अथवा घंटे के रूप में करते हैं। Flash में टाइम की मुख्य 

माप फ्रे म्स के इर्द -गिर्द  घमूती ह ैऔर किसी एनिमेशन के सेकंड/मिनट आपकी फ्रे म दर से अलग होते हैं।

तो, मोशन tweening इन सब में कहाँ फिट बठैता ह?ै जब आप Flash में कोई सरल एनिमेशन बनाते हैं, आप हमेशा एक आरंभ फ्रे म तथा एक समापन फ्रे म 

का विनिर्देश करें । उदाहरण के लिए आप फ्रे म 1 पर आपके स्टेज के बाएं सिरे  पर एक बॉल को निर्दिष्ट कर सकते हैं।

आप तब एक कीफ्रे म बनाते हैं, उदाहरण के लिए फ्रे म 20 पर, और उसी बॉल को आप अपने स्टेज के दाएँ सिरे  पर मूव करें ।

यदि आप अपने एनिमेशन का प्रीव्यू करते हैं, तो आप अपनी बॉल अपने स्टेज की बाई ंओर शुरू होता देखेंगे और अचानक जसेै कि आप फ्रे म 20 पर पहंुचते 

हैं वह दाई ंओर नज़र आती ह।ै बॉल के शुरुआती और अंतिम पोजिशंस के बीच सुगम ट्रांजीशन नहीं होता। यहीं मोशन tweening काम आती ह।ै 

मोशन tweening फ्रे म 1 तथा फ्रे म 20 पर आपकी बॉल के बीच एक ट्रांजीशन पदैा करता करती ह।ै Flash स्वतः ही इसकी गणना कर लेता ह ैकि आपकी 

बॉल का फ्रे म 2 और 19 के बीच क्या पोजिशन होगा, ताकि जब आप अपना एनिमेशन प्रीव्यू करें , तो आपकी बॉल धीरे -धीरे  अपनी आरंभिक बाई ंपोजिशन 

से अपनी दाई ंपोजिशन पर मूव करें । आपको शुरुआती और समापन फ्रे म को निर्दिष्ट करना होता ह।ै Flash बाकी का काम संभाल लेता ह!ै

चित्र 5.2.15: प्लेहेड

चित्र 5.2.16: फ्रे म 1 पर ऑब्ज़ेक्ट

चित्र 5.2.17: फ्रे म 20 पर ऑब्ज़ेक्ट
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Tweening उदाहरण पेश करें

•	 एक नीला सर्क ल बनाएँ और उसे सिम्बल (ग्राफिक) में बदलें।

•	य ह सर्कि ल केवल आपके स्टेज के बीच में स्थित होना चाहिए।

•	 अपनी टाइमलाइन फ्रे म 25 पर क्लिक करें  और इंसर्ट कीफ्रे म का सिलेक्ट करें ।

•	 आपको फ्रे म 25 पर एक कीफ्रे म दिखाई पड़ना चाहिए। अब फ्रे म 50 पर एक कीफ्रे म इंसर्ट करें । 

आपकी टाइमलाइन में फ्रे म 1 पर एक कीफ्रे म दिखाई पड़ना चाहिए।

•	 फ्रे म 25, तथा फ्रे म 50 आइए अपने सर्क ल के आकार को बदलते हैं। अपनी टाइमलाइन पर फ्रे म 25 पर 

वापस जाएँ, अपने सर्क ल पर राइट क्लिक करें  और फ्री ट्रांसफॉर्म  का चयन करें । आपके सर्क ल के 

चारों ओर स्के ल और स्क्यू बॉक्स दिखाई पड़ने चाहिए। उनमें से किसी एक बॉक्स के कोने पर 

क्लिक करें  और बाहर की ओर ड्रैग करें :

•	यदि  आप अपने एनिमेशन का प्रीव्यू Ctrl + Enter की मदद से देखने वाले थे, तो आप देखेंगे कि आपका 

सर्क ल छोटे से शुरू होगा और अचानक बड़ा बन जाएगा और फिर अपने छोटे आकार पर वापस लौट 

आएगा। आइए इसे और बेहतर बनाते हैं।

•	 फ्रे म 1 से फ्रे म 50 तक अपने टाइमलाइन के सभी फ्रे म का चयन करें । किसी भी चुने हुए फ्रे म पर राइट 

क्लिक करें  और Create Motion Tween सिलेक्ट करें ।

•	 इस बात पर ध्यान दें कि जब आप अपने एनिमेशन का प्रीव्यू करते हैं, सर्क ल सुगमतापरू्वक छोटे से बड़े 

और फिर वापस छोटे आकार की ओर एनिमेट करता ह।ै

चित्र 5.2.18: की फ्रे म्स इंसर्ट करें

चित्र 5.2.19: आकार बदलना

चित्र 5.2.20: मोशन tween बनाना

ध्यान दें: आपके पास प्रति लयेर और प्रति फ्रे म केवल एक ऑब्ज़ेक्ट ही होना चाहिए, अन्यथा आपका एनिमशेन tweening कारगर नहीं होगा। साथ ही 

आपको सभी इमज़ेों (bitmaps) तथा ग्राफिक्स (vectors) को फ्लै श टाइमलाइन में इस्तेमाल करन ेस ेपरू्व इन्हें सिम्बल में बदलना होगा।

5.2.5 Flash Shape Tween

यह पाठ आपको "shape tween" बनाने के तरीके के बारे  में बताएगा, जिसके लिए दो शेप्स लिए जाते हैं और उन्हें एक से दूसरे  में और दूसरे  से पहले में मॉर्फ  

करने के लिए इस्तेमाल किया जाता ह।ै शेप tweening एक शब्द ह ैजिसका इस्तेमाल Macromedia Flash में किया जाता ह,ै जिसका अर्थ होता ह ैएक शेप 

से दूसरे  शेप में ट्रांजीशन करना।

अपना tween बनाने से पहले आपको उस शेप की आवश्यकता होगी जिनका इस्तेमाल tween इफैक्ट पदैा 

करने में किया जायेगा। सबसे पहले, अपने टाइमलाइन के फ्रे म 1 में सरल आयत बनाएँ, जसैा कि नीचे 

हमारे  पास ह।ै

टाइमलाइन विंडो में फ्रे म 25 चुनें और एक कीफ्रे म इंसर्ट करें । फ्रे म 50 चुनें और एक अन्य कीफ्रे म इंसर्ट करें । 

यह ध्यान दें कि फ्रे म 1 से 50 के बीच एक शेडेड एरिया ह।ै यह आपका "सक्रिय/एक्टिव" एरिया ह ैऔर 

आपका एनिमेशन इसी एरिया में बनने जा रहा ह।ै

चित्र 5.2.21
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हम अपने शेप को एक से दूसरे  शेप में मॉर्फ  करना चाहते हैं। इसके विपरीत आइए हम अपने रे ड बॉक्स को नीले 

सर्क ल में मॉर्फ  करते हैं। मध्य फ्रे म यानी फ्रे म 25 का चयन करें , और मौजदूा रे ड बॉक्स के शीर्ष  पर कोई बड़ा नीला 

सर्क ल बनाएँ, ताकि यह परूी तरह से कवर हो जाए। फ्रे म 25 में Oval Tool का इस्तेमाल कर, शिफ्ट दबाएँ, लेफ्ट 

क्लिक करें  तथा ड्रैग कर एक बड़ा नीला सर्क ल बनाएँ। फ्रे म 25 के लिए आपका स्टेज अब ऐसा दिखाई पड़ना चाहिए।

टाइमलाइन विंडो में लेफ्ट-क्लिक करते हुए 2-24 के बीच का कोई फ्रे म चुनें। प्रॉपटीज़ विंडो में आपको tween करने 

के लिए एक विकल्प दिखाई पड़ेगा। वर्तमान में यह नन (none) पर सेट किया होता ह।ै tween ड्रॉप डाउन सलेक्टर 

से शेप का चयन करें ।

अब फ्रे म 26 पर एक अन्य कीफ्रे म इंसर्ट करें । 27-49 फ्रे म के बीच किसी पर लेफ्ट क्लिक करें  और एक बार फिर प्रॉपटीज़ विंडो से शेप tween चुनें।

यदि आपके पास अपने टाइमलाइन विंडो में सॉलिड लाइन के बजाए कोई डॉटेड लाइन हो, तो इस बात का ध्यान रखें कि आप इस बिदु तक निर्देशों का 

सटीक रूप से पालन करें गे।

Control मेन्यू से Control < Test Movie चुनें।

ध्यान दें: इस बात का ध्यान रखें कि आपके ग्राफिक्स शपे्स होन ेचाहिएं और आप यदि शपे tween का इस्तेमाल करना चाहत ेहैं, तो आपको उन्हें सिबंल 

में नहीं बदलना चाहिए।

शेप टके्स्ट

आप टेक्स्ट को अन्य टेक्स्ट का शेप दे सकते हैं या टेक्स्ट को ग्राफिक इमेज में शेप करें  या इसके उलट करें । बस ऊपर बताए चरणों का ही पालन करें । 

हालांकि आपको टेक्स्ट को किसी शेप में अलग-अलग तोड़ना होगा। ऐसा करने के लिए आपको Flash top Menu पर जाकर Modify > Break apart का 

ऑप्शन सिलेक्ट करना होगा।

आपको यह क्रिया दुहराने की आवश्यकता होगी, क्योंकि जब आप पहली बार टेक्स्ट को ब्रेक अपार्ट  करते हैं तो टेक्स्ट को एकल अक्षरों में तोड़ते हैं, और 

दूसरी बार अक्षरों को शेप में तोड़ा जाता ह।ै

चित्र 5.2.22: 1 फ्रे म से 50 चुनें

चित्र 5.2.23

चित्र 5.2.24: शेप चुनें

चित्र 5.2.25: शेप ट्विन चुनना

चित्र 5.2.26
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5.2.6 Mask बनाना
Masking किसी लेयर के हिस्सों को प्रकट करने का एक सरल तरीका होता ह।ै

स्टेटिक Masks

यहाँ इसे बनाने का तरीका बताया गया ह:ै

•	 Flash खोलें और एक नया flash डॉक्युमेंट बनाएँ।

•	 टाइमलाइन पर एक लेयर होता ह ै जिसका नाम “Layer 1” होता ह,ै किसी इमेज को 

इसी लेयर पर रखें। ठीक ह,ै अब आपको लेयर 1 के ऊपर एक नया लेयर बनाना होगा।

•	 नया लेयर बन जाने के बाद, Modify > Timeline > Layer प्रॉपर्टीज़ पर जाएँ और टाइप 

के रूप में 'Mask' चुनकर ok पर क्लिक करें ।

चित्र 5.2.27: मास्किं ग

ध्यान दें: यदि आप दो बार ब् रेक अपार्ट करत ेहैं तो टेक्स्ट में सुधार नहीं ला पाएँग।े

शेप इमेज्स (bitmaps)

किसी इमेज को शेप देने के क्रम में आपको उसे vector में बदलना होगा। आप ऐसा

•	 Illustrator (ऊपर देखें, illustrator Live trace) में कर सकते हैं या

•	 आप flash में image go to Modify > Bitmap > Trace Bitmap का चयन कर सकते हैं।

•	 इससे आपकी इमेज vector या Brake apart में बदल जाएगी।

ध्यान दें: उपरोक्त विधि स ेकिसी इमजे को vector म ें बदलन ेकी सलाह नहीं दी जाती, क्योंकि नया vector image एक बड़ी फाइल होगी और सभंवतः यह 

एनिमशेन स्पीड के लिए समस्या पदैा कर देगी। आपको प्रबल सलाह दी जाती ह ैकि आप vector म ें बदलन ेके बजाए Illustrator का इस्तेमाल करें ।

•	निच ले लेयर (लेयर 1) पर जाएँ और फिर Modify > Timeline > Layer properties पर जाएँ और लेयर टाइप के रूप में 'Masked' चुनकर ok पर क्लिक 

करें । अब आपके पास दो लेयर्स बन गए हैं, टॉप लेयर 'Mask’ ह ैजहाँ वास्तविक मास्किंग  उत्पन्न होगा और सबसे नीचे का लेयर 'Masked’ लेयर, 

जहां इमेज स्थित होती ह।ै

ध्यान दें: यदि आपकी टाइमलाइन पर दो लयेर्स हों, तो पहल ेलयेर पर राइट क्लिक करें  और Mask का चयन करें । आप पाएँग ेकि दूसरा लयेर अपन ेआप 

masked बन जाता ह।ै यदि आपके पास दो स ेअधिक लयेर्स हों तो केवल mask की तरह काम करन ेवाला लयेर और उसके नीच ेका लयेर masked बन 

जाएगा। अन्य लयेरों की मास्किं ग के लिए आपको चरण IV को दुहराना होगा।

चित्र 5.2.28 (a): लेयर 1 चित्र 5.2.28 (a): लेयर 2
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5.2.7 टके्स्ट मास्किं ग 

अब एक शेप का निर्माण करें , जसेै कि 'Mask' लेयर (टॉप लेयर) पर एक आयताकार या 

एक अंडाकार शेप। यहाँ इससे कोई फर्क  नहीं पड़ता कि उस शेप को कौन-सा रंग या 

आउटलाइन कलर दिया जाता ह,ै क्योंकि शेप एक वह हिस्सा होगा जिसके नीच इमेज 

दिखाई पड़ेगी; और कोई भी वह चीज़ जो शेप नहीं ह ैब्लैंक ऑफ कर दी जाएगी।

अब Ctrl + Enter दबाकर या दोनों लेयर्स को लॉक कर अपने मास्क की जाँच करें ।

ध्यान दें: एक अच्छी युक्ति यह ह,ै कि मास्क के लिए टेक्स्ट का इस्तेमाल करें । यह करन े

के लिए टॉप लयेर पर कुछ  टेक्स्ट बनाएँ और उस ेप्रीव्यू करें । अब टेक्स्ट के अदंर इमजे 

होना चाहिए।

•	 चरण 1: Flash खोलें और इस उदाहरण के लिए Modify > Movie से वर्क  एरिया को 

300 x 250 का साइज़ दें, बकैग्राउंड कलर के रूप में काला चुनें। 'File | Import' की 

मदद से कोई बकैग्राउंड इमेज इम्पोर्ट  करें  और बकैग्राउंड की तुलना में कोई बड़ी 

इमेज चुनें। स्टेज कवर करने के लिए इमेज का चयन कर उसे रीसाइज़ करें , Modify 

> Transform > Scale’ पर जाएँ। लेयर 'लीव्स’ का चयन कर उसे नाम दें। फ्रे म रे ट पर 

क्लिक करके इसे 20 fps में बदलें।

•	 चरण 2: पहले लेयर के ऊपर नया लेयर जोड़ें। टेक्स्ट टूल चुनें और स्टेज के मध्य में 

'leaves’ शब्द टाइप करें । हमने Arial Black, bold, size 92, कलर ब्लैक का इस्तेमाल 

किया। चयनित टेक्स्ट लेयर के साथ 'Modify > Layer’ चुनें, लेयर को 'mask' का नाम 

दें और 'mask' चयन को डॉट करें । OK पर क्लिक करें ।

•	 चरण 3: 'leaves' लेयर चुनें और Modify > Layer' का चयन करें  और 'masked’ को 

डॉट करें । OK पर क्लिक करें । टेक्स्ट के जरिए Masked लेयर (leaves)देखने के लिए 

'Control > Test Movie' का चयन करें ।

•	 चरण 4: हम वहाँ रुक सकते हैं और कुछ एनिमेशन जोड़ सकते हैं, तो एक कदम आगे बढ़ते हैं और मास्क को स्टेज पर मूव कराते हैं। 'leaves’ लेयर 

के फ्रे म 40 पर क्लिक करें  और 'F5' पर क्लिक कर टाइमलाइन एक्सटेंड करें , फिर लेयर लॉक कर दें ताकि आप उसे गलती से एडिट न कर दें। Mask 

लेयर चुनें और फ्रे म 40 पर एक कीफ्रे म 'F6’ जोड़ें। 'Windows > Panel > Frame’ चुनकर फ्रे म पनैल खोलें।

चयनित लेयर के साथ, फ्रे म पनैल से लेयर पर मोशन tween डालें। फ्रे म 1 पर क्लिक करें  और टेक्स्ट को स्टेज के दाएँ सिरे  पर खिसकाएँ। फ्रे म 40 पर 

क्लिक करें  और टेक्स्ट को स्टेज की दाई ंओर खिसकाएँ। लेयर लॉक करें  और आपको मास्क दिखाई पड़ेगा। रिवाइंड कर अपनी मूवी को चलाएँ और स्थिर 

इमेज पर टेक्स्ट रोल देखें।

चित्र 5.2.29: मास्किं ग की जाँच करें

चित्र 5.2.30: टेक्स्ट मास्किं ग

चित्र 5.2.31: कैरेक्टर

चित्र 5.2.32: लेयर चुनें
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5.2.8 सीन पर काम करना
Flash ऑथरिंग एनवायरन्मेंट में, टाइमलाइन की एक सीरीज को चिह्नित करने के लिए जिससे होकर SWF फाइल आगे बढ़ती ह,ै सीन का इस्तेमाल कर 

सकते हैं। gotoAndPlay() के दूसरे  परैामीटर या gotoAndStop() विधियों का इस्तेमाल कर आप प्लेहेड पर भेजे जाने हेतु किसी सीन को विनिर्देश कर 

सकते हैं। सभी FLA फाइल्स केवल आरंभिक सीन के साथ आरंभ होती हैं, पर आप नई सीन बना सकते हैं।

सीन का इस्तेमाल करना हमेशा सर्वोत्तम तरीका नहीं होता ह,ै क्योंकि सीन की कई सारी खामियाँ भी होती हैं। Flash डॉक्युमेंट्स जिसमें कई सारी सीन 

होती हैं, मेंटेन करना कठिन होता ह,ै खासकर मल्टीऑथर एनवायरन्मेंट में। कई सारे  सीन बैंडविड्थ में अप्रभावी भी हो सकती ह,ै क्योंकि प्रकाशन 

प्रक्रिया सभी सीनों का एकल टाइमलाइन में विलय कर देती ह।ै इससे सभी सीनों का उत्तरोत्तर/एक के बाद एक डाउनलोड होता ह,ै भले ही उन्हें कभी प्ले 

न किया जाए। इन कारणों से, मल्टिपल टाइमलाइन आधारित के अलावा मल्टिपल सीन के इस्तेमाल को अक्सर प्रोत्साहित नहीं किया जाता।

MovieClip क्लास की सीन प्रॉपर्टी कई प्रकार के Scene ऑब्जेक्ट लौटाती ह,ै जो SWF फाइल में सभी सीन को निरूपित करते हैं। currentScene प्रॉपर्टी 

एक सीन ऑब्ज़ेक्ट वापस करती ह ैजो उस सीन को निरूपित करता ह ैजो वर्तमान में चल रही हो। सीन क्लास में कई प्रॉपर्टीज़ होती हैं, जो किसी सीन के 

बारे  में सचूना देती हैं। लेबल्स प्रॉपर्टी कई प्रकार के FrameLabel ऑब्जेक्ट लौटाती ह,ै जो उस सीन में फ्रे म लेबल्स को निरूपित करते हैं। नेम प्रॉपर्टी स्ट्रिंग 

के रूप में सीन का नाम लौटाती ह।ै numFrames प्रॉपर्टी एक int लौटाती ह,ै जो उस सीन में फ्रे म्स की कुल संख्या को निरूपित करते हैं।

चित्र 5.2.33: सीन के साथ काम करना

5.2.9 Sound Forge: साउंड एडिटिंग

वर्क स्पेस: जब आप पहली बार Sound Forge ओपन करते हैं, तो आपका वर्क स्पेस खाली हो जाएगा।

चित्र 5.2.34: वर्कस्पे स
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जब आप कोई साउंड फाइल ओपन करते हैं, वह इस विंडो में दिखेगी।

टूलबार: वर्क स्पेस के टॉप पर दो टूलबार्स होते हैं: एक एडिटिग के लिए (एडिटिग टूलबार) तथा एक साउंड फाइलों की रिकॉर्डिंग और प्लेबकै को नियत्रित 

करने के लिए (यानी ट्रांसपोर्ट  टूलबार)।

फाइल खोलना: आपके पास फाइल खोलने के दो विकल्प होते हैं।

•	 एक नयी फाइल बनाएँ: नए मटैीरियल की रिकॉर्डिंग के लिए प्रयुक्त एक खाली फाइल।

•	 पहले से मौजदू साउंड फाइल खोलें (एक सैंपल, गाना इत्यादि)।

•	 नयी साउंड फाइल बनाने के लिए या तो टूलबार पर New बटन पर क्लिक करें , या 

फाइल मेन्यू पुल डाउन करें  और न्यू सिलेक्ट करें  नए का चयन करें :

•	 फाइल सेव करना: यह सुनिश्चित कर लें कि आपकी डेटा विंडो 

(अगला सेक्शन देखें) चुना जाए। फाइल मेन्यू पुल डाउन करें  

और Save As का चयन करें ।

चित्र 5.2.35: वर्कस्पे स

चित्र.5.2.36: फाइल खोलना

चित्र 5.2.37: फाइल सेव करना
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किसी मूवी में साउंड एडिट करना

Adobe Flash निम्नलिखित साउंड फॉर्मेट “read” कर सकता ह:ै MP3 – QuickTime – WAV 

– TIFF

•	 अपनी साउंड अपनी लाइब्रेरी में इम्पोर्ट  करें , जसैा कि आप इमेजों के साथ करते हैं। बस 

टॉप मेन्यू पर जाएँ और File > Import to Library पर जाएँ।

•	 बहुत ही बुनियादी परिचय के रूप में, किसी चयनित .wav फाइल को आपके .fla में 

इम्पोर्ट  करना आसान होता ह।ै साउंड जब इम्पोर्ट  की जाती ह,ै यह लाइब्रेरी से एक 

विकल्प के रूप में उपलब्ध होगी (यदि आप इसे खुद के लेयर पर इम्पोर्ट  करते हैं) या 

'साउंड’ पनैल से एक विकल्प के रूप में उलपब्ध होगी।

अपने मुख्य टाइमलाइन में एक बकैग्राउंड लपू के रूप में किसी साउंड का इस्तेमाल करने के लिए, उसके लिए एक पथृक लेयर का निर्माण करें  और तब 

उसे इम्पोर्ट  करें  या इसे लाइब्रेरी से स्टेज पर ड्रैग करें । लगातार से प्ले करने के लिए, 'Sync' को स्टार्ट  के रूप में और 'Loops' को 999 पर सेट करें । एक बार 

प्ले करने और उसके बाद रोकने के लिए 'Loops' को 0 पर रखें। आप साउंड को फ्रे ड इन और आउट पर भी सेट कर सकते हैं।

आप किसी छोटी साउंड को किसी ईवेंट पर भी असाइन कर सकते हैं। उदाहरण के लिए यदि आप बटन के 'ओवर’ स्टेट पर किसी साउंड को चयन कर उसे 

असाइन करते हैं तो एक बटन माउस-ओवर पर बीप कर सकता ह।ै

अपनी मूवी में साउंड सिक्रोनाइज़ करने का दूसरा तरीका ह ै साउंड लेयर के 

अंतिम कीफ्रे म को ड्रैग कर और उसे मूव करके टाइमलाइन को एडजस्ट करना।

चित्र 5.2.38: साउंड

चित्र 5.2.39: बैकग्राउंड के रूप में साउंड

चित्र 5.2.40: शॉर्ट साउंड 

चित्र 5.2.41: दसूरा तरीका
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साउंड को फेड इन तथा फेड आउट करने के लिए साउंड प्रॉपर्टीज़ 'effect' 

टबै का इस्तेमाल करें ।

5.2.9 बटन बनाना
नियमित HTML की तरह, बटन केवल सरल नेविगेशन इंटरफेस से कहीं ज्यादा होते हैं। Flash में कोई ऑब्ज़ेक्ट एक बटन हो सकता ह।ै बटन न केवल 

प्रयोक्ता को दूसरे  पेज पर ले जाने की व्यावहारिक विधियाँ प्रदान करता, बल्कि ये कुछ निश्चित उन्नत फंक्शन कॉल किए जा सकने की स्थिति में एक 

इंटरफेस का भी निर्माण करता ह।ै नीचे दिए ट्युटोरियल में आप बटन क्रिएट करना और ओवर, डाउन तथा हिट स्टेट्स जोड़ना सीखेंगे।

•	 सबसे पहले, Flash में एक नई मूवी क्रिएट करें । यह काफी सरल प्रक्रिया होती ह,ै 

इसलिए “intro” सोर्स कोड नहीं होगा। 

•	 नया Flash डॉक्युमेंट खोलने के बाद, Insert > New Symbol पर जाएँ। पॉप अप 

होने वाली विंडो से बटन से विकल्प चुनें और उसे ऐसा नाम दें जिसे याद करना 

आसान हो। OK पर क्लिक करें । नीचे दिए इमेज देखें।

•	य ह कर लेने के बाद, आप देखेंगे कि आपकी टाइमलाइन बटन की प्रॉपर्टीज़ को 

समायोजित करने के लिए बदल चुका ह।ै इस उदाहरण के लिए, Frame marked 

“Up” पर क्लिक करें  और ड्रॉइंग एरिया में सर्क ल ड्रॉ करें । साथ ही, अन्य फ्रे म 

मार्क्ड  "Over", "Down", तथा "Hit" पर क्लिक करें  और कीफ्रे म इंसर्ट करें । आप ओवर तथा डाउन स्टेट्स के लिए सर्क ल कलर को बदल सकते हैं, 

जिससे आप उस बटन को काम करता देख सकें । 

चित्र 5.2.42: Effect टैब

चित्र 5.2.43: नई मूवी

चित्र 5.2.44: बटन्स के लिए अन्य कलर

•	 अब, आपको करना यह ह ैकि मूवी को आप अपने मेन टाइमलाइन में जोड़ें। याद 

रखें कि यह बटन एक नए सिम्बल के रूप में इंसर्ट किया गया था और उसे मेन 

मूवी के कारगर होने के लिए मेन मूवी में रखा जाना चाहिए। सबसे ऊपर बाई ंओर 

सीन 1 बटन पर क्लिक कर उसे मेन मूवी पर ले जाएँ। चित्र 5.2.45: सीन 1 बटन
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•	यदि  आपने इस बटन को किसी नई मूवी से आरंभ किया ह,ै तो आपकी टाइमलाइन तथा ड्रॉइंग एरिया खाली दिखने चाहिए। बटन जोड़ने के लिए, 

Window > Library क्लिक करें , या Library Window लॉन्च करने के लिए (Ctrl + L on keyboard) पर क्लिक करें । अब, आपको करना यह ह ैकि 

आप लाइब्रेरी के इंस्टैंस “बटन” को टाइलमाइन पर ड्रैग करें । बस एक क्लिक कर ड्रैग करें ! 

•	 पहले लेयर में आपकी टाइमलाइन में एक और केवल एक कीफ्रे म होना चाहिए। स्क्रीन पर होने के दौरान बटन दिखाई भी पड़ना चाहिए। बटन कैसे 

काम करता ह ैयह देखने के लिए Ctrl + Enter दबाएँ या File > Publish Preview > HTML पर जाएँ।

बटन एक्शनस्क्रिप्ट

•	 आपके बटन के लिए सामान्य एक्शनस्क्रिप्ट

•	 Flash में एक्शन पनैल खोलें, बटन का चयन करें  और एक्शंस पनैल पर टाइप

•	च नें।

•	 एक्शन पनैल पर Movie clip control > on > release पर जाएँ।

•	फिर  एक स्पेस छोड़ें और Timeline control > gotoAndPlay > ऑन करें  “और विनिर्दिष्ट करें

•	क्लि क करने पर आप कहाँ ट्रांसफर करना चाहते हैं।

चित्र 5.2.44(a): बटन एक्शनस्क्रिप्ट
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अपनी फाइनल मूवी को एक्सपोर्ट करें

•	 File > Export movie पर जाएँ

•	 एक नई विंडो दिखेगी होगी, अपनी मूवी को एक नाम दें और अपनी मूवी को एक्सपोर्ट  किए जाने हेतु फॉर्मेट के प्रकार का चयन करें ।

ध्यान दें: आप काम कैस ेसौंप ेंग ेऔर किस फॉर्मेट म ें सौंप ेंग ेइस पर अधिक जानकारी पान ेके लिए प्रोजके्ट गाइडलाइंस पर जाएँ।

चित्र 5.2.44 (b): बटन एक्शनस्क्रिप्ट

चित्र 5.2.45: बटन एक्शनस्क्रिप्ट
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अभ्यास

डिस्टॉर्टेड पर्सपेक्टिव की रोटटेिंग और करेक्टिंग

ऊपर प्रदर्शित परिणाम पाने के लिए इमेज को क्रॉप करें । नीचे एक स्क्रीन शॉट ह,ै जो उस सिलेक्शन के काफी निकट ह,ै जो आपको करना होगा। आरंभिक 

चयन करने के बाद आप क्रूक्ड  ऐगंल सही करने के लिए इसे घुमाना चाहते हों, तो पर्सपेक्टिव एडजस्ट करने के लिए टॉप कॉर्नर्स  को मूव करें । यह ध्यान 

दें कि चयन सीमा का सबसे नीचे का किनारा घर के आधार के साथ अलाइन किया जाता ह ैऔर किनारे  घर के किनारों के साथ अलाइंड किए जाते हैं। 

याद रखें कि अपनी गति पर काब ूपाने के लिए हैंडल्स ड्रैग करते समय आप शिफ्ट-की का इस्तेमाल कर सकते हैं। इससे आपको पर्सपेक्टिव एडजस्ट 

करते समय सबसे ऊपरी और सबसे निचले किनारे  को अलाइन करने में मदद मिलेगी।

ध्यान दें: यदि आप सेंटर प्वाइंट मवू करत ेहैं, या कॉर्नर हैंडल को गलत तरीके स ेरखत ेहैं, तो Photoshop एक एरर मसेज़ै प्रदर्शित करेगा। यदि आप इस 

Error को देखत ेहैं, तो आपको कॉर्नर हैंडल को रिपोजिशन कर पनुः प्रयास करना होगा।

क्रॉपिग से पहले क्रॉपिग के बाद
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प्रैक्टिस एक्सरसाइज़ 1

चयन टूल के साथ क्रॉपिग करना

Photoshop में, आप किसी मार्की सेलेक्शन टूल्स के साथ किए गए किसी चयन को क्रॉप भी कर सकते हैं, हालांकि क्रॉप की गई इमेज हमेशा एक 

आयताकार आकृति में होगी, जो सेलेक्शन मार्की के सबसे बाहरी क्षेत्र की पुष्टि करती ह।ै सेलेक्शन जब ऐक्टिव हो, Image > Crop का चयन करें ।

बाई ंओर प्रदर्शित नतीजे पाने के लिए प्रैक्टिस इमेज का चयन करें । दाई ंओर Image > Crop चुनने के बाद की इमेज का एक स्क्रीन शॉट ह।ै क्रॉपिग  

से पहले।

क्रॉपिग से पहले क्रॉपिग के बाद

इमेज मनैिपुलशेन 

चरण 1: जेंटल स्काई ग्रेडिएंट बनाने के लिए ग्रेडिएंट टूल का इस्तेमाल करें । दिन के 

समय, वायुमंडलीय संयोजन इत्यादि के आधार पर रंग भिन्न होंगे, पर धरती या ऐसी ही 

चीज़ के लिए सबसे नीचे हल्का आसमानी रंग रखें और शीर्ष  पर फीका पड़ता गहरा 

आसमानी।।

चरण 2: बादल, मेरी विधि कुछ यूं ह:ै कहीं से भी बादलों के झंुड (मेघपंुज) की उच्च-

गुणवत्ता वाली फोटोग्राफी हासिल करें  (ध्यान रखें, कि आप कॉपीराइट या रॉयल्टी लेज/

नियमों का पालन कर रहे हों)।

अब उन सभी को समान कैनवस पर लाएँ, ताकि वे एक-दूसरे  पर लगभग आच्छादित से हों 

और एक अर्ध-विश्वसनीय बादल की रचना करें , हरे क लेयर से गुजरें  और CTRL+SHIFT+U (Desaturate) का इस्तेमाल करें  और लेयर को स्क्रीन पर सेट 

करें , आपको कई सारे  वर्ग  और अन्य भद्दापन भी दिखाई पड़ेंगे, हरे क लेयर के साथ फिर से आगे बढ़ना सही ह ैऔर तबतक ब्राइटनेस-कंट्रास्ट समायोजित 

करना होगा, जबतक कि वर्ग के किनारे  फीके न होने लगे (ब्राइटनेस कम, कंट्रास्ट अधिक), ध्यान रखें कि आप बादलों को छायाचित्र/सिलुएट्स में सफेद 

में बनाएँ।

बादलों के निर्माण के किनारे  पर उसे रखें जिनके वर्गाकार किनारे  गायब हो गए हों (नीचे देखें) और फिर अन्य को सही स्थान पर रखें। 
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चरण 3: अगला मिश्रण। अब जबकि आपके बादल परूी तरह से डीसचुैरे टेड, स्क्रीन पर सेट हों, स्क्रीन और कंट्रास्ट-समायोजित हों, तो आपको उन्हें मिश्रित 

करना होगा। स्पष्ट किनारों वाले बादल (जसैा कि ऊपर ह)ै में ज़्यादा कुछ करने की ज़रूरत नहीं ह,ै , पर जिस पर स्टॉक फोटो का स्काई-हिस्सा परूा तरह 

से फीका पड़ने में विफल रहा हो, उनके लिए आपको इरेज़र  और स्मज़ टूल के साथ काम करना होगा, मैं इसके लिए निम्नलिखित ब्रशों के इस्तेमाल की 

सलाह दंूगा:

ये ब्रश इरेज़ि ग, स्मज़िग तथा ब्रशिग के लिए कारगर होते हैं। याद रखें, बादलों में आयतन होता ह,ै इसलिए यदि आप चीज़ों को मिटाते हैं और उनके 

प्राकृतिक शेडिग को बदलते हैं तो आपको थोड़ा शेड करना होगा। साथ ही, क्लाउड लेयर्स को घुमाने का भी प्रयास करें , ताकि प्रकाश एक ही दिशा से 

आता प्रतीत हो। गहरे  रंग के किसी पतले लेयर पर ब्रश करें , और यदि आवश्यक हो तो शेडिग के लिए स्मज़ करें । साथ ही, बादलों को अधिक अतिच्छादित 

और अधिक व्हाइट आउट होने से रोकें । यदि आपको वाकई चमकीले पचै का एक गुच्छ मिलता ह,ै तो कुछ क्लाउड लेयर को मिटाएँ ताकि वे फीके पड़ जाएँ 

और तब उन्हें स्मज़-ब्लेंड करें । भले ही बादल सफेद होते हों, पर उनसे आंखें नहीं चौंधियातीं और न ही वे अपना प्रकाश फेकते हैं। अपने बादलों की ब्रशिग 

के समय कभी बिल्कु ल सफेद का इस्तेमाल न करें ।
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अगला भाग फेडेड-प्लैनेट इफैक्ट की जानकारी देगा। यह एक सरल मामला ह।ै

सबसे पहले, एक ग्रह हासिल करें , मैं एक अलग, जटिल प्रक्रिया से अपना खुद का बनाता हँू, पर ढेर सारे  प्लैनेट ट्यटूोरियल उपलब्ध हैं - यदि आपको 

प्लैनेट या ग्रह बनाना न आता हो तो आप उनमें से किसी एक का अनुसरण करें । अपने ग्रह को बाहर निकालें (दाएँ देखें)। कृपया परूी काली रात वाली 

तरफ देखें।

अब, प्लैनेट लेयर को डीसचुैरे ट करें , जो फ्लैट होना चाहिए (सिगल लेयर) CTRL+SHIFT+U का इस्तेमाल करें । आपको अपने प्लैनेट के लिए अच्छा 

एहसास लाने के लिए उसके ब्राइटनेस-कंट्रास्ट को समायोजित करने की ज़रूरत हो भी सकती ह ैऔर नहीं भी ।

अब, प्लैनेट को अपने स्काई-एंड-क्लाउड्स कैनवस पर लाएँ और उसे स्क्रीन पर सेट करें । प्रबल दृश्य क्रे सेंट पाने के लिए आवश्यकतानुसार लेवल या 

ब्राइटनेस/कंट्रास्ट एडजस्ट करें । आप स्काई के नीलेपन को देख सकते हैं कि इसमें एक अच्छा लुक ह,ै मानो दिन के समय चाँद दिखाई पड़ता हो।

टिप्पणियां 

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
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6. 3D एनिमेशन बनाएँ

यनूिट 6.1- 3D एनिमेशन बनाएँ

यनूिट 6.2 – ऑब्जेक्ट बनाना, मनैिपुलेट करना तथा देखना

यनूिट 6.3- Maya 3D सीन देखना

यनूिट 6.4- पॉलीगोनल मॉडलिग

यनूिट 6.5- NURBS मॉडलिग

यनूिट 6.6- एनिमेशन

यनूिट 6.7- पॉलीगोन टेक्सचरिंग

यनूिट 6.8- रें डरिंग



115114

प्रतिभागी पुस्तिका

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

इस मॉड्यलू के अंत में, आप निम्न में सक्षम होंगे:

1.	सिक्व ेंस तथा सीन/शॉट्स तयैार करने में डिजाइन, 3D एनिमेशन तथा फिल्म-मेकिग के सिद्धांतों को अपनाने में।

2.	 मोशन/परफॉर्मेंस कैप्चर स्टूडिय ो से प्राप्त मोशन कैप्चर डेटा के साथ काम करने में (डेटा क्लीन अप करने और एनिमेशन डेटा को 3D मॉडल के लिए 

मपै करने में)।

3.	प्री व्यू के लिए एक प्रोटोटाइप वर्क  प्रोडक्ट/प्री-विज़अलाइज़ेशन तयैार करने में।

4.	डिज़ ाइन विनिर्देशों तथा प्रोड्यसूर ब्रीफ को ध्यान में रखते हुए बने हुए एनिमेशन का समीक्षात्मक रूप से मूल्यांकन करने में।

5.	 3D एनिमेशन तकनीकों के साथ रियलिस्टिक 3D एनिमेशन (मोशन कैप्चर + की फ्रे म एनिमेशन) जसैा कि beowulf, avatar तथा gollum में 

इस्तेमाल किया गया था और सेमी-रियलिस्टिक एनिमेशन- little krishna और brave, toon एनिमेशन का उदाहरण ह ैkung-fu panda, ट्रेडिशनल तथा 

Stop Motion टेक्नीक के सिम्युलेशन का उपयोग करें , जसेै कि vineta cucini, amaron battery इत्यादि के विज्ञापनों में इस्तेमाल किया गया था।

6.	 3D गति और परफॉर्मेंस पदैा करें , जिनके लिए सहमत टाइमलाइन के भीतर 3D एनिमेशन सॉफ्टवेयर के इस्तेमाल की आवश्यकता होती ह।ै

निष्कर्ष 
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यूनिट 6.1: 3D एनिमेशन बनाएँ

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 Maya सॉफ्टवेयर की मदद से 3D एनिमेशन एंड-प्रोडक्ट तयैार करने में।

2.	सिक्व ेंस तथा सीन/शॉट्स तयैार करने में डिजाइन, 3D एनिमेशन तथा फिल्म-मेकिग के सिद्धांतों को अपनाने में।

6.1.1 Maya यूज़र इंटरफेस

6.1.2 Maya आरंभ करना

3D एनिमेशन के लिए दुनिया भर में कई सॉफ्टवेयर टूल्स का इस्तेमाल किया जाता ह।ै Maya उनमें से एक ह।ै  इस यनूिट में हम Maya की मदद से 3D 

एनिमेशन बनाने की विधि सीखेंगे।

यह आपको फीचर्स का उपयोग करने और टूल्स तथा एडिटर्स के परिचालन में मदद करता ह,ै जो आपको अपने त्रिविमीय वस्तुओ,ं सीन एनिमेट करने, 

तथा Maya के भीतर इफैक्ट तयैार करने तथा पेश करने में सक्षम बनाते हैं। 

Windows पर Maya आरंभ करना

•	 अपने डेस्कटॉप पर Maya आइकन पर डबल क्लिक करें ।

•	 (Windows 2000 Professional) Windows Start menu, से Programs > Autodesk > Autodesk Maya 2008 > Maya 2008 (Maya Complete या Maya 

Unlimited) चुनें।

•	 (Windows XP Professional) Windows Start menu, से All Programs > Autodesk > Autodesk Maya 2008 > Maya 2008 (Maya Complete या Maya 

Unlimited) चुनें।

मकै OS X पर Maya आरंभ करना

•	 अपने डेस्कटॉप पर Maya आइकन पर डबल क्लिक करें ।

•	 अपने Dock पर Maya आइकन पर क्लिक करें ।

•	 Apple Finder menu से Go > Applications चुनें और तब Maya आइकन ब्राउज़ करें  और Maya चाल ूकरने के लिए उसपर डबल क्लिक करें ।

Linux पर Maya आरंभ करना

•	 अपने डेस्कटॉप पर Maya आइकन पर डबल क्लिक करें ।

•	 शेल विंडो पर: Maya टाइप करें ।

Maya इंटरफेस सीखना

•	 मेन्यूज़ के साथ काम करें । 

•	 स्टेटस लाइन बटन का इस्तेमाल करें ।

•	 Shelf एक्सेस करें । 

•	 Channel Box तथा Layer Editor खोजें।

यूनिट के उद्देश्य  
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•	 animation controls, the Command Line तथा the Help Line की पहचान करें ।

•	 Toolbox तथा Quick Layout बटन का इस्तेमाल करें ।

•	 Secret मेन्यूज़ की खोज करें । 

Maya एक प्रोग्राम ह,ै जिसे Autodesk द्वारा तयैार किया ह,ै जिसका इस्तेमाल मॉडल बनाने, एनिमेट करने तथा 3D सीन देने में किया जाता ह।ै Maya के 

साथ बने 3D सीन मूवीज़, टेलीविज़न, विज्ञापनों, गेम्स, प्रोडक्ट विज़अलाइज़ेशन तथा वेब पर दिखाई पड़ते हैं। Maya के साथ, आप अपने खुद के 3D सीन 

तयैार और एनिमेट कर सकते हैं और उन्हें स्टिम इमेज या एनिमेशन सीक्वेंस में पेश कर सकते हैं।

 Maya के कई संस्करण मौजदू हैं और उनके बीच का अंतर उनमें से प्रत्येक में उपस्थित फीचरों के कारण होता ह।ै Maya के व्यावसायिक संस्करण में हर 

वह चीज़ शामिल होती ह,ै जो आपको 3D सीन और एनिमेशन क्रिएट करने और रें डर करने के लिए चाहिये। Maya के एक उन्नत संस्करण में Fluid 

Effects, Cloth, Hair तथा Fur features भी शामिल हैं। Maya का एक मुक्त रूप से उपलब्ध संस्करण भी ह ैजिसे पर्सनल लर्निंग एडिशन कहा जाता ह।ै 

पर्सनल लर्निंग एडिशन Maya Complete के समान ही होता ह,ै अंतर केवल इतना ह ैकि इसकी सभी रें डरिंग्स पर एक वॉटरमार्क  शामिल ह,ै जो इसे Maya 

सीखना शुरु करने के लिए एक शानदार जगह बनाते हैं।

पहली नज़र में Maya इंटरफेस थोड़ा डराने वाला लग सकता ह,ै क्योंकि इसमें हर जगह बटन, कंट्रोल्स तथा परैामीटर्स मिलते हैं, पर यदि आप ध्यान से 

देखेंगे तो पाएँगे कि सभी कंट्रोल्स लॉज़िकल सेट में वर्गीकृत होते हैं। कंट्रोल्स के इन विभिन्न सेटों से परिचित होने से इंटरफेस के साथ काम करना काफी 

आसान हो जाता ह।ै

इंटरफेस के सबसे ऊपर किनारे  पर मेन्यूज़ होते हैं और एक टूलबार बटन होता ह,ै जिसे Status Line कहा जाता ह।ै आप जिस मोड पर काम करते हैं उसके 

आधार पर मेन्यूज़ बदल सकता ह।ै Status Line के नीचे बटन की एक टबै्ड कतार होती ह।ै बटनों की इस कतार को Shelf कहा जाता ह,ै और यह कई 

कमांड के सेट को एकत्रित करने का एक सुविधाजनक तरीका देता ह।ै इंटरफेस की दाई ंओर परैामीटर का एक पनैल होता ह ैजिसे Channel Box कहा 

जाता ह।ै ये परैामीटर ऐट्रिब्युट्स के नाम से जाने जाते हैं, जो चुनी हुई विभिन्न वस्तुओ ंके अनुरूप बदलते रहते हैं। Channel Box के नीचे Layer Editor 

स्थित होता ह।ै

इंटरफेस के सबसे नीचे Range Slider तथा animation controls पाए जाते हैं, जिनका इस्तेमाल किसी एनिमेशन सीक्वेंस के विभिन्न फ्रे म्स के बीच 

विनिर्दिष्ट करने तथा खिसकने में किया जाता ह;ै साथ ही, सबसे नीचे Command Line तथा Help Line होते हैं, जिनका इस्तेमाल टेक्स्चुअल कमांड एंटर 

करने में किया जाता ह।ै अंत में, इंटरफेस की बाई ंओर बटनों का क्षैतिज कॉलम Toolbox तथा Quick Layout बटन के रूप में जाना जाता ह।ै इन बटनों का 

इस्तेमाल सीन ऑब्ज़ेक्ट का चयन करने और उन्हें रूपांतरित करने और साथ ही इंटरफेस लेआउट बदलने में किया जाता ह।ै

इंटरफेस के साथ काम शुरू करने के लिए एक संकल्पना जिसे समझना आपके लिए ज़रूरी ह,ै वह ये कि समान कमांड को एक्सेस करने के कई तरीके 

होते हैं। उदाहरण के लिए, आप Create, Polygon Primitives, Sphere menu command का इस्तेमाल कर अथवा Polygons shelf में Polygon Sphere बटन 

का इस्तेमाल कर एक स्फेयर  का निर्माण कर सकते हैं। यह डिजाइन जानबझू कर दी गई होती ह ैताकि प्रशिक्षु किसी कमांड को एक्सेस करने की एक 

सहज विधि का इस्तेमाल कर सकें  और एडवांस्ड प्रयोक्ताओ ंको ऐसी एक्सेस विधि हासिल हो सके जो उन्हें तेज़ी से काम करने में सक्षम बनाए, क्योंकि 

इससे वे शॉर्टकट सीख जाते हैं।

एडवांस्ड-यज़ूर कमांड्स को त्वरित रूप से एक्सेस करने का एक तरीका ह ैSecret मेन्यू का इस्तेमाल करना। ये संदर्भ-विशिष्ट पॉप-अप मेन्यू तब प्रकट 

होते हैं जब आप इंटरफेस पर राइट क्लिक करते हैं। कमांड एक्सेस करने का दूसरा सबसे तीव्र तरीका ह ैकीबोर्ड  शॉर्टकट का इस्तेमाल करना, जिसे 

हॉटकी कहा जाता ह।ै

Maya प्रयोक्ताओ ंको इंटरफेस को कस्टमाइज़ करने का विकल्प देता ह।ै कस्टमाइज़ेशन ऑप्शन का इस्तेमाल कर, आप कमांड आइकंस का एक कस्टम 

सेट तयैार कर सकते हैं, कीबोर्ड  शॉर्टकट्स परिभाषित कर सकते हैं और मेन्यूज को भी बदल सकते हैं। कई सारे  कस्टमाइज़ेशन ऑप्शन Window, 

Settings/Preferences मेन्यू में मौजदू होते हैं।

6.1.2.1 मेन्यूज़ के साथ काम करें
जब आपने Maya पर नया-नया काम करना शुरू किया हो, तो मेन मेन्यू कमांड्स ही वह पहली जगह होती हैं, जहाँ आपको कमांड ढँूढनी चाहिएं। कमांड्स 

को टेक्स्ट के रूप में लिस्ट किया जाता ह,ै जिससे तबतक उन कमांड्स को खोजना आसान बन जाता ह,ै जबतक कि आप विभिन्न बटनों के कार्य  के बारे  

में भली-भांति सीख नहीं लेते हैं। हरे क मेन्यू में कई सब-मेन्यू शामिल हो सकते हैं। सब-मेन्यू को एक छोटे, दाई ंओर इंगित करने वाले ऐरो से पहचाना जाता 

ह,ै जो मेन्यू के दाएँ सिरे  पर स्थित होता ह।ै
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मेंनू सेट्स बदलना

मेन्यूज़ डाइनेमिक होते हैं और चयनित मेन्यू सेट के आधार पर बदलते रहते हैं। आप ड्रॉप-डाउन लिस्ट की मदद 

से मेन्यू सेट के बीच बदलाव ला सकते हैं, ड्रॉप-डाउन लिस्ट चित्र 1-1 में दिखाए अनुसार Status Line की बिल्कु ल 

बाई ंओर होती ह।ै इसके विकल्पों में शामिल होते हैं Modeling, Rigging, Animation, FX, Rendering तथा मेन्यू 

सेट ड्रॉप-डाउन लिस्ट को कस्टमाइज़ करने का एक विकल्प।

सुझाव: हरे क मेन्यू सेट में एक संबद्ध हॉटकी होती ह।ै मॉडलिग के लिए हॉटकी ह ै F2, रिगिग के लिए F3, 

एनिमेशन के लिए F4, FX के लिए F5 तथा रें डरिंग के लिए F6।

पहले छह मेन्यू, File, Edit, Modify, Create, Display, तथा Window, सभी मेन्यू सेट में उपलब्ध होते हैं।

कीबोर्ड हॉटकी दखेना

कई मेन्यू कमांड्स में एक कीबोर्ड  हॉटकी होती ह ैजो मेन्यू की बाई ंओर होती ह,ै जसैा कि चित्र 1-2 में दिखाया 

गया ह।ै कीबोर्ड  पर इन हॉटकी को दबाने से कमांड सक्रिय होती ह।ै हॉटकी किसी कमांड को सक्रिय करने का 
चित्र 6.1.1: चित्र 1-1

एक त्वरित तथा आसान तरीका देता ह ैऔर उनके बारे  में सीख लेने से आप अधिक सक्षम बन जाएँगे। आप Hotkey Editor का इस्तेमाल कर हॉटकी 

कस्टमाइज़ कर सकते हैं, जिसे आप Window, Settings / Preferences, Hotkeys मेन्यू कमांड में ओपन कर सकते हैं।

चित्र 6.1.2: चित्र 1-2

Option Dialog Boxes को एक्सेस करना

कई मेन्यू में एक छोटा बॉक्स आइकन भी होता ह ैजो चित्र 1-2 में दिखाए अनुसार मेन्यू की बाई ंओर होता ह।ै ये बॉक्स आइकंस चयनित कमांड के लिए 

एक Options dialog box ओपन करें गे। ये Options dialog boxes, जसेै कि चित्र 1-3 में दिखाया गया Group Options dialog box, में ऐसे परैामीटर्स होते हैं 

जिन्हें आप बदल सकते हैं। इनमें Apply बटन भी मौजदू होते हैं जो डायलॉग बॉक्स बंद किए बिना आपको दिए हुए परैामीटरों के साथ कमांड लाग ूकरने 

में मदद करते हैं। ऑप्शन डायलॉग बॉक्स के मान अनवरत होते हैं। जिस भी मान को बदला जाता ह,ै उस कमांड के अगली बार इस्तेमाल होने पर उनकी 

सेटिग को बनाए रखेगा। आप डायलॉग बॉक्स मेन्यू में एडिट, रीसेट सेटिग्स मेन्यू कमांड का इस्तेमाल कर किसी ऑप्शन डायलॉग बॉक्स को उसके 

डिफॉल्ट मानों पर रीसेट कर सकते हैं।

चित्र 6.1.3: चित्र 1-3
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टियर-ऑफ मेन्यू का इस्तेमाल करना 

अधिकतर मेन्यू के सबसे ऊपर एक डबल लाइन स्थित होती ह,ै जिसे टियर-ऑफ मेन्यू कहा जाता ह।ै इस लाइन 

पर क्लिक करने से मेन्यू एक टियर-ऑफ मेन्यू बन जाता ह ैऔर यह चित्र 1-4 में दिखाए अनुसार एक अलग 

पनैल पर दिखाई पड़ता ह,ै जिसे आप उसके टाइटल बार पर ड्रैग कर खिसका सकते हैं। टियर-ऑफ मेन्यू 

सुविधाजनक होते हैं, क्योंकि वे मेन्यू कमांड को एक क्लिक में एक्सेस योग्य बनाते हैं, पर आपको किसी और 

चीज़ को कवर किए बिना टियर-ऑफ मेन्यू को खुला छोड़ने के लिए स्पेस की ज़रूरत होगी।

ध्यान दें: टियर-ऑफ मेन्यू को छोटा करने के लिए, टियर-ऑफ मेन्यू पर कीबोर्ड  हॉटकी प्रदर्शित नहीं होती।

चित्र 6.1.4: चित्र 1-4
टूल्स बनाम एक्शन को समझना

यदि आप मेन्यू पर ध्यान देते हैं, तो आप कई ऐसे कमांड्स देखेंगे जो वर्ड  टूल में समाप्त हो जाते हैं। टूल्स जब चुने जाते हैं, तो तब तक एक्टिव रहते हैं, जब 

तक दूसरा टूल न चुना जाये, लेकिन ऐक्शंस केवल एक ही बार सक्रिय होते हैं। पहले प्रयोग किये गये टूल आसान पुनर्चयन के लिए टूलबॉक्स के सबसे 

नीच दिखाए जाते हैं। किसी टूल बटन पर डबल-क्लिक करने से, चित्र 1-5 में Move टूल के लिए दिखाए अनुसार, इंटरफेस की दाई ंओर टूल सेटिग इंटरफेस 

ओपन हो जाता ह।ै आप Status Line की दाई ंओर स्थिति शो/हाइड Tool Settings बटन का इस्तेमाल कर भी टूल सेटिग ओपन कर सकते हैं। टूल सेटिग 

भी अनवरत बने रहते हैं और टूल सेटिग इंटरफेस के शीर्ष  पर Reset Tool बटन का इस्तेमाल कर उन्हें रीसेट किया जा सकता ह।ै

चित्र 6.1.5: चित्र 1-5
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ट्युटोरियल 1: पॉलिगन स्फेयर  बनाने के लिए किसी मेन्यू कमांड का इस्तेमाल करें ।

1.	 चरण 1: क्रिएट मेन्यू पर क्लिक करें  और फिर Polygon Primitives सब-मेन्यू का चयन करें  और स्फेयर  मेन्यू की दाई ंओर स्थित ऑप्शंस आइकन 

पर चित्र 1-3 में दिखाए अनुसार क्लिक कर ऑप्शन डायलॉग बॉक्स खोलें।  

2.	 चरण 2: Polygon Sphere Options डायलॉग बॉक्स में Apply बटन पर क्लिक करें ।  Workspace के मूल में एकल स्फेयर  ऑब्जेक्ट प्रकट होगा। 

3.	 चरण 3: डायलॉग बॉक्स से बाहर निकलने के लिए Close बटन पर क्लिक करें ।   

4.	 चरण 4: क्रिएट मेन्यू पर क्लिक करें  और तब Polygon Primitives सब-मेन्यू का चयन करें  और Cone मेन्यू कमांड पर क्लिक करें । Cone ऑब्जेक्ट, 

स्फेयर  को ओवलपै कर रहे सीन से जुड़ जाता ह।ै

5.	 चरण 5: ऑब्जेक्ट्स  को शेडेड ऑब्जेक्ट्स  के रूप में देखने के लिए की 5 दबाएँ। ऑब्जेक्ट्स  चित्र 1-6 में दिखाए अनुसार एक सरल क्रिस्टल बॉल 

के सदृश होते हैं।  

6.	 चरण 6: फाइल चुनें, सेव सीन ऐज़ चुनें और फाइल को Crystal ball.mb के रूप में सेव करें ।

चित्र 6.1.6: चित्र 1-6

6.1.2.2 Status Line बटन का इस्तेमाल करें

मेन्यू के सीधा नीचे बटनों की एक लंबी कतार होती ह ैजिसे साथ मिलाकर Status Line के नाम से जाना जाता ह।ै ये बटन नियत होते हैं और उन्हें बदला 

नहीं जा सकता ह,ै पर आप उन्हें छुपा सकते हैं। बटनों को ऐसे समूहों में बांटा जाता ह,ै जिन्हें एक विभाजक बार से पथृक किया जाता ह।ै चित्र 1-7 में दिखाए 

अनुसार इन बटन समूहों में शामिल होते हैं- बाएं से दाएं Menu Set लिस्ट, File बटन्स, Selection Mode मेन्यू, Selection Mode बटन्स, Selection Mask 

बटन्स, Snapping बटन्स, History बटन्स, Rendering बटन्स, Transform फिल्ड्स , तथा Show/Hide Editors बटन्स। इनमें से ज़्यादातर बटन समूहों की 

चर्चा  उन पाठों में की जाती ह,ै जो उनके फीचर्स की जानकारी देते हैं।
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चित्र 6.1.7: चित्र 1-7

पॉप-अप हेल्प का इस्तेमाल करना

जब आप पहली बार Status Line बटन का इस्तेमाल करना शुरु करते हैं, यह जानना जरा कठिन होता 

ह ैकि कौन सा बटन किस तरह का कार्य  करता ह,ै पर आप बटन के शीर्षक को एक पॉप-अप हेल्प के 

रूप में देख सकते हैं, जिसके लिए आपको बटन के ऊपर माउस कर्सर ले जाना होगा, इसे चित्र 1-8 में 

प्रदर्शित किया गया ह।ै पॉप-अप हेल्प संपरू्ण  इंटरफेस में सभी बटनों के लिए उपलब्ध होता ह।ै चित्र 6.1.8: चित्र 1-8

ध्यान दें: यदि पॉप-अप हेल्प सही तरह से चाल ून हो, तो आप उसे निष्क्रिय कर सकते हैं, या इसके डिस्प्ले टाइम को Window, Settings/Preferences, 

Preferences मेन्यू कमांड के साथ खुली प्रिफेर ें स डायलॉग बॉक्स में मौजदू हेल्प पनैल की मदद से सेट कर सकते हैं।

कर्सर क्लू की खोज करना

एक अन्य कारगर विज़अल क्लू ह ैयह जब किसी उपलब्ध राइट-क्लिक पॉप-अप मेन्यू वाले interface 

बटन के ऊपर होता ह ैतो कर्सर बदलता ह।ै यह नया कर्सर, कर्सर ऐरो के नीचे एक छोटा मेन्यू आयकन 

भी दिखाता ह,ै जिसे चित्र 1-9 में दिखाया गया ह।ै जब यह आइकन प्रकट होता ह,ै तो आप विकल्पों के 

अतिरिक्त मेन्यू को एक्सेस करने के लिए राइट-क्लिक कर सकते हैं। कुछ निश्चित टूल्स के इस्तेमाल पर 

भी कर्सर बदलता ह।ै

चित्र 6.1.9: चित्र 1-9
एक्सपेंडिंग और कॉलपै्सिंग आइकन बटन ग्रुप

Status Line में हरे क बटन ग्रुप को एक उदग्र रे खा से विभाजित किया जाता ह,ै जिसके मध्य में एक छोटा आयत स्थित होता ह।ै इस विभाजक को शो/हाइड 

बार कहते हैं और यदि आप उसके ऊपर क्लिक करें , तो उस सेक्शन में शामिल सभी बटन छिप जाएँगे। बटनों को फिर से प्रकट करने के लिए पुनः क्लिक 

करें । चित्र 1-10 कई कॉलेप्सेड और expanded बटन सेट दर्शाता ह।ै

चित्र 6.1.10: चित्र 1-10

किसी सीन को ओपन और सेव करना

मेन्यू सेट चयन सचूी की दाई ंओर बटनों का एक सेट होता ह,ै जिसे आप कोई नया सीन क्रिएट करने, किसी मौजदूा सीन को ओपन करने या उसे सेव 

करने में इस्तेमाल कर सकते हैं। ओपन तथा सेव बटन दोनों ही एक फाइल डायलॉग बॉक्स ओपन करें गे, जसैा कि चित्र 1-11 में दिखाया गया ह,ै जिसमें 

आप डायरेक्टर ी तथा फाइल नेम चुन सकते हैं। सेव हो जाने पर फाइल नेम टाइटल बार पर प्रकट होगा।



121120

प्रतिभागी पुस्तिका रोटो आर ट्िस्ट

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

चित्र 6.1.11: चित्र 1-11

एडिटर्स ओपन करना

Status Line की दाई ंओर चार Sidebar बटन होते हैं, चित्र 1-12 में प्रदर्शित अनुसार, जो किसी बटन ग्रुप 

से जुड़े  नहीं होते और वे हमेशा दिखाई पड़ते हैं। इन Sidebar बटनों का इस्तेमाल उस साइडबार पनैल को 

दिखाने और छुपाने में किया जाता ह,ै जो Attribute Editor, Tool Settings, तथा Channel Box/Layer 

Editor समेत व्यू पनैल की दाई ंओर दिखाई देते हैं। Attribute Editor में किसी चयनित वस्तु के लिए सभी 

ऐट्रिब्युट्स की सचूी होती Tool Settings में चयनित टूल के लिए कॉन्फिगर किए जाने योग्य सभी 

सेटिग्स की सचूी होती ह,ै Channel Box ऐट्रिब्यूट्स का एक सबसेट होता ह ै जिसे एनिमेट किया जा चित्र 6.1.12: चित्र 1-12

सकता ह,ै इसे कीएबल माना जाता ह ैऔर Layer Editor आपको सीन ऑब्ज़ेक्ट को लेयर्स में विभाजित करने की अनुमति देता ह।ै

ध्यान दें: Preferences डायलॉग बॉक्स के इंटरफेस पनैल में आप हरे क एडिटर को मुख्य विंडो के बजाए एक पथृक विंडो के रूप में खुलने का विकल्प चयन 

कर सकते हैं।

इंटरफेस एलीमेंट्स को दिखाना और छुपाना

इंटरफेस एलीमेंट के टॉप (या बाई ंओर) डॉटेड डबल लाइन पर डबल-क्लिक करने से चित्र 1-13 में लाइन के लिए दिखाए अनुसार, आप इंटरफेस एलीमेंट 

को छुपा भी सकते हैं। शो/हाइड बार पर राइट-क्लिक करने और उसके ऊपर mouse बटन को होल्ड डाउन करने से, सभी इंटरफेस एलीमेंट्स का एक पॉप-

अप मेन्यू प्रस्तुत होता ह।ै आप Display, UI Elements मेन्यू का इस्तेमाल कर इंटरफेस एलीमेंट को फिर से प्रकट कर सकते हैं। सभी UI एलीमेंट्स को एक 

साथ छुपाने के लिए आप Display, UI Elements, Hide UI Elements मेन्यू कमांड का इस्तेमाल कर सकते हैं।

चित्र 6.1.13: चित्र 1-13
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ट्युटोरियल 1: फाइल ओपन करना

1.	 चरण 1: पॉप-अप हेल्प जबतक Open a scene का संदेश न दे, तबतक बाई ंओर Status Line बटन पर माउस फिराएँ।

2.	 चरण 2: इस बटन पर क्लिक करें । चित्र 1-11 में दिखाए अनुसार एक फाइल डायलॉग बॉक्स प्रकट होता ह।ै

3.	 चरण 3: उस डायरेक्टर ी को खोजें जहां Skateboard.mb फाइल स्थित हो।

4.	 चरण 4: Skateboard.mb फाइल नेम पर क्लिक करें  और फिर Open बटन पर क्लिक करें ।  सेव की हुई फाइल फिर, चित्र 1-14 में दिखाए अनुसार 

Maya में लोड हो जाती ह।ै

ध्यान दें: Maya कोई फाइल ओपन करे  उससे पहले यह आपको मौजदूा फाइल सेव करने का मौका देता ह।ै

चित्र 6.1.14: चित्र 1-14

ट्युटोरियल 2: फाइल सेव करना

1.	 चरण 1: क्रिएट मेन्यू पर क्लिक करें  और फिर Polygon Primitives सब-मेन्यू का चयन करें  और स्फेयर  मेन्यू पर क्लिक कर स्के टबोर्ड  सीन में एक 

स्फेयर  जोड़ें।

2.	 चरण 2: पॉप-अप हेल्प जबतक Save the current scene का संदेश न दे, तबतक बाई ंओर Status Line बटन पर माउस फिराएँ।

3.	 चरण 3: इस बटन पर क्लिक करें ।  फाइल स्वतः ही मौजदूा फाइल को रिप्लेस करके सेव हो जाती ह।ै सेव हो जाने पर फाइल नेम टाइटल बार पर 

प्रकट होता ह।ै

ध्यान दें: आप File, Save As मेन्यू कमांड का इस्तेमाल कर किसी नए फाइल नेम के साथ सीन सेव कर सकते हैं।

ट्युटोरियल 3: वर्क प्लेस इंटरफेस को मकै्सिमाइज करें

1.	 चरण 1: Status Line की बाई ंओर डॉटेड डबल लाइन पर राइट क्लिक करें  और Status Line का चयन करें ।   Status Line छुप जाती ह।ै 

2.	 चरण 2: Shelf, Channel Box तथा Toolbox के लिए डैश्ड लाइंस पर डबल क्लिक करें  तथा अन्य इंटरफेस पर अन्य विकल्प चुनें। 

3.	 चरण 3: इंटरफेस के नीचे स्थित कंट्रोल्स के लिए डैश वाली डबल लाइनों पर राइट क्लिक करें  और प्रत्येक का चयन करें । तब चित्र 1-15 में दिखाए 

अनुसार सभी इंटरफेस एलीमेंट्स छुप जाएँगे और Workspace मकै्सिमाइज़ हो जाएगा।

4.	 चरण 4: Display, UI Elements, Status Line मेन्यू कमांड चुनें। Status Line इंटरफेस एलीमेंट फिर से प्रकट होता ह।ै

5.	 चरण 5: शेष इंटरफेस एलीमेंट्स को फिर से प्रकट करने के लिए आप Display, UI Elements, Show UI Elements मेन्यू कमांड का इस्तेमाल करें ।
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चित्र 6.1.15: चित्र 1-15

6.1.2.3 Shelf एक्सेस करें  

Shelf स्टेरॉयड्स पर एक टूलबार की तरह होता ह।ै इसमें बटनों के कई टबै्ड पनैल होते हैं। बटनों के विभिन्न सेट चुनने के लिए, बस एक टबै पर क्लिक 

करें  और इसके सेट में मौजदू बटन दिखाई पड़ेंगे। चित्र 1-16 पॉलीगोंस टबै के लिए बटन दर्शाता ह।ै

चित्र 6.1.16: चित्र 1-16

Shelf मेन्यू का इस्तेमाल करना

Shelf के बाई ंओर दो मेन्यू आइकन होते हैं। सबसे ऊपर का मेन्यू एक मिनी टबै की तरह दिखाई पड़ता ह ैऔर आप इसका इस्तेमाल किसी मेन्यू से एक 

Shelf टबै चुनने में कर सकते हैं। सबसे नीचे का मेन्यू आइकन एक ऐरो होता ह।ै आप इसका इस्तेमाल सभी Shelf टबै्स को छुपाने में, Shelf Editor ओपन 

करने में, shelves बनाने और डिलीट करने में, किसी custom shelf लोड करने में तथा सभी shelves सेव करने में कर सकते हैं। आप Shelf टबै्स को 

छुपाकर कुछ इंटरफेस स्पेस को सेव कर सकते हैं। ऐसा करने के लिए Shelf मेन्यू से Shelf Tabs मेन्यू कमांड का चयन कर विकल्प को टॉगल ऑफ करें ।

Shelves बनाना और डिलीट करना

Shelf मेन्यू का इस्तेमाल shelves बनाने और डिलीट करने में भी किया जा सकता ह।ै New Shelf मेन्यू कमांड 

एक सरल डायलॉग बॉक्स ओपन करता ह,ै जसैा कि चित्र 1-17 में दिखाया गया ह,ै जिसमें आप नए shelf का 

नाम दे सकते हैं। फिर टबै के दाएं सिरे  पर नया खाली shelf (एम्प्टी shelf) दिखाई देगा। Delete Shelf मेन्यू 

कमांड चुनने से वर्तमान में चयनित shelf डिलीट हो जाएगा।

चित्र 6.1.17: चित्र 1-17किसी Shelf में आइकन तथा मेन्यू कमांड्स जोड़ना

बटन चुनकर और उसे माउस के बीच वाले बटन के साथ पसंदीदा shelf के टबै पर ड्रैग करते हुए आप किसी एक shelf से दूसरे  shelf में बटन जोड़ सकते 

हैं। Ctrl/Command तथा Shift की हेल्ड डाउन के साथ मेन्यू कमांड पर क्लिक कर मेन्यू कमांड मौजदूा shelf में जोड़ा जा सकता ह।ै आप टबै के दाएँ सिरे  

पर माउस के बीच वाले बटन के साथ shelf आइकन को Delete Shelf आइकन (जो एक छोटे ट्रैश कैन की तरह दिखाई पड़ता ह)ै पर ड्रैग कर shelf आइकन 

डिलीट कर सकते हैं।

ध्यान दें: Maya माउस के तीनों बटनों का इस्तेमाल करता ह।ै यदि आप दो बटनों और एक स्क्रोल व्हील वाले माउस का इस्तेमाल कर रहे हैं, तो स्क्रोल 

व्हील मिड्ल माउस बटन के रूप में काम करता ह।ै यदि दो बटनों वाले माउस में स्क्रोल व्हील नहीं हो तो आप Ctrl/Command (कमांड) key और लेफ्ट 
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माउस बटन का इस्तेमाल मिड्ल माउस बटन के रूप में कर सकते हैं। Macintosh एक-बटन माउस के लिए, कमांड-की और माउस बटन, मिड्ल माउस 

बटन के रूप में काम करते हैं और ऑप्शन-की तथा माउस बटन, दाएँ माउस बटन के रूप में काम करते हैं।

किसी Shelf में लआेउट्स तथा स्क्रिप्ट्स जोड़ना

आप किसी shelf में कस्टम लेआउट्स जोड़ सकते हैं। आप जिस कस्टम लेआउट को होल्ड करना चाहते हैं उसके लिए लिए shelf चुनें और फिर Panel मेन्यू 

से Panels, Panel Editor का चयन करें । लेआउट टबै में, चित्र 1-18 में दिखाए अनुसार, उस कस्टम लेआउट का चयन करें  जिसे आप मौजदूा shelf में जोड़ना 

चाहते हैं और Add To Shelf बटन पर क्लिक करें । आप माउस के मिड्ल बटन की मदद से Script Editor से स्क्रिप्ट ड्रैग कर सकते हैं और उन्हें किसी shelf 

में डाल सकते हैं। Shelf पर स्क्रिप्ट्स  ‘MEL’ लेबल वाले बटन के रूप में प्रकट होता ह,ै जो Maya Expression Language का संक्षिप्त रूप ह,ै यह Maya की 

स्क्रिप्टिंग भाषा होती ह।ै

चित्र 6.1.18: चित्र 1-18

Shelf Editor का इस्तेमाल करना

Shelves मेन्यू में एक विकल्प मौजदू होता ह,ै जो Shelf Editor डायलॉग बॉक्स खोलेगा। इस एडिटर का इस्तेमाल कर, चित्र 1-19 में दिखाए अनुसार आप 

टबै्स तथा shelves के क्रम को पुनर्व्यवस्थित कर सकते हैं और उन्हें नाम दे सकते हैं, हरे क shelf के भीतर आइकन एडिट करें  और shelves के लिए 

सेटिग्स बदलें।

चित्र 6.1.19: चित्र 1-19
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ट्युटोरियल 1: New Shelf बनाएँ

1.	 चरण 1: Shelf मेन्यू पर क्लिक करें  और New Shelf का चयन करें ।   Create New Shelf डायलॉग बॉक्स प्रकट होता ह।ै

2.	 चरण 2: नए shelf के लिए MyShelf नाम टाइप करें  और OK पर क्लिक करें । Shelf के दाएं सिरे  पर, टाइप किए नाम के साथ एक नया टबै दिखाई 

देता ह।ै

ट्युटोरियल 2: New Shelf को पोपुलेट करें

1.	 चरण 1: MyShelf को सक्रिय करने के लिए इस टबै का चयन करें ।

2.	 चरण 2: शिफ्ट तथा Ctrl/कमांड-की होल्ड डाउन करें , Create, NURBS Primitives, Sphere का चयन करें । नए shelf में एक स्फेयर  आइकन जुड़ 

जाता ह।ै

3.	 चरण 3: Create मेन्यू में अन्य प्रिमिटिव ऑब्जेक्ट्स  के साथ चरण 2 को दुहराएँ।   चित्र 1-20 में दिखाए अनुसार, नये shelf पर प्रत्येक चयनित मेन्यू 

कमांड दिखाई देती ह।ै

4.	 चरण 4: Panel, Panel Editor panel मेन्यू कमांड चुनें। Panel Editor डायलॉग बॉक्स प्रकट होता ह।ै

5.	 चरण 5: लेआउट टबै चुनें और फिर Four View विकल्प का चयन करें । फिर Add to Shelf बटन पर क्लिक करें  और फिर Close बटन पर क्लिक करें ।   

जब Four View विकल्प का चयन किया जाता ह,ै तब व्यू विंडो बदल जाती ह ैऔर चार पथृक व्यू प्रदर्शित करना आरंभ करती ह।ै Add to Shelf बटन 

पर क्लिक करने के बाद, मौजदूा shelf पर एक नया आइकन प्रकट होता ह।ै

6.	 चरण 6: टूलबॉक्स में Move टूल खोजें और मिड्ल माउस बटन की मदद से आइकन को नए shelf पर ड्रैग करें ।   मिड्ल माउस बटन की मदद से 

आइकन को ड्रैग करने से वह आइकन मौज ूshelf में जुड़ जाता ह।ै चित्र 1-20 नया shelf प्रदर्शित करता ह।ै

7.	 चरण 7: Shelf मेन्यू से Save All Shelves का चयन करें ।  

चित्र 6.1.20: चित्र 1-20

6.1.2.4 Channel Box तथा Layer Editor खोजें

जब किसी ऑब्जेक्ट का चयन किया जाता ह,ै इसके कीएबल ऐट्रिब्यूट्स (या चनैल्स) चित्र 1-21 में दिखाए 

अनुसार, इंटरफेस की दाई ंओर Channel Box में दिखाई पड़ते ता ह।ै हरे क ऐट्रिब्यूट के साथ एक मान जुड़ा होता 

ह।ै ये मान प्रायः संख्याएँ होते हैं, पर वे ऑन या ऑफ, या एक कलर जसेै स्टेट हो सकते हैं। आप चनैल के मान 

को चयन कर, एक भिन्न मान डाल कर और एंटर की दबाकर इन मानों को बदल सकते हैं।

ध्यान दें: Layer Editor के नीचे double-arrow बटन दबाकर Channel Box तथा Layer Editor को विस्तृ त तथा 

संकुचित कर सकते हैं।

चित्र 6.1.21: चित्र 1-21
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ऐट्रिब्यूट्स का चयन करें  

आप टाइटल पर क्लिक कर एक सिगल ऐट्रिब्यूट चुन सकते हैं। चयनित होने पर ऐट्रिब्यूट टाइटल रे खांकित हो जाता ह।ै Ctrl/Command key को होल्ड 

डाउन कर और कई ऐट्रिब्यूट्स पर क्लिक करने से आपको एक ही बार में एकाधिक ऐट्रिब्यूट्स चुनने की अनुमति मिलती ह;ै आप कई सारे  ऐट्रिब्यूट्स को 

चुनने के लिए उनके ऊपर माउस ड्रैग कर सकते हैं। 

Channel Sliders का इस्तेमाल करना

आप Channel Box में ऐट्रिब्यूट का चयन कर ऐट्रिब्यूट मानों को रोचक तरीके से बदल सकते हैं और तब उन्हें व्यू पनैल में मिड्ल माउस बटन की मदद से 

ड्रैग कर सकते हैं। चित्र 1-22 में दिखाए अनुसार, Channel Box के ऊपर स्थित बटन का इस्तेमाल कर, आप चनैल स्लाइडर सेटिग्स को Slow, Medium, 

या Fast पर सेट कर सकते हैं। सेटिग जितनी अधिक होगी , ड्रैग करने पर ऐट्रिब्यूट उतनी की तेज़ी से बदलेगा। आप कोई लीनियर या हाइपरबोलिक 

स्लाइडर सेटिग का भी चयन कर सकते हैं। लीनियर सेटिग ऐट्रिब्यूट मानों को माउस के साथ ड्रैग करने पर रैखिक रूप से बदलता ह,ै पर हाइपरबोलिक 

सेटिग, माउस द्वारा ड्रैग किए जाने पर मान को अधिक तेज़ी से बदलता ह।ै

ध्यान दें: आप += और एक संख्या एंटर कर उसे मौजदूा मान की उस मात्रा में जोड़ सकते हैं। उदाहरण के लिए किसी ऐट्रिब्यूट फील्ड में 5.0 के रेडिय स 

मान के लिए +=2 टाइप करने से यह बदलकर 7.0 हो जाता ह।ै आप सापेक्षिक मानों को घटाने, गुणा करने तथा विभाजन करने के लिए -=, *= तथा /= 

का भी इस्तेमाल कर सकते हैं।

चित्र 6.1.22: चित्र 1-22

ऐट्रिब्यूट्स लॉक करना

लॉक किए हुए ऐट्रिब्यूट्स को बदला नहीं जा सकता ह।ै आप किसी ऐट्रिब्यूट को चयन कर और चनैल मेन्यू से Lock Selected मेन्यू कमांड चुनकर उस 

ऐट्रिब्यूट को लॉक कर सकते हैं। चित्र 1-23 में दिखाए अनुसार, लॉक हुए ऐट्रिब्यूट “grayed out,” के रूप में दिखाई पड़ेंगे । Channels, Unlock Selected 

मेन्यू कमांड की मदद से किसी भी लॉक किए ऐट्रिब्यूट को अनलॉक कर सकते हैं।

चित्र 6.1.23: चित्र 1-23
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लयेर्स जोड़ना और डिलीट करना

चित्र 1-24 में दिखाए अनुसार, Layer Editor, सीन एलीमेंट्स को कई लेयरों में बांटता ह,ै जिससे उन्हें दिखाना और छुपाना आसान बन जाता ह।ै Layer 

Editor में Create a New Layer बटन पर क्लिक करने से एक नई लेयर बनती ह।ै आप हरे क लेयर को कोई नाम, डिस्प्ले टाइप तथा कलर दे सकते हैं। 

Layers मेन्यू की मदद से लेयर्स डिलीट करें । किसी लेयर को डिलीट करने से उसके ऑब्ज़ेक्ट्स  डिलीट नहीं होते। Layer Editor के सबसे ऊपर Display 

तथा Render layers बनाने के विकल्प मौजदू होते हैं। Render layers की चर्चा  आगे की जाएगी।

चित्र 6.1.24: चित्र 1-24

किसी लयेर में ऑब्ज़ेक्ट्स जोड़ना

आप किसी लेयर पर राइट क्लिक कर तथा पॉप-अप मेन्यू से Add Selected Objects चुनकर चयनित ऑब्ज़ेक्ट्स  को जोड़ सकते हैं। आप किसी लेयर में 

सभी ऑब्ज़ेक्ट्स  को चुनने के लिए और किसी लेयर से ऑब्ज़ेक्ट्स  हटाने के लिए भी Layers मेन्यू का इस्तेमाल कर सकते हैं। अचयनित किए जाने पर 

ऑब्ज़ेक्ट्स  लेयर कलर ग्रहण कर सकते हैं।

सभी लयेर ऑब्ज़ेक्ट्स को छुपाना

Layer Editor में पहले कॉलम पर क्लिक कर लेयर ऑब्जेक्ट्स  को छुपा सकते हैं। यह कॉलम लेयर ऑब्ज़ेक्ट्स  के लिए विजिबिलिटी सेट करता ह ैऔर 

एक सरल button बटन ह ै जिसे आप टर्न ऑन या ऑफ कर सकते हैं। जब लेयर ऑब्ज़ेक्ट्स  दिखाई पड़ता ह ैतो V अक्षर दिखाई पड़ता ह ैऔर लेयर 

ऑब्ज़ेक्ट्स  छुपे होने पर कॉलम खाली होता ह।ै

सभी लयेर ऑब्ज़ेक्ट्स को फ्रीज़ करना

 दूसरे  कॉलम को Normal, Template या Reference पर सेट किया जा सकता ह।ै लेयर जब एक टेम्प्लेट होता ह ैतो इस कॉलम में T अक्षर प्रकट होता ह।ै 

टेम्प्लेट्स लेयर्स को तब चुना या खिसकाया नहीं जा सकता ह,ै जब वे टेम्प्लेट्स के रूप में होते हैं। References प्रॉक्सी ऑब्ज़ेक्ट्स  होते हैं, जो जटिल 

ऑब्ज़ेक्ट्स  के लिए होते हैं। तीसरा कॉलम लेयर कलर होता ह।ै इस कॉलम (या लेयर के नाम) पर डबल क्लिक करने से Edit Layer डायलॉग बॉक्स 

खुलता ह,ै जसैा कि चित्र 1-25 में दिखाया गया ह,ै जहाँ आप एक नया कलर चुन सकते हैं, लेयर के ऐट्रिब्यूट्स या लेयर का नाम बदल सकते हैं।

चित्र 6.1.25: चित्र 1-25
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ट्युटोरियल 1: Channel Box ऐट्रिब्यूट्स बदलें

1.	 चरण 1: File, Open Scene चुनें। Rocket.mb फाइल को खोजकर उसे ओपन करें । इस फाइल में ग्रिड ऑरिजिन पर कें द्रित एक सरल रॉकेट शामिल 

होता ह।ै रॉकेट ऑब्ज़ेक्ट के लिए सभी ऐट्रिब्यूट Channel Box में दिखाई पड़ते हैं। 

2.	 चरण 2: Translate X attribute में 5 एंटर करें  और Enter की दबाएँ। रॉकेट ऑब्ज़ेक्ट एक्स-एक्सिस पर पांच यनूिट्स खिसकता ह।ै

3.	 चरण 3: Channel Box में Translate Y एट्रिब्यूट पर क्लिक करें  और मिड्ल माउस बटन की मदद से Workspace में ऊपर की ओर ड्रैग करें ।   रॉकेट 

ऑब्ज़ेक्ट Y-एक्सिस पर माउस द्वारा ड्रैग की गई दूरी तक बढ़ता ह ैऔर ऐट्रिब्यूट का मान बदल जाता ह,ै इसे चित्र 1-26 में दिखाया गया ह।ै 

4.	 चरण 4: फाइल चुनें, Save Scene As चुनें और फाइल को Translated rocket.mb के रूप में सेव करें ।

चित्र 6.1.26: चित्र 1-26

ट्युटोरियल 2: New Layer बनाएँ और रीनेम करें

1.	 चरण 1: Layer Editor में Create a New Layer बटन पर क्लिक करें । Layer Editor में एक नया लेयर दिखाई पड़ता ह।ै

2.	 चरण 2: एडिट लेयर डायलॉग बॉक्स ओपन करने के लिए लेयर पर डबल क्लिक करें ।

3.	 चरण 3: नए लेयर में कोई नाम टाइप करें  और Save बटन पर क्लिक करें ।  

ट्युटोरियल 3: New Layer में ऑब्ज़ेक्ट्स  जोड़ना

1.	 चरण 1: स्फेयर  ऑब्ज़ेक्ट बनाने के लिए Create, Polygon Primitives, Sphere सिलेक्ट करें

2.	 चरण 2: सभी ऑब्ज़ेक्ट्स  को चुनने के लिए Edit, Select All मेन्यू कमांड चुनें।

3.	 चरण 3: Layer Editor में नए लेयर पर राइट क्लिक करें  और पॉप-अप मेन्यू से Add Selected Objects चुनें। सभी ऑब्ज़ेक्ट्स  नए लेयर में जुड़  
जाते हैं।

4.	 चरण 4: Layer Editor में पहले कॉलम पर क्लिक करें , जिसमें V दिखाई पड़ता ह।ै   लेयर पर सभी ऑब्ज़ेक्ट्स  छिपे होते हैं।
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6.1.2.5 Animation controls, Command Line तथा Help Line

इंटरफेस के सबसे नीचे कई सारे  इंटरफेस कंट्रोल्स होते हैं, जिनका इस्तेमाल विभिन्न एनिमेशन फ्रे म्स से होकर मूव करने में किया जाता ह ैइसके नीचे 

एक कमांड लाइन होती ह,ै जहाँ आप लाग ूकिए जाने वाले कमांड्स टाइप कर सकते हैं। इंटरफेस से नीचे एक Help Line होती ह,ै जहाँ संदर्भ-विशिष्ट 

सचूना प्रदर्शित होती ह।ै

एनिमेशन फ्रे म का चयन करना

चित्र 1-27 में दर्शाए अनुसार, इंटरफेस के सबसे नीचे टाइम स्लाइडर पर सभी मौजदूा एनिमेशन फ्रे म्स दिखाई पड़ते हैं। ब्लैक टाइम मार्कर  ड्रैग कर या टाइम 

स्लाइडर की दाई ंओर के फील्ड में फ्रे म नम्बर एंटर कर आप विभिन्न फ्रे म्स के बीच मूव करते हैं।

चित्र 6.1.27: चित्र 1-27

एनिमेशन रें ज सेट करना

चित्र 1-28 में दिखाए अनुसार टाइम स्लाइडर के नीचे रें ज स्लाइडर होता ह।ै इस स्लाइडर का इस्तेमाल करने से आप एनिमेशन फ्रे म्स के विशेष रें ज पर 

ध्यान कें द्रित कर सकते हैं। रें ज स्लाइडर के खिसकने से टाइम स्लाइडर बदलता ह।ै

चित्र 6.1.28: चित्र 1-28

एनिमेशन चलाना

चित्र 1-29 में दर्शाए अनुसार, एनिमेशन फ्रे म वलै्यू की दाई ंओर प्लेइंग, रिवाइंडिग तथा एनिमेशन फ्रे म्स में मूव करने के लिए कई कंट्रोल्स होते हैं। इन 

बटनों का इस्तेमाल करने से आप एनिमेशन आरंभ (या समापन), एक फ्रे म पीछे  लौटने (या आगे बढ़ने), एक की (key) पीछे  लौटने (या आगे बढ़ने) या 

एनिमेशन को आगे प्ले करने (या पीछे  प्ले करने) में सक्षम होंगे।

चित्र 6.1.29: चित्र 1-29

Animation Preferences को एक्सेस करना

Go to End button के नीचे एक बटन होता ह,ै जिसे चित्र 1-30 में दिखाया गया ह,ै जो Preferences dialog box ओपन करता ह,ै जसैा 

कि चित्र 1-31 में दिखाया गया ह।ै इस डॉयलॉग बॉक्स में Maya की सभी प्रेफ़रें सेज़ शामिल होती हैं, पर इस बटन का इस्तेमाल कर 

जब इसे खोला जाता ह,ै तो Timeline कैटगरी सिलेक्ट हो जाती ह,ै जिससे आप एनिमेशन प्रेफरें सेज़ बदल सकते हैं।
चित्र 6.1.30: चित्र 1-30



131130

प्रतिभागी पुस्तिका

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

चित्र 6.1.31: चित्र 1-31

ट्युटोरियल 1: एनिमेशन चलाएँ

1.	 चरण 1: फाइल चुनें, सीन ओपन करें  और फाइल को Billiard balls.mb. के रूप में ओपन करें । इस फाइल में एक सरल एनिमेटेड सीन शामिल  

होता ह।ै

चित्र 6.1.32: चित्र 1-32
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2.	 चरण 2: टाइम स्लाइडर में टाइम मार्कर  पर क्लिक करें  और उसे बाई ंओर ड्रैग करें । सीन में ऑब्ज़ेक्ट्स  मूव करते हैं, क्योंकि फ्रे म बढ़ जाते हैं। 

एनिमेशन सीक्वेंस का एक फ्रे म चित्र 1-32 में दिखाया गया ह।ै

3.	 चरण 3: Play Forwards बटन पर क्लिक करें । संपरू्ण  एनिमेशन सीक्वेंस बार-बार प्ले होगा।

4.	 चरण 4: एनिमेशन रोकने के लिए Stop बटन पर क्लिक करें ।

6.1.2.6 Toolbox तथा Quick Layout बटन का इस्तेमाल करें

चित्र 1-33 में दर्शाए अनुसार, इंटरफेस की बाई ंओर बटनों का एक कॉलम होता ह,ै जिसे टूलबॉक्स 

के रूप में जाना जाता ह।ै टूलबॉक्स के नीचे कई layout बटन होते हैं, जिन्हें सामूहिक रूप में Quick 

Layout बटन करते हैं।

ऑब्जेक्ट को सिलके्ट करना

टूलबॉक्स में पहले दो बटनों का इस्तेमाल सीन में ऑब्ज़ेक्ट्स  चुनने में किया जाता ह।ै ये Select 

Objects टूल और Lasso टूल होते हैं। Select Object टूल आपको ऑब्जेक्ट्स  पर क्लिक कर या एक 

आयताकार बॉर्डर ड्रैग कर उन्हें चुनने की अनुमति देता ह।ै Lasso टूल आपको अपने मनपसंद 

ऑब्जेक्ट पर किसी फ्रीहैंड आउटलाइन ड्रैग करने की अनुमति देता ह।ै

Select Objects टूल के साथ ऑब्जेक्ट्स  पर क्लिक करने के दौरान शिफ्ट-की होल्ड डाउन करने 

से ऑब्ज़ेक्ट्स  सेलेक्शन सेट पर जुड़ जाएगा। सभी चयनित ऑब्जेक्ट्स  सफेद दिखाई पड़ेंगे, 

केवल अंतिम ऑब्ज़ेक्ट के साथ ऐसा नहीं होता ह,ै जो हल्के  हरे  रंग में दिखाई पड़ता ह।ै यह हल्का 

हरा ऑब्जेक्ट को की-ऑब्जेक्ट के रूप में जाना जाता ह।ै

ट्रांसफॉर्म टूल्स का इस्तेमाल करना

Toolbox Move, Rotate, तथा Scale टूल्स भी शामिल होते हैं। जब इनमें से किसी टूल्स को चुना 

जाता ह,ै मनैिपुलेटर उस चयनित ऑब्जेक्ट के कें द्र (पिवट प्वाइंट) में दिखाई पड़ेगा। इन टूलों के 

साथ, आप चयनित ऑब्जेक्ट को रूपांतरित कर सकते हैं। चित्र 1-34 में Move टूल के लिए दिखाए 

अनुसार, मनैिपुलेटर आपको एकल अक्ष पर टूल को रूपांतरित करने की अनुमति देता ह।ै आप 

मनैिपुलेटर के समीप प्रदर्शित ट्रांसफॉर्म  वलै्यू पर भी क्लिक कर सकते हैं और कीबोर्ड  का इस्तेमाल 

कर नए मानों को भी एंटर कर सकते हैं।

ध्यान दें: जब किसी ट्रांसफॉर्म  टूल्स पर किसी ट्रांसफॉर्म  हैंडल का चयन किया जाता ह,ै यह पीला 

हो जाता ह।ै आप middle mouse बटन का इस्तेमाल कर चयनित हैंडल को ड्रैग कर सकते हैं।

चित्र 6.1.33: चित्र 1-33

चित्र 6.1.34: चित्र 1-34मनैिपुलटेर्स को समझना

हरे क ट्रांसफॉर्म  मनैिपुलेटर्स में कलर-आधारित घटक होते हैं जो आपको एकल अक्ष पर किसी ट्रांसफॉर्म  को रोकने की अनुमति देगा- लाल X-अक्ष के लिए 

होता ह,ै हरा- Y-अक्ष के लिए तथा नीला Z-अक्ष के लिए होता ह,ै जसेै चित्र 1-35 में दर्शाया गया ह।ै चयनित मनैिपुलेटर अक्ष पीला दिखाई पड़ेगा और ड्रैगिग 

से चयनित अक्ष पर वस्तु रूपांतरित हो जाएगा।

चित्र 6.1.35: चित्र 1-35
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ट्रांसफ़ॉर्मर मनैिपुलेटर्स के अलावा कई अन्य मनैिपुलेटर्स होते हैं। उदाहरण के लिए, जब किसी स्पॉट लाइट ऑब्जेक्ट का चयन किया जाता ह,ै आप किसी 

मनैिपुलेटर को सक्षम बना सकते हैं, जो व्यू में ड्रैगिग द्वारा अपनी लाइट प्रॉपर्टीज़ को बदलने की अनुमति देता ह,ै जसेै कि इसका फॉलऑफ कोन, दिशा 

तथा तीव्रता। ऑब्ज़ेक्ट मनैिपुलेटर्स को टूलबॉक्स में Show Manipulator बटन पर क्लिक कर सक्रिय बनाया जाता ह।ै

टूलबॉक्स में Show Manipulator Tool के नीचे एक अन्य बटन होता ह,ै जो इस्तेमाल किए गए अंतिम टूल को रोकता ह।ै याद रखें कि कोई मेन्यू आइटम 

या बटन जिसमें इसके नाम का वर्ड  टूल शामिल होता ह,ै तबतक सक्रिय बना रहता ह ैजबतक कि अन्य टूल का चयन न कर लिया जाये और यह टूलबॉक्स 

के सबसे नीचे प्रकट होगा।

ध्यान दें:  टूलबॉक्स का अंतिम स्लॉट मेन्यू से चयनित टूल्स के लिए आरक्षित रहता ह।ै टूलबॉक्स टूल्स इस स्लॉट को अधिग्रहित नहीं करेग ा।

लआेउट्स बदलना

चित्र 6.1.36: चित्र 1-36
लआेउट कस्टमाइज करना

आप लेआउट बदल सकते हैं जिसे हरे क बटन लेआउट बटनों पर राइट-क्लिक कर तथा पॉप-अप मेन्यू से लेआउट चुनकर ओपन करता ह।ै यदि आप Quick 

Layout बटनों के नीचे Model View बटन पर राइट क्लिक करते हैं, तो आप प्रदर्शित पेनों (panes) की संख्या का चयन कर सकते हैं। यदि एकाधिक पेन 

का चयन किया जाता ह,ै तो Model View बटन आपके द्वारा चयनित पेनों की संख्या में विभाजित हो जाएगा। Model View बटन पर क्लिक करने से आप 

क्लिक किए गए व्यू में प्रदर्शित व्यू को बदल सकते हैं।

व्यू पनैल्स की रीसाइज़िग तथा एडिटिंग

ट्युटोरियल 1: कोई ऑब्जेक्ट चुनें

1.	 चरण 1: Five spheres.mb फाइल ओपन करें  इस फाइल में पांच स्फेयर  ऑब्ज़ेक्ट्स  शामिल होते हैं।

2.	 चरण 2: सलेक्ट पर क्लिक करें  और फिर सेंटर स्फेयर  पर क्लिक करें । इस सीन में स्फेयर  हल्के  हरे  रंग का हो जाता ह ैऔर इसके ऐट्रिब्यूट्स चनैल 

बॉक्स में दिखाई पड़ते हैं।

3.	 चरण 3: शिफ्ट की होल्ड डाउन करें  और फिर सीन में अन्य स्फेयर्स  पर क्लिक करें ।  चित्र 1-38 में दिखाए अनुसार, सीन के सभी स्फेयर  सलेक्ट 

किये गये हैं और जिस अंतिम स्फेयर  पर क्लिक किया जाता ह ैवह हल्के  हरे  रंग का हो जाता ह।ै

जब एकाधिक व्यू पनैल्स दिखाई पड़ते हैं, आप पनैल्स के बीच डिवाइडर्स ड्रैग कर एकल पनैल को 

रीसाइज़ कर सकते हैं। एक समय में केवल एक व्यू पनैल सक्रिय हो सकता ह।ै

ध्यान दें: Spacebar का इस्तेमाल करने से ऐक्टिव व्यू पनैल द्वारा संपरू्ण  Workspace को भरने और 

पिछले लेआउट पर वापस लौटने के बीच टॉगल कर सकते हैं। उदाहरण के लिए, यदि Four View 

लेआउट का चयन किया जाता ह ैऔर टॉप व्यू पनैल सक्रिय व्यू पनैल होता ह,ै तो Spacebar दबाने से 

टॉप व्यू पनैल मकै्सिमाइज़ हो जाता ह।ै

आप किसी पनैल के व्यू को बदलने के लिए पनैल मेन्यू पर पनैल मेन्यू कमांड का इस्तेमाल कर 

सकते हैं। हरे क व्यू पनैल के शीर्ष  पर आपको पनैल मेन्यू मिलेगी। चित्र 1-37 में बताए अनुसार पनैल 

डायलॉग बॉक्स खोलने के लिए Panels, Saved Layouts, Edit Layouts मेन्यू कमांड। इस डायलॉग 
चित्र 6.1.37: चित्र 1-37

बॉक्स के साथ आप नया पनैल बना सकते हैं और कस्टम लेआउट्स एडिट कर सकते हैं।

टूलबॉक्स के नीचे कई बटन होते हैं, जिसे चित्र 1-36 में दिखाया गया ह,ै जो Maya इंटरफेस के 

लेआउट को तेज़ी से बदलने की अनुमति देता ह।ै डिफॉल्ट लेआउट विकल्पों में शामिल होता ह-ै 

Single Perspective View, Four View, Perspective/Outliner, Perspective/Graph Editor, 

Hypershade/Perspective, तथा Perspective/Hypergraph/Graph। इन लेआउट बटनों के नीचे स्थित 

ऐरो बटन अतिरिक्त लेआउट विकल्पों के एक पॉप-अप मेन्यू को निरूपित करता ह।ै
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चित्र 6.1.38: चित्र 1-38

ट्युटोरियल 2: कोई ऑब्ज़ेक्ट रूपांतरित करें

1.	 चरण 1: Five spheres.mb फाइल ओपन करें ।

2.	 चरण 2: सलेक्ट पर क्लिक करें  और फिर सेंटर स्फेयर  पर क्लिक करें ।

3.	 चरण 3: टूलबॉक्स में मूव टूल पर क्लिक करें  और हरे  (Y-अक्ष) को ऊपर की ओर ड्रैग करें । 

4.	 चरण 4: सीन में स्फेयर  ऊपर की ओर बढ़ता ह।ै 

चित्र 6.1.39: चित्र 1-39
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5.	 चरण 5: टूलबॉक्स में स्के ल टूल पर क्लिक करें  और लाल (X-अक्ष) को दाई ंओर ड्रैग करें ।

6.	 चरण 6: चित्र 1-39 में दिखाए अनुसार स्फेयर  X-अक्ष पर लंबा हो जाता ह।ै

7.	 चरण 7: फाइल चुनें, सेव सीन ऐज़ चुनें और फाइल को Elongated sphere.mb के रूप में सेव करें ।

ट्युटोरियल 3: इंटरफेस लेआउट बदलें

1.	 चरण 1: आप Status Line की दाई ंओर स्थिति शो/हाइड Channel Box बटन पर क्लिक करें ।

2.	 चरण 2: क्विक लेआउट बटन में Four Views बटन पर क्लिक करें ।   चित्र 1-40 में दिखाए अनुसार लेआउट चार व्यूज़ दिखाने के लिए परिवर्तित हो 

जाता ह।ै

चित्र 6.1.40: चित्र 1-40

6.1.2.7 Secret मेन्यूज़ का पता लगाएं

जब आप मेन्यू कमांड के प्रति अभ्यस्त हो जाते हैं, तो आप छिपे हुए मेन्यू का इस्तेमाल कर तेज़ी से काम करना सीख सकते हैं। जब आप सीन में 

ऑब्ज़ेक्ट्स  पर राइट क्लिक करते हैं तो ये मेन्यू में विभिन्न कमांड पॉप-अप होते हैं।

मार्किं ग मेन्यू को एक्सेस करना

कई आम/कॉमन कमांड को जल्‍दी से एक्सेस करने के लिए, आप व्यू पनैल पर राइट क्लिक कर 

और मेन्यू दिखने तक माउस बटन को होल्ड डाउन कर, एक मार्किंग  मेन्यू ओपन कर सकते हैं। 

आप फिर विभिन्न मेन्यू ऑप्शंस के बीच कर्सर को मूव कर सकते हैं और इच्छित मेन्यू कमांड 

चुनने के लिए माउस बटन छोड़/रिलीज़ कर सकते हैं। चित्र 1-41 पॉलिगोन स्फेयर  ऑब्ज़ेक्ट के 

लिए मार्किंग  मेन्यू दर्शाता ह।ै

ध्यान दें: व्यू पनैल में क्लिक करते समय q की (key) पर होल्ड डाउन कर आप सिलेक्शन ऑप्शंस 

की मार्किंग  मेन्यू एक्सेस कर सकते हैं। आप इसी तरीके से अन्य कस्टम मार्किंग  मेन्यू भी एक्सेस 

कर सकते हैं, जसेै कि Move Tool options (w), Rotate Tool options (e), Scale Tool options (r), 

Polygon Brush options (o), Select All menu (a), तथा Menu Sets (h).

चित्र 6.1.41: चित्र 1-41
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मार्किं ग मेन्यू को कस्टमाइज़ करना

आप मार्किंग  मेन्यू की चीज़ों को बदल सकते हैं, किसी मार्किंग  मेन्यू को एक हॉटकी असाइन कर सकते हैं या Marking Menu Settings डायलॉग बॉक्स 

का इस्तेमाल कर हॉटबॉक्स में मार्किंग  मेन्यू जोड़ सकते हैं, इसे चित्र 1-42 में दिखाया गया ह।ै Window, Settings/Preferences, Marking Menus मेन्यू 

कमांड का इस्तेमाल कर आप इस डायलॉग बॉक्स को एक्सेस कर सकते हैं।

चित्र 6.1.42: चित्र 1-42

Hotbox का इस्तेमाल करना

Hotbox चित्र 1-43 में दिखाया गया ह,ै जो 

कस्टमाइज़ किए जाने योग्य मेन्यू का एक 

परू्ण  सेट होता ह,ै जिसे आप स्पेसबार को 

दबाकर और होल्ड कर एक्सेस कर सकते 

हैं। Hotbox में Hotbox Controls विकल्प का 

इस्तेमाल करके आप Hotbox में प्रकट होने 

वाले मेन्यू कमांड का चयन कर सकते हैं।

चित्र 6.1.43: चित्र 1-43
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Hotbox को कस्टमाइज़ या अनुकूलित करना

यदि आप Hotbox से Hotbox Controls विकल्प का चयन करते हैं, तो Hotbox में शामिल करने के लिए मेन्यू सेट का चयन कर सकते हैं। आप “शो या 

हाइड ऑल मेन्यू” का भी चयन अर सकते हैं।

ट्युटोरियल 1: मार्किंग  मेन्यू को एक्सेस करना

1.	 चरण 1: स्फेयर  ऑब्ज़ेक्ट बनाने के लिए Create, Polygon Primitives, Sphere सिलेक्ट करें  

2.	 चरण 2: व्यू पनैल को डिसलेक्ट करने के लिए स्फेयर  से दूर व्यू पनैल पर क्लिक करें ।

3.	 चरण 3: स्फेयर  पर राइट क्लिक करें  और पॉप-अप मार्किंग  मेन्यू से Select चुनें। स्फेयर  ऑब्ज़ेक्ट सलेक्ट हो जाता ह।ै

ट्युटोरियल 2: Hotbox का इस्तेमाल करें

1.	 चरण 1: कर्सर को व्यू पनैल के कें द्र में ले जाएँ और स्पेसबार दबाकर होल्ड करें । चित्र 1-44 में दिखाए अनुसार Hotbox उस जगह मध्य में दिखाई 

पड़ता ह,ै जहाँ कर्सर स्थित होता ह।ै

2.	 चरण 2: कर्सर को क्रिएट बटन पर ड्रैग करें  और Polygon Primitives, Sphere कमांड का चयन करें । स्फेयर  ऑब्ज़ेक्ट व्यू पनैल में दिखाई पड़ता ह।ै

3.	 स्पेस बार छोड़ें।

चित्र 6.1.44: चित्र 1-44

6.1.3 NURBS सतह पर काम करना

NURBS, नॉन-यनूिफॉर्म  रे शनल B-स्प्लाइन का संक्षिप्त रूप ह।ै ये स्प्लाइन गणितीय रूप से परिभाषित रे खाएं होती हैं, जिन्हें मनैिपुलेट कर आप अनोखी 

आकृतियाँ बना सकते हैं। NURBS सतह, NURBS कर्वों से बना एक ठोस ऑब्ज़ेक्ट होता ह।ै NURBS सतह जवैिक वस्तुओ ंके मॉडलिग के लिए उपयोगी 

होती ह,ै जसेै कि फूल तथा पेड़, जहां सतहें एक-दूसरे  पर लुढ़कती हैं।

 NURBS सतहों को NURBS वक्रों की तरह ही उनके कंट्रोल वर्टिसेज (CVs) को मूव करके एडिट किया जा सकता ह।ै यह देखने के लिए विभिन्न CVs 

कैसे जुड़े  होते हैं, आप NURBS सतहों के लिए हल्स भी डिस्प्ले कर सकते हैं। राइट-क्लिक मार्किंग  मेन्यू का इस्तेमाल कर आप उन सभी घटकों को देखने 

का विकल्प चुन सकते हैं, जो NURBS सतह बनाते हों। 

NURBS सतहों के लिए अन्य आम घटक हैं आइसोपरैामटै्रिक कर्व्स (संक्षेप में आइसोपार्म्स)। आइसोपार्म्स प्रतिनिधि रे खाएँ होती हैं जो वस्तु की सतह 

दिखाती ह।ै आइसोपार्म  की दिशा को U और V कॉर्डि नेट सिस्टम की मदद से परिभाषित किया जाता ह,ै जहां U-direction आइसोपार्म  क्षैतिज (हॉरिज़ॉन्टल) 

रूप से गमन करता ह ैऔर V-direction आइसोपार्म  लम्बवत् (वर्टिकल) रूप से गमन करता ह।ै

Rough resolution (1-की दबाने से इनेबल्ड/सक्षम) पर आइसोपार्म्स की संख्या काफी कम हो जाती ह,ै लेकिन Fine resolution (3-की दबाने से सक्षम) पर 

कई अतिरिक्त आइसोपार्म्स दिखाई पड़ते हैं। नए आइसोपार्म्स का निर्माण किसी मौजदूा आइसोपार्म  को नए आइसोपार्म  की लोकेशन को चिह्नित करने हेतु 

ड्रैग करके आसानी से किया जा सकता ह।ै चिह्नित आइसोपार्म्स Surfaces, Insert Isoparms menu कमांड की मदद से स्थाई बनाया जा सकता ह।ै

आइसोपार्म्स के बीच का स्थान पचै कहलाता ह।ै हरे क पचै में दो साइड/किनारे  होते हैं। जो किनारा रें डर किया जाता ह,ै उसे छिपे vector की दिशा से 

निर्धा रित किया जाता ह,ै जिसे नॉर्मल कहा जाता ह।ै यह पचै फेस पर लम्बवत् फैलता ह।ै
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NURBS सतहों का निर्माण Create, NURBS Primitives मेन्यू की मदद से या NURBS कर्व पर एक Surfacesसर्फे स मेन्यू कमांड के इस्तेमाल से किया जा 

सकता ह।ै NURBS सर्फे स बन जाने पर आप Surfaces मेन्यू में मौजदू ऑपरे शंस की मदद से इस पर काम कर सकते हैं।

Surfaces मेन्यू में मौजदू कुछ ऑपरे शंस आपको सतहों को जोड़ने तथा अलग करने, अलाइन करने, खोलने और बंद करने, विस्तार करने ऑफसेट तथा 

फिलेट करने की अनुमति देते हैं। इन ऑपरे शनों के इस्तेमाल से पहले एक या अधिक सर्फे सों का चयन करना होता ह।ै Help Line बताती ह ैकि किसी 

ऑपरे शन का इस्तेमाल करने के लिए क्या चुना जाए।

Surfaces मेन्यू में कई सारे  टूल तथा कमांड भी शामिल होते हैं, जिनका इस्तेमाल Surface Editing tool, the Sculpt Geometry tool, तथा Break व Smooth 

Tangent commands समेत NURBS surfaces को एडिट करने में किया जाता ह।ै Surface Editing टूल आपको किसी सर्फे स लोकेशन पर क्लिक करने  

और इसे किसी मनैिपुलेटर से मूव करने या इसके टैंजेंट को बदलने की अनुमति देता ह।ै Sculpt Geometry टूल आपको एक परिवर्तनशील, इंट्रैक्टिव  

ब्रश के प्रयोग से सर्फे स को पुश, पुल या स्मूथ करने की अनुमति देता ह।ै ब्रेकिग टैंजेंट्स आपको NURBS सर्फे सों पर हार्ड  एजिज़ क्रिएट करने की अनुमति 

देता ह।ै

 ट्रिमिग, NURBS सर्फे सेज पर छिद्र डालने/होल्स एड करने की प्रक्रिया ह।ै इसे NURBS कर्व के साथ ट्रिम किए जाने वाले एरिया को चिह्नित कर किया 

जाता ह।ै ये कर्व्स सर्फे स से जुड़े  होने चाहिए, जो एक अन्य सर्फे स के बीच के इंटरसेक्शन को चिह्नित कर या किसी लाइव ऑब्ज़ेक्ट पर ड्राइंग कर किया 

जाता ह।ै 

Booleans दो ओवरलपैिग NURBS सर्फे सों के बीच के इंटरसेक्टिंग वॉल्यूम को संयोजित करने, घटाने और एक्सट्रैक्ट का तरीका प्रदान करता ह।ै 

NURBS सर्फे सों को साथ स्टिच करने से सर्फे स जुड़ जाते हैं, ताकि एक को हिलाने से दूसरा भी हिले। Maya आपको Global Stitch कमांड का इस्तेमाल 

करने या ऑब्ज़ेक्ट्स  को प्वाइंट, एजिज़ द्वारा स्टिच करने की अनुमति देता ह।ै

Modify, Convert मेन्यू का इस्तेमाल कर आप विभिन्न मॉडलिग टाइप्स के बीच रूपांतरण भी कर सकते हैं। यह मेन्यू आपको NURBS, polygons, तथा 

subdivision सर्फे सेज़ के बीच रूपांतरण की अनुमति देता ह।ै

6.1.3.1 NURBS Primitives सीखें

सरलतम NURBS सर्फे सेज़ प्रिमिटिव ऑब्ज़ेक्ट्स  होते हैं, जिन्हें Create, NURBS Primitives मेन्यू के इस्तेमाल से बनाया जा सकता ह।ै NURBS primitives 

में शामिल होते हैं sphere, cube, cylinder, cone, plane, तथा torus (जो एक डफनट के आकार जसैा होता ह)ै, इसे चित्र 2-1 में दिखाया गया ह।ै सलेक्ट 

करने पर प्रिमिटिव ऑब्ज़ेक्ट ग्रिड के ओरिजिन पर दिखाई पड़ता ह।ै 

चित्र 6.1.45: चित्र 2-1
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स्फे यर्स तथा क्यूब्स बनाना

 NURBS स्फेयर  प्रिमिटिव के लिए, आप उस अक्ष का चयन कर सकते हैं जिसके चारों ओर स्फेयर  स्थित होता ह।ै एक पार्शियल स्फेयर  क्रिएट करने के 

लिए आप Sphere Options डायलॉग बॉक्स का इस्तेमाल कर स्टार्ट  तथा एंड स्वीप ऐगंल वलै्यूज बदल सकते हैं, जिसे चित्र 2-2 में दर्शाया गया ह।ै रेडिय स 

वलै्यू स्फेयर  का आकार तथा सेक्शन की संख्या निर्धा रित करता ह ैऔर स्पैन उन आइसोपार्म्स को परिभाषित करता ह ैजिन्हें स्फेयर  में दर्शाया जाता ह।ै 

क्यूब NURBS प्रिमिटिव में समान ओरिएंटेशन अक्ष शामिल होता ह।ै आप क्यूब की चौड़ाई, लंबाई तथा ऊंचाई मानों को विनिर्देशित कर सकते हैं और U 

तथा V पचैेज ऑप्शन आइसोपार्म्स की संख्या सेट करते हैं।

चित्र 6.1.46: चित्र 2-2

Cylinders तथा Cones बनाना 

सिलिडर तथा कोन NURBS प्रिमिटिव्स में पार्शियल ऑब्ज़ेक्ट्स  बनाने के लिए Start तथा End Sweep Angles सेटिग्स शामिल होती हैं। आप रेडिय स तथा 

हाइट वलै्यू भी एंटर कर सकते हैं और किसी ऑब्ज़ेक्ट में टॉप, बॉटम या दोनों पर कैप मौजदू ह,ै कि नहीं। सेक्शन तथा स्पैन की संख्या उन पचैों की संख्या 

निर्धा रित करती ह,ै जो ऑब्ज़ेक्ट का निर्माण करते हैं। 

Plane और Torus बनाना 

Plane NURBS प्रिमिटिव्स के लिए, आप चौड़ाई और लंबाई के वलै्यू सेट कर सकते हैं। Torus NURBS प्रिमिटिव के लिए, आप स्टार्ट  व एंड स्वीप ऐगंल 

वलै्यूज़ और साथ ही रेडिय स और माइनर रेडिय स वलै्यूज सेट कर सकते हैं।

आइसोपार्म्स इंसर्ट करना 

आरंभ में आइसोपार्म्स की संख्या सेग्मेंट्स और स्पैन की संख्या द्वारा सेट किया जाता ह,ै पर आप Surfaces, Insert Isoparms मेन्यू कमांड का इस्तेमाल 

कर एक NURBS प्रिमिटिव में अधिक पचै जोड़ सकते हैं। यदि आप मार्किंग  मेन्यू से आइसोपार्म्स डिस्प्ले मोड का चयन करते हैं, तो आप किसी  

मौजदूा आइसोपार्म  से उस स्थान पर ड्रैग कर सकते हैं, जहाँ आप नए आइसोपार्म  को स्थित करना चाहते हैं। चित्र 2-3 में दिखाए अनुसार इस स्थान को 

पीली डैश्ड लाइन से चिह्नित किया जाता ह।ै यदि आप सक्रिय/इनेबल्ड At Selection विकल्प के साथ Insert Isoparms मेन्यू कमांड लाग ूकरते हैं, तो एक 

नए आइसोपार्म  का निर्माण होता ह।ै Between Selections विकल्प आपको संपरू्ण  ऑब्ज़ेक्ट के लिए U या V दिशा के लिए आइसोपार्म्स बनाने की अनुमति 

देता ह।ै
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चित्र 6.1.47: चित्र 2-3

ट्युटोरियल 1: Primitives से Candle बनाएँ 

1.	 चरण 1: क्विक लेआउट बटन में Four Views बटन पर क्लिक करें ।

2.	 चरण 2: Create, NURBS Primitives, Cylinder मेन्यू कमांड की मदद से सिलिडर का निर्माण करें ।

3.	 चरण 3: स्के ल टूल पर क्लिक करें  और हरे  Y-अक्ष मनैिपुलेटरको ड्रैग कर सिलिडर की ऊंचाई बढ़ाएं। 

4.	 चरण 4: Create, NURBS Primitives, Cylinder मेन्यू कमांड की मदद से एक अन्य सिलिडर ऑब्ज़ेक्ट का निर्माण करें । 

5.	 चरण 5: स्के ल टूल की मदद से टॉप व्यू में सेंटर हैंडल ड्रैग कर सिलिडर के डायमीटर को घटाएँ और फिर सिलिडर को लंबा करने के लिए हरे  Y-अक्ष 

मनैिपुलेटर को ऊपर की ओर ड्रैग करें । मूव टूल का चयन करें  और हरे  Y-अक्ष मनैिपुलेटर को ड्रैग कर छोटे सिलिडर को बड़े सिलिडर के ऊपर मूव 

करें । बड़ा सिलिडर कैं डल के लिए होता ह ैऔर छोट सिलिडर विक के लिए। 

6.	 चरण 6: Create, NURBS Primitives, Cylinder मेन्यू कमांड की मदद से एक अन्य सिलिडर ऑब्ज़ेक्ट का निर्माण करें । 

7.	 चरण 7: स्के ल टूल की मदद से टॉप व्यू में सेंटर हैंडल ड्रैग कर सिलिडर के डायमीटर को बढ़ाएँ और तब सिलिडर की ऊंचाई को कम करने के लिए 

हरे  Y-अक्ष मनैिपुलेटर को नीचे की ओर ड्रैग करें । मूव टूल का चयन करें  और हरे  वाई-अक्ष मनैिपुलेटर को ड्रैग कर बड़े फ्लैट सिलिडर को कैं डल के 

बेस पर मूव करें ।

8.	 चरण 8: Create, NURBS Primitives, Sphere मेन्यू कमांड की मदद से स्फेयर  ऑब्ज़ेक्ट का निर्माण करें ।

9.	 चरण 9: मूव टूल का चयन करें  और स्फेयर  को फ्रं ट व्यू में ऊपर की ओर कैं डल विक के टॉप पर ड्रैग करें ।

10.	 चरण 10: Status Line में Select by Component बटन पर क्लिक करें ।

11.	 चरण 11: फ्रं ट व्यू में सभी टॉप CV प्वाइंट्स पर ड्रैग करें  और हरे  Y-अक्ष मनैिपुलेटर की मदद से इन्हें फ्रं ट व्यू में ऊपर की ओर मूव करें ।

12.	 चरण 12: स्फेयर  पर सबसे टॉप CV प्वाइंट का चयन करें  और उसे फ्रं ट व्यू में ऊपर और बाई ंओर मूव करें  । एडिट किया गया स्फेयर , चित्र 2-4 में 

दिखाए अनुसार एक सरल मोमबत्ती की लौ के सदृश होता ह।ै

13.	 चरण 13: File चुनें, Save Scene As चुनें और फाइल को Primitive candle.mb के रूप में सेव करें ।
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चित्र 6.1.48: चित्र 2-4

ट्युटोरियल 2: आइसोपार्म्स जोड़ें 

1.	 चरण 1: Create, NURBS Primitives, Cone मेन्यू कमांड की मदद से कोन ऑब्ज़ेक्ट का निर्माण करें ।

2.	 चरण 2: कोन ऑब्ज़ेक्ट पर राइट क्लिक करें  और पॉप-अप मार्किंग  मेन्यू से आइसोपार्म्स चुनें।

3.	 चरण 3: फिर बॉटम सर्क ल से ऊपर की ओर कोन की ओर लगभग आधी दूरी तक क्लिक और ड्रैग करें । जहाँ नया आइसोपार्म  स्थिति होता ह ैवहाँ 

पीली डॉटेड लाइन दिखाई पड़ती ह।ै

4.	 चरण 4: Surfaces, Insert Isoparms का चयन करें । ऑब्ज़ेक्ट में एक नया आइसोपार्म  जुड़ जाता ह।ै

5.	 चरण 5: कोन ऑब्ज़ेक्ट पर राइट क्लिक करें  और पॉप-अप मार्किंग  मेन्यू से पुनः आइसोपार्म्स चुनें।

6.	 चरण 6: बॉटम सर्क ल और नए आइसोपार दोनों को सलेक्ट करने के लिए, दोनों पर से ड्रैग करें  । सलेक्ट किये जाने पर आइसोपार्म  पीला हो  

जाता ह।ै

चित्र 6.1.49: चित्र 2-5
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6.1.3.2 NURBS Surfaces को एडिट करना 

NURBS सर्फे स बन जाने पर आप इसके Surface को इसके घटकों को चुन कर और रूपांतरित कर सीधे एडिट कर सकते हैं। ऑब्ज़ेक्ट के CVs को 

रूपांतरित करने से इन प्रिमिटिव्स की मूल आकृति एडिट हो जाती ह।ै किसी ऑब्ज़ेक्ट के CVs को देखने के लिए, Status Line में Select by Component 

Type बटन पर क्लिक करें  (या F8 key दबाएँ); ऑब्ज़ेक्ट पर राइट क्लिक कर और मार्किंग  मेन्यू से कंट्रोल वर्टिसेज का चयन कर प्रिमिटिव के CVs का 

चयन करें । Move, Rotate, तथा Scale tools की मदद से चयनित CVs को रूपांतरित किया जा सकता ह।ै

घटकों का चयन करना

NURBS सर्फे सेज में उतने ही CVs हो सकते हैं, जितने कि NURBS, इसे चित्र 2-6 में दिखाया गया ह,ै इससे बिल्कु ल वही CVs चुनना कठिन हो जाता ह,ै 

जो आप चाहते हैं। इस समस्या से निजात पाने के लिए, आप Selection मेन्यू में से कमांड्स का इस्तेमाल कर सकते हैं। Selection menu में Grow CV 

Selection, Shrink CV Selection, Select CV Selection Boundary, तथा Select Surface Border कमांड शामिल होती हैं। जब आप एडिट करने के लिए 

NURBS surface घटकों का चयन करते हैं, तो ये कमांड वाकई कारगर हो सकती हैं।

ध्यान दें: एक चयनित CV के साथ, एडजेसेंट (बराबर वाला) CV चुनने के लिए आप ऐरो-की का इस्तेमाल कर सकते हैं।

7.	 चरण 7: Surfaces, Insert Isoparms, Options का चयन करें ।

8.	 चरण 8: Between Selections विकल्प चुनें और # Isoparms to Insert value को 5 पर सेट करें । Insert बटन पर क्लिक करें । पाँच नए आइसोपार्म्स 

बनते हैं और दो सलेक्ट किये हुए आइसोपार्म्स के बीच समान दूरी पर स्थित होते हैं, जिसे चित्र 2-5 पर दर्शाया गया ह।ै

9.	 चरण 9: File चुनें, Save Scene As चुनें और फाइल को New isoparms.mb के रूप में सेव करें ।

चित्र 6.1.50: चित्र 2-6

Surface Editing Tool का इस्तेमाल करना

Surfaces, Surface Editing, Surface Editing tool सलेक्ट करके आप सर्फे स के किसी भी बिदु पर क्लिक कर सकते हैं और मनैिपुलेटर्स का एक सेट 

दिखाई देगा (चित्र 2-7 में दिखाए अनुसार) जो सलेक्ट किये गये बिदु को मूव करने की अनुमति देता ह।ै Point Position हैंडल ड्रैग करने से बिदु मूव होता 

ह ैऔर मिड्ल माउस बटन से Slide Along Curve मनैिपुलेटर ड्रैग करने से Point Position हैंडल आइसोपार्म  पर स्लाइड होता ह/ैखिसकता ह।ै Tangent 

Direction पर क्लिक करने से स्विचेज़ U align, V-align, and normal-aligned tangent के बीच टॉगल होता ह।ै Tangent Direction हैंडल को मनैिपुलेट कर 

सर्फे स प्वाइंट के टैंजेंट को भी बदला जा सकता ह।ै डॉटेंड एक्सिस लाइंस पर क्लिक करने से टैंजेंट इस अक्ष पर अलाइन हो जाता ह।ै
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चित्र 6.1.51: चित्र 2-7

Sculpt Geometry Tool का इस्तेमाल करना 

Sculpt Geometry tool सर्फे सेज़ मेन्यू में उपलब्ध होता ह,ै जो आपको सर्फे स CVs को पुश, पुल, 

स्मूथ तथा इरे ज़ करने की अनुमति देता ह।ै चित्र 2-8 में दिखाए अनुसार, Tool Settings डायलॉग 

बॉक्स का इस्तेमाल कर, आप स्कल्प्ट टूल का रेडिय स, ओपेसिटी तथा शेप चुन सकते हैं। चयन 

किए जाने पर, एक लाल मनैिपुलेटर आपको ब्रश रेडिय स का आकार दिखाता ह ैऔर रेडिय ल 

सर्क ल से अलग इंगित करने वाला ऐरो आपको दिखाता ह ै कि ब्रश सर्फे स को कितनी दूर 

खिसकाता ह।ै तब आप किसी वस्तु की सतह को विरूपित या डिफॉर्म  करने के लिए उसकी सतह 

पर पेंट कर सकते हैं

ध्यान दें: b की को होल्ड डाउन कर ड्रैग करने से आप ब्रश रेडिय स को पारस्परिक रूप से बदल 

सकते हैं; आप ब्रश दूरी को भी बदल सकते हैं। 

Surfaces को सरल बनाना चित्र 6.1.52: चित्र 2-8

Surfaces, Rebuild Surfaces मेन्यू कमांड किसी सर्फे स की जटिलता को कम करती ह।ै यह विकल्प कई भिन्न रिबिल्ड विकल्प प्रदान करता ह ैऔर आप 

केवल U या V दिशा रीबिल्ड कर सकते हैं। 

टैंजेंट की ब्रेकिग तथा स्मूदिंग

डिफॉल्ट रूप से, NURBS सर्फे सेज़ अपने सतह पर चिकने होते हैं, क्योंकि सभी CVs के बीच के टैंजेंट प्वाइंट्स अलाइन स्थिति में रहते हैं, पर यदि एक हार्ड  

एज (सख्‍़त किनारा) बनाना चाहते हैं, तो आप Surfaces, Surface Editing, Break Tangents मेन्यू कमांड का इस्तेमाल कर किसी चयनित आइसोपार्म  के 

लिए टैंजेंट को तोड़ सकते हैं। Surfaces, Surface Editing, Smooth Tangents मेन्यू कमांड का इस्तेमाल किसी टूटे आइसोपार्म  को चिकना बनाने में किया 

जा सकता ह।ै

ट्युटोरियल 1: NURBS घटकों को एडिट करें  

1.	 चरण 1: Create, NURBS Primitives, Plane मेन्यू कमांड की मदद से किसी प्लेन ऑब्ज़ेक्ट का निर्माण करें ।

2.	 चरण 2: Status Line में Select by Component Type बटन पर क्लिक करें  (या F8 key बटन दबाएँ)।

3.	 चरण 3: मूव टूल का चयन करें  शिफ्ट की को होल्ड डाउन करें  और प्लेन ऑब्ज़ेक्ट के विपरीत कोनों पर CVs का चयन करें ।
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4.	 चरण 4: तब हरे  Y-अक्ष मनैिपुलेटर की मदद से दो CVs को ऊपर की ओर ड्रैग करें । प्लेन ऑब्ज़ेक्ट की सतह CVs की मूवमेंट का अनुसरण करने 

हेतु मुड़ जाती ह।ै

5.	 चरण 5: शिफ्ट की होल्ड डाउन करें  और फिर अन्य दो विपरीत कोने वाले CVs का चयन करें ।

6.	 चरण 6: हरे  Y-अक्ष मनैिपुलेटर की मदद से इन दो CVs को नीचे की ओर ड्रैग करें ।

7.	 चरण 7: इस सतह को शेड किया हुआ देखने के लिए 5 key दबाएँ जिसे चित्र 2-9 में दिखाया गया ह।ै

8.	 चरण 8: File चुनें, Save Scene As चुनें और फाइल को Bent plane object.mb के रूप में सेव करें ।

चित्र 6.1.53: चित्र 2-9

ट्युटोरियल 2: Surface Editing Tool का इस्तेमाल करें  

1.	 चरण 1: Create, NURBS Primitives, Sphere मेन्यू कमांड की मदद से स्फेयर  ऑब्ज़ेक्ट का निर्माण करें ।

2.	 चरण 2: Quick Layout बटन से Model View पर क्लिक करें  और पॉप-अप मेन्यू से Top View कमांड चुनें।

चित्र 6.1.54: चित्र 2-10
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3.	 चरण 3: Surfaces, Surface Editing, Surface Editing Tool मेन्यू कमांड का चयन करें ।

4.	 चरण 4: स्फेयर  पर बाएँ किनारे  पर क्लिक करें  स्फेयर  को लंबा करने के लिए Point Position हैंडल को बाई ंओर ड्रैग करें ।

5.	 चरण 5: फिर Tangent Distance हैंडल को सलेक्ट करें  और तब तक ड्रैग करें , जब तक कि यह Point Position हैंडल के शीर्ष  पर न स्थित हो जाए।

6.	 चरण 6: स्फेयर  के दाएँ किनारे  के लिए चरण 4 और 5 दोहराएं ।

7.	 चरण 7: Model View बटन पर पुनः क्लिक करें  और Perspective view का चयन करें । फिर शेडेड ऑब्ज़ेक्ट्स  देखने के लिए 5-की दबाएँ। स्फेयर  

ऑब्ज़ेक्ट, चित्र 2-10 में दिखाए अनुसार एक फुटबॉल की तरह दिखाई देगा।

8.	 चरण 8: File चुनें, Save Scene As चुनें और फाइल को Football.mb.के रूप में सेव करें ।

ट्युटोरियल 3: Sculpt Geometry Tool का इस्तेमाल करें  

1.	 चरण 1: Create, NURBS Primitives, Cylinder, Options menu command का चयन कर NURBS Cylinder Options डायलॉग बॉक्स ओपन करें । 

रेडिय स मान 5 पर, हाईट 15 पर, सेक्शन संख्या को 20 पर तथा स्पेन संख्या को 10 पर सेट करें । कैप्स के दोनों विकल्प चुनें और Create बटन पर 

क्लिक करें ।

2.	 चरण 2: चयनित प्लेन ऑब्ज़ेक्ट पर ज़मू इन करने के लिए key दबाएँ।

3.	 चरण 3: Surfaces, Sculpt Geometry Tool मेन्यू कमांड का चयन करें । टूलबॉक्स में टूल पर डबल क्लिक करें  और Tool Settings पनैल से Pull 

विकल्प का चयन करें ।

4.	 चरण 4: ‘B’ key होल्ड डाउन करें  और टूल रेडिय स को लगभग 2.0 पर ड्रैग करें । फिर ‘m’ key होल्ड डाउन करें  और Max Displacement मान को 

लगभग 2.0 पर ड्रैग करें । सिलिडर सर्फे स के ऊपर कर्सर खिसकाने से रेडिय स का आकार दिखाई पड़ता ह ैऔर सतह से इंगित करता ऐरो Max 

Displacement को दर्शाता ह।ै

5.	 चरण 5: स्कल्प्ट कर्सर को सिलिडर के साइड पर ले जाएँ और सर्फे स से एक सेक्शन को दूर खींचने के लिए, कई बार ड्रैग करें । यह खींचा गया 

सेक्शन कैरेक्टर  की नाक होती ह।ै

6.	 चरण 6: व्यू को तबतक घुमाएँ जबतक कि खिचा हुआ एरिया सीधा व्यू के सामने न आ जाए। टूल सेटिग्स पनैल में पुश बटन का चयन करें  और 

खिचे एरिया को नीचे ड्रैग कर एक मँुह बनाएँ।

7.	 चरण 7: ‘b’ key होल्ड डाउन करें  और रेडिय स को लगभग 1.0 पर सेट करें  और फिर आइ सॉकेट (आखों के कोटर) बनाने के लिए नाक वाले एरिया 

के ऊपर दो स्थान ड्रैग करें ।

चित्र 6.1.55: चित्र 2-11
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8.	 चरण 8: Create, NURBS Primitives, Cylinder, Sphere menu command का चयन करें  और sphere को एक आइ सॉकेट में रखें।

9.	 चरण 9: स्फेयर  को अभी भी चयनित रखते हुए, Edit, Duplicate menu command का चयन करें  और डुप्लिकेट स्फेयर  को दूसरे  आइ सॉकेट में रखें। 

सामान्य कैरेक्टर  फेस ऑब्ज़ेक्ट को चित्र 2-11 में दिखाया गया ह।ै 

10.	 चरण 10: File चुनें, Save Scene As चुनें और फाइल को Sculpted face.mb.के रूप में सेव करें । चित्र 2-11 स्कल्पटेड फेस

ट्युटोरियल 4: एक हार्ड  एज बनाएँ 

1.	 चरण 1: Create, NURBS Primitives, Sphere मेन्यू कमांड की मदद से स्फेयर  ऑब्ज़ेक्ट का निर्माण करें । 

2.	 चरण 2: Sphere पर राइट क्लिक करें  और पॉप-अप मार्किंग  मेन्यू से आइसोपार्म  चुनें। 

3.	 चरण 3: लम्बवत् (वर्टिकल) चलते किसी आइसोपार्म  को चुनने के लिए उस पर ड्रैग करें ।

4.	 चरण 4: आइसोपार्मको सलेक्ट किये हुए, Surfaces, Surface Editing, Break Tangent मेन्यू को दो बार चुनें। 

5.	 चरण 5: Sphere पर राइट क्लिक करें  और पॉप-अप मार्किंग  मेन्यू से Control Vertex चुनें।

6.	 चरण 6: सेंटर CV का चयन करें , जो परू्व  में चुने गए आइसोपार्म  पर स्थित होता ह ैऔर उसे स्फेयर  के कें द्र से दूर ड्रैग करें ।

7.	 चरण 7: शेडेड ऑब्ज़ेक्ट को देखने के लिए 5-की दबाएँ। दिए हुए आइसोपार्म  के लिए टैंजेंट टूटने से, ऑब्ज़ेक्ट में अतिरिक्त CVs जोड़ दिए जाते ह,ै 

जिससे चयनित आइसोपार्म  एक हार्ड  एज बन जाता ह।ै

8.	 चरण 8: Create, NURBS Primitives, Sphere menu command का चयन करें  और sphere को किसी एक आँख के रूप में रखें।

9.	 चरण 9: स्फेयर  को अभी भी चयनित रखते हुए, Edit, Duplicate menu command का चयन करें  और डुप्लिकेट स्फेयर  को दूसरी आँख की स्थिति 

में रखें।

10.	 चरण 10: File चुनें, Save Scene As चुनें और फाइल को Bird head.mb के रूप में सेव करें ।  

चित्र 6.1.56: चित्र 2-12
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6.1.3.3 Boolean Tools का इस्तेमाल करें

जब NURBS सतह ओवरलपै/अतिच्छादित होते हैं, तो आप Surfaces, Booleans मेन्यू का इस्तेमाल कर दो ऑब्ज़ेक्ट्स  के बीच जोड़ने, घटाने या इंटरसेक्शन 

का पता लगाने के लिए प्रयोग किये जा सकने वाले तीन टूल्स में से एक का चयन कर सकते हैं। इन तीनों में से कोई एक टूल सलेक्ट किये हुए, आप पहले 

ऑब्ज़ेक्ट या ऑब्ज़ेक्ट्स  को चुनने के लिए क्लिक कर सकते हैं और फिर दूसरे  ऑब्ज़ेक्ट या ऑब्ज़ेक्ट्स  को चुनने से पहले एंटर-की दबाएं । इनमें से हरे क 

टूल के लिए ऑप्शन डायलॉग बॉक्स (चित्र 2-13 में Union टूल के लिए प्रदर्शित) आपको इनपुट डिलीट करने और परूा होने पर टूल से बाहर निकलने की 

अनुमति देता ह।ै

ध्यान दें: Boolean टूल्स एक बार में केवल दो NURBS सर्फे सेज पर काम कर सकता ह।ै

चित्र 6.1.57: चित्र 2-13

Union Tool के साथ सर्फे सेज़ संयोजित करना: जब Union टूल का इस्तेमाल दो ओवलपैिग/ अतिच्छादित सतहों पर किया जाता ह,ै इंटरसेक्टिंग/

प्रतिच छ्ेदी रे खाएँ हट जाती हैं और परिणामी ऑब्ज़ेक्ट एक सिगल ऑब्ज़ेक्ट के रूप में काम करता ह।ै 

Subtract Tool के साथ Surface Parts को हटाना: Subtract टूल दूसरे  चयनित ऑब्ज़ेक्ट के ओवलपैिग/अतिच्छादित हिस्से को पहले चयनित ऑब्ज़ेक्ट 

से हटाता ह।ै जिस क्रम में ऑब्ज़ेक्ट्स  का चयन होता ह ैयह अहम होता ह।ै चयन क्रम को उलटने से नतीजा बदल जाता ह।ै 

Intersect Tool के साथ Surface Intersection बनाना: Intersect Tool दो अतिच्छादित सतहों के प्रतिच छ्ेदी हिस्से को छोड़कर, बाकी सभी कुछ  

हटाता ह।ै 

ट्युटोरियल 1: Boolean Union Surfaces का निर्माण करना 

1.	 चरण 1: File चुनें, सीन ओपन करें  और Boolean.mb. नाम वाली फाइल ओपन करें । 

2.	 चरण 2: Surfaces, Booleans, Union Tool मेन्यू कमांड का चयन करें । 

3.	 चरण 3: फिर स्फेयर  ऑब्ज़ेक्ट का चयन करें  और एंटर-की दबाएँ। 

चित्र 6.1.58: चित्र 2-14



147146

प्रतिभागी पुस्तिका रोटो आर ट्िस्ट

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

4.	 चरण 4: किसी एक सिलिडर ऑब्ज़ेक्ट्स  पर क्लिक करें  और ऑब्ज़ेक्ट्स  को एक साथ यनूियन (संयोजित) करने के लिए फिर से एंटर की दबाएँ।

5.	 चरण 5: अन्य दो सिलिडर के लिए चरण 2-4 दुहराएँ। अंतिम ऑब्ज़ेक्ट को चित्र 2-14 में दिखाया गया ह।ै

6.	 चरण 6: File चुनें, Save Scene As चुनें और फाइल को Boolean union.mb.के रूप में सेव करें ।

ट्युटोरियल 2: Boolean Subtract Surfaces का निर्माण करना 

1.	 चरण 1: File चुनें, सीन ओपन करें  और Boolean.mb. नाम वाली फाइल ओपन करें ।

2.	 चरण 2: Surfaces, Booleans, Subtract Tool मेन्यू कमांड का चयन करें ।

3.	 चरण 3: स्फेयर  ऑब्ज़ेक्ट का चयन करें  और एंटर-की दबाएँ।

4.	 चरण 4: किसी एक सिलिडर ऑब्ज़ेक्ट्स  पर क्लिक करें  और एक ऑब्ज़ेक्ट को दूसरे  से घटाने के लिए फिर से एंटर की दबाएँ।

5.	 चरण 5: अन्य दो सिलिडर के लिए चरण 2-4 दुहराएँ। अंतिम ऑब्ज़ेक्ट को चित्र 2-15 में दिखाया गया ह।ै.

6.	 चरण 6: File चुनें, Save Scene As चुनें और फाइल को Boolean union.mb के रूप में सेव करें ।

चित्र 6.1.59: चित्र 2-15

ट्युटोरियल 3: Boolean Intersect Surfaces का निर्माण करना

1.	 चरण 1: File चुनें, सीन ओपन करें  और Boolean.mb नाम वाली फाइल ओपन करें ।

2.	 चरण 2: Surfaces, Booleans, Intersect Tool मेन्यू कमांड का चयन करें ।

3.	 चरण 3: फिर स्फेयर  ऑब्ज़ेक्ट का चयन करें  और एंटर-की दबाएँ।

4.	 चरण 4: किसी एक सिलिडर ऑब्ज़ेक्ट्स  पर क्लिक करें  और एक ऑब्ज़ेक्ट को दूसरे  से प्रतिच छ्ेद करने के लिए फिर से एंटर की दबाएँ।

5.	 चरण 5: अन्य दो सिलिडर के लिए चरण 2-4 दुहराएँ। अंतिम ऑब्ज़ेक्ट को चित्र 2-16 में दिखाया गया ह।ै.

6.	 चरण 6: File चुनें, Save Scene As चुनें और फाइल को Boolean intersect.mb के रूप में सेव करें ।
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चित्र 6.1.60: चित्र 2-16

6.1.4 Keyframes के साथ एनिमेट करना

सरल 3D एनिमेशन आश्चर्यजनक रूप से आसान होता ह।ै चूंकि Maya, 3D सीन में ऑब्ज़ेक्ट्स  का सही स्थान जानता ह,ै यह किसी ऑब्ज़ेक्ट के लोकेशन 

को तेज़ी से और आसानी से इंटरपोलेट कर सकता ह,ै क्योंकि यह स्पेस में दो भिन्न बिदुओ ंके बीच मूव करता ह।ै स्पेस में इन लोकेशन को कीफ्रे म्स कहा 

जाता ह ैऔर ये किसी ऑब्ज़ेक्ट की गति के साथ इसकी मध्यवर्ती स्थितियों को परिभाषित करते हैं।

 आप किसी ऑब्ज़ेक्ट की स्थिति, घरू्णन, स्के ल तथा किसी भी कीएबल ऑब्ज़ेक्ट ऐट्रिब्यूट के लिए कीफ्रे म्स सेट कर सकते हैं। सभी keys क्रिएट हो जाने 

के बाद, इंटरफेस के सबसे नीचे टाइम स्लाइडर पर दिखाई पड़ती हैं। आप इन keys को अन्य ऑब्ज़ेक्ट्स  पर कॉपी तथा पेस्ट कर सकते हैं और फिर उन्हें 

आवश्यकतानुसार शिफ्ट और स्के ल कर सकते हैं।

 एनिमेशन बन जाने पर, आप इसे Time Slider में टाइम फ्रे म्स में स्क्रोल करके देख सकते हैं। एनिमेशन का एक प्रीव्यू व्यू पनैल में दिखाई पड़ता ह।ै किसी 

एनिमेशन सीक्वेंस की मूविंग में Animation Controls भी उपयोगी होते हैं। यदि व्यू पनैल को पर्याप्त तेज़ी से सीन अपडेट करने में कोई समस्या होती ह ैतो 

आप Playblast फीचर का इस्तेमाल कर किसी बफर को मौजदूा सीन के स्नैपशॉट भेज सकते हैं। 

कई ऐसे फीचर्स हैं जो एनिमेटेड ऑब्ज़ेक्ट्स  को देखने में आसान बनाते हैं। इन फीचर्स में मोशन ट्रेल्स शामिल हैं, जो ऑब्ज़ेक्ट की मोशन की ट्रैजेक्टरी 

प्रदर्शित करता ह ैऔर ghosting अपनी गति में आगे बढ़ते हुए एनिमेटेड ऑब्ज़ेक्ट की प्रतियों को प्रदर्शित करता ह।ै 

कीफ्रेमि ग के अलावा ऑब्ज़ेक्ट्स  एनिमेट करने का एक अन्य तरीका ह ैकिसी ऑब्ज़ेक्ट को मोशन पाथ से जोड़ना ह।ै वह ऑब्ज़ेक्ट फिर पाथ का पालन 

करता ह।ै इससे एक कर्व खींचना आसान हो जाता ह,ै जो सटीक रूप से बताता ह ैकि ऑब्ज़ेक्ट कहां मूव करता ह।ै 

आप Graph Editor में भी एनिमेटेड सींस को एडिट कर सकते हैं, जहां सभी ऑब्ज़ेक्ट मोशन तथा ऐट्रिब्यूट बदलाव ग्राफ्ड कर्व के रूप में प्रदर्शित होते हैं 

और सभी keys प्वाइंट होते हैं। आप इन कर्व्स तथा प्वाइंट्स को उनकी स्मूथनेस बदलकर और उनके टैंजेंट्स के साथ काम करके एडिट कर सकते हैं।

6.1.4.1 कीफ्रे म्स सेट करें

आप किसी ऑब्ज़ेक्ट को उसकी आरंभ अवस्था में लाकर और एक key सेट कर और फिर उसे उसकी अंतिम अवस्था में लाकर और एक अन्य key सेट कर, 

keys के प्रयोग एनिमेट कर सकते हैं। Maya तब दो keys के बीच हमेशा इन्हीं दो अवस्थाओ ंके बीच इंटरपोलेट करता ह।ै Keys आपको सुव्यवस्थित keys 

की सीमित संख्या के साथ काफी जटिल एनिमेशन सीक्वेंस बनाने में सक्षम बनाता ह।ै
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ध्यान दें: सभी एनिमेशन मेन्यू कमांड्स Animation Menu Set में पाए जाते हैं।

सेटिंग कीज़ 

जब कोई ऑब्ज़ेक्ट सटीक स्थिति में होता ह,ै तो आप Animate, Set Key मेन्यू कमांड का इस्तेमाल कर वर्तमान समय के लिए एक key को सेट कर सकते 

हैं। आप Attribute Editor या Channel Box में किसी ऐट्रिब्यूट पर राइट-क्लिक करके और पॉप-अप मेन्यू से Key Selected या Key All का चयन करके भी 

keys सेट कर सकते हैं। ऐसे ऐट्रिब्यूट्स जिनके keys सेट होते हैं, वे Attribute Editor तथा Channel Box में हल्के  भरूे  रंग में शेडेड रहते हैं, इसे चित्र 3-1 में 

दिखाया गया ह।ै सेटिग-कीज़ के लिए Tip The S key हॉट-की होती ह।ै

चित्र 6.1.61: चित्र 3-1

Auto Key का इस्तेमाल करना 

आप ऐसे ऐट्रिब्यूट्स के लिए स्वचालित रूप से keys बनाने के लिए Auto Key मोड का इस्तेमाल कर सकते हैं, जिनकी पहले से 

कम से कम एक key ह।ै Auto Key toggle को सक्षम करने के लिए, जिसे चित्र 3-2 में दिखाया गया ह,ै Range Slider के दाएँ सिर 

पर Auto Key बटन पर क्लिक करें । एक्टिव/सक्रिय होने पर बटन लाल हो जाता ह।ै जब Auto Key एक्टिव हो जाये, तो आप कोई 

नया टाइम चुन सकते हैं या किसी ऐट्रिब्यूट को अपडेट कर सकते हैं और Set Keys मेन्यू कमांड के इस्तेमाल के बिना ही key 

अपने आप बन जाती ह।ै 
चित्र 6.1.62: चित्र 3-2

ध्यान दें:  Auto Key को इनेबल करने/सक्षम बनाने से पहले आपको चयनित ऑब्ज़ेक्ट के लिए कीफ्रे म बनाने की ज़रूरत होगी, अन्यथा यह काम नहीं 

करेग ा।   

Keys का चयन करना 

चयनित ऑब्ज़ेक्ट के लिए Keys, Time Slider में पतली लाल रे खाओ ंके रूप में प्रकट होते हैं। यदि आप Time Slider में इन लाल रे खाओ ंपर क्लिक करते 

हैं, वर्तमान टाइम उस समय पर मूव हो जाता ह ैऔर key सलेक्ट हो जाती ह।ै चयनित keys नीले रंग की दिखाई पड़ती हैं, इसे चित्र 3.3 में दर्शाया गया ह।ै 
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यदि आप Shift key होल्ड डाउन करते हैं और कई keys पर ड्रैग करते हैं, तो चयनित टाइम लाल हो जाता ह ैऔर उस सेग्मेंट के भीतर सभी keys सलेक्ट 
हो जाती ह,ै जसैा चित्र 3-4 में दर्शाया गया ह।ै आप चयनित एरिया के भीतर या उसके दोनों सिरे  पर स्थित ऐरो को ड्रैग करके चयनित टाइम को शिफ्ट या 
स्के ल कर सकते हैं। 

ध्यान दें: Preference डायलॉग बॉक्स के Timeline पनैल में Key Tick Size सेटिग का इस्तेमाल कर, आप Time Slider में प्रदर्शित keys की मोटाई/
थिकनेस को बढ़ा सकते हैं। आप Colors डायलॉग बॉक्स के एनिमेशन पनैल में key कलर भी बदल सकते हैं, Window, Settings/Preferences, Preferences, 
Colors मेन्यू कमांड के साथ ओपन करें ।

चित्र 6.1.63: चित्र 3-4

Keys को कॉपी करना 

आप Keys Clipboard की मदद से फाइलों के बीच चयनित ऑब्ज़ेक्ट के लिए Keys के सेट को कॉपी और पेस्ट कर सकते हैं। keys को Clipboard पर कॉपी 

करने के लिए, Edit, Keys, Cut Keys या Edit, Keys, Copy Keys मेन्यू कमांड चुनें। वर्तमान सीन बंद करने और एक नए सीन खोलने पर Keys, 

Clipboard पर ही बने रहते हैं। आप Edit, Keys, Paste Keys मेन्यू कमांड का प्रयोग कर चयनित ऑब्ज़ेक्ट पर keys पेस्ट कर सकते हैं। 

Keys डिलीट करना 

Edit, Keys, Delete Keys मेन्यू कमांड चयनित ऑब्ज़ेक्ट के लिए सभी Keys डिलीट करता ह।ै अचयनित ऑब्ज़ेक्ट के लिए सेट की गई Keys सेट यूं ही 

बनी रहती हैं। 

Keys स्नैपिग करना 

Edit, Keys, Snap Keys मेन्यू कमांड सभी चयनित keys को उनके 

निकटवर्ती मान या टाइम पर स्नैप करता ह।ै कई सलेक्टेड keys की 

स्केलि ग के बाद यह खासतौर से उपयोगी होता ह।ै चित्र 3-5 में दिखाए 

अनुसार, Snap Keys Options डायलॉग बॉक्स से आप केवल चयनित 

Keys या सभी Keys को स्नैप कर सकते हैं। आप केवल Times, Values 

या दोनों को स्नैप करने का भी विकल्प चुन सकते हैं।

चित्र 6.1.64: चित्र 3-5
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ट्युटोरियल 1: Keys सेट करें  

1.	 चरण 1: Create, NURBS Primitives, Sphere मेन्यू कमांड की मदद से एक NURBS स्फेयर  ऑब्ज़ेक्ट का निर्माण करें ।

2.	 चरण 2: फ्रे म 1 में Time Slider के साथ, एनिमेट, Set Key मेन्यू कमांड का चयन करें । Channel Box में सभी ट्रांसफ्रॉर्म  ऐट्रिब्यूट्स हल्के  भरूे  रंग में 

दिखाई पड़ते हैं, जो दिखाता ह ैकि उनके साथ keys जुड़े हुए हैं।

3.	 चरण 3: टाइम स्लाइडर में टाइम को फ्रे म 25 पर ड्रैग करें । ध्यान दें कि यदि फ्रे म 25 न दिखाई पड़े, तो उसके दिखाई पड़ने तक Range Slider के दाएँ 

सिरे  को ड्रैग करें । यदि Range फ्रे म 50 पर नहीं पहंुचता ह,ै तो Range Slider की दाई ंओर स्थित टेक्स्ट फील्ड में 50 एंटर करें ।

4.	 चरण 4: Channel Box में ScaleX, ScaleY, तथा ScaleZ ऐट्रिब्यूट्स को 5.0. में बदलें।

5.	 चरण 5: फिर से एनिमेट, Set Key मेन्यू कमांड का चयन करें ।

6.	 चरण 6: टाइम स्लाइडर में टाइम को फ्रे म 50 पर ड्रैग करें ।

7.	 चरण 7: Channel Box में ScaleX, ScaleY, तथा ScaleZ एट्रिब्यूट्स को वापस 1.0. पर ले आएं।

8.	 चरण 8: फिर से एनिमेट, Set Key मेन्यू कमांड का चयन करें ।

9.	 चरण 9: Time Slider मार्कर  आगे-पीछे  ड्रैग करें । Time Slider ड्रैग करने से स्फेयर  बढ़ता या घटता ह।ै

10.	 चरण 10: File चुनें, Save Scene As चुनें और फाइल को Growing sphere.mb. के रूप में सेव करें ।

ट्युटोरियल 2: Auto Key को इस्तेमाल करें  

1.	 चरण 1: Create, NURBS Primitives, Sphere मेन्यू कमांड की मदद से एक NURBS स्फेयर  ऑब्ज़ेक्ट का निर्माण करें

2.	 चरण 2: Time Slider फ्रे म 1 पर होने की स्थिति में, Channel Box में makeNurbsSphere1 इनपुट नोड पर क्लिक करें , Start Sweep ऐट्रिब्यूट पर 

क्लिक करें  और फिर राइट-क्लिक करें  और पॉप-अप मेन्यू से Key Selected चुनें। 

3.	 चरण 3: इंटरफेस के नीचे दाएं किनारे  पर Auto Key बटन पर क्लिक करें । 

4.	 चरण 4: टाइम स्लाइडर में टाइम को फ्रे म 25 पर ड्रैग करें । 

5.	 चरण 5: Start Sweep वलै्यू को 180 कर दें। 

6.	 चरण 6: टाइम स्लाइडर में टाइम को फ्रे म 50 पर ड्रैग करें । 

7.	 चरण 7: Start Sweep वलै्यू को 359 कर दें। 

8.	 चरण 8: Time Slider मार्कर  आगे-पीछे  ड्रैग करें । चित्र 3-6 में 

दिखाए अनुसार Time Slider ड्रैग करने से स्फेयर  धीरे  से गायब हो 

जाता ह।ै

9.	 चरण 9: File चुनें, Save Scene As चुनें और फाइल को Sweeping 

sphere.mb. के रूप में सेव करें । 

चित्र 6.1.65: चित्र 3-6
ट्युटोरियल 3: Move कीज़ 

1.	 चरण 1: Create, NURBS Primitives, Sphere मेन्यू कमांड की मदद से NURBS स्फेयर  ऑब्ज़ेक्ट बनाएँ और फिर कोई NURBS प्लेन ऑब्ज़ेक्ट्स  

बनाएं और प्लेन ऑब्ज़ेक्ट को स्फेयर  से बड़ा बनाने के लिए स्के ल करें ।

2.	 चरण 2: स्फेयर  चुनें और Status Line में Select by Component Type बटन पर क्लिक करें । 

3.	 चरण 3: उन सभी CV को ड्रैग करें , जो उन्हें चुनने के लिए स्फेयर  के फ्रं ट व्यू में निचले हिस्से को बनाते हों।
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4.	 चरण 4: एनिमेट, Set Key मेन्यू कमांड का चयन करें ।

5.	 चरण 5: टाइम स्लाइडर में टाइम को फ्रे म 3 पर ड्रैग करें । 

6.	 चरण 6: Side व्यू में CVs को ऊपर की ओर ड्रैग करें  तथा एनिमेट, Set Key मेन्यू कमांड का फिर से चयन करें । यह उदाहरण दर्शाता ह ै कि 

कम्पोनेंट्स और साथ ही ऑब्ज़ेक्ट्स  को एनिमेट किया जा सकता ह।ै CVs के निचले हिस्से को ऊपर की ओर ड्रैग कर, स्फेयर  को तीन फ्रे म पर 

सिकोड़ा जा रहा ह।ै

7.	 चरण 7: Status Line में Select by Object Type बटन पर क्लिक करें । 

8.	 चरण 8: स्फेयर  का चयन करें  तथा Front व्यू में इसे ऊपर की ओर ले जाएँ और एनिमेट, Set Key मेन्यू कमांड का चयन करें । 

9.	 चरण 9: Time Slider को फ्रे म 10 पर ड्रैग करें , स्फेयर  को पुनः प्लेन ऑब्ज़ेक्ट पर ले जाएँ और एनिमेट, Set Key मेन्यू कमांड का फिर से चयन करें  

(या हॉटकी दबाएँ)। स्फेयर  अब प्लेन ऑब्ज़ेक्ट पर दिखाई पड़ रहा ह।ै 

10.	 चरण 10: Status Line में पुनः Select by Component Type बटन पर क्लिक करें । 

11.	 चरण 11: उन्हीं CVs का चयन करें  जिनका चयन पहले किया गया था और Shift key होल्ड डाउन कर Time Slider में सेट keys पर ड्रैग करें । 

12.	 चरण 12: पहली Key के फ्रे म 7 पर होने तक चयनित Keys को दाई ंओर ड्रैग करें । Shift key को होल्ड डाउन करते हुए Set Keys पर ड्रैग करने से 

चयनित Keys लाल हो उठते हैं तथा कुछ ब्लैक ऐरोज़ डिस्प्ले होते हैं, जिनका इस्तेमाल आप चयनित Keys को मूव या स्के ल करने में कर सकते हैं। 

13.	 चरण 13: Time Slider मार्कर  आगे-पीछे  ड्रैग करें । स्फेयर  बेस प्लेन पर गिरता ह ैजहाँ यह प्लेन ऑब्ज़ेक्ट्स  के साथ टकराने से सिकुड़ जाता ह,ै इसे 

चित्र 3-7 में दिखाया गया ह,ै File चुनें, Save Scene As चुनें और फाइल को Falling sphere.mb के रूप में सेव करें ।

चित्र 6.1.66: चित्र 3-7
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6.1.4.2 एनिमेशन दखेें 

केवल यह पता लगाने के लिए कि आपने कोई गलती की ह,ै आप फाइनल एनिमेशन पेश करने में काफी सारा समय लगा देते हैं, तो यह बरबाद करते हों, 

तो यह काफी और निराशापरू्ण  हो सकता ह।ै एनिमेशन प्रीव्यू करने से गलतियों को पहले ही दूर करने में मदद मिल सकती ह।ै 

एनिमेशन प्रीव्यू करना

इंटरफेस के बॉटम में एनिमेशन कंट्रोल्स में Play Forward बटन पर क्लिक कर (चित्र 3-8 में प्रदर्शित) एक्टिव व्यू 

पनैल में फ्रे म्स के ज़रिये एनिमेशन प्रीव्यू करना। आप एनिमेशन को उल्टे क्रम/रिवर्स में देखने के लिए Play 

Backwards बटन पर भी क्लिक कर सकते हैं। यदि आप Time Slider हैंडल चुनते और ड्रैग करते हैं, तो विभिन्न 

फ्रे म्स के बीच ड्रैग करने से व्यू पनैल अपडेट हो जाता ह।ै

चित्र 6.1.67: चित्र 3-8एनिमेशन की लूपिग

यदि आप Animation Preferences बटन पर क्लिक करते हैं, Auto Key बटन से अगला, Preferences डायलॉग बॉक्स का Timeline पनैल दिखाई देता ह,ै 

इसे चित्र 3-9 में दिखाया गया ह।ै इस डायलॉग बॉक्स में आप फ्रे मों की वह संख्या सेट करते हैं जो Time Slider में दिखती ह।ै Preferences डायलॉग बॉक्स 

में तीन Looping ऑप्शंस भी शामिल होते हैं —Once, Oscillate, तथा Continuous Play Forward बटन क्लिक करने पर Once विकल्प एनिमेशन को एक 

बार चलाता ह।ै Oscillate एनिमेशन को बार-बार आगे बढ़ाता और पीछे  लाता ह ैऔर Continuous एनिमेशन को बार-बार आगे चलाता ह।ै 

ध्यान दें: आप Time Slider या Animation Controls पर राइट क्लिक कर किसी पॉप-अप मेन्यू से भी लपूिग विकल्प एक्सेस कर सकते हैं।

चित्र 6.1.68: चित्र 3-9



155154

प्रतिभागी पुस्तिका

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

Ghosting इनेबल करें  

Ghosting एक एनिमेशन तकनीक ह,ै जिसमें आप पिछले तथा/या आने वाले फ्रे म्स में किसी ऑब्ज़ेक्ट की पोजिशन देखते हैं, इसे स्फेयर  के संदर्भ में 3-10 

में दिखाया गया ह।ै यह किसी ऑब्ज़ेक्ट के मोशन के टाइमिग पर काम करते समय मददगार साबित होता ह।ै Ghosting को सक्षम बनाने के लिए, 

Visualize, Ghost Selected मेन्यू कमांड का चयन करें । चित्र 3-11 में दिखाए अनुसार, Ghost Options डायलॉग बॉक्स में आप सटीक रूप से चुन सकते 

हैं, कि कौन से फ्रे म घोस्टेड हैं या वर्तमान फ्रे म कितने फ्रे म पहले और कितने फ्रे म बाद दिखाया गया ह।ै घोस्टिंग डिसेबल/अक्षम करने के लिए, Visualize, 

Unghost Selected या Animate, Unghost All मेन्यू कमांड्स का इस्तेमाल करें । 

सभी मेन्यू कमांड्स।

चित्र 6.1.69: चित्र 3-10

चित्र 6.1.70: चित्र 3-11
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Motion Trails बनाना

चित्र 3-12 में दर्शाए अनुसार, Motion Trails वह ट्रैजेक्टरी पाथ होता ह ैजिस पर कोई एनिमेटेड ऑब्ज़ेक्ट फ्रे म्स के बीच मूव करते हुए चलता ह।ै मोशन ट्रेल 

बनाने के लिए Visualize, Create Editable Motion Trail मेन्यू कमांड बनाएँ। Motion Trail Options डायलॉक्स बॉक्स में आप मोशन ट्रेल के लिए आरंभ 

व अंत समय सेट कर सकते हैं और Line, Locator, या Points के लिए Draw Style विकल्प। आप Show Frame Numbers को सलेक्ट और डिसलेक्ट भी 

कर सकते हैं।

चित्र 6.1.71: चित्र 3-12

Playblast का इस्तेमाल करना 

Window, Playblast मेन्यू कमांड हरे क फ्रे म के लिए एक्टिव व्यू पनैल का एक स्क्रीनशॉट कैप्चर करता ह।ै एक प्रीव्यू एनिमेशन क्रिएट करने के लिए ये 

फ्रे म्स फिर एक साथ स्टिच कर दिये जाते हैं, जो डिफॉल्ट सिस्टम मूवी प्लेयर में प्ले की जाती ह।ै Playblast का इस्तेमाल करना सुविधाजनक होता ह,ै 

क्योंकि जटिल सीन को व्यू पनैल में अपने व्यू को अपडेट करने में कुछ समय लगता ह।ै चित्र 3-13 में दिखाए अनुसार, Playblast Options डायलॉग बॉक्स 

का इस्तेमाल करने से, आप Time Range, Viewer, तथा Display Size ऑप्शंस चुन सकते हैं। आप केवल प्रीव्यू को एक फाइल में सेव करने का भी विकल्प 

चुन सकते हैं।

चित्र 6.1.72: चित्र 3-13
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ट्युटोरियल 1: एनिमेशन प्रीव्यू करना

1.	 चरण 1: File चुनें, Open Scene मेन्यू कमांड चुनें और Simple airplane.mb फाइल को लोकेट करें ।

2.	 चरण 2: टाइम स्लाइडर को फ्रे म 10 पर ड्रैग करें ।

3.	 चरण 3: एयरप्लेन चयनित करने के साथ, Animate, Ghost Selected, Options मेन्यू कमांड का चयन करें । 

4.	 चरण 4: Ghost Options डायलॉग बॉक्स में, Type of Ghosting list से Custom Frame Steps चुनें। स्टेप साइज़ को 3 करें  और Ghost बटन पर  

क्लिक करें ।

5.	 चरण 5: Animation Controls में Play Forward बटन दबाएँ। चित्र 3-14 में दिखाए अनुसार, घोस्टिंग के साथ एनिमेशन लपू्स बार-बार सक्षम  

होता ह।ै 

6.	 चरण 6: File चुनें, Save Scene As चुनें और फाइल को Airplane with ghost.mb के रूप में सेव करें । 

चित्र 6.1.73: चित्र 3-14

ट्युटोरियल 2: Playblast का इस्तेमाल करें  

1.	 चरण 1: File चुनें, Open Scene मेन्यू कमांड चुनें और Simple airplane.mb फाइल को लोकेट करें  

और खोलें।

2.	 चरण 2: Window, Playblast मेन्यू कमांड चुनें। एनिमेशन का हरे क फ्रे म Playblast buffer में कैप्चर 

होता ह ै और एनिमेटेड फ्रे म्स को डिफॉल्ट सिस्टम वीडियो प्लेयर में, जसेै कि Windows Media 

Player में प्रदर्शित किया जाता ह,ै जिसे चित्र 3-15 में दिखाया गया ह।ै

चित्र 6.1.74: चित्र 3-15
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6.1.4.3 Motion Paths की मदद से एनिमेट करें

Key framing के साथ काम करना आसान होता ह,ै पर कभी-कभी कोई पाथ परिभाषित करना और उस पाथ को किसी ऑब्ज़ेक्ट को उस पाथ पर चलाना 

ज़्यादा आसान हो सकता ह।ै मोशन पाथ्स कर्व होते हैं जिनसे आप यह परिभाषित कर सकते हैं, कि किसी ऑब्ज़ेक्ट को सीन में कैसे मूव करना ह।ै

Motion Path Keys बनाना 

आप सीन के पास ऑब्ज़ेक्ट ड्रैग करके और Animate, Motion Paths, Set Motion Path Key मेन्यू कमांड का इस्तेमाल करके एक मोशन पाथ बना सकते 

हैं। यह कमांड मौजदूा टाइम फ्रे म के लिए चयनित ऑब्ज़ेक्ट हेतु मोशन पाथ key रख देती ह।ै ऑब्ज़ेक्ट को किसी अन्य लोकेशन पर ले जाने और इस 

कमांड का फिर से इस्तेमाल करने से एक और key का निर्माण होता ह ैऔर key को जोड़ने वाला कर्व खींचा जाता ह।ै हरे क मोशन पाथ key कर्व पर एक 

प्वाइंट के रूप में काम करती ह।ै चित्र 3-16 में कई मोशन पाथ keys के साथ एक स्फेयर  मोशन पाथ पर चलता हुआ दिखाया गया ह।ै

चित्र 6.1.75: चित्र 3-16

Motion ड्रॉ करना 

आप किसी NURBS कर्व का इस्तेमाल एक मोशन पाथ के रूप में कर सकते हैं। डिफॉल्ट रूप से, NURBS कर्व पर पहला बिदु संलग्न ऑब्ज़ेक्ट के लिए 

आरंभ प्वाइंट चिह्नित करता ह।ै आप Create मेन्यू में पाये गये किसी कर्व क्रिएशन टूल का इस्तेमाल करके मोशन पाथ बना सकते हैं, जिसमें CV Curve 

tool, EP Curve tool, तथा Pencil Curve tool शामिल होते हैं। 

किसी Motion Path से ऑब्ज़ेक्ट अटचै/ संलग्न करना 

किसी मोशन पाथ से कोई ऑब्ज़ेक्ट जोड़ने के लिए, आपको पहले वे ऑब्ज़ेक्ट या ऑब्ज़ेक्ट्स सलेक्ट करने होंगे, जो अटचै करने ह ैऔर फिर उस NURBS 

पाथ का चयन करना होगा जिसका इस्तेमाल आप मोशन पाथ के लिए करना चाहते हैं। मोशन पाथ कर्व हमेशा आखिरी में सलेक्ट करना चाहिये। अंतिम 

चयन होना चाहिए। Animate, Motion Paths, Attach to Motion Path मेन्यू कमांड का चयन करें । चित्र 3-17 में एक NURBS स्फेयर  दिखाया गया ह,ै जिसे 

मोशन पाथ से जोड़ा गया ह।ै Play Forward बटन पर क्लिक करने से दिखता ह,ै कि कैसे वह स्फेयर  उस परूे  मोशन पाथ पर चल रहा ह।ै
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चित्र 6.1.76: चित्र 3-17

अटचै्ड Motion Path को एडजस्ट करना 

जब कोई वस्तु किसी मोशन पाथ से अटचै की जाती ह,ै तो आप Time Slider ड्रैग करके मोशन पाथ पर उस ऑब्ज़ेक्ट को मूव करा सकते हैं। अटचै्ड मोशन 

पाथ एडजस्ट करने के लिए, आप Move tool के साथ अटचै्ड ऑब्ज़ेक्ट को मूव करा सकते हैं और Animate, Motion Paths, Set Motion Path Key मेन्यू 

कमांड की मदद से एक नया मोशन पाथ बना सकते हैं। चित्र 3-18 एक मौज़ूदा अटचै्ड पाथ में की गई एडजस्टमेंट को दर्शाता ह।ै

चित्र 6.1.77: चित्र 3-18
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Motion Path पर चलत ेहुए किसी ऑब्ज़ेक्ट की डिफॉर्मिंग 

जब कोई वस्तु किसी मोशन पाथ का अनुसरण करती ह,ै तो आप ऑब्ज़ेक्ट का चयन कर सकते हैं और Constrain, Motion Paths, Flow Path Object मेन्यू 

कमांड का चयन कर सकते हैं। यह कमांड चयनित ऑब्ज़ेक्ट के चारों ओर एक लटैिस प्रकट करता ह।ै मोशन पाथ पर बढ़ने पर यह लटैिस विरूपित हो 

जाता ह।ै इस लटैिस को ऑल्टर करके, इस बात पर नियत्रण रख सकते हैं, कि मोशन पाथ का अनुसरण करते हुए ऑब्ज़ेक्ट डिफॉर्म  कैसे होगा। चित्र 3-19 

में एक टोरस ऑब्ज़ेक्ट दिखाई पड़ता ह,ै जो अपने चारों ओर स्थित लटैिस के साथ मोशन पाथ का अनुसरण करता ह।ै

चित्र 6.1.78: चित्र 3-19

ट्युटोरियल 1: Motion Path बनाना 

1.	 चरण 1: Create, NURBS Primitives, Cone मेन्यू कमांड की मदद से NURBS कोन ऑब्ज़ेक्ट का निर्माण करें । 

2.	 चरण 2: Animate, Motion Paths, Set Motion Path Key मेन्यू कमांड का चयन करें । 

चित्र 6.1.79: चित्र 3-20
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3.	 चरण 3: Time Slider को फ्रे म 5 पर ड्रैग करें  और कोन को उसकी मौजदूा स्थिति से दूर ड्रैग करें । 

4.	 चरण 4: Constrain, Motion Paths, Set Motion Path Key मेन्यू कमांड का फिर से चयन करें ।

5.	 चरण 5: चरण 3 और 4 को कई और बार दुहराएँ। प्रत्येक की मोशन पाथ के लिए एक कर्व प्वॉइंट की तरह काम करती ह।ै

6.	 चरण 6: Play Forward बटन दबाएँ। कोन ऑब्ज़ेक्ट्स  मोशन पाथ कर्व का अनुसरण करता ह,ै जसैा कि चित्र 3.20 में दिखाया गया ह।ै

7.	 चरण 7: File चुनें, Save Scene As चुनें और फाइल को path.mb के रूप में सेव करें ।

डिफॉल्ट पर्सपेक्टिव व्यू पनैल के अन्य अवयव:

•	 पनैल पर नीचे persp लिखा होता ह ैजो दर्शाता ह ैकि आप पर्सपेक्टिव कैमरा व्यू से Maya 

सीन देख रहे हैं।

•	 पनैल के ऊपरी बाएँ कोने पर पनैल का अपना मनै्यू बार होता ह।ै ये मेन्यू आपको उस 

विशिष्ट पनैल से संबंधित टूल और फंक्शन के एक्सेस देते हैं।

•	 दो मोटी रे खाओ ंके साथ ग्रिड डिस्प्ले होता ह,ै जो माया सीन के कें द्र में एक-दूसरे  को 

काटती हैं। सेंट्रल लोकेशन ओरिजिन कहलाती ह।ै ओरिजिन Maya की 3D दुनिया का 

कें द्र होता ह ैऔर सभी वस्तु के दिशात्मक मानों की माप इसी स्थान से की जाती ह।ै

Maya में, अन्य कई 3D एप्लिकेशनों की तरह ही, तीनों आयामों को X, Y और Z अक्षों के रूप 

चित्र 6.1.80: पर्सपेक्टिव व्यू

में दिखाया जाता ह।ै ओरिजिन 0, 0, 0 की X, Y, Z पोजिशन पर स्थित होता ह।ै ग्रिड भी X, Z प्लेन पर स्थित होती ह।ै हम इसे प्लेन कहते हैं क्योंकि आप 

इस 3D पोजिशन के अनुदिश स्थित एक काल्पनिक, समतल, द्वि-आयामी वर्ग देख सकते हैं।

Maya X, Y और Z अक्षों को एक कलर स्कीम में प्रदर्शित करता ह:ै X के लिए लाल, Y के लिए हरा और Z के लिए नीला। Maya इस कलर स्कीम का 

इस्तेमाल यह दर्शाने में करता ह ैकि आप उस विशेष आइटम को एक्सेस कर रहे हैं जो कुछ हद तक X, Y और Z से संबंधित ह।ै

चित्र 6.1.81: 3D व्यू

मेन मेन्यू बार

Maya में मनै्यू , मनै्यू सेट में समूहित होते हैं। इन मेन्यू सेट का प्रयोग मेन मेन्यू बार से किया जाता है

मेन मेन्यू बार Maya टाइटल बार के नीचे सीधे Maya इंटरफेस के ऊपर प्रदर्शित होता ह ैऔर चयनित मेन्यू सेट 

प्रदर्शित करता ह।ै प्रत्येक मेन्यू सेट Maya के अंदर एक मॉड्यलू से संबंधित होता ह:ै Animation, Polygons, 

Surfaces, Rendering और Dynamics मॉड्यलू्स संबंधित विशेषताओ ं और टूल्स को समूहित करने की एक 

विधि ह।ै 

चित्र 6.1.82: मुख्य सलेक्टर

ज्योंही अप मेन्यू सेट के बीच स्विच करते हैं, मेन्यू का दायाँ भाग बदल जाता ह,ै लेकिन बायाँ भाग यूं ही बना रहता ह;ै बायाँ मेन्यू सभी मेन्यू सेट के लिए 

समान होते हैं। बाई ंओर के मेन्यू में File, Edit, Modify, Create, Display, तथा Window, होते हैं।
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चित्र 6.1.83: मेन्यू

विशिष्ट मेन्यू सेट सलके्ट करने के लिए

•	 Status line पर, ड्रॉप-डाउन मेन्यू से Animation सलेक्ट करें । Main Menu, Animation मॉड्यलू से जुड़े  मेन्यू प्रदर्शित करने के लिए बदल जाता ह।ै 

विशेष रूप से, मेन्यू टाइटल जसेै Animate, Deform, Skeleton, Skin इत्यादि प्रदर्शित होते हैं।

•	 मेन्यू सलेक्टर की मदद से, ड्रॉप-डाउन सचूी से Polygons चुनें। Main Menu, Polygons के लिए मेन्यू सेट दर्शाने के लिए बदल जाता ह।ै मेन्यू टाइटल 

जसेै Select, Mesh, Edit Mesh इत्यादि प्रदर्शित होते हैं।

Polygons मेन्यू सेट से प्रिमिटिव 3D ऑब्जेट बनाने के लिए

चित्र 6.1.84: प्रिमिटिव 3D ऑब्ज़ेक्ट 

•	 Create > Polygon Primitives > Interactive Creation सलेक्ट करें  और सुनिश्चित करें  कि इस आइटम 

के बगल में चेकमार्क  प्रदर्शित नहीं ह।ै

•	 Main Menu बार से, Create > Polygon Primitives > Cube सलेक्ट करें । Maya 3D क्यूब प्रिमिटिव 

ऑब्ज़ेक्ट का निर्माण करता ह ैऔर इसे Maya वर्क प्लेस के सेंटर (ओरिजिन) में रखता ह।ै

Status Line

Status Line में, जो Main Menu बार के ठीक नीचे स्थित होता ह,ै अनेक प्रकार के आइटम होते हैं, जिनमें से अधिकांश का इस्तेमाल Maya में मॉडेलिग या 

ऑब्ज़ेक्ट्स  के साथ काम करने के दौरान किया जाता ह।ै अधिकांश Status Line आइटम ग्राफिकल आइकन द्वारा निरूपित होते हैं। आइकन Maya 

इंटरफेस में स्थान की बचत करते हैं और ज़्यादा इस्तेमाल होने वाले टूल्स के लिए त्वरित एक्सेस की सुविधा देते हैं।

चित्र 6.1.85: Status line

•	 Status line पर पहला आइटम: मेन्यू सेट के बीच चुनने के लिए Menu Selector का इस्तेमाल किया जाता ह।ै

•	 सर्क ल किए हुए आइकन का दूसरा समूह दृश्य को निरूपित करता ह ैऔर इसका इस्तेमाल आपके Maya दृश्यों का निर्माण करने, खोलने और सेव 

करने में किया जाता ह।ै

•	 बटनों के तीसरे  और चौथे समूह का उपयोग यह नियत्रित करने के लिए किया जाता ह ैकि आप किस प्रकार ऑब्ज़ेक्ट और ऑब्ज़ेक्ट के अवयवों का 

चयन करते हैं। आप बाद के पाठों में ऑब्ज़ेक्ट के चयन के बारे  में और अधिक सीखेंगे।

•	 आइकन के पाँचवें समूह का प्रयोग ऑब्ज़ेक्ट और अवयवों के लिए स्नैप मोड के नियत्रण के लिए किया जाता ह।ै आप इस अध्याय में बाद के पाठ में 

इन टूल्स का इस्तेमाल करना शुरू करें गे।

•	 अंतिम खंड में तीन बटन हैं जिसका इस्तेमाल एडिटर्स को दिखाने और छिपाने के लिए किया जाता ह,ै जिसमें Attribute Editor, Channel Box, Layer 

Editor और Tool Settings शामिल हैं। 

चित्र 6.1.86: लाइन
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चित्र 6.1.87: बार

शेल्फ

शेल्फ Status line के ठीक नीचे स्थित होता ह।ै Maya शेल्फ उन टूल और आइटम को स्टोर 

करने के लिए उपयोगी ह,ै जिनका उपयोग आप बार-बार करते हैं या जिन्हें आपने अपने 

प्रयोग के लिए कस्टमाइज़ किया ह।ै आप बार-बार इस्तेमाल किये जाने वाले टूल और 

आइटम को ऐसी लोकेशन पर रख सकते हैं, जहां से ये कभी भी आसानी से एक्सेस किये 

जा सकें । Maya में आपके इस्तेमाल के लिए कुछ आइटम पहले से कॉन्फिगर किए हुए 

होते हैं।
चित्र 6.1.88: शेल्फ

शेल्फ से टूल का प्रयोग करके ऑब्ज़ेक्ट बनाना

•	 शेल्फ से, Surfaces टवै सलेक्ट करें  ताकि उस शेल्फ पर स्थित टूल देख सकें ।

•	 Create > NURBS Primitives > Interactive Creation सलेक्ट करें  और सुनिश्चित करें  कि आइटम के बगल में चेकमार्क  प्रदर्शित नहीं ह।ै

•	 शेल्फ से, NURBS स्फेयर  आइकन को क्लिक करके सलेक्ट करें , जो बाएं सिरे  पर स्थित ह।ै

•	 Maya स्फेयर  प्रिमिटिव ऑब्ज़ेक्ट का निर्माण करता ह ैऔर क्यूब के ही समान पोजिशन में Maya वर्क स्पेस के कें द्र में रखता ह।ै

चित्र 6.1.89: Surface टैब सलेक्ट करना

चित्र 6.1.90: टूल पॉप-अप

	 जब ऑब्ज़ेक्ट इस तरह दिखाई देता ह,ै तो हम इसे सलेक्टेड या एक्टिव कहते हैं।

चित्र 6.1.91: ऑब्ज़ेक्ट
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Channel Box दिखाने या छिपाने के लिए

•	 Channel Box छिपाने के लिए, Status line के दाएं सिरे  से Show/Hide Channel Box आइकन पर क्लिक करें ।

•	 Channel Box गायब हो जाता ह ैऔर पर्सपेक्टिव सीन व्यू थोड़ा फैल जाता ह।ै छिपे हुए Channel Box के साथ, आपके पास सीन व्यू में काम करने के 

लिए अधिक जगह ह।ै

चित्र 6.1.92: Channel box

•	 Channel Box दिखाने के लिए, Status line के दाएं सिरे  से Show/Hide Channel Box आइकन पर क्लिक करें । Channel Box सीन व्यू में दिखाई  

देता ह।ै

अपना कार्य सेव करना

•	 Maya प्रोजेक्ट के साथ काम करते समय अपने कार्य  को बार-बार सेव करने की आदत डालें। इस तरह से, कोई गलती होने पर आप अपने कार्य  का 

पुराना वर्जन खोल सकते हैं।

•	 आपके द्वारा वर्क स्पेस पर बनाई गई हर चीज़ को Maya सीन के रूप में प्रस्तुत करता ह।ै इसमें ऑब्ज़ेक्ट, लाइट, कैमरा और आपकी कार्य  सेशन से 

जुड़ी सामग्रियाँ शामिल होती हैं।

अपना Maya सीन सेव करने के लिए

•	 File > Save Scene सलेक्ट करें ।

•	 फाइल ब्राउज़र प्रकट होता ह,ै जिसमें डिफॉल्ट डायरेक्टर ी सचूीबद्ध होता ह ैजहाँ आप अपना सीन सेव कर सकते हैं।

•	 टाइप: फाइल नेम टेक्स्ट बॉक्स में Lesson1 टाइप करें ।

•	 सेव पर क्लिक करें ।

Maya आपकी फाइल को आपके Maya डिफॉल्ट प्रोजेक्ट डायरेक्टर ी के अंदर सीन डायरेक्टर ी में सेव करता ह।ै Maya ओटोमटैिक रूप से .mb ऐक्सटेंशन 

के साथ फाइल सेव करता ह।ै .mb ऐक्सटेंशन दर्शाता ह ैकि सीन Maya बाइनरी फाइल के रूप में सेव हुआ था: यह Maya सीन के लिए डिफॉल्ट फाइल 

टाइप होता ह।ै

Maya से एक्जि़ट करना

इससे पहले कि आप Maya से बाहर निकलें, सुनिश्चित करें  कि आपने उस कार्य  को सेव कर लिया ह ैजिसकी आपको बाद में भी ज़रूरत ह ैऔर जिस पर 

आप बाद में भी काम ज़ारी रखना चाहते हैं।

Maya से एक्जि़ट करने के लिए

•	 मेन मेन्यू से File > Exit सलेक्ट करें । 

Maya निम्नलिखित दो में से कोई एक कार्य  करता ह:ै

•	यदि  आप Exit से तुरंत पहले अपना सीन सेव करते हैं, तो Maya बाहर निकल जाता ह।ै

•	यदि  आपने अपना सीन हाल में सेव नहीं किया ह,ै तो स्क्रीन पर यह पछूते हुए मसेैज प्रॉम्प्ट प्रदर्शित होता ह ैकि आप अपने परिवर्तनों को सेव करना 

चाहते हैं या नहीं। Save, Don’t Save या Cancel पर क्लिक करें ।
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यूनिट 6.2: ऑब्ज़ेक्ट बनाना, मनैिपुलटे करना तथा दखेना

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

•	 3D प्रिमिटिव ऑब्ज़ेक्ट बनाने में।

•	 मेनिपुलेशन और एडिटिग के उद्देश्यों के लिए ऑब्ज़ेक्ट सलेक्ट करने में।

•	 अपने माउस की मदद से ऑब्ज़ेक्ट को खिसकाने (मूव) और घुमाने (रोटेट) में।

6.2.1 नया सीन बनाना

6.2.2 प्रिमिटिव ऑब्ज़ेक्ट

नया खाली सीन बनाकर टेप्म्लेट प्रोजेक्ट शुरू करें । नया सीन बनाने के लिए:

•	 Maya स्टार्ट  करें  (यदि यह पहले से नहीं चल रहा तो):

»	 Maya स्टार्ट  होने पर, यह अपने आप एक नया सीन बनाता ह।ै

»	यदि  Maya पहले से रन कर रहा था, तो चरण 2 और 3 अपनाएँ।

•	 मेन मेन्यू से, File > New Scene सलेक्ट करें ।

•	 Maya निम्नलिखित प्रॉम्प्ट प्रदर्शित करता ह।ै

•	 No पर क्लिक करें । Maya एक नया सीन बनाता ह ैऔर पिछले सीन की हर चीज़ों को डिलीट कर देता ह।ै

Maya अनेक प्रकार के प्रिमिटिव टाइप और शेप प्रदान करता ह ैजसेै क्यूब, स्फेयर , सिलिडर और प्लेन।

चित्र 6.2.1: प्रोजेक्ट

चित्र 6.2.2: सीन सेव करना

चित्र 6.2.3: प्रिमिटिव ऑब्ज़ेक्ट

यूनिट के उद्देश्य  
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बेस के लिए पॉलिगोन सिलिंडर बनाने के लिए

•	 Polygons मेन्यू सेट सलेक्ट करें

•	 मेन मेन्यू से, Create > Polygon Primitives > Cylinder > _सलेक्ट करें , एक विकल्प विंडो प्रदर्शित होता ह।ै

•	 Polygon Cylinder Options विंडो में, Edit > Reset Settings सलेक्ट करें  और फिर निम्नलिखित विकल्प सेट करें :

»	रेडिय  स (त्रिज्या): 10

»	 ऊंचाई: 1

»	 अक्ष खंड: 8

»	 उंचाई विभाजन/वर्ग: 1

»	 कैप खंड: 1

»	 एक्सिस/अक्ष: Y

•	 Polygon Cylinder Options विंडो में, Create पर क्लिक करें ।

•	 Maya एक सिलिडर प्रिमिटिव ऑब्ज़ेक्ट बनाता ह ैजो आकार में ऑक्टोगोनल होता ह ैऔर Maya वर्क स्पेस के बीच स्थित होता ह।ै यह सिलिडर 20 

इकाई चौड़ा और एक इकाई ऊंचा होता ह ैऔर इसके आठ पषृ्ठ भाग होते हैं।

6.2.3 टूलबॉक्स
टूलबॉक्स: लआेउट शॉर्टकट

टूलबॉक्स Maya यजू़र इंटरफेस से बाई ंओर स्थित होता ह।ै इसमें वसेै आइकन मौजदू होते हैं 

जो आपके ऑब्ज़ेक्ट को Maya में रूपांतरित करने के लिए (सेलेक्शन, मूव, रोटेट, स्के ल) 

और व्यू और पनैल लेआउट बदलने के लिए लेआउट शॉर्टकट के टूल्स खोलते हैं Quick 

Layout बटन शॉर्टकट आपको एक अलग पनैल सलेक्ट करने या अन्य लेआउट पर जाने की 

अनुमति देते हैं।

•	 टूलबॉक्स से, Four View लेआउट शॉर्टकट पर क्लिक करें ।

चित्र 6.2.4: सिलिंडर

चित्र 6.2.5: टूलबॉक्स
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•	 वर्क स्पेस फोर-व्यू लेआउट में बदल जाता ह।ै पर्सपेक्टिव व्यू ऊपरी दाएँ कोने में स्थित होता ह ैऔर अन्य व्यू ऑब्ज़ेक्ट को ऊपर, सामने और बगल से 

दिखाते हैं।

•	 साइड व्यू को बड़ा करने के लिए, साइड व्यू पर माउस कर्सर रखें और अपने कीबोर्ड  का स्पेसबार टपै करें ।

टूलबॉक्स: ट्रांसफॉर्मेशन टूल्स

•	 आपको आधार को Y दिशा में थोड़ा ऊपर ले जाना होगा, ताकि यह X, Z प्लेन पर स्थित हो जाए। ऐसा करने 

के लिए Move ट्रांसफॉर्मेशन टूल का प्रयोग करें  जो टूलबॉक्स में स्थित होता ह।ै

•	 टूल का नाम Maya विंडो के नीचे Help Line में भी प्रदर्शित होता ह।ै

ऑब्ज़ेक्ट का सिलके्शन और डी-सिलके्शन

•	 इससे पहले कि आप किसी ऑब्ज़ेक्ट को रूपांतरित करें , आपको सुनिश्चित करना होगा कि यह सलेक्ट किया हुआ ह।ै ऑब्ज़ेक्ट को डीसलेक्ट करने 

के लिए, सलेक्ट किए हुए क्षेत्र के बाहर कही भी क्लिक करें ।

चित्र 6.2.6: फोर व्यू

चित्र 6.2.7: ट्रांसफॉर्मेशन टूल्स

चित्र 6.2.7: शॉर्टकट की

चित्र 6.2.7: ऑब्जेक्ट रूपांतरित करें
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सीव न्यू में बेस प्रिमिटिव सलके्ट करने के लिए

•	 अपने बाएं माउस बटन की मदद से, सीन व्यू में ऑब्ज़ेक्ट के वायरफ्रे म आउटलाइन पर क्लिक करें ।

•	 अपने बाएं माउस बटन से, ऑब्ज़ेक्ट वायरफ्रे म के एक कोने का बाउंडिग बॉक्स या किनारा ड्रैग करें ।

जब वायरफ्रे म आउटलाइन का रंग चमकते हरे  रंग में प्रदर्शित होने लगता ह ैतो यह सलेक्ट हो जाता ह।ै यदि यह सलेक्ट नहीं होता ह,ै तो इसका रंग गहरे  

नीले रंग का होता ह।ै

बेस/आधार की पोज़ीशन एडजस्ट करने के लिए Move Tool का उपयोग करने के लिए

•	 टूलबॉक्स से Move Tool सलेक्ट करें ।

•	 मूव मेनिपुलेटर आइकन सीन व्यू में प्रिमिटिव सिलिडर पर प्रदर्शित होता ह।ै

•	 साइड व्यू में, प्रिमिटिव सिलिडर को Y दिशा में ऊपर की ओर ले जाने के लिए हरा Y मेनिपुलेटर हैंडल ड्रैग करें । इसे पर्याप्त ऊपर करें  ताकि बेस 

सिलिडर का निचला भाग X अक्ष की लाइन में आ जाए।

अब बेस सिलिडर को थोड़ा घुमाना पड़ता ह ैजिससे बेस का आगे का भाग ग्रिड लाइन के समानांतर हो जाता ह।ै चूंकि ऑक्टागोन (अष्ठफलक) का प्रत्येक 

फलक वतृ्त का 45 डिग्री निरूपित करता ह,ै इसलिए आपको इसका लगभग आधा घुमाना होता ह ैअर्थात 22.5 डिग्री।

आधार (बेस) की पोज़ीशन एडजस्ट करने हेतु Rotate Tool का उपयोग करने के लिए

•	 व्यू में माउस कर्सर रखकर और अपने कीबोर्ड  का स्पेसबार टपै करके सभी चार व्यू प्रदर्शित करें । चार दृश्य वाला पनैल/फोर व्यू पनैल प्रदर्शित  

होता ह।ै

•	 माउस कर्सर टॉप व्यू पर रखें और एक बार स्पेसबार टपै करें । टॉप व्यू वर्क स्पेस में दिखाई पड़ता है

चित्र 6.2.8: Moov टूल का प्रयोग करें

•	 बेस सिलिडर सिलेक्ट किये हुए ही, टूलबॉक्स से Rotate टूल चुनें। सीन व्यू में प्रिमिटिव 

सिलिडर पर रोटेट मेनिपुलेटर आइकन प्रदर्शित होता ह।ै

•	 टॉप व्यू में, प्रिमिटिव सिलिडर को घुमाने के लिए हरा Y मेनिपुलेटर रिंग ड्रैग करें  ताकि बेस 

सिलिडर का एक फलक ग्रिड के साथ संरेखि त हो जाए जसैा कि नीचे के चित्र में दिखाया 

गया ह।ै आप सिलिडर को इसके Y अक्ष के चारों ओर घुमा रहे हैं।

चित्र 6.2.9: रोटेट मेनिपुलेटर्स

चित्र 6.2.10: टॉप व्यू
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6.2.4 Channel Box

Channel Box एक एडिटिग पनैल ह ैजो आपको किसी ऑब्जेक्ट की रूपांतरण सचूना इत्यादि प्रदान करता ह।ै यह किसी भी प्रकार के ऑब्जेक्ट के लिए 

तीन अलग-अलग क्षेत्रों पर सचूना प्रदान करता ह:ै ट्रांसफॉर्मेशन नोड, शेप नोड और इनपुट नोड।

Channel Box की मदद से बेस को मूव और रोटटे करने के लिए

•	 बेस सिलिडर को सिलेक्ट किये हुए ही, Channel Box में ट्रांसफॉर्मेशन ऐट्रिव्यूट 

देखें। विशेष रूप से, Translate Y और Rotate Y के मान देखें।

•	 Channel Box में, फील्ड पर क्लिक करके और सही सांख्यिक मान डालकर 

ऐट्रिब्यूट मानों को इस प्रकार एडजस्ट/समायोजित करें  कि वे ऊपर के चित्र के 

साथ मेल खाने लगें। इससे बेस आपके Maya सीन में सही तरीके से स्थित हो 

जाता ह।ै

•	 Maya ने सिलिडर प्रिमिटिव को नाम दे दिया था, जब यह पहली बार बना था। 

सिलिडर को रीनेम करें , जो आपके प्रोजेक्ट के हिसाब से ज़्यादा अर्थपरू्ण  हो।

Channel Box की मदद से सिलिंडर प्रिमिटिव को रीनेम करें

•	 Channel Box में, pCylinder1 नाम वाले फील्ड पर क्लिक करें ।

•	 नया नाम: templeBase टाइप करके प्रिमिटिव ऑब्जेक्ट का नाम बदलें और एंटर दबाएँ।

6.2.5 ऑब्जेक्ट का डुप्लिकट बनाना

किसी मौजदूा ऑब्जेक्ट का डुप्लिकेट बनाना, इसे परूा फिर से बनाये बिना ही, इसकी हू-ब-हू कॉपी बनाने की एक उपयोगी विधि ह।ै जब आप किसी 

आइटम का डुप्लिकेट बनाते हैं तो कॉपी में मूल की विशेषताएँ समाहित होती हैं। Duplicate टूल की मदद से आप कॉपी पर अतिरिक्त ट्रांसफॉर्मेशन (move, 

rotate, scale) एप्लाई कर सकते हैं।

टमे्प्लेट बेस डुप्लिकट करने के लिए

•	 व्यू में माउस कर्सर रखकर और स्पेसबार टपै करके सभी चार व्यू प्रदर्शित करें । फिर इस व्यू में बेस प्रदर्शित करने के लिए पर्सपेक्टिव व्यू में  

क्लिक करें ।

•	 सलेक्ट हुए मेन मेन्यु से templeBase के साथ, Edit > Duplicate Special > चुनें। Duplicate Special Options विंडो प्रदर्शित होती ह।ै

•	 Duplicate Special Options विंडो में, Edit > Reset Settings सलेक्ट करें  और फिर निम्नलिखित विकल्प सेट करें :

»	ट्रां सलेट: 0 1.0 0

»	र ोटेट: 0 0 0

चित्र 6.2.11: खिसकाएँ और घुमाएँ (Move और Rotate)

चित्र 6.2.12: प्रिमिटिव ऑब्जेक्ट का नाम बदलें/रीनेम
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»	 स्के ल: 0.9 1.0 0.9

»	 ज्योमेट्री का प्रकार: कॉपी

»	ग्रु प अंडर: पेरें ट

•	 Duplicate Options विंडो में, Duplicate Special पर क्लिक करें ।

Maya templeBase ऑब्जेक्ट का एक डुप्लिकेट बनाता ह ैजो X, Z अक्षों में मूल के स्के ल का 0.9 होता 

ह ैऔर templeBase से एक यनूिट ऊपर होता ह।ै स्के ल ऑपरे शन के परिणामस्वरूप, टेम्प्लेट के लिए 
बेस अब स्टेप्ड रूप में प्रदर्शित होता ह।ै

Maya मूल नाम के आधार पर डुप्लिकेट ऑब्जेक्ट के नाम का ट्रैक रखता ह ैऔर डुप्लिकेट हुए ऑब्जेक्ट का नाम बदलकर templeBase1 रखता ह।ै

चित्र 6.2.13: स्केल िंग

टिप्पणियां 
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यूनिट 6.3: Maya 3D सीन दखेना

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 Maya सॉफ्टवेयर पर 3D एनिमेशन तकनीकों के एप्लीकेशन में - Maya 3D सीन देखना।

2.	 वर्क प्लो ओवरव्यू के बारे  में सविस्तार बतायें।

6.3.1 कैमरा टूल्स

अब तक के पाठों में, जब आपने ऑब्जेक्ट को टॉप, फ्रं ट या साइड व्यू से देखा, तो आप सीन को ऑर्थोग्राफिक व्यू के जरिए देख रहे थे। ऑर्थोग्राफिक व्यू 

द्विआयामी दिखता ह,ै क्योंकि ऑब्जेक्ट एक ही समय में केवल दो अक्षों के समानांतर प्रक्षेपों के जरिए प्रदर्शित होता ह।ै 

जब आप सीन को पर्सपेक्टिव व्यू के जरिए देखते हैं, तो आप सीन को तीन-आयामी रूप में देखते हैं। पर्सपेक्टिव व्यू इस बात को सिम्युलेट करता ह ैकि 

आपका सीन कैमरे  की नज़र से कैसी दिखेगा।

पर्सपेक्टिव व्यू

Maya में, आप आभासी कैमरा के सेट के जरिए सीन देखते हैं। ये कैमरा या तो 

ऑर्थोग्राफिक या पर्सपेक्टिव होते हैं। Camera टूल्स की मदद से आप एडजस्ट कर 

सकते हैं, कि इन कैमरों से सीन कैसे दिखें।

चित्र 6.3.1: 2 ऐक्सिस व्यू

चित्र 6.3.2: पर्सपेक्टिव व्यू

यूनिट के उद्देश्य  
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6.3.2 वर्क फ्लो अवलोकन

कॉलम अनेक प्रिमिटिव से बने होते हैं जो पोज़ीशन में मूव्ड, स्के ल्ड और रोटेटेड होते हैं। जसेै 

ही पहला कॉलम बने, प्रत्येक कॉम्पोनेंट का नाम और पोज़ीशन बिल्कु ल सही हो, आप इसे 

समूहित/ग्रुप कर सकें गे और अन्य कॉलम बनाने के लिए डुप्लिकेट कर सकें गे।

पेडेस्टल के लिए पॉलिगोन सिलिंडर बनाना

•	 मेन मेन्यू से, Create > Polygon Primitives > Cube सलेक्ट करें । 

•	 Polygon Cube Options विंडो में, Edit > Reset Settings सलेक्ट करें  और फिर 

निम्नलिखित विकल्प सेट करें :

»	च ौड़ाई: 1.75

»	 ऊंचाई: 0.6

»	 डेप्थ (गहराई): 1.75

•	 अन्य भागों को उनके डिफॉल्ट सेटिग्स में रहने दें।

•	 Polygon Cube विकल्प विंडो में, Create पर क्लिक करें ।

Maya क्यूब प्रिमिटिव निर्माण करता ह ैऔर इसे मूल (ओरिजिन) पर रखता है

•	 साइड व्यू में, क्यूब को ऊपर की ओर मूव करें  (Y अक्ष) ताकि यह टेम्पल बेस की ऊपरी सतह पर टिक जाए। 

•	 Channel Box में, क्यूब का नाम बदलर (रीनेम) columnPedestal रखें।

शाफ्ट के लिए पॉलिगोन सिलिंडर बनाना

•	 मेन मेन्यू से, Create > Polygon Primitives > Cylinder > _ सलेक्ट करें ।

•	 Polygon Cylinder Options विंडो में, Edit > Reset Settings सलेक्ट करें  और फिर 

निम्नलिखित विकल्प सेट करें :

»	रेडिय  स (त्रिज्या): 0.5

»	 ऊंचाई: 6

»	 अक्ष खंड: 1

»	 अन्य भागों को उनके डिफॉल्ट सेटिग्स में रहने दें

»	 Polygon Cylinder Options विंडो में, Create पर क्लिक करें ।

चित्र 6.3.3: पहला कॉलम नाम

चित्र 6.3.4: पेडेस्टल के लिए पॉलिगोन क्यूब

चित्र 6.3.5: शाफ्ट के लिए पॉलिगोन सिलिंडर
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6.3.3 ऑब्जेक्ट का समूहन (ग्रुपिग)

•	 साइड व्यू में, सिलिडर को ऊपर की ओर मूव करें  (Y अक्ष) ताकि यह columnPedestal की ऊपरी सतह पर टिक जाए।

•	 Channel Box में, क्यूब का नाम बदल कर columnShaft रखें।

शडैेड मोड में ऑब्जेक्ट दखेना

अभी तक, आप ऑब्जेक्ट को डिफॉल्ट वायरफ्रे म में देख रहे थे। वायरफ्रे म मोड में, ऑब्जेक्ट साधारण वायर आउटलाइन को छोड़कर पारदर्शी दिखाई देता 

ह ैजो उनकी पोज़ीशन और सामान्य आकार को दर्शाता ह।ै Maya शडेैड रूप में ऑब्जेक्ट प्रदर्शित करने के लिए अनेक विकल्प प्रदान करता ह।ै

अपने सीन का डिस्प्ले इस प्रकार बदलें ताकि ऑब्जेक्ट शडेैड ऑब्जेक्ट की तरह दिखाई दे।

स्मूथ शडैेड मोड में ऑब्जेक्ट प्रदर्शित करने के लिए

•	 पर्सपेक्टिव व्यू बड़ा/एन्लार्ज करें  और सीन को डॉली और टंबल करें  ताकि आप आसानी से देख सकें  कि अब तक आपने क्या-क्या किया ह।ै

•	 पनैल मेन्यू से, Shading > Smooth Shade All सलेक्ट करें । आपने सीन में ऑब्ज़ेक्ट्स  अपारदर्शी गहरे  धसूर रंग में प्रदर्शित होंगे। इस पाठ के शेष 

हिस्से में आप ऑब्जेक्ट के साथ या तो शडेैड या अनशडेैड मोड में काम कर सकते हैं।

जब आपको अनेक ऑब्जेक्ट को एक यनूिट के रूप में मूव, स्के ल और रोटेट होता ह,ै तो आसान होता ह ैयदि वे एक साथ समूहित हों जिससे वे एक यनूिट 

के रूप में बदल जाएँ।

Maya में अधिकांश प्रिमिटिव ऑब्जेक्ट समूहित ऑब्जेक्ट के रूप में होते हैं। उदाहरण के लिए, NURBS क्यूब प्रिमिटिव में 6 समतल स्क्वायर या प्लेन होते 

हैं जो एकसाथ एक यनूिट के रूप में समूहित होते हैं। जब प्लेन ऑब्जेक्ट एकसाथ समूहित होते हैं, तो वे एक अनुक्रम का निर्माण करते हैं।

अनुक्रम उन नोड्स या ऑब्जेक्ट का एक संकलन ह ैजो समान उद्देश्य के लिए एकसाथ मिलकर एक यनूिट बनाते हैं। ऑब्जेक्ट्स  उनके अंदर की समान 

विशेषताएँ और ऐट्रिब्यूट; उदाहरण के लिए मूव, स्के ल और रोटेट, किस प्रकार साझा करें , इसके वर्णन करने के लिए अनुक्रम उपयोगी होते हैं।

कॉलम हेतु ऑब्जेक्ट्स को समूहित करने के लिए

•	 नीचे दिये गये विकल्पों में से कोई एक करके, कॉलम बनाने वाले चार ऑब्जेक्ट एक साथ सिलेक्ट करें :

»	 अपने बाएँ माउस बटन की मदद से, सीन व्यू में चारो ऑब्जेक्ट सेलेक्ट होने तक प्रत्येक ऑब्जेक्ट पर शिफ्ट-क्लिक करें ।

»	 अपने बाएँ माउस बटन की मदद से, ऑर्थोग्राफ़िक व्यू में कॉलम ऑब्जेक्ट्स  के चारों ओर एक बड़ा बाउंडिग बॉक्स ड्रैग करें ।

»	य ह महत्वपरू्ण  ह ैकि आप अपने सिलेक्शन के भाग के रूप में कोई templeBase सलेक्ट न करें । यदि आप गलती से कोई बेस ऑब्जेक्ट सलेक्ट 

कर लेते हैं तो उन्हें डीसलेक्ट करें ।

चित्र 6.3.6: शैडेड मोड में ऑब्जेक्ट
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•	 मेन मेन्यू से, Edit > Group >_ सलेक्ट करें ।

•	 Group विकल्प विंडो में, Edit > Reset Settings सलेक्ट करें  और फिर निम्नलिखित विकल्प सेट करें :

»	ग्रु प अंडर: पेरें ट

»	 अन्य भागों को उनके डिफॉल्ट सेटिग्स में रहने दें

•	 Group Options window में, Group पर क्लिक करें ।

•	 Maya ऑब्जेक्ट को अनुक्रम (हाइरार्की) में एकसाथ समूहित करता ह।ै आने वाले चरणों में आप अनुक्रम के बारे  में और अधिक सीखेंगे।

6.3.4 Hypergraph
Hypergraph वह विंडो ह ैजो दर्शाती ह ैकि आपके सीन में नोड्स और उनके कनेक्शन किस प्रकार व्यवस्थित हैं। आप Hypergraph में ऑब्जेक्ट हाइरार्की 

और डिपेंडेंसीज देखते हैं। यह देखने के लिए Hypergraph का उपयोग करें  कि जब आप ऑब्जेक्ट समूहित करते हैं तो क्या होता ह।ै 

Hypergraph दखेने के लिए

•	 व्यू मेन्यू से, Panels > Layouts > Two Panes Stacked सलेक्ट करें । सीन व्यू दो व्यूइंग पनैल में विभाजित होता ह ै- प्रत्येक का अपना अलग व्यू मेन्यू 

होता ह।ै आप ऊपरी व्यू में सीन और दूसरे  में Hypergraph देखने के लिए इन्हें सेट करें गे।

•	निच ले पनै मेन्यू से, Panels > Hypergraph Panel > Hypergraph Hierarchy सलेक्ट करें । Hypergraph पनैल सीन व्यू पनैल के नीच प्रदर्शित होगा।

•	 Hypergraph पनैल के ऊपरी भाग में, Scene Hierarchy आइकन चुनें ताकि सुनिश्चित कर सकें  कि Hypergraph सीन अनुक्रम प्रदर्शित कर रहा ह।ै

•	 Hypergraph पनैल में, View > Frame All सलेक्ट करें । Hypergraph सीन के सभी ऑब्जेक्ट के लिए अनुक्रम प्रदर्शित करता ह।ै सीन में ऐटंिटीज 

देखने की यह विधि आपके सीन के सभी विभिन्न नोड्स देखने के लिए संपरू्ण  ग्राफिकल एप्रोच प्रदान करती ह।ै

चित्र 6.3.7: Hypergraph देखना

चित्र 6.3.8: नोड्स
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Hypergraph में पेरें ट मोड का नाम बदलने के लिए

•	 Hypergraph में, group1 नोड पर क्लिक करें  ताकि यह एक्टिव हो जाए। सीन व्यू में, अनुक्रम के ऊपरी (पेरें ट) स्तर पर स्थित समूह सलेक्ट करने पर 

कॉलम समूह के सभी ऑब्जेक्ट सलेक्ट हो जाते हैं।

•	 Hypergraph में, group1 को निरूपित करने वाले ऊपरी नोड पर राइट-क्लिक करें  और पॉप-अप मेन्यू से Rename क्लिक करें । नोड में एक छोटा 

टेक्स्ट बॉक्स प्रकट होता ह।ै

•	 नये नाम के रूप में कॉलम एंटर करें । अब कॉलम समूहित होता ह,ै आपको इसे टेम्पल बेस के एक कोने पर रखना होगा।

कॉलम को टमे्पल बेस पर रखने के लिए

•	 अपने कीबोर्ड  पर 4 “की” टपै करके ऑब्जेक्ट के डिस्प्ले को वायरफ्रे म मोड में बदलें। यह एक कीबोर्ड  शॉर्टकट होता ह।ै कमांड इम्प्लिमेंट करने के 

लिए मेन्यू से आइटम सलेक्ट करने के बदले आप सिगल की का उपयोग कर सकते हैं।

•	 Hypergraph में, टॉप नोड में कॉलम सलेक्ट करें  ताकि कॉलम सीन व्यू में सक्रिय हो जाए।

•	 सीन व्यू में, टेम्पल बेस के आगे के कोने पर कॉलम स्थित करने के लिए Move टूल का उपयोग करें  जसैा नीचे दिखाया गया ह।ै

पहले कॉलम के पोज़ीशन में होने पर, आप कॉलम की कॉपी क्रिएट कर सकते हैं और बेस के साथ वाले कोने में पोज़ीशन कर सकते हैं।

कॉलम की डुप्लिकट कॉपी बनाने के लिए

•	 Hypergraph में कॉलम सलेक्ट किये हुए ही, मेन मेन्यू से Edit > Duplicate Special >_ चुनें।

»	 Duplicate Special Options विंडो प्रदर्शित होती ह।ै

•	 Duplicate Special Options विंडो में, Edit > Reset Settings सलेक्ट करें  और फिर निम्नलिखित विकल्प सेट करें :

»	 कॉपी की संख्या: 1

»	 अन्य भागों को उनके डिफॉल्ट सेटिग्स में रहने दें।

•	 Duplicate Special Options विंडो में, Duplicate Special पर क्लिक करें ।

»	 Hypergraph व्यू सीन में अतिरिक्त कॉलम ऑब्जेक्ट दिखाने के लिए अपडेट होता ह।ै कॉपी मूल समूह का प्रीफिक्स नाम भी ले लेती ह ैऔर यह 

Column1 नाम से लेबल होती ह।ै

सीन व्यू यह दर्शाता ह ै कि वास्तव में कुछ भी डुप्लिकेट नहीं हुआ था। जब कोई ऑब्जेक्ट बिना किसी ट्रांसफॉर्मेशन के डुप्लिकेट होता ह ै तो कॉपी 

ओरिजिनल के समान ही पोज़ीशन होती ह।ै दोनों ऑब्जेक्ट एक दूसरे  के ऊपर रहते हैं।

चित्र 6.3.9: पोज़ीशन किया हुआ कॉलम
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डुप्लिकट कॉलम को बेस पर पोज़ीशन करने हेतु मूव करने के लिए

•	 Hypergraph में, सुनिश्चित करें  कि Column1 इसके टॉप नोड पर क्लिक करके सिलेक्ट किया जाये, जिससे यह सीन व्यू में सलेक्टेड हो जाये।

•	 सीन व्यू में, टेम्पल बेस के बराबर में कोने पर Column1 स्थित करने के लिए Move टूल का उपयोग करें । 

•	 टूलबॉक्स से, Four View लेआउट शॉर्टकट पर क्लिक करें । वर्क स्पेस फोर-व्यू लेआउट में बदल जाता ह ैऔर Hypergraph अब प्रदर्शित नहीं होता।

सिलके्शन मोड्स और मास्क

जब आप किसी ऑब्जेक्ट को इसके हाइरार्की के अंदर के किसी विशेष स्तर पर सलेक्ट करना चाहते हैं तो Hypergraph विंडो को खोलकर रखना हमेशा 

उपयोगी साबित होता ह।ै Maya आपको आपकी विशेष ज़रूरत के अनुसार विभिन्न सिलेक्शन मोड्स में आइटम सलेक्ट करने की अनुमति देता ह।ै

तीन मुख्य प्रकार के सिलेक्शन मोड होते हैं: हाइरार्की, ऑब्जेक्ट और कॉम्पोनेंट अन्य ऑब्जेक्ट के सिलेक्शन को सीमित करने या मास्क करने के लिए 

आप इन मोड्स का उपयोग कर सकते हैं ताकि केवल वही आइटम सिलेक्ट हो जो आप चाहते हैं। जब आप सेलेक्शन मास्क का उपयोग का करते हैं तो 

आप उन आइटम को फिल्टर करते हैं या मास्क करते हैं जिन्हें आप सिलेक्शन में नहीं शामिल करना चाहते हैं।

चित्र 6.3.10: पोज़ीशन में दो कॉलम

चित्र 6.3.11: सिलेक्शन मोड्स और मास्क

जब आप पहली बार Maya चाल ूकरते हैं, तो डिफॉल्ट सिलेक्शन मोड ऑब्जेक्ट पर सेट होता ह।ै यह Maya के साथ बहुत सारे  सिलेक्शन कामों में उपयोगी 

होता ह,ै साथ ही कुछ अपवाद भी होते हैं।

हाइरार्की और कॉम्बिनेशन सिलके्शन मास्क का प्रयोग करने के लिए

•	 Status Line पर, Select by Hierarchy and Combinations आइकन चुनें।

•	 Selection Mask आइकन तीन सिलेक्शन विकल्प दर्शाने के लिए अपडेट होता ह।ै

•	 Status Line पर, Select by Hierarchy आइकन चुनें।

•	 हाइरार्की द्वारा सिलेक्शन सुनिश्चित करता ह ैकि जब आप आइटम सलेक्ट करें  तो वे अपने पेरें ट या रूट नोड पर सलेक्ट हों ।

•	 सीन व्यू में, Column और Column1 पर शिफ्ट-क्लिक करें  ताकि वे एक साथ सलेक्ट हो जाएँ।
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6.3.5 पिवट पॉइंट

पिवट प्वॉइंट 3D स्पेस में एक विशिष्ट पोज़ीशन ह ैजिसका इस्तेमाल ऑब्जेक्ट के ट्रांसफॉर्मेशन के लिए एक संदर्भ के रूप में किया जाता ह।ै सभी ऑब्जेक्ट 

(कर्व, सर्फे स, ग्रुप) के पिवट प्वॉइंट होते हैं।

दो कॉलम को समूहित करने के लिए

•	 सुनिश्चित करें  कि Column और Column1 सलेक्ट किए हुए हैं।

•	 मेन मेन्यू से, Edit > Group > सलेक्ट करें । 

•	 Group Options window में, Edit > Reset Settings सलेक्ट करें । निम्नलिखित विकल्पों को सेट करें : ग्रुप अंडर: पेरें ट

•	 Group Options window में, Group पर क्लिक करें ।

Maya ऑब्जेक्ट को हाइरार्की में एक दूसरे  के साथ समूहित करता ह ैऔर पिवट प्वॉइंट ओरिजिन पर स्थित होता ह।ै (जब पिवट प्वॉइंट Move Tool के 

ओरिजिन में स्थान बदलता ह)ै

समूह डुप्लिकट और रोटटे करने के लिए

•	 कॉलम ग्रुप को सिलेक्ट किये हुए मेन मेन्यू से Edit > Duplicate Special > _ चुनें।

•	 Duplicate Special Options विंडो में, Edit > Reset Settings सलेक्ट करें  और फिर 

निम्नलिखित विकल्प सेट करें :

•	र ोटेट: 0 90 0

•	 कॉपी की संख्या: 3

•	 Duplicate Special Options विंडो में, Duplicate Special पर क्लिक करें । कॉलम डुप्लिकेट होते हैं और प्रत्येक कॉपी के साथ 90 डिग्री से रोटेट  

करते हैं।

कॉम्पोनेंट और ऐट्रिब्यूट

आपको बेस और कॉलम के डिस्प्ले को टेम्प्लेट मोड में बदलना होगा ताकि टेम्प्लेट रूफ पर अधिक आसानी 

से काम कर सकें ।

बेस और कॉलम को टमे्प्लेट करने के लिए

•	 साइड व्यू में, सिलेक्शन मास्क को हाइरार्की में सेट रखे हुए, अपने सीन के सभी ऑब्जेक्ट सलेक्ट करें ।

•	 मेन मेन्यू से, Display > Object Display > Template सलेक्ट करें । सिलेक्ट किये गये ऑब्जेक्ट टेम्प्लेट 

हो जाते हैं। ।

चित्र 6.3.12: समूह घुमाएँ/ग्रुप रोटेट करें

चित्र 6.3.13: बेस और कॉलम को टेम्प्लेट करें
एंटबै्लचर के लिए टॉरस प्रिमिटिव बनाने और पोज़ीशन करने के लिए

•	 मेन मेन्यू से, Create > NURBS Primitives > Torus > _ सलेक्ट करें ।

•	 NURBS Torus Options window में, Edit > Reset Settings सलेक्ट करें  और फिर निम्नलिखित 

विकल्प सेट करें :

»	रेडिय  स (त्रिज्या): 8.5

»	 माइनर रेडिय स: 0.5

»	 सेक्शन की संख्या: 24

•	 NURBS Torus Options window में, Create पर क्लिक करें ।

•	 Channel Box में, टॉरस प्रिमिटिव एंटबै्लचर का नाम बदलें/रीनेम करें ।

•	 एंटबै्लचर को सीन में लंबवत खिसकाएँ/वर्टिकली मूव करें  ताकि कॉलम के ऊपर स्थित हो जाए।

चित्र 6.3.14: टॉरस प्रिमिटिव एंटैब्लचर
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6.3.6 कॉम्पोनेंट्स
•	 Maya के सभी ऑब्जेक्ट में ट्रांसफॉर्म  और शेप मोड होता ह।ै

•	 एंटबै्लचर के आकार को आधारभतू स्के ल ट्रांसफॉर्मेशन से परे  बदलने के लिए, आपको इसकी कॉम्पोनेंट सचूना बदलनी होगी।

एंटबै्लचर के कॉम्पोनेंट सलके्ट करने के लिए

•	 साइड व्यू में, एंटबै्लचर के निकट के दृश्य के लिए डॉली इन करें ।

•	सि लेक्शन मोड को कॉम्पोनेंट मोड पर सेट करें ।

•	 एंटबै्लचर के वायरफ्रे म पर राइट-क्लिक करें  और पॉप-अप मेन्यू से Control Vertex चुनें।

•	 पॉप-अप हुआ मेन्यू मार्किंग  मेन्यू होता ह ै जिससे ऑब्जेक्ट से संबंधित ऑपरे शन का त्वरित सिलेक्शन होता ह ैजहाँ आप माउस पर राइट-क्लिक  

करते हैं।

•	 शीर्षों के ऊपरी पंक्ति के चारों ओर एक सिलेक्शन बॉक्स ड्रैग करें  ताकि वे सलेक्ट हो जाएँ।

•	 Move Tool की मदद से, एंटबै्लचर का आकार बदलने के लिए शीर्षों को ऊपर की ओर खिसकाएँ जसैा कि नीचे दिखाया गया ह।ै

•	 CVs का डिस्प्ले कैं सल करने के लिए, एंटबै्लचर के वायरफ्रे म पर एक बार फिर राइट-क्लिक करें  और पॉप-अप मेन्यू से Object Mode चुनें।

चित्र 6.3.15: एंटैब्लचर के कॉम्पोनेंट

टेम्पल के लिए रूफ एंटबै्लचर के ऊपर स्थित होता ह।ै टेम्पल के लिए रूफ का निर्माण एक आधे स्फेयर  प्रिमिटिव से किया जाता ह।ै

टमे्पल के लिए रूफ का निर्माण करने के लिए

•	 Create > NURBS Primitives > Sphere > सलेक्ट करें ।

•	 NURBS Sphere Options विंडो में, Edit > Reset Settings सलेक्ट करें  और फिर निम्नलिखित विकल्प सेट करें :

»	 स्टार्ट  स्वीप कोण: 0

»	 एंड स्वीप कोण: 180

»	रेडिय  स (त्रिज्या): 8.75

»	 सेक्शन की संख्या: 8

»	 स्पैंस की संख्या: 4

NURBS Sphere Options विंडो में, Create पर क्लिक करें ।

•	 half-sphere templeRoof का नाम बदलें।

रूफ को X अक्ष के चारों ओर -90 डिग्री घुमाना होता ह ैऔर एंटबै्लचर के ऊपर स्थित करना होता ह।ै
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एंटबै्लचर पर रूफ को घुमाने और पोज़ीशन करने के लिए

•	 साइड व्यू में, रूफ को इस प्रकार घुमाएं कि डोम भाग ऊपर की ओर रहे।

•	 रूफ को इस प्रकार खिसकाएँ ताकि यह एंटबै्लचर के ऊपरी किनारे  के निकट स्थित रहे।

•	 रूफ को Z अक्ष (नीला मेनिपुलेटर हैंडल) के अनुदिश स्के ल करें  ताकि स्फेयर  का रूप हल्का 

दब जाए।

ऑब्जेक्ट को अनटमे्प्लेट करने के लिए

•	 Status Line पर, Select by Hierarchy and Combinations बटन चुनें।

•	 Status Line पर, Select by hierarchy: template बटन चुनें।

•	 Select by hierarchy: टेम्प्लेट सुनिश्चित करता ह ैकि सिलेक्शन द्वारा केवल टेम्प्लेट किए हुए ऑब्जेक्ट ही प्रभावित होंगे।

•	 सीन व्यू में, सीन में सभी ऑब्जेक्ट के चारों ओर सिलेक्शन बॉक्स ड्रैग करें  ताकि टेम्प्लेट हुए ऑब्जेक्ट एकसाथ सलेक्ट हो जाएँ।

•	 मेन मेन्यू से, Display > Object Display > Untemplate सलेक्ट करें ।

•	 Status Line पर, Select by hierarchy: root बटन चुनें।

ऐट्रिब्यूट एडिटर

ऐट्रिब्यूट एडिटर आपने सीन के ऑब्जेक्ट और सामग्रियों के लिए विभिन्न नोड्स और ऐट्रिब्यूट के बारे  में जानकारी प्रदान करता ह।ै

चित्र 6.3.16: एंटैब्लचर पर रूफ

चित्र 6.3.17: अनटेम्प्लेट ऑब्जेक्ट

ऐट्रिब्यूट एडिटर की मदद से ऑब्जेक्ट ऐट्रिब्यूट दखेने के लिए

•	 सीन व्यू में, templeRoof सलेक्ट करें  ताकि यह सलेक्टेड ऑब्जेक्ट बन जाए।

•	 ऐट्रिब्यूट एडिटर देखने के लिए, Status line पर Show/Hide आइकन पर क्लिक करें ।

•	 ऐट्रिब्यूट एडिटर templeRoof के लिए ऐट्रिब्यूट प्रदर्शित करता ह।ै templeRoof के विभिन्न 

ऐट्रिब्यूट अलग-अलग टबै्स के अंतर्गत प्रकट होते हैं। प्रत्येक टबै एक नोड को निरूपित 

करता ह।ै

चित्र 6.3.18: ऐट्रिब्यूट

चित्र 6.3.19: ऐट्रिब्यूट एडिटर
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•	 TempleRoof टबै पर क्लिक करके इसके ऐट्रिब्यूट दखेें। यह टबै ट्रांसफॉर्म  नोड कहलाता ह,ै क्योंकि इस टबै पर सबसे महत्वपरू्ण  ऐट्रिब्यूट 

templeRoof के ट्रांसफॉर्मेशन को नियत्रित करता ह।ै Maya के प्रत्येक दिखाई देने वाले ऑब्जेक्ट में कैमरा और लाइट सहित एक ट्रांसफॉर्म  मोड होता 

ह।ै

•	 TempleRoofShape टबै पर क्लिक करके इसके ऐट्रिब्यूट दखेें। यह टबै शेप नोड कहलाता ह ै क्योंकि जब ऑब्जेक्ट पहली बार बनता ह,ै तो 

ऐट्रिब्यूट्स ऑब्जेक्ट का ज्यामितीय आकार या भौतिक विशेषताएं स्थापित करता ह ै। अधिकतर ऑब्जेक्ट में शेप नोड होते हैं, कुछ में नहीं होते हैं, 

जसेै कॉलम ऑब्जेक्ट के लिए समूह। शेप नोड में अन्य प्रकार के ऐट्रिब्यूट भी शामिल हो सकते हैं जसेै ऑब्जेक्ट डिस्प्ले ऐट्रिब्यूट।

•	 makeNurbSphere टबै पर क्लिक करके इसके ऐट्रिब्यूट दखेें। यह एक इनपुट मोड ह ैजिसमें ऑब्जेक्ट के निर्माण इतिहास/कंस्ट्रक्शन हिस्ट्री से 

संबंधित ऐट्रिब्यूट शामिल होते हैं। इनपुट नोड के ऐट्रिब्यूट ऑब्जेक्ट के लिए कंस्ट्रक्शन हिस्ट्री में दूसरे  अनुवर्ती नोड के लिए पास कर दिया जाता ह ै

- इस मामले में templeRoofShape को पास कर दिया गया।

•	 अंतिम दो नोड आरंभिक/इनीशियल Shading Group और lambert1 हैं। यदि आप उन्हें नहीं देख पाते हैं, तो डिस्प्ले एरो पर क्लिक करें । 

initialShadingGroup और lambert1 डिफॉल्ट नोड हैं जो किसी ऑब्जेक्ट की डिफॉल्ट शडैिग सामग्री से संबद्ध होते हैं। ऑब्जेक्ट के शुरुआती रंग और 

शडैिग से संबंधित अन्य सेटिग्स के निर्धारण के लिए Maya उनका इस्तेमाल करता ह।ै

6.3.7 सर्फे स सामग्री

किसी ऑब्जेक्ट के रंग, चमक और परावर्तकता का नियत्रण इसकी सर्फे स सामग्री (इसे शडैर या शडैिग सामग्री कहते हैं) द्वारा होता ह/ै। मटैीरियल 

ऐट्रिब्यूट इस बात से संबंधित होता ह ैकि Maya के 3D कम्प्यूटर जगत में ऑब्जेक्ट प्रकाश के प्रति किस प्रकार स्वाभाविक रूप से सिम्युलेट करता ह।ै

टमै्पल ऑब्जेक्ट के लिए नई सामग्री निर्धारित करने के लिए

•	 एंटबै्लचर के वायरफ्रे म पर राइट-क्लिक करें  और पॉप-अप मेन्यू से Object Mode चुनें।

•	 अपने सीन में सभी ऑब्जेक्ट को सिलेक्ट करने के लिए उनके चारों ओर एक सिलेक्शन बॉक्स को ड्रैग करें ।

•	 Status Line से, मेन्यू सलेक्टर की मदद से Rendering मेन्यू सेट सलेक्ट करें ।

•	 Main Menu, Rendering के लिए मेन्यू सेट दर्शाने के लिए बदल जाता ह।ै

•	 मेन मेन्यू से, Lighting/Shading > Assign New Material > Blinn सलेक्ट करें ।

चित्र 6.3.20: एंटैब्लचर का वायरफ्रे म
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•	 ऐट्रिब्यूटर एडिटर में, blinn1 शेडिग मटैीरियल का नाम बदलकर templeShader करें ।

शडैिंग सामग्री का ऐट्रिब्यूट एडिट करने के लिए

•	 ऐट्रिब्यूट एडिटर में, Color शब्द के दाई ंओर स्थित धसूर बॉक्स में क्लिक करें ।

चित्र 6.3.21: शैडिंग सामग्री का ऐट्रिब्यूट एडिट करें

चित्र 6.3.22: Color Chooser प्रदर्शित होता है।

•	 Color Chooser प्रदर्शित होता ह।ै

•	 कलर व्हील/रंगीन पहिये (षटकोण) के अंदर क्लिक करें  और सैंड कलर प्राप्त करने के 

लिए प्वॉइंटर ड्रैग करें । सटीक रंग इस पाठ के लिए महत्वपरू्ण  नहीं ह।ै

•	च जूर को बंद करने के लिए एक्सेप्ट पर क्लिक करें । आप बाद के पाठों में Maya की 

शडैिग और टेक्चरिंग क्षमताओ ंके बारे  में अधिक सीखेंगे।

चित्र 6.3.23

टिप्पणियां 

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________

•	 ऐट्रिब्यूट एडिटर मेन्यू में, सलेक्टेड मेन्यू आइटम चुनें और सचूी से templeBase चुनें। templeBase 

के विशेषताएँ ऐट्रिब्यूट एडिटर में प्रदर्शित होती ह।ै

•	 TempleShader नोड टबै पर क्लिक करके इसके ऐट्रिब्यूट देखें।

•	यदि  आप उन्हें नहीं देख पाते हैं, तो टबै के दाई ंओर डिस्प्ले एरो पर क्लिक करें ।

•	 Show/Hide आइकन की मदद से ऐट्रिब्यूट एडिटर बंद करें ।
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यूनिट 6.4: पॉलिगोनल मॉडलिंग

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 Maya सॉफ्टवेयर पर 3D एनिमेशन तकनीकों का अनुप्रयोग- पॉलिगोन मॉडलिग।

2.	 Maya में विभिन्न प्रकार के मॉडलिग सर्फे स से परिचित हों।

यूनिट के उद्देश्य  

6.4.1 मॉडलिंग 

मॉडलिग एक ऐसी प्रक्रिया ह ैजिसके लिए उत्कृ ष्ठ दृश्य कौशल और मॉडलिग टूल्स में विशेषज्ञता की ज़रूरत होती ह।ै आकार, आकृति और विवरण और 

अनुपात के अर्थ में अपने फॉर्म  की मॉडलिग के समय आप जितना सटीक होते हैं, अंतिम सीन उतना ही वास्तविक लगेगा।

Maya में तीन मॉडलिग सर्फे स प्रकार हैं:

1.	 पॉलिगोन

2.	 NURBS

3.	 सबडिविजन सर्फे स

पॉलिगोन सर्फे स तीन या अधिक साइडेड फ्लैट सर्फे स का एक नेटवर्क  ह ैजिसे फेस कहा जाता ह,ै जो आपस में कनेक्ट हो कर एक पॉली मेश बनाते हैं। 

पॉलिगोन मेश में शीर्ष  (वर्टैक्स), पषृ्ठ (फेस) और किनारे  (एज) होते हैं।

चित्र 6.4.1: मॉडलिंग सर्फे स
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6.4.3 मॉडलिंग प्रिफरें स सेट करना

अपना पॉलिगोन मॉडल बनाने से पहले इस पाठ के जरिए बेहतर कार्य  करने के लिए कुछ डिफॉल्ट सेटिग को बदल दें।

•	 Window > Settings/Preferences > Preferences सलेक्ट करें ।

»	 Maya यजू़र प्रिफरें स विंडो प्रदर्शित होता ह।ै

•	प्रि फरें स विंडो के कैटेगरीज सेक्शन में पॉलिगोन सलेक्ट करें ।

•	 पॉलिगोन डिस्प्ले सेटिग में, निम्नलिखित सेट करें :

»	 सीमा किनारा: ऑन

»	कि नारे  की चौड़ाई: 4

»	 इससे बॉर्डर एजिज़ पॉलिगोन मेश पर मुख्य रूप से प्रदर्शित होते हैं। बॉर्डर एजिज़ को विशिष्ट रूप से प्रदर्शित करने से, आप अपने मॉडल के 

अन्य किनारों (एजिज़) से इनमें अंतर कर सकते हैं और त्रुटियों को दूर सकते हैं।

•	प्रि फरें स विंडो के कैटेगरीज सेक्शन में सिलेक्शन चुनें।

•	 पॉलिगोन सिलेक्शन सेटिग में, निम्नलिखित सेट करें :

»	 इनके साथ फेस सलेक्ट करें : संपरू्ण  फेस

»	 Whole फेस सेटिग्स से आप फेस पर कहीं भी क्लिक करके पॉलिगोन फेस सलेक्ट कर सकते हैं (Center सेटिग में आपको फेस के बीच के डॉट 

पर क्लिक करना पड़ता ह)ै। इसके अलावा, सीन में जब फेस सलेक्ट किया जाता ह,ै तब परूा फेस हाइलाइटेड प्रदर्शित होता ह।ै

»	 सेटिग विंडो बंद करने के लि Save बटन पर क्लिक करें ।

»	प्रिमिटि व्स के लिए Interactive Creation option ऑफ करें : Create > Polygon Primitives > Interactive Creation (no check mark) सलेक्ट करें ।

चित्र 6.4.3: प्रिमिटिव्स के लिए Interactive Creation विकल्प

फ्रं ट और साइड ऑर्थोग्राफिक व्यू में रेफ्रें स इमेज लोड करने के लिए

•	 टूलबॉक्स में, लेआउट शॉर्टकट बार से Four View पर क्लिक करें । पर्सपेक्टिव व्यू ऊपरी दाएँ कोने में स्थित होता ह ैऔर अन्य व्यू आपके सीन को 

ऊपर, सामने और साइड से दिखाते हैं।

•	 फ्रं ट व्यू पनैल मेन्यू में View > Image Plane > Import Image सलेक्ट करें ।

•	 HelmetFront.jpg नाम की इमेज फाइल सलेक्ट करें । यह इमेज आपके Maya सॉफ्टवेयर के साथ इंस्टॉल्ड Getting Started Lesson Data directory में 

पाई जा सकती ह:ै

	 Getting Started Lesson Data/Polygon Modeling/source images
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•	ब्रा उज़र में, Open बटन पर क्लिक करें ।

HelmetFront.jpg फ्रं ट व्यू में नज़र आता ह ैऔर हेलमेट की ड्रॉइंग दर्शाता ह।ै

•	 साइड व्यू पनैल मेन्यू में View > Image Plane > Import Image सलेक्ट करें ।

•	 HelmetSide.jpg नाम की इमेज फाइल सलेक्ट करें । यह इमेज आपके Maya सॉफ्टवेयर के साथ इंस्टॉल्ड GettingStartedLessonData directory में पाई 

जा सकती ह:ै

GettingStartedLessonData/PolygonModeling/sourceimages

•	ब्रा उज़र में, Open बटन पर क्लिक करें ।

साइड व्यू में HelmetSide.jpg नज़र आता ह।ै

चित्र 6.4.4: HelmetSide.jpg

रेफरें स इमेज की पारदर्शिता बदलने के लिए

•	 फ्रं ट व्यू पनैल मेन्यू में View > Select Camera सलेक्ट करें । फ्रं ट ऑर्थोग्राफिक व्यू के लिए कैमरा सलेक्ट होता ह।ै

•	 Status line पर Show/Hide Channel Box आइकन पर क्लिक करके Channel Box डिस्प्ले करें । Channel Box फ्रं ट ऑर्थोग्राफिक व्यू के लिए कीएबल 

ऐट्रिब्यूट प्रदर्शित करता ह।ै

•	 इनपुट सेक्शन में, इमेज प्लेन के लिए ऐट्रिब्यूट दर्शाने के लिए ImagePlane1 पर क्लिक करें ।

•	 Alpha Gain ऐट्रिब्यूट का मान 0.25 सेट करें । इमेज आंशिक रूप से पारदर्शी प्रदर्शित होता ह।ै

•	 साइड व्यू पनैल मेन्यू में, कैमरा सलेक्ट करें  और साइड व्यू इमजे प्लेन के लिए Alpha Gain सेटिग में वही परिवर्तन करें  जसैा कि आपने फ्रं ट व्यू इमजे 

प्लेन के लिए किया ह।ै

6.4.4 Polygon Primitive बनाना
संदर्भ के रूप में इमेज प्लेन की मदद लेकर क्यूब प्रिमिटिव से हेलमेट मेश का शीर्ष  भाग बनाएं। प्रिमिटिव ऑब्जेक्ट 3D शुरू करने की एक विधि ह ैक्योंकि 

उन्हें अन्य रूपों में परिवर्तित किया जा सकता ह।ै

हेलमेट मेश के लिए क्यूब प्रिमिटिव बनाना

•	 सुनिश्चित करें  कि आप पर्सपेक्टिव व्यू में काम कर रहे हैं।

•	 Create > Polygon Primitives > Cube > _ सलेक्ट करें ।

•	 विकल्प विंडो में, Edit > Reset Settings सलेक्ट करें  और फिर निम्नलिखित सेट करें :

»	च ौड़ाई: 14
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क्यूब प्रिमिटिव को स्मूथ तथा सबडिवाइड करना

•	 सीन व्यू में क्यूब को सिलेक्ट किये हुए, Mesh > Smooth > _ चुनें, और दिखाई पड़ने वाले विंडो में 

निम्नलिख्ति विकल्प सेट करें :

»	 ऐड डिवीजन: एक्सपोनेंशियली

»	डि वीजन लेवल्स: 2

•	 Smooth बटन पर क्लिक करें

क्यूब प्रिमिटिव स्मूथ किया जाता ह ैऔर चारों कोनो पर गोल बनाया जाता ह।ै क्यूब भी छोटे-छोटे फेसों में 

विभाजित किया गया ह।ै

पॉलीगन (बहुभुज) फेस अब भी चार-भुजाओ ंवाले हैं बावजदू इसके कि उनके आकार और स्थिति स्मूथ ऑपरे शन द्वारा मॉडिफाई किए गए हैं।

6.4.5 शेडेड मोड में मॉडलिंग

शेडेड मोड में पॉलिगन मेश की मॉडलिग आपको 3D वॉल्यूम की बेहतर समझ प्रदान करती ह ैकि मॉडल कैसे ऑक्युपाई करता ह ैऔर कैसे सतह की 

बारीकियां प्रकट होती हैं। 

प्रत्येक व्यू में आप किसी ऑब्जेक्ट की शेडिग नियत्रित कर सकते हैं। उदाहरण के लिए, आप केवल पर्स्पेक्टिव व्यू में शेडेड रूप में ऑब्जेक्ट प्रदर्शित कर 

सकते हैं, और ऑर्थोग्राफिक व्यू को वायरफ्रे म मोड में ऑब्जेक्ट प्रदर्शित करने के लिए सेट कर सकते हैं। साथ ही आप डिस्प्ले सेटिग्स शेडेड और वायरफ्रे म 

डिस्प्ले में एक साथ प्रदर्शित करने के लिए सेट कर सकते हैं।

वायरफ्रे म के शेडेड मोड में हेलमेट मेश प्रदर्शित करना

•	 पर्सपेक्टिव व्यू में, हेलमेट मेश पर राइट क्लिक करें  और दिखाई पड़ने वाले मार्किंग  मेन्यू से ऑब्जेक्ट मोड सलेक्ट करें । इससे स्लेक्शन मोड Objects 

में बदल जाता ह।ै

•	 हेलमेट मेश सलेक्ट करें ।

•	 पर्सपेक्टिव व्यू में, पनैल मेन्यू से Shading > Smooth Shade All सलेक्ट करें । हेलमेट मेश स्मूथ शेडेड मोड में प्रदर्शित होता ह।ै

•	 पनैल मेन्यू से, Shading > Wireframe on Shaded सलेक्ट करें । मेश और शेडिग पर वायरफ्रे म प्रकट होता ह ै(चाहे मेश सलेक्ट किया गया हो या नहीं)।

चित्र 6.4.6: क्यूब प्रिमिटिव स्मूथ किया गया

»	 ऊंचाई: 14

»	 डेप्थ (गहराई): 14

»	च ौड़ाई विभाजन/वर्ग: 1

»	 उंचाई विभाजन/वर्ग: 2

»	ग हराई विभाजन/वर्ग: 1

•	 Create बटन पर क्लिक करें ।

आपके द्वारा निर्दिष्ट डाइमेंशन के साथ मूल (ओरिजिन) तथा मध्य के चारों ओर एक उपखंड (सबडिविज़न) 

पर क्यूब प्रिमिटिव बनाया जाता ह।ै क्यूब प्रिमिटिव में चार-भुजाओ ंवाले पॉलीगन फेस होते हैं जिन्हें क्वाड 

कहा जाता ह।ै क्वाड पॉलीगन का उपयोग 3D कैरेक्टर  मॉडल के साथ बार-बार किया जाता ह ैक्योंकि वे 

आसानी से स्मूथ होते हैं और किसी कंकाल/ढांचें से बाउंड/स्थापित किये जाने पर अच्छी तरह से डिफॉर्म /

विरूपित होते हैं। चित्र 6.4.5: क्यूब प्रिमिटिव
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शडैेड X-Ray मोड में हेलमेट मेश प्रदर्शित करना

•	 हेलमेट के सलेक्ट रहते, साइड व्यू के पनैल मेन्यू से निम्नलिखित चुनें:

•	 Shading > Smooth Shade All

•	 Shading > Wireframe on Shaded

•	 Shading > X-Ray.

हेलमेट मेश वायरफ्रे म के साथ अर्धपारदर्शी शेडेड डिस्प्ले में अपडेट होता ह।ै आप मेश के पीछे  2D इमेज देख 

सकते हैं।

•	 फ्रं ट व्यू के लिए भी पिछले चरण को दुहराएं।
चित्र 6.4.7: शेडेड X-Ray मोड

चित्र 6.4.8: वायरफ्रे म

6.4.6 मॉडल सिमिट्री

•	 जब कभी आप कोई ऑब्जेक्ट मॉडल करते हैं, तो आपको फॉर्म  से उपलब्ध हो रही किसी सिमिट्री का लाभ उठाना चाहिए।

•	 मेश के बाएं अर्धभाग से फेस डिलीट करें

•	 शीर्ष  व्यू में, मेश पर राइट क्लिक करें  और दिखाई पड़ने वाले मार्किंग  मेन्यू से फेस सलेक्ट करें ।

•	 हेलमेट मेश के बाएं अर्धभाग पर फेसेज को सलेक्ट करने के लिए उनके चारों ओर से एक बाउंडिग बॉक्स ड्रैग करें ।

•	डि लीट-की दबाऍ ं

•	 सलेक्ट किए हुए फेस डिलीट हो जाते हैं।

चित्र 6.4.9: मॉडल सिमिट्री
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6.4.7 पेंटिंग द्वारा कंपोनेंट चयन करना
पेंट सिलके्शन टूल की मदद से डिलीट करने के लिए फेस चयन करना

•	 टूलबॉक्स में, पेंट सिलेक्शन टूल आइकन पर क्लिक करें ।

चित्र 6.4.10: पेंट सिलेक्शन टूल आइकन

•	 साइड व्यू में, हेलमेट मेश पर राइट क्लिक करें  और दिखाई पड़ने वाले मार्किंग  मेन्यू से फेस सलेक्ट करें ।

•	 साइड व्यू में, मेश के सामने और निचले भाग में (चित्र देखें) दिखाई पड़ने वाले फेसेज के ऊपर माउस ड्रैग कर फेसेज को पेंट सलेक्ट करें ।

चित्र 6.4.11

•	चयनि त फेसि स को हटाने के लिए Delete की दबाएं।

•	 अपने काम की समीक्षा के लिए पर्सपेक्टिव व्यू को टंबल करें ।

•	 पॉलीगन मेश की बाहरी परिधि के साथ लगे किनारे  जिसे बॉर्डर एज कहा जाता ह,ै मेश पर भीतरी किनारे  की तुलना में एक मोटी लाइन से दर्शाया 

जाता ह।ै पाठ की शुरुआत में आप यह डिस्प्ले सेटिग सेट करते हैं, इसलिए आप इस प्रकार के एजिज़ और अन्य एजिज़ में भेद कर सकते हैं।

6.4.8 एज लूप सलके्ट करना

शीर्ष  व्यू में, X एक्सिस के बिल्कु ल ऊपर और नीचे के एजिज़ की कतारें  और Z एक्सिस की दाई ंकतार सीधी नहीं हैं। आप इन कतारों (जिन्हें एज लपू कहा 

जाता ह)ै में किनारों को Move टूल की मदद से ग्रिड में स्नैप कर संरेखि त करना चाहेंगे। एज लपू उन पॉलिगन एजिज़ का पाथ होती ह,ै जो साझा शीर्ष 

बिदुओ ंसे क्रम में जुड़े  हुए हैं। जब आप पॉलीगन की मदद से मॉडल करते हैं तो एज लपू सिलेक्शन बहुत ही उपयोगी होता ह।ै

हेलमेट मेश पर किनारे संरेखित करना

•	 शीर्ष  व्यू में, मेन मेन्यू से Select > Select Edge Loop टूल का चयन कर पहला क्षैतिज 

एज लपू सलेक्ट करें  जो X एक्सिस के सीधे नीचे दिखाई पड़ता ह,ै और फिर जसैा कि 

ऊपर चित्र में दिखाया गया ह ैएज लपू पर डबल-क्लिक करें । एज लपू सलेक्ट हुआ।

चित्र 6.4.12: एज लूप सलेक्ट करें

•	ग्रि ड इंटरसेक्शन प्वाइंट । जब कई सारे  कंपोनेंट सलेक्ट किए जाते हैं, तो आप उन्हें ग्रिड के जरिए एक ही बार में एक दूसरे  के साथ संरेखि त कर 

सकते हैं।

•	 स्टेटस लाइन पर, आइकन पर क्लिक कर स्नैप टु ग्रिड चाल ूकरें ।
चित्र 6.4.13: आइकन पर क्लिक करें



187186

प्रतिभागी पुस्तिका रोटो आर ट्िस्ट

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

•	 टूलबॉक्स में, मूव टूल पर डबल-क्लिक कर इसकी टूल सेटिग दर्शा एं।

•	 Move Snap सेटिग्स में, Retain कंपोनेंट स्पेसिग सेटिग बंद करें ।

•	 शीर्ष  व्यू में, नीले एरो को मूव टूल मनैिपुलेटर पर नीचे की ओर एक छोटी दूरी तक क्लिक-ड्रैग करें ।

•	 एज लपू तुरंत निचली ग्रिड लाइन में स्नैप होता ह।ै यह उस स्थान पर स्थित नहीं ह ैजहाँ आप चाहते हैं, लेकिन लपू में सभी किनारे  जिन्हें आपने चुना 

ह ैएक दूसरे  से संरेखि त हो जाते हैं।

•	 स्टेटस लाइन पर, आइकन पर क्लिक कर स्नैप टु ग्रिड बंद करें ।

•	 शीर्ष  व्यू में, Move टूल के को एक्टिव रखे हुए ही, मनैिपुलेटर एरो ऊपर की ओर एक छोटी दूरी तक ड्रैग करें  जिससे एज लपू लगभग अपने मूल स्थान 

(जो कि X एक्सिस के नीचे दूसरी ग्रिड लाइन पर होना चाहिए) में स्थापित हो जाए।

•	 ऊपर बताए गए चरणों की मदद से, X एक्सिस से ऊपर दिखाई देने वाले अन्य एज लपू संरेखि त करें  और फिर एज लपू को सीधे Z एक्सिस की दाई ं

ओर संरेखि त करें । (आवश्यकतानुसार, स्नैप टु ग्रिड ऑन या ऑफ करना याद रखें।)

•	 जब आप यह परूा कर लें, तो X तथा Z एक्सिस के निकटतम एज लपू संरेखि त होते हैं।

चित्र 6.4.14: Moov Tool आइकन पर क्लिक करना

चित्र 6.4.15: एज लूप अलाइंड/संरेखित

ऑर्थोग्राफिक व्यूज़ में कंपोनेंट एडिट करना

कंपोनेंट सिलेक्शन और ट्रांसफॉर्मेशन पॉलीगन मेश के आकार को एडिट करने की एक मौलिक विधि ह।ै जब आप मॉडल करते हैं, तो आपको विभिन्न 

सीन व्यूज में काम करते हुए पॉलीगन कंपोनेंट की बार-बार जांच करनी पड़ती ह ैऔर फिर उनकी स्थिति (शीर्ष  बिदुओ,ं किनारों और फेसेज को) को 

सुधारना होता ह ैताकि वे इमेज प्लेन के संदर्भ चित्र से मेल खाएं।

हेलमेट के पीछे शीर्ष बिदुओ ंको मनैुअल रूप से पुनर्व्यवस्थित करना

•	 हेलमेट पर राइट क्लिक करें  और दिखाई पड़ने वाले मार्किंग  मेन्यू से Vertex (शीर्ष  बिदु) सलेक्ट करें ।
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चित्र 6.4.16: शीर्ष बिंद ुचुनें

•	 साइड व्यू में, पीछे  के निचले किनारे  पर (चित्र देखें) शीर्ष  बिदुओ ंको चारों ओर एक बाउंडिग बॉक्स ड्रैग कर वर्टिसिस का एक जोड़ा सलेक्ट करें ।

•	 टूलबॉक्स में, Move टूल पर क्लिक करें ।

•	 साइड व्यू में Move टूल मनैिपुलेटर पर नीले ऐरो को दाई ंओर तब तक क्लिक-ड्रैग करें  जब तक कि शीर्ष  बिदु पुनर्व्यवस्थित न हो जाएं ताकि आपका 

हेलमेट इमेज प्लेन के संदर्भ स्केच  से मेल खाये।

•	सिमि ट्री एक्सिस के अनुरे ख शीर्ष  बिदु और साथ ही इसके बराबर वाला शीर्ष  बिदु मूव करके आप 

यह सुनिश्चित करते हैं, कि हेलमेट की शेप बरकरार रहे।

•	 हेलमेट के पीछे  शीर्ष  बिदुओ ंके अन्य युग्मों के लिए 2 से 4 तक दोहराएं सुनिश्चित करें  कि एज लपू 

एक दूसरे  की तुलना में स्मूथ दिखाई पड़े।

चित्र 6.4.17: स्मूथ दिखता है

•	 साइड व्यू में, हेलमेट के ऊपर तथा सामने स्थित शीर्ष  बिदुओ ंके अन्य युग्म सलेक्ट करें  

और उन्हें एक ही तरह से मूव करें , जिससे वे संदर्भ  चित्र से मेल खाएं। फेश शील्ड के ऊपर 

स्थित शीर्ष  बिदुओ ंको अभी पुनर्व्यवस्थित न करें ।

चित्र 6.4.18: शीर्ष बिंदओुं के अन्य युग्म सलेक्ट करें

हेलमेट पर निचल ेबॉर्डर एज पुनर्व्यवस्थित करना

•	 साइड व्यू में, मेन मेन्यू से Select > Select Border Edge टूल का चयन कर हेलमेट पर सबसे निचला हॉरिज़ॉन्टल एज लपू सलेक्ट करें , और फिर जसैा 

कि नीचे चित्र में दिखाया गया ह ैलपू पर पहले और फिर आखिरी एज पर क्लिक करें ।

•	 Move टूल की मदद से, सलेक्ट किए हुए एज लपू को नीचे की ओर तब तक ड्रैग करें  जब तक की बाई ंओर के शीर्ष  बिदु संदर्भ  स्केच  में दिखाए गए 

निचले किनारे  से मोटे तौर पर मेल न खाने लगें।
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•	 साइड व्यू में, Move टूल की मदद से एज लपू पर स्थित शेष बचे शीर्ष  बिदुओ ंको अलग-अलग सलेक्ट 

और पुनर्व्यवस्थित करें , जिससे वे संदर्भ  सकेच  से मेल खाने लगें।

फेस शील्ड के ऊपरी किनारे पर बॉर्डर एज संपादित करना

•	 सलेक्ट मेन्यू से, Select Border Edge Tool चुनें।

•	 साइड व्यू में, पहले बॉर्डर एज पर क्लिक करें  जिसका उपयोग फेस शील्ड के ऊपरी किनारे  (एज) के रूप 

में होगा, फिर अंतिम बॉर्डर एज पर क्लिक करें । बीच के बॉर्डर एज सलेक्ट हो गए।

•	 टूलबॉक्स में, Rotate टूल के आइकन पर क्लिक कर उसे सलेक्ट करें ।

•	 साइड व्यू में, वामावर्त  (क्लॉकवाइज़) दिशा में रोटेट मनैिपुलेटर को तब तक क्लिक-ड्रैग करें  जब तक 

की बॉर्डर एज मोटे तौर पर उसी कोण से न घमू जाएं जो संदर्भ स्केच  में संगत किनारे  (एज) का ह।ै

•	 बॉर्डर एज सिलेक्ट किये हुए ही, Move टूल पर फिर से क्लिक करें  और हरे  मनैिपुलेटर 

को ऊपर की ओर ड्रैग करें  ताकि वह संदर्भ स्केच  में बॉर्डर एज के स्थान से मेल खाये।

•	 हेलमेट के ऊपरी सम्मुख भाग पर शीर्ष  बिदुओ ं के युग्म पुनर्व्यवस्थित करें  ताकि वे 

संदर्भ  स्केच  से सुमेलित हो जाएं।

चित्र 6.4.19: निचले बॉर्डर एज को पुनर्व्यवस्थित करें

चित्र 6.4.20: बचे हुए शीर्षों को चुनें और स्थान-
परिवर्तन (रीपोज़ीशन) करें 

चित्र 6.4.21: बॉर्डर सिरे (एज) को चुनें 

चित्र 6.4.22: बॉर्डर सिरे को खिसकाएं 

हेलमेट के बगल के हिस्से पर स्थित शीर्ष बिदुओ ं को हेलमेट की साइड पर रीपोज़ीशन/करना, 

जिससे वह स्के च से मेल खाये

•	 फ्रं ट व्यू डिस्प्ले करें ।

•	 फ्रं ट व्यू में, उन सभी शीर्ष  बिदुओ ंका चयन करें  जो हेलमेट की बाह्य रे खा से बाहर स्थित हैं जसैा कि 

संदर्भ स्केच  में दिखाया गया ह।ै 
चित्र 6.4.23: चुनना
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•	 फ्रं ट व्यू में, इन शीर्ष  बिदुओ ंको बाई ंओर ले जाएं जब तक कि वे संदर्भ  स्केच  में हेलमेट के सर्वाध िक 

विस्तृत हिस्से से मेल न खाने लगें।

चित्र 6.4.24: बाईं ओर खिसकाना

6.4.9 पर्सपेक्टिव व्यू में संपादन घटक (एडिटिंग कम्पोनेंट्स)

ओर्थोग्राफिक व्यू की तुलना में पर्सपेक्टिव व्यू में पॉलीगोन कम्पोनेंट्स घटकों का स्थान-परिवर्तन करना अधिक चुनौतीपरू्ण  हो सकता ह ैक्योंकि जसेै ही 

आप 3D व्यू को ट्रैक, डॉली या टम्बल करते हैं वसेै ही आपका फ्रे म ऑफ रे फरें स बदल जाता ह।ै

मेश पर किसी शीर्ष को मेश की दिशा में खिसकाना

•	 मेश का परीक्षण करते समय आप पर्सपेक्टिव व्यू को तब तक डॉली और टम्बल करते 

रहें जब तक कि आपको ऐसे शीर्ष  नहीं मिल जाते जो कि मेश में से अवांछित तरीके से 

बाहर की ओर निकले हुए हों।

चित्र 6.4.25: बाईं ओर खिसकाना

•	 मूव सेटिग एडिटर को प्रदर्शित/डिस्प्ले करने के लिए टूलबॉक्स में मूव टूल पर डबल क्लिक करें ।

•	 मूव सेटिग एडिटर में मूव सेक्शन में नॉर्मल ऑप्शन को ऑन करें ।

चित्र 6.4.26: बाईं ओर खिसकाना

•	 पर्सपेक्टिव व्यू में, आप जिस शीर्ष  का स्थान परिवर्तन करना चाहते हैं उस पर क्लिक करें । शीर्ष 

हाइलाइट हो जाता ह ैऔर मूव मनैीपुलेटर दिखाई देता ह ैजो कि यह दर्शाता ह ैकि इस मोड में तीन 

दिशाओ ंमें मूवमेंट हो सकती ह।ै

•	 U और V हैंडल शीर्ष  को अपने संबंद्ध सिरों के अनुसार स्लाइड करते हैं। जबकि N हैंडल शीर्ष  को या 

तो मेश के नज़दीक ले जाता ह ैया फिर उससे दूर, जिस भी दिशा में आप अपने माउस को मूव करें ।

चित्र 6.4.27: U और v हैंडल
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•	 शीर्ष  की आवश्यकता अनुसार N हैंडल को अंदर या बाहर की तरफ ड्रैग करें । यह करने के बाद मेश का परीक्षण करने के लिए व्यू को डॉली या टम्बल 

करें  और आवश्यक संशोधन करें ।

•	 मेश पर किसी अन्य बाहर या अंदर की ओर के शीर्षों के लिए ऊपर वाले चरण तब तक दोहराएँ जब तक कि मेश स्मूथ नहीं हो जाता ह।ै

•	 अगले सेक्शन पर जाने से पहले मूव टूल पर डबल क्लिक करें  और मूव सेटिग को डिफॉल्ट वर्ल्ड  सेटिग पर वापस ले आएं।

6.4.10 पॉलीगोन बनाना

हेलमेट का सामने का निचला भाग (वह भाग जो हेलमेट पहनने वाले के मँुह और जबड़े की रक्षा करता ह)ै बनाने के लिए आप सामने के निचले भाग के 

क्रॉस सेक्शन के लिए क्रिएट Polygon टूल का इस्तेमाल करके मनुैअल रूप से शीर्षों को रखकर पॉलीगोन बनाएंगे। 

पॉलीगोन के लिए शीर्षों को रखना

•	 साइड व्यू में, Mesh > Create Polygon Tool >Polygon टूल चुनें। क्रिएट Polygon टूल सेटिग्स एडिटर दिखाई देगा।

•	 टूल सेटिग्स एडिटर में निम्नलिखित विकल्पों को सेट करें :

»	बि दुओ ंकी संख्या सीमित रखें: ऑन

»	बि दुओ ंकी सीमित संख्या: 6

•	 स्लाइड व्यू में प्रोफाइल के लिए छह बिदुओ ंको रखें जो कि हेलमेट के सामने के निचले भाग के क्रॉस सेक्शन में दिखाई देते हैं (नीचे तस्वीर देखें)। 

सुनिश्चित करें  कि इस चरण के लिए आप शीर्षों को घड़ी की विपरीत दिशा (एंटी-क्लॉक्वाइज़) में रखें।

•	 पॉलीगोन फेस परूा हो जाने के बाद क्रिएट Polygon टूल को बंद करने के लिए q की दबाएं।

चित्र 6.4.28: मेश को स्मूथ करना

चित्र 6.4.29: पॉलीगोन फेस बनाना
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सामने के निचल ेभाग के लिए पॉलीगोन फेस को बाहर निकालना।

•	 सीन व्यू को एकल/सिगल पर्सपेक्टिव व्यू में विस्तारित/एन्‍लार्ज करें ।

•	 पॉलीगोन फेस को सिलेक्ट किये हुए, Edit Mesh > Extrude चुनें। चयनित फेस पर एक्सट्रू ड मनैीपुलेटर दिखाई देता ह।ै

•	 पर्सपेक्टिव व्यू में, मेश के एक सेक्शन को फेस से (धनात्मक X) लगभग आधी ग्रिड इकाई की दूरी पर बाहर निकालने के लिए मनैीपुलेटर पर नीले 

तीर को ड्रैग करें ।

•	फिर  से एक्सट्रू ड करने के लिए g की दबाएं।

•	र ोटेट मनैीपुलेटर को प्रदर्शित/डिस्प्ले करने के लिए उस बड़े वतृ्त पर क्लिक करें  जो कि मनैीपुलेटर को घेरे  रहता ह ैऔर उसके बाद रे फरें स स्केच  

(तस्वीर देखें) में दिये कोण से एक्सट्रू शन कोण का मिलान करने के लिए एक्सट्रू शन कोण को घुमाने के लिए हरे  वतृ्ताकार मनैीपुलेटर को ड्रैग करें । 

इसके बाद मेश के दूसरे  भाग को बाहर निकालने के लिए दूसरी बार तीर मनैीपुलेटर को ड्रैग करें ।

चित्र 6.4.30: एक्सट्रूडिंग

चित्र 6.4.31: एक्सट्रूशन के कोण को घुमाइए

•	 G की फिर से दबाएं और मेश के एक्सट्रू डेड भाग को खिसकाने, घुमाने या नापने के लिए मनैीपुलेटर का इस्तेमाल करके तीसरा एक्सट्रू डेड क्षेत्र 

बनाएं ताकि रे फरें स की तुलना में आप इसे सही स्थान पर रख सकें ।

चित्र 6.4.32: तीसरा एक्सट्रूडेड भाग बनाना
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एक्सट्रू डेड मेश पर से अनावश्यक फेस हटाना

•	 जब तक आप सामने के निचले भाग को नहीं देख लेते तब तक पर्सपेक्टिव व्यू को टम्बल करते रहें। 

चित्र 6.4.33: आंतरिक फेसों को सिलेक्ट और डिलीट करना

•	 एक्सट्रू शन के दोनों सिरों के फेस सहित हाल ही में एक्सट्रू डेड की गए मेश के अंदर के फेस को 

चुनें। ये फेस निचले भाग के एक्सट्रू डेड भागों को बनाने के लिए आवश्यक थे लेकिन इसके 

बाद ज़रूरी नहीं हैं।

•	चयनि त फेसि स को हटाने के लिए Delete की दबाएं।

•	 जब आपका काम परूा हो जाएगा तब निचले भाग के एक्सट्रू डेड भाग और हेलमेट मेश की बीच 

जगह खाली जगह मौजदू रहेगी।

चित्र 6.4.34: दो मेशों के बीच खाली जगह मौजूद है

हेलमेट मेश के निचल ेकिनारों को बाहर निकालना

•	 पर्सपेक्टिव व्यू में हेलमेट मेश के निचले किनारों को Select > Select Border Edge टूल का इस्तेमाल करके चुनें।

•	 Edit Mesh > Extrude चुनें, इसके बाद ऐसे किनारों की पंक्ति बनाने के लिए जो कि चयनित निचले किनारों पर लंबवत हों, हेलमेट के अंदर की दिशा 

में नीले तीर मनैीपुलेटर को ड्रैग करें । इन किनारों को एक ग्रिड इकाई की गहराई से एक्सट्रू ड करें ।

फेस शील्ड के लिए ऊपरी और साइड के सिरों को एक्सट्रू ड करना

•	 पर्सपेक्टिव व्यू में हेलमेट मेश के ऊपरी और साइड के सिरों को Select > Select Border Edge Tool (नीचे तस्वीर देखें) का इस्तेमाल करके चुनें।

•	 Edit Mesh > Extrude चुनें और इसके बाद सिरों को बनाने के लिए, जो कि फेस शील्ड के ऊपरी और साइड के सिरों पर लंबवत हैं, हेलमेट के अंदर 

की दिशा में नीले तीर को एक्सट्रू ड मनैीपुलेटर पर ड्रैग करें । इन किनारों को एक ग्रिड इकाई की गहराई से एक्सट्रू ड करें

चित्र 6.4.35: ऊपरी और साइड के सिरों को अंदर की तरफ एक्स्ट्र्यूड करें
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रेफरें स स्के च से मिलान करने के लिए शीर्षों को निचल ेऊपरी भाग पर खिसकाएं।

चित्र 6.4.36: ऊपरी और साइड के सिरों को अंदर की तरफ एक्स्ट्र्यूड करें

चित्र 6.4.37: चारों शीर्षों का चयन करें

•	 पर्सपेक्टिव व्यू में हेलमेट पर दायां क्लिक करें  और सिलेक्शन टाइप को वर्टिसिस करने के लिए वर्टेक्स मोड सिलेक्ट करें ।

•	 हेलमेट के निचले सामने वाले भाग के चार शीर्षों को चुनें जो कि समरूपता (नीचे तस्वीर देखें) अक्ष के नज़दीक हैं और मूव टूल का इस्तेमाल करके, 

मूव टूल के हरे  तीर को ड्रैग करके सिलेक्ट किये गये शीर्षों को ऊपर की ओर मूव करें ।

चित्र 6.4.38: शीर्षों को ऊपर की तरफ खिसकाएं

•	निच ले भाग के उन शीर्षों को एडजस्ट करें , जिन्हें ज़रूरत के अनुसार सिलेक्ट करके और मूव करके थोड़ा रीपोज़ीशन करना पड़ सकता ह।ै
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6.4.11 सिरों को जोड़ना (ब्रिजिग)

आगे आप निचले सामने वाले भाग को हेलमेट मेश से जोड़ेगें। आप Bridge विशेषताओ ं(Edit Mesh > Bridge) की सहायता से मेशेस बना सकते हैं जो कि 

मेश के एक या अधिक बॉर्डर एजिज़/सिरों को जोड़ें।

ब्रिज फीचर का इस्तेमाल करते समय आपको ध्यान रखना चाहिए कि:

•	 जोड़े जाने वाले सिरे  एक ही पॉलीगोन मेश में हों। इसका मतलब यह ह ैकि ब्रिज परफॉर्म  करने से पहले आप कम्बाइन फीचर का इस्तेमाल करके दो 

मेशों को एक बनाएं।

•	ब् रिज किये जाने वाले क्षेत्र के दोनों ओर आप बॉर्डर एजिज़ की बराबर संख्या सिलेक्ट करें

हेलमेट के साइड रिजन (क्षेत्र) पर एज लूप्स डालना

•	 Edit Mesh > Insert Edge Loop Tool का चयन करें । इन्सर्ट एज लपू टूल सेटिग्स एडिटर दिखाई देगा।

•	 टूल सेटिग्स एडिटर में निम्नलिखित विकल्पों को सेट करें । पोज़ीशन बनाये रखे: एज से सापेक्ष दूरी

•	 पर्सपेक्टिव व्यू में, नीचे तस्वीर में दिखाए अनुसार सिरे  के नीचे स्थित हेलमेट के साइड रिजन के एज को क्लिक-ड्रैग करें । माउस बटन को छोड़े  

बिना माउस को ऊपर की ओर, लगभग एक तिहाई दूरी तक एज के साथ-साथ ले जाएँ और फिर एज लपू इन्सर्ट करने/डालने के लिए माउस बटन 

को छोड़ दें।

चित्र 6.4.39: साइड एज को ड्रैग करें

•	 इन्सर्ट एज लपू टूल के एक्टिव रखे हुए ही उसी एज के टॉप के निकट स्थित हेलमेट के साइड के भाग को क्लिक-ड्रैग करें  और सिरे  के साथ-साथ 

लगभग दो तिहाई दूरी का एक दूसरा एज लपू इन्सर्ट करें /जोड़ें।

चित्र 6.4.40: साइड एज को ड्रैग करें
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हेलमेट के लोअर फ्रं ट (निचल ेसामने के हिस्से) और साइड रिजन (किनारे वाला क्षेत्र) के बीच ब्रिज 

करना (जोड़ना)

•	 Select > Select Border Edge Tool चुनें और इसके बाद मेश के लोअर फ्रं ट और साइड रिजन के उन 

हिस्सों, जहां आप ब्रिजिग मेश कंस्ट्रक्ट करना चाहते हैं, के बॉर्डर एजिज़ पर क्लिक करें ।

•	 Edit Mesh > Bridge का चयन करें । 

•	ब् रिज ऑप्शन्स विंडो में डिविज़न को 0 पर सेट करें  और उसके बाद ब्रिज क्रिएट करने के लिए Bridge बटन पर क्लिक करें ।

•	सि लेक्ट मोड पर वापस लौटने के लिए q की दबाएं और एजिज़ को अनसिलेक्ट करने के लिए मेश में कहीं भी क्लिक करें ।

6.4.12 मेश में पॉलीगोन जोड़ना/एड करना

हेलमेट पर सुरक्षात्मक फेस शील्ड के लिए आप एपेंड टु पॉलीगोन टूल का इस्तेमाल करके एक बड़ा बहु-पक्षीय (मल्टी-साइडेड) पॉलीगोन बनाएंगे और 

उसके बाद उसे कई सारे  चार साइड वाले पॉलीगोन (क्वाड) में इस प्रकार विभाजित करें गे कि नये पॉलीगोन हेलमेट मेश के मौजदूा फोर-साइडेड टॉपोलॉजी 

से मिलता जुलता हो।

एपेंड टु Polygon Tool का इस्तेमाल करके फेस शील्ड बनाना

•	 पर्सपेक्टिव व्यू को टम्बल करें  ताकि आप फेस शील्ड के चारों तरफ के सभी एजिज़/ सिरों को देख सकें ।

•	 Edit Mesh > Append to Polygon Tool सिलेक्ट चुनें। 

•	 एपेंड टु पॉलीगोन टूल सेटिग्स विंडो में न्यू फेसेस प्लानर को बंद रखें। अगर प्लानर विकल्प ऑन होगा, तो एपेंड टु पॉलीगोन टूल मल्टी-साइडेड 

पॉलीगोन नहीं बना पायेगा, क्योंकि जो एजिज़ आपने सिलेक्ट किये हैं, वे प्लानर भाग नहीं बनाते हैं।

•	 पर्सपेक्टिव व्यू में, जिस मेश को आप एपेंड करना चाहते हैं उसे दर्शाने के लिए हेलमेट मेश टॉप इनर (भीतरी) बॉर्डर एज पर एक बार क्लिक करें  और 

उसके बाद एपेंड ऑपरे शन शुरू करने के लिए उसी सिरे  पर दोबारा क्लिक करें  (नीचे तस्वीर देखें)।

•	 फेस शील्ड के बॉटम एज (निचले सिरे ) पर क्लिक करें  जो कि उस सिरे  के विपरीत ह ैजिस पर आपने अभी-अभी क्लिक किया था। एक पॉलीगोन 

दिखाई देता ह ैजो कि दोनों सिरों/एजिज़ को फैला देता ह।ै

चित्र 6.4.41: सिलेक्ट एजिज़

चित्र 6.4.42: अनसिलेक्ट एजिज़
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6.4.13 पॉलीगोन फेसिस को स्प्लिट करना

•	 फेस शील्ड (नीचे तस्वीर देखें) के ओपनिग के चारों ओर के बचे हुए बॉर्डर एजिज़ को घड़ी की गति की विपरीत दिशा में क्लिक करना तब तक जारी 

रखें जब तक कि आप अंतिम एज/सिरे  तक नहीं पहँुच जाते।

•	 फेस शील्ड की परिधि बॉर्डर एजिज़ पर क्लिक करना खत्म करने के बाद टूल से बाहर निकलने के लिए q की दबाएं।

मल्टी-साइडेड पॉलीगोन परूा हो गया ह ैऔर मौजदूा मेश में जोड़ दिया गया ह।ै मल्टी-साइडेड पॉलीगोन को n-gons भी कहा जाता ह।ै

इस पाठ के शुरुआत में आपने मेश में एज लपू्स डालकर हेलमेट को स्प्लिट किया ह।ै स्प्लिट पॉलीगोन टूल का इस्तेमाल करके आप मेश के परिसीमित 

क्षेत्र/लोकलाइज्‍़ड एरिया को स्प्लिट कर सकते हैं।

फेस शील्ड को वर्टिकली स्प्लिट/लंबवत विभाजित करना

•	 Edit Mesh > Split Polygon Tool >_ चुनें।

»	स्प्लि ट पॉलीगोन टूल सेटिग्स एडिटर दिखाई देता ह।ै

•	नि म्नलिखित विकल्पों को सेट करें :

»	 केवल एज से स्प्लिट करें : ऑन

»	 एज पर स्नैपिग प्वाइंट्स प्रयोग करें : ऑन

»	 स्नैपिग टॉलरें स: 100

चित्र 6.4.43: मेश पर एपेंड होने वाले मल्टी-साइडेड फेस

चित्र 6.4.44: मेश पर एपेंड होने वाले मल्टी-साइडेड फेस
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•	 पर्सपेक्टिव व्यू में कैमरा को टम्बल करें  ताकि आप फेस शील्ड के अपर इनर एजिज़/ऊपरी आंतरिक सिरे  और लोअर इनर एजिज़/ निचले आंतरिक 

सिरे , दोनों देख सकें ।

•	स्प्लि ट शुरुआत को दर्शाने के लिए (नीचे तस्वीर देखें) फेस शील्ड के टॉप इनर एज को क्लिक-ड्रैग करें । वर्टेक्स/शीर्ष  को पोज़ीशन करने के लिए 

माउस को तब तक ड्रैग करें , जब तक वर्टेक्स एज के दाई ंओर रुक न जाये।

•	स्प्लि ट की समाप्ति को दर्शाने के लिए (तस्वीर देखें) हेलमेट मेश के लोअर इनर एज को क्लिक-ड्रैग करें । माउस को दाई ंओर ड्रैग करें , जब तक वर्टेक्स 

एज के दाई ंओर रुक न जाये।

•	 फेस को स्प्लिट करने के लिए y की दबाएं।

•	स्प्लि ट पॉलीगोन टूल को फिर से सिलेक्ट करने के लिए g की दबाएं और फिर नीचे तस्वीर में बताए 

अनुसार अन्य स्थानों पर फेस शील्ड को लंबवत विभाजित/वर्टिकली स्प्लिट करना जारी रखें।

फेस शील्ड को क्षैतिज रूप से विभाजित/हॉरिज़ॉन्टली स्प्लिट करना

•	 पर्सपेक्टिव व्यू में, स्पलिट पॉलीगोन टूल के एक्टिव रहते हुए हॉरिज़ॉन्टल स्प्लिट क्षैतिज की स्टार्ट  लोकेशन दर्शाने के लिए इनर साइड एज को 

क्लिक-ड्रैग करें  (तस्वीर देखें)।

•	 साइड व्यू में, फेस शील्ड के फ्रं ट वर्टिकल बॉर्डर एज को क्लिक-ड्रैग करें  d (यह बॉर्डर एज समरूपता अक्ष (एक्सिस ऑफ सिमिट्री) पर होता ह)ै और 

माउस बटन को एज के साथ-साथ चलाते हुए मध्य-बिदु पर तब छोड़ें जब शीर्ष  स्वाभाविक रूप से स्नैप होते हैं (जसेै कि कोई चंुबक इन्हें उस स्थान 

की ओर आकर्षित कर रहा हो)।

चित्र 6.4.45: इनर एजिज़ को ड्रैग करें

चित्र 6.4.46: एक पांच साइड वाला पॉलीगोन

चित्र 6.4.47: स्प्लिटिंग
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•	 फेसेस को स्प्लिट करने के लिए y की दबाएं।

•	 स्पलिट पॉलीगोन टूल से बाहर निकलने के लिए q की दबाएं।

फेस शील्ड का शेप/आकार एडजस्ट करना

•	 साइड व्यू में, फेस शील्ड के सामने वाले भाग पर स्थित बीच वाले दो शीर्षों का चयन करें  और मूव टूल का इस्तेमाल करके शीर्षों को थोड़ा सा बाहर 

(+Z) की तरफ मूव करें  (तस्वीर देखें)।

•	 पर्सपेक्टिव व्यू में, फेस शील्ड पर बचे हुए बीच वाले शीर्षों को, एक समय में एक, सिलेक्ट करें  और मूव सेटिग ऑप्शन को नॉर्मल पर सेट करके मूव 

टूल का इस्तेमाल करके थोड़ा सा बाहर की ओर रीपोज़ीशन करें ।

•	 अगले चरण पर जाने से पहले मूव टूल के मूव सेटिग्स टू वर्ल्ड  को रिसेट करें ।

चित्र 6.4.48: स्प्लिटिंग

चित्र 6.4.49: फेस शील्ड का आकार एडजस्ट करें 

तिरछे/डायग्नल ग्रिल वेंट्स के लिए मल्टिपल एजिज़ इन्सर्ट करना

•	 Edit Mesh > Insert Edge Loop Tool > _ चुनें।

•	 इन्सर्ट एज लपू टूल ऑप्शंस विंडो में निम्नलिखित सेट करें :

»	 मल्टिपल एज लपू्स: ऑन

»	 एज लपू्स की संख्या: 4

»	 ऑटो कम्प्लीट: ऑफ

ये सेटिग्स आपको उस फेस पर चार समान अंतराल/दूरी वाले एजिज़ इन्सर्ट करने की सुविधा प्रदान करती हैं, जहाँ आप चाहते हैं कि आपके ग्रिल वेंट्स 

दिखाई दें।

•	 पर्सपेक्टिव व्यू में, फेस के बॉर्डर एज को क्लिक करें  जहाँ ग्रिल वेंट्स दिखाई देंगे और उसके बाद उस बॉर्डर एज के ठीक सामने वाले बॉर्डर एज को 

क्लिक करें ।
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•	 एज लपू इंसर्शन परूा करने के लिए y की दबाएं।

•	 एजिज़ को डिसिलेक्ट करने के लिए ऑफ द मेश पर क्लिक करें /मेश को ऑफ करें  ।।

•	 टूल से बाहर निकलने और सिलेक्शन मोड में वापस जाने के लिए q की दबाएं।

ग्रिल वेंट्स के तिरछा/डायग्नल दिखने के लिए आप दाई ंओर से वर्टिसिस सिलेक्ट करें  और मूव टूल का प्रयोग करके उन्हें नीचे की ओर मूव करें ।

मूव टूल का इस्तेमाल करके वर्टिसिस को एज के साथ-साथ मूव करना

•	 हेलमेट मेश पर राइट-क्लिक करें  और सिलेक्शन मोड को बदल कर वर्टेक्स कर दें।

•	ग्रि ल फीचर के दाई ंओर वर्टिसिस सिलेक्ट करें ।

•	 मूव टूल के सेटिग एडिटर को प्रदर्शित/डिस्प्ले करने के लिए मूव टूल आइकन पर डबल क्लिक करें । 

मूव टूल के सेटिग्स एडिटर में Set to Edge बटन पर क्लिक करें । वर्टिसिस अस्थाई रूप से अनसलेक्टेड 

नज़र आते हैं। मूव टूल आपसे अपेक्षा करता ह ैकि आप एक ऐसा एज चुनें, जो मूवमेंट के अक्ष के लिए 

संदर्भ हो।

•	 ऐसे एज पर क्लिक करें , जो उन्हीं एजिज़ की लाइन में हो, जिससे आपने वर्टिसिस सिलेक्ट की ह।ै

•	 मूव टूल मनैीपुलेटर दिखाई देता ह ैऔर आपके द्वारा सिलेक्ट किये गये एज के साथ अलाइन ह।ै वर्टिसिस फिर से सलेक्टेड दिखाई देने लगते हैं, जो 

कि इस बात का संकेत हैं, कि मूव टूल अब उन वर्टिसिस को उस एक्सिस के साथ-साथ मूव करने के लिए सेट ह,ै जो आपके द्वारा सिलेक्ट किये गये 

एज द्वारा परिभाषित ह।ै

•	 वर्टिसिस को मूव करने के लिए लाल तीर को मूव मनैीपुलेटर पर नीचे की ओर ड्रैग करें  ताकि ग्रिल के लिए फेसेस का आकार अधिक तिरछा/

डायग्नल हो सकें ।

चित्र 6.4.50: ग्रिल वेंट्स

चित्र 6.4.51: ग्रिल वेंट्स
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•	 वर्टिसिस को डिसिलेक्ट करने के लिए मेश को ऑफ करें

•	 अगले सेक्शन पर जाने से पहले, मूव टूल पर डबल क्लिक करें  और Reset बटन पर क्लिक करके टूल सेटिग को रिसेट करें ।

ग्रिल फीचर के लिए फेसेस को एक्सट्रू ड करना

चित्र 6.4.52

•	 हेलमेट मेश पर राइट-क्लिक करें  और सिलेक्शन मोड को बदल कर फेसेस करें ।

•	ग्रि ल फीचर के बॉटम/नीचे से शुरुआत करते हुए, तस्वीर में दिखाए अनुसार दो तिरछे  फेसेस को 

शिफ्ट-सिलेक्ट करें ।

•	 Edit Mesh > Extrude चुनें। एक्सट्रू ड मनैीपुलेटर दिखाई देता ह।ै

•	ग्रि ल के लिए दो रिसेस्ड वेंट्स बनाने के लिए हेलमेट की ओर कुछ दूरी तक एक्सट्रू ड मनैीपुलेटर पर 

नीले तीर को ड्रैग करें ।

चित्र 6.4.53: पतले तिरछे फेसों को शिफ्ट-सिलेक्ट करें

चित्र 6.4.54: ग्रिल के लिए दो रिसेस्ड वेंट्स
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6.4.14 एज लूप्स को टर्मिनेट करना

जब आपने ग्रिल वेंट्स के लिए एजिज़ को इन्सर्ट किया तब बराबर वाला फेस चार साइड में से आठ साइड में बदल गया। शेयर्ड  एज/साझा सिरों के साथ हुई 

स्प्लिटिग के चलते ऐसा हुआ।

मल्टी-साइडेड पॉलीगोन को तीन फोर-साइडेड पॉलीगोन में मनै्युअली स्प्लिट करना

•	 Edit Mesh > Split Polygon Tool चुनें।

•	 पर्सपेक्टिव व्यू में टॉप ग्रिल वेंट के टॉप साइड एज पर क्लिक-ड्रैग करें । अपने माउस को ड्रैग करें , जिससे वर्टेक्स एज के बॉटम पर पोज़ीशन हो।

•	 मल्टी-साइडेड पॉलीगोन के सबसे ऊपरी सिरे  को क्लिक-ड्रैग करें  और वर्टेक्स को एज के दाएं सिरे  की ओर स्लाइड करें ।

•	 फेस को स्प्लिट करने के लिए y की दबाएं।

»	 स्पलिट एज के ऊपर का भाग पॉलीगोन की तरह दिखाई देता ह ैलेकिन वास्तव में ग्रिल वेंट पर एजिज़ होने के कारण यह चार साइड वाला ह।ै

•	निच ले ग्रिल वेंट पर साइड एज को अपने माउस से उसी प्रकार क्लिक ड्रैग करके स्प्लिट करें , जिससे वर्टेक्स एज के टॉप पर पोज़ीशन हो।

•	 एक्सट्रू ड फीचर से बाहर निकलने के लिए q की दबाएं।

•	 समरूपता अक्ष पर स्थित ग्रिल वेंट्स के दोनों साइड फेस को शिफ्ट -सिलेक्ट करें  और उन्हें डिलीट 

करे  दें (नीचे तस्वीर देखें)। हेलमेट के विपरीत आधे भाग को बनाने के लिए इन फेसों की ज़रूरत 

नहीं होगी।

•	 अगले खंड में जाने से पहले अपना काम सेव कर लें।

चित्र 6.4.55: दो साइड वाले फेसों को डिलीट करें

चित्र 6.4.56: फेस को स्प्लिट करें
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•	 मल्टी-साइडेड पॉलीगोन के बॉटम एज को क्लिक ड्रैग करें  और वर्टेक्स को एज के दाएं सिरे  पर स्लाइड करें  (तस्वीर देखें) ।

•	 फेस को स्प्लिट करने के लिए y की दबाएं।

आपका मल्टी-साइडेड पॉलीगोन अब तीन फोर-साइडेड फेस में स्प्लिट हो गया ह ैऔर हेलमेट मेश की संपरू्ण  क्वाड टोपोलॉजी वसैी ही बनी हुई ह।ै

•	 स्पलिट पॉलीगोन टूल से बाहर आने के लिए q की दबाएं।

चित्र 6.4.57: साइड एज को स्प्लिट करें

6.4.15 कंस्ट्रक्शन हिस्ट्री को डिलीट करना

अपनी कंस्ट्रक्शन हिस्ट्री के ज़रिये माया ऑप्शंस, एट्रिब्यूट्स तथा किसी ऑब्जेक्ट में किये गये ट्रांस्फॉर्मेशन का ट्रैक रखता ह।ै कंस्ट्रक्शन हिस्ट्री उपयोगी 

ह,ै जब आप सर्फे स पर काम कर रहे हों और मॉडल डिवेलपमेंट के प्रारभिक चरण के किसी एट्रिब्यूट को एडिट करना चाहते हों।

हेलमेट मेश पर कंस्ट्रक्शन हिस्ट्री डिलीट करने के लिए

•	 मेश पर राइट-क्लिक करें  और सेलेक्शन मोड को ऑब्जेक्ट में बदलें और हेलमेट मेश चुनें।

•	च नैल बॉक्स प्रदर्शित करें  यदि यह पहले से नहीं ह,ै तो और इनपुट सेक्शन में प्रदर्शित हो रही हिस्ट्री नोड्स की लिस्ट देंखें।

•	 Edit > Delete by Type > History चुनें।

हेलमेट मेश पर कंस्ट्रक्शन हिस्ट्री डिलीट हो जाती ह।ै देखें कि इनपुट के अंतर्गत आइटमों की सचूी में केवल एक ही आइटम शेष ह ै- polySurfaceShape 

node।

चित्र 6.4.58: कंस्ट्रक्शन हिस्ट्री डिलीट करना
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6.4.16 मेश को मिरर कॉपी करना

जब आप अपने आधे पॉलिगन मॉडल फाइनल कर चुके हों, (और इसका निर्माण इतिहास डिलीट कर देते हैं) तो आप सामने के आधे सिमेट्री के अक्ष पर इसे 

कॉपी करके क्रिएट करना चाहेंगे, जिससे आपके पास परूा मॉडल आ जाये। Mirror Geometry (Mesh > Mirror Geometry) की मदद से आप पॉलिगोन मेश 

की मिरर्ड  कॉपी तयैार कर सकते हैं।

यह सुनिश्चित करने के लिए कि बॉर्डर वर्टिसिस सिमेट्री के अक्ष के साथ-साथ ही हैं।

•	 फ्रं ट व्यू को बड़ा करें , जिससे आप उन वर्टिसिस को देख सकें , जो सिमेट्री के अक्ष के अनुदिश स्थित होते हैं। मेश पर यदि कोई शीर्ष  Y अक्ष के अनुदिश 

बाहर निकला होता ह,ै तो आपको स्नैप टु ग्रिड फीचर के साथ मूव टूल की मदद से इन्हें Y अक्ष तक काटना होगा।

•	 फ्रं ट व्यू में , उन सभी शीर्षों का चयन करें  जिन्हें बाउंडिग बॉक्स चयन की मदद से सममिति अक्ष (Y अक्ष) के अनुदिश स्थित होना चाहिए।

•	 स्टेटस लाइन पर, स्नैप टु ग्रिड चाल ूकरें ।

•	 टूलबॉक्स में, मूव टूल पर डबल-क्लिक करके इसकी सेटिग को प्रदर्शित करें  और सुनिश्चित करें  कि रिटेन कम्पोनेंट स्पेसिग सेटिग बन्द ह।ै फ्रं ट व्यू 

में, लाल ऐरो को दाई ंओर कुछ दूरी तक मूव टूल मनैिपुलेटर पर क्लिक-ड्रैग करें ।

शीर्ष  तत्काल दाई ंओर ग्रिड लाइन तक कट जाता ह।ै शुरुआत में वे उस स्थान पर स्थित नहीं होंगे जहाँ आप चाहते हैं, लेकिन आप देखेंगे वे सभी शीर्ष 

जिन्हें आपने चुना ह,ै संरेखि त/अलाइंड हो जाते हैं।

•	 मनैिपुलेटर को तब तक बाई ंओर ड्रैग करें  जब तक कि वह शीर्ष  Y अक्ष तक स्नैप न हो जाए।

•	 स्टेटस लाइन पर, स्नैप टु ग्रिड बंद करें ।

•	 शीर्षों को अनसिलेक्ट/अचयनित करने के लिए मेश को ऑफ करें ।

पॉलिगोन मेश को मिरर कॉपी करने के लिए

•	 मेश पर राइट-क्लिक करें , सिलेक्शन मोड को ऑब्जेक्ट में बदलें और फिर हेलमेट मेश चुनें।

•	 Mesh > Mirror Geometry > _ चुनें, निम्नलिखित विकल्प सेट करें  और फिर Mirror बटन पर क्लिक करें ।

»	मिरर  डायरेक्श न: -X

»	 असली के साथ विलय: ऑन

»	 शीर्षों का विलय: ऑन

मेश -X के अनुदिश कॉपी हो जाता ह ैताकि मॉडल का सामने का आधा भाग क्रिएट हो सके। दो मेश संयुक्त होकर एक हो जाते हैं और शीर्षों का विलय हो 

जाता ह ैजिससे वे शेयर्ड  हो जाते हैं।

•	 अगले खंड में जाने से पहले अपना काम सेव कर लें।

इस बिदु पर, हेलमेट मॉडल का लो रिज़ोल्यूशन वर्जन परूा हो जाता ह।ै अगले खंड में आप प्रीव्यू देखेंगे कि सबडिव प्रॉक्सी फीचर की मदद से मॉडल हाइ 

रिज़ोल्यूशन पर कैसा नज़र आता ह।ै

चित्र 6.4.59: मैनिपुलेटर ड्रैग करें
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6.4.17 स्मूथेड मेश के साथ काम करना
सबडिव प्रॉक्सी की मदद से हाइ रिज़ोल्यूशन स्मूथेड मॉडल क्रिएट करना

•	 मेश पर राइट-क्लिक करें , सिलेक्शन मोड को ऑब्जेक्ट में बदलें और फिर हेलमेट मेश चुनें।

•	 Proxy > Subdiv Proxy > _ चुनें, और निम्नलिखित सेट करें :

»	डि वीजन लेवल्स: 2

»	मिरर  बिहेवियर: कोई नहीं

»	 सबडिव प्रॉक्सी शेडर: रखिये

•	 Smooth बटन पर क्लिक करें ।

ओरिजिनल मेश की ही पोज़ीशन पर हेलमेट मेश की एक हाइ रिज़ोल्यूशन, स्मूथेड कॉपी बन जाती ह।ै 

इस पोज़ीशन पर दो वर्जनों को देखना संभव होता ह ै(और आप किसी एक को या दोनों को प्रदर्शित 

करने के लिए टॉगल कर सकते हैं) लेकिन इस पाठ में आप हाइ रिज़ोल्यूशन वर्जन का चयन करें गे 

और इसे थोड़ा सा बाई ंओर मूव करें गे।

•	 ऑब्जेक्ट मोड में मेश के दोनों वर्ज़न, हाइ तथा लो रिज़ोल्यूशन को सलेक्ट करें ।

•	 हाइ तथा लो रिज़ोल्यूशन वर्ज़नों के बीच टॉगल करने के लिए की दबाएं (यह 1 की के बाई ंओर 

होती ह)ै

•	 दोनों वर्जनों की बीच डिस्प्ले टॉगल करना तब उपयोगी होता ह ैजब आप किसी एक या दूसरे  को 

देखना चाहते हैं।

•	डि स्प्ले टॉगल करने के लिए ~ की दबाएँ जिससे दोनों दुबारा दिखाई देने लगते हैं।

•	 ऑब्जेक्ट मोड में केवल स्मूथ वर्जन सलेक्ट करें  और इसे लगभग 25 यनूिट (X = -25) बाई ंओर खिसकाएँ।

•	 ज्योंही आप हेलमेट मेश के लो रिज़ोल्यूशन वर्जन को एडिट करते हैं आपको इसके पीछे  स्मूथ वर्जन पर इससे होने वाले अपडेट दिखाई देंगे।

चित्र 6.4.60: संपूर्ण मॉडल का निर्माण करें

चित्र 6.4.61

चित्र 6.4.62: स्मूथ वर्जन खिसकाएँ/मूव करें



207206

प्रतिभागी पुस्तिका

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

6.4.18 मेश पर एजिज़ की क्रीजिग और हार्डेनिग

आप अपने पॉलिगोन मेश के एजिज़ को क्रीज़ और हार्डेन कर सकते हैं। एजिज़ की हार्डेनिग और क्रीजिग यह तय करता ह ैकि फेसि स/पषृ्ठों के बीच मेश 

ट्रांजिशन किस प्रकार आपके मॉडल की वास्तविकता को बढ़ाता ह।ै

मेश पर हार्ड और सॉफ्ट एज प्रदर्शित करने के लिए

•	 लो रिज़ोल्यूशन मेश पर राइट-क्लिक करें , सिलेक्शन टाइप को ऑब्जेक्ट मोड में बदलें और फिर हेलमेट मेश चुनें।

•	 Display > Polygons > Soft/Hard Edges चुनें।

हेलमेट पर वायरफ्रे म मेश डैश्‍ड तथा सॉलिड, दोनों लाइनें डिस्प्ले करने के लिए अपडेट हो जाता ह।ै डैश्‍ड लाइनें उन एजिज़ को इंगित करती हैं, जिन्हें 

सॉफ्ट शेडिड के रूप में डिस्प्ले करने के लिए सेट किया गया ह।ै सॉलिड लाइंस उन एजिज़ को इंगित करती हैं, जिन्हें हार्ड  शेडिड के रूप में डिस्प्ले करने 

के लिए सेट किया गया ह।ै

•	 मेश पर एजिज़ को सॉफ्ट करना

•	 हेलमेट के लो रिज़ोल्यूशन वर्ज़न को सलेक्ट किये हुए ही Normals > Soften Edge का चयन करें ।

हेलमेट मेश पर सभी एजिज़ सौम्य तरीके से शे‍ड करने के लिए सेट किए गए हैं। वायरफ्रे म मेश डैश्‍ड लाइंस के रूप में डिस्प्ले होने के लिए अपडेट हो जाता 

ह,ै जो कि इस बात का संकेत ह,ै कि सभ एजिज़ को सॉफ्ट शेड के लिए सेट किया गया ह।ै

फेस शील्ड के आस-पास के एजिज़ को कठोर/हार्डन करना

•	 लो रिज़ोल्यूशन मेश पर दायाँ क्लिक करें  और एज को सिलेक्शन मोड पर सेट करें ।

•	 फेस शील्ड की परिधि के आस-पास आंतरिक किनारों/इनर एजिज़ को सलेक्ट करें  ।

चित्र 6.4.63: सॉलिड और डैश्‍ड फ्रे म लाइनें

चित्र 6.4.64: डैश्‍ड फ्रे म लाइनें
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कीप हार्ड एज एट्रिब्यूट ऑन करना

•	 पर्सपेक्टिव व्यू में हेलमेट मेश का केवल स्मूथेड हाइ रिज़ोल्यूशन वर्ज़न सलेक्ट करें ।

•	च नैल बॉक्स में इनपुट सेक्शन में इसके एट्रिब्यूट्स प्रदर्शित करने के लिए लिस्टेड प्रॉक्सी पर क्लिक करें ।

•	 कीप हार्ड  एज एट्रिब्यूट ऑन पर सेट करें ।

अब स्मूथेड हाइ रिज़ोल्यूशन वर्ज़न पर फेस शील्ड और शेष हेलमेट के बीच शार्पर ट्रांज़िशन दिखाई देता ह।ै

•	ग्रि ल वेंट्स के लिए सभी एजिज़ सलेक्ट करें  और उन्हें भी हार्डन /कठोर करें ।

चित्र 6.4.65

चित्र 6.4.66: एजिज़ को हार्ड करना

मेश पर एजिज़ को क्रीज़ करना

•	 फेस शील्ड पर निम्न बाह्य किनारों/लोअर आउटर एजिज़ का चयन करें  (छवि देखें)।

•	 Edit Mesh > Crease Tool का चयन करें ।

•	 सीन व्यू में बीच का माऊस बटन दबाएँ और सलेक्ट किये हुए एजिज़ पर क्रीज़ एड करने के लिए माउस को दाई ंओर ड्रैग करें ।

•	 अपना काम सेव करें ।
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चित्र 6.4.67: मोटी लाइनें नज़र आना
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यूनिट 6.5: NURBS मॉडलिंग

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 Maya सॉफ्टवेयर-NURBS पर 3D एनिमेशन तकनीक के एप्लिकेशन में।

2.	 NURBS मॉडलिग पर Maya के साथ काम करना।

6.5.1 परिचय 

NURBS (नॉन-यनूिफॉर्म  रे शनल B-स्प्लाइंस) कर्व्स और सर्फे स को गणितीय रूप से वर्णित करने की विधि का उपयोग करता ह ैजो 3D एप्लिकेशन के 

लिए उपयुक्त होती हैं। NURBS, उनके द्वारा बनाए जाने वाले स्मूथ आर्गेनिक फॉर्म्स के द्वारा जाने जाते हैं।

NURBS सतहों को विभिन्न तकनीकों के ज़रिए तेज़ी से मॉडल और एडिट किया जा सकता ह।ै NURBS सतह को एक या उससे अधिक NURBS कर्व का 

उपयोग करके बनाया जाता ह ैजो आपकी वांछित सतह के लिए आकार की प्रोफाइल को निर्धा रित करते हैं और फिर एक विशिष्ट निर्माण विधि का प्रयोग 

करके फिनिश्‍ड सर्फे स की रचना की जाती ह।ै

NURBS सतह बनाने की सरल तकनीक ह ैवांछित फॉर्म  के प्रोफाइल के लिए कर्व का निर्माण करें  और फिर Maya में उपलब्ध विभिन्न NURBS सर्फेसि ग 

टूल्स में से किसी एक का उपयोग करके सर्फे स का निर्माण करना। इस अध्याय में NURBS कर्व और रिवोल्व टूल का उपयोग करके आप एक एग होल्डर 

बनाते हैं।

यूनिट के उद्देश्य  

6.5.2 प्रोफाइल कर्व का निर्माण करना

रिवोल्व कुम्‍हार के घमूते पहिये से बर्तन को आकार देने की तकनीक के समान ही एक सामान्य मॉडलिग तकनीक 

ह।ै आपको सबसे पहले ओर्थोग्राफिक व्यू में एक प्रोफाइल कर्व का निर्माण करना चाहिए और सर्फे स बनाने के लिए 

रिवोल्‍व टूल का उपयोग करें ।

प्रोफाइल कर्व का निर्माण करना

•	 सुनिश्चित करें  कि आपने पषृ्ठ 165 पर “अध्यायों के लिए तयैार करना” में दिए गए चरणों को परू्ण  कर 

लिया किया ह।ै

•	 सीन के मल्टिपल व्यूज़/कई सारे  दृश्य देखने के लिए Panels > Layouts > Four Panes का चयन करें ।

चित्र 6.5.1: कर्व का निर्माण करना

चित्र 6.5.2: प्रोफाइल कर्व बनाना
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•	 Create > CV Curve Tool का चयन करें । कर्व ड्रॉ करने के लिए उपयोग किया जाने वाला यह टूल सबसे आम टूल ह।ै 

•	 फ्रं ट व्यू में चित्र में दिखाए अनुसार, नम्बर्ड  पोज़ीशंस पर क्लिक करें । सुनिश्चित करें  कि पहली और अंतिम स्थितियाँ ग्रिड के Y अक्ष (फ्रं ट व्यू ग्रिड की 

सबसे माटी वर्टिकल लाइन) पर हों। 

पोज़ीशन 9, 10 तथा 11 के लिए एक ही जगह पर तीन बार क्लिक करें । कर्व में शार्प  प्वाइंट/तीक्ष्ण बिन्दु या कोना बनाने के लिए यह ज़रूरी ह।ै

आखिरी क्लिक किए गए बिन्दु की स्थिति बदलने के लिए आप इसे माऊस के बीच के बटन से ड्रैग कर सकते हैं। 

•	 सीन व्यू में जिन बिन्दुओ ंपर आपने क्लिक किया वे परूे  हुए कर्व के कंट्रोल वर्टिसिस (CV) बन जाते हैं।

6.5.3 रिवोल्व सर्फे स का निर्माण करना

•	 आउट लाइनर में सचूी में आपके रिवोल्‍व किये गये कर्व (curve1) को इसके नाम पर 

क्लिक करके चुनें। सीन व्यू में कर्व प्रकाशित हो जाता ह।ै

•	 फ्रं ट व्यू में राइट-क्लिक करें  और मार्किंग  मेन ूसे कंट्रोल वर्टेक्स का चयन करें । कर्व के 

लिए CV दिखाई देगा।

•	 अपनी आवश्यकता के अनुसार कर्व के आकार को एडजस्ट करने के लिए एक या 

अधिक CV का चयन करें  और मूव करें । ।

अगर आपको फ्रं ट व्यू में CV के चयन में समस्या होती ह ैतो इसे पर्सपेक्टिव व्यू में कैमरा को 

आवश्यकतानुसार डॉली और टंबल करके सलेक्ट करें ।

इससे एग होल्डर के आकार में बदलाव आता ह ैक्योंकि यह इसकी कंस्ट्रक्शन हिस्ट्री के ज़रिये 

कर्व के आकार से जुड़ा ह/ैलिक्‍ड ह।ै

•	 ज़रूरत हो, तो सीन को भविष्य में समीक्षा के लिए सेव करें ।

•	 आउटलाइनर विंडो बंद करें ।

रिवोल्व सर्फे स टूल के साथ सर्फे स बनाने के लिए कर्व को अक्ष पर रोटेट किया जाता ह।ै उपयोगकर्ता  रिवोल्यूशन के अक्ष को निर्धा रित कर सकता ह।ै

रिवोल्व सर्फे स का निर्माण करना

•	 कर्व को सलेक्ट रखे हुए ही Surfaces > Revolve का चयन करें । यह रिवोल्वड प्रोफाइल कर्व से एग होल्डर सर्फे स का निर्माण करता ह।ै पर्सपेक्टिव 

व्यू में परिणामों का परीक्षण करें । 

Maya प्रोफाइल कर्व को डिलीट नहीं करता। बाद के चरणों में आप सर्फे स के आकार को बदलने के लिए प्रोफाइल कर्व को संपादित करें गे।

•	 सर्फे स का चयन करें  और चनैल बॉक्स में इसका नाम बदलकर एगहोल्डर करें ।

•	 प्वांइटर को पर्सपेक्टिव व्यू में रखे हुए, 5 दबाएँ (Shading > Smooth Shade All के लिए)।

यह एग होल्डर को पर्सपेक्टिव व्यू में वायरफ्रे म की बजाय शेडेड सर्फे स के रूप में प्रदर्शित करता ह।ै

कंस्ट्रक्शन हिस्ट्री के साथ सर्फे स को एडिट करना 

•	 Window > Outliner का चयन करें । आउटलाइनर दिखाई देता ह ैऔर सीन में आइटम्स की सचूी को प्रदर्शित करता ह।ै

चित्र 6.5.3: कंस्ट्रक्शन हिस्ट्री
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6.5.4 NURBS सर्फे स स्क्ल्प्ट करना

6.5.5 आसानी से दखेने के लिए सर्फे स सामग्री/मटैीरियल को संशोधित करना

स्फेयर  (वतृ्त) को स्क्ल्प्ट करने के लिए तयैार करना

•	 सुनिश्चित करें  कि आपने पषृ्ठ 165 पर “अध्यायों के लिए तयैार करना” में दिए गए चरणों 

को परू्ण  कर लिया किया ह।ै

•	 Create > NURBS Primitives > Sphere > सलेक्ट करें । options window में Edit > Reset 

Settings सलेक्ट करें  और निम्न वलै्यू एंटर करें :

»	रेडिय  स (त्रिज्या): 6

»	 सेक्शन की संख्या: 30

»	 स्पैंस की संख्या: 30

•	रेडिय  स ग्रिड यनूिट्स में स्फेयर  का आकार सेट कर देता ह।ै वलै्यू 6 रखने से इतना बड़ा 

स्फेयर  बन जाता ह,ै कि इसके आाकर की तुलना के लिए ग्रिड प्रयोग की जा सके।

•	 स्फेयर  एगहेड का का नाम रखें। 

•	 स्फेयर  को इसकर साइड पर 90 डिग्री रोटेट करें  (Z को घुमाएँ: 90)। इससे स्फेयर  का CV 

एक साधारण सिर तथा चेहरा मॉडल करने के लिए बिल्कु ल ठीक से पोज़ीशन हो जाता ह।ै 

इसका कारण आप बाद में इस अध्याय में जानेंगे।

•	 एगहेड को अंडे का आकार देने के लिए स्फेयर  के लिए ScaleX को 1.3 या इसी के लगभग 

पर सेट करें ।

चूंकि आप इस अध्याय में सहज सर्फे स मॉडलिग करें गे, एगहेड को ब्राइट हाइलाइट्स के साथ डिस्प्ले करना अच्छा रहेगा, जिससे आप अपने द्वारा किये 

गये बदलावों का प्रभाव स्पष्ट रूप से देख सकें ।

Blinn सर्फे स मटैीरियल असाइन करना

•	 एगहेड को सलेक्ट किये हुए स्मूथ शेडिग वाला सर्फे स डिस्प्ले करने के लिए 5 दबाएं।

•	 एगहेड पर राइट-क्लिक करें  और Assign New Material > Blinn का चयन करें । ब्लिन मटैीरियल के लिए एट्रिब्यूट एडिटर तुरंत प्रदर्शित होगा।

•	 कलर एट्रिब्यूट स्लाइडर को दाई ंओर लगभग 3/4 ड्रैग करें , इसेंट्रिसिटी को 0 पर सेट करें  और विंडो को बंद कर दें।

चित्र 6.5.4: प्रोफाइल कर्व बनाना

चित्र 6.5.5: स्फे यर तैयार करें

चित्र 6.5.6: एगहेड
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6.5.6 मूलभूत संरचना निर्माण तकनीक बुनियादी/बेसिक स्कल्प्टिंग तकनीकें

बेसिक स्कल्प्टिंग ऑप्रेशंस से बेसिक स्कल्प्टिंग का अभ्यास करना

•	 एगहेड को सलेक्ट किये हुए ही, Edit NURBS > Sculpt Geometry Tool सलेक्ट करें । टूल सेटिग्स विंडो में रीसेट क्लिक करें  और सुनिश्चित करें  कि 

स्कल्प्ट परैामीटर्स डिस्प्ले हों। 

•	 सर्फे स पर प्रत्येक चार ऑप्रेशंस के साथ प्रयोग करें । परिणाम के बारे  में चिता न करें । बस अपने माऊस के स्ट्रोक की प्रतिक्रिया से परिचित हों जाएं।

•	 इरेज़  ऑपरे शन का चयन करें  और Flood बटन पर क्लिक करें । यह आपके सारे  परिवर्तनों को मिटा देगा।

•	 पुल ऑप्रेशन सलेक्ट करें  और 0.25 का रेडिय स (U) एंटर करें , फिर बिना एक दूसरे  को क्रॉस किये होरिज़ॉन्टल आइसोपार्म्स के एक जोड़े के बीच  

ड्रैग करें । 

इसका कोई प्रभाव नहीं होता, क्योंकि स्ट्रोक रेडिय स का किसी भी आइसोपार्म्स के CV से  

कोई संपर्क  नहीं हुआ। आप किसी भी ऑपरे शन का उपयोग करें , केवल CV ही स्ट्रोक से प्रभावित 

होते हैं। 

•	रेडिय  स (U) को 2 करें  और पहले वाले स्ट्रोक्स दोहराएं ।

•	 आपके द्वारा सर्फे स पर पहले किए गए बदलावों को फ्लड इरे ज़ करें

•	 0.5 के रेडिय स (U) के साथ पुल ऑप्रेशन सलेक्ट करें । वर्टिकल आइसोपार्म्स के साथ ड्रैग 

करें । तुलना करने के लिए एक होरिज़ॉन्टल आइसोपार्म्स भी साथ में ड्रैग करें ।

इस चित्र का स्नैपशॉट लेने से पहले हम डिस्प्ले टेब पर शेडेड पर वायरफ्रे म को नन/None पर 

सेट करते हैं (Window > Setting/Preferences > Preferences)। यह सर्फे स आइसोपार्म्स की 

हाइलाइटिग को बंद कर देता ह,ै जिससे सर्फे स के परिवर्तनों को देखना आसान हो जाता ह।ै 

जसेै आप स्कल्प्ट जियोमेट्री टूल के बारे  में सीखते हैं, शो वायरफ्रे म के लिए ऑन और ऑफ 

सेटिग्स को बदलने पर विचार करें ।

•	 आपके द्वारा सर्फे स पर पहले किए गए बदलावों को फ्लड इरे ज़ करें

•	 कैमरा व्यू को इस तरह रोटेट करें , कि घुमाएँ कि व्यू एक्सिस का X अक्ष आपकी तरफ हो। फिर से एक वर्टिकल पुल स्ट्रोक ड्रॉ करें । 

•	 सभी परिवर्तनों को फिर से इरे ज़ करें , फिर कैमरा को नये व्यू में रीपोज़ीशन करें , जिससे व्यू एक्सिस का Z अक्ष आपकी तरफ हो।

चित्र 6.5.7: NURBS संपादित करें

चित्र 6.5.8: त्रिज्या बदलें

चित्र 6.5.9: शेडेड पर वायरफ्रे म
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अतिरिक्त स्कल्प्टिंग तकनीकों का अभ्यास करना

स्कल्प्ट जियोमेट्री टूल के स्कल्प्ट परैामीटर सेक्शन में मकै्स डिस्प्लेसमेंट को 2 पर सेट करें ।

•	 एक वर्टिकल पुल स्ट्रोक ड्रॉ करें ।

•	 मकै्स डिस्प्लेसमेंट को बदलकर 1 कर दें।

•	 पास में ही एक और वर्टिकल स्ट्रोक ड्रॉ करें ।  मकै्स डिस्प्लेसमेंट वह अधिकतम दूरी तय करता ह,ै जितना कि सर्फे स के CVs को एक सिगल स्ट्रोक 

के साथ पुश (या पुल) किया जा सकेग ा। 

•	 सर्फे स के परिवर्तनों को इरे ज़ करें ।

•	 मकै्स डिस्प्लेसमेंट को 2 पर सेट करें ।

•	 एक वर्टिकल पुल स्ट्रोक ड्रॉ करें ।

•	 ओपेसिटी को उसकी डिफॉल्ट वलै्यू 1 से बदलकर 0.2 पर सेट कर दें।

•	 पास में ही एक और वर्टिकल स्ट्रोक ड्रॉ करें ।

»	 एक रिज दूसरे  से उंची ह।ै ओपेसिटी वलै्यू मकै्स डिस्प्लेसमेंट के प्रभाव को मापती ह।ै 

उदाहरण के लिए 0.2 ओपेसिटी के साथ हर स्ट्रोक में मकै्स डिस्प्लेसमेंट सेटिग का इफैक्ट 

लगभग केवल 0.2 गुना ही होगा। । 

»	 आमतौर पर पुश या पुल करते समय लो ओपेसिटी वलै्यू प्रयोग करना सबसे अच्छा होता ह।ै 

आप अनेक स्ट्रोक्स के साथ विरूपण को धीरे  धीरे  बढ़ा सकते हैं।

»	 अगर आप सर्फे स के सिर्फ  छोटे से क्षेत्र को प्रभावित करना चाहते हैं तो उस क्षेत्र में स्ट्रोक 

करने के बजाए क्लिक करने के लिए अपने माऊस का उपयोग करें । अगर ब्रश का रेडिय स 

और ओपेसिटी कम हैं तो आपको दो आइसोपार्म्स के निकटतम विच छ्ेदन बिन्दु पर क्लिक 

करने की ज़रूरत होगी।

•	 ओपेसिटी 1 पर सेट किये हुए सर्फे स के सभी परिवर्तनों को मिटा दें ।

चित्र 6.5.10

चित्र 6.5.11: शेडेड पर वायरफ्रे म



215214

प्रतिभागी पुस्तिका

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

6.5.7 नाक की रचना करना

6.5.8 आई सॉकेट की रचना करना/बनाना

अब आप साधारण सी नाक बनाने के साथ एगहेड का चेहरा बनाना शुरू करें गे।

कैरेक्टर के लिए नाक की रचना करना

•	 पर्सपेक्टिव व्यू को इस तरह स्थित करें  कि व्यू एक्सिस का Z-अक्ष आपकी तरफ प्वाइंट कर 

रहा हो।

•	 स्कल्प्ट जियोमेट्री टूल को रीसेट करें ।

•	 पुल ऑपरे शन का चयन करें  और निम्नलिखित विकल्पों को सेट करें । त्रिज्या: 1Opacity: 

0.2

•	ग ौसियन ब्रश प्रोफाइल सेटिग का चयन करें  ताकि आपके स्ट्रोक में सॉफ्ट, फेडेड एज हों: 

•	 एगहेड के बीच के बिन्दु के ऊपर से, नाक के ऊपर से नोक तक – लगभग दो होरिज़ॉन्टल 

आइसोपार्म्स के बीच की दूरी के बराबर - वर्टिकली स्ट्रोक करें  (निम्न इलस्ट्रेशन देखें)। 

नाक के ब्रिज को बनाने के लिए कई स्ट्रोक का उपयोग करें । कुछेक बार नाक की नोक के 

आइ सॉकेट ऑखंों के लिए इनसेट (ऑखंें बिठाने के लिए जगह) तथा बकैड्रॉप उपलब्ध कराता ह।ै

कैरक्टर के लिए आइ सॉकेट बनाना 

•	 पुश ऑपरे शन सिलकै्ट करें । 

•	 बाकी सटैिग्स वसेै ही रहने दें, जसेै नोज़ के लिए रखी थीं।

•	 एक जसेै आई सॉकेट का जोड़ा बनाने के लिए टूल सेटिग्स विंडो में स्ट्रोक सेटिग्स डिस्प्ले करें  

और रिफ़्लेक्शन ऑन करें ।

•	 रिफ़्लेक्शन एक्सिस को X पर सेट करें  और स्कल्प्ट आइकॉन को एगहेड पर स्थित करें । 

एगहेड पर पुश आइकॉन का एक समान जोड़ा दिखाई देगा। 

•	 आई सॉकेट के लिए अपेक्षित पोज़ीशन एडजस्ट करें । वांछित जगह पर कई बार माउस  

क्लिक करें । 

6.5.9 आइब्रोज़ की रचना करना/बनाना

आइब्रोज़ से यह निर्धा रित होता ह ैकि चेहरा कितना कठोर या सौम्य दिखाई देगा।

कैरक्टर के लिए आइब्रोज़ की रचना करना

•	 पुल ऑपरे शन सिलकै्ट करें । रिफ़्लेक्शन समेत, वही ऑप्शन सेटिग्स प्रयोग करें , जो आइ सॉकेट के लिए की थीं।

•	 स्कल्प्ट आइकॉन्‍ को आँखों के ऊपर स्थिति करें  और क्षैतिज/हॉरिज़ॉन्टल स्ट्रोक्स ड्रॉ करें । आवश्यकता होने पर उन जगहों पर क्लिक करें  जहां आप 

आइब्रो बनाना चाहते हैं। आवश्यकतानुसार आइब्रोज़ को स्मूथ करें ।

चित्र 6.5.12: नाक की रचना करना

दाहिनी तरफ और फिर कुछेक बार बाई ंतरफ होरिज़ॉन्टल स्ट्रोकिग से नथुने (नोस्ट्रिल्स) बनाएं।

चित्र 6.5.13: आइ सॉकेट की रचना करना/बनाना
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6.5.10 मुँह की रचना करना/बनाना

इस अध्याय में मूलभतू क्षेत्र के लिए निर्दिष्ट 30 सेक्शनों और 30 स्पैन्स के साथ मँुह के क्षेत्र में 

आइसोपार्म्स के बीच की बड़ी सी जगह होंठों को कोई सौम्यँ आकार देना असंभव बना देती ह।ै

•	 इस समस्या से निपटने के लिए, मँुह की रचना शुरु करने से पहले आपको मँुह वाले क्षेत्र 

में आइसोपार्म्स ज़रूर डालने चाहिएं।

अतिरिक्त आइसोपार्म डालने (इन्सर्ट) के लिए

•	 एगहेड पर राइट-क्लिक करें  और मार्किंग  मनै्यू से आइसोपार्म  सिलकै्ट करें ।

•	 टूलबॉक्स से सेलेक्ट टूल का चयन करें ।

•	 नाक के नीचे क्षैतिज आइसोपार्म  पर क्लिक करें  और इससे नीचे अगले दो पर शिफ़्ट-

क्लिक करें , जिससे ये पीले हो जाएं।

•	 Edit NURBS > Insert Isoparms > चुनें। ऑप्शंनस विंडो में बिट्वीन सेलेक्शंस ऑन करें , 

#आइसोपार्म्स टु इन्सर्ट के लिए 2 एंटर करें  और फिर इन्सर्ट पर क्लिक करें ।

यह कुल चार अतिरिक्त आइसोपार्म्स के लिए, सिलकै्टस किये गये आइसोपार्म्स के हर जोड़े के 

बीच में दो अतिरिक्तय आइसोपार्म्स इंसर्ट कर देता ह।ै यह मँुह के क्षेत्र में सौम्यता पदैा करने के 

लिए पर्याप्त सीवी प्रदान कर देता ह।ै

चित्र 6.5.14: आइब्रोज़ की रचना करना/बनाना

चित्र 6.5.15: मुँह गढ़ना/की रचना करना

चित्र 6.5.16: अतिरिक्त आइसोपार्म्स

चित्र 6.5.17: आइसोपार्म्स डालें/इंसर्ट करें
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कैरक्टर/पात्र/किरदार के लिए मुँह की रचना करना

•	 पुनः स्कल्प्ट जियॉमेट्री टूल सिलकै्ट करें । 

•	 पुश ऑपरे शन सिलकै्ट करें । रेडिय स (U) के लिए 0.2 एंटर करें । सुनिश्चित करें  कि स्ट्रोक 

टबै में रिफ्लेशन ऑन हो। 

•	 होंठों के बीच निशान के लिए उपयुक्त क्षेत्र के बीच से शुरू करते हुए, मध्य से बाहर की 

ओर स्ट्रोक करें । सबसे बढ़िया यह रहेगा, कि एक दूसरे  के ऊपर डुऍल आइकॉन (दूसरे  

शब्दों में, केवल एक ही आइकॉन दिखाई देता ह)ै से स्ट्रोक करना शुरू करें  । 

•	 पुल ऑपरे शन सिलकै्ट करें  और रेडिय स (U) को 0.3 पर सेट करें । पहले वाले चरण के 

लिए इस्तेकमाल की गई तकनीक से ही ऊपर वाला होंठ स्ट्रोक करें । निचले होंठों के 

लिए यही दोहराएँ।

6.5.11 चेहरे की अन्य विशेषताओ/ंमुखाकृतियों को गढ़ना

अब आपके पास अन्य मुखाकृतियॉ ंजोड़ने का विकल्प ह।ै इन सुझावों पर विचार करें :

•	 ठोड़ी, गाल और माथे जसैी मुखाकृतियों के लिए 1 से अधिक रेडिय स का उपयोग करें  और मकै्सिमम डिस्लेकर 

समेंट को 0.5 और 1 के बीच रखकर शुरु करें ।

•	 जहॉ ंभी आप कुछ अतिरिक्तस विशिष्टृता डालना चाहें, स्कल्प्ट जियॉमेट्री टूल के साथ आइसोपार्म  इंसर्ट करें ।

अपने दृश्य में पहल ेसे मौजूद मॉडल्सव इम्पोर्ट करने के लिए

अगर आपने पिछले अध्याय में एगहोल्डर दृश्य/सीन सेव किया था, तो आप इस एगहेड दृश्य में एग होल्डर इम्पोर्ट  कर 

सकते हैं और फिर एगहेड को एग होल्डर में पोज़ीशन/स्थित कर दें।

•	 एग होल्डर को एगहेड दृश्य में इम्पोर्ट  करने के लिए फ़ाइल > इम्पोर्ट  और फिर एगहोल्डर वाले दृश्य का नाम 

सिलकै्टे करें । दृश्य को इम्पोरर्ट  करने पर उस दृश्य से सभी ऑब्जेक्ट्स  इम्पोहर्ट हो जाते हैं।

•	 स्नग फिट के लिए आवश्यकतानुसार एग होल्डर (या एग हेड) के स्के ल को बढ़ाएँ (या घटाएँ)

चित्र 6.5.17: आइसोपार्म्स डालें/इंसर्ट करें

चित्र 6.5.18: चेहरे की अन्य 
विशेषताओं/मुखाकृतियों को गढ़ना

टिप्पणियां 

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
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यूनिट 6.6: एनिमेशन

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 Maya सॉफ्टवेयर – एनिमेशन पर 3D एनिमेशन तकनीकों के एप्लिकेशन में

6.6.1 परिचय

6.6.2 प्लेबकै रें ज सेट करना

जब आप कोई कीफ्रे म (या की) सेट करते हैं तो आप ऑब्जेक्ट की विशेषताओ ं(उदाहरण के लिए, ट्रॉं स्लेट, रोटेट, स्के ल, कलर आदि) को एक निर्दिष्ट समय 

पर एक वलै्यू (मान) असाइन करते हैं।

अधिकांश एनिमेशन प्रणालियाँ, फ्रे म को माप की मूलभतू यनूिट के तौर पर उपयोग करती हैं क्योंकि हर फ्रे म को गति का भ्रम पदैा करने के लिए एक के 

बाद एक तुरंत चलाया जाता ह।ै

एनिमेशन को चलाने के लिए उपयोग किया जाने वाला फ्रे म रे ट (फ्रे म प्रति सकैें ड) उस माध्यम पर आधारित होता ह,ै जिस पर एनिमेशन प्लेए बकै की 

जायेगी (उदाहरण के लिए फिल्म, टीवी, वीडियो गेम आदि)

जब आप भिन्न मानों के साथ विभिन्न समय पर कई की सेट करते हैं तो माया हर फ्रे म के चलने के साथ उन समय अंतरालों में एट्रीब्यूट वलै्यू जॅनॅरे ट 

करता ह।ै परिणाम होता ह,ै उन ऑब्जैक्ट्स  तथा एट्रीब्यूट्स के समय के साथ हुआ बदलाव या गति।

दृश्य आरंभ करने के लिए

•	 सुनिश्चित करें  कि आपने पषृ्ठ 217 पर “अध्यायों के लिए तयैार करना” में दिए गए चरणों को परू्ण  कर लिया किया ह।ै

•	 Keyframing.mb नामक दृश्य/सीन फाइल खोलें। 

यह फाइल आपके माया सॉफ्टवेयर द्वारा इंस्टॉल की गई GettingStartedLessonData डायरेक्टर ी या उस ड्राइव से आपको मिल जायेगी, जहां आपने गेटिग 

स्टारटेड फाइल्स कॉपी की थीं। 

GettingStartedLessonData/Anim/Keyframing.mb

चित्र 6.6.1: दशृ्य

यूनिट के उद्देश्य  
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दृश्य में एक बॉल ऑब्जेक्ट ह,ै जो अभी ग्राउंड प्लेन के किनारे  के नजदीक X – एक्सिस पर स्थित ह।ै 

दृश्य के लिए प्लेबकै रें ज सेट करना

बॉल को एनिमेट करने के लिए आप प्लेबकै रें ज के विभिन्न समयों पर इसकी स्थिति को की/सेट करते हैं।

प्लेबकै रें ज टाइम और रें ज स्लाइडर द्वारा निर्धा रित होती ह।ै टाइम और रें ज स्लाइडर कंट्रोल्स के ज़रिये आप अपनी एनिमेशन को प्लेबकै या स्क्रोल कर 

सकते हैं अथवा अपनी एनिमेशन के किसी विशिष्टि समय बिन्दु/किसी विशिष्ट क्षण पर जाकर कीफ्रे म सेट कर सकते हैं।

•	 नीचे दिए चित्र में दिखाये गये प्लेबकै कंट्रोल्स को देखें।

टाइम स्लाइडर प्लेबकै रें ज और चुने हुए ऑब्जेक्ट के लिए आपके द्वारा सेट की हुई कीज़ को दर्शाता ह।ै कीज़ लाल रंग की रे खा के रूप में दिखाई गई हैं। 

टाइम स्लाइडर के दाई ंओर का बॉक्स आपको एनिमेशन के वर्तमान फ्रे म (समय) को सेट करने की सुविधा देता ह।ै 

प्लेबकै कंट्रोल्स एनिमेशन प्लेबकै को नियत्रित करता ह।ै आप प्ले और रिवाइंड (फिर से शुरू करने) के लिए पारंपरिक बटनों को पहचान ही सकते हैं। 

stop बटन केवल तभी दिखाई देता ह,ै जब एनिमेशन चल रही/प्ले हो रही हो। यह जानने के लिए कि कौन-सा बटन क्या काम करता ह,ै माऊस पॉइंटर को 

इसके ऊपर रोक कर रखें।

एनिमेशन Preferences बटन प्लेबकै स्पीड जसैी एनिमेशन प्रेफेर ें स सेटिग्स के लिए विंडो दर्शाता ह।ै

रें ज स्लाइडर, आपके द्वारा play बटन क्लिक किये जाने पर, फ्रे म्स की रें ज को नियत्रित करता ह।ै

•	 प्लेबकै एंड टाइम बॉक्स (ऊपर देखें) में 72 एंटर करें । 

•	 मोशन पिक्चर फिल्म के लिए 24 फ्रे म प्रति सेकंड (fps) की फ्रे म दर इस्तेमाल की जाती ह।ै वीडियो के लिए फ्रे म दर, प्रयोग किये जा रहे फॉर्मेट के 

आधार पर, 30 fps (NTSC) या 25 fps (PAL) हो सकता ह।ै

•	 1 से 72 तक की प्लेबकै रें ज में आप तीन सेकंड का एनिमेशन बना सकते हैं। (72 फ्रे म्स को 24 फ्रे म प्रति सेकंड से विभाजित करने पर = 3 सेकंड्स।) 

इस अध्याय में आपको जो समय मिलेगा, वह एक शॉर्ट  एनिमेशन बनाने के लिए पर्याप्त ह।ै

6.6.3 कीफ्रे म्स सेट करना
निम्नलिखित चरणों में आप बॉल की मूवमेंट की आरंभिक तथा अंतिम स्थिति/पोज़ीशंस को सेट करने के लिए कीफ्रे म्स का उपयोग करें गे।

•	 आरंभिक तथा अंतिम कीफ्रे म्स सेट करना 

•	 प्लेबकै रें ज की शुरुआत में जाने के लिए rewind बटन पर क्लिक करें । इससे वर्तमान फ्रे म बदलकर 1 हो जाता ह।ै

•	 पहले बॉल सलेक्ट करें  और उसके बाद Animate > Set Key सलेक्ट करें । (कीबोर्ड  शॉर्टकट: s)

•	य ह बॉल के सभी बदलाव विशेषताओ/ंट्रांस्फॉर्म  एट्रिब्यूट्स के लिए फ्रे म 1 पर की सेट कर देता ह।ै ट्रांस्फॉर्म  एट्रिब्यूट्स X, Y, Z मूव एट्रिब्यूट्स हैं। 

हालांकि इस अध्याय में आप बॉल के केवल ट्रांसलेट X तथा Y एट्रिब्यूट्स को ही एनिमेट करते हैं, सभी ट्रांसफॉर्म  एट्रीब्यूट्स की कीइंग करने से आप 

निर्दिष्ट एट्रीब्यूट को की करने में लगने वाले समय को बचा सकते हैं।

चित्र 6.6.2: प्लेबैक कंट्रोल्स
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•	 टाइम स्लाइडर में फ्रे म 1 पर लाल रंग के चिन्ह पर ध्यान दें जिसे टिक के नाम से जाना जाता ह।ै यह टिक फ्रे म 1 के लिए की सेट करने पर दिखाई 

देता ह।ै बॉल सलेक्ट हो जाने के बाद टाइम स्लाइडर के टिक दर्शाते हैं, कि आपके कीज़ कहां सेट की हैं।

•	 फ्रे म 72 पर जाएँ। इसे करने का आसान तरीका टाइम स्लाइडर में वांछित स्थान पर क्लिक करना ह।ै

•	 नीचे दिखाए गए चित्र के अनुसार, बॉल को ग्राउंड के दाएं किनारे  पर स्थित करने के लिए, मूव टूल के साथ बॉल के X-एक्सिस हैंडल को ड्रैग करें ।

•	 फ्रे म 72 पर की सेट करें । (s दबाएँ।)

•	 आरंभ में जाएँ और एनिमेशन प्ले करें ।

आपके द्वारा सेट की गई 2 कीज़ से, माया पोज़ीशंस के बीच मोशन पदैा करता ह।ै डिफॉल्ट रूप से एनिमेशन फ्रे म 1 से 72 तक लगातार चलती रहती ह।ै 

इस चरण में बॉल बाड़/मेड़ से गुज़रती ह।ै

•	 कुछ बार देख लेने के बाद एनिमेशन को रोकने के लिए प्लेबकै कंट्रोल्स पर स्थित stop बटन दबाएं। 

इंटरमीडिएट कीफ्रे म्स सेट करना

•	 फ्रे म 33 या ऐसे ही किसी फ्रे म पर जाएं, जब बॉल बाड़ के बीच में रुकती ह।ै

•	 मूव टूल के साथ बॉल के Y एक्सिस हैंडल को इसके बाड़ के थोड़ा ऊपर होने तक ड्रैग करें ।

•	 की सेट करें । (s दबाएँ।)

•	 एनिमेशन चलाएं/प्ले करें ।

बॉल अब ग्राउंड से ऊपर, बाड़ के ऊपर होती हुई उड़ती ह ैऔर की किये गये स्टार्ट, मिडल तथा एंड पोज़ीशन के बीच स्मूद आर्क  में वापस ग्राउंड में आ जाती ह।ै

•	 प्लेबकै को समाप्त करने के लिए stop बटन दबाएँ। 

चित्र 6.6.3: आरंभिक और अंतिम पोज़ीशंस को सेट करें

चित्र 6.6.4: इंटरमीडियट कीफ्रे म सेट करें
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बाद के चरणों में हर की को सेट करने के बाद एनिमेशन चलाएं। सामान्यतः हर की के बाद अपने काम की प्रगति जांचना उपयोगी होता ह,ै खासतौर पर 

जब आप सीख रहे हों।

बॉल को बाउन्स करने के लिए कीफ्रे म्स सेट करना

•	 फ्रे म 50 पर जाएँ। इस समय बॉल ग्राउंड की सतह आधे दाहिने भाग के बीच के मध्य भाग के ऊपर एक पोज़ीशन पर ह।ै

•	 बॉल को मूव करें , जिससे यह ग्राउंड पर आ जाये।

•	 की सेट करें ।

•	 फ्रे म 60 पर जाएँ।

•	 बॉल को फिर से ऊपर मूव करें , लेकिन उतना ऊपर नहीं, जितनी कि बाड़ की उंचाई ह।ै

•	 की सेट करें । जब आप एनिमेशन प्ले करते हैं तो बॉल बाड़ के ऊपर से गुजरते हुए दूसरी ओर बाउन्स करती ह।ै 

चित्र 6.6.5: कीफ्रे म सेट करें

चित्र 6.6.6: बॉल को ऊपर ले जाएँ
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6.6.4 ग्राफ एडिटर का उपयोग करना

ग्राफ एडिटर का उपयोग करके एनिमेशन कर्व को एडिट करना

•	 बॉल सलेक्ट करके Window > Animation Editors > Graph Editor सलेक्ट करें ।

ग्राफ एडिटर कई एनिमेशन कर्व दर्शाता ह,ै बॉल के हर की किये गये एट्रिब्यूट के लिए एक कर्व।

•	ग्रा फ एडिटर के बाएँ कॉलम में केवल ट्रांसलेट X और ट्रांसलेट Y एट्रिब्यूट्स को शिफ्ट-सलेक्ट करें ।

अब ग्राफ एडिटर में केवल ट्रांसलेट X और ट्रांसलेट Y के लिए एनिमेशन कर्व दिखाई देंगे।

•	 एनिमेशन कर्व को बीच में प्रदर्शित करने के लिए View > Frame Selection (ग्राफ एडिटर विंडो में) सलेक्ट करें । अगर आप ग्राफ में और विवरण देखना 

चाहते हैं तो ग्राफ व्यू को ट्रैक तथा डॉली करने के लिए अपने माउस का उपयोग करें ।

•	 फ्रे म 50 पर ट्रांसलेट Y (हरा) कर्व पर बिन्दु चुनें। इससे टैंजेंट हैंडल्स की जोड़ी बिन्दु पर दिखाई देने लगती ह।ै नई प्रदर्शित सीधी रे खा का हर अंतिम 

बिन्दु टैंजेंट हैंडल ह।ै इस हैंडल की सहायता से आप की पॉइंट के निकट कर्वेचर को नियत्रित कर सकते हैं।

•	ग्रा फ एडिटर में, Keys > Break Tangents सलेक्ट करें ।

इससे आप हर टैंजेंट हैंडल को, स्वतंत्र रूप से एक जगह से दूसरी जगह ले जा सकते हैं।

•	 दाएँ टैंजेंट हैंडल को सलेक्ट करें , और थोड़ा सा ऊपर सरकाने के लिए मूव टूल का उपयोग करें । बाएँ टैंजेंट हैंडल के साथ भी ऐसा ही करें । ध्यान रहे, 

कि आप की पॉइंट न सलेक्ट कर दें।

चित्र 6.6.7: एनिमेशन कर्व

चित्र 6.6.8:  ट्रांसलेट X और ट्रांसलेट Y



223222

प्रतिभागी पुस्तिका

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

इससे बाउन्स गुरुत्वाकर्षण और लोच के प्रभाव का आभास देता हुआ और भी शार्प  हो जाता ह।ै

6.6.4 एट्रीब्यूट का समय बदलना

बॉल अपना रास्ता बेहद धीमी गति से तय करती प्रतीत हो रही ह।ै निम्नलिखित चरणों में आप इसकी गति को तेज़ करने के लिए ग्राफ एडिटर का उपयोग 

करें गे। खास तौर पर, आप बॉल के एनिमेशन से इसका सफर तीन सेकंड (72 फ्रे म) के बजाए दो सेकंड (48 फ्रे म) में समाप्त करवा देंगे।

बॉल की मूवमेंट के एनिमेशन को तज़े करना

•	सि लेक्शन बॉक्स को दोनों कर्व के सभी की पॉइंट्स के आस-पास ड्रैग करें । 

•	 स्के ल टूल का चयन करें ।

•	 फ्रे म 1 (0 के थोड़ी दाएँ ओर) पर ग्राफ में कहीं भी माऊस के बीच वाले बटन को क्लिक करके 

होल्ड करें ।

•	 प्रश्नवाचक चिन्ह के आइकॉन पर ध्यान दें। इस आइकॉन की स्थिति दर्शाती ह,ै कि स्केलि ग 

किस बिन्दु से हुई ह।ै (चूंकि आपको फ्रे म 1 की तरफ एनिमेशन को अंदर की ओर स्के ल करने 

की ज़रूरत ह,ै आपको अपना ड्रैग ऑपरे शन फ्रे म 1 से शुरू करना होगा।)

•	 माऊस के बटन को बिना छोड़े, बाई ंओर तब तक ड्रैग करें  जब तक दोनों कर्व पर सबसे दाई ं

ओर के की पॉइंट्स लगभग फ्रे म 48 पर स्थित न हो जाएँ। (सलेक्ट करने पर सबसे दायाँ की 
पॉइंट पीला हो जाता ह।ै)

6.6.5 एनिमेशन को फाइनट्यून करना/निखारना

निम्नलिखित दो चित्र परिवर्तन/सुधार के बाद कर्व के उदाहरण को प्रदर्शित करते हैं। दोनों ग्राफ समरूप हैं केवल दूसरी चित्र में कर्व बिन्दुओ ंको सलेक्ट 

किया गया ह।ै दूसरी आकृति टैंजेंट हैंडल की स्थिति को दर्शाती ह।ै

चित्र 6.6.9:  दाएँ टैंजेंट का चयन करना

चित्र 6.6.10:  बॉल की मूवमेंट

चित्र 6.6.11 (a):  एनिमेशन को फाइन ट्यून करना
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6.6.6 अतिरिक्त कीफ्रे म और स्टेटिक चनैलों को डिलीट करना
स्टेटिक चनैलों को डिलीट करने के लिए

मेन मनै्यू से Edit > Delete All by Type > Static Channels सलेक्ट करें । यह सीन में मौजदू सभी ऑब्जेक्ट्स  के लिए अनावश्यक कीज़ को हटा देगा। 

वकैल्पिक रूप से आप किसी चुने हुए ऑब्जेक्ट के लिए स्टेटिक चनैलों को Edit > Delete by Type > Static Channels में जाकर हटा सकते हैं।

चित्र 6.6.11 (b):  एनिमेशन को फाइन ट्यून करना

चित्र 6.6.12:  स्टेटिक चैनलों को डिलीट करना

6.6.7 एनिमेशन को प्लेबकै करने लिए प्लेब्लास्ट का इस्तेमाल करना

जब आप किसी सीन को प्ले करते हैं तब आपको एनिमेशन का एक रफ अनुमान दिखाई देता ह।ै हर फ्रे म को रें डर करने और इस उद्देश्य से डिज़ाइन किए 

गए प्लेबकै यटूिलिटी से फ्रे म को सिक्वेंस में प्ले करने की तुलना में प्लेबकै की गति और गुणवत्ता सही नहीं ह।ै

एकदम सही समय के साथ एनिमेशन दखेें

•	 Window > Playblast सलेक्ट करें

•	 अगले कुछ सेकंड के दौरान माया परूे  एनिमेशन को फ्रे म दर फ्रे म प्रोसेस करेग ा। प्रोसेस परूा होने के बाद एक प्लेबकै विंडो दिखाई देगी।

•	 एनिमेशन देखने के लिए इस विंडो में दिख रहे play बटन पर क्लिक करें ।

•	 परूा होने के बाद प्लेब्लास्ट विंडो को बंद कर दें।
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यूनिट 6.7: पॉलीगोन टके्स्चरिंग

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 माया सॉफ्टवेयर-पॉलीगोन टेक्सचरिंग पर 3D एनिमेशन तकनीक का प्रयोग करने में।

6.7.1 क्रैक र बॉक्स मॉडल बनाना

क्यूब प्रिमिटिव का इस्तेमाल करके क्रैक र बॉक्स बनाना

•	 Create > Polygon Primitives > Cube > _ सलेक्ट करें ।

•	 पॉलीगोन क्यूब ऑप्शपन विंडो में Edit > Reset Settings सलेक्ट करें  निम्नलिखित विकल्प सेट करें  और उसके बाद क्रिएट पर क्लिक करें :

»	च ौड़ाई: 8

»	 ऊंचाई: 10

»	 डेप्थ (गहराई): 3

»	च ौड़ाई विभाजन/वर्ग: 1

»	 उंचाई विभाजन/वर्ग: 1

»	ग हराई विभाजन/वर्ग: 1

»	 एक्सिस/अक्ष: Y

»	 UV बनाएं: ऑन

»	 सामान्यीकरण: ऑफ

सीन व्यू में क्यूब प्रिमिटिव एक आयताकार बॉक्स के रूप में नज़र आता ह।ै जब क्रिएट UVs ऑप्शन ऑन रहता ह,ै तो यह सुनिश्चित करता ह ैकि प्रिमिटिव 

ऑब्जेक्ट डिफॉल्ट UV टेक्सचर को-ऑर्डि नेट्स के एक सेट से बनाया गया हो। माया में सभी पॉलीगोन प्रिमिटिव, क्रिएशन के समय ही UV टेक्सचर  

को-ऑर्डि नेट्स बनाने का विकल्प प्रदान करते हैं। 

•	च नैल बॉक्स का इस्तेमाल करके ट्रांसलेट Y एट्रिब्यूट को 5 पर सेट करें  ताकि क्रै कर बॉक्स को पुनर्स्थापि त करके X एक्सिस अक्ष पर किया  

जा सके।

यूनिट के उद्देश्य  

चित्र 6.7.1:  क्रै कर बॉक्स मॉडल बनाना
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6.7.2 पॉलीगोन मेश पर टके्सचर मपै एप्लाई करना

माया में, रें डर की गई तस्वीर में सतह वसैी दिखाई देती ह ैजसैी शेडिग सामग्री आपने इस्तेमाल की ह।ै डिफॉल्ट शेडिग सामग्री जो कि सतह पर लगाई 

जाती ह ैवह रंग, पारदर्शिता और चमक जसैी मूलभतू विशेषताएँ प्रदान करती ह।ै

क्रैक र बॉक्स में शेडिंग सामग्री असाइन करने के लिए

सीन व्यू के पनैल मनै्यू में जाकर Shading > Smooth Shade All सलेक्ट करें । यह क्रै कर बॉक्स को डिफॉल्ट ग्रे, स्मूथ शेडिग मटैीरियल में दर्शाता ह,ै जो 

डिफॉल्ट लाइटिग के प्रयोग से प्रकाशित होता ह।ै स्मूथ शेड ऑल को ऑन करने से वो असाइंड शेडिग मटैीरियल दिखने लगेगा, जो आप निम्न चरणों में 

क्रै कर बॉक्स में एप्लाई करें गे।

•	 सीन व्यू‍ में, क्रै कर बॉक्स के किसी भी भाग पर राइट-क्लिक करें  और मार्किंग  मनै्यू ्से Assign New Material > Lambertमटैीरियल सलेक्ट करें ।

चित्र 6.7.2: पॉलीगोन मेश पर टेक्सचर मैप

•	 एक नया लमै्बर्ट शेडिग मटैीरियल बन जाएगा और क्रै कर बॉक्स को असाइन हो जाएगा। 

एट्रिब्यूट एडिटर दिखाई देगा और नए लमै्बर्ट शेडिग मटैीरियल के लिए विभिन्न 

एट्रिब्यूट्स प्रदर्शित करेग ा।

चित्र 6.7.3: न्यू लैम्बर्ट शेडिंग मैटीरियल

•	 pCube1 प्रिमिटिव का नाम बदलकर: cracker_box कर दीजिए।
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नया लमै्बर्ट मटैीरियल उस डिफॉल्ट ग्रे मटैीरियल से मिलता जुलता ह ैजो क्रै कर बॉक्स को पहले असाइन किया गया था।

•	 एट्रिब्यूट एडिटर में, lambert2 बॉक्स पर डबल क्लिक करें  और उसके बाद शेडिग मटैीरियल का नाम बदलने के लिए box_material टाइप करें ।

शेडिग मटैीरियल का नाम बदलने से बाद में ज़रूरत पड़ने पर आपको इसे पहचानने में आसानी होती ह।ै माया में चीज़ों को अनठेू तरीके से नाम देना एक 

उपयोगी आदत ह।ै

•	 एट्रिब्यूट एडिटर में, कलर स्लाइडर को परूी तरह से दाई ंओर ले जाएँ ताकि कलर बॉक्स सफेद दिखाई दे।

चित्र 6.7.4: शेडिंग मैटीरियल का नाम बदलें

•	 बॉक्स मॉडल को असाइन शेडिग मटैीरियल भी सीन व्यू में अपडेट हो जाता ह,ै इसलिए थोड़ा 

चमकदार दिखने लगता ह।ै

•	 कलर स्लाइडर के दाएं ओर स्थित Map बटन पर क्लिक करें । क्रिएट रें डर नोड विंडो दिखाई 

देगी और इसके साथ ही बॉक्स मटैीरियल के कलर चनैल में विभिन्न टेक्सचर ऑप्शंस आ  

जाते हैं, जो आप एप्लाई (या कनकै्ट) कर सकते हैं। 2D टेक्सचर की सचूी से PSD फाइल पर 

क्लिक करें ।

चित्र 6.7.5: शेडिंग मैटीरियल का नाम बदलें

चित्र 6.7.6: PSD फाइल पर क्लिक करें
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यूनिट 6.8: रें डरिंग

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 माया सॉफ्टवेयर-रें डरिंग पर 3D एनिमेशन तकनीकों को एप्लाई करने में।

6.8.1 सीन रें डर करना

एक इमेज प्रोड्यजू़ करने के लिए रें डरिंग में कई घटक शामिल होते हैं:

•	 शेडिग मटैीरियल और टेक्सचर

•	 लाइटिग और शडैो

•	 कैमरा और एनिमेशन

•	र ें डरिंग विधि

•	 विज़अल इफैक्ट्स

•	 सुनिश्चित करें  कि आपने पषृ्ठ 429 पर “अध्यायों के लिए तयैार करना” में दिए गए 

चरणों को परू्ण  कर लिया किया ह।ै

•	 Apple.mb नाम की सीन फाइल खोलें। 

•	य ह फाइल आपको माया सॉफ्टवेयर के साथ इंस्टॉल हुई GettingStartedLessonData 

डायरेक्टर ी पर या फिर उस ड्राइव में मिल जायेगी, जहां आपने गेटिग स्टारटेड फाइल्स 

कॉपी की हुई हैं:

GettingStartedLessonData/Rendering/Apple.mb

दृश्य में एक सेब प्लेन पर पड़ा ह,ै और एक अन्य प्लेन बकैग्राउंड ह।ै दृश्य में एक कैमरा 

अलग-अलग दूरियों से सेब के चारों ओर चक्कर लगाने के लिए एनिमेटेड ह।ै (Apple.mb 

सीन का इस्तेमाल करने की बजाय आप अपने किसी ऑब्जेक्ट से भी ऐसा ही सीन तयैार 

कर सकते हैं)।

चित्र 6.8.1(a): रेंडरिग इमेज चित्र 6.8.1(b): रेंडरिग इमेज चित्र 6.8.1(c): रेंडरिग इमेज

चित्र 6.8.2: सीन रेंडर करना

यूनिट के उद्देश्य  



229228

प्रतिभागी पुस्तिका

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

•	 Window > Settings/Preferences > Preferences सलेक्ट करें ।

•	 टाइमलाइन कैटगरी पर क्लिक करें  और सुनिश्चित करें  कि प्लेबकै स्पीड ऑप्शन रियल-टाइम (30 fps) पर हो, इसलिए आपका एनिमेशन 24 फ्रे म्स 

प्रति सेकंड की डिफॉल्ट दर से प्लेबकै होगा। 

•	प्रि फेर ें स विंडो बंद करें ।

•	 एनिमेटेड कैमरे  का प्रयोग आप अध्याय में बाद में करें गे, उससे पहले नहीं। अगले चरणों में आप शेडिग मटैीरियल क्रिएट करके सेब और प्लेन को 

कलर करें गे।

6.8.2 ऑब्जेक्ट के लिए शेडिंग मटैीरियल बनाना

•	 पर्सपेक्टिव व्यू में Shading > Smooth Shade All सलेक्ट करें

•	 पर्सपेक्टिव व्यू में सेब के तने को उसकी ज्योमेट्री पर क्लिक करके सलेक्ट करें । (ध्यान 

रखें कि सेब का सिर्फ  तना ही सलेक्ट हो।)

चित्र 6.8.3: सीन रेंडर करना

चित्र 6.8.4: पर्सपेक्टिव व्यू

चित्र 6.8.5: सेब के तने को चुनें
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6.8.3 माया सॉफ्टवेयर रें डर का इस्तेमाल करके रें डरिंग करना

•	र ें डरिंग मेन ूसेट से Lighting/Shading > Assign New Material > Lambert सलेक्ट करें । लमै्बर्ट मटैीरियल के लिए एट्रिब्यूट एडिटर दिखाई देता ह।ै 

लमै्बर्ट मटैीरियल बिना शाइनी हाईलाइट के मटै सतह बनाता ह।ै बाद के अध्यायों में आप मटैीरियल और उनके एट्रिब्यूट्स के विषय में और अधिक जानेंगे।

•	 कलर के दाई ंओर के ग्रे बॉक्स पर क्लिक करें ।

कलर चज़ूर विंडो दिखाई देगी।

•	 कलर व्हील के अंदर क्लिक करें  और भरूे  रंग पर ड्रैग करें ।  कलर चज़ूर में से चुना हुआ रंग सेब के 

तने में एप्लाई हो जाएगा।

•	 विंडो को बंद करने के लिए Accept पर क्लिक करें ।

•	 एट्रिब्यूट एडिटर में लमै्बर्ट शेडिग मटैीरियल को रीनेम करके appleStem_lambert कर दें।

परूे  एनिमेशन को रें डर करने में काफी समय लग सकता ह,ै इसलिए अच्छा रहेगा, कि पहले माया सॉफ्टवेयर की सहायता से अपने मॉनिटर पर कुछ फ्रे म्स 

की रें डरिंग टेस्ट कर लें और परिणामों का निरीक्षण करें ।

कैमरा व्यूज़ में स्विच करना और एनिमेशन को प्लेबकै करना

•	 पर्सपेक्टिव व्यू में Panels > Perspective > apple_camera सलेक्ट करें ।

»	 apple_camera के लेंस से सीन कैसा दिखेगा यह दर्शाने के लिए व्यू अपडेट हो जाता ह।ै

•	 टाइम स्लाइडर प्लेबकै कंट्रोल्स में Play बटन पर क्लिक करें ।

»	 प्लेबकै के दौरान एनिमेटेड कैमरा सेब को ट्रैक और टम्बल करता रहता ह।ै

•	जि स फ्रे म को आपको टेस्ट रें डर करना ह,ै उस पर एनिमेशन को रोकें ।

एनिमेशन के वर्तमान फ्रे म के रें डर का परीक्षण करने के लिए

चित्र 6.8.6: ग्रे बॉक्स

चित्र 6.8.7: कलर चूज़र विंडो
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•	र ें डर व्यू विंडो में Options > Render Settings सलेक्ट करें । 

•	र ें डर सेटिग्स विंडो में रें डर में से ड्रॉप डाउन सचूी से माया सॉफ्टवेयर सलेक्ट करें ।

•	र ें डर सेटिग्स विंडो में माया सॉफ्टवेयर टबै सलेक्ट करें ।

•	 एंटी-अलाइज़िन्ग क्वालिटी सेक्शन में क्वालिटी ड्रॉप डाउन सचूी से प्रोडक्शन क्वालिटी सलेक्ट करें ।

यह सेटिग रें डर की गई इमेज की खुरदुरी सतह और सिरों को स्मूथ करके उच्च-स्तरीय परिणाम 

देती ह।ै

•	र ें डर सेटिग्स विंडो को बंद करें ।

•	र ें डर सेटिग्स विंडो में Render > Render > Current (apple_camera) सलेक्ट करें ।

•	 एनिमेशन के फ्रे म नंबर 120 पर जाएं जहां आपको सेब अलग स्थिति में दिखाई देगा।

•	र ें डर व्यू में Render > Render > Current (apple_camera) सलेक्ट करें ।

6.8.4 एनिमेशन फ्रे म्स की सिक्वेंस को बचै रें डरिंग करना

बचै रें डरिंग के लिए रें डर सेटिंग्स को सेट करना

•	र ें डर व्यू विंडो में, रें डर सेटिग्स विंडो को प्रदर्शित करने के लिए Options > Render Settings सलेक्ट करें ।

•	र ें डर सेटिग्स विंडो में, कॉमन टबै सलेक्ट करें  और उसके बाद इमेज फाइल आउटपुट सेक्शन को खोलें।

•	 इमेज फाइल आउटपुट सेक्शन में निम्नलिखित विकल्प सेट करें :

चित्र 6.8.8: रेंडर सेटिंग्स

चित्र 6.8.9: उच्च गुणवत्ता
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»	 फाइल नेम प्रीफिक्स: Apple नाम टाइप करें । यह नाम बचै रें डरिंग द्वारा बनाए गए फाइल नामों का आधार होगा। 

»	 फ्रे म/एनिमेशन एक्सटेंशन: name.#.ext सलेक्ट करें  यह नाम दिखाता ह ैकि फाइल का नाम का फॉर्मेट इस प्रकार होगा prefix.frameNumber.

fileFormat उदाहरण के लिए परूी 200 फ्रे म की एनिमेशन की बचै रें डरिंग से Apple.0001.iff, Apple.0002.iff, Apple.00200.iff आदि बनेंगे।

»	 इमेज फॉर्मेट: माया IFF (.iff) सलेक्ट करें , माया का मानक इमेज फाइल फॉर्मेट। एनिमेशन की प्रीव्यूइंग तथा कम्पोज़िटिग सहित, आपको आगे 

जो भी काम करना हो, आप .iff फॉर्मेट का इस्तेमाल कर सकते हैं। अगर आपको अलग फॉर्मेट की ज़रूरत ह ैतो आप रें डर सेटिग्स में .iff के 

स्थान पर उसे लिख सकते हैं।

»	 प्रारंभिक फ्रे म/स्टार्ट फ्रे म: 1 एंटर करें , एनिमेशन सीक्वेंस का बचै रें डर किया जाने वाला पहला फ्रे म।

»	 एंड फ्रे म/अंतिम फ्रे म: 60 एंटर करें , बचै रें डर होने वाला अंतिम फ्रे म। (सभी 200 फ्रे म्स को रें डर करने में काफी समय लग सकता ह।ै)

»	 फ्रे म पेडिंग: 4 एंटर करें । इससे फाइलनेम के फ्रे मनम्बर हिस्से में नम्बर से पहले 0 (शनू्य) लगाकर इसे चार अंकों का बना दिया जायेगा। 

उदाहरण के लिए, फाइलों के नाम Apple.0001.iff से लेकर Apple.0050.iff हो जाएंगे। 

»	 रें डर करने योग्य कैमरा: जिस कैमरा व्यू को आप रें डर करना चाहते हैं उसे चुनने के लिए ड्रॉप डाउन सचूी से apple_camera सलेक्ट करें ।

रें डर सेटिग्स को सेट करने के बाद कॉमन टबै का ऊपरी भाग बचै रें डरिंग के दौरान बनने वाली फाइलों के लिए सही पाथ और फाइल नाम प्रदर्शित करता 

ह।ै जांच करें  कि यह जानकारी सही ह ैया नहीं। 

•	र ें डर सेटिग्स विंडो को बंद करें ।

एनिमेशन फ्रे म रें डर को बचै करने के लिए

•	 दृश्य को सेव करें ।

बचै रे न्डरिंग से पहले दृश्य को सेव करना एक अच्छा अभ्यास साबित होता ह।ै यह तब उपयोगी होता ह ैयदि बचै रे न्डरिंग के बाद, आपको डिस्प्ले सटैिग 

में परिवर्तन करना हो और पुन: रें डर करना हो। बचै रे न्डरिंग से पहले दृश्य को सेव करके, आप यह जानने के लिए दृश्य का परीक्षण कर सकते हैं कि बचै 

रें डर करने पर किस विकल्प की सटैिग्स उपयोग अधीन थीं।

•	र ें डरिंग मेन ूमें Render > Batch Render > _चयन करें  Render > Batch Render > _। बचै रें डर फ्रे म विंडो दिखाई देता ह।ै

•	 सभी उप्लब्ध प्रोसेसर्स के उपयोग को योग्य करें , फिर बचै रें डर पर क्लिक करें  और बचै रे न्डरिंग को आरंभ करने के लिए इसे बंद करें । 

(सभी उप्लब्ध प्रोसेसर्स के उपयोग का विकल्प MAYA को रें डर परूा करने के लिए सभी उप्लब्ध प्रोसेसर्स का उपयोग करने की सुविधा प्रदान करता ह।ै)

बचै रें डर की स्थिति को जांचने के लिए

•	 की स्थिति की जाँच के लिए, चयन करें  Window > General Editors > Script Editor। स्क्रिप्ट एडिटर विंडो का आकार बढाएं। यह विंडो रें डर किए 

जाने वाले फ्रे म्स के लिए लॉग का परूा होना दर्शाती ह।ै 

चित्र 6.8.10: उच्च गुणवत्ता
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•	 MAYA परिणामी फाइल्स को डिफ़ॉल्ट इमेजिज़ डायरेक्टर ी में डालती ह।ै फाइल्स के निम्नलिखित नाम होते हैं:

»	 Apple.0001.iff

»	 Apple.0002.iff

»	 Apple.0003.iff

»	 Apple.0050.iff

इमेजिज़ डायरेक्टर ी उसी स्थान पर स्थित होती ह ैजहाँ दृश्य डायरेक्टर ी स्थित होती ह।ै आप MAYA के लिए प्रोजेक्ट सेटिग में परिवर्तन करके एक भिन्न 

मार्ग  निर्धा रित कर सकते हैं। प्रोजेक्ट के बारे  में अधिक जानकारी के लिए MAYA सहायता देखें।

•	नि म्न संदेश आने पर स्क्रिप्ट एडिटर को बंद कर दें:

// परिणाम: रें डरिंग संपरू्ण  हुई। जानकारी के लिए mayaRenderLog.txt देखें //

•	 mayaRenderLog.txt फाइल में एडवांस्ड यज़ूर्स के लिए रें डरिंग आंकड़े निहित होते हैं।

6.8.5 रें डर्ड फ्रे म्स का सीक्वेंस दखेना

एक विडियो या फिल्म की गति पर बचै रें डर्ड  चित्र देखने के लिए आप MAYA की FCheck इमेज व्यूइंग यटूिलिटी का उपयोग कर सकते हैं।

रें डर्ड फ्रे म्स का सीक्वेंस दखेने के लिए FCheck का उपयोग करने के लिए

•	 Select File > View Sequence पर जाएँ। एक फाइल ब्राउज़र विंडो दिखाई देगी।

•	 फाइल ब्राउज़र की सहायता से, अपने वर्तमान प्रोजेक्ट के लिए इमेजिज़ डायरेक्टर ी पर जाएँ (या जहाँ आपने एप्पल के लिए चित्रों का सीक्वेंस सेव 

किया ह।ै)

•	 सीक्वेंस में प्रथम चित्र चुनने के लिए Apple.001.iff इमेज फाइल का चयन करें  और Open पर क्लिक करें । FCheck इमेज व्यूइंग यटूिलिटी दिखाई 

देगी और 50 फ्रे म्स का रें डर्ड  सीक्वेंस एक एनीमेटेड लपू के रूप में चलता ह।ै

•	 एनिमेशन देखने के बाद विंडो को बंद कर दें

टिप्पणियां 

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
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7. Stop Motion एनिमेशन

यनूिट 7.1 Stop Motion द्वारा गति को रोकना
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इस मॉड्यलू के अंत में, आप निम्न में सक्षम होंगे:

1.	स्क्रि प्ट और निर्देशक के निर्देशों के अनुसार Stop Motion कैरेक्टर्ज़  (कठपुतलियां या मॉडल) का एनिमेशन बनाना।

2.	 एनिमेशन की प्रक्रिया के दौरान रचनात्मक विचारों का योगदान देना।

3.	 Stop Motion एनिमेशन तकनीकों का उपयोग करना।

4.	 Stop Motion Pro द्वारा गति को रोकना, Stop Motion Pro सॉफ्टवेयर द्वारा Stop Motion एनिमेशन तकनीकों का उपयोग करना।

निष्कर्ष 
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यूनिट 7.1: Stop Motion Pro द्वारा गति को रोकें

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	स्क्रि प्ट और निर्देशक के निर्देशों के अनुसार Stop Motion कैरेक्टर्ज़  (कठपुतलियां या मॉडल) का एनिमेशन बनाना।

2.	 एनिमेशन की प्रक्रिया के दौरान रचनात्मक विचारों का योगदान देना।

7.1.1 Stop Motion Pro

7.1.2 एक नई प्रोडक्शन/शॉट बनाना

Stop Motion एनिमेशन प्रत्येक वदृ्धिशील परिवर्तन को फिल्माते समय कैमरे  के सामने अस्थिर या बदलती मुख्य सामग्री द्वारा बनाई जाती ह।ै इन चित्रों 

का प्लेबकै एक भ्रम, एनिमेशन के समान भाव उत्पन्न करता ह।ै

जब आप एक नई एनिमेशन बनाना चाहते हों, तो आपको एक प्रोडक्शन का नाम बनाने की आवश्यकता होगी, आपकी असल फिल्म उसी प्रोडक्शन में 

फिल्माई जाएगी। आप बाद में अपनी प्रोडक्शन में नए शॉट्स जोड़ सकते हैं। 

Stop Motion Pro को स्टार्ट  करें  और आपको वेल्कम डायलॉग दिखाई देगा। Create a new Production/Shot का चयन करें , फिर OK पर क्लिक करें ।

जब एक बार आप नई प्रोडक्शन/शॉट बना लेते हैं, आपको कैप्चर सटैिग डायलॉग दिखाई देता ह।ै यह डायलॉग आपको यह दिखाने के लिए बनाया गया 

चित्र 7.1.1: एक नया प्रोडक्शन/शॉट बनाएं

चित्र 7.1.2: एक नया प्रोडक्शन/शॉट बनाएं

यूनिट के उद्देश्य  
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ह ै कि एनिमेशन बनाते समय Stop Motion Pro उपयोग करने के लिए आपके पास कौन सा हार्डवेयर 

उप्लब्ध ह।ै

विडियो कैप्चर कार्ड /कनेक्ट किए गए कैमरे  के आधार पर कैप्चर के कई तरीके दिखाई देते हैं।  आपके 

कार्य  करने के ढंग के अनुसार सबसे उपयुक्त तरीके का चयन करें

ध्यान दें: कुछ  विकल्प केवल तब ही दिखाई देत ेहैं जब उनके प्रकार का हार्डवयेर कनके्ट किया जाए।

कैमरा कनकै्शन पर नवीनतम जानकारी के लिए हमारी वेबसाइट पर रे फेर  करें ।

आपके कैमरे  से मेल खाते कैप्चर ढंग का चयन करें  फिर फ्रे म का आकार निर्धा रित करें  (यदि आवश्यक हो) और OK पर क्लिक करें ।

अपना कैमरा सेट अप करें  ताकि ऐसी किसी भी वस्तु को बदल सकें  जिसे आप आसानी से हाथ में उठा सकते हैं – खिलौना गाड़ी, कप, पेन या ऐसी कोई 

अन्य वस्तु। मॉडल को छोटे कदमों पर हिला कर, हर समय पर फोटो लेकर (जिसे “कैप्चरिंग” कहते हैं) आप अपनी प्रथम एनिमेशन बनाने जा रहे हैं। इन 

चित्रों का प्लेबकै एक भ्रम, एनिमेशन के समान भाव उत्पन्न करता ह!ै

चित्र 7.1.3: कैप्चर सैटिंग

चित्र 7.1.4: कैप्चर का चयन करें
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फ्रे म कैप्चर करने के लिए, आप लाइव मोड में होने चाहिएं। मेन टूलबार पर, live बटन पर क्लिक करें  और लाइव मोड दर्शाने के लिए इसमें रौशनी जगेगी। 

यदि आप कैमरे  के सामने अपना हाथ लाएं तो आपको यह स्क्रीन पर चलते हुए दिखाई देगा। एक फ्रे म कैप्चर करने के लिए, capture बटन पर क्लिक करें

जब एक फ्रे म कैप्चर किया जाता ह,ै तो फ्रे म काउंटर बढ़ जाता ह।ै अब कैमरे  के सामने की वस्तु में परिवर्तन करें ।

आप onionskin फंक्शन द्वारा पहले कैप्चर किए गए फ्रे म और वर्तमान लाइव वीडियो के बीच अंतर देख सकते हैं। Onionskin विज़ीबिलिटी बढाने के लिए 

onionskin स्लाइडर को बाई ंओर ले जाएँ।

चलिए ऑब्जेक्ट को एनिमेट करें । ऑब्जेक्ट को सीधी रे खा में हिलाएं, फ्रे म में प्रत्येक छोटी हरकत को कैप्चर करने के लिए capture बटन पर क्लिक करें । 

इसे 10 बार करें , 10 फ्रे म कैप्चर करें ।

अब एक शॉट लें और एक फ्रे म कैप्चर करें ; हम बाद में यह फ्रे म हटा देंगे। प्रत्येक फ्रे म में ऑब्जेक्ट की भिन्न स्थिति पर अन्य 10 या अधिक फ्रे म कैप्चर करें ।

7.1.3 एनिमेशन चलाना

एनिमेशन चलाने के लिए आपको स्टोर्ड  मोड में होना चाहिए। मेन टूलबार पर, stored बटन पर क्लिक करें  और स्टोर्ड  मोड दर्शाने के लिए इसमें एक रौशनी 

जगेगी।

एनिमेशन को प्ले करने के लिए play बटन पर क्लिक करें । ध्यान दें कि प्लेबकै के दौरान शॉट में 

आपका हाथ दिखाई देता ह।ै एनिमेशन में आगे या पीछे  जाने के लिए next या previous बटन पर  

क्लिक करें ।

मेन टूलबार पर प्ले दर (एनिमेशन के प्लेबकै की गति) fps (फ्रे म्स प्रति सेकंड) विंडो में दिखाई देती ह।ै 

चलिए प्रति सेकंड फ्रे म्स की संख्या को बढ़ाकर एनिमेशन की गति को तीव्र करें । अपने माउस द्वारा fps 

विंडो पर दाएं बटन से क्लिक करें , आपको एक ड्रॉप डाउन मेन ूदिखाई देगा।

7.5 fps का विकल्प चुनें। अब मेन टूलबार पर play बटन दबाएँ। आप देखेंगे कि आपकी एनिमेशन का 

प्लेबकै धीमा हो गया ह ै(क्योंकि यह 15 फ्रे म्स की बजाए 7.5 फ्रे म्स प्रति सेकंड की दर पर चलता ह)ै। 

उसी तरीके से fps को दोबारा 15 fps पर बदलें।

चित्र 7.1.5: फ्रे म कैप्चर करें

चित्र 7.1.6: एनिमेशन चलाना

चित्र 7.1.7: प्ले दर
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7.1.4 एनिमेशन को एडिट करना

जब एनिमेशन का प्लेबकै किया जाता ह ैतो शॉट में आपका हाथ दिखाई देता ह।ै चलिए इनबिल्ट एडिटिग टूल्स द्वारा एनिमेशन से अपना हाथ हटा दें।

अपनी एनिमेशन एडिट करने के लिए, आपको एडिटर मोड में होना चाहिए। मेन टूलबार पर, editor बटन पर क्लिक करें  और एडिटर मोड दर्शाने के लिए 

इसमें एक रौशनी जगेगी।

प्रत्येक फ्रे म की थंबनेल दिखाई देती ह।ै

यदि आवश्यक हो तो एडिटर में थंबनेल्स में नेविगेट करने के लिए Windows स्क्रोल बार (थंबनेल इमेजिस के दाई ंओर) का उपयोग करें । माउस के बाएँ 

बटन से उस फ्रे म पर क्लिक करें  जिसमें आपका हाथ दिखाई देता ह।ै फ्रे म लाल रंग में हाईलाइट होगा। साइड टूलबार पर, एक्शन पर माउस का बायाँ बटन 

दबाएँ। अब आप एडिटर विंडो के दाई ंओर Hide बटन द्वारा फ्रे म को हाईड कर सकते हैं।

वह फ्रे म जिसमें आपका हाथ दिखाई देता ह,ै इसमें पीले रंग की एक तिरछी रे खा दिखाई देगी और फ्रे म्स के प्लेबकै के दौरान यह दिखाई नहीं देगी। आप 

इसे play बटन पर क्लिक करके चेक कर सकते हैं और एनिमेशन देख सकते हैं।

चित्र 7.1.8: एनिमेशन एडिट करना
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7.1.5 साउंड ट्रैक के साथ एनिमेशन बनाना

7.1.6 ऑडियो के साथ एनिमेशन

•	 सबसे पहले ऑडियो ट्रैक के साथ एनिमेशन चलाकर देखें और सुनें। एनिमेशन देखने  

के लिए

	 आपको Microsoft “Windows Media Player” खोलना होगा। ऐसा आप Windows Start 

menu, Windows Media Player पर जाकर कर सकते हैं। मीडिया प्लेयर में File|Open 

का चयन करें  और निम्न मूवी खोलें:

C:\Program Files\Stop Motion Pro v7\assets\Quickstart\quickstart_movie.mpg

•	य ह कैरेक्टर  के ऑब्जेक्ट में बदलने की 3 सेकंड की एनिमेशन ह।ै आप एनिमेशन बनाने 

के लिए वही ऑडियो ट्रैक का उपयोग करें गे।

•	 एनिमेट करने के लिए एक कैरेक्टर  खोजना – आप प्लास्टिक की वस्तु, खिलौना गाड़ी, 

पेंसिल का शार्पनर – जो भी आपके पास हो, का उपयोग कर सकते हैं। आपको कैरेक्टर  के लिए मिलाने के लिए एक ऑब्जेक्ट की आवश्यकता होगी, 

यह एक कप, बक्सा या टेलीफोन, और फिर से, आपके पास जो भी हो उसे ही उपयोग कर सकते हैं।

•	 Stop Motion Pro में एक नई प्रोडक्शन/शॉट शुरू करें  प्रोडक्शन को एक नाम दें My animation और वॉक क्रै श का शॉट लें और OK पर क्लिक करें ।

•	 कैप्चर परैामीटर निर्धा रित करें  जसैा कि आपने Task 1 में किया था। एक बार जब आप अपने कैमरे  से लाइव व्यू ले लेते हैं, तो वह ऑब्जेक्ट निर्धा रित 

करें  जो स्क्रीन पर दिखाई देगा। अपने कैरेक्टर  को स्क्रीन के बायीं ओर करें , बिल्कु ल शॉट से बाहर।

•	 मेन टूलबार पर अपनी फ्रे म्स प्रति सेकंड (fps) दर देखें। यह सुनिश्चित करें  कि fps 15 पर सेट ह।ै यदि आप एडजस्ट करना चाहें तो fps बटन पर माउस 

के दाएं बटन से क्लिक करें , आपको एक ड्रॉप डाउन मेन ूदिखाई देगा, 15 fps चुनें।

एनिमेशन शुरू करने से पहले, हमें अपना ऑडियो ट्रैक जोड़ना होगा और सुनिश्चित करना होगा कि 

यह सही समय पर चले। ऐसा करने के लिए, Tools|Audio sync मेन ूका चयन करें ।

•	नि म्नलिखित WAV फाइल चुनें:

C:\Program Files\Stop Motion Pro v7\assets\Quickstart\walk_crash_ow.wav

ऑडियो सिक विंडो हरे  रंग की तरंगदार रे खा, ऑडियो ट्रैक के विज़अल प्रतिरूप के रूप में एक wav 

ऑडियो फाइल दिखाएगी। ऑडियो फाइल सुनने के लिए ऑडियो सिक विंडो पर प्ले बटन पर क्लिक 

करें । नीचे दिए चित्र में आप कुछ नोइस देख सकते हैं जिसे हम अपनी एनिमेशन में synchronize 

करना चाहते हैं। ऑडियो फाइल एक व्यक्ति के कदमों की आवाज़ के साथ शुरू होती ह ैजिससे एक 

कप टूट जाता ह,ै वह व्यक्ति फिर कहता ह:ै “ओ!”

चित्र 7.1.9: साउंड ट्रैक के साथ एनिमेशन

चित्र 7.1.10: ऑडियो ट्रैक के साथ एनिमेटिंग

ऑडियो तरंग के नीचे छोटी वर्टिकल रे खाएं यह दर्शाती हैं कि एनिमेशन के वास्तविक फ्रे म कहाँ होंगे।

ऑडियो का सही समय पर चलना और बंद होना सुनिश्चित करने के लिए हमें विडियो फ्रे म और ऑडियो फ्रे म दोनों के साथ फ्रे म 1 के साथ “synchronize” 

करना होगा।
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चलिए इसे अभी करते हैं। हरी तरंग पर बाएं बटन से क्लिक करें  और फ्रे म 1 पर आने तक माउस को बायीं ओर ड्रैग करें । ऑडियो सिक विंडो पर sync बटन 

पर क्लिक करें । ऑडियो सिक विंडो टूलबार ऐसा दिखाई देगा:

अब आप ऑडियो ट्रैक के साथ अपने कैरेक्टर  को एनिमेट करना शुरू कर सकते हैं। दो फ्रे म कैप्चर करें , अपना “person” कैरेक्टर  धीरे  से शॉट में लाएं। दो 

अन्य फ्रे म लें और दोबारा कैरेक्टर  को मूव करें ।

वे फ्रे म जो आपने कैप्चर किए हैं वे स्लेटी रंग में दिखाई देते हैं, वर्तमान स्टोर्ड  फ्रे म सफेद रंग में हाईलाइट होते हैं। यह आपको स्पष्ट करता ह ैकि आप साउंड 

ट्रैक में कहाँ तक पहंुचे हैं।

कुछ समय लें यह देखने के लिए कि ऑडियो ट्रैक में क्या हो रहा ह:ै मुख्य 

समय वह ह ैजब कैरेक्टर  ऑब्जेक्ट से टकराता ह।ै

यह साउंडट्रैक में यह बिल्कु ल 2 सेकंड ह।ै प्रत्येक फ्रे म कैप्चर करते समय 

कैरेक्टर  को चारों ओर घुमाएं, 2 सेकंड में ऑब्जेक्ट तक पहँुचने का लक्ष्य 

रखें।

यदि आपको ऐसा करना हो, तो यह देखने के लिए सैंपल विडियो की समीक्षा करें  कि हमने किस प्रकार इस साउंड ट्रैक के साथ एनिमेशन किया ह।ै हमारी 

एनिमेशन देखने के लिए हमें Microsoft “Windows Media Player” खोलना होगा। अपने Windows के Start menu पर जाएँ और Windows Media Player 

पर देखें। मीडिया प्लेयर में File|Open का चयन करें  और निम्न मूवी खोलें:

चित्र 7.1.11: छोटी वर ट्िकल लाइन्स

चित्र 7.1.12:  हरी तरंग

चित्र 7.1.13:  ऑडियो सिंक
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C:\Program Files\Stop Motion Pro v7\assets\Quickstart\quickstart_movie.mpg

फ्रे म्स को कॉपी, पेस्ट या हाईड करने के लिए एडिटर के उपयोग पर विचार करें  (जसैा कि आपने कार्य  1 में सीखा ह)ै कार्यक्रमों के समय में सुधार करें । 

इस दृश्य को दो बार एनीमेट करने के प्रयास के लिए तयैार रहें। आप देखेंगे कि आपकी एनिमेशन में एक शॉट से दूसरे  तक बहुत परिवर्तन आएगा। अपने 

शॉट्स को अलग-अलग नाम दें ताकि बाद में आप अपनी उन्नति की समीक्षा कर सकें ।

7.1.7 एक मूवी बनाना

अपना एनिमेशन सीक्वेंस बनाने के बाद इसे कई एप्लीकेशंस पर एक्सपोर्ट  किया जा सकता 

ह।ै यदि आप अपनी एनिमेशन को DVD, ईमेल या वेब पर डालना चाहते हैं, या यदि आप विडियो 

एडिटिग सॉफ्टवेयर द्वारा इसमें टाइटल, फेड इन/आउट, डिज़ौल्व म्यूज़िक या अन्य साउंड ट्रैक 

जोड़ना चाहें, तो यह उपयोगी हो सकता ह।ै

•	 Stop Motion Pro से अपनी एनिमेशन की आउटपुट के लिए मेन मेन ूमें File|Make movie 

का चयन करें । मूवी बनाएं डायलॉग दिखाई देगा।

•	 इस उदाहरण के लिए, यह सुनिश्चित करें  कि आपने ऑडियो फाइल का उपयोग करें  

विकल्प का चयन किया ह ैजिसमें वह ऑडियो फाइल शामिल ह ैजो आपने अपनी आउटपुट 

मूवी में अपनी एनिमेशन में उपयोग किया ह।ै

•	 सभी फ्रे म्स चुनें।

•	 आउटपुट मूवी की ऊंचाई और चौड़ाई निर्धा रित करें  (अभी के लिए इसे छोड़ दें) OK पर 

क्लिक करें ।

•	 अपनी एनिमेशन को my animation.wmv नाम दें और इसे अपने डैस्कटॉप पर सेव करें ।

अब आप इस फाइल को देखने के लिए Windows Media player या एडिट करने के लिए 

Windows Movie Maker में खोल सकते हैं। 

अपनी एनिमेशन को फिल्माना परूा करने पर आप अगले चरण में जा सकते हैं, इसे एक मूवी में बदलना।

चित्र 7.1.14:  ऑडियो सिंक शॉट्स

चित्र 7.1.15:  मूवी बनाना
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7.1.8 एक ऑडियो ट् रैक रिकॉर्ड करना

7.1.9 Chroma key

अपनी एनिमेशन पर आपकी अपनी आवाज़ रिकॉर्ड  करना बहुत मज़ेदार होता ह।ै ऑडियो रिकॉर्डर और एक माइक्रोफोन के साथ, एनिमेशन के दौरान 

डायलॉग और साउंड इफ़ेक्ट  जोड़ना आसान होता ह।ै

•	 मेन मेन ूTools|Audio recorder चुनें और ऑडियो रिकॉर्डर विंडो दिखाई देगी।

•	य ह सुनिश्चित करें  कि माइक्रोफोन आपके कंप्यूटर से जुड़ा ह।ै

•	 अपनी ऑडियो रिकॉर्डिंग सेट अप करने के लिए शीर्ष  बाई ंओर से तीन ड्रॉप डाउन मेन ू(डिवाइस, इनपुट और फॉर्मेट) का उपयोग करें ।

•	 Recording Start / Stop बटन दबाएँ। जब आप माइक्रोफोन में बोलते हैं तो आपको रिकॉर्डिंग स्तर के इंडिकेटर (दो हरी बार्स) को देखना चाहिए। 

रिकॉर्डिंग रोकने के लिए Start/Stop बटन पर दोबारा क्लिक करें । आप ऑडियो फाइल्स को सेव कर सकते हैं (बाद में एडिटिग के लिए) या उन्हें 

ऑडियो सिक विंडो में अपनी वर्तमान एनिमेशन में स्वैचालित रूप से syncronise कर सकते हैं।

•	 रिकॉर्डिंग और प्लेयिग के दौरान प्ले स्टोर्ड  फ्रे म्स के रूप में चिन्हित बॉक्स को चकै कर सकते हैं, ऑडियो रिकॉर्ड  करते समय फिल्माई गई एनिमेशन 

का उपयोग मार्गदर्शन के तौर पर कर सकते हैं।

रिकॉर्डिंग परूी होने पर, आप अपने आप ऑडियो सिक टूल में ऑडियो फाइल को इम्पोर्ट  कर सकते हैं, जिसे आप मार्गदर्शन के तौर पर उपयोग कर  

सकते हैं।

अपनी लाइव विडियो में अन्य चित्र के साथ रंगों की एक विशेष सीमा को Chroma key द्वारा प्रतिस्थापित करें । इसे ग्रीन सक्रीन या ब्लू स्क्रीन भी  

कहते हैं।

यह नीचे दिए चित्र में दर्शाया गया ह ैकि कैरेक्टर  (नीला रंग) के आसपास बकैग्राउंड सरू्यास्त के चित्र के साथ कहाँ प्रतिस्थापित होगा।

चित्र 7.1.16:  ऑडियो रिकॉर्डर
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Chroma key टूल के उपयोग के लिए, मेन मेन ूTools|Chroma key चुनें और Chroma key विंडो दिखाई देगी। Chroma key फंक्शंस के उपयोग के लिए 

आपको Chroma key फाइल को स्टोर्ड  फ्रे म के साथ synchronise करना चाहिए।

•	 मेन टूलबार पर स्लाइडर बार द्वारा स्टोर्ड  फ्रे म चुनें।

•	 Chroma key विंडो पर स्लाइडर बार या प्लेबकै बटन द्वारा स्टोर्ड  फ्रे म चुनें।

•	सि क पर क्लिक करें  और बटन पीले रंग में हाईलाइट हो जाएगा।

•	 जब synchronize हो जाएँ, तो लॉक किए गए स्टोर्ड  फ्रे म नंबर और इससे जुड़े क्रोम की के लॉक किए गए स्टोर्ड  फ्रे म नंबर क्रोम की विंडो में दिखाई 

देते हैं।

•	 जब आप मेन टूलबार द्वारा स्टोर्ड  फ्रे म्स में जाएं तो क्रोम की सिक में रहेगी।

Chroma key रंग का चयन करने वाले बटन को चुनें और लाइव विडियो विंडो में माउस के बाएं बटन को उस रंग पर क्लिक करें  जिसे Chroma key चित्र 

से प्रतिस्थापित किया जाना ह।ै tolerance slider की सहायता से लाइव विडियो इमेज के साथ Chroma key फुटेज को मिश्रित करना संभव हो जाता ह।ै

चित्र 7.1.17: बाएँ: Chroma key से पहले

चित्र 7.1.18: बाएँ: Chroma key के उपयोग के बाद
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8. कार्यस्थल में स्वास्थ्य एवं 
सुरक्षा बनाये रखना

यनूिट 8.1 कार्यस्थल में स्वास्थ्य एवं सुरक्षा बनाये रखना

MES/N 1014
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इस मॉड्यलू के अंत में, आप निम्न में सक्षम होंगे:

1.	 संगठन के वर्तमान स्वास्थ्य, सुरक्षा तथा रक्षा नीतियों एवं प्रक्रियाओ ंको समझने तथा इनका अनुपालन करने में।

2.	 अपने व्यवसाय से जुड़ी सुरक्षित कार्य  पद्धतियों को समझने में।

3.	 स्वास्थ्य एवं सुरक्षा से संबंधित सरकारी नियमों एवं नीतियों को समझने में, जिनमें बीमारी, दुर्घटना, आगज़नी या परिसर खाली कराने के लिए 

आपात्कालीन प्रक्रियाएं भी शामिल हैं।

4.	 कार्यस्थल में स्वास्थ्य एवं सुरक्षा के लिए जिम्मेदार व्यक्तियों का पता लगाने में, जिनमें आपात्कालीन स्थिति में सम्पर्क  किये जाने वाले लोग भी 

शामिल हैं।

5.	  सुरक्षा संकेतों, जसेै फायर अलार्म  और सीढ़ी, फायर वार्डन स्टेशन, फर्स्ट एड तथा मेडीकल कक्ष जसेै स्थानों का पता लगाने में।

6.	  आपके कार्यस्थल के ऐसे पहलुओ ंकी पहचान करने में, जो आपके या अन्य लोगों के स्वास्थ्‍य तथा सुरक्षा के लिए जोखिम बन सकते हैं।

7.	 एहतियाती उपायों के माध्यम से कार्यस्थल में स्वय और अन्य लोगों के लिए स्वास्थ्य एवं सुरक्षा सुनिश्चित करने में।

8.	 स्वास्थ्य, सुरक्षा तथा रक्षा को सुधारने के अवसरों की पहचान तथा विनिर्दिष्ट व्यक्ति से उनकी सिफारिश करने में।

9.	 व्यक्ति के प्राधिकारों की सीमाओ ंमें बीमारी, दुर्घटनाओ,ं आग या किसी अन्य प्राकृतिक आपदा जसेै जोखिमों की सुरक्षित तरीके से पहचान करें  तथा 

उन्हें ठीक करने में।

निष्कर्ष 
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यूनिट 8.1: कार्यस्थल में स्वास्थ्य एवं सुरक्षा बनाये रखना

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 एहतियाती उपायों के माध्यम से कार्यस्थल में स्वय और अन्य लोगों के लिए स्वास्थ्य एवं सुरक्षा सुनिश्चित करने में।

2.	 व्यक्ति के प्राधिकारों की सीमाओ ंमें बीमारी, दुर्घटनाओ,ं आग या किसी अन्य प्राकृतिक आपदा जसेै जोखिमों की सुरक्षित तरीके से पहचान करें  तथा 

उन्हें ठीक करने में।

3.	 कार्यस्थल में स्वास्थ्य एवं सुरक्षा के लिए जिम्मेदार व्यक्तियों का पता लगाने में, जिनमें आपात्कालीन स्थिति में सम्पर्क  किये जाने वाले लोग भी 

शामिल हैं।

8.1.1 परिचय
जब इमारत के अन्दर ठहरना सुरक्षित न रहे तो ऐसी स्थिति में आपातकालीन रिक्तीकरण की आवश्यकता होती ह।ै प्रत्येक संगठन में एक खाली कराने 

की प्रक्रिया होती ह।ै प्रत्येक संगठन में, संगठन परिसर के भीतर ही अथवा संगठन परिसर से बाहर एक सुरक्षित स्थान होता ह,ै जहां पर किसी 

आपातकालीन रिक्तीकरण की स्थिति में सभी कर्मचारियों को एकत्रित होना होता ह।ै टीम लीडर टीम का नेततृ्व करता ह,ै और उन्हें सुरक्षित स्थान पर 

ले जाता ह।ै ऐसे मामलों में तुरंत सुरक्षित स्थान पर एकत्र हो जाना बेहद महत्वपरू्ण  होता ह।ै 

यदि आप उचित समय पर सुरक्षित स्थान पर नहीं पहंुचते हैं, तो आपकी सुरक्षा के लिए जिम्मेदार टीम लीडर आपको खोजने के लिए किसी को भेजेगा। 

इससे उस व्यक्ति का जीवन खतरे  में आ जायेगा।

रिक्तीकरण की स्थितियां 

रिक्तीकरण की आवश्यकता वाली आपात-स्थितियों में शामिल ह:ै 

•	 आगज़नी 

•	 विस्फोटक 

•	 बाढ़ 

•	भ कंूप 

•	 समुद्री तफूान 

•	 बवंडर 

•	 विषाक्त सामग्री का उत्सर्जन 

•	 दंगे/उपद्रव 

•	 कार्यस्थल हिसा

प्रत्येक कम्पनी के पास होती ह:ै

•	 एक रिक्तीकरण नीति। सभी टीम लीडरों (TL) की यह जिम्मेदारी होती ह ैकि वे अपने कर्मचारियों को इसके बारे  में सचूित करें । आपके टीम लीडर 

(TL) जब आपको इनके बारे  में आपको सचूित कर रहे हों तो आप उनकी बातों को ध्यान से सुने। असावधानी के कारण जीवन संकट में पड़ सकता 

ह।ै 

•	 आपात स्थितियों के लिए एक निर्दिष्ट स्थान। सुनिश्चित करें  कि ये स्थान आपको पता हो। 

•	 विकलांग व्यक्तियों के लिए एक “मित्र प्रणाली (बडीसिस्टम)”। यदि आप किसी व्यक्ति के मित्र (बडी) हैं, तो सुनिश्चित करें  कि आपके साथ, 

आपका मित्र भी परिसर से सुरक्षित बाहर निकल आया हो। 

चित्र 8.1.1:  रिक्तीकरण की स्थितियां

यूनिट के उद्देश्य  
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•	क ार्य क्षेत्रों में रिक्तीकरण मार्गों के साथ फ्लोर प्लान। सुनिश्चित करें  कि आप इसे समझते हों ताकि आवश्यकता पड़ने पर इसका उपयोग कर सकें । 

•	 एकत्रीकरण स्थान। रिक्तीकरण के पश्चात आपको इन स्थानों पर एकत्रित होने की आवश्यकता होती ह।ै 

•	 आवधिक रिक्तीकरण अभ्यास। सुनिश्चित करें  कि उन अभ्यासों के दौरान आप सभी बातों पर ध्यान दें। आपको अपना जीवन बचाना ह ैऔर आप 

दूसरों का जीवन बचाने में भी सहायक हो सकते हैं। 

8.1.2 बनावटी अभ्यास/ रिक्तीकरण

8.1.3 चिकित्सीय आपातकालीन स्थितियां

अग्नि सुरक्षा तथा रिक्तीकरण योजनाओ ं में आपातकालीन स्थितियों में स्टाफ के कर्तव्यों तथा जिम्मेदारियों का वर्णन किया गया ह।ै स्टाफ को इन 

कर्तव्यों एवं जिम्मेदारियों के बारे  में मालमू हो, यह सुनिश्चित करने में सहायता हेतु सतत् प्रशिक्षण की आवश्यकता होती ह।ै बनावटी आगज़नी की स्थिति 

पदैा करने से कर्मचारियों को इस बात के प्रदर्शन का अवसर मिलता ह ै कि वे अपने उन कर्तव्यों एवं जिम्मेदारियों का सुरक्षित तथा कुशल ढंग से 

निष्‍पादन कर सकते हैं। यह उनके लिए यह दिखाने का समय भी होता ह ैकि वे कार्यस्थल सुरक्षा रणनीतियों से परिचित हैं, तथा अपने संरक्षणाधीन 

व्यक्तियों की सुरक्षा करने हेतु आपके केन्द्र  की अग्नि सुरक्षा तथा निर्गमन सुविधाओ ंका लाभ उठा सकते हैं।

अग्निशमन अभ्यास को एक कृत्रिम आपातस्थिति में कर्मचारियों की प्रतिक्रिया के मूल्यांकन हेतु तयैार 

किया गया ह।ै ये आपके केन्द्र  की अग्नि सुरक्षा/रिक्तीकरण योजनाओ ंतथा कर्मचारी प्रशिक्षण कार्यक्रमों 

का भी एक इम्तिहान होते हैं। सभी अग्निशमन अभ्यास सुचारू रूप से नहीं चलते हैं। यदि कर्मचारी तथा 

प्रबंधन उनसे सीखते हैं तथा अपनी त्रुटियों को सुधारते हैं तो ठीक ह,ै कोई बात नहीं। इसलिए यह 

महत्वपरू्ण  बात ह ैकि हम प्रत्येक बनावटी अभ्यास की समीक्षा की जाए ताकि सामने आने वाली किसी 

भी समस्या का समाधान किया जा सके। संभवत: अपरू्ण  या पुराने पड़ चुके अग्निशमन/रिक्तीकरण 

योजनाओ ं के कारण समस्याएं हैं। सम्भवत: कर्मचारियों को अतिरिक्त प्रशिक्षण प्रदान करने की 

आवश्यकता ह।ै 

अग्निशमन तयैारी योजना के दो प्रमुख अंग निम्नलिखित हैं: 

1.	 एक आपातकालीन कार्र वाई योजना, जिसमें बताया गया हो कि आग लगने की स्थिति में क्या 

करना ह।ै 

2.	 एक आगज़नी रोकथाम योजना, जिसमें बताया गया हो, कि आग लगने से रोकने के लिए क्या 

करना ह।ै 

आपको अपनी तथा अन्य लोगों की सुरक्षा हेतु संगठन द्वारा आयोजित किए जाने वाले अग्निशमन 

अभ्यास में सहभागिता करनी चाहिए। ये बनावटी अभ्यास आग लगने की स्थिति में संगठन की कार्र वाई 

योजना तथा सुरक्षा संकेत-चिन्हों को समझने में आपकी सहायता करते हैं।

आपातकालीन स्थितियों के लिए सभी लोग योजना बनाते हैं। इसी वजह से हम अपने पास एक प्राथमिक चिकित्सा किट रखते हैं। वसेै कार्यस्थल पर लोगों 

को काफी तनाव तथा शारीरिक गतिविधियों से गुज़रना पड़ता ह।ै इसके कारण कुछ चिकित्सीय आपातकालीन स्थितियां उत्पन्न हो सकती हैं। इसलिए 

बेहतर होगा, कि प्राथमिक चिकित्सा उपायों तथा उन्हें स्वय व अन्य लोगों पर क्रियान्वित करने के ज्ञान के साथ तयैार रहें। इस मॉड्यलू में आपको यही 

सचूना प्रदान की जाएगी। ऐसे निर्णायक अवसरों पर की जाने वाली कार्र वाई को समझने के लिए इन चिकित्सीय आपातकालीन प्रक्रियाओ ंपर ध्यान दें। 

इन सत्रों के दौरान ध्यान दें। आप स्वय अपना व अपने मित्रों का जीवन बचाने में सक्षम हो सकते हैं।

चित्र 8.1.2:  बनावटी अभ्यास
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8.1.2.1 चिकित्सीय आपातकालीन स्थिति का सामना करना

एक चिकित्सीय आपातकालीन स्थिति एक दुर्घटनात्मक क्षति अथवा एक चिकित्सीय संकट होता ह।ै इसके कुछ उदाहरण निम्नलिखित हैं: 

•	 व्यक्ति सांस नहीं ले रहा ह ै

•	स् ट्रोक या हृदयाघात 

•	 तेज़ रक्तस्राव 

•	 आघात 

•	 विषाक्तीकरण 

•	 जलना 

एक चिकित्सीय आपातकालीन स्थिति में आपको तत्काल ध्यान देने की आवश्यकता होती ह,ै कई बार तो आपातकालीन सेवा को बुलाने से पहले भी। 

इसलिए अपनी स्वय तथा अन्य लोगों की सुरक्षा हेतु आपको आपातकालीन चिकित्सीय सेवा (EMS) नम्बर ज्ञात होना बेहद ज़रूरी ह।ै 

निम्नलिखित कार्य न करें  

•	 पीड़ित व्यक्ति को कुछ खाने या पीने के लिए देना 

•	 पीड़ित व्यक्ति को अवरुद्ध करना। 

•	 पीड़ित व्यक्ति के चेहरे  पर किसी प्रकार का द्रव छिड़कना या उड़ेलना। 

•	 पीड़ित व्यक्ति को किसी दूसरे  स्थान पर ले जाना (जब तक कि यह पीड़ित व्यक्ति को सुरक्षित रखने का एकमात्र तरीका न हो)। 

रक्तस्राव 

•	 एक डायरेक्ट  प्रेशर बैंडेज से घाव पर सीधा दबाव डालें। 

•	र क्तस्राव को धीमा करने के लिए घाव को ऊपर उठाएं। 

•	र क्तस्राव को कम करने में सहायता करने हेतु आवश्यक होने पर प्रेशर प्वाइंट्स पर अतिरिक्त दबाव डालें। 

बेहोशी

•	 बेहोशी, अर्थात् जब एक संक्षिप्त अवधि के लिए व्यक्ति चेतनाशनू्य हो जाये। ऐसा तब होता ह ैजब मस्तिष्क को रक्त प्रवाह अस्थायी तौर पर कम  

हो जाये।

•	 एक संक्षिप्त अवधि के लिए चेतनाशनू्य होने से फर्श पर गिरने के कारण होने वाली दुर्घटना। 

•	ध ीमी नब्ज़। 

•	 पीली, ठंडी त्वचा तथा पसीना आना। 

बेहोशी के कारण:

•	 बहुत कम मात्रा में भोजन तथा द्रव्यों का सेवन करना (निर्जलीकरण)। 

•	नि म्न रक्तचाप। 

•	निद्रा  का अभाव। 

•	 अत्यधिक थकान। 

बेहोशी के लिए प्राथमिक चिकित्सा: 

•	 पीड़ित व्यक्ति को पीठ के बल लिटाएं तथा उसकी टांगों को हृदय स्तर से ऊपर उठाएं। 

•	 जांच कर सुनिश्चित करें  कि पीड़ित व्यक्ति का वायुमार्ग  अवरुद्ध न हो। 

•	 देखें, कि सांस लेने, खांसी करने या हिलने-डुलने जसैी कोई हरकत हो। 
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•	 कपड़ों को ढीला करें  (टाई, कॉलर, बेल्ट आदि)। 

•	यदि  एक मिनट के अन्दर होश नहीं आता ह,ै तो EMS को कॉल करें । 

आघात 

जब रक्तवह-तंत्र में कोई कमी आती ह,ै तथा ऊतकों तक पर्याप्त ऑक्सीजन नहीं पहंुचती ह,ै तो आघात लगता ह।ै यदि इस स्थिति का तुरंत उपचार न किया 

जाए, तो महत्वपरू्ण  अंग खराब हो सकते हैं, जिसके कारण अंतत: मतृ्यु भी हो सकती ह।ै भय और पीड़ा आपके आघात की स्थिति को और भी बदतर बना 

देते हैं। 

आघात के लिए प्राथमिक चिकित्सा: 

•	 पीड़ित व्यक्ति को लिटाए रखें (यदि सम्भव हो)। 

•	 परैों को 10-12 इंच ऊपर उठाएं, यदि पीठ में क्षति हो या अस्थियां भंग हो तो फिर परैों को ऊपर न उठाएं। 

•	 शरीर का तापमान संतुलित रखने के लिए पीड़ित व्यक्ति को कवर करें । 

•	 पीड़ित व्यक्ति को पर्याप्त मात्रा में ताजी वायु और खुला स्थान प्रदान करें । 

•	 पीड़ित व्यक्ति यदि उल्टियां करना शरु कर देता ह,ै तो उसे उसके बॉईं तरफ रखें। 

•	 कसे हुए कपड़ों को ढीला करें । 

मांसपेशियों में ऐठंन 

•	 ऐठंन को प्रभावहीन करने के लिए प्रभावित मांसपेशी को खींचते हुए सीधा करें । 

•	 ऐठंी हुई मांसपेशी पर दृढ़तापरू्वक मालिश करें । 

•	 प्रभावित स्थान पर नम ऊष्मा का प्रयोग करें । 

•	 ऐठंन यदि फिर भी बनी रहती ह,ै तो चिकित्सीय सहायता लें। 

•	 आराम करें - पीड़ा उत्पन्न करने वाली गतिविधियों एवं क्रियाकलापों से बचें। 

•	 बर्फ  का प्रयोग करें - यह पीड़ा और सजून को कम करने में सहायक होती ह।ै 

•	 कम्प्रेशन- इलास्टिक रैप या बैंडेज पहनने से पड़ने वाले हल्के  दबाव से सजून कम होने में सहायता मिल सकती ह।ै 

•	 ऊपर उठाना- प्रभावित अंग को ऊपर उठाकर हृदय के स्तर तक ले जाने से पीड़ा एवं सजून में कमी आती ह।ै 

अस्थिभंग 

अस्थि की निरन्तरता में किसी भंजन या दरार को अस्थिभग कहते हैं।

विस्थापन

किसी जोड़ पर एक या अधिक अस्थियों के स्थान-परिवर्तन को विस्थापन कहते हैं। आमतौर पर यह कंधों, कोहनी, अंगठेू, अंगुलियों, तथा निचले जबड़े में 

होता ह।ै 

विस्थापन एवं अस्थिभंग के लिए प्राथमिक चिकित्सा:

•	 प्रभावित हिस्से को हिलने-डुलने न दें। 

•	 प्रभावित हिस्से को स्थिर करें ।

•	 कपड़े को एक लटकन (स्लिंग) के रूप में प्रयोग करें । 

•	 बोर्ड  को एक लटकन (स्लिंग) के रूप में प्रयोग करें । 

•	 पीड़ित व्यक्ति को सावधानीपरू्वक स्ट्रेचर पर लिटाएं। 

•	 एक चिकित्सक बुलाएं। 
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8.1.4 प्राथमिक चिकित्सा

प्राथमिक चिकित्सा बॉक्स को सुस्पष्ट रूप से चिन्हांकित करके ऐसे स्थान पर रखना चाहिए, 

जहां वह किसी आपातस्थिति में तुरंत मिल सके। ये कार्यस्थल पर किसी भी स्थान से 100 

मीटर से अधिक दूर नहीं होना चाहिए। वास्तव में, ये किट किसी वॉश-बेसिन के निकट अथवा 

किसी पर्याप्त रोशनी वाले स्थान पर होने चाहिएँ। इनमें रखी जाने वाली चीज़ों की नियमित 

जांच की जानी चाहिए तथा उपयोग की जा चुकी वस्तुओ ंको फिर से भर दिया जाना चाहिये। 

आमतौर पर एक प्राथमिक चिकित्सा बॉक्स की सामग्रियों का विनियमन काननू द्वारा किया 

जाता ह,ै जो कि कम्पनी के आकार तथा संभावित औद्योगिक जोखिमों पर निर्भर करता ह।ै 

एक सामान्य किट में एक धलूरोधी तथा जलरोधी डिब्बे में निम्नलिखित चीज़ें शामिल हो 

सकती हैं: 

•	र ोगाणुहीन बैंडेज, प्रेशर बैंडेज, ड्रेसिग (गेज पड्ैस), तथा स्लिग्स। इन्हें अलग-अलग लपेटा तथा एक धलूरोधी डिब्बे या बगै में रखा होना चाहिए। 

छोटे-मोटे जलने एवं कटने का उपचार करने के लिए हमेशा ही अलग-अलग आकारों की पर्याप्त मात्रा अवश्य उपलब्ध होनी चाहिए। बैंडेज एवं ड्रेसिग 

को बांधने के लिए मेडिकल एडहेसिव टेप (स्ट्रिप प्लास्टर) की भी आवश्यकता होती ह।ै 

•	 घाव को साफ करने के लिए रुई। 

•	 कैं ची, चिमटी (स्पिलिटर के लिए), तथा सेफ्टी पिन। 

•	 एक आई बाथ तथा आई वॉश बोतल। 

•	 तुरंत उपयोग किए जा सकने वाले एन्टीसेप्टिक सोल्यूशन तथा क्रीम। 

•	 साधारण बिना प्रिस्क्रिप्शन वाली दवाएं जसेै कि एस्पिरिन तथा एन्टैसिड।

•	प्रा थमिक चिकित्सा उपचार के बारे  में जानकारी देने वाली एक बुकलेट या लीफलेट।

प्राथमिक चिकित्सा के लिए कुछ प्रशिक्षण की आवश्यकता होती ह,ै परंतु अधिकांश स्थानों पर इसकी व्यवस्था करना आसान ह।ै प्राथमिक चिकित्सा के 

लिए जिम्मेदार व्यक्तियों के नाम तथा स्थान (टेलीफोन नंबर समेत) का विवरण एक नोटिस बोर्ड  पर लगाया जाना चाहिए। कर्मचारियों की सहभागिता, 

विशेष तौर पर आपाकालीन स्थितियों में, की कड़ी सिफारिश की जाती ह,ै तथा प्रत्येक व्यक्ति को चिकित्सीय सहायता प्राप्त करने की प्रक्रिया ज्ञात होनी 

चाहिए। छोटी स्थापनाएं, जिनके पास स्वय की सुविधाएं नहीं हैं, उन्हें किसी निकट के क्लीनिक या अस्पताल से संपर्क  रखना चाहिए, ताकि कोई दुर्घटना 

घटित होने की स्थिति में चिकित्सीय सहायता प्राप्त करने में अधिक समय न लगे, बेहतर होगा कि यह दूरी 30 मिनट से काफी कम समय की रहे। 

क्लीनिक या अस्पताल तक जाने के परिवहन की भी पहले से व्यवस्था होनी चाहिए। आवश्यक होने पर एक बाह्य एम्बुलेंस भी बुलाई जा सकती ह।ै स्ट्रेचर 

उपलब्ध होना भी वांछनीय ह।ै

चित्र 8.1.3:  प्राथमिक चिकित्सा बॉक्स

टिप्पणियां 

___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
___________________________________________________________________________________
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9. संचार/संवाद कौशल एवं 
व्यावसायिक कौशल

यनूिट 9.1- संचार कौशल

यनूिट 9.2- पेशेवर कौशल
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इस मॉड्यलू के अंत में, आप निम्न में सक्षम होंगे:

1.	स्क्रि प्ट और कैरेक्टर  वर्णन को पढ़ें  और समझें।

2.	 समान उन्नति सुनिश्चित करने के लिए कार्य  योजना और प्रोडक्शन कार्यक्रम पढ़ें।

3.	 सहयोगियों से स्पष्ट संवाद करें  और उन्हें प्रभावी रूप से सहयोग जो पिछले या अगले दृश्यों/शॉट्स का कार्य  कर रहे हैं।

4.	नि देशक, एनिमेशन पर्यवेक्षक और निर्माता द्वारा किए जाने वाले आवश्यक संशोधनों को समझें।

5.	प्रो डक्शन के दौरान पेश आई ंचुनौतियों पर चर्चा  करें  और भविष्य के प्रोजेक्ट्स  में इस तरह की चुनौतियों का सामना करने के तरीकों पर चर्चा  करें ।

6.	 जहां आवश्यक हो वहाँ सामूहिक रूप से एवं स्वतन्त्र रूप से कार्य  करने में समर्थ होने के लिए निर्णय लेना।

7.	 शॉट ब्रेक अप और योजना के प्रयास और शॉट के प्रत्येक तत्व के लिए आवश्यक समय की समझ रखें।

8.	 व्यक्तिगत समय सीमाओ ंकी योजना कैसे बनानी ह ैऔर उन्हें प्राथमिकता कैसे देनी ह ैऔर समय पर वितरण कैसे करना ह।ै

9.	 टीम के सदस्य के रूप में प्रभावी ढंग से कार्य  करना और संपरू्ण  टाइमलाइनों को हासिल करने में मदद करना।

10.	 कार्य-उत्पादों और कार्यों को आवश्यकताओ ंके आधार पर प्राथमिकता के क्रम में रखना।

निष्कर्ष 
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यूनिट 9.1: संचार कौशल

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	स्क्रि प्ट और कैरेक्टर  वर्णन को पढ़ें  और समझें।

2.	 सहयोगियों से स्पष्ट संवाद करें  और उन्हें प्रभावी रूप से सहयोग जो पिछले या अगले दृश्यों/शॉट्स का कार्य  कर रहे हैं।

3.	प्रो डक्शन के दौरान पेश आई ंचुनौतियों पर चर्चा  करें  और भविष्य के प्रोजेक्ट्स  में इस तरह की चुनौतियों का सामना करने के तरीकों पर चर्चा  करें ।

9.1.1 परिचय

9.1.2 संचार कौशल की मूल बातों को समझना

सरल तौर पर संचार जानकारी को एक स्थान से दूसरे  स्थान तक स्थानांतरित 

करने का ज़रिया ह।ै

हालांकि यह एक सरल परिभाषा ह,ै परन्तु जब हम एक विषय के बारे  में संवाद करने 

के बारे  में सोचते हैं तब यह एक बहुत जटिल हो जाती ह।ै संचार की कई विभिन्न 

श्रेणियां हैं और ये एक समय में एक या एक से अधिक हो सकती हैं।

प्रभावी ढंग से संवाद करने की क्षमता संबंधों, शिक्षा और कार्य  में महत्वपरू्ण  होता ह।ै 

आप में संचार के अच छ्े  कौशल विकसित करने में सहायता के लिए कुछ कदम और 

सुझाव इस प्रकार हैं।

•	 जानें कि वास्तव में संचार क्या ह:ै संचार एक प्रेषक और प्राप्तकर्ता  के मध्य विभिन्न तरीकों (लिखित शब्द, अशाब्दिक संकेत, शब्दों को बोलने) 

के माध्यम से संकेतों/संदेशों के स्थानातरण की प्रक्रिया ह।ै इसके आलावा यह हमारे  द्वारा संबंधों को स्थापित और संशोधित करने के लिए उपयोग 

की जाने वाली व्यवस्था भी ह।ै

•	 अपने मन की बात कहने का साहस रखें: इस बात में विश्वास कि आप वार्तालाप में एक सार्थक योगदान दे सकते हैं। हर दिन अपनी राय और 

भावनाओ ंके बारे  में जानने के लिए समय निकालें ताकि आप उन्हें अन्य लोगों को पर्याप्त रूप से व्यक्त कर सकें । वे व्यक्ति, जो इसलिए बोलने से 

घबराते हैं क्योंकि उन्हें लगता ह ैकि उनकी बात सार्थक साबित नहीं होगी, उन्हें डरना नहीं चाहिए। ऐसा हो सकता ह ैकि कोई चीज़ एक व्यक्ति के 

लिए महत्वपरू्ण  हो और किसी अन्य व्यक्ति के लिए ऐसा न हो और किसी और के लिए बहुत महत्वपरू्ण  हो।

चित्र 9.1.1:  संचार कौशल

यूनिट के उद्देश्य  
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•	 अभ्यास: उन्नत संचार कौशल का विकास सरल बातचीत के साथ शुरू होता ह।ै संचार कौशल सामाजिक से लेकर पेशेवर तक के रूप में हर रोज़ 

अभ्यास किया जा सकता ह।ै नए कौशल परिष्कृ त होने में समय लगता ह,ै लेकिन हर बार संप्रेषण कौशल उपयोग करते समय आप खुद को नए 

अवसरों और भावी साझेदारियों के प्रस्तुत करते हैं।

9.1.3 अपने दर्शकगणों से जुड़ना

•	 नेत्र संपर्क  बनाना/आँखों में दखेना। चाहे आप बोल रहे हों या सुन रहे हों, जिस व्यक्ति से आप बातचीत 

कर रहे हैं, उसकी आंखों में आंखें डालकर बात करना वार्तालाप को अधिक सफल बना सकता ह।ै  

आंखों का संपर्क  रूचि दर्शाता ह ैऔर बदले में आपके पार्टनर को भी आपमें रूचि लेने के लिए प्रोत्साहित 

करता ह।ै

	 सजगतापरू्वक श्रोता की एक आंख में देखना और फिर दूसरी में देखना इसमें सहायक तकनीक ह।ै दोनों 

के बीच निगाह फिराना, आपकी आंखों को प्रखर दिखाता ह।ै एक अन्य तरकीब यह ह ैकि श्रोता के चेहरे  

पर एक “T” की कल्पना करें , जिसमें पड़ी लाइन भौंहों पर और खड़ी लाइन नाक की सीध में नीचे की 

ओर आती हुई हो। अपनी आंखों से “T” जोन में स्कै न करते रहें।

•	 हाव-भाव का उपयोग करें । आपके हाथों और चेहरे  से प्रकट किए जाने वाले हाव-भाव इसमें शामिल हैं। 

अपने परूे  शरीर को संवाद की मुद्रा में लाएं। व्यक्तियों और छोटे समूहों से छोटे हाव-भावों का उपयोग करें । 

सम्बोधन वाला समूह बड़ा होने पर हाव-भाव भी बड़े हो जाने चाहिए।

•	 मिश्रित संदशे मत दें। आपके शब्दों, हाव-भावों, चेहरे  की अभिव्यक्तियों और लय में तालमेल होना चाहिए। 

किसी को अनुशासित करते समय मुस्कराना, मिश्रित संदेश देता ह ैऔर इसलिए यह अप्रभावी रहता ह।ै 

यदि आपको कोई नकारात्मक संदेश देना हो, तो अपने शब्दों, चेहरे  की अभिव्यक्तियों और लय का 

तालमेल शब्दों से बनाएं।

•	 अपने शरीर के लहजे को लकेर सजग रहें। शारीरिक भाषा, ढेर सारे  शब्दों से कहीं ज़्यादा प्रभावशाली संदेश दे सकती ह।ै आपकी भुजाएं आराम से 

पार्श्व में रखते हुए खुली मुद्रा, आस-पास के लोगों को बताती ह ैकि आप सुलभ हैं और उनकी बात सुनने के लिए तयैार हैं।

»	 दूसरी ओर बंधी बांहें और झुके कंधे वार्तालाप में अरूचि या संप्रेषण की अनिच्छा प्रकट करते हैं। ऐसी शारीरिक भाषा द्वारा प्रायः संवाद शुरू होने 

से पहले रोका जा सकता ह ैजो लोगों को बता देती ह ैकि आप बात नहीं करना चाहते।

»	 उचित भाव-भंगिमा और सुलभ मुद्रा, कठिन वार्तालाप प्रवाह भी अधिक सुचारू बना सकती ह।ै

•	 रचनात्मक दृष्टिकोणों और विश्वासों का प्रकटीकरण। बातचीत में आपके दृष्टिकोण का इस पर बड़ा असर पड़ता ह ैकि आप किस तरह खुद को 

तयैार और किस तरह दूसरों से बात करते हैं। दूसरों के प्रति ईमानदार, धरै्यवान, आशावादी, विनम्र, सम्मानपरू्ण , और उदार बनें। दूसरों की भावनाओ ं

के प्रति संवेदनशील रहें और दूसरों की क्षमताओ ंमें विश्वास करें ।

•	 सुनने के प्रभावी कौशल विकसित करना। न केवल आपको प्रभावी ढंग से बोलना आना चाहिए, बल्कि दूसरों की बात भी अवश्य सुननी चाहिए 

और सामने वाला जिस बारे  में कह रहा ह,ै उसकी बात ध्यान देकर समझनी चाहिए। इस तरह से मत सुनें कि उनकी बात परूी होते ही आप अपने उन 

विचारों या स्मृतियों को प्रकट करने लगें जो दूसरों के बोलते समय आपके दिमाग में उपजी थीं।

चित्र 9.1.2: आंखों का संपर्क

चित्र 9.1.3: हाव-भाव का उपयोग करें
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9.1.4 अपने शब्दों का उपयोग करना

9.1.5 संवाद प्रक्रिया

•	 अपने शब्दों को व्यक्त करें । स्पष्ट बोलें और बड़बड़ाएं नहीं। यदि लोग सदवै आपसे आपकी बात दोहराने को कहते हों, तो खुद को बेहतर तरीके से 

पेश करने का तरीका खोजना ज़्यादा श्रेष्ठ ह।ै

•	 अपने शब्दों का सही उच्चारण करें । लोग आपकी शब्दावली से आपकी क्षमता का आकलन करें गे। यदि आपको ठीक पता न हो कि किसी शब्द 

को कैसे कहना ह,ै तो उसका उपयोग मत करें । रोजाना नए शब्द पढ़ते हुए अपनी शब्दावली को बेहतर बनाएं

•	 सही शब्दों का इस्तेमाल करें । यदि आपको किसी शब्द का अर्थ ठीक पता न हो तो उसका उपयोग मत करें । शब्दकोश उठाएं और रोजाना एक नया 

शब्द सीखने की आदत बनाएं। दिन में अपनी बातचीत में कुछ बार इसे उपयोग करें ।

•	 अपनी बोलने की गति धीमी करें । अगर आप जल्दी-जल्दी बोलेंगे तो लोग आपको नर्वस और हड़बड़ाया हुआ मानेंगे। हालांकि ध्यान रखें कि इतना 

धीमे भी न हों कि लोग आपकी मदद के लिए अपनी तरफ से आपकी बात परूी करने लगें।

•	 अपनी आवाज़ विकसित करें । ऊंची या रिरियाहट भरी आवाज़, अधिकारपरू्ण  नहीं मानी जाती ह।ै वास्तव में, ऊंची और मुलायम आवाज़ आपको किसी 

आक्रामक सहकर्मी का शिकार दिखा सकती ह,ै या दूसरे  आपको गंभीरता से नहीं लेंगे। अपनी आवाज़ का लहजा नीचा रखने का अभ्यास करें । गाने 

का प्रयास करें , लेकिन ऐसा करते हुए अपने सभी पसंदीदा गाने धीमे सुर में गाएं। इसका अभ्यास करें , और फिर एक समय बाद आपकी आवाज़ नीची 

होने लगेगी।

•	 अपनी आवाज़ जीवंत बनाएं। नीरसता से बचें और गतिशीलता अपनाएं। आपके लहजे में क्रम से उतार-चढ़ाव आना चाहिए। रेडिय ो डीजे, इसका एक 

बेहतरीन उदाहरण ह।ै

•	 उचित वॉल्यूम का उपयोग करें । ऐसे वॉल्यूम का उपयोग करें  जो परिस्थिति के अनुसार उपयुक्त हो। जब आप अकेले और निकट हों तो अधिक 

नर्माहट से बोलें। जब आप बड़े समूहों से या बड़ी जगहों पर बोल रहे हों तो तेज़ बोलें।

संवाद प्रक्रिया के अनेक घटक हैं। आइए एक नज़र डालें।

•	 प्रेषकः प्रेषक वह पक्ष होता ह ैजो संदेश भेजता ह।ै लिडसे, निस्संदेह, प्रेषक होगी। उसे संदेश की भी आवश्यकता होगी, जो संप्रेषित की जाने वाली 

सचूना होती ह।ै लिडसे को उसका संदेश एनकोड भी करना होगा, जिसके अंतर्गत वह प्रेषित की जाने वाली सचूना के अपने विचारों को ऐसे रूप में 

रूपांतरित करेग ी, जिसे प्रेषित किया जा सके, जसेै कि शब्द।

•	 संवाद माध्यमः संवाद माध्यम भी चुनना होता ह,ै जो कि संदेश प्रेषण का तरीका होता ह।ै संवाद माध्यम में बोलना, लिखना, वीडियो प्रसारण, 

ऑडियो प्रसारण, ईमेल, पाठ संदेशों और फैक्स के माध्यम से इलेक्ट्रॉनिक प्रसारण, और यहां तक कि अमौखिक संवाद जसेै कि शारीरिक भाषा भी 

शामिल हैं। लिडसे को अपने संवाद का लक्ष्य भी समझना होगा। यह पक्ष ग्राही कहलाता ह।ै

•	 ग्राहीः ग्राही को संदेश डिकोड करने (समझने) में अवश्य सक्षम होना चाहिए, अर्थात वह अपनी मानसिक प्रक्रिया द्वारा संदेश को समझ लेने के 

लायक हो। यदि आप डिकोड नहीं कर सकते, तो संदेश विफल रहता ह।ै उदाहरण के लिए, किसी ऐसी विदेशी भाषा में संदेश भेजने पर जिसे ग्राही 

ठीक से समझ न सके, डिकोडिग विफल हो जाती ह।ै

•	 प्रतिक्रियाः कभी-कभी ग्राही, प्रेषक को प्रतिक्रिया देता ह,ै अर्थात ग्राही द्वारा प्रेषक को एक संदेश वापस भेजा जाता ह।ै उदाहरण के लिए, लिडसे की 

टीम का कोई सदस्य लिडसे के संदेश में प्राप्त किसी सचूना को स्पष्ट करने के लिए प्रश्न के रूप में प्रतिक्रिया दे सकता ह।ै

अब इन सभी घटकों को व्यवस्थित करके संवाद प्रक्रिया का मॉडल तयैार करें :

•	प्रे षक, सचूना एनकोड करता ह।ै

•	प्रे षक, संवाद माध्यम चुनता ह ैजिससे संदेश भेजना होता ह।ै

•	ग्रा ही, संदेश प्राप्त करता ह।ै

•	ग्रा ही, संदेश डिकोड करता ह।ै
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•	ग्रा ही, प्रेषक को प्रतिक्रिया दे सकता ह।ै

9.1.6 7 संवाद प्रक्रिया के मुख्य तत्व

संवाद प्रक्रिया के सात मुख्य तत्व ये हैं: (1) प्रेषक (2) विचार (3) एनकोडिग (4) संवाद माध्यम (5) ग्राही (6) डिकोड करना, और (7) प्रतिक्रिया। संवाद को 

ऐसी प्रक्रिया के रूप में स्पष्ट किया जा सकता ह ैजो किसी संगठन में विभिन्न पदधारक व्यक्तियों के बीच पारस्परिक सामंजस्य प्राप्त करने के लिए तथ्यों 

या विचारों के आदान-प्रदान से संबंधित होती ह।ै संवाद प्रक्रिया कोई स्थिर घटना नहीं बल्कि गतिशील प्रकृति की होती ह।ै इस तरह से संवाद प्रक्रिया को 

एक सतत्‌ और गतिशील आपसी व्यवहार माना जाना चाहिए, जो अनेक परिवर्तनीय कारकों को प्रभावित करती और उनसे प्रभावित होती ह।ै

1.	प्रे षकः अन्य के समक्ष सचूना और विचार प्रस्तुत करने के इरादे से संदेश प्रेषित करने का इच छ्ु क व्यक्ति प्रेषक या संप्रेषक कहलाता ह।ै

2.	व िचारः यह संवाद की विषयवस्तु होता ह।ै यह राय, दृष्टिकोण, अनुभतूि, नज़रिया, आदेश, या सुझाव हो सकता ह।ै

3.	 एनकोडिंगः चूंकि संवाद की विषयवस्तु सदै्धांतिक और अमूर्त  होती ह,ै इसलिए इसे आगे पहंुचाने के लिए कुछ निश्चित प्रतीकों जसेै कि शब्दों, कार्यों, 

या चित्रों आदि का उपयोग आवश्यक होता ह।ै विषयवस्तु का इन प्रतीकों में रूपांतरण एनकोडिग प्रक्रिया कहलाता ह।ै

4.	 संवाद माध्यमः संवाद में रूचि रखने वाले व्यक्ति को अपेक्षित सचूना, विचार इत्यादि प्रेषित करने के लिए माध्यम चुनना होता ह।ै यह सचूना, ग्राही 

तक निश्चित माध्यमों द्वारा प्रसारित करनी होती ह ैजो या तो औपचारिक या अनौपचारिक हो सकते हैं।

5.	ग्रा हीः ग्राही वह व्यक्ति होता ह ैजो संदेश प्राप्त करता ह ैया जिसके लिए संदेश प्रेषित किया जाता ह।ै वांछित उद्‌देश्य प्राप्त करने के लिए ग्राही को 

सर्वश्रेष्ठ संभव तरीके से संदेश समझने का प्रयास करना होता ह।ै

6.	ड िकोडिंगः संप्रेषक से संदेश, या संवाद के प्रतीक प्राप्त करने वाला व्यक्ति उसे इस प्रकार से परिवर्तित करने का प्रयास करता ह ैकि वह परूी तरह 

समझने के लिए उसका अर्थ निकाल सके।

7.	 प्रतिक्रियाः प्रतिक्रिया, यह सुनिश्चित करने की प्रक्रिया होती ह ैकि ग्राही ने संदेश प्राप्त कर लिया ह ैऔर प्रेषक की वांछना के अनुसार उसका उपयुक्त 

अर्थ समझ लिया ह।ै

9.1.7 सुनने के कौशल

•	 सुनना, सबसे महत्त्वपरू्ण  संवाद कौशल है

•	 हम कदाचित किसी अन्य प्रकार के कौशल के बजाय अपने सुनने के कौशल उपयोग करने में अधिक समय व्यतीत करते हैं

चित्र 9.1.4: संवाद प्रक्रिया
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•	 अन्य कौशलों की तरह, सुनने के लिए भी अभ्यास करना होता है

•	 सही ढंग से सुनना, एक सक्रिय प्रक्रिया है

•	 सुनने के लिए ध्यान देना होता ह।ै

प्रभावी ढंग से सुनना

प्रभावी ढंग से सुनना, ध्वनियों का विश्ले षण करने, उन्हें पहचानयोग्य पटैर्नों में व्यवस्थित 

करने, पटैर्नों की व्याख्या करने और अर्थ निकालते हुए संदेश को समझने की प्रक्रिया ह।ै

हमारे  दनैिक जीवन में लोगों के साथ हमें अनुभव होने वाली अनेक समस्याएं प्रमुख रूप से 

अप्रभावी ढंग से सुनने, या सुनने के अभाव के कारण ही होती हैं।

सुनने के बारे में भ्रांतियां

•	 सुनना, मेरी समस्या नहीं ह!ै

•	 सुनना और बस सुनाई पड़ना समान बातें हैं

•	 अच छ्े  पाठक अच छ्े  श्रोता होते हैं

•	 स्मार्ट  लोग अच छ्े  श्रोता होते हैं

•	 सुनना, आयु के साथ बेहतर बनता है

•	 सुनने के कौशल सीखना कठिन ह ै

सुनने के उद्‌दशे्य

•	 सीखना

•	 अपनी समझ बढ़ाना

•	 सलाह या परामर्श देना

•	कि सी की बोरियत दूर करना

•	 संगीत सुनना

सुनने का महत्त्व

•	 प्रभावी ढंग से सुने बिना संवाद परूा नहीं होता

•	 सजग श्रोता, वक्ता को बेहतर बोलने के लिए प्रेरित करता है

•	 अच्छा श्रोता, किसी लापरवाह श्रोता की अपेक्षा बेहतर सीखता है

•	 अच्छा श्रोता, अस्पष्ट बातों को समझकर स्पष्ट अर्थ निकाल सकता है

•	 अच्छा श्रोता, पक्षपात, परू्वमान्यताओ ंऔर दृष्टिकोणों की पड़ताल करना सीखता ह।ै

चित्र 9.1.5: प्रभावी ढंग से सुनना

चरण 1 - सुनाई दनेा: सुना जाना, सुनने की प्रक्रिया का प्रथम अनिवार्य  चरण ह ैऔर यह ध्वनि के संवेदी बोध से संबंधित ह।ै इसके बाद श्रोता, ज्ञात हुई 

ध्वनि को प्रक्रमित करता ह।ै प्रभावी ढंग से सुनने के लिए सजगता से और एकाग्रता से सुना जाना चाहिए।

चरण 2 - छानना: सुनी गई ध्वनियों को महससू करना और छानना, अगला चरण ह।ै सुने गए संदेश को वांछित या अवांछित के रूप में वर्गीकृत किया 

जा सकता ह।ै अवांछित संदेश को रद्‌द कर दिया जाता ह।ै यहां व्यक्ति की निर्णय क्षमता भमूिका निभाती ह,ै अर्थात, छानने की प्रक्रिया वषैयिक होती ह ै

और व्यक्ति यह चुनता ह ैकि उसे अपने लिए क्या सार्थक बचा कर रखना ह।ै

9.1.7.1 सक्रिय होकर सुनने की प्रक्रिया 
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प्रभावी ढंग से सुनने की रूकावटें दो तरह की होती हैं:

1.	भ ौतिक रूकावटें

2.	  लोगों से संबंधित रूकावटें

»	 दहैिक रूकावटें

»	 मानसिक रूकावटें       

भौतिक रूकावटें

•	 शोर

9.1.7.2 प्रभावी ढंग से सुनने की रूकावटें

चरण 3 - समझना: श्रोता इसे समझता ह ैकि वक्ता क्या कहने का प्रयास कर रहा ह।ै यह गतिविधि अवशोषण, ग्रहण, या समावेशित/स्वांगीकृत करना 

कही जा सकती ह।ै श्रोता अपने ज्ञान, अनुभव, दृष्टिबोध, और बोधात्मक शक्ति का उपयोग करता ह।ै

चरण 4 - याद रखना: स्वांगीकृत संदेश भविष्य में स्मरण के लिए स्मृति में संचित किया जाता ह।ै

चरण 5 - प्रतिक्रिया दनेा: संवाद के बाद तुरंत या देर से, यह दर्शाने के लिए संदेश पर प्रतिक्रिया दी जाती ह ै कि संदेश प्राप्त कर और समझ लिया  

गया ह।ै

चित्र 9.1.6: सुनने की प्रक्रिया
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•	 दुर्बल ध्वनियां

•	 दोषपरू्ण  यांत्रिक युक्तियां

•	 बार-बार गतिरोध

•	 बठैने की असुविधाजनक व्यवस्था

•	 असुविधाजनक वातावरण

•	 संदेश अत्यधिक होना

दहैिक रूकावटें

•	 स्वास्थ्य की दशा: श्रोता और वक्ता के स्वास्थ्य की दशाएं, सुनने की सामर्थ्य को प्रभावित करती हैं। बुखार, दर्द , या किसी अन्य तरह की शारीरिक 

परे शानी, व्यक्ति के लिए आराम से सुनना या बोलना कठिन बना देती ह।ै

•	 अक्षमताः श्रवण बाधाएं, खराब ढंग से सुनने का कारण बन सकती हैं। इसी प्रकार, वक्ता के वाणी विकार भी श्रोता के लिए वक्तृ ता को असंगत बना 

सकते हैं। वक्ता का बोलने का अंदाज भी श्रोता के लिए समझना कठिन बना सकता ह।ै

•	 ध्यान इधर-उधर भटकनाः मानव मस्तिष्क लगभग 500 शब्द प्रति मिनट की दर से प्रक्रमित कर सकता ह,ै जबकि वक्ता लगभग 150 शब्द प्रति 

मिनट की दर से ही बोल सकता ह।ै इन दोनों के बीच काफी अंतर होने की वजह से श्रोता का मन भटकने के लिए पर्याप्त समय मिल जाता ह।ै

मानसिक रूकावटें

•	 वक्ता की क्षमता को लकेर अनिश्चित होना: विगत अनुभवों या स्रोतों से प्राप्त इनपुटों के आधार पर, श्रोता के मन में वक्ता की क्षमता को लेकर पहले 

से ही धारणा बनी हो सकती ह।ै वह सोच सकता ह ैकि वक्ता को अच्छा ज्ञान नहीं ह,ै या गहनता और सामर्थ्य का अभाव ह।ै इसलिए श्रोता वह नहीं 

सुनता जो वक्ता कहना चाहता ह।ै

•	 व्यक्तिगत परेशानियां: कभी-कभी श्रोता व्यक्तिगत चिताओ ंव परे शानियों से घिरा होता ह।ै इससे वक्ता द्वारा कही जा रही बात समझना कठिन हो 

जाता ह।ै

•	 दृष्टिकोणः ''यह सब पता ह ैवाले दृष्टिकोण'' के रूप में श्रोता काफी अहंकें द्रित हो सकता ह ैऔर वह नहीं सुन सकता क्योंकि उसे लगता ह ैकि वक्ता 

जो कहना चाहता ह ैवह उसे पहले से जानता ह।ै

•	 अधीरताः श्रोता में दूसरे  व्यक्ति की बात परूी होने देने के लिए पर्याप्त धरै्य  नहीं हो सकता ह।ै वह असहनशील हो सकता ह ैया अपने बिदु चर्चा  में लाने 

के लिए उत्सुक हो सकता ह।ै परिणामस्वरूप उसकी बोलने की इच्छा, उसकी सुनने की इच्छा पर भारी पड़ती ह ैजो एक रूकावट का काम करती ह।ै

•	 भावनात्मक अवरोधः कुछ निश्चित विचारों में हमारे  गहराई से जमे हुए विश्वास, हमारे  लिए ऐसे विचार सुनना कठिन बना देते हैं जो हमारे  विश्वास 

के विपरीत होते हैं। हम ऐसे किसी विचार को गलत तरह से सुन सकते हैं या यह हमारे  दिमाग में हमारी धारणाओ ंके अनुसार विरूपित हो सकता ह ै

या हम इसे बिल्कु ल अनसुना करके रोक सकते हैं। अनेक बार, प्रायः हम किसी चीज़ से जुड़ी दर्दभरी यादों की वजह से उसे परूी तरह से खुद से दूर 

रोक देते हैं।

अच्छे श्रोता बनने के लिए सुझाव

•	 बोलने वाल ेव्यक्ति की ओर अपना पूरा ध्यान लगाएं। खिड़की की तरह, या कमरे  की अन्य गतिविधियों पर ध्यान न दें।

•	 सुनिश्चित करें  कि आपका मन कें द्रित रहे। यदि आपको लगे कि वह व्यक्ति अब जो कहेगा, वह तो आपको पहले से ही पता ह,ै तो आपका ध्यान 

आसानी से भटक सकता ह,ै जबकि आप गलत हो सकते हैं। यदि आपको लगे कि आपका ध्यान भटक रहा ह,ै तो अपने शरीर की मुद्रा बदलें और वक्ता 

के शब्दों पर कें द्रित होने का प्रयास करें ।

•	 अपनी बात कहना शुरू करने से पहल ेवक्ता को उसकी बात पूरी कर लनेे दें। वक्ता जो भी कहना चाहते हैं, बिना हस्तक्षेप के वह परूी बात कहने 

का अवसर मिलना पसंद करते हैं। हस्तक्षेप करने पर ऐसा प्रकट होता ह ैकि आप सुन नहीं रहे हैं, चाहे वास्तव में आप सुन रहे हों। 

•	 बोलना शुरू करने से पहल ेसुनने का कार्य पूरा करें ! अगली बार आपको जो कहना ह,ै वही सोचने में यदि आप व्यस्त रहेंगे तो आप वास्तव में 

सुन नहीं सकते हैं। 
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लहजाः आप द्वारा उपयोग किया जाने वाला वॉल्यूम, संप्रेषित की जाने वाली भावनाओ ंका स्तर और प्रकार, तथा आप द्वारा चुनिदा शब्दों पर दिया गया 

जोर आदि बातें लहजे में शामिल हैं। यदि आप उत्साह के बिना और एकरसता भरे  लहजे में बोलते हैं, तो निश्चित रूप से रोगी बोर हो जाएंगे।

जागरूकता: मौखिक संवाद के लिए, एक विषय अवश्य चाहिए होता ह,ै प्रतिक्रिया करने के लिए, बात कहने के लिए, और इसे शुरू करने के लिए।

व्याकरणः इसकी आवश्यकता इसलिए होती ह,ै ताकि आप वार्तालाप में सही वाक्य व्यवस्थित कर सकें । मौखिक और लिखित रूप में किसी भाषा में 

विशेषज्ञता प्राप्त करने का सही तरीका सीखने के लिए भी व्याकरण उपयोगी ह।ै

शब्दावलीः पर्याप्त शब्दावली न होने पर आप प्रभावी ढंग से संवाद, या अपने विचारों को मौखिक व लिखित रूप में व्यक्त नहीं कर सकते। शब्दावली के 

बिना कुछ भी संप्रेषित नहीं किया जा सकता।

उच्चारणः उच्चारण, आपके बोलते समय स्पष्ट भाषा बोलने का तरीका ह।ै यह स्वरविज्ञान से जुड़ी उस प्रक्रिया से संबंधित ह ैजिसके अनुसार, व्याकरण 

के घटक ऐसे तत्वों और सिद्धांतों के आधार पर बने होते हैं जो इसका निर्धारण करते हैं कि किसी भाषा में ध्वनियां किस तरह परिवर्तित होती और पटैर्न 

बनाती हैं। लोगों के बोलते समय, किसी विशेष भाषा में शब्दों को किस तरह स्पष्ट रूप से उत्पन्न किया जाना ह,ै इसका अध्ययन ही उच्चारण ज्ञान ह।ै 

•	 समझबोध

•	 व्याकरण

•	 शब्दावली

•	 उच्चारण

•	ध ारा प्रवाह होना

•	 शारीरिक भाषा

•	 वक्तृ ता दर

•	 मुख्य विचारों को सुनना। मुख्य विचार सबसे महत्त्वपरू्ण  बिदु होते हैं जो वक्ता बताना चाहता ह।ै वे बातचीत के आरंभ में या अंत में कहे जा सकते हैं, 

और कई बार दोहराए जा सकते हैं। इस तरह के शब्दों से शुरू होने वाले कथनों पर विशेष ध्यान दें जसेै कि, ''मैं इस पर जोर देता हंू कि...'' या ''ध्यान 

रखने वाली बात यह ह ैकि...''

•	 प्रश्न पूछें। यदि आप वक्ता की कही बात उचित प्रकार से न समझ पाएं, तो प्रश्न पछूें । उदाहरण के लिए, आप कह सकते हैं, ''जब आपने कहा कि दो 

एक जसेै जेब्रा, तो क्या आपका मतलब यह था कि दोनों पर धारियां अलग-अलग तरह की हैं?' 

•	 प्रतिक्रिया दें। सीधे बठैें  और वक्ता की आंखों में देखें। आप समझ रहे हैं, यह प्रकट करने के लिए यदा-कदा सिर हिलाएं। किसी उचित बिदु पर आप 

मुस्करा, त्योरी चढ़ा, हंस या चुप रह सकते हैं। ये सब वक्ता को यह जताने के तरीके हैं कि आप सचमुच सुन रहे हैं। याद रखें, आप अपने कानों से ही 

नहीं, अपने चेहरे  से भी सुनते हैं। 

9.1.8 बोलने के कौशल
बोलना वह कौशल ह ैजिसकी पेशेवर माहौल में सबसे ज़्यादा बार ज़रूरत होती ह।ै प्रभावी ढंग से बोलना, कहे गए शब्दों के माध्यम से अपने संदेश को 

दर्शकगणों के सम्मुख प्रभावी ढंग से व्यक्त करने की दक्षता ह।ै बोलना, रचनात्मक अर्थ में एक अंतर्क्रिय ात्मक प्रक्रिया ह,ै जिसमें सचूनाओ ंको मौखिक 

उत्पादित, प्राप्त और प्रक्रमित करना शामिल ह।ै

आपकी नौकरी में बोलने का महत्त्व

एक एनिमेटर के रूप में, बोलने में प्रभावशाली बनना बहुत महत्त्वपरू्ण  ह।ै तो, आप रोगियों से कैसे बोलते हैं, यह रोगी के मन में एक छवि अंकित करता ह।ै 

आपको रोगी से विनम्रता से बोलना होगा ताकि उनको ठेस न लगे। लेकिन यदि आप रोगियों को ठेस पहंुचाए बिना उन्हें कुछ निर्देश देना चाहते हों, तो 

आपको जोर देकर बोलना होगा। अभ्यास, प्रभावी ढंग से बोलने के लिए ज़रूरी ह।ै

बोलने के कौशल के घटक

बोलने के कौशल के महत्त्वपरू्ण  घटक ये हैं:

•	 लहजा

चित्र 9.1.7: बोलने का कौशल
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बोलते समय, संवाद की प्रक्रिया समझने में आसान बनाने के लिए उच्चारण एक बहुत महत्त्वपरू्ण  भमूिका निभाता ह।ै

धाराप्रवाह होनाः धाराप्रवाह होने को धाराप्रवाह और शुद्धतापरू्वक बोलने की सामर्थ्य के रूप में स्पष्ट किया जा सकता ह।ै संकोच, पुनरावतृ्ति, और स्वय-

सुधार के बिना सामान्य गति से बोलना ही धाराप्रवाह होने का अर्थ ह।ै धाराप्रवाह होने के लिए यह महत्वपरू्ण  ह ैकि आप "वो क्या कहते हैं", "मेरा मतलब", 

"उम", "अर", "आह" जसेै फिलर्स का उपयोग न करें ।

शरीर की भाषा: शरीर की भाषा का अर्थ ह ैशरीर की मुद्रा, हाव-भाव, चेहरे  की भाव-भंगिमा और आवाज़ के लहजे के जरिए संवाद करना। शरीर की भाषा 

आपके शब्दों के अनुरूप होनी चाहिए; नहीं तो संभव ह ैकि वह ग्राहकों को भ्रमित कर देगी। अपने शब्दों का समर्थन करने और आपका संदेश सही प्रकार 

से समझा जाए यह सुनिश्चित करने के लिए शरीर की भाषा का सकारात्मक होना महत्वपरू्ण  ह।ै

बोलने की गति: बोलने की गति धीमी होने से वार्तालाप अरुचिकर बन जाता ह।ै मध्यम गति और उपयुक्त आवाज़ के साथ बोलें। एनिमेटर को अपनी 

आवाज़ की गति, रोगी की गति के साथ मिलानी चाहिए। एक एनिमेटर के रूप में, प्रभावी संवाद (सुनने और बोलने का कौशल) का प्रदर्शन करने के लिए, 

आपको चाहिए कि आप:

•	ध रै्य  के साथ सुनें और रोगी के जो भी प्रश्न हों उनका उत्तर दें।

•	 अवलोकनों को नर्स को बताएं। जब आपको रोगी की स्थिति में कोई असामान्यता या कोई अजीब बात दिखाई दे, तो सीधे संबंधित व्यक्ति को  

सचूना दें। 

•	र ोगी के साथ कार्यविधियों की चर्चा  करें  और उसे दनैिक गतिविधियों, जसेै साज-संवार, नहाना, निष्कासन, परिवहन आदि करते समय सहज 

अनुभव कराएं।

9.1.9 पढ़ने का कौशल

•	 पढ़ना, भंडारित जानकारी या विचारों का अर्थ पुनः प्राप्त करने की एक प्रक्रिया ह।ै

•	लिखि त या छपी हुई सामग्री को शांति के साथ या तेज़ी से बोलकर पढ़ने की क्रिया या कौशल: "अतिरिक्त पठन हेतु सुझाव"; "पढ़ने का कौशल"।

•	लिखि त या छपी हुई सामग्री जिसे पढ़ा जा सकता ह:ै "वह मुख्य तौर पर जाससूी कहानियां पढ़ता था"।

पढ़ने का कौशल पाठकों को लिखित सामग्री को अर्थ में बदलने और पठन स्वतन्त्रता, बोध एवं धाराप्रवाहिता के लक्ष्य प्राप्त करने में समर्थ बनाता ह।ै यदि 

पढ़ने के कौशल का अभाव प्रतीत हो, तो पढ़ने के कौशल का आकलन करने की अनुशंसा की जाती है

पढ़ने का उद्देश्य और महत्व

•	 ज्ञान अर्जित करना 

•	 पढ़ने से मानसिक विकास में मदद मिलती है

•	 वार्तालाप कौशल का सुधार होता है

•	 पाठकों को नये शब्दों का अर्थ समझने में मदद मिलती है

•	 शब्दावली, भाषा कौशल विकसित करना

•	यदि  पाठक को किसी विषय के बारे  में कुछ नहीं पता ह,ै तो उसके लिए जानकारी को पकड़ना मुश्किल होगा।

पठन को समझने का मार्ग

1.	 शब्द पुकारना - शब्द संरचनाओ ंको पहचानने की योग्यता।

2.	 शब्दों को समझें - शब्दों के संदर्भ  के अंदर उनका अर्थ समझने की योग्यता।

एक के बिना दूसरे  का कोई वजदू नहीं होता ह।ै 
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9.1.10 लखेन कौशल
लखेन क्या ह?ै 

लेखन संवाद का एक माध्यम ह ैजो संकेतों एवं प्रतीकों को लिपिबद्ध करने के माध्यम से भाषा को निरूपित करता ह।ै लेखन कौशल संवाद का एक 

महत्वपरू्ण  भाग ह।ै लेखन कौशल अच्छा होने से आप अपना संदेश आमने-सामने के या टेलीफोन वार्तालाप की तुलना में कहीं अधिक बड़ी संख्या में लोगों 

तक स्पष्टता एवं आसानी से पहंुचा सकते हैं।

डेटा एंट्री ऑपरेटर के लिए लखेन कौशल का महत्व 

एक एनिमेटर के तौर पर आप अपने लेखन कौशल का उपयोग मेल व रिपोर्ट  लिखने और कार्यस्थल पर प्रभावी ढंग से संवाद करने के लिए करें गे। यह 

मॉड्यलू सामान्य लेखन के साथ आरम्भ होगा और फिर हम रिपोर्ट  लेखन का अभ्यास करें गे। प्रभावी रिपोर्ट  लेखन कई नौकरियों की पहली शर्त होती ह।ै 

एक एनिमेटर के तौर पर प्रभावी लेखन कौशल होना बहुत महत्वपरू्ण  ह ैक्योंकि आपको अकसर ही संगठन के अंदर अन्य लोगों के साथ मेल या लिखित 

रिपोर्टों के जरिए संवाद करना होगा। अच्छा लेखन कौशल आपकी मदद करता ह ैक्योंकि: 

1.	 अच्छी शब्दावली और वर्तनी एवं व्याकरण का उत्कृ ष्ट ज्ञान त्रुटि मुक्त डेटा बनाए रखने में मदद करते हैं। 

2.	 इससे लिखित मेल, रिपोर्ट  आदि की सहायता से मनेैजमेंट के साथ आंतरिक संवाद में मदद मिलती ह।ै 

जब भी आप कुछ लिख रहे हों, तो यह महत्वपरू्ण  ह ैकि आप योजना बनाएं, व्यवस्थित करें  और लिखें:

•	 समस्त उपयोगी जानकारी एकत्र करें  

•	 तय करें  कि क्या चीज़ें महत्वपरू्ण  हैं 

•	च नें कि किन चीज़ों को छोड़ देना ह ै

•	 जानकारी को तर्क संगत ढंग से समूहबद्ध करें  

संक्षिप्त लखेन शलैी के लिए 

•	 अनावश्यक शब्द हटा दें 

पठन के प्रकार 

1.	 उद्देश्य के अनुसार पठन

»	 पाठ्य में कोई विशिष्ट जानकारी तलाशना

»	 इसमें आप “पढ़ने से ज़्यादा छोड़ते हैं।”

»	 इसे खोज कर पढ़ना (सर्च रीडिग) भी कहते हैं

»	 कोई विशिष्ट जानकारी तलाशना

»	 कोई विशिष्ट जानकारी तलाशना

2.	 सरसरी तौर पर पढ़ना

»	 संपरू्ण  पाठ्य की सामान्य समझ

»	 उद्देश्य पर आधारित पठन का सबसे तेज़ प्रकार

»	द्रु त-सर्वेक्षण पठन (रैपिड-सर्वे रीडिग) भी कहते हैं

चित्र 9.1.8: पठन के प्रकार
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•	 वाक्यों को जोड़ें 

•	 पुनः लिखें
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यूनिट 9.2: व्यावसायिक कौशल

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 जहां आवश्यक हो वहाँ सामूहिक रूप से एवं स्वतन्त्र रूप से कार्य  करने में समर्थ होने के लिए निर्णय लेना।

2.	 शॉट ब्रेक अप और योजना के प्रयास और शॉट के प्रत्येक तत्व के लिए आवश्यक समय की समझ रखें।

3.	 व्यक्तिगत समय सीमाओ ंकी योजना कैसे बनानी ह ैऔर उन्हें प्राथमिकता कैसे देनी ह ैऔर समय पर वितरण कैसे करना ह।ै

4.	 टीम के सदस्य के रूप में प्रभावी ढंग से कार्य  करना और संपरू्ण  टाइमलाइनों को हासिल करने में मदद करना।

5.	 कार्य-उत्पादों और कार्यों को आवश्यकताओ ंके आधार पर प्राथमिकता के क्रम में रखना।

9.2.2 निर्णय लनेा

अपने कार्य  को अक्षत रखने और प्रभावी ढंग से कार्य  करने के लिए, आपको नीचे बताए 

गए बिन्दुओ ंका प्रबंधन करना होगा। चलिए उन्हें एक-एक करके समझते हैं।

लोग अकसर कहते हैं कि उन्हें निर्णय लेने में कठिनाई होती ह।ै

दुर्भाग्य से हम सभी को हमेशा ही निर्णय लेने होते हैं, ये निर्णय मामूली भी हो सकते हैं, जसेै 

लंच में क्या खाना ह,ै और ऐसे भी जो जीवन बदल सकते हों, जसेै कहां और किस चीज़ की 

पढ़ाई करना ह,ै और किससे शादी करनी ह।ै

कुछ लोग अधिक से अधिक जानकारी खोजते रहते हैं या अधिक से अधिक लोगों से 

उनकी राय लेते रहते हैं और ऐसा करके वे निर्णय टालते जाते हैं।

कुछ अन्य लोग वोट करवा कर, सचूी में पिन लगा कर या सिक्का उछाल कर निर्णय लेते हैं।

निर्णय लनेा क्या ह?ै

अपने सबसे सरल अर्थ में, निर्णय लेना दो या अधिक क्रिया मार्गों में से एक को चुनने का कार्य  ह।ै

समस्या हल करने की अधिक व्यापक प्रक्रिया में, निर्णय लेने में समस्या के संभावित समाधानों में से चयन करना शामिल होता ह।ै निर्णय सहज-ज्ञान 

प्रक्रिया या तर्काधारी प्रक्रिया, या इन दोनों के संयोजन के द्वारा लिए जा सकते हैं।

सहज-ज्ञान

सहज-ज्ञान का अर्थ ह ैसंभावित क्रिया मार्गों के बारे  में अपनी ‘अन्दर की आवाज़’ को सुनना। हालांकि लोग इसे जादुई ‘अनुभतूि’ जसेै कुछ बताते हैं, पर 

सहज-ज्ञान असल में पिछले अनुभवों और आपकी व्यक्तिगत मान्यताओ ंका एक संयोजन होता ह।ै अपने सहज-ज्ञान को विचार में लेना उचित ह,ै क्योंकि 

यह जीवन के बारे  में आपकी सीख को दर्शाता ह।ै हालांकि यह हमेशा ही वास्तविकता पर आधारित नहीं होता ह,ै यह आपकी धारणाओ ंपर भी आधारित 

होता ह,ै जिनमें से कई धारणाओ ंकी शुरूआत बचपन में हुई होती ह ैऔर इसलिए ज़रूरी नहीं कि वे धारणाएं परिपक्व हों।

इसलिए यह ठीक रहेगा कि आप अपनी अन्दर की आवाज़ को ठीक से जाँच लें, विशेषकर तब जब किसी खास क्रिया मार्ग  के विरुद्ध आपको कोई 

शक्तिशाली अनुभतूि हो रही हो, ताकि आप यह देख सकें  कि आप इस बात का पता लगा सकते हैं या नहीं कि वह अनुभतूि क्यों हो रही ह ैऔर क्या वह 

उचित ह।ै

चित्र 9.2.1: निर्णय लेना

यूनिट के उद्देश्य  
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तर्क -वितर्क

तर्क -वितर्क  का अर्थ ह ैनिर्णय करने के लिए अपने सामने मौजदू तथ्यों और आंकड़ों का उपयोग करना। तर्क -वितर्क  की जड़ें यहां-और-अभी में तथा तथ्यों 

में हैं। हालांकि, यह निर्णय के भावानात्मक पहलुओ ंको नजरअंदाज कर सकता ह,ै और विशेष रूप से, अतीत के ऐसे मुद्दों को नज़रअंदाज कर सकता ह ै

जो निर्णय को अमल में लाने के तरीके को प्रभावित कर सकते हैं।

सहज-ज्ञान निर्णय लेने का एक परू्णतः स्वीकृत साधन ह,ै हालांकि आमतौर पर यह तब अधिक उचित होता ह ैजब निर्णय साधारण प्रकृति का हो या फौरन 

लिया जाना हो।

अधिक जटिल निर्णयों के लिए एक अधिक औपचारिक, संरचित पद्धति की आवश्यकता होती ह,ै जिसमें आमतौर पर सहज-ज्ञान और तर्क -वितर्क , दोनों 

शामिल होते हैं। यह महत्वपरू्ण  ह ैकि किसी परिस्थिति की आवेगी प्रतिक्रियाओ ंके प्रति सावधान रहा जाए।

प्रभावी ढंग से निर्णय लनेा

चाहे व्यक्तिगत स्तर पर हो या संगठन के स्तर पर, निर्णयों का अमल में लाने योग्य होना ज़रूरी होता ह।ै इसलिए यह ज़रूरी ह ैकि आप निर्णय के प्रति 

व्यक्तिगत रूप से प्रतिबद्ध हों और अन्य लोगों को उसके लाभों का विश्वास दिला सकते हों।

इसलिए प्रभावी ढंग से निर्णय लेने की प्रक्रिया को यह सुनिश्चित करने की आवश्यकता होती ह ैकि आप वसैा करने में समर्थ हों।

प्रभावी ढंग से निर्णय लनेा किन चीज़ों से रुक सकता ह?ै

ऐसी कई समस्याएं हैं जो प्रभावी ढंग से निर्णय लेने को रोक सकती हैं। इनमें शामिल हैं:

1.	 पर्याप्त जानकारी न होना: यदि आपके पास पर्याप्त जानकारी नहीं ह ैतो आपको ऐसा लग सकता ह ैकि आप बिना किसी आधार के निर्णय ले रहे हैं। 

थोड़ा समय निकाल कर आवश्यक डेटा इकट्ठा करें , भले ही समय-सीमाएं कड़ी क्यों न हों। यदि आवश्यक हो तो, यह पहचानें कि कौन-सी जानकारी 

आपके लिए सबसे महत्वपरू्ण  होगी और उसी के अनुसार जानकारी इकट्ठा करने की अपनी प्रक्रिया को प्राथमिकता के क्रम में रखें।

2.	 अत्यधिक जानकारी होना: ठीक उल्टी समस्या, पर यह अकसर मौजदू होती ह:ै इतनी सारी विरोधाभासी जानकारी होना कि ‘महत्वपरू्ण  चीज़ों को 

देख पाना’ असंभव हो जाता ह।ै

	 कभी-कभी इसे एनालिसिस परैालिसिस कहते हैं, और इसका उपयोग संगठन के ऐसे निर्णयों में विलंब करने की युक्ति के रूप में भी किया जाता ह ै

जिनमें निर्णय लेने से पहले अधिकाधिक जानकारी की ज़रूरत होती ह।ै

	प्राय ः इस समस्या का हल, कौन-सी जानकारी वास्तव में महत्वपरू्ण  ह ैऔर क्यों, यह तय करने के लिए सभी को साथ लाकर, और निर्णय लेने के 

लिए एक स्पष्ट समय-सीमा, जिसमें जानकारी इकट्ठा करने का चरण भी शामिल होता ह,ै तय करके किया जा सकता ह।ै

3.	 अत्यधिक लोग होना: समिति द्वारा निर्णय लेना कठिन होता ह।ै हर किसी का अपना दृष्टिकोण, अपनी मान्यताएं होती हैं। और हालांकि यह जानना 

महत्वपरू्ण  ह ैकि वे दृष्टिकोण क्या हैं, और वे क्यों व कैसे महत्वपरू्ण  हैं, पर कोई निर्णय लेने के लिए किसी एक व्यक्ति द्वारा उत्तरदायित्व लिया जाना 

आवश्यक हो सकता ह।ै कभी-कभी, कोई निर्णय करना, कुछ भी निर्णय नहीं करने से बेहतर होता ह।ै

4.	निहित  स्वार्थ: निर्णय लेने की प्रक्रियाएं अकसर निहित स्वार्थों के अधीन पाई जाती हैं। ये निहित स्वार्थ  प्रायः खुल्लमखुल्ला प्रकट नहीं किए जाते, 

पर वे एक महत्वपरू्ण  बाधा हो सकते हैं। चूंकि वे खुल्लमखुल्ला प्रकट नहीं किए जाते हैं, इसलिए उनकी पहचान करना कठिन होता ह,ै और इसी वजह 

से उन्हें हल करना भी कठिन होता ह,ै पर कभी-कभी किसी ऐसे व्यक्ति, जो प्रक्रिया से बाहर हो पर लगभग समान पद पर हो, के साथ उनकी 

छानबीन करने से हल तक पहंुच पाना संभव हो जाता ह।ै

	 सभी हितधारकों के साथ, आमतौर पर प्रक्रिया में सहयोग के लिए एक बाहरी फैसिलिटेटर के साथ, तर्क संगत/सहज-ज्ञान संबंधी पहलुओ ं की 

छानबीन करने से भी मदद मिल सकती ह।ै

5.	 भावनात्मक जुड़ाव: लोग अकसर यथा स्थिति से बहुत अधिक जुड़े होते हैं। निर्णयों में बदलाव की संभावनाएं होती हैं, जो बहुत से लोगों को कठिन 

मालमू दे सकती हैं।

6.	क ोई भावनात्मक जुड़ाव नहीं: कभी-कभी कोई निर्णय लेना इसलिए कठिन होता ह ैक्योंकि आपको किसी भी विकल्प से कोई फर्क  ही नहीं पड़ता। 

इस मामले में, निर्णय लेने की संरचित प्रक्रिया से मदद मिल सकती ह,ै जिसमें उठाए जाने वाले कदमों के कुछ ऐसे बेहद वास्तविक लाभों एवं हानियों 

की पहचान की जाती ह ैजिनके बारे  में आपने शायद पहले नहीं सोचा था।
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	 इनमें से कई मुद्दों को संरचित निर्णय प्रक्रिया द्वारा हल किया जा सकता ह।ै इससे निम्नांकित में मदद मिलेगी:

»	 अधिक जटिल निर्णयों को सरल चरणों में बाँटना;

»	य ह देखना कि निर्णयों तक कैसे पहँुचा जाता ह;ै और

»	 समय-सीमाओ ंकी परू्ति  के लिए निर्णय लेने की प्रक्रिया की योजना बनाना।

निर्णय लेने की कई विभिन्न तकनीकें  विकसित की जा चुकी हैं, जिनमें साधारण अनुभवसिद्ध रीतियों से लेकर बेहद जटिल कार्यविधियां तक शामिल हैं।  

कौन-सी विधि प्रयोग की जाएगी यह इस बात पर निर्भर करता ह ैकि निर्णय की प्रकृति क्या ह ैऔर वह कितना जटिल ह।ै

9.2.3 विश्लेषी एवं आलोचनात्मक चितन

विश्ले षी और आलोचनात्मक चितन एक प्रक्रिया ह ैजिसका उपयोग जानकारी के बारे  में सोचने, उसका मूल्यांकन करने और एक निष्कर्ष तक पहँुचने 

के लिए किया जाता ह।ै इसका अर्थ ह ैकि आपको स्वतः ही यह नहीं मान लेना चाहिए कि जानकारी वधै/मान्य ह,ै सत्य ह,ै लाग ूहोती ह ैया सही ह।ै इसके 

बजाए, आपको प्रमाण एकत्र करने चाहिए, सभी पहलुओ ंका तर्क संगत एवं निष्पक्ष ढंग से विश्ले षण करना चाहिए, और वह भी खुले मन से, ताकि आप 

अपने स्वय के निष्कर्ष तक पहंुच सकें ।

डेटा एंट्री ऑपरे टर के लिए विश्ले षी और आलोचनात्मक चितन का महत्व 

एनिमेटर के तौर पर, आपको सिस्टम में विभिन्न सॉफ्टवेयरों पर कार्य  करना होगा। इस कार्य  को प्रभावी ढंग से करने के लिए, डेटा को बस copy  

paste करने से काम नहीं चलेगा, बल्कि आपको जानकारी का विश्ले षण और मूल्यांकन भी करना होगा। इसलिए इस कौशल से निम्नांकित में मदद 

मिलती ह-ै 

•	 अपनी कार्य  आवश्यकताओ ं को परूा करने और संबंधित जानकारी प्रदान करने के लिए ज़रूरतों, आवश्यकताओ ं और निर्भरताओ ं के अनुसार 

जानकारी और गतिविधियों का विश्ले षण करना। 

•	 विभिन्न स्थितियों के समाधान प्रदान करने के लिए कार्य  पर एक विस्तृत एवं रचनात्मक ढंग से अपना मत प्रदान करना।

9.2.4 योजना बनाएं एवं संगठित करें

योजना बनाने और संगठित करने से ऑफिस में आपके समय 

का प्रभावी ढंग से उपयोग हो पाता ह ैक्योंकि आप प्रोजेक्ट के 

आरम्भ से उसके परू्ण  होने तक फोकस बनाए रखते हैं। कार्य 

गतिविधियों और प्रोजेक्ट के लिए व्यापक योजना होने से यह 

सुनिश्चित होता ह ै कि आप सफलता के लिए सभी आवश्यक 

कदम उठाएंगे। संगठित करने के साधनों से आपको गतिविधि 

के नियोजन की प्रगति पर नज़र रखने की सुविधा मिलती ह।ै 

संगठित करने की योजना, गतिविधियों को परूा करने में 

भमूिका निभाने वाले अन्य टीम सदस्यों के साथ परस्पर सहयोग 

और जानकारी साझा करने को भी सरल बनाती ह।ै अपनी 

संगठित करने की विधि में थोड़ा-सा बदलाव करने से आप अपने 

ऑफिस के लिए सबसे प्रभावी नियोजन तंत्र बना सकते हैं।

चित्र 9.2.2: योजना बनाएं एवं संगठित करें
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9.2.4.1 योजना बनाने और संगठित करने के चरण 
चरण 1: प्रत्येक कार्य  गतिविधि से संबंधित नियोजन प्रक्रिया का दायरा और लक्ष्य पहचानें। तय करें  कि गतिविधि या प्रोजेक्ट की सफलता के लिए 

आपको क्या हासिल/परू्ण  करने की आवश्यकता ह।ै यदि वह टीम प्रोजेक्ट ह ैतो कार्य  में भमूिका निभाने वाले कर्मचारियों की पहचान करें ।

चरण 2: गतिविधि के प्रमुख/बड़े कार्यों को ऐसे छोटे-छोटे चरणों में तोड़ें जिन्हें आपको कार्य  परू्ण  करने हेतु करना होगा, मूलतः आपको प्रोजेक्ट के लिए 

करने वाले कार्यों की सचूी (टू-डू लिस्ट) बनानी ह।ै यदि कार्यों पर आपके साथ अन्य कर्मचारी कार्य  कर रहे हैं, तो हर व्यक्ति को एक भमूिका और उसके 

विशिष्ट दायित्व सौंप दें, ताकि कार्यभार विभाजित हो जाए।

चरण 3: कार्य  गतिविधि को परू्ण  करने की समय सीमा तय करें । गतिविधि के प्रत्येक अलग-अलग कार्य  के लिए एक परू्ण  होने की तारीख तय कर दें, यह 

सुनिश्चित करने के लिए कि सभी चीजें समयबद्ध ढंग से परूी हो जाएं। समय-सीमा आने से पहले सभी संबद्ध कार्यों को परूा करने के लिए स्वय को पर्याप्त 

समय दें।

चरण 4: प्रोजेक्ट के कार्यों की हर अंतिम तिथि अपने कैलेंडर पर लिख लें, या अपने कम्प्यूटर में रिमाइंडर सेट कर लें जो समय सीमा पास आने के साथ-

साथ आपकी स्क्रीन पर प्रकट होते रहें।

चरण 5: पहचानें कि कार्य  गतिविधियों में आपका सामना किन संभावित समस्याओ ंया बाधाओ ंसे हो सकता ह।ै प्रोजेक्ट पटरी पर बनाए रखने हेतु उन 

मुद्दों से बचने की कार्य  योजना बनाएं।

चरण 6: प्रमुख/बड़ी कार्य  गतिविधियों, जो कंपनी की सफलता के लिए बहुत महत्वपरू्ण  हैं, के लिए किसी ऑनलाइन प्रोजेक्ट मनेैजमेंट प्रोग्राम का उपयोग 

करें । ये प्रोग्राम जटिल प्रोजेक्ट या कई टीम सदस्यों वाली गतिविधियों के लिए विशेष रूप से प्रभावी होते हैं। प्रगति पर नज़र रखी जाती ह ैऔर सभी 

कर्मचारियों को प्रोग्राम के जरिए अपडेट मिलती रहती हैं।

चरण 7: जब प्रोजेक्ट पर कार्य  करने वाले अन्य लोगों से सक्रिय सहभागिता और फीडबकै की आवश्यकता हो तो नियोजन बठैकें  (मीटिग) आयोजित 

करें । समय का उपयोग प्रभावी ढंग से करने के लिए बठैकों को लक्ष्य पर केन्द् रित और उत्पादक बनाए रखें।

चरण 8: प्रोजेक्ट पर कार्य  कर रहे अन्य सभी कर्मचारियों को नियमित रूप से अपडेट एवं सचूनाएं भेजते रहें। इससे सभी टीम सदस्यों को नवीनतम 

सचूना मिलती रहती ह ैऔर वे अपनी कार्य  सचूियों (टू-डू लिस्ट) एवं समय-सीमाओ ंको आवश्यकतानुसार अपडेट कर पाते हैं।

9.2.5 समय प्रबंधन

अधिक प्रभावी कार्य  एवं उत्पादकता हासिल करने के लिए अपने समय को व्यवस्थित करने, 

संगठित करने, समय निर्धा रित करने और बजट निर्धा रित करने की कला को समय प्रबंधन 

कहा जाता ह।ै

अतः समय प्रबंधन में प्रभावशीलता, कुशलता या उत्पादकता बढ़ाने पर फोकस के साथ, 

विशिष्ट गतिविधियों पर बिताए जाने वाले समय की मात्रा पर सजग ढंग से नियत्रण किया 

जाता ह।ै

इस प्रकार, समय प्रबंधन से व्यक्ति को अधिक संगठित और अधिक उत्पादक बनने में मदद 

मिलती ह।ै 

•	 समय प्रबंधन, विशिष्ट गतिविधियों पर बिताए जाने वाले समय की मात्रा को सजग ढंग 

से नियत्रित करने की प्रक्रिया ह,ै जो विशेषकर कुशलता या उत्पादकता बढ़ाने के लिए की जाती ह।ै 

•	 विशिष्ट कार्यों, प्रोजेक्ट एवं लक्ष्यों को हासिल करते समय, समय का प्रबंधन करने के लिए प्रयोग किए जाने वाले विभिन्न कौशलों, साधनों/टूल्स 

एवं तकनीकों से समय प्रबंधन में सहायता मिल सकती ह।ै

समय प्रबंधन क्यों?

•	 समय बचाने के लिए।

•	 तनाव घटाने के लिए।

चित्र 9.2.3: समय प्रबंधन
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•	 हमारा कार्य  आउटपुट बढ़ाने के लिए।

•	 हमारे  जॉब दायित्वों पर अधिक नियत्रण पाने के लिए।

समय का प्रभावी ढंग से उपयोग कैसे करें ?

•	 प्रभावी नियोजन।

•	 लक्ष्य एवं उद्देश्य तय करना।

•	 समय-सीमाएं तय करना।

•	 दायित्व सौंपना।

•	गति विधियों के महत्व के अनुसार उन्हें प्राथमिकता के क्रम में रखना।

•	 सही गतिविधि पर सही मात्रा में समय व्यतीत करना।

समय प्रबंधन की प्रक्रिया

•	 अपने समय का मूल्य आँकें ।

•	गति विधि लॉग बनाना।

•	 लक्ष्य तय करना।

•	निय ोजन।

•	प्रा थमिकता के क्रम में रखना।

•	 समय-निर्धारण (शेड्यलूिग)।

अपने समय का मूल्य आँकना: अपनी प्रति वर्ष  लागत की गणना करके वास्तविक मूल्य समझें

प्रति वर्ष  लागत = (वेतन + कर + ऑफिस स्थान + ऑफिस उपकरण + आपके द्वारा अर्जित लाभ)

गतिविधि लॉग बनाना: 

•	 जॉब ऑर्डरों पर दिन के दौरान व्यतीत समय का एक यथार्थवादी आकलन करें ।

•	 महत्वपरू्ण /नाजुक क्षेत्रों का पता लगाएं।

•	 हमारे  दिन का उच्च लब्धि वाला समय खोजना।

चित्र 9.2.4: समय का प्रभावी ढंग से प्रयोग करना

चित्र 9.2.5: समय प्रबंधन 

चित्र 9.2.6: अपने समय का मूल्य आँकना

चित्र 9.2.7: गतिविधि लॉग बनाना

लक्ष्य तय करना: 

•	 जीवन लक्ष्य तय करने से अपने जीवन मार्ग  और अपने कैरियर पथ का मानचित्र बनाने में 

मदद मिलती ह।ै

•	 अपने जीवन लक्ष्य को छोटे-छोटे लक्ष्यों में तोड़ें।

•	 एक दनैिक कार्यसचूी (टू-डू लिस्ट) बनाएं। चित्र 9.2.8: लक्ष्य तय करना
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चित्र 9.2.9: नियोजन

•	 अपनी सचूी को रोजाना संशोधित एवं अपडेट करें  और अपने प्रदर्शन का मूल्यांकन करें ।

नियोजन:

•	 एक कार्य  योजना - अपने लक्ष्य हासिल करने के लिए की जाने वाली चीज़ों की एक सचूी 

- तयैार करें ।

प्राथमिकता के क्रम में रखना:

•	 एक कार्यसचूी (टू-डू लिस्ट) बनाएं।

•	 कार्य  को करने से पहले उसके मूल्य पर विचार करें  - क्या वह आपके समय और 

कंपनी संसाधनों को व्यय करने के योग्य ह।ै

•	 अपने कार्य  को प्राथमिकता के क्रम में रखें - सबसे महत्वपरू्ण  कार्यों को सबसे पहले 

परूा किया जाना चाहिए जिसके बाद अन्य कार्य  किए जाने चाहिए। 

समय-निर्धारण (शेड्यूलिंग):

•	 आप कितना कार्य  कर सकते हैं इसका एक यथार्थवादी आकलन तयैार करें ।

•	 उपलब्ध समय का सर्वोत्तम उपयोग करने की योजना बनाएं।

चित्र 9.2.10: प्राथमिकता के क्रम में रखना

•	 ‘अप्रत्याशित कार्यों’ से निपटने के लिए थोड़ा आकस्मिकता समय सुरक्षित रखें।

•	 स्वय के द्वारा और अन्य के द्वारा प्रतिबद्धता से बच कर तनाव को न्यूनतम करें ।

समय प्रबंधन मटै्रिक्स

चित्र 9.2.11: समय प्रबंधन मैट्रिक्स



273272

प्रतिभागी पुस्तिका

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

9.2.6 टीम वर्क
•	 टीमकार्य , समान मान्यता के तहत किसी एक विशिष्ट उद्देश्य के लिए एक टीम के रूप में साथ मिलकर कार्य  कर रहे लोगों की अवधारणा ह।ै

•	यदि  आपको साथ मिलकर कार्य  करना ह ैतो कहीं अधिक अंतर्वैयक्तिक (इंटरपर्सनल) कौशलों की आवश्यकता होगी।

•	 टीम, एक-दूसरे  को परूा करने वाले कौशलों से युक्त लोगों का एक छोटा समूह होती ह,ै जो एक ऐसे साझा उद्देश्य की प्राप्ति के लिए सक्रिय रूप से साथ 

मिलकर कार्य  करते हैं जिसके लिए वे खुद को सामूहिक रूप से जवाबदेह ठहराते हैं।

•	 टीमें, आधुनिक संगठनों में क्रांतिकारी बदलावों के पीछे  के प्रमुख बलों में से एक होती हैं।

टीमकार्य की प्रकृति

•	 टीम सदस्य के साथ मिलकर इस प्रकार से सक्रिय ढंग से कार्य  करते हैं कि उनके सभी कौशलों का उपयोग एक साझा उद्देश्य की प्राप्ति में हो  

जाता ह।ै

•	 टीमकार्य  किसी भी उच्च प्रदर्शन करने वाली टीम का केन्द्रीय  आधार ह।ै

चलिए टीमकार्य  के सबसे महत्वपरू्ण  घटक - आपको इसके बारे  में कैसा महससू होता ह ै- पर विचार करके शुरूआत करते हैं! टीमकार्य  न केवल आपके 

कौशलों पर, बल्कि आपके रवयैे पर भी निर्भर करता ह।ै

साझा दायित्व

•	 इससे टीम सदस्य टीम के प्रदर्शन और उसके परिणाम के लिए समान रूप से जिम्मेदार महससू करते हैं। 

•	 इससे व्यक्तियों को टीम कार्यों को परूा करने के लिए प्राथमिक भमूिकाएं मिलती हैं और टीम के लक्ष्यों व कार्यों को परू्ण  करने के लिए जो भी कुछ 

आवश्यक ह ैउसे करने के लिए वे लचीले बने रह पाते हैं। 

खुला संवाद

•	 इससे भरोसे, खुलेपन और ईमानदार संवाद का माहौल बनता ह ैतथा बना रहता ह।ै 

•	 टीम सदस्यों को आपस में खुल कर बातचीत करने दें। 

•	 फीडबकै/प्रतिपुष्टि का आदान-प्रदान करने को बढ़ावा दें। 

•	 टीम सदस्यों को अपनी गलतफहमियों तथा द्वन्द्वों को दूर करने का अवसर दें। 

निम्न को अपने ध्यान में रखें

•	 टीमवर्क  कामकाज़ी माहौल को बेहतर बनाता ह।ै 

•	 टीमवर्क  संवाद में निरन्तरता बनाए रखता ह।ै 

•	 टीमवर्क  तनाव से राहत देता ह।ै 

•	 टीमवर्क  त्रुटियों को कम करता ह।ै 

•	 टीमवर्क  परस्पर संवाद बनाए रखता ह।ै 

प्रभावी टीम सदस्यों की विशेषतायें

•	 टीम सदस्य परिणाम हासिल करने में सहायक होते हैं। 

•	 टीम सदस्य दूसरों की कीमत/मेहनत पर ‘‘बाज़ी मारने’’ या दूसरों की मेहनत का श्रेय लेने से बचते हैं। 

•	 टीम सदस्य दूसरों के आइडिया पर विचार करने के लिए भी तयैार रहते हैं। 

•	 टीम सदस्य जानकारी तथा विचारों का आदान-प्रदान करते हैं। 

•	 टीम सदस्य दूसरों के योगदान को भी समर्थन देते हैं। 
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9.2.7 ग्राहक-कें द्रस्थता/कें द्रीयता
यद्यपि ग्राहक-कें द्रीयता नई नहीं ह,ै यह अन्य कई के साथ-साथ, डिजिटल मार्केटि ग ट्रांसफॉर्मेशन, कॉर्पोरे ट ‘कस्टमर कल्चर’, ग्राहक अनुभव (प्रबंधन), 

ग्राहक-अभिमुख व्यापार दृष्टिकोण तथा ग्राहक लाइफ साइकिल (सेवा इत्यादि सहित) के संदर्भ में प्रयोग की जाती ह।ै

ग्राहक-कें द्रस्थता/कें द्रीयता यह एक ऐसा शब्द ह,ै जिसे हम सदियों से प्रयोग करते आ रहे हैं - और शायद ऐसे ही कई शब्द और भी – बिना इनके बारे  में 

ज़्यादा कुछ सोचे-समझे, बल्कि कारोबार में प्रत्यक्ष रूप से इसका इस्तेमाल करते हैं। पहला सवालः ग्राहकों पर कें द्रित होने का क्या अर्थ ह?ै

यह निर्भर करता ह।ै हममें से अधिकांश लोग इसे ग्राहक को कें द्र में रखने के अर्थ में प्रयोग करते हैं। समय से पथृक, उसे समझते हुए, ग्राहकों पर महज 

कें द्रित होने के बजाय, ग्राहक मूल्य सजृित करने और वास्तव में ग्राहकों को सर्वोपरि प्राथमिकता देने से यह सर्वाध िक और सबसे स्थायी व्यावसायिक 

मूल्य सजृित करता ह।ै इस अर्थ में यह सामान्य भाषा ह।ै ग्राहकों पर कें द्रित। जसेै कि नजृातिकें द्रित, अहंकें द्रित, भकूें द्रित, या सौरकें द्रित।

ग्राहकों पर कें द्रित कंपनी के गुण

अनेक कंपनियां खुद को ग्राहकों पर कें द्रित बताना पसंद करती हैं, और इसके उपयुक्त कारण होते हैं। अपने ग्राहकों को प्राथमिकता देने वाली कंपनियां 

बेहतर व्यावसायिक परिणाम प्राप्त करती हैं, लोगों से अधिक तारीफें  पाती हैं, और बाज़ार में अधिक नवप्रवर्तक उत्पाद पेश करती हैं। लेकिन जहां अनेक 

कंपनियां ग्राहकों पर कें द्रित होने का दावा करती हैं, वहीं ऐसी कंपनियों की वास्तविक संख्या बहुत कम होती ह।ै तो, आप कैसे जानेंगे कि क्या आपकी 

कंपनी ऐसा अनुभव प्रदान कर रही ह,ै जो आपके ग्राहकों को आनंदित करता हो? सच में ग्राहकों पर कें द्रित कंपनियों पर विचार करते समय 5 विशेषताएं 

देखनी चाहिएः

1.	 सुलभः ग्राहकों पर कें द्रित कंपनियां, ग्राहकों के लिए उनसे संपर्क  करना आसान बनाती हैं, जहां भी, जब भी ग्राहक ऐसा करना चाहें। इसका अर्थ ह ै

कि अपनी साइट और ग्राहक समुदाय को गतिशील और खोज अनुकूलित बनाएं, कि उपयुक्त सोशल मीडिया साइटों पर आपकी मौजदूगी हो, और 

यह कि आपके ग्राहकों को एकदम स्पष्ट पता हो कि वे किस तरह आपसे संपर्क  करें गे।

	 इसका यह भी अर्थ ह ैकि उनसे मतै्रीपरू्ण  और समझने में आसान तरीके से संवाद किया जाए, और उद्योग जगत के तकनीकी अप्रचलित शब्दों और 

गोलमोल सी प्रतिक्रियाओ ंसे इसे बोझिल न बनाया जाए।

2.	 प्रतिक्रियाशीलः आपके ग्राहकों को आपसे जो अपेक्षाएं हैं, उन पर सोशल मीडिया का काफी प्रभाव पड़ता ह।ै न केवल वे हर बार, अपने पसंदीदा 

किसी भी माध्यम से आपसे संपर्क  करने पर प्रतिक्रिया चाहते हैं, बल्कि इसे तुरंत भी पाने की आशा करते हैं! आप अधिकाधिक माध्यमों पर अपनी 

मौजदूगी बनाकर जिसकी आप तर्क संगत ढंग से निगरानी कर सकें  और इन वार्तालापों को आपके ग्राहक समुदाय की ओर मोड़कर इसे संभाल 

सकते हैं। और याद रखें, केवल पहली बार ही उनके संपर्क  करने पर प्रतिक्रिया देना काफी नहीं होता ह।ै आपको हर बार प्रतिक्रिया देनी होगी, और 

कोई नई बात होते ही सबको तुरंत अवगत कराना होगा।

3.	 समानुभूतिपूर्णः अगर आप समानुभतूिपरू्वक प्रतिक्रिया नहीं करते, तो इससे कोई फर्क  नहीं पड़ता कि आपने कितनी तेजी से प्रतिक्रिया दी! सोचें 

कि किसी समस्या पर अपने किसी मित्र से किस तरह बात करते हैं। हां, आप इसे सुलझाने में उनकी मदद करना चाहते हैं। लेकिन पहले आप यह 

सुनिश्चित करना चाहते हैं कि उनको अहसास हो कि आप सुन रहे हैं, आप समझ रहे हैं और आप परवाह करते हैं। अपने ग्राहकों से भी यही तरीका 

अपनाएं, और वे आपके मित्रों की तरह ही आपके प्रति निष्ठावान बने रहेंगे।

4.	 सुसंगतः आपका विभाग पथृक-पथृक खानों में बंटा हो, तो आपके ग्राहकों को तेज, सही सचूना दे पाना कठिन हो जाता ह।ै कोई यह जानना चाह 

सकता ह ैकि आपका अगला उत्पाद कब जारी होगा, कोई दूसरा यह जानना चाह सकता ह ैकि आपकी नवीनतम ग्राफीय सचूना में कही बात आप 

कब परूी कर पाएंगे, और कोई अन्य किसी विशेष पकेैज में शामिल विशेषताओ ंके बारे  में ज्यादा जानना चाह सकता ह।ै जब तक आपकी कंपनी में 

उचित आंतरिक संवाद और सहयोग नहीं होगा, आप इन प्रश्नों के उत्तर तेजी से या ईमानदारी से नहीं दे पाएंगे। इसके लिए हम दि सटैिस्फैक्टर ी नामक 

आंतरिक समुदाय का उपयोग करते हैं। आप क्या उपयोग करते हैं? 

5.	त जेः आपकी कंपनी को ग्राहकों की प्रतिक्रियाओ,ं विचारों, और हां आलोचना के लिए भी खोलने का सबसे महत्त्वपरू्ण  बिदु यह ह ैकि इसे आपकी 

आंतरिक विचार-प्रक्रिया और विकास प्रक्रिया से गुजरने दें। कभी-कभी आपके ग्राहक कोई ऐसी बात कह सकते हैं कि जिसकी आपको उम्मीद न 

रही हो। इसका मतलब यह नहीं ह ैकि आपको उनके हर बार के अनुरोधों के अनुसार ही खुद को ढालना होगा। लेकिन आपकी भावी योजनाओ ंमें 

उनकी टिप्पणियों की प्रमुख भमूिका होनी चाहिए। यदि ऐसा नहीं ह,ै तो प्रतिक्रियाओ ंका क्या लाभ ह?ै
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10. रोज़गार और उद्यमिता 
कौशल

यनूिट 10.1 – व्यक्तिगत शक्तियां एवं मूल्य प्रणाली 

यनूिट 10.2 – डिजिटल साक्षरता: पुनरावतृ्ति

यनूिट 10.3 – पसेै का महत्व

यनूिट 10.4 – रोज़गार और स्व-रोज़गार के लिए तयैारी करना 

यनूिट 10.5 – उद्यमिता को समझना

यनूिट 10.6 – उद्यमी बनने की तयैारी करना
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इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 स्वास्थ्य के अर्थ की व्याख्या करने में

2.	 सामान्य स्वास्थ्य संबंधी समस्याओ ंकी सचूी बनाने में

3.	 आम स्वास्थ्य संबंधी समस्याओ ंकी रोकथाम के उपायों पर चर्चा  करने में

4.	 स्वच्छता के अर्थ की व्याख्या करने में

5.	 स्वच्छ भारत अभियान के उद्देश्य को समझने में

6.	 आदत के अर्थ की व्याख्या करने में

7.	 एक सुरक्षित कार्य  वातावरण स्थापित करने के तरीकों पर चर्चा  करने में

8.	 कर्मचारियों द्वारा अपनाई जाने वाली महत्वपरू्ण  सुरक्षा आदतों पर चर्चा  करने में

9.	 आत्म-विश्ले षण के महत्व की व्याख्या करने में

10.	 मास्लो’स हिरारकी ऑफ नीड्स से प्रेरणा को समझने में

11.	 उपलब्धि प्रेरणा के अर्थ पर चर्चा  करने में

12.	 उपलब्धि प्रेरणा वाले उद्यमियों की विशेषताओ ंकी सचूी बनाने में

13.	 आप को प्रेरित करने वाले विभिन्न कारकों की सचूी बनाने में

14.	च र्चा  करने में कि सकारात्मक रवयैा कैसे बनाए रखा जाए

15.	 आत्म-विश्ले षण में रवयैे/नज़रिये की भमूिका पर चर्चा  करने में

16.	 अपनी शक्ति और कमजोरियों की सचूी बनाने में

17.	 ईमानदार लोगों के गुणों पर चर्चा  करने में

18.	 उद्यमियों में ईमानदारी के महत्व का वर्णन करने में

19.	 एक मजबतू कार्य  नतैिकता के तत्वों पर चर्चा  करने में

20.	च र्चा  करने में कि अच्छी कार्य  नतैिकता को कैसे बढ़ावा दिया जाए

21.	 बेहद रचनात्मक लोगों की विशेषताओ ंकी सचूी बनाने में

22.	 बेहद उन्नतिशील लोगों की विशेषताओ ंकी सचूी बनाने में

23.	 समय प्रबंधन के लाभों पर चर्चा  करने में

24.	 प्रभावी समय प्रबंधकों के गुणों की सचूी बनाने में

25.	 प्रभावी समय प्रबंधन तकनीक का वर्णन करने में

26.	क्रोध  प्रबंधन के महत्व पर चर्चा  करने में

27.	क्रोध  प्रबंधन रणनीति का वर्णन करने में

28.	क्रोध  प्रबंधन के सुझावों पर चर्चा  करने में

29.	 तनाव के कारणों पर चर्चा  करने में

30.	 तनाव के लक्षणों पर चर्चा  करने में

31.	 तनाव प्रबंधन के सुझावों पर चर्चा  करने में

32.	 कंप्यूटर के बुनियादी भागों को पहचनने में

33.	 कीबोर्ड  के बुनियादी भागों को पहचानने में

प्रमुख अभ्यास निष्कर्ष 
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34.	 कंप्यूटर की बुनियादी शब्दावली को याद रखने में

35.	 कंप्यूटर की बुनियादी शब्दावली को याद रखने में

36.	 कंप्यूटर की बुनियादी कंुजियों के कार्यों को याद रखने में

37.	 MS Office की प्रमुख एप्लीकेशंस पर चर्चा  करने में

38.	 Microsoft Outlook के लाभों पर चर्चा  करने में

39.	 ई-कॉमर्स के विभिन्न प्रकारों पर चर्चा  करने में

40.	 खुदरा विक्रे ताओ ंऔर ग्राहकों के लिए ई-कॉमर्स के लाभों की सचूी बनाने में

41.	च र्चा  करने में, कि डिजिटल इंडिया अभियान से भारत में ई-कॉमर्स को कैसे बढ़ावा मिलेगा

42.	 व्याख्या कर सकें गे कि आप एक ई-कॉमर्स मंच पर एक उत्पाद या सेवा कैसे बेचेंगे

43.	 पसेै बचाने के महत्व पर चर्चा  कर सकें गे

44.	 पसेै बचाने के लाभों पर चर्चा  कर सकें गे

45.	 बैंक खातों के प्रमुख प्रकारों पर चर्चा  कर सकें गे

46.	 बैंक में खाता खोलने की प्रक्रिया का वर्णन करने में

47.	 स्थाई और परिवर्ती लागत के बीच अंतर स्पष्ट कर सकें गे

48.	नि वेश विकल्पों के प्रमुख प्रकारों का वर्णन कर सकें गे

49.	 बीमा उत्पादों के विभिन्न प्रकारों का वर्णन कर सकें गे

50.	 करों के विभिन्न प्रकारों का वर्णन कर सकें गे

51.	 ऑनलाइन बैंकिग के उपयोगों पर चर्चा  कर सकें गे

52.	 इलेक्ट्रॉनिक धन हस्तांतरण के प्रमुख प्रकारों पर चर्चा  कर सकें गे

53.	 साक्षात्कार के लिए तयैारी करने के विभिन्न चरणों पर चर्चा  कर सकें गे

54.	 प्रभावी रिज़्यूमे बनाने के विभिन्न चरणों पर चर्चा  कर सकें गे

55.	 साक्षात्कार में अक्सर पछूे  जाने वाले सवालों पर चर्चा  कर सकें गे

56.	च र्चा  कर सकें गे कि साक्षात्कार में अक्सर पछूे  जाने वाले सवालों का जवाब कैसे दिया जाए

57.	 बुनियादी कार्यस्थल शब्दावली पर चर्चा  कर सकें गे

58.	 उद्यमशीलता की अवधारणा पर चर्चा  कर सकें गे

59.	 उद्यमशीलता के महत्व पर चर्चा  कर सकें गे

60.	 उद्यमशीलता की विशेषताओ ंकी चर्चा  कर सकें गे

61.	 उद्यमों के विभिन्न प्रकारों का वर्णन कर सकें गे

62.	 एक प्रभावी नेता के गुणों की सचूी बना सकें गे

63.	 प्रभावी नेततृ्व के लाभों पर चर्चा  कर सकें गे

64.	 एक प्रभावी टीम के गुणों की सचूी बना सकें गे

65.	 प्रभावशाली ढंग से सुनने के महत्व पर चर्चा  कर सकें गे

66.	 प्रभावी तरीके से सुनने की प्रक्रिया पर चर्चा  कर सकें गे

67.	 प्रभावशाली ढंग से बात करने के महत्व पर चर्चा  कर सकें गे

68.	च र्चा  कर सकें गे कि प्रभावशाली ढंग से कैसे बात की जाए

69.	च र्चा  कर सकें गे कि समस्याओ ंको किस प्रकार हल किया जाए
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70.	 समस्या सुलझाने के महत्वपरू्ण  गुणों की सचूी बना सकें गे

71.	 समस्या सुलझाने के कौशल आंकलन के तरीकों पर चर्चा  कर सकें गे

72.	 नगैोशिएशन के महत्व पर चर्चा  कर सकें गे

73.	च र्चा  कर सकें गे कि नगैोशिएट कैसे किया जाए

74.	च र्चा  कर सकें गे कि नए व्यापार अवसरों की पहचान कैसे की जाए

75.	च र्चा  कर सकें गे कि नए व्यापार अवसरों की पहचान अपने व्यवसाय के भीतर कैसे की जाए

76.	 उद्यमी के अर्थ को समझ सकें गे

77.	 विभिन्न प्रकार के उद्यमियों का वर्णन कर सकें गे

78.	 उद्यमियों की विशेषताओ ंकी सचूी बना सकें गे

79.	 उद्यमियों की सफलता की कहानियां याद कर पाएंगे

80.	 उद्यमशीलता की प्रक्रिया पर चर्चा  कर सकें गे

81.	 उद्यमशीलता ईकोसिस्टम का वर्णन कर सकें गे

82.	 उद्यमशीलता ईकोसिस्टम में सरकार की भमूिका पर चर्चा  कर सकें गे

83.	भ ारत में वर्तमान उद्यमशीलता ईकोसिस्टम पर चर्चा  कर सकें गे

84.	 मेक इन इंडिया अभियान के उद्देश्य को समझ सकें गे

85.	 उद्यमिता और जोखिम लेने की क्षमता के बीच संबंध पर चर्चा  कर सकें गे

86.	 उद्यमशीलता और लचीलेपन के बीच संबंध पर चर्चा  कर सकें गे

87.	 एक लचीले उद्यमी की विशेषताओ ंका वर्णन कर सकें गे

88.	च र्चा  कर सकें गे कि असफलता से कैसे निपटा जाए

89.	च र्चा  कर सकें गे कि विपणन (मार्के ट) शोध कैसे किया जाए

90.	 मार्केटि ग के 4 P का वर्णन कर सकें गे

91.	 विचार उत्पत्ति के महत्व पर चर्चा  कर सकें गे

92.	 बुनियादी व्यापार शब्दावली को याद कर सकें गे

93.	 CRM की आवश्यकता पर चर्चा  कर सकें गे

94.	 CRM के लाभों पर चर्चा  कर सकें गे

95.	 नेटवर्किंग  की आवश्यकता पर चर्चा  कर सकें गे

96.	 नेटवर्किंग  के लाभों पर चर्चा  कर सकें गे

97.	 लक्ष्यनिर्धारण के महत्व को समझ सकें गे

98.	 अल्पकालिक, मध्यम अवधि और लंबी अवधि के लक्ष्यों के बीच अंतर कर सकें गे

99.	च र्चा  कर सकें गे कि एक व्यवसाय योजना कैसे लिखी जाए

100.	वित्तीय योजना प्रक्रिया की व्याख्या कर सकें गे

101.	अपने जोखिम को प्रबंधित करने के तरीकों पर चर्चा  कर सकें गे

102.	बैंक से वित्त के लिए आवेदन करने की प्रक्रिया और औपचारिकताओ ंका वर्णन कर सकें गे

103.	चर्चा  कर सकें गे कि अपने उप्रकम का प्रबंधन कैसे किया जाए

104.	ऐसे महत्वपरू्ण  प्रश्नों की सचूी बना सकें गे जो प्रत्येक उद्यमी को उप्रकम शुरू करने से पहले पछूने चाहिए
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यूनिट 10.1: व्यक्तिगत शक्ति और मूल्य प्रणाली

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 स्वास्थ्य के अर्थ की व्याख्या करने में

2.	 सामान्य स्वास्थ्य संबंधी समस्याओ ंकी सचूी बनाने में

3.	 आम स्वास्थ्य संबंधी समस्याओ ंकी रोकथाम के उपायों पर चर्चा  करने में

4.	 स्वच्छता के अर्थ की व्याख्या करने में

5.	 स्वच्छ भारत अभियान के उद्देश्य को समझने में

6.	 आदत के अर्थ की व्याख्या करने में

7.	 एक सुरक्षित कार्य  वातावरण स्थापित करने के तरीकों पर चर्चा  करने में

8.	 कर्मचारियों द्वारा अपनाई जाने वाली महत्वपरू्ण  सुरक्षा आदतों पर चर्चा  करने में

9.	 आत्म-विश्ले षण के महत्व की व्याख्या करने में

10.	 मास्लो’स हिरारकी ऑफ नीड्स से प्रेरणा को समझने में

11.	 उपलब्धि प्रेरणा के अर्थ पर चर्चा  करने में

12.	 उपलब्धि प्रेरणा वाले उद्यमियों की विशेषताओ ंकी सचूी बनाने में

13.	 आप को प्रेरित करने वाले विभिन्न कारकों की सचूी बनाने में

14.	च र्चा  करने में कि सकारात्मक रवयैा कैसे बनाए रखा जाए

15.	 आत्म-विश्ले षण में रवयैे/नज़रिये की भमूिका पर चर्चा  करने में

16.	 अपनी शक्ति और कमजोरियों की सचूी बनाने में

17.	 ईमानदार लोगों के गुणों पर चर्चा  करने में

18.	 उद्यमियों में ईमानदारी के महत्व का वर्णन करने में

19.	 एक मजबतू कार्य  नतैिकता के तत्वों पर चर्चा  करने में

20.	च र्चा  करने में कि अच्छी कार्य  नतैिकता को कैसे बढ़ावा दिया जाए

21.	 बेहद रचनात्मक लोगों की विशेषताओ ंकी सचूी बनाने में

22.	 बेहद उन्नतिशील लोगों की विशेषताओ ंकी सचूी बनाने में

23.	 समय प्रबंधन के लाभों पर चर्चा  करने में

24.	 प्रभावी समय प्रबंधकों के गुणों की सचूी बनाने में

25.	 प्रभावी समय प्रबंधन तकनीक का वर्णन करने में

26.	क्रोध  प्रबंधन के महत्व पर चर्चा  करने में

27.	क्रोध  प्रबंधन रणनीति का वर्णन करने में

28.	क्रोध  प्रबंधन के सुझावों पर चर्चा  करने में

29.	 तनाव के कारणों पर चर्चा  करने में

30.	 तनाव के लक्षणों पर चर्चा  करने में

31.	 तनाव प्रबंधन के सुझावों पर चर्चा  करने में

यूनिट के उद्देश्य 
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10.1.1 स्वास्थ्य, आदतें, स्वच्छता: स्वास्थ्य क्या है
विश्व स्वास्थ्य संगठन (WHO) के अनुसार, स्वास्थ्य "परू्ण  शारीरिक, मानसिक और सामाजिक आरोग्यता की स्थिति ह,ै न कि केवल रोग या दुर्बलता का 

अभाव।" इसका अर्थ ह ैकि स्वस्थ होने का अर्थ यह नहीं होता ह ैकि आप अस्वस्थ नहीं हैं - इसका अर्थ यह भी ह ैकि आपको भावनात्मक रूप से शांत होना 

चाहिए और शारीरिक रूप से फिट महससू करना चाहिए। उदाहरण के लिए, आप यह नहीं कह सकते कि आप स्वस्थ हैं क्योंकि आपको को सर्दी या खांसी 

जसैी शारीरिक बीमारियां नहीं ह।ै आपको यह भी सोचना होगा कि, क्या आप शांत, तनाव-मुक्त और प्रसन्नचित्त महससू कर रहे हैं।

आम स्वास्थ्य संबंधी समस्याएँ

कुछ आम स्वास्थ्य संबंधी समस्याएँ हैं:

•	 एलर्जी

•	 दमा

•	 त्वचा संबंधी रोग

•	 अवसाद और चिता

•	 मधुमेह

•	 खांसी, जुकाम, गला खराब

•	 नींद कम आना

•	 मोटापा

10.1.1.1 स्वास्थ्य संबंधी समस्याओ ंकी रोकथाम के लिए सुझाव 

खराब स्वास्थ्य की रोकथाम करना किसी रोग या बीमारी के लिए उपाय करने से हमेशा बेहतर होता ह।ै आप इसके द्वारा स्वस्थ रह सकते हैं:

•	 फल, सब्जियों और गिरियों जसेै स्वस्थ खाद्य पदार्थ  खाकर

•	 अस्वस्थ और शर्कर ायुक्त खाद्य पदार्थों का सेवन कम करके

•	 हर रोज़ पर्याप्त पानी पी कर

•	ध मू्रपान या शराब का सेवन न करके

•	 एक दिन में कम से कम 30 मिनट व्यायाम करके, एक सप्ताह में 4-5 बार

•	 आवश्यकता अनुसार टीकाकरण कराके

•	य ोग व्यायाम और ध्यान का अभ्यास करके

इनमें से आप कितने स्वास्थ्य मानकों का पालन करते हैं? आप पर लाग ूहोने वालों पर निशान लगाएँ।

1.	 हर रात कम से कम 7-8 घंटे सोते हैं।	 
2.	 सुबह उठ कर सबसे पहले और सोने से ठीक पहले ईमेल चेक करने से बचते हैं।	 
3.	 कभी भोजन नहीं छोड़ते हैं - सही समय पर नियमित रूप से भोजन करते हैं।	 
4.	 प्रत्येक दिन थोड़ा-बहुत पढ़ते हैं।	 
5.	 जंक फूड से अधिक घर पर पकाया गया खाना खाते हैं	 
6.	 बठेै रहने की तुलना में खड़े अधिक रहते हैं।	 
7.	 सुबह उठ कर सबसे पहले एक गिलास पानी पीते हैं और सारा दिन कम से कम 8 गिलास पानी पीते हैं।	 
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10.1.1.2 स्वच्छता क्या ह?ै

8.	नियमि त जाँच के लिए डॉक्टर और दंत चिकित्सक के पास जाते हैं।	 
9.	 एक सप्ताह में कम से कम 5 बार 30 मिनट के लिए व्यायाम करते हैं।	 
10.	 अधिक वातित पेय पदार्थों के सेवन से बचते हैं।	 

विश्व स्वास्थ्य संगठन (WHO) के अनुसार, "स्वच्छता ऐसी स्थिति और अभ्यास हैं, जो स्वास्थ्य को बनाए रखने और रोगों के प्रसार को रोकने में मदद 

करती हैं।" सरल शब्दों में, स्वच्छता का अर्थ यह सुनिश्चित करना ह ैकि आप वह सब करते हैं जो आपके आसपास के वातावरण को साफ रखने के लिए 

आवश्यक ह,ै जिससे आप कीटाणुओ ंऔर बीमारियों के प्रसार की संभावना को कम कर सकें ।

उदाहरण के लिए, अपने घर में रसोई के बारे  में सोचें। अच्छी स्वच्छता सुनिश्चित करने का अर्थ ह ैकि रसोई हमेशा साफ और दाग रहित ह,ै भोजन ढक कर 

रखा जाता ह,ै बर्तन धो दिए जाते हैं और कचरे  का डिब्बा कचरे  से लबालब भरा हुआ नहीं रहता। ऐसा करने से हम चहूों या तिलचट्टे जसेै कीटों को आकर्षित 

करने की संभावना को कम कर देते हैं, और कवक तथा अन्य रोग फैलाने वाले जीवाणुओ ंके विकास को रोक देते हैं।

इनमें से आप कितने स्वास्थ्य मानकों का पालन करते हैं? आप पर लाग ूहोने वालों पर निशान लगाएँ।

1.	र ोज़ साबुन से नहाते हैं - और सप्ताह में 2-3 बार शमै्पू से अपने बाल धोते हैं।	 
2.	 हर रोज़ साफ, धुले हुए अंतर्वस्त्र पहनते हैं।	 
3.	 सुबह और सोने से पहले अपने दाँत ब्रश करते हैं।	 
4.	नियमि त रूप से अपने हाथ और परैों के नाखनू काटते हैं।	 
5.	 शौचालय जाने के बाद साबुन से हाथ धोते हैं।	 
6.	यदि  आप को बहुत पसीना आता ह,ै तो अपने अंडरआर्म  पर दुर्गंध रोधी डिओडोरें ट का प्रयोग करते हैं।	 
7.	 खाना पकाने या खाने से पहले साबुन से अपने हाथ धोते हैं।	 
8.	 जब आप बीमार होते हैं तो घर पर रहते हैं, ताकि आपकी बीमारी की चपेट में अन्य लोगों भी ना आ जाएं।	 
9.	ग दे कपड़ों को फिर से पहनने से पहले उन्हें कपड़े धोने के साबुन से धोते हैं।	 
10.	 जब आपको खांसी या छीकें  आती हैं तो अपने नाक को एक टिश्यू/अपने हाथ से ढक लेते हैं।	 
हर लगाए गए निशान के लिए स्वय को 1 अंक देकर देखें कि आप कितने स्वस्थ और स्वच्छ हैं! फिर अपने अंकों पर ध्यान दें कि उनका क्या अर्थ ह।ै

आपके अंक

•	 0-7/20: आप को फिट और ठीक रहने के लिए बहुत कठिन काम करने की आवश्यकता ह!ै इसे दनैिक अच्छी आदतों का अभ्यास करने के लिए एक 

शुरुआत बनाएं और देखें कि आप कितना बेहतर महससू करते हैं!

•	 7-14/20: बुरा नहीं ह,ै लेकिन सुधार की गंुजाइश ह!ै कोशिश करें  और अपनी दिनचर्या  में कुछ और अच्छी आदतें जोड़ें।

•	 14-20/20: बहुत अच्छा! अच्छा काम करते रहें! आपका शरीर और मन आपको धन्यवाद करता ह!ै
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10.1.1.3 स्वच्छ भारत अभियान

10.1.1.4 आदतें क्या हैं?

स्वय के लिए अच्छी स्वच्छता और स्वास्थ्य पद्धतियों का पालन करने के महत्व पर हम पहले ही चर्चा  कर चुके हैं। लेकिन, स्वस्थ और स्वच्छ रहने के लिए 

हमारे  लिए इतना ही पर्याप्त नहीं ह।ै हमें इन मानकों का अपने घरों, अपने आस-पास और समग्र रूप से परूे  देश में भी प्रसार करना होगा।

2 अक्टूबर 2014 को प्रधानमंत्री श्री नरेन्द्र  मोदी द्वारा शुरू किया गया 'स्वच्छ भारत अभियान' वास्तव में ऐसा करने में विश्वास रखता ह।ै इस मिशन का 

उद्देश्य गलियों और भारत की सड़कों को साफ करना और साफ-सफाई के समग्र स्तर को बढ़ाना ह।ै वर्तमान में इस मिशन में देश भर के 4,041 शहर और 

नगर शामिल हैं। हमारे  लाखों लोगों ने एक स्वच्छ भारत के लिए संकल्प लिया ह।ै आप को भी प्रतिज्ञा लेनी चाहिए, और अपने देश को साफ रखने के लिए 

हर संभव प्रयास करना चाहिए!

आदत एक तरह का व्यवहार होती ह ैजिसे अक्सर दोहराया जाता ह।ै हम सभी में कुछ अच्छी आदतें और कुछ बुरी आदतें होती हैं। जॉन ड्राइडन द्वारा कही 

गई बात को मन में रखें: "हम पहले अपनी आदतें बनाते हैं, और फिर हमारी आदतें हमें बनाती हैं।" यही कारण ह ैकि यह बहुत महत्वपरू्ण  ह ैकि आप अच्छी 

आदतों को जीवन का हिस्सा बनाएँ, और ध्यानपरू्वक बुरी आदतों से बचें।

कुछ आदतें जिन्हें आपको अपनी दिनचर्या  का हिस्सा बनाना चाहिए:

•	 हमेशा सकारात्मक रवयैा रखें

•	 व्यायाम को अपनी दिनचर्या  का हिस्सा बनाना

•	 प्रेरक और प्रेरणादायक कहानियां पढ़ना

•	 मुस्कुर ाना! जितनी बार संभव हो उतनी बारे  मुस्कुर ाने की आदत डाल लें

•	 परिवार और दोस्तों के लिए समय निकालें

•	 सुबह जल्दी उठें  और रात को जल्दी सोएँ

कुछ बुरी आदतें जो आपको तुरंत छोड़ देनी चाहिएं:

•	 नाश्ता ना करना

•	 अक्सर स्नैक्स खाना, भले आप को भखू ना ही लगी हो

•	 बहुत ज़्यादा वसा वाला और मीठा भोजन खाना

•	 धमू्रपान करना, शराब पीना और नशा करना

•	 अपनी आय से अधिक पसैा खर्च करना

•	 महत्वहीन बातों के बारे  में चिता करना

•	 देर रात तक जागना और सुबह देरी से उठना

10.1.1.5 सुझाव 
•	 निम्न स्वस्थ और स्वच्छ पद्धतियों का पालन करने से आप स्वय को हर रोज़ मानसिक और शारीरिक रूप से अच्छा महससू करें गे।

•	 स्वच्छता स्वास्थ्य का दो-तिहाई ह ै- इसलिए अच्छी स्वच्छता से आप को मज़बतू और स्वस्थ रहने में मदद मिलेगी!
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10.1.2 सुरक्षा: एक सुरक्षित कार्यस्थल तयैार करने के लिए सुझाव

10.1.2.1 परक्राम्य/विनिमेय कर्मचारी सुरक्षा आदतें

10.1.3 आत्म-विश्लेषण - रवयैा, उपलब्धि प्रेरणा

10.1.2.2 सुझाव 

यह सुनिश्चित करना प्रत्येक नियोक्ता का दायित्व ह ैकि उसके कार्यस्थल पर उच्चतम संभव सुरक्षा प्रोटोकॉल का पालन होता हो। जब एक व्यवसाय 

स्थापित करना हो, तो मालिकों को इसे ध्यान में रखना चाहिए:

•	 गिरने और घमूने जाने से बचने के लिए श्रम-दक्षता की दृष्टि से तयैार फर्नीचर और उपकरणों का उपयोग करें

•	 भारी वस्तुओ ंको उठाने या ढोने से बचने के लिए यांत्रिक सहायता प्रदान करें

•	 खतरनाक कार्यों के लिए सुरक्षा उपकरण पास रखें

•	 आपातकालीन निकास निर्धा रित करें  और सुनिश्चित करें  कि वे आसानी से सुलभ हो

•	 स्वास्थ्य कोड निर्धा रित करें  और सुनिश्चित करें  कि उन्हें लाग ूकिया जाए

•	 कार्यस्थल में और उसके आस-पास नियमित रूप से सुरक्षा निरीक्षण की प्रथा का पालन करें

•	 सुनिश्चित करें  कि नियमित रूप से ईमारत का निरीक्षण किया जाए

•	 कार्यस्थल सुरक्षा पर विशेषज्ञ सलाह प्राप्त करें  और उसका पालन करें

यह सुनिश्चित करना प्रत्येक नियोक्ता का दायित्व ह ैकि उसके कार्यस्थल पर उच्चतम संभव सुरक्षा प्रोटोकॉल का पालन होता हो। जब एक व्यवसाय 

स्थापित करना हो, तो मालिकों को इसे ध्यान में रखना चाहिए:

•	 असुरक्षित स्थितियों की सचूना तुरंत पर्यवेक्षक को दें

•	 सुरक्षा संबंधी खतरों को पहचानें और उनकी सचूना दें जो फिसलने, लड़खड़ाने, और गिरने का कारण बन सकते हैं

•	 सभी चोटों और दुर्घटनाओ ंकी सचूना पर्यवेक्षक को दें

•	 आवश्यकता अनुसार सही सुरक्षा उपकरण पहनें

•	 जानें कि सुरक्षा उद्देश्यों के लिए प्रदान किए गए उपकरण का उपयोग सही ढंग से कैसे किया जाए

•	 ऐसी क्रियाओ ंपर ध्यान दें और उनसे बचें जिनसे अन्य लोगों को खतरा हो सकता है

•	 दिन के दौरान कुछ समय के लिए आराम करें  और सप्ताह में कुछ समय के लिए काम से दूर रहें

•	 जानकारी प्राप्त करें  कि कार्यस्थल पर आपात स्थिति के समय में किस आपातकालीन नंबर पर कॉल की जाए

•	 अफरा तफरी में निकासी से बचने के लिए नियमित रूप से निकासी अभ्यासों का अभ्यास करें

सही मायने में अपनी परूी क्षमता हासिल करने के लिए, आप को अपने अंदर झाँकने और पता लगाने की आवश्यकता ह ैकि वास्तव में आप किस तरह के 

व्यक्ति हैं। अपने व्यक्तित्व को समझने के इस प्रयास को आत्म-विश्ले षण के रूप में जाना जाता ह।ै इस तरह से खुद का आंकलन करने से आपको अपने 

विकास में मदद मिलेगी, और इससे आप को अपने भीतर ऐसे क्षेत्रों की पहचान करने में भी मदद मिलेगी जिनमें आपको उन्हें और विकसित करने, बदलने, 

या छोड़ने की आवश्यकता ह।ै आप अपने अंदर झाँककर स्वय को बेहतर समझ सकते हैं कि आपको क्या प्रेरित करता ह,ै आपका रवयैा कैसा ह,ै और 

आपकी शक्तियाँ और कमज़ोरियां क्या हैं।
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10.1.3.1 प्रेरणा क्या ह?ै

10.1.3.2 मास्लो’स हिरारकी ऑफ नीड्स (Maslow’s Hierarchy of Needs)

सरल शब्दों में कहें, प्रेरणा आपके क्रिया करने का कारण ह ैया आप का किसी विशिष्ट तरीके से व्यवहार करना ह।ै यह समझना बहुत महत्वपरू्ण  ह ैकि 

सभी लोग एक समान चीज़ों से प्रेरित नहीं होते हैं - लोग कई तरह की अलग-अलग चीज़ों से प्रेरित होते हैं। हम इसे मास्लो’स हिरारकी ऑफ नीड्स 

(Maslow’s Hierarchy of Needs) को देखकर बेहतर समझ सकते हैं।

प्रसिद्ध अमेरिकी मनोवजै्ञानिक इब्राहीम मास्लो (Abraham Maslow) समझना चाहता था कि लोगों को क्या प्रेरित करता ह।ै उनका मानना ​​था कि लोगों 

की पाँच प्रकार की ज़रूरतें होती ह,ै इसमें बहुत बुनियादी आवश्यकताओ ं(जिन्हें दहैिक आवश्यकताएं कहा जाता ह)ै से लेकर सबसे महत्वपरू्ण  ज़रूरतें 

शामिल हैं जो आत्म-विकास (जिन्हें आत्म वास्तविकीकरण ज़रूरतें कहा जाता ह)ै के लिए आवश्यक हैं। दहैिक और आत्म-विकास की आवश्यकताओ ंके 

बीच तीन अन्य ज़रूरतें होती हैं - सुरक्षा आवश्यकता, अपनेपन और प्यार की आवश्यकता, और सम्मान की  आवश्यकता। इन आवश्यकताओ ं को 

सामान्यता पांच स्तरों वाले एक पिरामिड के रूप में दर्शाया जाता ह ैऔर इसे मास्लो’स हाइरार्की ऑफ नीड्स (Maslow’s Hierarchy of Needs) के रूप में 

जाना जाता ह।ै

जसेै कि आप पिरामिड में देख सकते हैं, सबसे निचला स्तर सबसे बुनियादी आवश्यकताओ ंको दर्शाता ह।ै मास्लो का मानना ​​था कि हमारा व्यवहार, 

हमारी बुनियादी आवश्यकताओ ंसे प्रेरित होता ह,ै जब तक वे ज़रूरतें परूी नहीं हो जाती। ये ज़रूरतें परूी होने के बाद, हम अगले स्तर पर चलते हैं और अगले 

स्तर की आवश्यकताओ ंसे प्रेरित होते हैं। चलिए इसे एक उदाहरण के साथ बेहतर समझते हैं।

चित्र 10.1.1: मास्लो’स हिरारकी ऑफ नीड्स (Maslow’s Hierarchy of Needs)
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10.1.3.3 उपलब्धि प्रेरणा को समझना

रूपा एक बहुत ही गरीब परिवार से संबंध रखती ह।ै उसके पास कभी पर्याप्त भोजन, पानी, अपनापन या आराम नहीं रहा। मास्लो के अनुसार, जब तक रूपा 

सुनिश्चित नहीं हो जाती कि उसकी यह आवश्यकताएं परूी हो जाएंगी, तब तक वह अगले स्तर की आवश्यकताओ ंके बारे  में सोचेगी भी नहीं - उसकी 

सुरक्षा संबंधी आवश्यकताएं। लेकिन, जब उसे भरोसा हो जाता ह ैकि उसकी बुनियादी आवश्यकताएं परूी हो जाएंगी, तो वह अगले स्तर पर जाएगी और 

फिर उसका व्यवहार सुरक्षा और रक्षा की उसकी आवश्यकता अनुसार प्रेरित होगा। जब उसकी यह आवश्यकताएं परूी हो जाती हैं, तो रूपा अगले स्तर पर 

जाएगी, और रिश्तों और मित्रों की अपनी आवश्यकताओ ंसे प्रेरित होती ह।ै इस आवश्यकता के परूा होने के बाद, रूपा चौथे स्तर की आवश्यकताओ ंपर 

ध्यान केन्द् रित करेग ी - उसकी सम्मान संबंधी आवश्यकताएं जिसके बाद वह पांचवें और अंतिम स्तर की ओर जाएगी - अपनी परूी क्षमता अनुसार हासिल 

करने की इच्छा।

अब हम जानते हैं कि लोग, बुनियादी, मनोवजै्ञानिक और आत्म-परू्ति  आवश्यकताओ ंसे प्रेरित होते हैं। हालांकि, कुछ लोग बेहद चुनौतीपरू्ण  प्राप्तियों की 

उपलब्धि से भी प्रेरित होते हैं। यह उपलब्धि प्रेरणा या 'उपलब्धि की आवश्यकता' के रूप में जाना जाता ह।ै

उपलब्धि प्रेरणा का स्तर प्रत्येक व्यक्ति के लिए अलग-अलग होता ह।ै यह महत्वपरू्ण  ह ैकि उद्यमियों में उपलब्धि प्रेरणा का स्तर ऊँचा होना चाहिए - कुछ 

महत्वपरू्ण  और अद्वितीय प्राप्त करने की गहरी इच्छा। यह भी उतना ही महत्वपरू्ण  ह ै कि वे ऐसे लोग भर्ती करें  जो स्वय भी चुनौतियों और सफलता से 

अत्यधिक प्रेरित होते हैं।

आपको क्या प्रेरित करता ह?ै

ऐसी कौन-सी चीज़ें हैं जो वास्तव में आपको प्रेरित करती हैं? ऐसी पांच चीज़ों की सचूी बनाएँ जो आपको प्रेरित करती हैं। याद रखें, कि जवाब ईमानदारी 

से दें!

मैं इनसे प्रेरित हंू:

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

...................................................................................................................................................................................

..................................................................................................................................................................................
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उपलब्धि प्रेरणा वाल ेउद्यमियों की विशेषताएँ

•	 उपलब्धि प्रेरणा वाले उद्यमियों को निम्न अनुसार वर्णित किया जा सकता ह:ै

•	 व्यक्तिगत उपलब्धि के लिए जोखिम लेने से नहीं डरते हैं

•	 भविष्य उन्मुख लचीलेपन और अनुकूलता चुनौतियां अच्छी लगती हैं

•	 सकारात्मक प्रतिक्रम/फीडबकै के मुकाबले नकारात्मक प्रतिक्रम/फीडबकै को अधिक महत्त्व देते हैं

•	 जब लक्ष्यों को प्राप्त करने की बात आती ह ैतो बहुत ज़िद्दी होते हैं

•	 अत्यंत साहसी

•	 बेहद रचनात्मक और अभिनव/उन्नतिशील

•	 बेचनै - लगातार अधिक प्राप्त करने के बारे  में सोचते हैं

•	 समस्याओ ंको सुलझाने के लिए व्यक्तिगत रूप से जिम्मेदारी लेते हैं

इनके बारे में सोचें:

•	 आप में इनमें से कितने गुण हैं?

•	 क्या आपके ज़हन में ऐसा कोई उद्यमी आता ह ैजिसमें यह गुण हों?

10.1.3.4 सकारात्मक रवयैा कैसे विकसित किया जाए

10.1.3.5 रवयैा क्या ह?ै

अच्छी खबर यह ह ैकि रवयैा एक पसंद/विकल्प ह।ै इसलिए अपने रवयैा को सुधारना, नियत्रित करना और बदलना संभव ह,ै अगर हम ऐसा करने का 

निर्णय कर लें! निम्नलिखित सुझाव सकारात्मक मानसिकता को प्रोत्साहित करने में मदद करते हैं:

•	 याद रखें कि आप अपने रवयैा को नियत्रित करते हैं, ना कि आपके आस-पास के लोग

•	 दिन में कम से कम 15 मिनट कुछ सकारात्मक पढ़ने, देखने और सुनने के लिए समर्पित करें

•	 नकारात्मक लोगों से बचे, जो केवल शिकायत करते हैं और अपने आप को कोसने से बचें

•	 अपनी शब्दावली का सकारात्मक शब्दों के साथ विस्तार करें  और अपने मन से नकारात्मक बातों को निकाल दें

•	 सराहना करें  और आप में, आपके जीवन में, और अन्यों में क्या अच्छा ह,ै उस पर कें द्रित रहें

•	 अपने आप को पीड़ित समझना बंद करें  और सक्रिय होना शुरू करें

•	 कल्पना करें  कि आप सफल हो रहे हैं और अपने लक्ष्य प्राप्त कर रहे हैं

अब हमने समझ लिया ह ैकि प्रेरणा आत्म-विश्ले षण के लिए इतनी महत्वपरू्ण  क्यों ह,ै चलिए देखते हैं कि हमारा रवयैा खुद को समझने में क्या भमूिका 
निभाता ह।ै रवयैे को आपकी किसी के बारे  में या किसी चीज़ के बारे  में सोचने और महससू करने की प्रवतृ्ति (सकारात्मक या नकारात्मक) के रूप में वर्णित 
किया जा सकता ह।ै रवयैा जीवन के हर पहल ूमें सफलता का आधार ह।ै हमारा रवयैा हमारा सबसे अच्छा दोस्त या हमारा सबसे बड़ा दुश्मन हो सकता ह।ै 
सरल शब्दों में:

"जीवन में एक मात्र अक्षमता गलत रवयैा ही होती ह।ै"

जब आप एक व्यवसाय शुरू करते हैं, तो आप सुनिश्चित होते हैं कि आपको बुरे  समय और असफलताओ ंसे लेकर अच छ्े  समय और सफलताओ ंजसैी विभिन्न 
प्रकार की भावनाओ ंका समाना करना होगा। आपका रवयैा वह होता ह ैजो कठिन समय में आपके साथ होगा और सफलता की दिशा में मार्गदर्शन करेग ा। 
रवयैा भी संक्रामक ह।ै यह आपके निवेशकों से लेकर आपके कर्मचारियों और आपके ग्राहकों तक, आपके आस-पास सभी को प्रभावित करता ह।ै एक 
सकारात्मक रवयैा कार्यस्थल में विश्वास का निर्माण करने में मदद करता ह ैजबकि एक नकारात्मक रवयैा आपके लोगों को संभावित रूप से प्रेरणाहीन 
कर सकता ह।ै



287286

प्रतिभागी पुस्तिका रोटो आर ट्िस्ट

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

10.1.4 ईमानदारी और कार्य नतैिकता: ईमानदारी क्या ह?ै

10.1.3.6 आपकी शक्तियां और कमज़ोरियां क्या हैं

आत्म विश्लेष्ण  करने एक अन्य तरीका ह ैईमानदारी से अपनी शक्तियों और कमज़ोरियों को पहचानना। इससे आपको अपने सर्वोत्तम लाभ के लिए अपनी 

शक्तियों का उपयोग करने और अपनी कमज़ोरियों को कम करने में मदद मिलेगी।

नीचे दिए गए दो कॉलम में अपनी सभी शक्तियों और कमज़ोरियों को लिखें। खुद के साथ ईमानदार रहना याद रखें!

शक्तियां कमज़ोरियां

10.1.3.7 सुझाव 

•	 उपलब्धि प्रेरणा सीखी जा सकती ह।ै

•	 गलतियां करने से मत डरें ।

•	 आपने जो शुरू किया उसे खत्म करने के लिए खुद को प्रशिक्षित करें ।

•	 बड़ा सोचें।

ईमानदारी निष्पक्ष और सच्चा होने की गुणवत्ता ह।ै इसका अर्थ इस प्रकार से बोलना और कार्य  करना ह ै जिससे विश्वास बढ़ता हो। एक व्यक्ति जिसे 

ईमानदार कहा जाता ह ैउसे सच्चा और निष्कपट माना जाता ह ैऔर ऐसा व्यक्ति जो धोखेबाज या कुटिल नहीं ह ैऔर चोरी या धोखा नहीं करता ह।ै 

ईमानदारी के दो आयाम हैं - एक ह ैसंवाद में ईमानदारी और अन्य ह ैआचरण में ईमानदारी।

ईमानदारी एक अत्यंत महत्वपरू्ण  गुण ह,ै क्योंकि इससे मन की शांति मिलती ह ैऔर विश्वास पर आधारित रिश्ते बनते हैं। दूसरी तरह, बेईमान होने से चिता 

होती ह ैऔर अविश्वास और संघर्ष  से भरे  रिश्ते बनते हैं।
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10.1.4.1 ईमानदार लोगों के गुण

10.1.4.2 उद्यमियों में ईमानदारी का महत्व

10.1.4.3 काम नतैिकता क्या ह?ै

ईमानदार व्यक्तियों में कुछ अलग विशेषताएं होती हैं। ईमानदार लोगों के बीच कुछ आम गुण हैं:

•	 वे नहीं सोचते कि अन्य लोग उनके बारे  में क्या सोचते हैं। वे खुद में विश्वास करते हैं - वे ध्यान नहीं देते कि उन्हें उनके व्यक्तित्व के लिए पसंद किया 

जा रहा ह ैया नापसंद किया जा रहा ह।ै

•	 वे अपने विश्वास पर अडिग रहते हैं। वे अपना ईमानदार दृष्टिकोण देने के लिए दो बार नहीं सोचेंगे, भले ही वे जानते हैं कि उनका नज़रिया 

अल्पसंख्यक के साथ निहित हैं।

•	 वे अति संवेदनशील होते हैं। इसका अर्थ यह ह ैकि वे अपनी ईमानदार राय के लिए कठोर समझे जाने के कारण दूसरों से प्रभावित नहीं होते हैं।

•	 वे भरोसेमंद, सार्थक और स्वस्थ मित्रता करते हैं। ईमानदार लोग सामान्यता अपने आस-पास ईमानदार मित्र ही रखते हैं। उन्हें विश्वास होता ह ैकि 

उनके मित्र हर समय सच्चे और उनके साथ खड़ें रहेंगे।

उनके साथियों को उन पर भरोसा होता ह।ै उन्हें ऐसे लोगों के रूप में देखा जाता ह,ै जिन पर सच्चाई के लिए और निष्पक्ष फीडबकै और सलाह के लिए 

भरोसा किया जा सकता ह।ै

•	 ईमानदारी और कर्मचारी: जब उद्यमी अपने कर्मचारियों के साथ ईमानदार संबंध बनाते हैं, इससे कार्यस्थल में और अधिक पारदर्शिता आती ह,ै 

जिससे काम का प्रदर्शन स्तर बढ़ता ह ैऔर बेहतर परिणाम मिलते हैं।

•	 ईमानदारी और निवेशक: उद्यमियों के लिए, निवेशकों के साथ ईमानदार होने का अर्थ केवल शक्तियाँ साझा करना नहीं ह,ै बल्कि खुलकर वर्तमान 

और संभावित कमज़ोरियों, समस्या क्षेत्रों और समाधान रणनीतियों का खुलासा करना ह।ै ध्यान रखें कि निवेशकों को स्टार्ट-अप का बहुत अच्छा 

अनुभव ह ैऔर उन्हें पता ह ैकि सभी नई कंपनियों को समस्याएं आती हैं। उन्होंने दावा किया कि सब कुछ परूी तरह से ठीक और सुचारू रूप से चलना 

अधिकतर निवेशकों के लिए एक खतरे  का निशान ह।ै

•	 अपने आप के साथ ईमानदारी: अपने आप के साथ बेईमान होने के सख्त परिणाम हो सकते हैं विशेष रूप से उद्यमियों के मामले में। उद्यमियों को 

सफल बनने के लिए, यह महत्वपरू्ण  ह ैकि वे हर समय उनकी स्थिति के बारे  में यथार्थवादी रहें और अपने उद्यम के हर पहल ूका सटीकता से आंकलन 

करें  कि वास्तव में यह किसलिए ह।ै

उद्यमियों में सबसे महत्वपरू्ण  विशेषताओ ंमें से एक ईमानदारी ह।ै जब उद्यमी अपने ग्राहकों, कर्मचारियों और निवेशकों के साथ ईमानदार रहते हैं, यह 

दर्शाता ह ैकि वे उन का सम्मान करते हैं जिनके साथ वे काम करते हैं। यह भी महत्वपरू्ण  ह ैकि उद्यमी अपने आप के साथ भी ईमानदार रहें। चलिए नज़र 

डालते हैं कि कैसे ईमानदार होने से उद्यमियों को बहुत लाभ होंगे।

•	 ईमानदारी और ग्राहक: जब उद्यमी अपने ग्राहकों के साथ ईमानदार होते हैं, इससे मज़बतू संबंधों को बल मिलता ह,ै जिससे व्यापार बढ़ता ह ैऔर 

एक मज़बतू ग्राहक नेटवर्क  बनता ह।ै

कार्यस्थल पर नतैिक होने का अर्थ अपने सभी निर्णयों और संवाद में ईमानदारी, निष्ठा और सम्मान जसेै मूल्यों को प्रदर्शित करना ह।ै इसका अर्थ ह ैकि 

झठू बोलना, धोखा देना और चोरी करना जसेै नकारात्मक गुणों का प्रदर्शन नहीं करना ह।ै

कार्यस्थल में नतैिकता कंपनी के मुनाफे में एक बड़ी भमूिका निभाती ह।ै यह उच्च मनोबल और टीम वर्क  के रूप में एक उद्यम के लिए बहुत महत्वपरू्ण  ह।ै 

यही कारण ह ैकि ज़्यादातर कंपनियां विशिष्ट कार्यस्थल नतैिक दिशा-निर्देश की रूप रे खा तयैार करती हैं जिनका उनके कर्मचारियों को अनिवार्य  रूप 

से पालन करना होता ह।ै यह दिशा-निर्देश सामान्यता एक कंपनी की कर्मचारी पुस्तिका में रे खांकित होते हैं।
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10.1.4.4 एक मज़बूत कार्य नतैिकता के तत्व

10.1.4.5 अच्छी कार्य नतैिकता को बढ़ावा कैसे दिया जाए

एक उद्यमी को मज़बतू कार्य  नतैिकता का प्रदर्शित करना होगा, साथ ही केवल उन व्यक्तियों को भर्ती करना चाहिए, जो कार्यस्थल में समान स्तर के 

नतैिक व्यवहार में विश्वास रखते हैं और प्रदर्शित करते हैं। मज़बतू कार्य  नतैिकता के कुछ तत्व हैं:

•	 व्यावसायिकता: इसमें वह सब कुछ शामिल ह ै जिसमें आप अपने आप को कॉर्पोरे ट सेटिग में उसी प्रकार प्रदर्शित करते हैं, जिस प्रकार आप 

कार्यस्थल में अन्य लोगों से व्यवहार करते हैं।

•	 मान्यता: इसका अर्थ ह ैसंतुलित और कूटनीतिक रहना भले ही स्थिति कितनी ही तनावपरू्ण  या अस्थिर हो।

•	निर्भ रता: इसका अर्थ हमेशा अपने शब्दों पर कायम रहें, भले ही वह किसी बठैक के लिए समय पर पहंुचना हो या समय पर कार्य  परूा करना हो।

•	 समर्पण: इसका अर्थ ह ैकि जब तक निर्धा रित कार्य  परूा ना हो जाए तब तक कार्य  ना छोड़ना और उत्कृ ष्टता के उच्चतम संभव स्तर पर कार्य  परूा 

करना।

•	 दृढ़ता: इसका अर्थ ह ैकि व्यवधानों को, रुकावट की बजाय चुनौती के रूप में लेना और वांछित परिणाम प्राप्त करने के उद्देश्य और लचीलेपन के साथ 

आगे बढ़ना।

•	 जवाबदहेी: इसका अर्थ ह ैअपने कार्यों और उनके परिणामों के लिए जिम्मेदारी लेना, ना कि अपनी गलतियों के लिए बहाने बनाना।

•	व िनम्रता: इसका अर्थ ह ैकि सबके प्रयासों और मेहनत को स्वीकार करना, और प्राप्तियों का श्रेय उनसे साझा करना।

एक उद्यमी के रूप में, यह महत्वपरू्ण  ह ैकि आप स्पष्ट रूप से परिभाषित करें  कि आप कार्यस्थल पर प्रत्येक टीम सदस्य और व्यक्ति से किस प्रकार के 

व्यवहार की अपेक्षा करते हैं। आप को यह स्पष्ट करना चाहिए कि आप कर्मचारियों से निम्न अनुसार सकारात्मक कार्य  नतैिकता का प्रदर्शन करने की 

अपेक्षा करते हैं:

•	 ईमानदारी: एक व्यक्ति को सौंपा गया सारा कार्य  बिना किसी भी छल या झठू के, परूी ईमानदारी के साथ किया जाना चाहिए।

•	 अच्छा रवयैा: टीम के सभी सदस्यों को आशावादी, ऊर्जावान और सकारात्मक होना चाहिए।

•	व िश्वसनीयता: कर्मचारियों को दिखाना चाहिए कि वह वहीं ह ैजहां उन्हें होना चाहिए।

•	 अच्छी कार्य संबंधी आदतें: कर्मचारियों को हमेशा अच्छी तरह से तयैार होना चाहिए, कभी भी अनुचित भाषा का उपयोग नहीं करना चाहिए, हर 

समय पेशेवर के रूप में कार्य  तथा व्यवहार करना चाहिए

•	 पहल: केवल कार्य  करना ही पर्याप्त नहीं ह।ै हर टीम के सदस्य को सक्रिय होना होगा और पहल करनी होगी।

•	व िश्वसनीयता: विश्वास गरै परक्राम्य ह।ै यदि एक कर्मचारी पर भरोसा नहीं किया जा सकता ह,ै तो यह कर्मचारी को बाहर करने का समय ह।ै

•	 सम्मान करना: कर्मचारियों को कंपनी, काननू, अपने काम, अपने सहयोगियों और खुद का सम्मान करने की ज़रूरत ह।ै

•	 सत्यनिष्ठा: प्रत्येक और हर टीम का सदस्य परूी तरह से नतैिक होना चाहिए और उसे हर समय उपरोक्त बोर्ड  व्यवहार का प्रदर्शन करना चाहिए।

•	 दक्षता: दक्ष कर्मचारी एक कंपनी को आगे बढ़ाने में मदद करते हैं, जबकि अकुशल कर्मचारी समय और संसाधनों की बर्बादी करते हैं।
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10.1.4.6 सुझाव 

10.1.5.1 सुझाव 

•	 जब भी कोई आपको सच्चाई बताए और जो आपने सुना वो आपको अच्छा ना लगे, तो गुस्सा मत करें ।

•	 हमेशा अपनी गलतियों की जिम्मेदारी स्वीकार करने के लिए तयैार रहें।

10.1.5 रचनात्मकता और नवाचार

रचनात्मकता क्या है

रचनात्मकता का अर्थ कुछ अलग सोचना ह।ै इसका अर्थ ह ै चीज़ों को नए तरीके से या अलग-अलग दृष्टिकोण से देखना और फिर इन विचारों को 

वास्तविकता में परिवर्तित करना। रचनात्मकता के दो भाग होते हैं: सोच और उत्पादन। केवल एक विचार होना आपको कल्पनाशील बनाता ह,ै रचनात्मक 

नहीं। हालांकि, एक विचार होना और उस पर कार्र वाई करना आपको रचनात्मक बनाता ह।ै

बेहद रचनात्मक लोगों की विशेषताएं

रचनात्मक लोगों की कुछ विशेषताएं हैं:

•	 वे कल्पनाशील और चंचल होते हैं 

•	 वे समस्याओ ंको अलग-अलग कोणों से देखते हैं 

•	 वे छोटे-छोटे विवरण पर भी ध्यान देते हैं

•	 वे किसी भी काम से बहुत कम ऊबते हैं

•	 वे नियम और दिनचर्या  से नफरत करते हैं

•	 उन्हें खयाली पुलाव पकाना अच्छा लगता है

•	 वे बहुत उत्सुक होते हैं

नवाचार क्या ह?ै

नवाचार की कई अलग-अलग परिभाषाएं हैं। सरल शब्दों में, नवाचार का अर्थ ह ैएक विचार को समाधान में परिवर्तित करना जिससे उपयोगिता बढ़ती ह।ै 

इस का अर्थ यह भी हो सकता ह ैकि एक नए उत्पाद, सेवा या प्रक्रिया को कार्यान्वयन करके या एक मौजदूा उत्पाद, सेवा या प्रक्रिया में महत्वपरू्ण  सुधार 

करके इसकी उपयोगिता बढ़ाना।

बेहद नवाचार/उन्नतिशील लोगों की विशेषताएं

बेहद नवाचार लोगों की कुछ विशेषताएं हैं:

•	 उन्हें चीज़ों को अलग तरीके से करने में मज़ा आता है

•	 उन्हें शॉर्टकट लेने में विश्वास नहीं है

•	 उन्हें अपरंपरागत होने का डर नहीं है

•	 वे अत्यधिक सक्रिय और दृढी हैं

•	 वे संगठित, सतर्क  और जोखिम से बचने वाले हैं

•	 खुद को पुन:ऊर्जित करने और ताज़ा परिप्रेक्ष्य हासिल करने के लिए अपने रचनात्मक काम से नियमित रूप से अंतराल लें।

•	 अक्सर प्रोटोटाइप का निर्माण करें , उनका परीक्षण करें , प्रतिक्रिया प्राप्त करें  और आवश्यक परिवर्तन करें ।



291290

प्रतिभागी पुस्तिका रोटो आर ट्िस्ट

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

10.1.6 समय प्रबंधन

10.1.6.1 प्रभावी समय प्रबंधकों के गुण

समय प्रबंधन की प्रक्रिया अपने समय को व्यवस्थित करना ह,ै और तय करना ह ैकि विभिन्न गतिविधियों के बीच अपना समय कैसे बाँटा जाए। अच्छा 

समय प्रबंधन स्मार्ट  तरीके से काम करना (कम समय में अधिक काम करना) और कड़ी मेहनत करने (अधिक काम के लिए अधिक समय तक काम 

करना) के बीच अंतर ह।ै

प्रभावी समय प्रबंधन से कुशल कार्य  उत्पादन मिलता ह,ै भले ही आपको कम समय सीमा और उच्च दबाव स्थितियों का सामना करना हो। दूसरी ओर, 

अपने समय को प्रभावी रूप से प्रबंधित ना करने से अकुशल उत्पादन होता ह ैऔर तनाव और चिता बढ़ जाती ह।ै

समय प्रबंधन के लाभ

समय प्रबंधन से निम्न जसेै बड़े लाभ हो सकते हैं:

•	 बेहतर उत्पादकता	

•	 उच्च दक्षता

•	 बेहतर पेशेवर प्रतिष्ठा	

•	 कम तनाव

•	 कैरियर में उन्नति की अधिक संभावनाएं	

•	 लक्ष्य प्राप्त करने के लिए अधिक से अधिक अवसर

समय को प्रभावी ढंग से प्रबंधित ना करने के निम्न अवांछनीय परिणाम हो सकते हैं:

•	 समय सीमा में काम परूा ना होना	

•	 अकुशल कार्य  आउटपुट

•	 काम की गुणवत्ता कम होना	

•	 खराब पेशेवर प्रतिष्ठा

•	 कैरियर रुक जाता ह	ै

•	 तनाव और चिता में वदृ्धि होती है

प्रभावी समय प्रबंधकों में से कुछ लक्षण हैं:

•	 वे परियोजनाओ ंको जल्दी शुरू करते हैं वे दनैिक लक्ष्य निर्धा रित करते हैं

•	 वे आवश्यकता अनुसार, बेहतर परिणाम हासिल करने के लिए योजनाओ ंको संशोधित करते हैं

•	 वे लचीले और खुले विचारों वाले होते हैं

•	 वे पहले ही लोगों को सचूित कर देते हैं, यदि उनकी मदद की आवश्यकता होगी

•	 वे जानते हैं कि मना कैसे किया जाता है

•	 वे विशिष्ट समय सीमा के साथ कार्य  को चरणों में बांट लेते हैं

•	 वे लगातार लंबी अवधि के लक्ष्यों की समीक्षा करते रहते हैं

•	 वे आवश्यकता पड़ने पर वकैल्पिक समाधान के बारे  में सोचते हैं

•	 वे आवश्यकता पड़ने पर मदद मांगते हैं। वे बकैअप योजना बनाते हैं
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10.1.6.2 प्रभावी समय प्रबंधन तकनीकें

10.1.7 क्रोध प्रबंधन

आप निश्चित समय प्रबंधन तकनीकों का अभ्यास कर अपने समय का प्रबंधन वेहतर तरीके से कर सकते हैं कुछ उपयोगी सुझाव हैं:

•	दि न की योजना के साथ व्यवधानों की भी योजना बनाएँ। अपनी समय योजना को समझने के लिए अपने आप को कम से कम 30 मिनट दें। 

अपनी योजना में, व्यवधानों के लिए कुछ समय निर्धा रित करें ।

•	 जब आपको एक निश्चित समय में काम पूरा करना हो तो एक "तंग न करें  (Do Not Disturb)" संकेत लगाएं।

•	कि सी भी चीज़ से ध्यान भंग न होने दें। बजते फोनों, चटै संदेशों का जवाब ना देने, सामाजिक मीडिया साइटों की अनदेखी करने के लिए अपने 

आप को प्रशिक्षित करें ।

•	 अपने काम को किसी को सौंप दें। इससे ना केवल अपना काम तेज़ी से करने में मदद मिलेगी, बल्कि इससे आप को अपने आस-पास के अद्वितीय 

कौशल और क्षमताएं भी दिखाई देंगी।

•	 टालना बन्द करें । अपने आप को याद दिलाएं कि विलंब सामान्यता डर या असफलता या इस विश्वास के कारण होता ह ैकि आप काम उस तरीके से 

परूा नहीं कर सकते जसेै आप करना चाहते थे।

•	प्राथमिकत ा निर्धारित करें । प्रत्येक कार्य  की तात्कालिकता या महत्व स्तर के क्रम में परूा करने के अनुसार सचूी बनाएं। फिर एक-एक करके 

प्रत्येक कार्य  को परूा करने पर ध्यान कें द्रित करें ।

•	 अपने काम की गतिविधियों का एक लॉग बना कर रखें। अपनी दक्षता और हर रोज़ कितना समय बर्बाद होता ह ैनिर्धा रित करने में मदद के लिए 

लॉग का विश्लेष्ण  करें ।

•	 समय की बर्बादी को कम करने के लिए समय प्रबंधन के लक्ष्य निर्धा रित करें ।

10.1.6.3 सुझाव 
•	 हमेशा पहले सबसे महत्वपरू्ण  कार्यों को परूा करें ।

•	 हर रोज़ कम से कम 7-8 घंटे की नींद लें।

•	 अपने दिन की शुरुआत जल्दी करें ।

•	 छोटे, महत्वहीन विवरण पर बहुत अधिक समय बर्बाद मत करें ।

•	 अपने लिए गए हर काम के लिए एक समय सीमा निर्धा रित करें ।

•	 कार्यों के बीच तनाव को कम करने के लिए अपने आप को कुछ समय दें।

क्रोध प्रबंधन एक प्रक्रिया ह ैजिसमें:

1.	 ऐसे संकेत पहचानने सीखे जाते हैं जो दर्शाते हैं कि आप या किसी और को क्रोध आ रहा है

2.	 एक सकारात्मक तरीके से स्थिति को शांत करने के लिए सबसे उचित कार्र वाई करें । क्रोध प्रबंधन का अर्थ क्रोध को दबाना नहीं ह।ै

क्रोध प्रबंधन का महत्व

क्रोध एक परूी तरह से सामान्य मानव भावना ह।ै वास्तव में, जब इसे सही तरीके से प्रबंधित किया जाता ह,ै तो क्रोध एक स्वस्थ भावना भी बन सकती ह।ै 

लेकिन, अगर इस पर ध्यान नहीं दिया जाए, तो क्रोध हमसे अनुपयुक्त कार्य  करा सकता ह ैऔर इसके परिणाम स्वरूप हम ऐसी बातें कर या बोल जाते हैं 

जिनका हमें बाद में पछतावा होगा।
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10.1.7.1 क्रोध प्रबंधन रणनीतियां

चरम सीमा पर क्रोध:

•	 आपको शारीरिक रूप से नुक्सान पहंुचा सकता ह:ै इससे हृदय रोग, मधुमेह, प्रतिरक्षा प्रणाली कमज़ोर, अनिद्रा, और उच्च रक्तचाप हो सकता ह।ै

•	 आप को मानसिक रूप से नुक्सान पहंुचा सकता ह:ै यह आपको उलझन में डाल सकता ह ैऔर आपके तनाव, अवसाद और मानसिक स्वास्थ्य 

समस्याओ ंका कारण बन सकता ह।ै

•	 आपके कैरियर को नुकसान पहंुचा सकता ह:ै इससे आपके सहयोगियों, मालिकों, ग्राहकों में अलगाव की भावना पदैा हो सकती ह ैजिससे सम्मान 

में कमी आ सकती ह।ै

•	 आपके संबंधों को नुकसान पहंुचा सकता ह:ै इससे आपके परिवार और मित्रों का आप पर भरोसा करना कठिन हो जाता ह,ै अपने साथ ईमानदार 

रहें और अपने आस-पास सहज महससू करें ।

यही कारण ह ैकि क्रोध प्रबंधन, या क्रोध को उचित रूप से प्रबंधित करना इतना महत्वपरू्ण  ह।ै

यहां कुछ रणनीतियां हैं जो आप को अपने क्रोध को नियत्रित करने में मदद कर सकती हैं:

रणनीति 1: विश्राम

गहरी सांस लेना और सुकून देने वाली तस्वीरें  देखना क्रोध जसैी भावनाओ ंको शांत करने में अद्भुत रुप से काम करता ह।ै इन साधारण श्वास व्यायामों 

का अभ्यास करें :

•	 अपने डायाफ्राम से एक गहरी सांस लें (अपने सीने से सांस ना लें)

•	 कल्पना करें  कि आपकी सांस आपके पेट से ऊपर आ रही है

•	 'शांत रहो' या 'सब ठीक ह'ै जसेै शांत करने वाले शब्द दोहराते रहें (शब्द दोहराते समय गहरी सांस लेना याद रखें)

•	 एक सुकून वाले पल की कल्पना करें  (यह आपकी स्मृति से या आपकी अपनी कल्पना हो सकती ह)ै

दनैिक रूप से इस शांत रहें तकनीक का पालन करें , विशेष रूप से जब आपको लगे कि आप को क्रोध आ रहा ह।ै

रणनीति 2: संज्ञानात्मक पुनर्गठन

संज्ञानात्मक पुनर्गठन का अर्थ अपने सोचने के तरीके को बदलना ह।ै क्रोध आपसे श्राप दिला सकता ह,ै कसम खिला सकता ह,ै अतिरजन करा सकता 

ह ैऔर बहुत नाटक करवा सकता ह।ै जब ऐसा होता ह,ै तो अपने आप को अपने क्रोधी विचारों को तार्कि क विचारों के साथ बदलने के लिए मज़बरू करें । 

उदाहरण के लिए, 'सब कुछ बर्बाद हो गया ह'ै सोचने के बजाय अपनी मानसिकता बदलें और अपने आप से कहें 'यह दुनिया का अंत नहीं ह ैऔर क्रोध से 

कोई समाधान नहीं होगा'।

रणनीति 3: समस्या को सुलझाना

किसी समस्या के लिए क्रोधित होना जिसे आप नियत्रित नहीं कर सकते हैं, परूी तरह से स्वाभाविक प्रतिक्रिया ह।ै कभी-कभी, कोशिश करने के बाद भी, 

पेश आई समस्या का कोई समाधान नहीं हो सकता ह।ै ऐसे मामलों में, समस्या को सुलझाने पर ध्यान कें द्रित करना बंद कर दें और इसके बजाय समस्या 

से निपटने और उसका सामना करने पर ध्यान कें द्रित करें । अपने आप को याद दिलाएं कि आप स्थिति से निपटने के लिए परूी कोशिश करें गे, लेकिन 

अगर आपको वांछित समाधान नहीं मिलता ह,ै तो आप अपने आप को दोष नहीं देंगे।

रणनीति 4: बेहतर संवाद

जब आप क्रोध में होते हैं, तो गलत निष्कर्ष पर पहंुचना बहुत आसान होता ह।ै इस तरह के मामले में, आपको किसी तरह स्वय पर काब ूरखना होगा, कि 

आप कोई प्रतिक्रिया न दें। कुछ भी कहने से पहले, ध्यान से सोचें कि आप क्या कहना चाहते हैं। अपने जहन में आने वाली पहली बात कहने से बचें। स्वय 

को दूसरे  की बात ध्यान से सुनने के लिए मजबरू करें । फिर जवाब देने से पहले बातचीत के बारे  में सोचें।

रणनीति 5: अपना माहौल बदलना

यदि आपको लगे कि आपका माहौल आपके क्रोध का कारण ह ैतो कुछ समय के लिए अपने आप को इस माहौल से दूर कर लें। अपने लिए भी थोड़ा समय 

निकालने का सक्रिय प्रयास करें , खासतौर से बेहद व्यस्त तथा तनावपरू्ण  दिनों में। थोड़ा समय शांति से अकेले में बिताने से निश्चित ही आपको मन शांत 

करने में मदद मिलेगी।
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10.1.7.2 क्रोध प्रबंधन के लिए सुझाव 
•	 निम्नलिखित सुझाव आपको अपने क्रोध पर नियत्रण रखने में मदद करें गे:

•	 क्रोध में कुछ भी कहने से पहले अच्छी तरह से सोच लें।

•	 शांत होने के बाद अपने क्रोध का कारण एक मुखर, लेकिन गरै झगड़ाल ूतरीके से व्यक्त करें ।

•	 जब आपको लगे कि आप क्रोधित हो रहे हैं तो दौड़ या तेज़ चलने जसेै शारीरिक व्यायाम करें ।

•	 छोटे छोटे अंतरालों को अपनी दनैिक दिनचर्या  का हिस्सा बनाएँ विशेष रूप से तनावपरू्ण  दिनों के दौरान। अपना ध्यान क्रोध पदैा करने वाली समस्या 

के समाधान पर कें द्रित करें , न कि इस बात पर कि समस्या आपको क्रोधित कर रही ह।ै

10.1.8 तनाव प्रबंधन

10.1.8.1 तनाव के लक्षण

हम कहते हैं, कि हम ‘’तनावग्रस्त’’ हैं, जब हमारे  ऊपर बहुत ज़्यादा काम होते हैं और इनके बोझ से जझूने की अपनी क्षमता के बारे  में हम निश्चित नहीं होते। 

ऐसी कोई भी चीज़ जो हमारे  सुख को चुनौती देती ह ैया उसके लिए खतरा ह ैउसे तनाव के रूप में परिभाषित किया जा सकता ह।ै यह ध्यान रखना महत्वपरू्ण 

ह ै कि तनाव सकारात्मक और नकारात्मक दोनों हो सकता ह।ै सकारात्मक तनाव हमें आगे बढ़ने की प्रेरणा देता ह,ै जबकि नकारात्मक तनाव हमारे  

मानसिक और शारीरिक स्वास्थ्य को प्रभावित करता ह।ै यही कारण ह ैकि इस नकारात्मक तनाव को प्रभावी ढंग से प्रबंधित करना बहुत महत्वपरू्ण ह।ै

तनाव के कारण

तनाव आंतरिक और बाह्य कारकों के कारण हो सकता ह।ै

तनाव के आंतरिक कारण:

•	 लगातार चिता

•	 कठोर सोच

•	 अवास्तविक अपेक्षाएं

•	 निराशावाद

•	 अपने बारे  में नकारात्मक बातें करना

•	 आर या पार का रवयैा

तनाव के बाहरी कारण:

•	 जीवन के प्रमुख परिवर्तन

•	 रिश्तों में कठिनाइयाँ

•	 बहुत काम होना

•	 काम पर या स्कू ल में कठिनाइयाँ

•	 वित्तीय कठिनाइयाँ

•	 बच्चों और/या परिवार के बारे  में चिता

तनाव कई तरीकों से ज़ाहिर हो सकता ह।ै तनाव के संज्ञानात्मक, भावनात्मक, शारीरिक और व्यावहारिक लक्षणों पर एक नज़र डालें।
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10.1.8.2 तनाव प्रबंधन के लिए सुझाव 

संज्ञानात्मक लक्षण भावनात्मक लक्षण

•	 स्मृति समस्याएं

•	 एकाग्रता मुद्दे

•	 निर्णय का अभाव

•	 निराशावाद

•	 चिता

•	 लगातार चिता

•	 अवसाद

•	 व्याकुलता

•	 चिड़चिड़ापन

•	 अकेलापन

•	 चिता

•	 क्रोध

शारीरिक लक्षण व्यवहारिक लक्षण

•	 पीड़ा और दर्द

•	 दस्त या कब्ज़

•	 जी मिचलाना

•	 चक्कर आना

•	 सीने में दर्द  और/या तेजी से दिल धड़कना

•	 लगातार ठंड या फ्लू होने जसैा महससू करना

•	 भखू अधिक या कम लगना

•	 अधिक सोना या कम सोना

•	 सामाजिक रूप से अलग थलग होना

•	 जिम्मेदारियों की उपेक्षा करना

•	 शराब या सिगरे ट पीना

•	 नाखनू चबाने, तेज़ चलने जसैी बेचनै आदतें

निम्नलिखित सुझाव आपको अपने तनाव का प्रबंधन बेहतर तरीके से करने में मदद कर सकते हैं:

•	 ऐसे अलग-अलग तरीकों को लिख लें जिनसे आप अपने तनाव के विभिन्न स्रोतों से निपट सकते हैं।

•	 याद रखें कि आप सब कुछ नियत्रित नहीं कर सकते हैं, लेकिन आप अपनी प्रतिक्रिया को नियत्रित कर सकते हैं।

•	 गुस्से से, रक्षात्मक या निष्क्रिय तरीके से प्रतिक्रिया देने की बजाय भावनाओ,ं दृष्टिकोणों तथा धारणाओ ंपर चर्चा  करें ।

•	 जब भी आपको को तनाव महससू हो, तब ध्यान, योग या ताई ची जसैी सुकून देने वाली तकनीकों का अभ्यास करें ।

•	 अपने दिन का कुछ समय व्यायाम को दें।

•	 फलों और सब्जियों जसेै स्वस्थ आहारों का सेवन करें । अस्वास्थ्यकर भोजन विशेष रूप से चीनी की बड़ी मात्रा युक्त आहारों से बचें।

•	 अपने दिन को नियोजित करें , ताकि आप कम तनाव के साथ अपने समय का बेहतर प्रबंधन कर सकें ।

•	 आवश्यकता पड़ने पर लोगों और चीज़ों को न कहना सीखें।

•	 अपने शौक और रुचियों को कुछ समय देने के लिए समय तय करें ।

•	 सुनिश्चित करें  कि आप कम से कम 7-8 घंटे की नींद लें।

•	 कैफीन का सेवन कम करें ।

•	 अपने परिवार और दोस्तों के साथ अधिक समय बिताएँ।
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यूनिट 10.2: डिजिटल साक्षरता: पुनरावतृ्ति

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 कंप्यूटर के बुनियादी भागों को पहचनने में

2.	 कीबोर्ड  के बुनियादी भागों को पहचानने में

3.	 कंप्यूटर की बुनियादी शब्दावली को याद रखने में

4.	 कंप्यूटर की बुनियादी शब्दावली को याद रखने में

5.	 कंप्यूटर की बुनियादी कंुजियों के कार्यों को याद रखने में

6.	 MS Office की प्रमुख एप्लीकेशंस पर चर्चा  करने में

7.	 Microsoft Outlook के लाभों पर चर्चा  करने में

8.	 ई-कॉमर्स के विभिन्न प्रकारों पर चर्चा  करने में

9.	 खुदरा विक्रे ताओ ंऔर ग्राहकों के लिए ई-कॉमर्स के लाभों की सचूी बनाने में

10.	च र्चा  करने में, कि डिजिटल इंडिया अभियान से भारत में ई-कॉमर्स को कैसे बढ़ावा मिलेगा

11.	 वर्णन करने में, कि आप ई-कॉमर्स प्लेटफार्म  पर एक उत्पाद या सेवा कैसे बेचेंगे

यूनिट के उद्देश्य 

10.2.1 कंप्यूटर और इंटरनेट के बारे में बुनियादी बातें

चित्र 10.2.1: कंप्यूटर के भाग

चित्र 10.2.2: कीबोर्ड के भाग
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10.2.1.1 कंप्यूटर के बुनियादी भाग

10.2.1.2 बुनियादी इंटरनेट शब्द

10.2.1.3 बुनियादी कंप्यूटर कंुजियाँ

1.	 Central Processing Unit (CPU): कंप्यूटर का मस्तिष्क। यह प्रोग्राम के निर्देशों को समझता ह ैऔर उन्हें अंजाम देता ह।ै

2.	 हार्ड ड्राइव:  एक डिवाइस जो बड़ी मात्रा में डेटा संग्रहित करती ह।ै

3.	 मॉनिटर: एक डिवाइस जिसमें कंप्यूटर स्क्रीन शामिल होती ह ैजहां सचूना दृष्टिगत रूप से प्रदर्शित होती ह।ै

4.	ड ेस्कटॉप: ऑपरेटि ग सिस्टम लोड होने के बाद प्रदर्शित होने वाली पहली स्क्रीन।

5.	 बकैग्राउंड: एक छवि जो डेस्कटॉप के बकैग्राउंड में होती ह।ै

6.	 माउस: एक हैंड-हेल्ड डिवाइस जो मॉनिटर पर आइटम की ओर संकेत करने के लिए इस्तेमाल होती ह।ै

7.	 स्पीकर: एक डिवाइस जो आपको कंप्यूटर से आवाज सुनने में सक्षम बनाती ह।ै

8.	प्रिं टर: एक डिवाइस जो एक कंप्यूटर के आउटपुट को कागज़ों पर प्रिन्ट करके निकालता ह।ै

9.	 आइकॉन: एक छोटी सी तस्वीर या छवि जो आपके कंप्यूटर पर किसी प्रोग्राम, सॉफ़्टवेयर अथवा फंक्शन इत्यादि का चिन्ह होती ह।ै

10.	कर्स र: एक तीर जो इंगित करता ह ैकि आप स्क्रीन पर कहाँ हैं।

11.	प्रोग्रा म मनै्यू: आपके कंप्यूटर पर प्रोग्रामों की सचूी जिसे स्टार्ट  मनै्यू से उपयोग किया जा सकता ह।ै

12.	 टास्कबार: कंप्यूटर स्क्रीन के तल पर एक हॉरिज़ॉन्टल बार जो वर्तमान में प्रयोग की जा रही एप्लीकेशंस को सचूीबद्ध करता ह।ै

13.	 रिसाइकल बिन: डिलीट की गई फाइलों के लिए एक अस्थायी भंडारण।

•	 इंटरनेट: कंप्यूटर नेटवर्क  का एक व्यापक, अंतर्राष्ट्रीय संग्रह जो जानकारी हस्तांतरित करता ह।ै

•	वर्ल्ड  वाइड वेब: एक प्रणाली जो आपको इंटरनेट पर जानकारी एक्सेस करने देती ह।ै

•	व ेबसाइट: वर्ल्ड  वाइड वेब (और इंटरनेट) पर एक स्थान जिसमें किसी विशिष्ट विषय के बारे  में जानकारी होती ह।ै

•	 होम पेज: एक वेबसाइट के बारे  में जानकारी प्रदान करता ह ैऔर आपको वेबसाइट के अन्य पषृ्ठों के लिए निर्देश देता ह।ै

•	ल िंक/हाइपरलिंक: एक हाइलाइटेड या रे खांकित आइकॉन, ग्राफिक, या टकै्स्ट जो आप को किसी अन्य फाइल या वस्तु पर ले जाता ह।ै

•	व ेब एड्रेस/ URL: एक वेबसाइट के लिए पता।

•	 एड्रेस बॉक्स: ब्राउज़र विंडो में एक बॉक्स जहाँ आप एक वेब एड्रेस लिख कर सकते हैं।

•	 ऐरो कीज़: इन कंुजियों को अपने कर्सर को स्थानांतरित करने के लिए दबाएँ।

•	 स्पेस बार: एक खाली जगह सम्मिलित हो जाती ह।ै

•	 एंटर/रिटर्न: आपके कर्सर को नई लाइन पर ले जाता ह।ै

•	शि फ्ट: यदि आप कोई बड़ा (कैपिटल) अक्षर या एक कंुजी का ऊपर वाला चिन्ह टाइप करना चाहते हैं तो इस कंुजी को दबाएँ।

•	क प्स लॉक: यदि आप चाहते हैं कि सभी अक्षर जो आप टाइप करते हैं वे कैपिटल अक्षरों में हो तो इस कंुजी को दबाएँ। वापिस छोटे अक्षरों को टाइप 

करने के लिए इसे फिर से दबाएँ।

•	 बकैस्पेस: आपके कर्सर के बाई ंओर सब कुछ मिटा देता ह।ै
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10.2.1.4 सुझाव 

10.2.2.1 सुझाव 

•	 जब .com पते पर जाएं, तो http:// या www भी टाइप करने की कोई ज़रूरत नहीं ह।ै केवल वेबसाइट का नाम टाइप करें  और उसके बाद Ctrl + Enter 

दबाएँ। (उदाहरण: www.apple.com पर जाने के लिए टाइप करें  'appleapple' और फिर Ctrl + Enter दबाएँ)

•	 शब्दों / टकै्स्ट का आकार बढ़ाने या घटाने के लिए Ctrl कंुजी + या - को दबाएँ।

•	 एक वेब पषृ्ठ को फिर से लोड या रिफ्रे श करने के लिए F5 या Ctrl + R दबाएँ।

10.2.2 MS Office और ईमेल
MS Office के बारे में

MS Office या Microsoft Office Microsoft द्वारा विकसित कंप्यूटर प्रोग्राम का एक सुइट ह।ै हालांकि सभी उपयोगकर्ताओ ंके लिए उपलब्ध ह,ै यह छात्रों, 

घरे ल ूउपयोगकर्ताओ ंऔर व्यापारिक उपयोगकर्ताओ ंके लिए विशेष रूप से विभिन्न संस्करण उपलब्ध कराता ह।ै सभी प्रोग्राम Windows और Macintosh 

के साथ संगत (कम्पैटिबल) में हैं।

सबसे लोकप्रिय ऑफिस उत्पाद

सबसे लोकप्रिय और सार्वभौमिक रूप से इस्तेमाल किए जाने वाले MS Office एप्लीकेशंस में से कुछ हैं:

1.	 Microsoft Word: इससे किसी डॉक्यूमेंट में टाइप किया जा सकता ह ैऔर इमेज भी डाली जा सकती हैं।

2.	 Microsoft Excel: उपयोगकर्ता  एक स्प्रेडशीट में डेटा दर्ज कर सकते हैं, गणना कर सकते हैं और ग्राफ बना सकते हैं।

3.	 Microsoft PowerPoint: इसमें लिखा जा सकता ह,ै तस्वीरें  तथा मीडिया डाला जा सकता ह ैऔर स्लाइड शो और प्रैज़ेंटेशन बनाई जा सकती ह।ै

4.	 Microsoft Outlook: इसके ज़रिये ईमेल भेजी तथा रिसीव की जा सकती हैं।

5.	 Microsoft OneNote: इससे आप बिल्कु ल कागज़ और पेन के अहसास के साथ नोट्स और ड्रॉइंग्स बना सकते हैं।

6.	 Microsoft Access: इसके ज़रिये आप कई सारणियों (टेबल) में डेटा संग्रहित कर सकते हैं।

Microsoft Outlook क्यों चुनें

एक लोकप्रिय ईमेल प्रबंधन विकल्प विशेष रूप से कार्यालयों में, Microsoft Outlook में एड्रेस बुक, नोटबुक, वेब ब्राउज़र और कैलेंडर भी शामिल हैं। इस 

प्रोग्राम के कुछ प्रमुख लाभ इस प्रकार हैं:

•	 एकीकृत खोज प्रोग्राम: आप सभी Outlook प्रोग्रामों में डेटा की खोज करने के लिए कीवर्ड्स का उपयोग कर सकते हैं।

•	 अधिक सुरक्षा: आपका ईमेल हकैर्स, जंक मेल और फिशिग वेबसाइट ईमेल से सुरक्षित ह।ै

•	 ईमेल सिकिग: आपके मेल को आपके कैलेंडर, कॉन्टैक्ट लिस्ट, One Note के नोट और आपके फोन के साथ सिक करता ह।ै

•	 ईमेल का ऑफलाइन उपयोग: इंटरनेट नहीं ह?ै कोई बात नहीं! ईमेल ऑफलाइन लिखें और कनेक्ट होने पर उन्हें भेजें।

•	 ईमेल का जवाब देने के लिए एक शॉर्टकट विधि के रूप में Ctrl + R दबाएँ।

•	 केवल बहुत महत्वपरू्ण  ईमेल के लिए अपनी डेस्कटॉप नोटिफिकेशन सेट करें ।

•	 संदेशों का चयन करें  और Insert key दबाकर, जल्दी से मसेैज फ़्लैग करें ।

•	 बार-बार भेजी जाने वाली ईमेल्स पुन:उपयोग करने के लिए एक टेम्पलेट के रूप में सेव करें ।

•	 सुविधाजनक रूप से महत्वपरू्ण  ईमेल्स को फाइलों के रूप में सेव करें ।
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10.2.3 ई-कॉमर्स

10.2.3.1 ई-कॉमर्स के लाभ

ई-कॉमर्स क्या है

ई-कॉमर्स इलेक्ट्रॉनिक रूप में इंटरनेट पर सामान और सेवाएँ बेचना या खरीदना ह ैया पसेै या डेटा का हस्तांतरण ह।ै ई-कॉमर्स "इलेक्ट्रॉनिक कॉमर्स" का 

संक्षिप्त रूप ह।ै

ई-कॉमर्स के उदाहरण:

•	 ऑनलाइन शॉपिग ऑनलाइन नीलामी

•	 ऑनलाइन टिकेटि ग

•	 इलेक्ट्रॉनिक भुगतान

•	 इंटरनेट बैंकिग

ई-कॉमर्स के प्रकार

ई-कॉमर्स को लेनदेन में प्रतिभागियों के प्रकार के आधार पर वर्गीकृत किया जा सकता ह।ै ई-कॉमर्स के मुख्य प्रकार हैं:

•	 व्यापार से व्यापार (B2B): लेनदेन करने वाले दोनों पक्ष व्यापार हैं।

•	 उपभोक्ता से व्यापार (B2C): व्यवसाय इलेक्ट्रॉनिक रूप से उपभोक्ताओ ंको वस्तु या सेवाएं बेचते हैं।

•	 उपभोक्ता से उपभोक्ता (C2C): उपभोक्ता वस्तुएँ खरीद अथवा बेचकर दूसरे  उपभोक्ताओ ंके साथ कारोबार करते हैं।

•	 उपभोक्ता से व्यापार (C2B): उपभोक्ता उत्पादों या सेवाओ ंका निर्माण करते हैं जो ऐसी कंपनियों के लिए उपलब्ध होते हैं जिन्हें बिल्कु ल वसेै ही 

उत्पाद और सेवाएं चाहिए।

•	 व्यापार से प्रशासन (B2A): कंपनियों और लोक प्रशासन के बीच होने वाले ऑनलाइन लेनदेन।

•	 उपभोक्ता से प्रशासन (C2A): व्यक्तियों और लोक प्रशासन के बीच होने वाले ऑनलाइन लेनदेन।

ई-कॉमर्स व्यापार खुदरा विक्रे ताओ ंऔर ग्राहकों को कुछ लाभ प्रदान करता ह।ै

खुदरा विक्रेत ाओ ंके लिए लाभ:

•	 ऑनलाइन उपस्थिति स्थापित करता है

•	 ऊपरी लागत को हटाकर परिचालन लागत कम कर देता है

•	 अच छ्े  कीवर्ड्स के उपयोग के माध्यम से ब्रांड जागरूकता बढ़ जाती है

•	 भौगोलिक दूरियों तथा समय की कमी जसैी बाधाओ ंको दूर करके बिक्री में बढ़ोत्तरी होती ह।ै

ग्राहकों के लिए लाभ:

•	 किसी भी वास्तविक दुकान से कहीं अधिक व्यापक रें ज प्रदान करता है

•	 दूरस्थ स्थानों से वस्तुओ ंऔर सेवाओ ंकी खरीद सक्षम बनाता है

•	 उपभोक्ताओ ंको मूल्य की तुलना करने में सक्षम बनाता है
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10.2.3.2 डिजिटल इंडिया अभियान

प्रधानमंत्री नरें द्र मोदी ने हर नागरिक को डिजिटल सेवाओ,ं ज्ञान और जानकारी तक पठै/पहँुच प्रदान करने के उद्देश्य से 2015 में डिजिटल इंडिया 

अभियान का शुभारंभ किया। अभियान का उद्देश्य देश के ऑनलाइन बुनियादी ढांचे में सुधार करना और इंटरनेट कनेक्टिविटी बढ़ाना ह,ै इस प्रकार 

ई-कॉमर्स उद्योग को बढ़ावा मिलेगा।

वर्तमान में, अधिकतर ऑनलाइन लेनदेन टियर 2 और टियर 3 शहरों से होते हैं। एक बार डिजिटल इंडिया अभियान स्थापित होने के बाद, सरकार मोबाइल 

कनेक्टिविटी के माध्यम से सेवाएं प्रदान करेग ी, जिससे देश के सुदूर कोनों तक इंटरनेट पहँुचाने में मदद मिलेगी। इससे ई-कॉमर्स बाजार को भारत के 

टीयर 4 शहरों और ग्रामीण क्षेत्रों में प्रवेश करने में मदद मिलेगी।

ई-कॉमर्स गतिविधि

एक उत्पाद या सेवा चुनें जिसे आप ऑनलाइन बेचना चाहते हैं। आप मौजदूा ई-कॉमर्स प्लेटफॉर्म  का उपयोग कैसे करें गे इसकी व्याख्या करते हुए एक 

संक्षिप्त नोट लिखें, या अपने उत्पाद या सेवाएं बेचने के लिए नया ई-कॉमर्स प्लेटफॉर्म  बनाएँ।

10.2.3.3 सुझाव 

•	 अपना ई-कॉमर्स प्लेटफॉर्म  शुरू करने से पहले, सब कुछ जांच लें।

•	 अपने सोशियल मीडिया पर व्यक्तिगत रूप से करीब से ध्यान दें।
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यूनिट 10.3: पसैे का महत्व

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 पसेै बचाने के महत्व पर चर्चा  कर सकें गे

2.	 पसेै बचाने के लाभों पर चर्चा  कर सकें गे

3.	 बैंक खातों के प्रमुख प्रकारों पर चर्चा  कर सकें गे

4.	 बैंक में खाता खोलने की प्रक्रिया का वर्णन करने में

5.	 स्थाई और परिवर्ती लागत के बीच अंतर स्पष्ट कर सकें गे

6.	नि वेश विकल्पों के प्रमुख प्रकारों का वर्णन कर सकें गे

7.	 बीमा उत्पादों के विभिन्न प्रकारों का वर्णन कर सकें गे

8.	 करों के विभिन्न प्रकारों का वर्णन कर सकें गे

9.	 ऑनलाइन बैंकिग के उपयोगों पर चर्चा  कर सकें गे

10.	 इलेक्ट्रॉनिक धन हस्तांतरण के प्रमुख प्रकारों पर चर्चा  कर सकें गे

यूनिट के उद्देश्य 

10.3.1 व्यक्तिगत वित्त – बचत क्यों करें

बचत के महत्व

हम सभी जानते हैं कि भविष्य अप्रत्याशित ह।ै आप नहीं जानते कि कल, अगले सप्ताह या अगले साल क्या होगा। यही कारण ह ैकि साल दर साल पसेै की 

बचत महत्वपरू्ण  होती ह।ै पसैा बचाने से, आपको समय के साथ अपनी वित्तीय स्थिति में सुधार लाने में मदद मिलेगी। लेकिन अधिक महत्वपरू्ण  बात ह,ै  

कि आपात स्थिति के लिए पसेै संभाल कर रखने से आपको मन की शांति मिलेगी। पसेै बचाने से कई और अधिक विकल्पों और संभावनाओ ंके दरवाजे 

खुलते हैं।

बचत करने के लाभ

बचत की आदत डालने से कई लाभ हो सकते हैं। बचत करने से आप को निम्न में मदद मिलती ह:ै

•	 आर्थिक रूप से स्वतंत्र बनने में: जब आपके स्वय को वित्तीय दृष्टि से सुरक्षित महससू कराने के लिए पर्याप्त पसैा हो, तो आप छुट्टियों पर जाने से 

लेकर, करियर बदलने तथा अपना कारोबार शुरु करने तक कोई भी मनचाहा फैसला ले सकते हैं।

•	शि क्षा के माध्यम से स्वयं पर निवेश करें : बचत के माध्यम से, आप पाठ्यक्रमों का भुगतान करने के लिए पर्याप्त कमा सकते हैं जो आपके पेशेवर 

अनुभव में जुड़ जाएगा और अंत में बेहतर वेतन देने वाली नौकरियां मिल जाएंगी।

•	कर्ज  मुक्त हो जाएं: एक बार आरक्षित फंड के रूप में पर्याप्त बचाने के बाद, आप अपनी बचत का उपयोग ऋण या बिलों जसेै कर्ज का भुगतान करने 

के लिए कर सकते हैं, जो समय के साथ संचित हो जाते हैं।

•	 अप्रत्याशित खर्चों के लिए तयैार रहें: बचत होने से आप आर्थिक रूप से बिना तनाव महससू किए अचानक आने वाले कार या घर की मरम्मत जसेै 

अप्रत्याशित खर्चों के लिए भुगतान करने में सक्षम होते हैं।

•	 आपात स्थिति के लिए भुगतान करें : बचत आपको आर्थिक रूप से बोझिल महससू किए बिना अचानक आई स्वास्थ्य समस्याओ ंया तत्काल 

यात्राओ ंजसैी आपातस्थितियों से निपटने में मदद करती ह।ै

•	 बड़ी खरीद करने का सामर्थ्‍य और प्रमुख लक्ष्य प्राप्त करना: लगन से बचत करना घर या एक कार खरीदने जसैी बड़ी खरीद और लक्ष्यों के लिए 

भुगतान करना संभव बनाता ह।ै
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•	 सेवामुक्त होना: जब आपके पास अपनी नौकरी से प्राप्त होने वाली आय नहीं होगी, तब आपके द्वारा समय के साथ बचाए गए पसेै आपको  

आराम देंगे।

10.3.1.1 सुझाव 
•	 अपनी खर्च करने की आदत को कम करें । प्रति सप्ताह एक महंगी आइटम पर खर्च नहीं करने की कोशिश करें  और उस पसेै को अपनी बचत में डालें 

जिसे अन्यथा आपने खर्च कर दिया होता।

•	 तय करें  कि आप निश्चित दिनों या हफ्तों पर कुछ भी नहीं खरीदेंगे और अपने निश्चय पर अडिग रहेंगे।

10.3.2 बैंक खातों के प्रकार

भारत में बैंक चार मुख्य प्रकार के बैंक खातों की पेशकश करते हैं। ये हैं:

1.	च ाल ूखाते

2.	 बचत खाते

3.	 आवर्ती जमा खाते

4.	 सावधि जमा खाते

चालू खाते

चाल ूखाते सबसे अधिक द्रव्य/तरल जमा की पेशकश करते हैं और इस प्रकार, व्यापारियों और कंपनियों के लिए सबसे अनुकूल हैं। क्योंकि यह खाते 

निवेश और बचत के लिए नहीं बने हैं, इसलिए एक दिन में किए जाने वाले लेनदेन की संख्या या राशि पर कोई सीमा नहीं लगाई गई ह।ै चाल ूखाता धारकों 

को अपने खातों में रखी राशि पर कोई ब्याज नहीं देता ह।ै उनसे इस तरह के खातों पर ऑफर की जाने वाली कुछ सेवाओ ंके लिए शुल्क लिया जाता ह।ै

बचत खाते

बचत खाते बचत को बढ़ावा देने के लिए होते हैं और इसलिए वेतनभोगी व्यक्तियों, पेंशनरों और छात्रों के लिए नंबर एक पसंद हैं। हालांकि जमा की राशि 

और संख्या पर कोई प्रतिबंध नहीं ह,ै फिर भी सामन्यता निकासी की राशि और संख्या पर प्रतिबंध होते हैं। बचत खाता धारकों को अपनी बचत पर ब्याज़ 

दिया जाता ह।ै

आवर्ती जमा खाते

आवर्ती जमा खातों को RD खाते भी कहा जाता ह,ै जो उन लोगों के लिए होते हैं जो हर महीने एक राशि बचाना चाहते हैं, लेकिन एक बार में एक बड़ी राशि 

निवेश करने में असमर्थ हैं। इस तरह के खाता धारक परू्व  निर्धा रित अवधि (कम से कम 6 महीने) के लिए एक छोटी, निश्चित राशि हर महीने जमा करते 

हैं। मासिक भुगतान में देरी होने पर खाता धारक से एक दंड राशि ली जाती ह।ै कुल राशि निर्धा रित अवधि के अंत में ब्याज के साथ लौटा दी जाती ह।ै

सावधि जमा खाते

सावधि जमा खातों को FD खाते भी कहा जाता ह,ै ये उन लोगों के लिए आदर्श हैं जो ब्याज की एक उच्च दर के बदले में लंबे समय के लिए अपनी  

बचत जमा करना चाहते हैं। ब्याज दर की पेशकश जमा राशि और समय अवधि पर निर्भर करती ह ैऔर यह हर बैंक में अलग-अलग होती ह।ै FD के मामले 

में, खाता धारक द्वारा एक निश्चित राशि निश्चित समय अवधि के लिए जमा की जाती ह।ै जब अवधि समाप्त हो जाती ह ैतो पसैा वापस लिया जा सकता ह।ै 

यदि आवश्यक हो, तो जमाकर्ता  समय से पहले सावधि जमा तोड़ सकते हैं। बहरहाल, इससे सामान्यता एक दंड राशि लगती ह ैजो हर बैंक में अलग-अलग 

होती ह।ै
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10.3.2.2 सुझाव 

10.3.2.1 बैंक में खाता खोलना
बैंक में खाता खोलना काफी सरल प्रक्रिया ह।ै अपना खुद का एक खाता खोलने के लिए निम्न चरणों पर एक नज़र डालें:

चरण 1: खाता खोलने वाला फॉर्म भरें
इस फॉर्म  में आप को निम्नलिखित जानकारी प्रदान करनी होगी:

•	 व्यक्तिगत विवरण (नाम, पता, फोन नंबर, जन्म तिथि, लिग, व्यवसाय, पता)

•	 अपने खाते का विवरण प्राप्त करने की विधि (हार्ड  कॉपी/ईमेल)

•	 अपने आरंभिक जमा का विवरण (नकद/चकै)

•	 खाते के संचालन का तरीका (ऑनलाइन/मोबाइल बैंकिग/पारंपरिक चकै के माध्यम से, स्लिप बुक्स) सुनिश्चित करें  कि आप ने हर आवश्यक जगह 

पर हस्ताक्षर किए हैं।

चरण 2: अपनी तस्वीर लगाएँ
फॉर्म  पर दी गई जगह में अपनी हाल ही की फोटोग्राफ चिपकाएं।

चरण 3: अपना, अपने ग्राहक को जानिए (KYC) विवरण प्रदान करें
KYC एक प्रक्रिया ह ैजो बैंकों को अपने ग्राहकों के पते और उनकी पहचान की पुष्टि करने में मदद करती ह।ै एक खाता खोलने के लिए, हर व्यक्ति को 

फोटो पहचान (ID) और पते के प्रमाण के संबंध में कुछ अनुमोदित दस्तावेज प्रस्तुत करने होते हैं।। कुछ आधिकारिक वधै दस्तावेज़ (OVDs) हैं:

•	 पासपोर्ट

•	 ड्राइविंग लाइसेंस

•	 मतदाता पहचान पत्र

•	 पनै कार्ड

•	 UIDAI (आधार) कार्ड

चरण 4: अपने सभी दस्तावेज़ जमा करें
खाता खोलने का भरा हुआ फॉर्म  और KYC दस्तावेज़ जमा करें । फिर फॉर्म  पर कार्र वाई होने और आपका खाता खुलने तक प्रतीक्षा करें !

•	 उपयुक्त खाता चुनें।

•	 नामांकन की परूी जानकारी भरें ।

•	 शुल्कों के बारे  में पछूें ।

•	 नियमों को समझें।

•	 ऑनलाइन बैंकिग के बारे  में पछूें  - यह सुविधाजनक ह!ै

•	 अपने बैंक बलैेंस पर नज़र रखें।
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10.3.3 लागतें: स्थाई बनाम परिवर्ती

10.3.4 निवेश, बीमा व कर

स्थाई व परिवर्ती लागतें क्या हैं

•	 स्थाई व परिवर्ती लागत मिलकर किसी कंपनी की कुल लागत बनती ह।ै वस्तुओ ंव सेवाओ ंका उत्पादन करते हुए कम्पनी को ये दो प्रकार के मूल्य 

वहन करने पड़ते हैं।

•	 स्थाई लागत किसी कंपनी द्वारा उत्पादित वस्तुओ ंव सेवाओ ंकी मात्रा के साथ बदलती नहीं ह।ै यह हमेशा समान रहती ह।ै

•	 दूसरी ओर, परिवर्ती लागत, उत्पादित वस्तुओ ंव सेवाओ ंकी मात्रा के अनुसार घटती व बढ़ती रहती ह।ै दूसरे  शब्दों में, यह उत्पादित मात्रा के अनुसार 

बदलती रहती ह।ै

स्थाई व परिवर्ती लागतों के बीच अंतर

आइए स्थाई व परिवर्ती लागतों के बीच प्रमुख अतंरों पर नज़र डालें:

कसौटी स्थाई लागत परिवर्ती लागत

अर्थ लागत समान रहती ह,ै चाहे उत्पादन की मात्रा 

कितनी भी क्यों न हो।

ऐसी लागत जो निम्नानुसार बदलती रहती है

प्रकृति समय सम्बंधित मात्रा सम्बंधित

व्यय / खर्च व्यय पर उत्पादित यनूिट्स की मात्रा से कोई 

फर्क  नहीं पड़ता।

यनूिट्स का उत्पादन किये जाने पर ही व्यय होता ह।ै

यनूिट लागत उत्पादित यनूिट्स की संख्या के व्युत्क्रमानुपाती 

होती है

प्रति यनूिट, समान रहती ह।ै

उदाहरण मूल्य ह्रास, किराया, वेतन, बीमा, कर आदि उपयोग किया गया मटैीरियल, वेतन, बिक्री पर कमीशन, पकैिग खर्च आदि।

10.3.3.1 सुझाव 
•	 कोई लागत स्थाई ह ैया परिवर्ती, यह निर्धा रित करने के लिए निम्न प्रश्न पछूें : यदि कंपनी अपनी उत्पादन गतिविधियाँ रोक देती ह,ै तो किसी विशिष्ट 

लागत में कोई परिवर्तन होगा? यदि उत्तर ‘नहीं’ ह,ै तो यह स्थाई लागत ह।ै यदि उत्तर ‘हां’ ह,ै तो संभवतः यह परिवर्ती लागत ह।ै

निवेश

निवेश का अर्थ ह ैभविष्य में वित्तीय लाभ कमाने के उद्धेश्य से आज व्यय किया गया धन। निवेश विकल्पों के प्रमुख प्रकार निम्नलिखित हैं:

•	 बॉन्ड्स : बॉन्ड्स  सार्वजनिक व निजी कंपनियों द्वारा धन की एक बड़ी राशि जुटाने का साधन ह ै- यह राशि इतनी बड़ी होती ह,ै कि इसे बैंक से ऋण 

के रूप में नहीं लिया जा सकता। ये बॉन्ड्स  (प्रतिज्ञापत्र) फिर सार्वजनिक बाज़ार में जारी किये जाते हैं और ऋणदाताओ ंद्वारा ख़रीदे जाते हैं।

•	 स्टॉक: स्टॉक या इक्विटी कंपनियों द्वारा जारी किये गए शेयर होते हैं जो आम जनता द्वारा ख़रीदे जाते हैं।

•	ल घु बचत योजनाएं: लघु बचत योजनाएं कम-कम मात्रा में धन की बचत करने के साधन हैं। कुछ लोकप्रिय योजनाओ ंमें कर्मचारी भविष्य निधि, 

सुकन्या समदृ्धि योजना व राष्ट्रीय पेंशन योजना शामिल हैं।
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•	 म्यूचुअल फंड: म्यूचअल फंड पेशेवर तरीके से प्रबंधित वित्तीय साधन हैं, जिनमें निवेशकों की ओर से विभिन्न प्रतिभतूियों में धन का निवेश किया 

जाता ह।ै

•	 सावधि जमाएँ: किसी वित्तीय संस्थान के पास निर्धा रित समय के लिए निश्चित धनराशि जमा कराई जाती ह ैजिससे धन पर ब्याज मिलता है

•	 रियल एस्टेट: संपत्ति खरीदने के लिए बैंकों से ऋण लिया जाता ह,ै जो इसके बाद किराये पर दी जाती ह ैया बेच दी जाती ह ैजिसका उद्देश्य संपत्ति की 

बढ़ी हुई कीमतों पर लाभ कमाना होता ह।ै

•	 हेज फंड्स: हेज फंड्स वित्तीय यौगिकों और / या सार्वजनिक रूप से खरीदी-बेची जाने वाली प्रतिभतूियों, दोनों में ही निवेश किये जाते हैं।

•	प्रा इवेट इक्विटी: प्राइवेट इक्विटी किसी ऐसी ऑपरेटि ग कंपनी के शेयरों में निवेश करना ह,ै जो सार्वजनिक रूप से सचूीबद्ध/लिस्टेड नहीं होती और 

जिसके शेयर स्टॉक मार्कि ट में उपलब्ध नहीं होते।

•	 उद्यम पंूजी (वेंचर कैपिटल): उद्यम पूंजी (वेंचर कैपिटल) का अर्थ ह,ै किसी उभरती हुई कंपनी में, स्टॉक्स के बदले, भारी मात्रा में पसैा लगाना।

बीमा

बीमा दो तरह का होता ह:ै

1.	 जीवन बीमा 

2.	ग रै-जीवन या सामान्य बीमा

जीवन बीमा उत्पाद

मुख्य जीवन बीमा उत्पाद हैं:

1.	निर्धा रित अवधि बीमा (टर्म इंश्योरें स): यह बीमा का सबसे सरल व सस्ता प्रारूप ह।ै यह निर्धा रित अवधि, जसेै 15 से 20 वर्ष  के लिए वित्तीय सुरक्षा 

उपलब्ध कराता ह।ै मतृ्यु होने की स्थिति में, आपके परिवार को बीमित राशि का भुगतान किया जाता ह।ै यदि बीमाकर्ता  निर्धा रित अवधि तक जीवित 

रहता ह,ै तो उसे किसी तरह का भुगतान नहीं करना पड़ता।

2.	 एंडोमेंट पॉलिसी: यह बीमा व निवेश के दोहरे  फायदे देती ह।ै प्रीमियम का कुछ हिस्सा बीमित राशि में आबंटित किया जाता ह ैजबकि शेष प्रीमियम 

का निवेश इक्विटी व डेब्ट में किया जाता ह।ै इसमें निर्धा रित अवधि के बाद या बीमा धारक की मतृ्यु जो भी पहले हो, होने पर एकमुश्त राशि का 

भुगतान किया जाता ह।ै

3.	 यूनिट-लिंक्ड इंश्योरें स प्लान (ULIP): इसमें प्रीमियम का कुछ हिस्सा जीवन बीमा पर खर्च किया जाता ह,ै जबकि शेष हिस्से का निवेश इक्विटी व 

डॅब्‍ट में कर दिया जाता ह।ै इससे नियमित बचत की आदत विकसित होती ह।ै

4.	 मनी बकै जीवन बीमा: पॉलिसी अवधि के दौरान, पॉलिसीधारक के जीवित रहने पर आंशिक उत्तरजीविता लाभों का आवधिक भुगतान किया जाता 

ह।ै बीमाधारक की मतृ्यु होने पर, कंपनी उत्तरजीविता लाभों के साथ परूी बीमित राशि का भुगतान करती ह।ै

5.	 पूर्ण जीवन बीमा: यह बीमा तथा निवेश के दोहरे  लाभ देता ह ैयह व्यक्ति के परूे  जीवन या 100 वर्ष  की उम्र, जो भी पहले हो तक बीमा कवर उपलब्ध 

करता ह।ै

सामान्य बीमा (जनरल इंश्योरें स)

सामान्य बीमा (जनरल इंश्योरें स) के अन्तर्गत सभी इंश्योरें स कवर वाली सम्पत्तियों, जसेै पशु, खेती की फसलों, वस्तुओ,ं कारखानों, कारों आदि का बीमा 

किया जाता ह।ै

सामान्य बीमा उत्पाद:

1.	 मोटर बीमा: इसे चौपहिया वाहन बीमा व दुपहिया वाहन बीमा में बांटा जा सकता ह।ै

2.	 स्वास्थ्य बीमा: स्वास्थ्य बीमा के प्रमुख प्रकारों में व्यक्तिगत स्वास्थ्य बीमा, फैमिली फ्लोटर स्वास्थ्य बीमा, समग्र स्वास्थ्य बीमा व गंभीर बीमारी 

बीमा शामिल होते हैं।

3.	 यात्रा बीमा: इसे व्यक्तिगत ट्रेवल पॉलिसी, फैमिली ट्रेवल पॉलिसी, स्टूडेंट ट्रेवल इंश्योरें स व सीनियर सिटिज़न हेल्थ इंश्योरें स में वर्गीकृत किया जा 

सकता ह।ै
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4.	 गहृ बीमा: यह मकान व सामान को जोखिम से सुरक्षा प्रदान करता ह।ै

5.	 समुद्री बीमा (मेरीन इंश्योरैंस): यह बीमा रे ल, सड़क, समुद्र या वायु मार्ग  से आवागमन के दौरान वस्तुओ,ं माल, कार्गो आदि के गुम हो जाने अथवा 

क्षतिग्रस्त हो जाने की स्थिति में वित्तीय सुरक्षा प्रदान करता ह।ै

कर (टकै्स)

कर (टकै्स) दो प्रकार के होते हैं: 

1.	 प्रत्यक्ष कर 

2.	 अप्रत्यक्ष कर

प्रत्यक्ष कर

प्रत्यक्ष कर किसी यनूिट या व्यक्ति पर प्रत्यक्ष रूप से लगाये जाते हैं और ये अहस्तांतरणीय होते हैं। प्रत्यक्ष करों के कुछ उदाहरण हैं:

•	 आय कर: यह कर एक वित्तीय वर्ष  के दौरान आपकी आय पर लगाया जाता ह।ै यह व्यक्तियों व कंपनियों, दोनों पर लाग ूहोता ह।ै

•	 पंूजी लाभ कर: जब भी आपको एक बड़ी मात्रा में धन मिलता ह,ै तो यह कर लाग ूहोता ह।ै  आमतौर पर यह दो प्रकार का होता ह ै- 36 महीनों से कम 

के लिए किये गए निवेश पर होने वाला अल्पावधि पूंजी लाभ व 36 महीनों से अधिक की अवधि के लिए किये गए निवेश पर होने वाला दीर्घकालिक 

पूंजी लाभ।

•	 प्रतिभूति लने-दने कर: यह कर शेयर के मूल्य में जोड़ दिया जाता ह।ै हर बार शेयर बेचते या खरीदते समय यह कर लगता ह।ै

•	 अनुलाभ कर: यह कर कंपनी द्वारा उपार्जित भत्तों या कर्मचारियों द्वारा उपयोग किये गए भत्तों पर लगता ह।ै

•	क ॉर्पोरेट कर: कंपनियों द्वारा अर्जित राजस्व पर कॉर्पोरे ट कर दिया जाता ह।ै

अप्रत्यक्ष कर

अप्रत्यक्ष कर वस्तुओ ंया सेवाओ ंपर लगाये जाते हैं। अप्रत्यक्ष करों के कुछ उदाहरण हैं:

•	बिक्री  कर: बिक्री कर किसी उत्पाद की बिक्री पर लगाया जाता ह।ै

•	 सेवा कर: सेवा कर भारत में उपलब्ध कराई जाने वाली सेवाओ ंपर लगाया जाता ह।ै

•	 मूल्य-वर्द्धित कर: मूल्य- वर्द्धित कर का निर्णय राज्य सरकार द्वारा लिया जाता ह ैयह कर राज्य में बेचीं जाने वाली वस्तुओ ंपर लगाया जाता ह।ै कर 

की राशि का निर्धारण राज्य द्वारा किया जाता ह।ै

•	क स्टम शुल्क व चुंगी: कस्टम शुल्क ऐसा शुल्क ह ैजो किसी अन्य देश से आयात कर खरीदी गई वस्तुओ ंपर लगाया जाता ह।ै चंुगी उन वस्तुओ ंपर 

लगती ह ैजो भारत में ही एक राज्य से दूसरे  राज्य में ले जाई जाती हैं।

•	 उत्पाद शुल्क: भारत में विनिर्मित या उत्पादित सभी वस्तुओ ंपर उत्पाद शुल्क लगाया जाता ह।ै

10.3.4.1 सुझाव 
•	 इस बात पर विचार करें  कि आप अपना धन कितनी जल्दी वापस पाना चाहते हैं और इसी के अनुसार अपनी निवेश योजना चुनें।

•	 सुनिश्चित करें  कि आप अपने लिए उपयुक्त बीमा पॉलिसी चुन रहे हों।

•	 याद रखें, करों का भुगतान न करने पर जुर्माने से लेकर जेल तक की सज़ा हो सकती ह।ै
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10.3.5 ऑनलाइन बैंकिग, NEFT, RTGS आदि

ऑनलाइन बैंकिग क्या ह?ै

इंटरनेट या ऑनलाइन बैंकिग खाताधारकों को लपैटॉप के ज़रिये कहीं से भी अपना खाता एक्सेस करने की सुविधा प्रदान करती ह।ै इस तरह से, निर्देश 

जारी किये जा सकते हैं। अपना खाता एक्सेस करने के लिए, खाताधारकों को अपना विशेष ग्राहक आईडी नंबर और पासवर्ड  प्रयोग करना होता ह।ै

इंटरनेट बैंकिग का प्रयोग निम्न के लिए किया जा सकता ह:ै

•	 खाते में बकाया राशि का पता लगाने के लिए

•	 एक खाते से दूसरे  खाते में पसैा हस्तांतरित करने के लिए

•	 चेक जारी करने हेतु

•	 भुगतान हेतु निर्देश देने के लिए

•	 चेक बुक हेतु निवेदन करने के लिए

•	 खाते के विवरण हेतु निवेदन के लिए

•	 सावधि जमा के लिए

इलके्ट्रॉनिक फंड ट्रांसफर के लिए

इलेक्ट्रॉनिक फंड ट्रांसफर इंटरनेट व मोबाइल बैंकिग जसेै एकीकृत बैंकिग साधनों का इस्तेमाल करके, आराम से घर बठेै धन हस्तांतरित करने का एक 

सुविधाजनक तरीका ह।ै

इलेक्ट्रॉनिक माध्यमों से धन का हस्तांतरण अत्यधिक सुविधाजनक ह।ै ऑनलाइन बैंकिग की मदद से आप इनका चयन कर सकते हैं:

•	 समान बैंक में अपने ही एक खाते से दूसरे  खाते में धन का हस्तांतरण।

•	 समान बैंक के अलग-अलग खातों में धन का हस्तांतरण।

•	 NEFT का प्रयोग करते हुए विभिन्न बैंकों के खातों में धन हस्तांतरण।

•	 RTGS का प्रयोग करते हुए अन्य बैंक खातों में धन हस्तांतरण।

•	 IMPS का प्रयोग करते हुए विभिन्न बैंक खातों में धन का हस्तांतरण।

NEFT

NEFT का अर्थ ह ैनेशनल इलेक्ट्रॉनिक फण्ड ट्रांसफर। यह धन हस्तांतरण प्रणाली आपको अपने बैंक खाते से उसी बैंक के किसी अन्य खाते में या किसी 

अन्य बैंक के खाते में इलेक्ट्रॉनिक रूप से धन हस्तांतरित करने की सुविधा प्रदान करती ह।ै NEFT का प्रयोग व्यक्तियों, फर्मों व कॉर्पोरे ट संगठनों द्वारा 

एक खाते से अन्य खातों में धन के हस्तांतरण के लिए किया जाता ह।ै

NEFT के माध्यम से धन हस्तांतरित करने के लिए, दो चीज़ों की आवश्यकता होती ह:ै

•	 हस्तांतरण करने वाला बैंक

•	 लक्ष्यित बैंक

NEFT के माध्यम से धन हस्तांतरित करने से पहले आपको उस लाभार्थी का पंजीकरण करना पड़ेगा जिसे धन भेजा जाना ह।ै इस पंजीकरण को परूा करने 

के लिए, आपको निम्नलिखित की आवश्यकता पड़ेगी

•	 प्राप्तकर्ता  का नाम

•	 प्राप्तकर्ता  की खाता संख्या

•	 प्राप्तकर्ता  के बैंक का नाम

•	 प्राप्तकर्ता  के बैंक का IFSC कोड
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RTGS

RTGS का अर्थ ह ैरियल टाइम ग्रॉस सेटलमेंट यह एक रियल टाइम धन हस्तांतरण प्रणाली ह,ै जो आपको सकल आधार पर या तुरंत एक बैंक से दूसरे  बैंक 

में धन हस्तांतरित करने में सक्षम बनाती ह।ै हस्तांतरित धन एक बैंक के खाते से तुरंत निकाल लिया जाता ह ैऔर उसी समय दूसरे  बैंक के खाते में जमा 

हो जाता ह।ै RTGS भुगतान गेटवे का रख-रखाव भारतीय रिज़र्व बैंक द्वारा किया जाता ह।ै बैंकों के बीच लेन-देन इलेक्ट्रॉनिक रूप से किया जाता है

RTGS का प्रयोग व्यक्तियों, कंपनियों व फर्मों द्वारा बड़ी मात्रा में धन हस्तांतरित करने के लिए किया जा सकता ह।ै RTGS के द्वारा धन भेजने से पहले, 

आपको अपने ऑनलाइन बैंकिग खाते के ज़रिये लाभार्थी व उसके बैंक खाते का विवरण डालना होगा। यह पंजीकरण परूा करने के लिए, आपको 

निम्नलिखित जानकारी की आवश्यकता होगी:

•	 लाभार्थी का नाम	

•	 लाभार्थी की खाता संख्या

•	 लाभार्थी के बैंक का पता	

•	 बैंक का IFSC कोड

IMPS

IMPS का अर्थ ह ैइमीडियेट पेमेंट सर्विस (त्वरित भुगतान सेवा)। यह एक रियल-टाइम, अंतर-बैंकीय, इलेक्ट्रॉनिक धन हस्तांतरण प्रणाली ह,ै जिसका 

प्रयोग भारत भर के बैंकों में धन के हस्तांतरण के लिए किया जाता ह।ै IMPS उपयोक्ताओ ंको मोबाइल फोन का प्रयोग करते हुए, मोबाइल बैंकिग व SMS 

के माध्यम से त्वरित इलेक्ट्रॉनिक हस्तांतरण भुगतान में सक्षम बनता ह।ै इसका प्रयोग ATMs व ऑनलाइन बैंकिग के माध्यम से भी किया जा सकता ह।ै 

IMPS हफ्ते के सातों दिन चौबिसों घंटे उपलब्ध ह।ै यह प्रणाली एक सुरक्षित हस्तांतरण गेटवे ह ैऔर तुरंत ऑर्डर्स  के परूे  होने की पुष्टि करता ह।ै

IMPS के माध्यम से धन हस्तांतरण के लिए आपको यह करने की आवश्यकता ह:ै

•	 अपने बैंक में IMPS के लिए पंजीकरण

•	 बैंक से एक मोबाइल मनी आइडेंटिफायर (MMID) प्राप्त करें

•	 बैंक से MPIN प्राप्त करें

ये दोनों प्राप्त करने के बाद आप लाभार्थी को कोई भी राशि हस्तांतरित करने के लिए लॉग-इन कर सकते हैं या SMS के माध्यम से निवेदन भेज सकते हैं।

लाभार्थी को हस्तांतरित धन प्राप्त करने के लिए निम्न चीज़ें करनी होंगी:

•	 अपने मोबाइल नंबर को सम्बंधित खाते से जोड़ना

•	 बैंक से MMID प्राप्त करना

IMPS के माध्यम से धन का हस्तांतरण करने के लिए, आपको निम्नलिखित जानकारी डालनी होगी:

•	 लाभार्थी का मोबाइल नंबर	

•	 लाभार्थी का MMID

•	 हस्तांतरित राशि	

•	 आपका MPIN

जसेै ही आपके खाते से धन निकल जाता ह ैऔर लाभार्थी के खाते में पहँुच जाता ह,ै तो भविष्य में सन्दर्भ के लिए आपको ट्रांज़ेक्शन रिफरे न्स नंबर के साथ 

एक पुष्टि (कन्फर्मेशन) SMS भेजा जायेगा।
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10.3.5.1 NEFT, RTGS व IMPS के बीच अंतर

10.3.5.2 सुझाव 

•	 अपनी ऑनलाइन बैंकिग वेबसाइट देखने के लिए, कभी भी किसी ई-मेल सन्देश में दिए गए किसी लिक पर क्लिक न करें ।

•	 ऑनलाइन बैंकिग का प्रयोग करने के दौरान आपसे कभी भी आपके क्रेडि ट या डेबिट कार्ड  की जानकारी नहीं मांगी जाती।

•	 अपना ऑनलाइन बैंकिग पासवर्ड  नियमित रूप से बदलते रहे।

चित्र 10.3.1: NEFT, RTGS व IMPS के बीच अंतर
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यूनिट 10.4: रोज़गार व स्व-रोज़गार के लिए तयैारी

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 साक्षात्कार के लिए तयैारी करने के विभिन्न चरणों पर चर्चा  कर सकें गे

2.	 प्रभावी रिज़्यूमे बनाने के विभिन्न चरणों पर चर्चा  कर सकें गे

3.	 साक्षात्कार में अक्सर पछूे  जाने वाले सवालों पर चर्चा  कर सकें गे

4.	च र्चा  कर सकें गे कि साक्षात्कार में अक्सर पछूे  जाने वाले सवालों का जवाब कैसे दिया जाए

5.	 बुनियादी कार्यस्थल शब्दावली पर चर्चा  कर सकें गे

यूनिट के उद्देश्य 

10.4.1 साक्षात्कार (इंटरव्यू) की तयैारी: इंटरव्यू के लिए तयैारी कैसे करें
आप जो नौकरी चाहते हैं, उसे पाने के लिए आपकी सफलता मुख्य रूप से इस बात पर निर्भर करती ह,ै कि उस नौकरी के लिए आपका इंटरव्यू कैसा होता 

ह।ै इसलिए, अपना इंटरव्यू देने से पहले यह महत्त्वपरू्ण  ह,ै कि आप थोड़े सी रिसर्च व योजना के साथ इसकी तयैारी कैसे करते हैं। किसी भी इंटरव्यू के लिए 

परूी तरह तयैारी करने से पहले इन चरणों का ध्यान रखें:

1.	जि स संगठन के लिए इंटरव्यू द ेरहे हैं उसके बारे में जानकारी प्राप्त करें ।

•	 पहले से ही कंपनी के बारे  में जानकारी प्राप्त कर लेने से आपको इंटरव्यू के समय अधिक तयैार रहने में मदद मिलेगी। संगठन के बारे  में आपकी 

जानकारी से आपको इंटरव्यू में प्रश्नों का उत्तर देने में आसानी होगी और आप अधिक विश्वस्त दिखाई देंगे और महससू करें गे। इससे आप निश्चित रूप 

से, उन उम्मीदवारों से अलग दिखाई देंगे जिन्हें इसके बारे  में इतनी जानकारी नहीं ह।ै

•	 कंपनी की पषृ्ठभमूि की जानकारी लें। कंपनी व इसके उद्योग विवरण की परूी जानकारी प्राप्त करने का प्रयास करें ।

•	 कंपनी के क्रियाकलापों की जानकारी प्राप्त करने के लिए कंपनी की वेबसाइट देखना भी एक अच्छा तरीका ह।ै कंपनी की वेबसाइट महत्त्वपरू्ण 

जानकारी का साधन होती ह।ै कंपनी की मिशन स्टेटमेंट (ध्येय वक्तव्य) को पढ़ें  व समझें। कंपनी के उत्पादों/सेवाओ ंव ग्राहकों की सचूी पर विशेष 

ध्यान दें। कंपनी के संभावित विकास व स्थिरता की जानकारी के लिए इसकी प्रेस विज्ञप्तियां पड़ें।

•	 अपनी खोजबीन परूी करने के बाद यदि कोई प्रश्न मन में हों, तो उन्हें लिखें।

2.	 इस बारे में विचार करें  कि क्या आपकी कुशलताएं व योग्यताएं नौकरी की आवश्यकताओ ंसे मेल खाती हैं।

•	 सावधानीपरू्वक नौकरी के विवरण को पड़ें व उसका विश्ले षण करें ।

•	 नौकरी की आवश्यकताओ ंको परूा करने वाली जानकारी, कुशलताओ ंव योग्यताओ ंका संक्षिप्त विवरण बनाएं।

•	 संगठन के पदानुक्रम पर नज़र डालें। यह देखें की जिस पद के लिए आपने आवेदन किया ह ैवह इस क्रम में कहाँ पर ह।ै

3.	 आमतौर पर सबसे अधिक पूछे जाने वाल ेइंटरव्यू प्रश्न दखेें और अपने उत्तर तयैार करें ।

•	 याद रखें, अधिकांश इंटरव्यू (साक्षात्कारों) में आपके रिज़्यूमे से जुड़े  व केस स्टडी (विशिष्ट मामलों से जुड़े) प्रश्न पछूे  जाते हैं।

•	 इन क्षेत्रों से जुड़े  सामान्य प्रश्नों के उत्तर के बारे  में विचार करें ।

•	 इन उत्तरों का तब तक अभ्यास करें  जब तक आप विश्वस्त व स्पष्ट तरीके से इनका जवाब देने में सक्षम न हो जाएं।

4.	 इंटरव्यू के लिए अपनी वेशभूषा की योजना बनाएं।

•	 औपचारिक व्यावसायिक वेशभषूा चुनना ही सबसे सुरक्षित विकल्प होता ह,ै बशर्ते बिज़नेस कैजुअल परिधान की मांग न की जाये (इस मामले में 

अपना सर्वोत्तम निर्णय प्रयोग करना चाहिए)।
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•	 सुनिश्चित कर लें की आपके वस्त्र साफ़-सुथरे  व अच्छी तरह प्रेस/ इस्त्री किये गए हों। सामान्य रंग के कपड़ें पहने - न तो अत्यधिक चमकदार और न 

ही बहुत हल्के  रंग के।

•	 आपके द्वारा पहने गए जतेू आपके कपड़ों के अनुरूप होने चाहिए और इंटरव्यू में पहनने योग्य होने चाहिए।

•	 याद रखें, आपका लक्ष्य हर व्यक्ति पर यह प्रभाव छोड़ना ह ैकि आप एक प्रोफेशनल व अत्यधिक सक्षम व्यक्ति हैं।

5.	 सुनिश्चित कर लें की आपने वह सब कुछ अपने पास रख लिया ह ैजिसकी इंटरव्यू के दौरान ज़रूरत पड़ सकती ह।ै

•	 अपने रिज़्यूमे (जीवनवतृ) की कुछ प्रतियाँ अपने पास रखें। अपने रिज़्यूमे के लिए एक अच्छी गुणवत्ता वाले पेपर का उपयोग करें ।

•	 हमेशा अपने पास एक नोटपडै व पेन रखें।

•	 आवेदन पत्र भरने के लिए, अपने साथ पर्याप्त जानकारी ले जाएं।

•	 यदि प्रासंगिक हो तो, अपने साथ अपने कार्य  के कुछ सैंपल (नमूने) ले जाएं।

6.	 अमौखिक संवाद के महत्त्व को याद रखें।

•	 विश्वास बढ़ानें का अभ्यास करें । स्वय को मुस्कुर ाने की याद दिलाते रहें और, सामने वाले की आँखों की तरफ देखकर बात करें । मजबतूी से हाथ 

मिलाएं।

•	 दिमाग में बठैने/खड़े होने की मुद्रा का ध्यान रखें। सीधे खड़े होने का अभ्यास करें । नर्वस होने के लक्षणों, जसेै चंचल होने व परै को लगातार हिलाने 

से स्वय को रोकने का अभ्यास करें ।

•	 अपनी प्रतिक्रियाओ ंको नियत्रण में रखें। याद रखें, आपके चेहरे  के भाव आपकी वास्तविक भावनाओ ंको अभिव्यक्त करते हैं। अपनी एक सकारात्मक 

छवि बनाने का प्रयास करें ।

7.	 इंटरव्यू समाप्त करने वाल ेप्रश्नों की सूची बनाएं।

•	 अधिकांश साक्षात्कारों में, साक्षातकर्ता  आपसे पछूें  कि क्या आपके भी कुछ प्रश्न हैं? अब आपके पास यह दिखाने का मौका ह ैकि आपने क्या रिसर्च 

की हुई ह ैऔर आप कंपनी के बारे  में और अधिक जानने के इच छ्ु क हैं।

•	 यदि साक्षात्कारकर्ता  आपसे यह प्रश्न नहीं पछूता ह ैतो आप उन्हें यह बता सकते हैं कि आपके पास कुछ ऐसे प्रश्न हैं जिन पर आप चर्चा  करना चाहते 

हैं। आपके पास अब उन नोट्स का सन्दर्भ देने का अवसर ह ैजिसके बारे  में आपने अध्ययन किया ह।ै

•	 इस समय पछूे  जाने वाले कुछ अच छ्े  प्रश्न हैं:

»	 इस नौकरी में सफलता के लिए आपके अनुसार सबसे महत्वपरू्ण  मापदंड यह ह?ै

»	 मेरे  कार्यप्रदर्शन का मूल्यांकन कैसे किया जायेगा?

»	 उन्नति के लिए क्या अवसर हैं?

»	 नौकरी पर रखने की (हायरिंग) प्रक्रिया के अगले चरण क्या हैं?

•	 याद रखें, कभी भी वह जानकारी न पछूें  जो कंपनी की वेबसाइट पर आसानी से उपलब्ध ह।ै

10.4.1.1 सुझाव 
•	 व्यावहारिक व संभावित प्रश्न पछूें ।

•	 बातचीत करते समय, भाव-भंगिमाओ ंके प्रभावी रूपों जसेै मुस्कुर ाहट, नेत्र संपर्क  व सक्रियता से सुनने व सिर हिलाने का प्रयोग करें । झुकें  नहीं, 

आसपास की वस्तुओ ंसे खिलवाड़ न करें , बेचनै न हों, च्यूइंगम न चबाएं, या बड़बड़ाएं नहीं।
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10.4.2 प्रभावी रिज़्यूमे तयैार करना 
रिज़्यूमे एक ऐसा औपचारिक दस्तावेज़ होता ह,ै जो किसी उम्मीदवार के कार्यानुभव, शिक्षा व कुशलताओ ं को प्रदर्शित करता ह।ै एक अच्छा रिज्यूम 

संभावित नियोक्ता को पर्याप्त जानकारी देकर यह विश्वास दिलाता ह ैकि आवेदक साक्षात्कार के लिए योग्य ह।ै इसलिए रिज़्यूमे प्रभावी तरीके से बनाना 

बहुत महत्वपरू्ण  ह।ै प्रभावी रिज़्यूमे बनाने के लिए निम्नलिखित चरणों पर नज़र डालें:

चरण 1: अपने पत ेवाला हिस्सा लिखें

पते का हिस्सा आपके रिज़्यूमे में सबसे ऊपर होना चाहिए। इसमें आपका नाम, पता, फ़ोन नंबर व ई-मेल एड्रेस शामिल होता ह।ै इस हिस्से को अपने शेष 

रिज़्यूमे से अलग करने के लिए इसके बाद एक मोटी लाइन डालें।

उदाहरण:

चरण 2: प्रोफाइल समरी सेक्शन, जोड़ें

आपके रिज़्यूमे के इस हिस्से में आपका अनुभव, उपलब्धियां, पुरस्कार, प्रमाणीकरण व शक्तियों की जानकारी होनी चाहिए। आप अपने सारांश को 2-3 

मुख्य बिन्दुओ ंतक सीमित, या 8-10 मुख्य बिन्दुओ ंतक विस्तृत कर सकते हैं।

उदाहरण:

चरण 3: अपनी शकै्षिक योग्यताएं शामिल करें ।

अपना शकै्षिक रिकॉर्ड  सचूीबद्ध करते समय, सबसे पहले अपनी सबसे बड़ी डिग्री सचूीबद्ध करें । उसके बाद उच्चतम योग्यता के नीचे उससे कम उच्चतम 

योग्यता जोड़ें और इसी क्रम में आगे जोड़ते जाएं। अपनी शकै्षिक पषृ्ठभमूि की स्पष्ट व सटीक तस्वीर उपलब्ध कराने के लिए, यह महत्वपरू्ण  ह ैकि प्रत्येक 

सचूीबद्ध डिग्री या प्रमाणपत्र के लिए, आपने अपने स्थान, दर्जे, प्रतिशत या CPI की जानकारी भी दी हो।

यदि आपने कुछ प्रमाणीकरण या प्रशिक्षण लिए हैं, तो आप अपने शकै्षिक योग्यता खंड में प्रशिक्षण व प्रमाणीकरण खंड शामिल कर सकते हैं।

उदाहरण:
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चरण 4: अपनी तकनीकी कुशलताओ ंको सूचीबद्ध करें ।

अपनी तकनीकी कुशलताओ ं की सचूी बनाते समय, सबसे पहले वे कुशलताएं लिखें जिनके बारे  में आप सबसे अधिक विश्वस्त हैं। इसके बाद ऐसी 

कुशलताएं लिखें जिनमें आप परूी तरह पारंगत नहीं हैं। केवल एक ही कौशल शामिल करना भी सर्वथा उपयुक्त ह,ै यदि आपको ऐसा लगता ह ैकि यह 

विशिष्ट कौशल आपके रिज़्यूमे को उल्लेखनीय रूप से महत्वपरू्ण  बना देता ह।ै यदि आपके पास कोई तकनीकी कौशल नहीं ह ैतो आप यह चरण छोड़ 

सकते हैं।

उदाहरण:

चरण 5: अपना शकै्षिक प्रोजेक्ट अनुभव शामिल करें ।

वे सभी महत्वपरू्ण  प्रोजेक्ट सचूीबद्ध करें  जिन पर आपने काम किया ह।ै इस खंड में निम्नलिखित जानकारी डालें:

उदाहरण:

चरण 6: अपनी शक्तियां सूचीबद्ध करें ।

यह वह हिस्सा ह ैजिसमें आप अपनी प्रमुख शक्तियों की जानकारी दे सकते हैं। यह खंड बुलेट प्वाइंट्स में होना चाहिए।

उदाहरण:

चरण 7: अपनी पाठत्तर गतिविधियों की सूची बनाएं।

यह प्रदर्शित करना बहुत महत्वपरू्ण  ह ै कि आपकी विविध रुचियाँ हैं और आपका जीवन शिक्षा से परे  भी ह।ै पाठ्येत्तर गतिविधियों को शामिल करने से 

आपको ऐसे अन्य उम्मीदवारों की तुलना में अधिक प्राथमिकता मिल सकती ह ैजिनके आपके समान शकै्षिक अंक व प्रोजेक्ट अनुभव होते हैं। यह खंड बुलेट 

प्वाइंट्स में होना चाहिए।

उदाहरण:
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चरण 8: अपनी व्यक्तिगत जानकारी लिखें।

आपके रिज़्यूमे के अंतिम हिस्से में निम्नलिखित व्यक्तिगत जानकारी होनी चाहिए:

•	 जन्म तिथि 

•	 लिग व ववैाहिक स्थिति

•	 राष्ट्रीयता 

•	 ज्ञात भाषाएँ

उदाहरण:

10.4.1.2 सुझाव 
•	 अपनी रिज़्यूमे फाइल का नाम छोटा, सरल व सचूनात्मक रखें।

•	 सुनिश्चित कर लें कि रिज़्यूमे साफ़ सुथरा व टाइपिग की गलतियों से मुक्त हो।

•	 हमेशा अपना रिज़्यूमे सादे सफ़े द कागज़ पर तयैार करें ।

10.4.3 साक्षात्कार में आमतौर पर पूछे जाने वाल ेप्रश्न

आमतौर पर इंटरव्यू (साक्षात्कार) में पछूे  जाने वाले प्रश्नों पर नज़र डालें और उनका उत्तर देने के सहायक कुछ सुझावों पर विचार करें ।

1.	 क्या आप अपने बारे में मुझे कुछ बता सकत ेहैं?

उत्तर दनेे हेतु सुझाव:

•	 अपने पिछले काम की परूी जानकारी या व्यक्तिगत इतिहास न बताएं।

•	 अपने 2-3 विशिष्ट अनुभव बताएं जो आपको सर्वाध िक महत्वपरू्ण  व प्रासंगिक लगते हों।

•	 इस बात से समापन करें  कि उन अनुभवों ने आपको इस विशिष्ट भमूिका के लिए किस तरह बेहतर बनाया ह।ै



315314

प्रतिभागी पुस्तिका रोटो आर ट्िस्ट

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

2.	 आपको इस पद के बारे में कैसे पता लगा?

उत्तर दनेे हेतु सुझाव:

•	 साक्षातकारकर्ता  को बताएं कि आपको इस नौकरी के बारे  में कैसे पता लगा - चाहे वह किसी मित्र (मित्र का नाम), आयोजन या लेख (उनका नाम 

बताएं) या किसी जॉब पोर्टल (बताएं किस पोर्टल से) से लगा हो।

•	 यह बताएं कि इस भमूिका के बारे  में आप कितने उत्साहित हैं और इसके बारे  में आपको क्या आकर्षक लगा ह।ै

3.	 आप कंपनी के बारे में क्या जानत ेहैं?

उत्तर दनेे हेतु सुझाव:

•	 कंपनी के About Us पषृ्ठ को न दोहराएं।

•	 यह प्रदर्शित करें  की आप कंपनी के लक्ष्यों को समझतें व उनका ध्यान रखते हैं।

•	 यह बताएं कि आप कंपनी के मिशन व मूल्यों में क्यों विश्वास रखते हैं।

4.	 आप यह नौकरी क्यों चाहत ेहैं?

उत्तर दनेे हेतु सुझाव:

•	 दर्शा एं कि आप नौकरी के बारे  में उत्साहित हैं।

•	 यह बताएं कि यह भमूिका आपके अनुरूप ह।ै

•	 बताएं कि आप कंपनी को क्यों पसंद करते हैं?

5.	 हमें आपको नौकरी क्यों दनेी चाहिए?

उत्तर दनेे हेतु सुझाव:

•	 अपने शब्दों से सिद्ध करें  कि आप केवल काम ही नहीं कर सकते, बल्कि निश्चित रूप से उत्कृ ष्ट परिणाम भी दे सकते हैं।

•	 बताएं, कि टीम व कार्य  संस्कृति  के लिए कैसे आप बिल्कु ल दुरुस्त साबित होंगे।

•	 यह बताएं कि आपको अन्य उम्मीदवारों की तुलना में क्यों चुना जाना चाहिए।

6.	 आपकी सबसे शानदार पेशेवर शक्तियां क्या हैं?

उत्तर दनेे हेतु सुझाव:

•	 ईमानदार होना - अच छ्े  लगने वाले उतर देने की बजाय अपनी कुछ वास्तविक शक्तियों के बारे  में बताएं।

•	 उन विशिष्ट शक्तियों के उदाहरण दें जो आपेक्षित पद से संबंधित हों।

•	 उदाहरण देकर बताएं कि आपने इन शक्तियों को किस तरह प्रदर्शित किया ह।ै

7.	 अपनी कमजोरियों के बारे में बताएं?

उत्तर दनेे हेतु सुझाव:

•	 इस प्रश्न का उद्देश्य आपकी स्व-जागरूकता व ईमानदारी का आंकलन करना ह।ै

•	 अपनी किसी ऐसी कमी का उदाहरण दें जिसके साथ आप संघर्ष  कर रहे हैं, लेकिन यह भी बताएं कि आप इस पर सुधार के लिए काम कर रहे हैं।

8.	 आपकी वेतन अपेक्षाएं क्या हैं?

उत्तर दनेे हेतु सुझाव:

•	 किसी पद के लिए आवेदन करते समय उस पद के लिए सामान्यत: दिये जाने वाले वेतन के बारे  में खोजबीन कर लें।

•	 अपने अनुभव, शिक्षा व कुशलताओ ंके आधार पर पता लगाएं कि आपके वेतन की सीमा क्या होनी चाहिए।

•	 लचीले बनें। साक्षात्कारकर्ता  को बताएं कि आप जानते हैं कि आपकी कुशलताएं कितनी मूल्यवान हैं, लेकिन आपको नौकरी की ज़रूरत ह ैऔर आप 

इस पर बात करने के इच छ्ु क हैं।
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10.4.3.1 सुझाव 
•	 उत्तर देते समय ईमानदार और विश्वस्त रहें।

•	 अपने उत्तरों को और अधिक प्रभावशाली बनाने के लिए अपने पुराने अनुभवों के उदाहरणों का प्रयोग करें ।

10.4.5 काम के लिए तयैारी - शर्तें व शब्दावलियाँ
प्रत्येक कर्मचारी को निम्नलिखित शब्दों के बारे  में परूी जानकारी होनी चाहिए:

•	व ार्षिक अवकाश: नियोक्ताओ ंद्वारा कर्मचारियों को दिया जाने वाला सभुगतान अवकाश।

•	 पषृ्ठभूमि की जाँच: संभावित उम्मीदवारों द्वारा उपलब्ध करायी गई जानकारी की सटीकता को सत्यापित करने के लिए नियोक्ताओ ंद्वारा प्रयोग की 

जाने वाली विधि।

•	ल ाभ: कर्मचारी के प्रतिपरू्ति  पकेैज का एक हिस्सा।

•	 अन्तराल (ब्रेक्स): कार्यघंटों के दौरान कर्मचारियों द्वारा लिया गया अल्प अवधि का विश्राम।

•	 प्रतिपूर्ति पकेैज: वेतन एवं लाभों का सम्मिश्रण जो कोई नियोक्ता अपने कर्मचारियों को देता ह।ै

•	 प्रतिपूर्ति समय (कॉम्प टाइम): वेतन के बदले छुट्टी।

9.	क ाम के अलावा आप क्या करना पसंद करत ेहैं?

उत्तर दनेे हेतु सुझाव:

•	 इस प्रश्न का उद्देश्य यह देखना ह ैकि आप कंपनी की संस्कृति  में सामंजस्य बिठा सकें गे कि नहीं।

•	 ईमानदार बनें - उन गतिविधियों व रुचियों के बारे  में खुल कर बताएं जो आपको पसंद ह ैऔर जिनसे आप उत्साहित होते हैं।

10.	 यदि आप जानवर होत ेतो क्या बनना चाहत?े

उत्तर दनेे हेतु सुझाव:

•	 यह प्रश्न पछूने का उद्देश्य यह देखना ह ैकि आप अपने बल पर सोचने में सक्षम हैं।

•	 आपका कोई भी उत्तर गलत नहीं होगा - लेकिन अच्छा प्रभाव डालने के लिए, अपने उत्तर के माध्यम से अपनी शक्तियों या व्यक्तित्व की छाप छोड़ने 

का प्रयास कीजिये।

11.	 अपने विचार से आप बेहतर या अलग तरीके से क्या कर सकत ेहैं?

उत्तर दनेे हेतु सुझाव:

•	 यह प्रश्न पछूने का उद्देश्य यह पता लगाना ह ैकि क्या आपने कंपनी के बारे  में कुछ खोजबीन की ह ैऔर इससे यह भी पता चलता ह ैकि क्या आप 

समालोचना के आधार पर सोच सकते हैं और नए विचार दे सकते हैं।

•	 नए विचार सुझाइये। यह दर्शा एं कि आपकी रुचियों व विशेषज्ञता से इन विचारों को कैसे क्रियान्वित किया जा सकता ह।ै

12.	 क्या आप हमसे कुछ पूछना चाहत ेहैं?

उत्तर दनेे हेतु सुझाव:

•	 ऐसे प्रश्न न पछूें  जिसका उत्तर आसानी से कंपनी की वेबसाइट पर या ऑनलाइन सर्च के माध्यम से मिल सकता ह।ै

•	 ऐसे बुद्धिमत्तापरू्ण  प्रश्न पछूें  जो गंभीरता से सोचने की आपकी योग्यता दर्शाते हों।
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•	 ठेका कर्मचारी: ऐसा कर्मचारी जो किसी ऐसे संगठन के लिए काम करता ह,ै जो उक्त कर्मचारी की सेवाएं, किसी प्रोजेक्ट या समय आधार पर किसी 

अन्य कंपनी को बेचता ह।ै

•	नि युक्ति का कांट्रेक्ट: जब किसी कर्मचारी को भुगतान या वेतन के बदले काम की पेशकश की जाती ह,ै और वह नियोक्ता द्वारा की गई पेशकश 

को स्वीकार कर लेता ह,ै तो रोज़गार (नियक्ति) का कांट्रेक्ट हो जाता ह।ै

•	क ॉर्पोरेट संस्कृति : कंपनी के सभी सदस्यों द्वारा आपस में आदान-प्रदान की गई तथा कर्मचारियों की एक पीड़ी से दूसरी पीड़ी को प्रदान की गई 

मान्यताएं व मूल्य।

•	क ाउंटर पेशकश/काउंटर प्रस्ताव: कंपनी द्वारा प्रस्तावित वेतन की राशि बढ़ाने के लिए संभावित कर्मचारी द्वारा प्रयोग की गई नगैोशिएशन 

तकनीक।

•	कव र लटेर: ऐसा पत्र जिसके साथ उम्मीदवार का रिज़्यूमे संलग्न होता ह।ै इसमें उम्मीदवार के रिज़्यूमे के महत्वपरू्ण  बिदु होते हैं और यह वे वास्तविक 

उदाहरण उपलब्ध कराता ह ैजो अपेक्षित कार्य  करने के लिए उम्मीदवार की योग्यता को प्रमाणित करता ह।ै

•	क रिकलम वायट े(CV)/रिज़्यूमे: उम्मीदवार की उप्लब्धियों, शकै्षिक पषृ्ठभमूि, कार्यानुभव, कुशलताओ ंव शक्तियों का सारांश।

•	 अस्वीकार पत्र: नियोक्ता द्वारा कर्मचारी को दी गई नौकरी की पेशकश को अस्वीकार करते हुए, कर्मचारी द्वारा नियोक्ता को भेजा गया पत्र।

•	क टौतियां: कर्मचारी के वेतन में से घटाई गई धन राशि, जिसका उल्लेख कर्मचारी की वेतन पर्ची (पे स्लिप) में हो।

•	 भेदभाव: किसी व्यक्ति के साथ, किसी अन्य व्यक्ति की तुलना में ख़राब या असमान व्यवहार करना।

•	कर्म चारी: ऐसा व्यक्ति जो भुगतान के बदले किसी अन्य व्यक्ति के लिए काम करता ह।ै

•	कर्म चारी प्रशिक्षण: किसी कर्मचारी को उसके वरिष्ठ अधिकारी के आदेश के अंतर्गत कराई जाने वाली कार्यशाला या इन-हाउस प्रशिक्षण, जिससे 

नियोक्ता को फायदा पहंुचे।

•	 रोज़गार अन्तराल: नौकरियों के बीच बेरोज़गारी के समय की अवधियाँ।

•	निर्धा रित-अवधि के कांट्रेक्ट: नौकरी का कांट्रेक्ट, जो एक सहमति से तय की गई निर्धा रित-तिथि पर समाप्त हो जाता ह।ै

•	फ ॉलो-अप: किसी उम्मीदवार द्वारा संभावित नियोक्ता के पास अपना रिज़्यूमे भेजे जाने के बाद, नियोक्ता से संपर्क  करने की गतिविधि।

•	 फ्रीलांसर/कंसलटेंट/स्वतंत्र ठेकेदार: ऐसा व्यक्ति जो स्वय के लिए काम करता ह ैऔर विभिन्न नियोक्ताओ ंके साथ अस्थाई नौकरियां व प्रोजेक्ट 

परूे  करता ह।ै

•	 छुट्टी: काम से सभुगतान अवकाश।

•	 घंटवेार दर: 60 मिनट के काम के लिए दिया जाने वाला वेतन या भुगतान।

•	 इंटर्नशिप: किसी संभावित कर्मचारी जिसे इंटर्न कहा जाता ह ैको किसी नियोक्ता द्वारा एक निर्धा रित, सीमित समय अवधि के लिए नियोक्ता की 

कंपनी में दिया गया नौकरी का अवसर।

•	 इंटरव्यू (साक्षात्कार): संभावित कर्मचारी को नौकरी पर रखे जाने का निर्धारण करने के लिए, संभावित कर्मचारी व नियोक्ता के प्रतिनिधि के बीच 

होने वाला संवाद।

•	 नौकरी के लिए आवेदन: एक फॉर्म  जिसमें उम्मीदवार के बारे  में जानकारी, जसेै उम्मीदवार का नाम, पता, संपर्क  विवरण व कार्य  अनुभव शामिल 

होता ह।ै नौकरी का आवेदन पत्र जमा कराने का उद्देश्य यह दर्शाना होता ह,ै कि उम्मीदवार की दिलचस्पी किसी विशिष्ट कंपनी में काम करने में ह।ै

•	 नौकरी की पेशकश: किसी नियोक्ता द्वारा संभावित कर्मचारी को रोज़गार की पेशकश करना।

•	 जॉब सर्च एजेंट: एक ऐसा प्रोग्राम जो उम्मीदवारों को नौकरियों के लिए प्रोग्राम में सचूीबद्ध मापदंडों का चयन करके रोज़गार अवसरों की खोज में 

सक्षम बनाता ह।ै

•	ल  ेऑफ (कामबंदी): ले ऑफ तब होता ह ैजब कर्मचारी को अस्थाई रूप से अपना काम बंद करना पड़ता ह,ै क्योंकि नियोक्ता के पास उस कर्मचारी 

के लिए कोई काम नहीं होता।

•	 अवकाश: किसी नियोक्ता द्वारा अपने कर्मचारी को काम से अनुपस्थित रहने व छुट्टी लेने की औपचारिक अनुमति।

•	 स्वीकार्यता पत्र: नियोक्ता द्वारा कर्मचारी को नौकरी की पेशकश करने व पेशकश की शर्तों का विवरण देने की पुष्टि करने वाला पत्र।
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•	 सहमति पत्र: ऐसा पत्र जो रोज़गार (नौकरी) की शर्तों की रूपरे खा प्रदर्शित करता ह।ै

•	 संस्तुति पत्र: किसी व्यक्ति की कार्य  कुशलताओ ंकी पुष्टि करने के उद्देश्य से लिखा गया पत्र।

•	 माततृ्व अवकाश: ऐसी महिलाओ ंद्वारा लिया गया अवकाश जो गर्भवती हैं या जिन्होंने हाल ही में संतान को जन्म दिया ह।ै

•	 मार्गदर्शक (मेंटर): ऐसा व्यक्ति जो आपसे उच्च पद पर काम कर रहा ह ैऔर आपको कैरियर के लिए सलाह व मार्गदर्शन देता ह।ै

•	 न्यूनतम मजदूरी: प्रति घंटा आधार पर भुगतान की जाने वाली न्यूनतम राशि।

•	 नोटिस: नियोक्ता या कर्मचारी द्वारा की गई वह घोषणा जिसमें यह कहा जाता ह ैकि कर्मचारी का कांट्रेक्ट किसी निर्दिष्ट तिथि को समाप्त हो जायेगा।

•	 रोज़गार (नौकरी) की पेशकश: नियोक्ता द्वारा संभावित कर्मचारी को की गई पेशकश जिसमें दी जाने वाली नौकरी से जुड़ी महत्वपरू्ण  जानकारी 

जसेै शुरू करने की विधि, वेतन, कार्यस्तिथियां आदि का विवरण होता ह।ै

•	 मुक्त-निर्णय (ओपन एनडीड) कांट्रेक्ट: रोज़गार या नौकरी का ऐसा कांट्रेक्ट जो तब तक चलता ह ैजब तक नियोक्ता या कर्मचारी दोनों में से कोई 

इसे समाप्त नहीं कर देता।

•	 अत्यधिक योग्य (ओवर क्वालिफाइड): ऐसा व्यक्ति जो किसी विशिष्ट नौकरी/पद के लिए इसलिए उपयुक्त नहीं होता क्योंकि उसके पास बहुत 

अधिक कार्य  अनुभव या शिक्षा का ऐसा स्तर होता ह,ै जो उस कार्य  या नौकरी के लिए वांछित योग्यता से बहुत अधिक ह ैया वह वर्तमान में अथवा परू्व 

में बहुत अधिक वेतन पा रहा हो।

•	 अंश-कालिक कामगार: ऐसा कर्मचारी जो कार्य  के सामान्यत: निर्धा रित मानक घंटों से कम घंटों के लिए काम करता ह।ै

•	पित तृ्व अवकाश: हाल ही में पिता बने व्यक्ति को दिया जाने वाला अवकाश।

•	 रिक्रु टर/हेडहन्टर्स/एग्जीक्यूटिव सर्च फर्म्स: नियोक्ता द्वारा भुगतान आधार पर रखे गए पेशेवर जो विशिष्ट पदों के लिए लोगों की खोज करते हैं।

•	 इस्तीफा दनेा/त्यागपत्र: जब कोई कर्मचारी औपचारिक रूप से अपने नियोक्ता को सचूित करता ह ैकि वह अपनी नौकरी छोड़ रहा ह।ै

•	 स्व-रोजगारी: ऐसा व्यक्ति जिसका अपना व्यवसाय ह ैऔर वह कर्मचारी के रूप में काम नहीं करता।

•	 टाइम शीट: ऐसा फॉर्म  जो किसी कर्मचारी द्वारा नियोक्ता को दिया जाता ह ैजिसमें कर्मचारी द्वारा प्रतिदिन किये जाने वाले कार्य  घंटों का विवरण 

होता ह।ै
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यूनिट 10.5: उद्यमशीलता को समझना

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	 उद्यमशीलता की अवधारणा पर चर्चा  कर सकें गे

2.	 उद्यमशीलता के महत्व पर चर्चा  कर सकें गे

3.	 उद्यमशीलता की विशेषताओ ंकी चर्चा  कर सकें गे

4.	 उद्यमों के विभिन्न प्रकारों का वर्णन कर सकें गे

5.	 एक प्रभावी नेता के गुणों की सचूी बना सकें गे

6.	 प्रभावी नेततृ्व के लाभों पर चर्चा  कर सकें गे

7.	 एक प्रभावी टीम के गुणों की सचूी बना सकें गे

8.	 प्रभावशाली ढंग से सुनने के महत्व पर चर्चा  कर सकें गे

9.	 प्रभावी तरीके से सुनने की प्रक्रिया पर चर्चा  कर सकें गे

10.	 प्रभावशाली ढंग से बात करने के महत्व पर चर्चा  कर सकें गे

11.	च र्चा  कर सकें गे कि प्रभावशाली ढंग से कैसे बात की जाए

12.	च र्चा  कर सकें गे कि समस्याओ ंको किस प्रकार हल किया जाए

13.	 समस्या सुलझाने के महत्वपरू्ण  गुणों की सचूी बना सकें गे

14.	 समस्या सुलझाने के कौशल आंकलन के तरीकों पर चर्चा  कर सकें गे

15.	 नगैोशिएशन के महत्व पर चर्चा  कर सकें गे

16.	च र्चा  कर सकें गे कि नगैोशिएट कैसे किया जाए

17.	च र्चा  कर सकें गे कि नए व्यापार अवसरों की पहचान कैसे की जाए

18.	च र्चा  कर सकें गे कि नए व्यापार अवसरों की पहचान अपने व्यवसाय के भीतर कैसे की जाए

19.	 उद्यमी के अर्थ को समझ सकें गे

20.	 विभिन्न प्रकार के उद्यमियों का वर्णन कर सकें गे

21.	 उद्यमियों की विशेषताओ ंकी सचूी बना सकें गे

22.	 उद्यमियों की सफलता की कहानियां याद कर पाएंगे

23.	 उद्यमशीलता की प्रक्रिया पर चर्चा  कर सकें गे

24.	 उद्यमशीलता ईकोसिस्टम का वर्णन कर सकें गे

25.	 उद्यमशीलता ईकोसिस्टम में सरकार की भमूिका पर चर्चा  कर सकें गे

26.	भ ारत में वर्तमान उद्यमशीलता ईकोसिस्टम पर चर्चा  कर सकें गे

27.	 मेक इन इंडिया अभियान के उद्देश्य को समझ सकें गे

28.	 उद्यमिता और जोखिम लेने की क्षमता के बीच संबंध पर चर्चा  कर सकें गे

29.	 उद्यमशीलता और लचीलेपन के बीच संबंध पर चर्चा  कर सकें गे

30.	 एक लचीले उद्यमी की विशेषताओ ंका वर्णन कर सकें गे

31.	च र्चा  कर सकें गे कि असफलता से कैसे निपटा जाए

यूनिट के उद्देश्य 
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10.5.1 अवधारणा परिचय 
ऐसा व्यक्ति, जो किसी भी तरह का जोखिम उठाकर, कारोबार शुरु करने के लिए दृढ़-संकल्प हो, उद्यमी कहलाता ह।ै उद्यमी अपने स्वय के स्टार्ट  अप 

चलाते हैं, वित्तीय जोखिमों के लिए जिम्मेदारी उठाते हैं और सफलता हासिल करने के लिए रचनात्मकता, अभिनवता और स्व-प्रेरणा के विशाल क्षेत्र से 

जुड़ते हैं। वे बड़े सपने देखते हैं और अपनी सोच को व्यवहारिक पेशकश तक ले जाने के लिए निश्चित होते हैं। उद्यमी का लक्ष्य एक उद्यम का निर्माण करना 

होता ह।ै इस उद्यम का निर्माण करने की प्रक्रिया को उद्यमशीलता कहा जाता ह।ै

10.5.1.1 उद्यमशीलता का महत्व

निम्नलिखित कारणों से उद्यमशीलता बहुत महत्वपरू्ण  ह:ै

1.	 इससे नए संगठनों का निर्माण होता है

2.	य ह बाज़ार में रचनात्मकता लाती है

3.	य ह जीवन के मानकों में सुधार लाती है

4.	य ह देश की अर्थव्यवस्था विकसित करने में मदद करती है

10.5.1.2 उद्यमशीलता की विशेषताएं
सभी सफल उद्यमियों में कुछ सांझी विशेषताएं होती हैं।

जो ये हैं:

•	 अपने काम के बारे  में अत्यधिक जुननूी होना

•	 अपने आप में विश्वास रखना

•	 अनुशासित और समर्पित होना

•	 प्रेरित और जोशीला होना

•	 अत्यधिक रचनात्मक

•	 दूरदृष्टा होना

•	 खुले दिमाग का होना

•	 निर्णायक होना

उद्यमियों में ऐसी सोच भी होती ह:ै

•	 उच्च जोखिम की सहनशीलता

•	 हर काम की संपरू्ण  योजना

•	 अपने धन का बुद्धिमत्तापरू्ण  उपयोग

•	 ग्राहकों को अपनी प्राथमिकता मानना

•	 अपनी पेशकशों और अपने बाज़ार को विस्तार से समझते हैं

•	 आवश्यकता पड़ने पर विशेषज्ञों की सलाह लें

•	 जानते हैं, कि कब हानियों को कम करना है
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10.5.1.3 प्रसिद्ध उद्यमियों के उदाहरण

कुछ मशहूर उद्यमी हैं:

•	 बिल गेट्स (Microsoft के संस्थापक)

•	 स्टीव जॉब्‍स (Apple के सह-संस्थापक)

•	 मार्क  ज़करबर्ग (Facebook के संस्थापक)

•	 पिएरे  ओमिडायर (eBay के संस्थापक)

10.5.1.4 उद्यमियों के प्रकार
भारत में एक उद्यमी के रूप में, आप निम्नलिखित में से किसी भी प्रकार के उद्यम के मालिक बन सकते हैं और उसे चला सकते हैं: 

सोल प्रोप्राइटरशिप (एकल स्वामित्व)

एक सोल प्रोप्राइटरशिप (एकल स्वामित्व) में, एक व्यक्ति उद्यम का स्वामी होता ह,ै इसका प्रबंधन करता ह ै और इस पर नियत्रण रखता ह।ै काननूी 

औपचारिकताओ ंके संदर्भ में इस तरह का बिज़नेस बनाना सबसे आसान होता ह।ै व्यवसाय और मालिक का काननूी अस्तित्व भिन्न नहीं होता ह।ै सारा 

लाभ स्वामी का होता ह,ै इसी तरह सारा घाटा भी उसी का होता ह।ै

पार्टनरशिप (हिस्सेदारी)

पार्टनरशिप फर्म  की स्थापना दो या अधिक लोगों द्वारा की जाती ह।ै उद्यम के मालिकों को पार्टनर (हिस्सेदार) कहा जाता ह।ै सभी पार्टनर्स (हिस्सेदारों) 

द्वारा पार्टनरशिप समझौतों पर हस्ताक्षर किये जाने चाहिएं। फर्म  और पार्टनर्स (हिस्सेदारों) का अलग कोई काननूी अस्तित्व नहीं होता ह।ै लाभ का बंटवारा 

पार्टनर्स (हिस्सेदारों) में होता ह।ै हानियों के संदर्भ में, पार्टनर्स (हिस्सेदारों) का उत्तदायित्व असीमित होता ह।ै फर्म  की उम्र अवधि सीमित होती ह ैऔर किसी 

एक हिस्सेदार की मतृ्यु हो जाने, सेवानिवतृ हो जाने, दीवालिया घोषित हो जाने या विक्षिप्त (पागल) हो जाने पर यह समाप्त हो जाती ह।ै

सीमित उत्तरदायित्व पार्टनरशिप (LLP)

सीमित उत्तरदायित्व पार्टनरशिप या LLP में, फर्म  के हिस्सेदार दीर्घकालिक अस्तित्व के साथ-साथ सीमित उत्तरदायित्व का लाभ उठातें हैं। प्रत्येक पार्टनर 

का उत्तरदायित्व LLP को उसके स्वीकृत योगदान तक सीमित होता ह।ै पार्टनरशिप व इसके हिस्सेदारों का अलग काननूी अस्तित्व होता ह।ै

10.5.1.5 सुझाव 
•	 अन्य लोगों की असफलताओ ंसे सीखें।

•	 सुनिश्चित करें  कि आप यही चाहते हैं।

•	 अपने विचार से किसी समस्या को जोड़ कर देखने की बजाए हल करने के लिए समस्या खोजते हैं।

10.5.2 लीडरशिप व टीमवर्क : लीडरशिप व लीडर्स
लीडरशिप का अर्थ अन्य लोगों के अनुसरण के लिए एक उदाहरण स्थापित करना। एक अच्छा उदाहरण स्थापित करने का अर्थ ह ैकिसी को ऐसा कार्य 

करने के लिए कहना जो आप स्वेच्छा से स्वय नहीं करना चाहेंगे। लीडरशिप से यह पता चलता ह ैकि एक टीम व एक कंपनी के रूप में जीत हासिल करने 

के लिए क्या करना ह।ै

लीडर सही काम करने में विश्वास रखते हैं। वे दूसरो को सही कार्य  करने हेतु सहायता देने में भी विश्वास रखतें हैं। प्रभावी लीडर वह होता ह ैजो:

•	 भविष्य के लिए एक प्रेरक सोच (विज़न) का निर्माण करता ह।ै

•	 अपनी टीम को उस विज़न (दूरदृष्टि) को आगे बढ़ाने के लिए उत्साहित व प्रेरित करता ह।ै
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10.5.2.1 नेततृ्व गुण जो सभी उद्यमियों के लिए आवश्यक हैं

सफल उद्यमी बनना केवल तभी संभव ह,ै जब उद्यमी में उत्कृ ष्ट नेततृ्व गुण हैं। कुछ महत्वपरू्ण  नेततृ्व योग्यताएं जो प्रत्येक उद्यमी में होनी चाहिए:

1.	 व्यवहारिकता: इसका अर्थ ह ैसभी अवरोधों व चुनौतियों को सामने लाने की योग्यता होना, ताकि समस्याओ ंका समाधान किया जा सके और 

जोखिमों को कम किया जा सके।

2.	व िनम्रता: इसका अर्थ ह ैगलतियों को आमतौर पर व शीघ्र स्वीकार करना और अपनी गतिविधियों की जिम्मेदारी लेना। गलतियों को ऐसी चुनौतियों 

के रूप में देखा जाना चाहिए जिनका सामना किया जा सके, न कि इन्हें किसी पर दोष लगाने का अवसर बनाना चाहिए।

3.	ल चीलापन: अच छ्े  लीडर के लिए बहुत लचीला होना और बदलाव को जल्दी से स्वीकार करना महत्वपरू्ण  होता ह।ै यह जानना भी उतना ही महत्वपरू्ण 

ह ैकि कब स्थिति के अनुसार स्वय को ढाला जाये और कब नहीं।

4.	 प्रमाणिकता: इसका अर्थ ह ैअपनी शक्तियों व कमज़ोरियों, दोनों का प्रदर्शन करना। इसका अर्थ ह ैइंसान बनना और अन्य लोगों को दिखाना कि 

आप भी इंसान हैं।

5.	 पुनराविष्कार: इसका अर्थ ह ै आवश्यकता पड़ने पर अपनी नेततृ्व शलैी को तरोताज़ा करना या उसमें बदलाव करना। ऐसा करने के लिए यह 

सीखना महत्वपरू्ण  ह ैकि आपके नेततृ्व में कहां कमियां ह ैऔर उन्हें समाप्त करने के लिए कौन-कौन से संसाधन हैं।

6.	 जागरूकता: इसका अर्थ ह ैयह पता लगाना कि अन्य लोग आपको कैसे देखते हैं। इसका अर्थ ह ैयह समझना कि आपकी उपस्थिति आपके आस-पास 

के लोगों को कैसे प्रभावित करती ह।ै

10.5.2.2 प्रभावी नेततृ्व के फायदे
प्रभावी नेततृ्व के अनेक फायदे हैं। महान नेततृ्व लीडर को सफलतापरू्वक आगे बढ़ता ह:ै

•	 टीम सदस्यों की वफादारी और प्रतिबद्धता प्राप्त होती ह।ै

•	 टीम को कंपनी के लक्ष्य और उद्देश्य प्राप्त करने के लिए उत्साहित होती ह।ै

•	 टीम सदस्यों में मनोबल का निर्माण होता ह ैऔर विश्वास उत्त्पन्न होता ह।ै

•	 टीम सदस्यों में आपसी समझ और टीम भावना बढ़ती ह।ै

•	 टीम सदस्यों को किसी भी परिस्थिति के अनुसार बदलाव लाने की आवश्यकता के लिए सहमत किया जा सकता है

10.5.2.3 टीमवर्क  (सामूहिक कार्य) और टीम

टीमवर्क  तब होता ह ैजब कार्यस्थल पर लोग अपनी व्यक्तिगत कुशलताओ ंको एक साथ मिलाकर साझे लक्ष्य को प्राप्त करते हैं। प्रभावशाली टीम में वे लोग 

शामिल होते हैं जो इस साझे लक्ष्य को प्राप्त करने के लिए मिलकर काम करते हैं। अच्छी टीम वह होती ह ैजो अंतिम परिणाम के लिए स्वय को जिम्मेदार 

मानती ह।ै

10.5.2.4 उद्यमशीलता की सफलता में टीम वर्क  का महत्व
उद्यमशील लीडर के लिए किसी उपक्रम की सफलता हेतु प्रभावी टीम महत्वपरू्ण  होती ह।ै एक उद्यमी को यह सुनिश्चित करना चाहिए कि वह जो टीम बनाता 

ह ैउसमें महत्वपरू्ण  विशेषताएं, लक्षण और गुण होने चाहिएं। एक प्रभावशाली टीम वह होती ह ैजिसमें निम्नलिखित विशेषताएं होती हैं:

1.	 उद्देश्य की एकता: सभी टीम सदस्यों को टीम के उद्देश्य, विज़न और लक्ष्यों को स्पष्ट रूप से समझना चाहिए और इसके लिए समान रूप से प्रतिबद्ध 

होना चाहिए।

2.	 उत्कृ ष्ट संवाद कौशल: टीम सदस्यों के पास अपनी आशंकाओ ंको व्यक्त करने, प्रश्न पछूने तथा जटिल जानकारी का वर्णन करने के लिए रे खाचित्र 

व चार्ट्स का प्रयोग करने की योग्यता होनी चाहिए।
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10.5.2.4.1 सुझाव 
•	 अपने मूल आइडिया के साथ बहुत ज़्यादा न जुड़े रहें। इसमें परिवर्तन और बदलाव की अनुमति दें।

•	 अपनी कमज़ोरियों के प्रति जागरूक रहें और एक ऐसी टीम बनाएं जो आपकी कमियों को परूा कर सके।

•	 केवल सही लोगों का चयन करना ही काफी नहीं ह।ै अपने सर्वाध िक प्रतिभावान लोगों को प्रोत्साहित या पुरस्कृ त करने की भी आवश्यकता होती 

ह ैताकि उन्हें प्रेरणा मिलती रहे।

•	 अपनी टीम से सम्मान हासिल करें ।

3.	मिलक र काम करने की योग्यता: प्रत्येक सदस्य को समझना चाहिये कि उसे नए विचारों पर नियमित फीडबकै उपलब्ध कराने का हक ह।ै

4.	 पहल: टीम में अतिसक्रिय व्यक्ति शामिल होने चाहिएं। सदस्यों में नए विचारों के साथ आगे आने, मौजदूा विचारों में सुधार करने और अपना स्वय 

का अनुसंधान करने का जोश होना चाहिए।

5.	 दूरदृष्टा सदस्य: टीम में समस्याओ ंका परू्वानुमान करने और उनके वास्तविक समस्या में बदलने से पहले इनका समाधान निकाल लेने की योग्यता 

होनी चाहिए।

6.	 उत्कृ ष्ट अनुकूलन योग्यता: टीम को यह विश्वास होना चाहिए कि परिवर्तन एक सकारात्मक शक्ति ह।ै परिवर्तन को सुधार करने और नयी बातों 

का प्रयास करने के अवसर के रूप में देखा जाना चाहिए।

7.	 उत्कृ ष्ट संगठनात्मक योग्यता: टीम के पास मानक कार्य  प्रक्रियाओ,ं उत्तरदायित्वों को संतुलित करने, परियोजनाओ ंकी उचित योजना बनाने 

और प्रगति तथा निवेशों पर मिलने वाले लाभों का आंकलन करने की विधि तयैार करने की योग्यता होनी चाहिये।

10.5.3 संवाद कौशल 
संवाद की प्रक्रिया के दौरान संदेश को सही तरीके से प्राप्त करने और समझने की योग्यता को श्रवण (सुनने की योग्यता) कहा जाता ह।ै प्रभावी संवाद के 

लिए सुनने की योग्यता महत्वपरू्ण  ह।ै प्रभावी श्रवण (सुनने की योग्यता) कौशल के बिना, संदेशों को गलत समझा जा सकता ह।ै इससे संवाद में रूकावट 

आ जाती ह ैऔर संदेश भेजने व प्राप्त करने वाला निराश और परे शान हो सकता ह।ै

इस बात पर ध्यान देना बहुत महत्वपरू्ण  ह ैकि सुनने का अर्थ वही नहीं ह,ै जो सुनाई देने का ह।ै सुनने का अर्थ केवल उन आवाज़ों से ह ैजो आपको सुनाई 

देती हैं। श्रवण (सुनने की योग्यता) का अर्थ उससे कहीं अधिक व्यापक ह।ै श्रवण (सुनने की योग्यता) के लिए, ध्यान कें द्रित करने की आवश्यकता होती 

ह।ै इसका अर्थ केवल कहानी सुनना नहीं ह,ै बल्कि इस बात पर ध्यान देना भी ह ैकि कहानी किस तरह सुनाई जाती ह,ै किस तरह की भाषा और आवाज़ 

का प्रयोग किया जाता ह ैऔर वक्ता अपनी भाव-भंगिमाओ ंका प्रयोग किस तरह करता ह।ै सुनने की योग्यता इस बात पर निर्भर करती ह ैकोई व्यक्ति 

मौखिक और अमौखिक, दोनों तरह के संकेतों का सही अर्थ निकालकर या महससू करके, कितना समझ सकता ह।ै

10.5.3.1 प्रभावी रूप से कैसे सुनें 
प्रभावी रूप से सुनने के लिए आपको:

•	 बातें करना छोड़ना होगा

•	 टोकना छोड़ना होगा

•	 जो कहा जाए उस पर परूी तरह से ध्यान लगाना होगा

•	 हामी भरनी होगी और प्रोत्साहक शब्दों व हाव-भावों का इस्तेमाल करना होगा

•	 खुले-विचारों वाला रहना होगा

•	 वक्ता के नज़रिए से सोचना होगा
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10.5.3.2 प्रभावी रूप से कैसे सुनें 
कोई संदेश कितनी सफलता से सम्प्रेषित हुआ ह,ै यह परूी तरह से इस बात पर निर्भर करता ह ैकि आपने इसे कितने प्रभावपरू्ण  ढंग से ग्रहण किया। एक 

प्रभावी वक्ता वह ह,ै जो स्पष्ट तरीके से बोले, शब्दों का सही उच्चारण करे , सही शब्दों का चयन करे  और उस गति से बोले जो आसानी से समझ आती हो। 

इसके अलावा, जोर से बोले जाने वाले शब्दों का हाव-भाव, लहजे व भाव-भंगिमा से परूी तरह से मिलान होना चाहिए।

आप क्या कहते हैं, और किस लहजे में कहते हैं, इसके परिणामस्वरूप कई धारणाएं बनती हैं। जो व्यक्ति झिझक कर बोलता ह,ै उसके बारे  में यह धारणा 

कायम की जा सकती ह,ै कि उसमें आत्म-विश्वास की कमी ह ैया उसे उस विषय में ज़्यादा ज्ञान नहीं ह,ै जिस पर चर्चा  की जा रही ह।ै धीमी आवाज़ वालों 

को आसानी से शर्मीले होने का दर्जा  दिया जा सकता ह।ै और जो बेहद स्पष्टता के साथ प्रभावशाली लहजे में बोलते हैं, उन्हें आमतौर पर बेहद आत्मविश्वासी 

माना जाता ह।ै यह बात संभाषण को संवाद का एक निर्णायक कौशल बना देती ह।ै

10.5.3.3 प्रभावी रूप से कैसे बोलें 
प्रभावी रूप से बोलने के लिए आपको:

•	 अपने भाषण में आंखें मिलाना, मुस्कुर ाना, हामी भरना, हाव-भाव व्यक्त करना आदि जसैी भाव-भंगिमाओ ंको शामिल करना होगा।

•	 असल में भाषण देने से पहले अपने भाषण का मसौदा बनाना होगा।

•	 सुनिश्चित करना होगा, कि आपकी सभी भावनाएं व अनुभतूियां नियत्रण में हों।

•	 अपने शब्दों को स्पष्ट और उचित स्वर व प्रबलता के साथ बोलना होगा। आपका परूा भाषण बिल्कु ल स्पष्ट होना चाहिये।

•	भ ाषण के वक्त लहज़ा खुशनुमा व स्वाभाविक रखे। आपके श्रोताओ ंको ऐसा नहीं लगना चाहिए कि आप कोई अस्वाभाविक लहज़ा अपना रहे हैं या 

असहज तरीके से बोल रहे हैं।

•	 अपना संदेश पहंुचाने के लिए सटीक व विशिष्ट शब्दों का प्रयोग करें । हर हाल में दोहरे  मतलब वाले शब्दों से बचना चाहिए।

•	 सुनिश्चित करें  कि आपके भाषण में एक तार्कि क प्रवाह हो।

•	 संक्षिप्त रहें। कोई सचूना न जोड़ें।

•	 व्यग्रता और फड़कने आदि जसैी खिझाने वाली आदतों से बचने का सजग प्रयास करें ।

•	 अपने शब्द ध्यानपरू्वक चुनें और सरल शब्दों का इस्तेमाल करें , जिससे ज़्यादातर श्रोताओ ंको उन्हें समझने में कोई परे शानी न हो।

•	 स्लाइड्स या व्हाइटबोर्ड  जसेै विज़ुअल साधनों का उपयोग करें ।

•	 सहजता से बोलें ताकि आपके श्रोता आसानी से समझ सकें  कि आप क्या कह रहे हैं। हालांकि, ध्यान रहे, कि इतना धीरे  भी न बोलें, कि इससे रूखाप़न 

झलके या ऐसा लगे कि आप तयैारी के साथ नहीं आये हैं या फिर आप दूसरों को नीचा दिखाने की कोशिश कर रहे हैं।

•	 सही जगहों पर थोड़ा रुकें ।

•	 बहुत ज़्यादा धीरज रखना होगा

•	 इस्तेमाल किए जाने वाले लहजे पर ध्यान देना होगा

•	 वक्ता के हाव-भाव, भाव-भंगिमाओ ंव आंखों की गति/हरकत पर ध्यान देना होगा

•	 हड़बड़ाहट व जल्दबाजी न मचाएं

•	 वक्ता की बनावट या आदत से न चिड़े या अपना ध्यान बटने न दें
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10.5.3.4 सुझाव 

•	 अगर आपको इस बात पर ध्यान देना मुश्किल लगे कि कोई क्या कह रहा ह,ै तो उनके शब्द अपने दिमाग में दोहराने की कोशिश करें ।

•	जि स व्यक्ति से आप बात कर रहे हैं, उसको बोलते व सुनते वक्त हमेशा उसकी आंखों से संपर्क  बनाएं रखें। इससे बातचीत में आपकी दिलचस्पी नज़र 

आती ह ैऔर रूचि बढ़ती ह।ै

10.5.4 समस्या समाधान व मोलभाव/नगैोशिएशन कौशल 
Concise Oxford Dictionary (1995) के मुताबिक, समस्या का मतलब ह,ै “एक संदेहात्मक या मुश्किल मसला जिसे समाधान की ज़रूरत हो”

सभी समस्याओ ंमें दो तत्व होते हैं:

1.	 लक्ष्य	

2.	 बाधाएं

समस्या समाधान का उद्देश्य बाधाओ ंको पहचानना और लक्ष्य प्राप्ति हेतु उन्हें दूर करना होता ह।ै

10.5.4.1 समस्याएं कैसे सुलझाएं

10.5.4.2 समस्या सुलझाने के महत्वपूर्ण गुण

किसी समस्या को सुलझाने के लिए तार्कि क सोच की ज़रूरत पड़ती ह।ै जब कोई मसला सुलझाना हो तो इन तार्कि क चरण अपनाएं:

•	 चरण 1: समस्या पहचानें	

•	 चरण 2: समस्या का विस्तार से अध्ययन करें

•	 चरण 3: सभी संभावित समाधानों की सचूी बनाएं	

•	 चरण 4: बेहतरीन समाधान चुनें

•	 चरण 5: चुने हुए समाधान को लाग ूकरें   

•	 चरण 6: जांचें कि समस्या वाकई सुलझ गई है

समस्या सुलझाने की अत्यंत विकसित योग्यता, व्यवसायियों तथा उनके कर्मचारियों, दोनों के लिए बेहद ज़रूरी हैं। समस्याओ ंको प्रभावशाली ढंग से 

सुलझाने में निम्न व्यक्तिगत गुण एक महत्वपरू्ण  भमूिका निभाते हैं:

•	 खुले विचारों वाला बनें	

•	 सही सवाल पछूें

•	 सक्रिय रहें	

•	 घबराएं नहीं

•	 सकारात्मक दृष्टिकोण रखें	

•	 सही समस्या पर ध्यान दें
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10.5.4.2 समस्या सुलझाने के महत्वपूर्ण गुण

10.5.4.3 नगैोशिएशन क्या ह?ै

एक उद्यमी के तौर पर, यह अच्छी बात ह ैकि संभावित उम्मीदवारों को नियक्त करने से पहले उनके समस्या सुलझाने के हुनर को परखा जाए। इस हुनर 

को परखने के कुछ तरीके इस तरह हैं:

•	 आवेदन पत्र: आवेदन पत्र में उम्मीदवार के समस्या सुलझाने के कौशल का कोई प्रमाण माँगे।

•	 मनोमितिय/साइकोमटै्रिक परीक्षण: संभावित उम्मीदवारों से तार्कि क सवाल पछूें  और उन्हें गंभीर चितन वाले प्रश्‍न दें और देखें कि वे कितने 

कारगर हैं।

•	 साक्षात्कार: बनावटी समस्याग्रस्त हालात पदैा करें  या नतैिक सवाल उठाएं और देखें कि उम्मीदवार कैसे जवाब देते हैं।

•	 तकनीकी सवाल: उम्मीदवारों को असल ज़िंदगी की समस्याओ ंके उदाहरण दें और उनकी चितन प्रक्रिया का मूल्यांकन करें ।

नगैोशिएशन मतभेदों को दूर करने का एक तरीका ह।ै नगैोशिएशन का उद्धेश्य, विवादों को टालते हुए, समझौते या राजीनामे के जरिए मतभेदों को हल 

करना ह।ै नगैोशिएशन के बिना, मतभेद लोगों के बीच अंसतोष को जन्म देते हैं। नगैोशिएशन का अच्छा हुनर दोनों पक्षों को संतुष्ट करने में मदद करता 

ह ैऔर मजबतू रिश्ते बनाने की ओर ले जाता ह।ै

नगैोशिएशन क्यों

व्यवसाय शुरू करने में कई नगैोशिएशन करने पड़ते हैं। कुछ नगैोशिएशन छोटे होते हैं जबकि अन्य इतने गंभीर होते हैं कि स्टार्टअप बना या बिगाड़ 

सकते हैं। नगैोशिएशन कार्यस्थल पर भी अहम भमूिका निभाते हैं। एक उद्यमी के तौर पर, आपको न महज यह जानने की ज़रूरत होती ह ै कि खुद 

नगैोशिएट कैसे करें , बल्कि यह भी कि नगैोशिएशन की कला में कर्मचारियों को भी कैसे प्रशिक्षित करें ।

नगैोशिएशन कैसे करें

नगैोशिएशन समझने के लिए कुछ चरणों पर ध्यान दें:

चरण 1: नगैोशिएशन से पहले की तयैारी: समस्या पर बातचीत करने के लिए मिलने के स्थान पर सहमति, यह तय करना कि कौन-कौन मौजदू होंगे 

और बातचीत के लिए समयसीमा तय करना।

चरण 2: समस्या पर चर्चा  करना: इसमें सवाल पछूना, दूसरा पक्ष सुनना, अपने विचार सामने रखना और संदेहों को दूर करना शामिल ह।ै

चरण 3: उद्धेश्य स्पष्ट करें : सुनिश्चित करें  कि दोनों ही पक्ष समान समस्या हल करना चाहते हैं और समान लक्ष्य तक पहँुचना चाहते हैं।

चरण 4: दानों पक्षों के लाभ का लक्ष्य रखें: नगैोशिएशन के वक्त खुले विचारों वाला रहने की परूी कोशिश करें । दोनों पक्षों के लाभ की स्थिति पाने के 

लिए समझौता करें  और वकैल्पिक समाधान पेश करें ।

चरण 5: समझौते को स्पष्ट तौर पर परिभाषित करें : जब कोई समझौता तय हो जाए, तो समझौते का विवरण दोनों पक्षों को एकदम स्पष्ट होना चाहिए, 

गलतफहमी की कोई गंुजाइश नहीं होनी चाहिए।

चरण 6: सर्वसम्मत समाधान को लाग ूकरें : समाधान को अमल में लाने के लिए कार्यवाही करने पर सहमत हों।

10.5.4.4 सुझाव 
•	 इस पर अमल करने से पहले यह जान लें कि आप चाहते क्या हैं

•	 बोलने की बजाए सुनने व सोचने को ज़्यादा अहमियत दें

•	 जीतने की बजाए रिश्ता कायम करने पर ध्यान दें
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10.5.5 व्यवसायिक अवसरों की पहचान

•	य ाद रखें कि आपका व्यवहार कौशल नतीजे पर असर डालेगा

•	 जानें कि कब पीछे  हटना ह ै– क्योंकि कभी-कभार समझौते पर पहंुचना मुमकिन नहीं होता

“उद्यमी हमशेा बदलाव की खोज में रहता ह,ै इस पर प्रतिक्रिया देता ह ैऔर एक अवसर के तौर पर इसका इस्तेमाल करता ह।ै” 

पीटर ड्रकर

व्यवसायिक अवसरों को पहचानने की योग्यता एक उद्यमी का एक अहम गुण ह।ै

अवसर क्या ह?ै

अवसर शब्द का अर्थ हालातों की वजह से मिलने वाला एक अच्छा मौका या कुछ करने के लिए एक अनुकूल माहौल होता ह।ै

एक व्यवसायिक अवसर का मतलब ह ैकि मौजदूा माहौल में, मौजदूा समय में, किसी खास व्यवसाय को चलाने के लिए उपलब्ध एक अच्छा या अनुकूल 

बदलाव।

उद्यमियों के सामने आने वाल ेआम सवाल

एक गंभीर सवाल जिसका सभी उद्यमी सामना करते हैं, कि उस व्यवसायिक अवसर को कैसे खोजें जो उनके लिए सही हो।

कुछ आम सवाल जिनके बारे  में उद्यमी लगातार सोचते रहते हैं:

•	क्या  नए उपक्रम को किसी अपरू्ण  आवश्यकता के आधार पर कोई नया उत्पाद या सेवा लानी चाहिए?

•	क्या  नए उपक्रम को एक बाजार से कोई मौजदूा उत्पाद या सेवा चुनकर इसे दूसरे  बाज़ार में पेश करना चाहिए, जहां यह उपलब्ध न हो?

•	क्या  उपक्रम को एक आजमाए व परीक्षित फॉर्मू ले पर आधारित रहना चाहिए, जो हर जगह काम करे ?

इसलिए यह बेहद ज़रूरी ह ैकि उद्यमी जानें कि नए व मौजदूा व्यवसायिक अवसरों को कैसे पहचानें और उनकी सफलता की संभावनाओ ंको परखें।

कोई सोच एक अवसर कब होती ह?ै

एक सोच एक अवसर तब होती ह ैजब:

•	य ह ग्राहक के लिए मूल्यवर्द्धन करे

•	य ह किसी अहम समस्या को हल करे , दुखती नब्ज ठीक करे  या कोई मांग परूी करे

•	 एक तगड़ा बाजार और मुनाफे की गंुजाइश हो

•	 सही समय व स्थान पर संस्थापक व मनेैजमेंट टीम के साथ अच्छा तालमेल हो

अवसरों को देखते वक्त ध्यान देने वाले कारक

•	 व्यवसायिक अवसरों को देखते वक्त निम्न पर ध्यान दें:

•	 फंडिग में बदलते आर्थिक रूझान

•	 वेंडर्स, पार्टनर्स व सप्लायर्स के बीच बदलते रिश्ते

•	 बाजार के रूझान

•	र ाजनीतिक समर्थन में बदलाव

•	 लक्षित लोगों में बदलाव
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नए व्यवसायिक अवसरों को पहचानने के तरीके

•	 बाजार की अक्षमताएं पहचानें: जब कोई बाजार देखें, तो इस बात पर ध्यान दें कि कौन सी अक्षमताएं बाजार में मौजदू हैं। इन अक्षमताओ ंको ठीक 

करने के तरीकों के बारे  में सोचें।

•	 मुख्य बाधाओ ंको दूर करें : नया उत्पाद या सेवा बनाने के बजाए, आप नए ढंग से कोई उत्पाद, सेवा या प्रक्रिया सुधार सकते हैं।

•	 कुछ नया रचें: मौजदूा व्यवसायिक मॉडलों के आधार पर सोचें कि आप ग्राहकों के लिए नया अनुभव कैसे रच सकते हैं।

•	 कोई उभरता क्षेत्र/उद्योग चुनें: शोध करें  और पता लगाएं कि कौन सा क्षेत्र या उद्योग उभर रहा ह ैऔर सोचें कि कौन से अवसर आप इसमें जोड़  

सकते हैं।

•	 उत्पाद भिन्नता के बारे में सोचें: अगर आपके दिमाग में पहले से ही कोई उत्पाद ह,ै तो इसे मौजदूा उत्पादों से अलग स्थापित करने के तरीकों के 

बारे  में सोचें।

अपने व्यवसाय के भीतर व्यवसायिक अवसर पहचानने के तरीके

SWOT पड़ताल: अपने व्यवसाय के भीतर अवसर पहचानने का एक बेहतरीन तरीका SWOT विश्ले षण का निर्माण करना ह।ै SWOT का मतलब 

स्ट्रेंथ(मजबतूी), वीकनेस(कमजोरी), अपरच्युनिटी(अवसर), व थ्रेट(डर) ह।ै SWOT विश्ले षण फ्रे मवर्क :

व्यवसायिक अवसरों को देखते वक्त निम्न पर ध्यान दें:

SWOT फ्रे मवर्क  के इस्तेमाल से खुद को व अपने प्रतियोगियों को देखते हुए, आप उन अवसरों को ढंूढ सकते हैं जिन्हें आप संभालने के साथ-साथ 

इस्तेमाल कर सकें  और उन डरों को दूर कर सकें  जो आपकी सफलता को पटरी से उतार सकते हैं।

अपनी USP स्थापित करें

अपनी USP स्थापित करें  और खुद को अपने प्रतियोगियों से हटकर दर्शा एं। पता लगाएं, कि ग्राहक आपसे क्यों खरीदेंगे और उस वजह को बढ़ावा दें।

चित्र 10.5.1: SWOT विश्लेषण
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अवसर का विश्लेषण

जब आप एक बार अवसर की पहचान कर लें, तो आपको इसके विश्ले षण करने की ज़रूरत होगी। किसी अवसर का विश्ले षण करने के लिए, आपको:

•	 सोच पर ध्यान कें द्रित करना है

•	 सोच के बाजार पर ध्यान कें द्रित करना है

•	 सोच में समान स्थिति वाले इंडस्ट्री लीडर्स से बात करनी है

•	 सोच में समान स्थिति वाले बड़े व्यवसायियों से बात करनी है

10.5.5.1 सुझाव 
•	य ाद रखें, कि अवसर हालात के मुताबिक होते हैं।

•	 सफल साबित हो चुका ट्रैक रिकॉर्ड  अपनाएं।

•	 लेटेस्ट क्रे ज़ से बचें।

•	 अपनी सोच से प्यार करें ।

10.5.6 उद्यमिता इको-सिस्टम को सपोर्ट करती है

एक उद्यमी वो व्यक्ति ह ैजो:

•	कि सी कर्मचारी के लिए काम नहीं करता

•	 एक छोटा उपक्रम चलाता है

•	 उपक्रम के सभी जोखिमों व फायदों, सोच, माल या सेवा को मानकर चलता है

उद्यमियों के प्रकार

उद्यमी मुख्य तौर पर चार प्रकार के हैं:

1.	 परंपरागत उद्यमी: इस तरह के उद्यमी में आमतौर पर किसी तरह का हुनर होता ह ै– वे बढ़ई, मिस्त्री, बावर्ची आदि हो सकते हैं। उनके ऐसे व्यवसाय 

होते हैं जो कई सालों से चले आ रहे हैं जसेै रे स्टोरें ट, दुकान व बढ़ई। खासतौर से, समान क्षेत्र में अपना खुद का व्यवसाय शुरू करने से पहले वे किसी 

खास इंडस्ट्री में भरपरू अनुभव हासिल करते हैं।

2.	व िकास क्षमता वाल ेउद्यमी: इस तरह के उद्यमी की इच्छा एक ऐसा उपक्रम शुरू करने की होती ह ैजो विकास करे , बहुत से ग्राहक बनाये और ढेर 

सारा पसैा कमाए। उनका अंतिम लक्ष्य आखिरकार अपने उपक्रम को अच छ्े  मुनाफे पर बेचना होता ह।ै ऐसे उद्यमियों की आमतौर पर विज्ञान या 

तकनीकी पषृ्ठभमूि होती ह।ै

3.	प्रो जेक्ट-लक्ष्यित उद्यमी: इस तरह के उद्यमी आमतौर पर कला या मनोविज्ञान की पषृ्ठभमूि वाले होते हैं। उनके उपक्रम ऐसी चीज़ों पर ध्यान कें द्रित 

करने की कोशिश करते हैं जिनको लेकर वे बेहद जुननूी होते हैं।

4.	 जीवनशलैीगत उद्यमी: इस तरह के उद्यमी आमतौर पर एक टीचर या एक सचिव के तौर पर काम करते हैं। वे बहुत ज़्यादा पसैा कमाने की बजाए, 

ऐसी चीज़ बेचने में रूचि रखते हैं जिसे लोग पसंद करें ।

एक उद्यमी के गुण

सफल उद्यमियों में निम्नलिखित गुण होते हैं:

•	 वे बेहद अभिप्रेरित होते हैं
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•	 वे रचनात्मक व सीखने की ललक रखने वाले होते हैं

•	 वे हरे क काम को संभालने के लिए मानसिक तौर पर तयैार होते हैं

•	 उनमें व्यवसाय का बेहतरीन हुनर होता ह ै– वे जानते हैं कि अपना नकदी प्रवाह, बिक्री व मुनाफा कैसे जांचें

•	 वे बड़े जोखिम उठाने के लिए तयैार होते हैं

•	 बे बेहद सक्रिय होते हैं – इसका मतलब ह ैकि वे किसी दूसरे  का इंतजार करने की बजाय, अपना काम स्वय करना चाहते हैं

•	 उनके पास एक नजरिया होता ह ै– वे परू्ण  परिप्रेक्ष्य देखने की योग्यता रखते हैं

•	 वे लचीले और खुले विचारों वाले होते हैं

•	 वे फैसला लेने में अच छ्े  होते हैं

10.5.6.1 उद्यमी की सफल कहानियां

10.5.6.2 उद्यमिता की प्रक्रिया

धीरू भाई अंबानी

धीरू भाई अबंानी न ेअपना उद्यमी करियर सप्ताहातं पर माउंट गिरनार म ें तीर्थयात्रियों को “पकौड़े” बचेन ेस ेशरुू किया था। 16 की उम्र म ें, व ेयमन गए जहा ं

उन्होंन ेएक गसै-स्टेशन अटेंडेंट, और एक तले कंपनी म ें क्लर्क  के तौर पर काम किया। व े50,000 रुपयों के साथ भारत लौटे और एक टेक्सटाइल ट्रेडिग 

कंपनी शरुू की। रिलायसं ग्लोबल मार्के ट म ें पसैा उगाहन ेवाली पहली भारतीय कंपनी बनी और फॉर्ब्स 500 की सचूी म ें जगह पान ेवाली पहली भारतीय 

कंपनी बनी।

डॉ. करसनभाई पटले

करसनभाई पटेल न ेअपन ेघर के पीछ ेअहात ेम ें डिटर्जेंट पाउडर बनाया। व ेअपना उत्पाद घर-घर जाकर बचेत ेथ ेऔर बचे ेगए हरेक पकै पर पसैा वापसी 

की गारंटी भी देत ेथ।े व े3 रुपय ेप्रति . किलोग्राम लते ेथ ेजबकि उस वक्त सबस ेसस्ता डिटर्जेंट 13 रुपय ेप्रति किलोग्राम था। डॉ. पटेल न ेआखिरकार निरमा 

शरुू किया जो भारतीय घरेल ूडिटर्जेंट बाजार का परूी तरह स ेएक नया हिस्सा बन गया।

चलिए उद्यमिता प्रक्रिया के चरणों पर एक नजर डालते हैं।

•	 चरण 1: सोच निर्धारण। उद्यमिता प्रक्रिया एक ऐसे विचार से शुरू होती ह ैजो उद्यमी के मन में आया हो। यह विचार एक समस्या होती ह,ै जो हल की 
जा सकती ह।ै

•	 चरण 2: पनपना या मान्यता प्राप्त करना। इस चरण में सोची गई समस्या का संभावित समाधान निकाला जाता ह।ै

•	 चरण 3: तयैारी करना या व्याख्या करना। समस्या का आगे अध्ययन किया जाता ह ैऔर यह पता लगाने के लिए शोध किया जाता ह ैदूसरों ने समान 
समस्या का हल निकालने के लिए कैसे कोशिश की।

•	 चरण 4: सपने बुनना या कल्पना करना इस चरण में रचनात्मक विचार मंथन शामिल ह,ै ताकि और अधिक विचार (आइडियाज़) मन में आएं। समस्या 
वाले क्षेत्रों पर ज़्यादा सोच-विचार नहीं किया जाता।

•	 चरण 5: संभाव्यता अध्ययन: अगला कदम ह,ै एक संभाव्यता अध्ययन करना, जिससे यह पता लगाया जा सके, कि यह आइडिया लाभदेय होगा या 
नहीं और इसे आज़माया जाये या नहीं।

•	 चरण 6: प्रकाशित करना या हक़ीकत में बदलना यह तब होता ह ैजब सभी अनिश्चित क्षेत्र अचानक स्पष्ट हो जाते हैं। उद्यमी को परूा विश्वास हो जाता 
ह,ै कि उसकी सोच में दम ह।ै

•	 चरण 7: पुष्टीकरण या प्रमाणीकरण। इस आखिरी चरण में, इस बात की पुष्टि की जाती ह,ै कि यह आइडिया काम करेग ा कि नहीं और यह उपयोगी 
ह,ै या नहीं।

इस प्रक्रिया की बेहतर समझ पाने के लिए नीचे दिए चित्र पर नजर डालें।



331330

प्रतिभागी पुस्तिका रोटो आर ट्िस्ट

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

10.5.6.3 उद्यमी क्या होता ह?ै
उद्यमिता ईकोसिस्टम को समर्थित करती ह,ै यह उद्यमिता के संग्रहित तथा समग्र स्वरूप का द्योतक ह।ै नई कंपनियां केवल उन्हें लॉचं करने वाले साहसी, दूर 

दृष्टा उद्यमियों की बदौलत नहीं उभरती तथा फलती-फूलती, बल्कि इसलिए कामयाब होती हैं, क्योंकि ये निजी तथा सार्वजनिक प्रतिभागियों से भरे  परिवेश 

या ‘‘ईकोसिस्टम’’ में लगाई जाता हैं। ये प्रतिभागी इन नये उपक्रमों को पोषित करके तथा बनाये रखकर इन उद्यमियों के प्रयासों को सफल बनाते हैं।

उद्यमिता ईकोसिस्टम निम्नलिखित छह क्षेत्रों से बना ह:ै

1.	 अनुकूल संस्कृति : इसमें उद्यमी की जोखिम व गलतियों को सहने की शक्ति, बढ़िया नेटवर्किंग  और सकारात्मक सामाजिक रुतबा जसेै तत्व 

शामिल हैं।

2.	 सुविधाजनक नीतियां व नेततृ्व: इसमें नियामक फ्रे मवर्क  के लाभ और सार्वजनिक अनुसंधान संस्थानों का अस्तित्व शामिल ह।ै

3.	व ित्तीय विकल्प: एंजेल फाइनेंसिग, उपक्रम पूंजीपति और माइक्रो लोन्स इसके अच छ्े  उदाहरण होंगे।

4.	 मानव पंूजी: इसका संदर्भ प्रशिक्षित व अप्रशिक्षित श्रम, उद्यमी और उद्यमिता प्रशिक्षण प्रोग्राम आदि से हैं।

5.	 उत्पाद व सेवाओ ंके लिए हितकर बाजार: इसका तात्पर्य  उत्पाद/सेवा के लिए बाजार की मौजदूगी या मौजदूगी की संभावना से ह।ै

6.	 संस्थागत व आधारभूत संरचनात्मक सपोर्ट: इसमें काननूी व वित्तीय सलाहकार, दूरसंचार, डिज़िटल व ट्रांसपोर्टेशन इंफ्रास्ट्रक्चर और उद्यमिता 

नेटवर्किंग  कार्यक्रम शामिल हैं।

ये भाग दर्शाते हैं कि क्या उद्यमिता को सपोर्ट  करने वाला एक मजबतू ईकोसिस्टम ह ैऔर इसे और अधिक प्रोत्साहित करने हेतु सरकार को क्या कदम 

उठाने चाहिएं। छह भाग और उनके विभिन्न तत्व ग्राफ के रूप में दर्शाए गए हैं।

चित्र 10.5.2: उद्यमिता प्रक्रिया के चरण
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चित्र 10.5.4: उद्यमिता को समर्थन देने वाला ईकोसिस्टम
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हर उद्यमिता को समर्थित करने वाला ईकोसिस्टम अनठूा ह ैऔर इस तंत्र के सभी तत्व परस्पर निर्भर हैं। यद्यपि, हर उद्यमिता ईकोसिस्टम का उपरोक्त छ: 

विशेषताओ ंद्वारा व्यापक रूप से वर्णन किया जा सकता ह,ै हर ईकोसिस्टम सकैड़ों तत्वों की एक-दूसरे  से होने वाली जटिल तथा विशिष्ट अन्त: क्रियाओ ं

का नतीजा ह।ै

उद्यमिता ईकोसिस्टम आखिरकार (व्यापक तौर पर) खुद से चलने वाला बन जाता ह।ै जब ये छह भाग पर्याप्त लचीले होते हैं, तो ये परस्पर लाभदायक होते 

हैं। इस बिदु पर, सरकार की भागीदारी बड़े स्तर पर कम हो सकती ह ैऔर होनी चाहिए। ईकोसिस्टम को सुचारू रूप से चलाने के लिए सार्वजनिक नेताओ ं

को ज़्यादा निवेश करने की ज़रूरत नहीं पड़ती। यह लाजिमी ह ैकि उद्यमिता ईकोसिस्टम प्रोत्साहन स्व-भुगतान के हिसाब से बने होते हैं, इसलिए परिवेश 

की वहनीयता पर कें द्रित होते हैं।

10.5.6.4 उद्यमिता ईकोसिस्टम में सरकार की भूमिका

10.5.6.5 भारत में उद्यमिता ईकोसिस्टम की तस्वीर

नए उपक्रमों को प्रोत्साहन देने पर नीतिनिर्माताओ ं का विशेष ज़ोर रहता ह।ै दुनिया भर में सरकारें  इस बात को मान रहीं हैं, कि विशिष्ट प्रकार के 

समर्थनकारी माहौल में व्यापार फलते-फूलते हैं। नीतिनिर्माताओ ंको हालात का अध्ययन करना चाहिए और नीतियां व नियामक बनाते वक्त निम्नलिखित 

बिदुओ ंको ध्यान में रखना चाहिए जिससे उद्यमिता को समर्थन देने वाला एक सफल ईकोसिस्टम बन सके।

•	 नीतिनिर्माताओ ंको उन नियामकों से बचना चाहिए जो नए प्रतियोगियों को हतोत्साहित करते हैं और व्यवसाय स्टार्टअप्स के लिए सक्षम तरीके 

बनाने की ओर काम करना चाहिए। नीतियां व नियामक जो उद्यमिता उपक्रमों के मुकाबले मौजदूा प्रबल कम्पनियों की पक्षधर हैं, स्पर्धा  को सीमित 

करती हैं और नई कम्पनियों के प्रवेश में रोड़ा बनती हैं।

•	 बाज़ार की नाकामियों में संशोधन करने हेतु नीतियाँ विकसित करने के बजाय, नीतिनिर्माताओ ंको उद्यमियों से बातचीत करनी चाहिये और उन 

चुनौतियों को समझना चाहिये जिनका वे सामना कर रहे हैं। नये आइडिया की खोज, उत्पाद विकास तथा सौदे का प्रवाह बढ़ाने हेतु प्रेरित करने 

वाली नीतियों के विकास के लिए फीडबकै का प्रयोग किया जाना चाहिये।

•	 उद्यमिता समर्थकों को एक डाटाबेस बनाना चाहिए जो यह पहचान करने में सक्षम हो कि ईकोसिस्टम में भागीदारी करने वाले कौन हैं और वे कैसे 

जुड़ें  हैं। ये ईकोसिस्टम मपै अनुबंध रणनीतियां बनाने में कारग़र औजार हैं।

•	 आर्थिक व सामजिक जीवन में दुर्घटनाएं अपरिहार्य  हैं। हालांकि, यहॉ ंयह उल्लेखनीय ह,ै कि आर्थिक दुर्घटनाएं उद्यमिता के अवसर पदैा करती हैं। 

उद्यमिता ईकोसिस्टम के निर्माताओ ं (उद्यमी, मेंटर, नीतिनिर्माता व उपभोक्ता,) को इन गिरावटों को भांपना चाहिए, ताकि उनके चलते पदैा हुए 

अवसरों से लाभ कमाया जा सके।

स्थानीय उद्यमिता ईकोसिस्टम को समर्थन दे, इसके लिए प्रभावी रणनीतियों की आवश्यकता व्यवहारिक ह।ै असल ईकोसिस्टम की बेहतर समझ एक 

फ्रे मवर्क  प्रदान करती ह,ै जिसके तहत नीतिनिर्माता प्रासंगिक सवाल पछू सकते हैं, अधिक कार्यकुशल दृष्टिकोण अपना सकते हैं और आने वाले नतीजों 

का मूल्याँकन कर सकते हैं।

उद्यमिता को भारत में नया सम्मान मिला ह।ै बहुत से भारतीय, जो कारोबार की दुनिया से वाकिफ हैं, जिन्होंने परंपरागत रूप से नौकरी करने का विकल्प 

चुना था, अब अपने उपक्रम स्थापित कर रहे हैं। उद्यमिता ईकोसिस्टम के बहुत से तत्व अब इकट्ठे होने शुरु हो गये हैं। उदाहरण के लिए, उपक्रम पूंजीपतियों, 

सरकारी योजनाओ ंव इंक्युबेटर्स, शिक्षा उद्योग संपर्क  तथा उभरते समूहों में इज़ाफा और ग्रामीण अर्थव्यवस्था को समर्थन। ये सभी पहलें प्रभावी हैं, लेकिन 

ईकोसिस्टम को निम्नलिखित तरीकों द्वारा फिर से बढ़ाने व समदृ्ध करने की ज़रूरत ह:ै

1.	 हमें असफलताओ ंके प्रति अपने व्यवहार की समीक्षा करने की ज़रूरत ह ैऔर उन्हें अनुभव के तौर पर स्वीकार करने की ज़रूरत ह।ै

2.	 हमें शिक्षितों को उद्यमी बनने के लिए प्रोत्साहित करने की ज़रूरत ह ैऔर स्कू ल व कॉलेजों में उद्यमी हुनर मुहयैा करवाने की ज़रूरत ह।ै

3.	 विश्विविद्यालय, अनुसंधान प्रयोगशालाओ ंतथा सरकार को उद्यमिता को समर्थन देने वाला ईकोसिस्टम तयैार करने में अपनी भमूिका निभाने की 

आवश्यकता ह।ै
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4.	 नीतिनिर्माताओ ंको भ्रष्टाचार, रे ड टेप व अफसरशाही जसैी बाधाओ ंको कम करने पर ध्यान देने की ज़रूरत ह।ै

5.	 हमें अपने काननूों में संशोधन करना चाहिये, अंतर्राष्ट्रीय उपक्रम पूंजी फर्मों को आकर्षित करना चाहिये और उन्हें भारत ले आना चाहिये।

6.	 हमें भारत के उन द्वितीयक व ततृीयक शहरों तक पहंुचने के लिए नीतियां व विधियां बनानी चाहिए, जहां लोगों की पठै उन संसाधनों तक नहीं ह,ै 

जो शहरों में उपलब्ध हैं।

आज, इस देश में नवीन समाधान शामिल करने का एक बड़ा अवसर ह ैजो आगे बढ़ने में सक्षम हो और ईकोसिस्टम में सहयोग करे  और साथ ही इसे  

समदृ्ध करे ।

10.5.6.6 मेक इन इंडिया अभियान

हरे क उद्यमी की कुछ ज़रूरतें होती हैं। उनकी कुछ महत्वपरू्ण  ज़रूरतें इस प्रकार हैं:

•	 आसानी से कर्ज पाना

•	 आसानी से निवेशक पाना

•	 करों से छूट पाना

•	 संसाधनों व बेहतर आधारभतू संरचना की आसान पठै

•	 ऐसी प्रक्रिया का लाभ उठाना, जिसमें कोई परे शानी न हो और त्वरित हो

•	 अन्य फर्मों से आसानी से भागीदारी कर सकें

प्रधानमंत्री मोदी द्वारा लॉन्च मेक इन इंडिया अभियान, का मकसद युवाओ,ं महत्वाकांक्षी उद्यमियों की इन सभी ज़रूरतों को परूा करना ह।ै इसका मकसद 

ये ह:ै

•	नि वेश को आसान बनाना

•	 नई सोच को समर्थन देना

•	 कौशल विकास बढ़ाना

•	 उद्यमियों के आइडिया की सुरक्षा

•	 उत्पादों के निर्माण के लिए अत्याधनिक सुविधाएं बनाना

10.5.6.6 सुझाव 
•	 अन्य उद्यमियों, उपक्रम पूंजीपतियों, एंजेल निवेशकों के साथ मौजदूा बाजार, नेटवर्क  का शोध करना और आपकी उद्यमिता को सक्षम करने के लिए 

लाग ूनीतियों की विस्तार से समीक्षा करना।

•	 असफलता आगे बढ़ने के लिए एक सीढ़ी ह,ै न कि रास्ते का अंत। अपनी व अपने साथियों की गलतियों की समीक्षा करें  और अपने भावी उपक्रम में 

इन्हें सुधार लें।

•	 अपने ईकोसिस्टम में सक्रिय रहें। अपने ईकोसिस्टम की अहम विशेषताएं पहचानें और अपने उद्यम को समर्थन देने वाले ईकेसि स्टम के लिए स्व-

वहनीयता सुनिश्चित करने हेतु उसे समदृ्ध करते रहें।
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10.5.7 जोखिमों उठाने की इच्छा व लचीलापन

उद्यमिता और जोखिम

उद्यमी स्वाभाविक रूप से जोखिम उठाने वाले होते हैं। वे पथ का निर्माण करने वाले होते हैं, न कि पहले से तय पथ पर चलने वाले। एक आम, एहतियाती 

व्यक्ति के उल्ट, एक उद्यमी अपनी नौकरी (उसकी एकमात्र आमदनी) छोड़ने और अपने आइडिया के लिए स्वय को जोखिम में डालने के बारे  में दो बार 

नहीं सोचेगा।

एक उद्यमी जानता ह ैकि अपने सपनों को परूा करते वक्त उसके अनुमान गलत साबित हो सकते हैं और अप्रत्याशित घटनाएं घट सकती हैं। वह जानता ह ै

कि कई समस्याओ ंसे निपटने के बाद भी, सफलता की कोई गारंटी नहीं ह।ै उद्यमिता जोखिम उठाने की योग्यता का पर्यायवाची ह।ै यह योग्यता, जो कि 

जोखिम लेने की क्षमता कहलाती ह,ै एक उद्यमी का गुण ह ैजो कि कुछ हद तक आनुवंशिक होता ह ैऔर कुछ हद तक हासिल किया गया।

जोखिम लनेे की क्षमता क्या ह?ै

जोखिम लेने की क्षमता की परिभाषा यह ह,ै कि कम्पनी अपने उद्धेश्यों की प्राप्ति के लिए किस हद तक जोखिम उठाने के लिए तयैार ह।ै इसका तात्पर्य 

संभावित मुनाफे व माहौल में आए बदवाल (आर्थिक ईकोसिस्टम, नीतियां आदि) से होने वाले नुकसान के बीच कंपनी द्वारा बिठाये गये सन्तुलन से होता 

ह।ै ज़्यादा जोखिम उठाना से ज़्यादा मुनाफा हो सकता ह,ै लेकिन इससे उतने ही अधिक नुकसान की भी संभावना बन जाती ह।ै हालांकि, बहुत ज़्यादा 

सतर्क  रहना कंपनी के खिलाफ जा सकता ह,ै क्योंकि इससे वह विकास और अपने उद्धेश्यों को परूा करने के कई अच छ्े  अवसर खो देती ह।ै

जोखिम लेने की क्षमता के स्तर को “निम्न”, “मध्यम” व “उच्च” में वर्गीकृत किया जा सकता ह।ै कंपनी के उद्यमियों को सभी संभावित विकल्पों का 

मूल्यांकन करना होता ह ैऔर उस विकल्प को चुनना होता ह,ै जिसके सफल होने की संभावना सबसे अधिक ह।ै कंपनियों के विभिन्न मकसदों के लिए 

जोखिम लेने की क्षमता के स्तर भी अलग-अलग होते हैं। स्तर इन बातों पर निर्भर करते हैं:

•	 उद्योग का प्रकार

•	 बाजार दबाव

•	 कंपनी के उद्धेश्य

उदाहरण के लिए, क्रांतिकारी धारणा वाले एक स्टार्टअप की जोखिम लेने की क्षमता का स्तर बहुत ऊँचा होगा। स्टार्टअप अपनी दीर्घकालिक सफलता 

हासिल करने से पहले लघुकालिक असफलताएं झेल सकता ह।ै इस तरह की भखू एक-सी नहीं रहेगी और कंपनी के मौजदूा हालातों के मुताबिक तय 

होती रहेगी।

जोखिम लनेे की क्षमता का वक्तव्य

कंपनियों को अपनी जोखिम लेने की क्षमता को अपने उद्धेश्यों तथा अवसरों के बारे  में लिए जाने वाले निर्णयों के साथ जोड़ना तथा परिभाषित करना होता 

ह।ै जोखिम लेने की क्षमता का वक्तव्य होने का अर्थ ह,ै एक ऐसी संरचना मौज़ूद होना, जो स्पष्ट रूप से व्यापार में जोखिम की स्वीकार्यता तथा प्रबंधन 

को व्यक्त करती ह।ै यह जोखिम उठाने की सीमा को कंपनी की हद में रखता ह।ै जोखिम लेने की क्षमता के वक्तव्य से निम्न जाहिर होने चाहिए:

•	 व्यवसाय द्वारा झेले जाने वाले जोखिमों की प्रकृति।

•	 कौन से जोखिम कंपनी आसानी से ले सकती ह ैऔर कौन से जोखिम अस्वीकार्य  हैं।

•	 सभी जोखिम श्रेणियों में कितना जोखिम स्वीकार्य  ह।ै

•	 जोखिम व फायदे के बीच इच्छित अदला-बदली।

•	 जोखिम तथा इसके परीक्षण के उपाय और पड़ताल के तरीके और जोखिम के स्तर का नियमन।

उद्यमिता और लचीलापन

उद्यमी के चरित्र में लचीलापन नामक विशेषताएं निहित होती हैं। ये योग्यताएं एक उपक्रम को विकसित करने के शुरुआती चरणों में खासतौर से बहुत 

बड़ी भमूिका अदा करती हैं। जोखिम लचीलापन एक बेहद मूल्यवान गुण ह,ै क्योंकि ऐसा विश्वास ह ैकि यह व्यवसाय के माहौल में बदलाव और चुनौतियों 

के डर के खिलाफ उद्यमियों की रक्षा करता ह।ै

उद्यमिता लचीलापन क्या ह?ै

लचीलापन शब्द उन व्यक्तियों की व्याख्या करने हेतु प्रयोग किया जाता ह,ै जो अपनी ज़िंदगी व करियर महत्वाकांक्षाओ ंसे संबंधित असफलताओ ंसे 

उभरने की क्षमता रखते हैं। एक लचीला व्यक्ति वह होता ह ैजो असफलताओ ंसे आसानी से व जल्दी से उभरने में सक्षम हो। उद्यमियों के लिए, लचीलापन 
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एक निर्णायक गुण ह।ै उद्यमिता लोच को निम्नलिखित तरीकों से निखारा जा सकता ह:ै

•	 कोच व मेंटर के पेशेवर नेटवर्क  को विकसित करके

•	य ह स्वीकार करके कि बदलाव ज़िंदगी का हिस्सा है

•	 बाधाओ ंको ऐसा मान कर, कि इन्हें पार किया जा सकता है

लचील ेउद्यमी के गुण

उद्यमी को इतना लचीला बनाने, कि वह अपने व्यवसायिक उपक्रम में परूी तरह आगे बढ़ें , हेतु निम्न विशेषताओ ंकी आवश्यकता होती ह:ै

•	निय त्रण की मजबतू भीतरी भावना

•	 मजबतू सामाजिक सम्पर्क

•	 असफलताओ ंसे सीखने का हुनर

•	 समग्र परिप्रेक्ष्य देखने की क्षमता

•	 विविधता अपनाने व विस्तारित होने की क्षमता

•	 बने रहने की प्रवतृ्ति

•	 नकदी-प्रवाह के प्रति सचेत रहने की आदत

•	 बारीकी से ध्यान देना

10.5.7.1 सुझाव 
•	ग्रा हकों, सप्लायरों, साथियों, दोस्तों व परिवार का एक बड़ा नेटवर्क  बनाएं। यह न सिर्फ  आपके व्यवसाय को बढ़ाने में मदद करेग ा, बल्कि आपको 

नए अवसर सीखने, पहचानने में भी मदद करेग ा और बाजार के बदलावों से अवगत रखेगा।

•	 असफलताओ ंसे मायसू न हों। इस बात पर ध्यान दें कि फिर से आगे बढ़ने के लिए क्या किया जाए।

•	 हालांकि आपको अपने खर्चों पर नियत्रण रखने का प्रयास करना चाहिये, ऐसा आपकी कम्पनी के विकास की कीमत पर हरगिज़ नहीं होना चाहिये।

10.5.8 सफलता और असफलता
उद्यमिता में सफलताओ ंऔर असफलताओ ंको समझें

श्याम एक मशहूर उद्यमी ह,ै वह अपनी सफलता की कहानी के लिए जाना जाता ह।ै मगर एक बात ज़्यादातर लोग नहीं जानते, कि श्याम अपना उपक्रम 

सफल करने से पहले कई बार असफल हुआ था। यह जानने के लिए कि उद्यमिता असल में क्या ह,ै उनका साक्षात्कार पढ़ें , उस उद्यमी की सीधी बात जिसे 

दोनों मिले, असफलता और सफलता।

साक्षात्कारकर्ता: श्याम, मैंने सुना ह ैकि उद्यमी ज़बरदस्त जोखिम उठाने की क्षमता रखते हैं, जो असफल होने से कभी नहीं डरते। क्या यह सच ह?ै

श्याम: हां हां (हँसकर), नहीं बेशक यह सही नहीं ह!ै ज़्यादातर लोग मानते हैं कि उद्यमियों को बिना किसी डर के जुननूी होना चाहिये। मगर सच्चाई यह 

ह,ै कि डर एक बहुत आम व जायज़ मानवीय प्रतिक्रिया ह,ै खासतौर से जब आप अपना व्यवसाय शुरू करने की योजना बना रहे होते हैं! असल में, मेरा 

सबसे बड़ा डर असफल होने का डर था। सच्चाई यह ह,ै कि उद्यमी जितने असफल होते हैं, उतने ही वे सफल होते हैं। नुस्खा यह ह ैकि असफलता के डर को 

खुद पर इतना हावी न होने दें कि आप आगे बढ़ने की अपनी योजनाओ ंको रोक दें। याद रखें, असफलताएं भविष्य की सफलता का पाठ हैं!

साक्षात्कारकर्ता: आपके मुताबिक उद्यमी के असफल होने की वजह क्या होती ह?ै
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10.5.8.1 सुझाव 

श्याम: खरै, उद्यमी के असफल होने की कोई एक अकेली वजह नहीं होती। उद्यमी कई वजहों की वजह से असफल हो सकता ह।ै आप इसलिए असफल हो 

सकते हैं कि आपने अपने असफलता के डर के आगे हार मान ली। आप इसलिए असफल हो सकते हैं कि आप काम बांटने के प्रति अनिच छ्ु क थे। जसैा कि 

कहा जाता ह,ै “आप कुछ भी कर सकते हैं, मगर सब कुछ नहीं!” आप इसलिए असफल हो सकते हैं कि आपने आसानी से हार मान ली - हो सकता ह ैकि 

आप पर्याप्त रूप से डटे न हो। आप इसलिए असफल हो सकते हैं कि आपने अपनी ऊर्जा  छोटे, ग़ैर-ज़रूरी कामों पर लगा दी और वो काम नजरअंदाज कर 

दिए जो बेहद महत्वपरू्ण  थे। असफलता की एक और वजह गलत लोगों के साथ भागीदारी भी हो सकती ह,ै अपने उत्पाद सही जगह पर, सही समय पर सही 

ग्राहक को न बेच पाना......और भी बहुत से कारण!

साक्षात्कारकर्ता: एक उद्यमी के तौर पर, आपको क्या लगता ह ैकि असफलता को कैसे लेना चाहिए?

श्याम: मेरा मानना ह ैकि हम सबको असफलता को एक पूंजी मानना चाहिए, बजाए इसके कि यह कुछ नकारात्मक चीज़ ह।ै मैं इसे इस तरीके से देखता 

हंू कि, अगर आपके पास कोई आइडिया ह,ै तो आपको इसे अमल में लाने की कोशिश करनी चाहिए, चाहे आपके असफल होने की संभावना ही क्यों न हो। 

ऐसा इसलिए, क्योंकि प्रयास ही न करना तो असफलता ह ैही! और असफलता आपके साथ घट सकने वाली सबसे बुरी घटना नहीं ह।ै मेरा मानना ह ैकि 

प्रयास न करना और फिर पछताना, कि काश! प्रयास किया होता.....असल में प्रयास करने और असफल रहने से कहीं अधिक बदतर ह।ै

साक्षात्कारकर्ता: जब आप पहली बार असफल हुए तो आपको कैसा लगा?

श्याम: मेरा दिल परूी तरह टूट गया था! यह बहुत दर्दनाक अनुभव था। मगर अच्छी बात यह ह,ै कि आप असफलता से उबर जाते हैं। और हर आने वाली 

असफलता के साथ, उबरने की प्रक्रिया और आसान हो जाती ह।ै ऐसा इसलिए होता ह ैक्योंकि आप असफलता को एक पाठ मानना शुरू कर देते हैं, जो 

आखिरकार सफल होने में आपकी मदद करती ह,ै बजाए इसे एक ऐसी बाधा मानना के, जिसे आप पार न कर सकें । आप यह महससू करना शुरू कर देंगे 

कि असफलता के कई फायदे ह।ै

साक्षात्कारकर्ता: क्या आप हमें असफलता के कुछ फायदे बता सकते हैं?

श्याम: एक फायदा यह ह ैजो मैंने असफलता से निजी तौर पर सीखा ह ैकि असफलता ने मुझे चीज़ों को एक नई रोशनी में देखना सिखाया। इसने मुझे वो 

जवाब दिए जो मेरे  पास पहले नहीं थे। असफलता आपको बेहद मजबतू बनाती ह।ै यह आपके अभिमान को नियत्रण में रखने में भी मदद करती ह।ै

साक्षात्कारकर्ता: आप उन उद्यमियों को क्या सलाह देंगे जो अपना खुद का उपक्रम शुरू करना चाहते हैं?

श्याम: मैं उनको कहना चाहंूगा कि अपनी रिसर्च करें  और यह सुनिश्चित करें  कि उनके उत्पाद की ग्राहकों को वाकई ज़रूरत ह।ै मैं उनको अपने भागीदार 

व कर्मचारी बेहद समझदारी और सावधानी से चुनने की राय दँूगा। मैं उनको कहंूगा कि आक्रामक होना बहुत महत्वपरू्ण  ह ै– अपने उत्पाद को जितना हो 

सके, आक्रामक ढंग से बढ़ावा दें और उसकी मार्केटि ग करें । मैं उन्हें चेताना चाहँूगा, कि किसी उपक्रम को शुरू करना बेहद खर्चीला होता ह ैऔर उन्हें उस 

हालात के लिए तयैार रहना चाहिए जहां उनके पसेै खत्म हो जाएंगे।

मैं उन्हें दीर्घकालिक उद्देश्य बनाने के लिए कहंूगा और उन उद्देश्यों को पाने के लिए कोई योजना अमल में लाने के लिए कहंूगा। मैं उन्हें एक ऐसा उत्पाद 

बनाने की राय दँूगा, जो वाकई अनठूा हो। इस बात का बेहद ध्यान रखें व सुनिश्चित करें  कि आप किसी दूसरे  स्टार्टअप की नकल न करें । आखिर में, मैं 

उनको कहना चाहंूगा कि यह बहुत महत्वपरू्ण  ह ैकि वे सही निवेशक तलाशें।

साक्षात्कारकर्ता: श्याम, यह वाकई काफी मददगार सलाह ह!ै मुझे परूा विश्वास ह,ै कि ये सुझाव उद्यमियों को अपना सफर शुरू करने के लिए और अधिक 

तयैार कर देंगे। अपने बेशकीमती अनुभव साझा करने के लिए धन्यवाद!

•	य ाद रखें कि कुछ भी नामुमकिन नहीं ह।ै

•	 शुरू करने से पहले अपना मिशन व अपना उद्देश्य पहचान लें।

•	 अपने अगले कदम की योजना बनाएं – जल्दबाजी में फैसले न लें।
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यूनिट 10.6: एक उद्यमी बनने की तयैारी करना

इस यनूिट के अंत में, आप निम्न करने में सक्षम होंगे:

1.	च र्चा  कर सकें गे कि विपणन (मार्के ट) शोध कैसे किया जाए

2.	 मार्केटि ग के 4 P का वर्णन कर सकें गे

3.	 विचार उत्पत्ति के महत्व पर चर्चा  कर सकें गे

4.	 बुनियादी व्यापार शब्दावली को याद कर सकें गे

5.	 CRM की आवश्यकता पर चर्चा  कर सकें गे

6.	 CRM के लाभों पर चर्चा  कर सकें गे

7.	 नेटवर्किंग  की आवश्यकता पर चर्चा  कर सकें गे

8.	 नेटवर्किंग  के लाभों पर चर्चा  कर सकें गे

9.	 लक्ष्यनिर्धारण के महत्व को समझ सकें गे

10.	 अल्पकालिक, मध्यम अवधि और लंबी अवधि के लक्ष्यों के बीच अंतर कर सकें गे

11.	च र्चा  कर सकें गे कि एक व्यवसाय योजना कैसे लिखी जाए

12.	 वित्तीय योजना प्रक्रिया की व्याख्या कर सकें गे

13.	 अपने जोखिम को प्रबंधित करने के तरीकों पर चर्चा  कर सकें गे

14.	 बैंक से वित्त के लिए आवेदन करने की प्रक्रिया और औपचारिकताओ ंका वर्णन कर सकें गे

15.	च र्चा  कर सकें गे कि अपने उपक्रम का प्रबंधन कैसे किया जाए

16.	 ऐसे महत्वपरू्ण  प्रश्नों की सचूी बना सकें गे जो प्रत्येक उद्यमी को उप्रकम शुरू करने से पहले पछूने चाहिए

यूनिट के उद्देश्य 

10.6.1 बाजार अध्ययन / मार्केटि ंग के 4 पी / एक आइडिया का महत्व
मार्के ट रिसर्च समझना

मार्के ट रिसर्च किसी उत्पाद या सेवा जो बाजार में बेची जा रही हो पर बाजार सचूना जुटाने, इसका विश्ले षण करने व इसकी व्याख्या करने की प्रक्रिया ह।ै 

इसमें निम्न की सचूना भी शामिल ह:ै

•	पिछ ले, मौजदूा व भावी ग्राहक

•	ग्रा हक विशेषताएं व खर्च करने की आदतें

•	 लक्ष्यित बाजार की स्थिति व आवश्यकताएं

•	 संपरू्ण  उद्योग

•	 संबंधित प्रतिस्पर्धी

मार्के ट रिसर्च में दो तरह का डाटा शामिल ह:ै

•	प्रा थमिक सचूना। यह रिसर्च आपके द्वारा स्वय आपके द्वारा नियक्त किए गए किसी व्यक्ति की द्वारा की जाती ह।ै

•	द्वि तीयक सचूना। यह रिसर्च पहले से ही मौजदू होती ह ैऔर आपको इसे तलाशना व इस्तेमाल करना होता ह।ै
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प्राथमिक रिसर्च

प्राथमिक रिसर्च दो प्रकार की हो सकती ह:ै

•	 खोजपरक: यह एकदम खुली होती ह ैऔर इसमें आमतौर पर विस्तारित, गरैसंरचनात्मक साक्षात्कार शामिल होते हैं।

•	 विशिष्ट: यह सटीक होती ह ैऔर इसमें संरचनात्मक, औपचारिक साक्षात्कार शामिल होते हैं। खोजपरक रिसर्च चलाने की अपेक्षा विशिष्ट रिसर्च 

चलाना ज़्यादा खर्चीला ह।ै

द्वितीयक रिसर्च

द्वितीयक रिसर्च बाहरी जानकारी का इस्तेमाल करती ह।ै कुछ आम द्वितीयक स्रोत इस तरह हैं:

•	 सार्वजनिक स्रोत: ये आमतौर पर मुफ्त होते हैं और इनमें काफी अच्छी जानकारी होती ह।ै उदाहरण हैं सरकारी विभाग, पब्लिक लाइब्रेरियों के 

व्यवसायिक विभाग आदि।

•	 वाणिज्यिक स्रोत: ये मूल्यवान जानकारी देते हैं मगर आमतौर पर इसका शुल्क लेते हैं। उदाहरण हैं रिसर्च व ट्रेड संघ, बैंक व अन्य वित्तीय  

संस्थान आदि।

•	 शिक्षण संस्थान: ये जानकारी सचूना की एक संपदा पेश करते हैं। उदाहरण हैं कॉलेज, यनूिवर्सिटी, तकनीकी संस्थान आदि।

10.6.1.1 विपणन के 4 Ps

विपणन के 4 Ps निम्नलिखित हैं:

1.	 उत्पाद (Product), 

2.	 कीमत (Price), 

3.	 संवर्धन (Promotion), और 

4.	 स्थान (Place)। 

आइये इन 4 Ps में से प्रत्येक पर विस्तार से विचार करते हैं।

उत्पाद

कोई उत्पाद:

•	 एक मूर्त  माल

•	य ा अमूर्त  सेवा हो सकती है

आपका उत्पाद कुछ भी क्यों न हो, इससे पहले कि आप विपणन प्रक्रिया शुरू करें , आपके लिए स्पष्ट रूप से यह समझ लेना महत्वपरू्ण  ह,ै कि आप क्या 

ऑफर कर रहे हैं, उसकी अनठूी विशेषताएं क्या हैं।

अपने आप से पछूे  जाने वाले कुछ प्रश्न:

•	ग्रा हक की उत्पाद/सेवा से क्या अपेक्षा ह?ै

•	 इससे कौन सी ज़रूरतों की परू्ति  होती ह?ै

•	क्या  कोई अन्य विशेषताएं भी हैं, जिन्हें जोड़ा जा सकता ह?ै

•	क्या  इसमें कोई खर्चीली और अनावश्यक विशेषताएं हैं?

•	ग्रा हक इसका इस्तेमाल किस तरह से करें गे?

•	 इसे क्या नाम दिया जाना चाहिए?

•	य ह समान उत्पादों से किस प्रकार भिन्न ह?ै
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•	 इसके उत्पादन की लागत कितनी होगी?

•	क्या  इसे मुनाफे में बेचा जा सकता ह?ै

कीमत

जब उत्पाद के सभी तत्वों को निर्धा रित कर लिया गया हो, तो कीमत संबंधी घटक पर विचार किया जाना चाहिए। किसी उत्पाद की कीमत अनेक कारकों 

पर निर्भर करेग ी, जसेै लाभ की मात्रा, आपरू्ति , मांग और विपणन कार्यनीति।

अपने आप से पछूे  जाने वाले कुछ प्रश्न:

•	ग्रा हकों के लिए इस उत्पाद/सेवा का मूल्य क्या ह?ै

•	क्या  स्थानीय उत्पादों/सेवाओ ंद्वारा मूल्य बिन्दुओ ंको तय किया गया ह?ै

•	क्या  ग्राहक कीमत के प्रति संवेदनशील ह?ै

•	क्या  छूट दी जानी चाहिए?

•	 आपके प्रतिस्पर्धियों की तुलना में आपके द्वारा तय की गई कीमत कैसी ह?ै

संवर्धन

जब आप अपने उत्पाद और उसकी कीमत के प्रति सुनिश्चित हो जाते हैं, तो अगला चरण होगा इसके संवर्धन पर विचार करना। संवर्धन के कुछ महत्वपरू्ण 

तत्वों में विज्ञापन, जन-संपर्क , सोशियल मीडिया, मार्केटि ग, ईमेल मार्केटि ग, सर्च इंजन मार्केटि ग, वीडियो मार्केटि ग आदि शामिल हैं।

अपने आप से पछूे  जाने वाले कुछ प्रश्न:

•	 आपको अपने उत्पाद या सेवा का संवर्धन कहां करना चाहिए?

•	 अपने लक्ष्य दर्शकगणों तक पहंुचने के लिए प्रयोग किए जाने वाला सर्वश्रेष्ठ माध्यम कौन सा ह?ै

•	 अपने उत्पाद के संवर्धन का सबसे अच्छा समय क्या होगा?

•	 आपके प्रतिस्पर्धी अपने उत्पादों का संवर्धन किस तरह से कर रहे हैं।

स्थान

अधिकांश विपणनकर्ताओ ंके अनुसार, विपणन का आधार सही समयपर, सही जगह पर, सही कीमत पर सही उत्पाद ऑफर करना ह।ै इस कारण से, 

संभावित क्लाइन्ट्स  को वास्तविक क्लाइन्ट्स  में बदलने के लिए सर्वोत्तम संभव स्थान चुनना अत्यंत महत्वपरू्ण  होता ह।ै

अपने आप से पछूे  जाने वाले कुछ प्रश्न:

•	 आपके उत्पाद या सेवा की खोज वास्तविक स्टोर में की जायेगी, ऑनलाइन स्टोर में या फिर दोनों में?

•	 आपको सर्वाध िक उपयुक्त वितरण चनैलों को एक्सेस करने के लिए क्या करना चाहिए?

•	क्या  आपको विक्रय दल (सेल्स फोर्स) की आवश्यकता होगी?

•	 आपके प्रतिस्पर्धी अपने उत्पाद या सेवाएं कहॉ ंसे ऑफर कर रहे हैं?

•	क्या  आपको अपने प्रतिस्पर्धियों के पद चिन्हों पर चलना चाहिए?

•	क्या  आपको अपने प्रतिस्पर्धियों से कुछ हट कर करना चाहिए?

IDEA (आइडिया या विचार) का महत्व

विचार प्रगति का आधार होते हैं। कोई विचार छोटा या अद्वितीय हो सकता ह,ै आसानी से परूा किया जाने वाला हो सकता ह ैया उसे लाग ूकरना बहुत ही 

कठिन हो सकता ह।ै कैसी भी स्थिति क्यों न हो, सच्चाई यह ह ैकि किसी विचार से उसके महत्व का पता लगता ह।ै बिना विचारों के कुछ भी संभव नहीं 

ह।ै अधिकांश लोग अपने विचारों को प्रस्तुत करने से डरते हैं, उन्हें डर होता ह ैकि उनकी हंसी उड़ाई जाएगी। लेकिन, यदि आप एक उद्यमी हैं और प्रतिस्पर्धी 

तथा नवोन्मेषी/उन्नतिशील बने रहना चाहते हैं, तो आपको अपने विचारों को सामने लाना होगा।
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ऐसा करने के कुछ तरीके हैं:

•	 विचार मंथन की संस्कृति  की स्थापना करना जहां पर आप रूचि रखने वाली सभी पक्षों को योगदान के लिए आमंत्रित करते हैं

•	 विचारों पर खुले रूप से चर्चा  करना ताकि लोग उन विचारों के संबंध में अपने विचार, दृष्टिकोण, या राय दे सकें ।

•	 खुले मन-मस्तिष्क वाला बनना और अपने विचारों को सीमित न करना, चाहे कोई विचार बहुत हास्यास्पद ही क्यों न दिखाई दे।

•	कि सी भी ऐसे विचार को न त्यागना जिस पर आप तत्काल काम नहीं करते हैं, अपितु उनका नोट बना कर रखना और उन्हें संजो कर रखना ताकि 

उन पर बाद में कभी विचार किया जा सके।

10.6.1.2 सुझाव 

•	 ध्यान रखें कि अच छ्े  विचार हमेशा ही अनठेू नहीं होते।

•	य ाद रखें कि आपके विचार की सफलता में समय बहुत बड़ी भमूिका निभाता ह।ै

•	स्थितिय ां और परिस्थितियां हमेशा बदलेंगी, इसलिए लोचपरू्ण  रहें और तदनुसार अपने विचार को अनुकूलित करें ।

10.6.2. व्यवसाय इकाई अवधारणाएं: मूलभूत व्यवसाय शब्दावली
यदि आपका उद्देश्य कोई व्यवसाय शुरू करना और उसे चलाना ह,ै तो यह महत्वपरू्ण  ह ैकि आपको मूलभतू व्यवसाय शब्दों की अच्छी समझ होनी हो। हर 

उद्यमी को निम्नलिखित शब्दों की भली भांति जानकारी होनी चाहिए:

•	 लखेांकन: वित्तीय लेनदेनों को रिकार्ड  और रिपोर्ट  करने की व्यवस्थित विधि

•	 लखेा दये: कंपनी द्वारा अपने लेनदारों को देय राशि।

•	 लखेा प्राप्य: क्लाइन्ट्स  द्वारा कंपनी को देय राशि

•	 सम्पत्तियां: कंपनी द्वारा धारित और अपने व्यवसाय को प्रचालित करने के लिए प्रयोग की जाने वाली सभी चीज़ों का मूल्य

•	 तुलन पत्र: कंपनी की संपत्तियों, देयताओ,ं और किसी विशिष्ट समय पर स्वामी की ईक्विटी का सारांश।

•	 बॉटम लाइन: किसी महीने के अंत में व्यवसाय द्वारा अर्जित या गंवाई गई कुल राशि

•	 व्यवसाय: कोई संगठन, जो लाभ अर्जित करने के उद्देश्य से काम करता ह।ै

•	 व्यापार से व्यापार (B2B): कोई व्यवसाय जिसके द्वारा किसी दूसरे  व्यवसाय को माल या सेवाओ ंकी बिक्री की जाती ह।ै

•	 उपभोक्ता से व्यापार (B2C): कोई व्यवसाय जिसके द्वारा अंतिम उपयोगकर्ताओ ंको माल या सेवाओ ंकी बिक्री का जाती ह।ै

•	 पंूजी: किसी व्यवसाय का उसके खातों, सम्पत्तियों तथा निवेशों में लगा धन। दो मुख्य प्रकार की पूंजी में ऋण और ईक्विटी शामिल होते हैं।

•	 नकदी प्रवाह: व्यवसाय में एक महीने के दौरान निधियों की समग्र आवाजाही, जिसमें आय और व्यय शामिल हैं।

•	 नकदी प्रवाह विवरण: समय की किसी विशिष्ट अवधि के दौरान व्यवसाय में आने और जाने वाली पूंजी को दर्शाने वाला विवरण।

•	 ठेका (संविदा): वेतन के लिए काम करने हेतु एक औपचारिक समझौता।

•	 मूल्य ह्रास: समय के साथ किसी सम्पत्ति की कीमत में कमी।

•	 खर्च: किसी व्यवसाय द्वारा अपने प्रचालनों के दौरान वहन की जाने वाली लागतें।

•	व ित्त: धन और अन्य संपत्तियों का प्रबंधन और आवंटन
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10.6.3. CRM और नेटवर्किं ग

•	 वित्तीय रिपोर्ट: व्यवसायिक लेन देनों और व्ययों का व्यापक लेखा-जोखा

•	 नियत लागत: एक बार किया जाने वाला खर्च।

•	 आय विवरण (लाभ और हानि विवरण): किसी समयावधि में व्यवयास की लाभप्रदता को दर्शाता ह।ै

•	 दयेताएं: वह मूल्य जो व्यवसाय द्वारा किसी दूसरे  को देय होता ह।ै

•	 विपणन: उत्पाद या सेवा के संवर्धन, विक्रय और वितरण की प्रक्रिया।

•	निवल  आय/लाभ: राजस्व घटा व्यय।

•	 निवल संपत्ति: व्यवसाय की कुल कीमत

•	 पेबकै (चुकौती) अवधि: व्यवसाय में किए गए निवेश की वसलूी में लगने वाला समय।

•	 लाभ मार्जिन: लाभ का अनुपात, जिसे राजस्व द्वारा विभाजित किया जाता ह ैऔर प्रतिशत के रूप में दर्शाया जाता ह।ै

•	 निवेश प्रतिफल (ROI): व्यवसाय द्वारा निवेश पर प्रतिफल के रूप में प्राप्त की जाने वाली राशि।

•	 राजस्व: व्ययों को घटाने से परू्व  आय की कुल राशि।

•	 विक्रय संभावना: एक संभावित ग्राहक।

•	 आपूर्तिकर्ता: व्यवसाय को आपरू्तियों का प्रदाता।

•	 लक्षित बाज़ार: ग्राहकों का एक विशिष्ट समूह जिनके लिए कंपनी के उत्पाद और सेवाएं लक्षित होती हैं।

•	 मूल्यन: व्यवसाय की कुल संपत्ति का समग्र अनुमान।

•	व िचलनशील लागत: व्यवसाय की गतिविधि के अनुपात में परिवर्तित होने वाले व्यय।

•	 कार्यशील पंूजी: मौजदूा सम्पत्तियां घटा चाल ूदेयताओ ंके आधार पर परिकलित।

CRM क्या ह?ै

CRM का अर्थ ह ैग्राहक संबंध प्रबंधन मूल रूप से ग्राहक संबंध प्रंबंधन का आशय ग्राहकों के साथ अपने संबंधों का प्रबंधन करना था। लेकिन, वर्तमान में, 

इसका आशय IT प्रणालियां और सॉफ्टवेयर से ह ैजिनका डिज़ाइन कंपनियों द्वारा अपने संबंधों के प्रबंधन के लिए किया जाता ह।ै

CRM की आवश्यकता

कंपनी द्वारा अपने ग्राहकों के साथ जितने अच छ्े  तरीके से अपने संबंधों का प्रबंधन किया जाएगा, कंपनी की सफलता की संभावनाएं उतनी ही अधिक 

होंगी। किसी उद्यमी के लिए, मौजदूा ग्राहकों को सफलतापरू्वक अपने साथ बनाए रखना और उद्यम का विस्तार बहुत अधिक महत्वपरू्ण  होता ह।ै इसी कारण 

से ऐसी IT प्रणालियों, जिनमें ग्राहकों के साथ व्यवहार करने से जुड़ी समस्याओ ंका समाधान दनैिक आधार पर किया जाता ह,ै की मांग बढ़ती जा रही ह।ै

ग्राहक समय के साथ साथ परिवर्तन अपेक्षित होता ह,ै और प्रौद्योगिकी से वास्तव में यह समझना आसान बनाया जा सकता ह ैकि ग्राहक वास्तव में चाहते 

क्या हैं। इस अंतर्ज्ञान से कंपनियों को अपने ग्राहकों की ज़रूरतों के प्रति अधिक प्रतिक्रियाशील होने में सहायता मिलती ह।ै इससे वे ज़रूरत होने पर अपने 

व्यवसाय को बदल पाने में समर्थ होते हैं, ताकि उनके ग्राहकों को संभवत: सर्वश्रेष्ठ रूप से सेवाएं प्रदान की जा सकें । सरल शब्दों में कहा जाए तो CRM 

से कंपनियों को अपने ग्राहकों के मूल्य को स्वीकार करने में सहायता मिलती ह ैऔर वे उन्नत ग्राहक संबंधों का दोहन कर सकने में सक्षम हो पाती हैं।

CRM के लाभ

CRM के अनेक महत्वपरू्ण  लाभ होते हैं:

•	 इससे मौजदूा ग्राहकों के साथ संबंधों में सुधार करने में सहायता मिलती ह ैजिसके परिणाम स्वरूप:

»	बिक्री  में बढ़ोतरी होती है
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»	ग्रा हक की आवश्यकताओ ंकी पहचान हो पाती है

»	 उत्पादों का क्रॉस विक्रय संभव हो पाता है

•	 इससे आप अपने उत्पादों या सेवाओ ंका बेहतर विपणन कर सकते हैं।

•	 इससे ग्राहक की संतुष्टि और उसे अपने साथ बनाए रखने में सुधार होता ह।ै

•	 इससे सर्वाध िक लाभदायक ग्राहकों की पहचान करके और उन पर ध्यान केन्द् रित करके लाभप्रदता में सुधार होता ह।ै

6.3.3.1 नेटवर्किं ग क्या ह?ै
व्यवसाय में, नेटवर्किंग  का अर्थ ह ैअपने व्यवसाय और व्यक्तिगत कनेक्शनों का दोहन करना ताकि नए कारोबार की नियमित आपरू्ति  प्राप्त की जा सके। 

मार्केटि ग की यह विधि प्रभावी और साथ ही निम्न लागत वाली होती ह।ै यह विक्रय के अवसरों और संपर्कों का विकास करने का शानदार तरीका ह।ै 

नेटवर्किंग , रे फरल्स और परिचयों पर निर्भर हो सकती ह ैया ऐसा फोन, ईमेल, सामाजिक और व्यवसायिक नेटवर्किंग  वेबसाइट्स के माध्यम से किया जा 

सकता ह।ै

नेटवर्किं ग की आवश्यकता

कारोबार से जुड़े  लोगों के लिए नेटवर्किंग  एक अनिवार्य  व्यक्तिगत कौशल ह,ै लेकिन यह उद्यमियों के लिए उससे भी कहीं अधिक महत्वपरू्ण  ह।ै नेटवर्किंग  

की प्रक्रिया की जड़ें, रिश्तों के सजृन से जुड़ी हैं। नेटवर्किंग  के परिणामस्वरूप विस्तारित संचार संभव होता ह ैऔर उद्यमिता ईकोसिस्टम में एक सशक्त 

उपस्थिति को दर्ज किया जाता ह।ै इससे दूसरे  उद्यमियों के साथ मजबूत रिश्ते बनाने में मदद मिलती ह।ै

परूी दुनिया में होने वाले बिजनेस नेटवर्किंग  आयोजन, समान सोच रखने वाले उद्यमियों, जो संचार, विचार विनिमय और सोच को वास्तविकता में बदलने 

के लिए समान मूलभतू मान्यताओ ंको साझा करते हैं, को आपस में एक-दूसरे  से जोड़ने में बहुत बड़ी भमूिका निभाते हैं। इस प्रकार के नेटवर्किंग  कार्यक्रमों 

द्वारा संभावित निवेशकों के साथ उद्यमियों को जोड़ने में भी अति महत्वपरू्ण  भमूिका निभाई जाती ह।ै उद्यमी व्यापक रूप से भिन्न अनुभव और पषृ्ठभमूियों 

वाले हो सकते हैं, लेकिन उन सभी के मन में एक समान लक्ष्य होता ह ै- वे सभी सम्पर्क , प्रेरणा, सलाह, अवसर और विश्वसनीय सलाहकार चाहते हैं। 

नेटवर्किंग  से उन्हें ऐसा करने का एक मंच प्राप्त हो जाता ह।ै नेटवर्किंग  के लाभ

उद्यमियों को नेटवर्किंग  से असंख्य लाभ प्राप्त होते हैं कुछ बड़े लाभ निम्नलिखित हैं:

•	 उच्च-स्तरीय लीड्स प्राप्त होती हैं

•	 कारोबार के अधिक अवसर मिलते हैं

•	 उपयुक्त कनेक्शनों के लिए बेहतर स्रोत

•	 एक समान सोच वाले उद्यमियों से सलाह की प्राप्ति

•	भ ावी परिदृश्य का अनुमान और आपके प्रोफाइल का संवर्धन

•	 सकारात्मक और उत्साही लोगों से मुलाकात

•	 आत्मविश्वास में बढोतरी

•	 दूसरे  की सहायता से मिलने वाली संतुष्टि

•	 सशक्त और स्थाई मित्रता की स्थापना

10.6.3.2 सुझाव 
•	 आवश्यकताओ ंकी पहचान करने और फीडबकै प्राप्त करने के लिए सोशियल मीडिया इंटरैक्शन्स का प्रयोग करें

•	 नेटवर्किंग  करते समय, हां/नहीं जसेै प्रश्नों की बजाए, खुले प्रश्न पछूें



345344

प्रतिभागी पुस्तिका

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

10.6.4 व्यवसाय योजना: लक्ष्य क्यों निर्धारित किए जाएं

10.6.4.1 व्यवसाय योजना के तत्व

लक्ष्यों को तय करना महत्वपरू्ण  होता ह ैक्योंकि इससे आपको दीर्घकालिक विज़न और अल्पकालिक प्रेरणा प्राप्त होती ह।ै लक्ष्य अल्पकालिक, मध्यावधि 

और दीर्घकालिक हो सकते हैं।

अल्पकालिक लक्ष्य

•	य ह तात्कालिक भविष्य के लिए विशिष्ट लक्ष्य होते हैं। उदाहरण: खराब हो चुकी मशीन की मरम्मत कराना। मध्यम अवधि लक्ष्य

•	ये  लक्ष्य आपके अल्पकालिक लक्ष्यों पर निर्मित होते हैं।

•	 इनका आपके अल्पकालिक लक्ष्यों की तरह इतना अधिक विशिष्ट होना ज़रूरी नहीं ह।ै

उदाहरण: सेवा समझौते की व्यवस्था करना ताकि यह सुनिश्चित किया जा सके कि आपकी मशीन फिर से खराब नहीं होती ह।ै

दीर्घकालिक लक्ष्य

इन लक्ष्यों के लिए समय और नियोजन की आवश्यकता होती ह।ै आमतौर पर इन्हें प्राप्त करने में एक वर्ष  या अधिक समय लगता ह।ै

उदाहरण: अपने खर्चों की योजना बनाना ताकि आप नई मशीनों को खरीद सकें ।

व्यवसाय योजना क्यों तयैार की जाए

व्यवसाय योजना, यह समझने का एक साधन ह ैकि अपने कारोबार को संजो कर कैसे रखा जाए। इसका प्रयोग प्रगति पर नज़र रखने, की निगरानी 

करने, जवाबदेही को बढ़ावा देने और कारोबार के भविष्य को नियत्रित करने के लिए किया जा सकता ह।ै आमतौर पर इसके द्वारा 3-5 वर्ष  का परू्वानुमान 

प्राप्त होता ह ैऔर इसमें उस योजना को रे खांकित किया जाता ह,ै जिसे कंपनी अपना राजस्व बढ़ाने के लिए अमल में लाना चाहती ह।ै महत्वपरू्ण  कर्मचारियों 

या भावी निवेशकों की अभिरूचि को प्राप्त करने के लिए भी व्यवसाय योजना एक महत्वपरू्ण  साधन ह।ै

विशिष्ट रूप से व्यवसाय योजना में आठ तत्व शामिल होते हैं।

कार्यकारी सारांश

कार्यकारी सारांश टाइटल पषृ्ठ के अनुसार ह।ै सारांश में, कारोबार स्वामी के रूप में और कारोबार जसेै स्वरूप में आपकी इच्छाओ ंका संक्षिप्त में स्पष्ट 

वर्णन किया जाना चाहिए। यह आपके व्यवसाय और आपकी योजनाओ ंकी समीक्षा ह।ै आदर्श रूप से यह 1-2 पषृ्ठों से ज़्यादा नहीं होना चाहिए।

आपके कार्यकारी सारांश में निम्नलिखित शामिल होना चाहिए:

•	मि शन वक्तव्य: समग्र रूप से अपने व्यवयास के स्वरूप को समझाना।

उदाहरण: Nike का मिशन वक्तव्य

Nike का मिशन वक्तव्य, “दुनिया के प्रत्येक खिलाड़ी में प्रेरणा और इनोवेशन का विकास करना।”

•	 कंपनी जानकारी: इसमें यह जानकारी निहित होती ह ै कि आपके व्यवसाय की स्थापना कब की गई थी, संस्थापकों के नाम और भमूिकाएं, 

कर्मचारियों की संख्या, आपके कारोबार का स्थान आदि।

•	 विकास संबंधी विशिष्ट तथ्य: कंपनी के विकास के उदाहरणों का उल्लेख करें । जहां भी संभव हो वहां ग्राफ्स और चार्ट्स का इस्तेमाल करें ।

•	 आपके उत्पाद/सेवाएं: प्रदान किए जाने वाले उत्पादों तथा सेवाओ ंका वर्णन करें ।

•	 वित्तीय जानकारी: मौजदूा बैंक और निवेशकों की जानकारी प्रदान करना।

•	 भावी योजनाओ ंको सारांश रूप से प्रस्तुत करें : वर्णन करें  कि आप भविष्य में अपने कारोबार के बारे  में क्या अभिकल्पना करते हैं।

व्यवसाय विवरण

आपकी व्यवयास योजना के दूसरे  खण्ड में आपके कारोबार के विभिन्न तत्वों की विस्तृत समीक्षा उपलब्ध कराई जानी चाहिए। इससे संभावित ग्राहकों 

को आपकी व्यावसायिक योजना और आपकी पेशकशों की विशिष्टता को सही-सही समझने में मदद मिलेगी।
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आपके व्यावसायिक विवरण में निम्नलिखित तथ्य शामिल होने चाहिए:

•	 आपके व्यवसाय की प्रकृति का वर्णन

•	 वे बाज़ार आवश्यकताएं जिन्हें आप संतुष्ट करने का लक्ष्य रखते हैं

•	 आपके उत्पादों और सेवाओ ंद्वारा इन आवश्यकताओ ंको किस तरह से परूा किया जाता ह।ै

•	 वे विशिष्ट उपभोक्ता और संगठन जिन्हें आप सेवाएं प्रदान कराने का इरादा रखते हैं।

•	 आपके विशिष्ट प्रतिस्पर्धात्मक लाभ

बाज़ार विश्लेषण

बाज़ार विश्ले षण खण्ड आमतौर पर व्यावसायिक विवरण के बाद आता ह ैइस खण्ड़ का उद्देश्य आपके उद्योग और बाज़ार जानकारी या ज्ञान को दिखाना 

होता ह।ै यह वह खण्ड ह ैजहां पर आपको अपने शोध परिणामों और निष्कर्षों को दर्शाना चाहिए।

आपके बाज़ार विश्ले षण में निम्नलिखित शामिल होने चाहिए:

•	 आपका उद्योग विवरण और परिप्रेक्ष्य (आउटलुक)

•	 आपके लक्षित बाज़ार से संबंधित जानकारी

•	 आपके लक्ष्य दर्शकगण की आवश्यकताएं और जनसांख्यिकी

•	 आपके लक्षित बाज़ार का आकार

•	 आप कितने मार्के ट शेयर पर कब्जा करना चाहते हैं।

•	 आपकी कीमत संबंधी संरचना

•	 आपका प्रतिस्पर्धात्मक विश्ले षण

•	 कोई विनियामक अपेक्षाएं

संगठन और प्रबंधन

यह खण्ड बाज़ार विश्ले षण के तत्काल बाद आना चाहिए। आपके संगठन और प्रबंधन खण्ड में निम्नलिखित शामिल होना चाहिए:

•	 आपकी कंपनी का संगठनात्मक ढांचा

•	 आपकी कंपनी के स्वामित्व का ब्यौरा

•	 आपके प्रबंधन दल का ब्यौरा

•	 आपके निदेशकों की योग्यता

•	 प्रत्येक डिविज़न /विभाग का विस्तृत विवरण और इसके कार्य

•	 आपके द्वारा अपने कर्मचारियों को दिया जाने वाला वेतन और लाभ

•	 आपके द्वारा प्रदान किए जाने वाले प्रोत्साहन (इंसेन्टिव्स)

सेवा या उत्पाद लाइन

अगला खण्ड सेवा या उत्पाद लाइन खण्ड ह।ै यहां पर आप अपनी सेवा या उत्पाद का वर्णन करते हैं, संभावित और मौजदूा ग्राहकों को मिलने वाले लाभों 

पर बल देते हैं। विस्तार से समझाएं कि आपके उत्पाद की पसंद से क्या आपके लक्षित ग्राहकों की आवश्यकताओ ंकी परू्ति  होगी।

आपके सेवा और उत्पाद लाइन खण्ड में निम्नलिखित शामिल होना चाहिए:

•	 आपके उत्पाद/सेवा का वर्णन

•	 आपके उत्पाद या सेवा के जीवन चक्र का वर्णन

•	कि सी कॉपीराइट या पेटेन्ट आवेदन की सचूी
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•	कि सी R &D गतिविधि का विवरण जिसमें आप शामिल हैं अथवा शामिल होने की योजना रखते हैं।

विपणन और विक्रय

एक बार जब आपकी योजना का सेवा या उत्पाद लाइन खण्ड परूा हो जाता ह,ै तो आपको अपने व्यवसाय के लिए विपणन और विक्रय प्रबंधन कार्यनीति 

के वर्णन पर कार्य  आरम्भ करना चाहिए।

आपके विपणन खण्ड में निम्नलिखित कार्यनीतियां शामिल होनी चाहिएं:

•	 बाज़ार पठै कार्यनीति: इस कार्यनीति में मौजदूा बाजारों में आपके मौजदूा उत्पादों या सेवाओ ंको बेचने पर ध्यान केन्द् रित किया जाता ह,ै ताकि 

आपके मार्के ट शेयर हिस्से को बढ़ाया जा सके।

•	 विकास कार्यनीति: इस कार्यनीति में मार्के ट शेयर को बढ़ाने पर ध्यान केन्द् रित किया जाता ह,ै चाहे इससे अल्पावधि में आय में कमी ही क्यों न हो।

•	 वितरण के चनैल कार्यनीति: ये थोक विक्रे ता, खुदरा विक्रे ता, वितरक और इंटरनेट भी हो सकते हैं।

•	 संचार कार्यनीति: ये लिखित कार्यनीतियां (ई-मेल, पाठ, चटै), मौखिक कार्यनीतियां (फोन काल्स, वीडियो काल्स, आमने सामने बठै कर  

बातचीत करना), गरै मौखिक कार्यनीतियां (भाव भंगिमाएं, चेहरे  के भाव, स्वर का लहज़ा) और दृश्यिक कार्यनीतियां (संकेत, वेबपषृ्ठ, उदाहरण) हो 

सकती हैं।

आपके विक्रय खण्ड में निम्नलिखित जानकारी होनी चाहिए:

•	 कार्यबल कार्यनीति: इस कार्यनीति में उद्यम के राजस्व को बढ़ावा देने पर ध्यान केन्द् रित किया जाता ह।ै

•	 आपकी विक्रय संबंधित गतिविधियों का विवरण (ब्रेकडाउन): इसका अर्थ विस्तार से यह तय करना ह,ै कि आप अपने उत्पादों और सेवाओ ंको 

किस प्रकार से बेचने का इरादा रखत ेहैं - क्या आप इसे ऑफलाइन या ऑनलाइन बेचेंगे, आप कितने यनूिट्स को बेचने का इरादा रखते हैं, आपकी 

प्रत्येक यनूिट को किस कीमत पर बेचने की योजना हैं, आदि.

वित्तपोषण अनुरोध

यह खण्ड विशिष्ट रूप से उन लोगों के लिए ह ैजिन्हें अपने उद्यम के लिए वित्त पोषण की आवश्यकता होती ह।ै वित्त पोषण खण्ड में निम्नलिखित जानकारी 

शामिल होनी चाहिए:

•	 वर्तमान में आपको कितना वित्त पोषण चाहिए।

•	 अगले पांच वर्षों के दौरान आपको कितना वित्त पोषण चाहिये होगा। यह आपके दीर्घकालिक लक्ष्यों पर निर्भर करेग ा।

•	 आप किस प्रकार का वित्त पोषण चाहते हैं और आप इसका कैसे प्रयोग करने की योजना रखते हैं। क्या आपको ऐसा वित्त पोषण चाहिए जिसका प्रयोग 

केवल विशिष्ट उद्देश्य के लिए किया जा सके, या वह वित्त-पोषण जिसका प्रयोग किसी भी आवश्यकता के लिए किया जा सके?

•	भ विष्य के लिए कार्यनीतिक योजनाएं इसमें आपकी दीर्घकालिक योजनाओ ं का विस्तृत विवरण शामिल होगा - ये योजनाएं क्या हैं, और इन 

योजनाओ ंको लाग ूकरने के लिए आपको कितने पसेै की ज़रूरत होगी।

•	 ऐतिहासिक और भावी वित्तीय जानकारी ऐसा आपके समस्त वित्तीय रिकार्ड्स को तयैार करके और उन्हें बनाए रख कर किया जा सकता ह,ै जिसकी 

शुरूआत आपके द्वारा उद्यम को शुरू करने से लेकर आज तक के वित्तीय रिकार्ड्स को तयैार करने से होती ह।ै इसके लिए अपेक्षित दस्तावेज़ों में 

आपका तुलन पत्र जिसमें आपकी कंपनी की सम्पत्तियों और देयताओ ंका ब्यौरा शामिल होता ह,ै आपका आय विवरण जिसमें आपकी कंपनी के 

राजस्व, व्यय और वर्ष  के लिए निवल आय को सचूीबद्ध किया जाता ह,ै आपकी कर विवरणियां (आम तौर पर पिछले तीन वर्ष  की) और आपका नकदी 

प्रवाह बजट शामिल होता ह ैजिसमें आने वाली नकदी, और बाहर जाने वाली नकदी का वर्णन किया जाता ह ैऔर यह उल्लेख किया जाता ह ैकि क्या 

आपके पास महीने के अंत में नकदी की कमी ह ै(नकारात्मक शेष) ह ैअथवा अधिशेष (सकारात्मक शेष) ह।ै

वित्तीय नियोजन

इससे पहले की आप अपने उद्यम का निर्माण करने की शुरूआत करें , आपको अपने वित्त आदि की योजना बनानी होती ह।ै वित्तीय नियोजन के चरणों पर 

ध्यान दें:

•	 चरण 1: वित्तीय योजना तयैार करें  इसमें आपके लक्ष्य, कार्यनीतियां और इन लक्ष्यों को परूा करने के लिए समयावधियां शामिल होनी चाहिए।

•	 चरण 2: अपने सभी महत्वपरू्ण  वित्तीय दस्तावेजों की व्यवस्था करें  अपने निवेश ब्यौरे , बैंक विवरण, कर संबंधी कागज़ात, क्रेडि ट कार्ड  बिल्स, बीमा 

संबंधी कागज़ात और किसी भी अन्य वित्तीय रिकार्ड  को फाइल में संजो कर रखें।
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•	 चरण 3: अपनी निवल संपत्तियों का परिकलन करें  इसमें अपनी स्वय की सम्पत्तियों (सम्पत्तियां जसेै घर, बैंक खाते, निवेश आदि) का परिकलन 

करना और उसमें से आपके द्वारा देय राशियां (देयताएं जसेै ऋण, लंबित क्रेडि ट कार्ड  विवरण आदि) को घटाया जाना होता ह,ै और इसे बाद जो शेष रह 

जाता ह ैवह आपकी निवल सम्पत्तियां होती हैं।

•	 चरण 4: व्यय करने की योजना तयैार करें  इसका अर्थ ह ैकि विस्तार से यह लिखे कि आपका पसैा कहां से आएगा और कहां जाएगा।

•	 चरण 5: आपातकालीन निधि बनाएं एक अच्छी आपातकालीन निधि में इतना धन शामिल होता ह ैजिससे कम से कम 6 महीनों के खर्चों को कवर 

किया जा सके।

•	 चरण 6: अपना बीमा निर्धा रित करें । बीमा से दीर्घकालिक वित्तीय सुरक्षा मिलती ह ैऔर आपको जोखिमों के विरूद्ध सुरक्षा प्राप्त होती ह।ै

जोखिम प्रबंधन

उद्यमी के रूप में, आपके लिए यह महत्वपरू्ण  ह ैकि आप जिस प्रकार के उद्यम की शुरूआत करना चाहते हैं, उससे जुड़े जोखिमों का मूल्यांकन करें , इससे 

पहले की आप कंपनी की स्थापना करें । आपके द्वारा जब संभावित जोखिमों की पहचान कर ली जाती ह,ै आप उन्हें कम करने के लिए कदम उठा सकते 

हैं। जोखिमों का प्रंबधन करने के कुछ तरीके निम्नलिखित हैं:

•	 समान कारोबारों पर शोध करें  और उनके जोखिमों का पता लगाएं और यह जानकारी प्राप्त करें  कि उन्हें कैसे न्यूनतम किया गया ह।ै

•	 मौजदूा बाज़ार रूझानों का मूल्यांकन करें  और यह पता लगाएं कि क्या इसी प्रकार के उत्पाद और सेवाएं, जिन्हें कुछ समय पहले पेश किया गया था, 

उन्हें आज भी लोगों द्वारा परू्ण  रूप से स्वीकार किया जा रहा ह ैया नहीं।

•	 इस बात पर विचार करें  कि क्या आप अपने उत्पाद या सेवा को पेश करने के लिए वास्तव में अपेक्षित विशेषज्ञता रखते हैं।

•	 अपने वित्त की जांच करें  और देखें कि क्या आपके पास उद्यम को शुरू करने के लिए पर्याप्त आमदनी ह।ै

•	 अर्थव्यवस्था की मौजदूा स्थिति के प्रति जागरूक रहें, विचार करें  कि समय के साथ अर्थव्यवस्था में कैसे परिवर्तन हो सकता ह,ै और इस बात पर 

विचार करें  कि इनमें से किसी भी परिवर्तन से आपका उद्यम किस प्रकार से प्रभावित हो सकता ह।ै

•	 विस्तृत व्यवयास योजना तयैार करें

10.6.4.2 सुझाव 
•	 सुनिश्चित करें  कि आपकी योजना में समस्त महत्वपरू्ण  तत्वों को कवर किया जाये।

•	 ऑकंड़ों की डेटा की गहन जॉचं कर लें।

•	 संक्षिप्तता बरतें और यर्थार्थवादी रहें।

•	 अपनी कार्यप्रणाली और परू्वानुमान के संबंध में सतर्क ता बरते (अनुदारवादी रहें)

•	 जहां कहीं संभव हो विज़ुअल्स जसेै चार्ट्स, ग्राफ्स और छवियों का प्रयोग करें

10.6.5 बैंक वित्त पोषण के लिए प्रक्रिया और औपचारिकताएं
बैंक वित्त पोषण की आवश्यकता

उद्यमियों के सामने सबसे कठिन चुनौती स्टार्टअप्स के लिए फंड जुटाने की होती ह।ै उपलब्ध विभिन्न वित्त पोषण विकल्पों के साथ, उद्यमियों को इस बात 

पर गहन विचार करना होता ह ैकि उनके लिए कौन सी वित्त पोषण विधि सर्वश्रेष्ठ रहेगी। भारत में, बैंक स्टार्टअप्स के लिए सबसे बड़े वित्त पोषक हैं, और 

वे ही प्रतिवर्ष हजारों स्टार्टअप्स का वित्त पोषण करते हैं।
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10.6.5.2 बैंक द्वारा ऋण प्रदान करने के मानदण्ड

10.6.5.1 उद्यमियों को वित्त पोषण के लिए बैंक को कौन सी जानकारी दनेी चाहिए
बैंक से संपर्क  करते समय, उद्यमियों को उन विभिन्न मानदण्डों की स्पष्ट जानकारी होनी चाहिए जिनका प्रयोग बैंक द्वारा ऋण आवेदनों की स्क्रीनिग, 

रेटि ग और प्रसंस्करण करने के लिए किया जाना ह।ै उद्यमियों को बैंक को सटीक और सही जानकारी प्रदान करने के महत्व के प्रति भी जागरूक होना 

चाहिए। वित्तीय संस्थानों के लिए पहले की अपेक्षा अब ऋण आवेदकों के चकू संबंधी व्यवहार का पता लगाना बहुत ही आसान हो चुका ह।ै बैंक से वित्त 

पोषण की अपेक्षा करने वाले उद्यमियों को अपनी सामान्य जानकारी, वित्तीय स्थिति और गांरटी या समपार्श्विक (कोलॅट्रल्स) आदि, जिसे वे उपलब्ध करा 

सकते हैं, के बारे  में जानकारी प्रदान करनी चाहिए।

सामान्य जानकारी

यहां पर आप, एक उद्यमी के रूप में, बैंक को अपने बकैग्राउंड की जानकारी दे सकते। इस प्रकार की जानकारी में निम्नलिखित शामिल होता ह:ै

•	 परिचय पत्र: इस पत्र को एक सम्मानीय कारोबारी व्यक्ति द्वारा लिखा जाना चाहिए जो आपको भली भांति जानता ह ैताकि वह आपका परिचय दे 

सके। इस पत्र का लक्ष्य आपकी उपलब्धियों को गिनाना ह ैऔर आपके चरित्र और सत्यनिष्ठा का सत्यापन करना ह।ै

•	 आपका प्रोफाइल: मूल रूप से यह आपका जीवन-वतृ ह।ै आपको बैंक को अपनी शकै्षणिक उपलब्धियों, पेशेवर प्रशिक्षण, योग्यताओ,ं रोज़गार 

रिकार्ड्स और उपलब्धियों का उपयुक्त ब्यौरा प्रदान करना होता ह।ै

•	 बिजनेस ब्रोशर (विवरणिका): विशिष्ट रूप से किसी व्यवसाय विवरणिका में कंपनी के उत्पादों, क्लाइन्ट्स , कारोबार कितने समय से किया जा 

रहा ह,ै आदि की जानकारी प्रदान की जाती ह।ै

•	 बैंक और अन्य संदर्भ: यदि आपका किसी अन्य बैंक में खाता ह,ै तो इन बैंक विवरणों को प्रदान करना एक अच्छी बात होगी।

•	 कंपनी के स्वामित्व या पंजीकरण की जानकारी: कुछ मामलों में, आपको कंपनी के स्वामित्व और पंजीकरण का साक्ष्य देना पड़ सकता ह।ै 

सम्पतियों और देयताओ ंकी सचूी की भी ज़रूरत हो सकती ह।ै

वित्तीय स्थिति

बैंक आपके उद्यम की मौजदूा वित्तीय स्थिति की जानकारी की अपेक्षा कर सकते हैं। आपके द्वारा तयैार की जाने वाली मानक वित्तीय रिपोर्ट्स में 

निम्नलिखित जानकारी शामिल होनी चाहिए:

•	 तुलन पत्र	

•	 लाभ और हानि खाता

•	 नकदी प्रवाह विवरण	

•	 अनुमानित बिक्री और राजस्व

•	 व्यापार योजना	

•	 संभाव्यता अध्ययन

गारंटी या समपार्श्विक

आमतौर पर बैंक आपको बिना सिक्योरिटी के ऋण देने से इंकार कर देंगे। आप सिक्योरिटी के तौर पर सम्पत्तियां दे सकते हैं और यदि आप ऋण की चुकौती 

करने मे विफल रहते हैं तो बैंक उन्हें जब्त कर सकते हैं और बेच सकते हैं। नियत सम्पत्तियां जसेै मशीनरी, उपकरण, वाहन आदि पर ऋण की सिक्योरिटी 

के लिए विचार किया जा सकता ह।ै

यदि आप निम्नलिखित उधार देने के मानदण्डों को परूा कर सकते हैं, तो वित्त पोषण के आपके अनुरोध को मंजरू किए जाने की उच्चतर संभावनाएं होती हैं:

•	 बेहतर नकदी प्रवाह

•	 पर्याप्त शेयरधारक निधियां

•	 पर्याप्त सिक्योरिटी
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•	 कारोबार में अनुभव

•	 अच्छी प्रतिष्ठा

प्रक्रिया

वित्त पोषण हेतु आवेदन करने के लिए निम्नलिखित प्रक्रिया का पालन किया जाना चाहिए।

•	 अपने आवेदन प्रपत्र और अन्य सभी अपेक्षित दस्तावेजों को बैंक में प्रस्तुत करें ।

•	 बैंक द्वारा आपकी उधार पात्रता का सावधानीपरू्वक आकलन किया जाएगा और प्रबंधन, वित्त, प्रचालन, और औद्योगिक जानकारी और विगत ऋण 

निष्पादन जसेै परैामीटर्स का विश्ले षण करके आपको रेटि ग प्रदान की जाएगी।

•	 बैंक द्वारा निर्णय किया जाएगा कि क्या आपको वित्त पोषण दिया जाए अथवा नहीं।

10.6.5.3 सुझाव 
•	 अनुभवी बैंकर्स से वित्त पोषण विकल्पों के बारे  में सलाह प्राप्त करें ।

•	 सजग रहें और जितनी आपको आवश्यकता ह,ै उससे अधिक उधार न लें, न ही अपनी आवश्यकता से अधिक लंबी अवधि के लिए उधार लें और इसके 

लिए अपनी सुविधा से परे  उच्च ब्याज दर भी उधार लेने से बचें।

10.6.6 उद्यम प्रबंधन- एक समीक्षा

अपने उद्यम का प्रभावशाली रूप से प्रबंधन करने के लिए, आपको विभिन्न पहलुओ ंपर विचार करना होगा जिसमें दिन प्रतिदिन की गतिविधियां के प्रबंधन 

से लेकर, किसी बड़ी घटना का प्रबंधन शामिल ह।ै अपनी कंपनी के प्रभावी प्रबंधन के लिए आइये कुछ सरल चरणों पर विचार करते हैं।

चरण 1: अपने लीडरशिप (नेततृ्व) कौशल का प्रयोग करें  और जब भी अपेक्षित हो, सलाह प्राप्त करें ।

आइये रामू के उदाहरण पर विचार करते हैं, एक उद्यमी जिसने अभी हाल ही में अपना व्यवसाय शुरू किया ह।ै रामू के पास अच्छा लीडरशिप कौशल ह ै- वह 

ईमानदार ह,ै अच छ्े  से बातचीत करता ह,ै यह भी जानता ह ैकि काम को किस प्रकार से विभाजित किया जाए आदि। इन लीडरशिप कौशल से सुनिश्चित रूप 

से रामू को अपने उद्यम के प्रबंधन में सहायता मिलेगी। लेकिन, कभी कभी रामू को ऐसी स्थितियों का सामना करना पड़ता ह ैजिनकी हैंडलिग के बारे  में 

वह निश्चित रूप से नहीं जानता। रामू को ऐसी स्थिति में क्या करना चाहिए? उसके लिए एक समाधान यह ह ैकि उसे अपने से अधिक अनुभवी मनेैजर का 

पता लगाना चाहिए जो उसका मार्गदर्शन कर सके। रामू के लिए दूसरा समाधान यह ह ैकि वह अपने ही नेटवर्किंग  कौशल का इस्तेमाल करे  ताकि वह 

दूसरे  संगठनों के मनेैजर्स से संपर्क  कर सके, जो उसे इस प्रकार की स्थितियों के बारे  में कार्र वाई करने के बारे  में सलाह दे सकते हैं।

चरण 2: अपने कार्यों को दूसरों में बांट दें- इस तथ्य को समझ लें कि आप हर काम स्वयं नहीं कर सकत ेहैं।

यहां तक कि इस दुनिया में सर्वाध िक कुशल मनेैजर वह हर काम स्वय नहीं कर पाएगा जिसकी उससे उद्यम द्वारा मांग या आशा की जाती ह।ै किसी 

समझदार मनेैजर को यह समझना होता ह ैकि उसके उद्यम के प्रबंधन के पीछे  सर्वाध िक महत्वपरू्ण  बात यह ह ैकि उसे अपने आसपास के लोगों के बीच 

में अपने कार्य  का विभाजन करना चाहिए। इसे डेलिगेशन कहा जाता ह:ै लेकिन डेलिगेशन पर्याप्त नहीं ह।ै यदि कोई मनेैजर बेहतर परिणाम चाहता ह,ै तो 

उसे प्रभावी रूप से कार्य  विभाजन करना चाहिए. यह महत्वपरू्ण  ह ैक्योंकि जब विभाजन गलत तरीके से किया जाता ह,ै तो परिणाम स्वरूप आपके लिए 

और अधिक काम भी पदैा हो सकता ह।ै प्रभावी रूप से कार्य  विभाजन के लिए, आपको दो सचूियां तयैार करते हुए काम शुरू करना चाहिए। एक सचूी में 

वह काम होने चाहिए जिनके बारे  में आप जानते हैं कि आप स्वय उनकी देखभाल कर सकते हैं। दूसरी सचूी में वे बातें शामिल होनी चाहिए जिनके बारे  में 

आपको विश्वास ह ैकि उनका प्रबंधन और रख रखाव करने के लिए उन्हें दूसरों को दिया जा सकता ह।ै गलत कार्य  विभाजन के अलावा, एक अन्य मुद्दा 

पदैा हो सकता ह ैजिसे आवश्यकता से अधिक डेलीगेशन कहा जाता ह।ै इसका अर्थ ह ैकि अपने बहुत से कार्यों को दूसरों को दे देना। इसके साथ समस्या 

यह ह ैकि जितने अधिक कार्य  आप डेलीगेट करते हैं, उतना ही अधिक समय आपको, उन लोगों के कार्य  की प्रगति को ट्रैक करने और उसकी निगरानी 

करने में लग जाता ह,ै जिनको आपने यह कार्य  सौंपे थे। इससे आपके पास अपने काम को परूा करने के लिए बहुत ही कम समय बचेगा।
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10.6.6.1 सुझाव 

10.6.7.20 उद्यमशीलता पर विचार करना

चरण 3: काम पर सही व्यक्तियों की नियुक्ति करें ।

सही व्यक्तियों की नियक्ति करना आपके उद्यम के प्रभावी प्रबंधन में बहुत ही निर्णायक साबित होता ह।ै कार्य  के लिए सर्वाध िक उपयुक्त व्यक्तियों की 

नियक्ति करने के लिए, आपको साक्षात्कार की प्रक्रिया के बारे  में बहुत ही सजग रहना होगा। आपको संभावित उम्मीदवारों से सही प्रश्न पछूने होंगे और 

सावधानी से उनके उत्तरों का मूल्यांकन करना होगा। पषृ्ठभमूि जांच करना हमेशा ही अच्छा साबित होता ह।ै क्रेडि ट जांच करना भी उपयुक्त रहता ह,ै विशेष 

रूप से जिन व्यक्तियों की आप नियक्ति करने जा रहे हैं, वे आपके पसेै का रख रखाव करें गे। प्रत्येक भमूिका, जिसके लिए आप नियक्ति करने जा रहे हैं, 

के लिए एक विस्तृत जॉब विवरण तयैार करें  और सुनिश्चित करें  कि समस्त उम्मीदवारों को जॉब विवरण की स्पष्ट और सही जानकारी ह।ै आपके पास 

कर्मचारी नियम पुस्तिका होनी चाहिए, जिसमें आपको उन सभी उम्मीदों को शामिल करना चाहिए जो आप अपने कर्मचारियों से रखते हैं। इन सभी कार्यों 

से यह सुनिश्चित करने में सहायता मिलेगी कि आपके उद्यम को चलाने के लिए आपने सही लोगों से ही संपर्क  किया ह।ै

चरण 4: अपने कर्मचारियों को अभिप्रेरित करें  और उन्हें भली भांति प्रशिक्षण दें।

आपके उद्यम का केवल तभी प्रभावी रूप से प्रबंधन किया जा सकता ह ैजब कर्मचारी आपके उद्यम के लिए कड़ी मेहनत करने के लिए अभिप्रेरित हों। 

अभिप्रेरित होने के एक भाग के तौर पर, आपके कर्मचारियों को आपके उद्यम के विज़न और मिशन में विश्वास होना चाहिए और वे वास्तव में उनको प्राप्त 

करने की दिशा में प्रयास करने के इच छ्ु क होने चाहिएं। आप अपने कर्मचारियों को सम्मान, बोनस आदि और उपलब्धियों के लिए पुरूस्कार आदि प्रदान 

करके अभिप्रेरित कर सकते हैं। आप उन्हें यह बता कर भी अभिप्रेरित कर सकते हैं कि उनके ही प्रयासों की वजह से कंपनी ने किस प्रकार से सफलता 

हासिल की ह।ै इससे वे गर्व  महससू करें गे और उनके मन में उत्तरदायित्व की भावना विकसित होगी जिससे वे और अधिक अभिप्रेरित होंगे।

अपने कर्मचारियों को अभिप्रेरित करने के अलावा, इन्हें निरन्तर नए अभ्यासों और तकनीकों का प्रशिक्षण दिया जाना चाहिए। याद रखें, कि प्रशिक्षण एक 

बार किया जाने वाला प्रयास नहीं ह।ै यह सतत प्रयास ह ैजिसे निरन्तर किया जाना चाहिए।

चरण 5: अपने ग्राहकों को भली भांति हैंडल करने के लिए अपने कर्मचारियों को प्रशिक्षण दें।

आपके कर्मचारियों को ग्राहक प्रंबधन की कला में पारंगत होना चाहिए। इसका अर्थ ह ैकि वे यह समझने में समर्थ होने चाहिए कि उनके ग्राहक क्या चाहते 

हैं और साथ ही उन्हें यह भी मालमू होना चाहिए कि उनकी ज़रूरतों को किस तरह से परूा किया जाए। वे इन बातों को वास्तविक रूप से समझ सकें , उन्हें 

यह देखना होगा कि आप ग्राहकों के साथ किस प्रकार से प्रभावी रूप से कार्र वाई करते हैं। इसे उदाहरण द्वारा अगुवाई करना कहते हैं। उन्हें यह दिखाएं 

कि आप अपने क्लाइन्ट्स  की बातों को किस प्रकार गंभीरता से सुनते हैं, और उनकी ज़रूरतों को समझने में आप कितने प्रयास करते हैं। आप अपने 

क्लाइन्ट्स  से जो प्रश्न पछूते हैं, उन्हें इन प्रश्नों को समझने दें ताकि वे समझ सकें  कि कौन से प्रश्न उपयुक्त होते हैं।

चरण 6: अपने उद्यम का प्रभावी विपणन (प्रस्तुतीकरण) करें ।

अपने उद्यम के प्रभावी विपणन (प्रस्तुतीकरण) के लिए अपने समस्त कौशल और अपने कर्मचारियों के कौशल का उपयोग करें । यदि आपको लगता ह ैकि 

इस विषय में आपको सहायता की ज़रूरत ह,ै तो आप एक मार्केटि ग एजेन्सी की नियक्ति कर सकते हैं।

अब आपको यह समझ में आ चुका ह ैकि आपके उद्यम को प्रभावी रूप से चलाने के लिए क्या अपेक्षित ह,ै इन बातों को लाग ूकरें  और देखें कि आपके उद्यम 

का प्रबंधन कितना आसान हो जाता ह!ै

•	 अनुभवी बैंकर्स से वित्त पोषण विकल्पों के बारे  में सलाह प्राप्त करें ।

•	 सजग रहें और जितनी आपको आवश्यकता ह,ै उससे अधिक उधार न लें, न ही अपनी आवश्यकता से अधिक लंबी अवधि के लिए उधार लें और इसके 

लिए अपनी सुविधा से परे  उच्च ब्याज दर भी उधार लेने से बचें।

उद्यमशीलता पर विचार करने से पहले स्वय से पछूे  जाने वाले प्रश्न

•	 मैं कारोबार क्यों शुरू कर रहा हंू?

•	 मैं कौन सी समस्या का समाधान करने जा रहा हंू?
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•	क्या  दूसरों ने इस समस्या का समाधान करने का इससे पहले प्रयास किया था? क्या वे सफल रहे थे अथवा विफल?

•	क्या  मेरा कोई मार्गदर्शक1 ह,ै या कोई उद्योग विशेषज्ञ ह ैजिससे मैं सहायता प्राप्त कर सकता हंू?

•	 मेरे  आदर्श ग्राहक2 कौन कौन हैं?

•	 मेरे  प्रतिस्पर्धी3 कौन कौन हैं?

•	 मेरा कारोबार दूसरे  के कारोबार से किस प्रकार से भिन्न ह?ै

•	 मेरे  उत्पाद या सेवा की महत्वपरू्ण  विशेषताएं क्या हैं?

•	क्या  मैंने SWOT4 विश्ले षण किया ह?ै

•	 उस बाज़ार का आकार क्या ह ैजिसमें मेरे  उत्पाद या सेवा को खरीदा जाएगा?

•	 बाज़ार की जांच करने के लिए न्यूनतम व्यव्हार्य  उत्पाद5 को तयैार करने के लिए क्या प्रयास करने होंगे?

•	 मुझे कारोबार की शुरूआत करने के लिए कितने पसैो की ज़रूरत ह?ै

•	क्या  मुझे ऋण की आवश्यकता होगी?

•	 मेरे  उत्पाद और सेवाएं कितनी जल्दी उपलब्ध हो सकें गी?

•	 मैं न लाभ - न हानि6 की स्थिति या लाभ की स्थिति में कब पहंुच जाऊंगा?

•	 मेरे  उद्यम में निवेश करने वाले किस प्रकार से लाभान्वित होंगे?

•	 मुझे अपने व्यवसाय के लिए किस प्रकार के काननूी अवंसरचना7 तयैार करनी होगी?

•	 मुझे कौन-कौन से कर8 देने होते हैं?

•	 मुझे किस प्रकार के बीमा9 की आवश्यकता ह?ै

•	क्या  फीडबकै के लिए मैंने अपने संभावित ग्राहकों से संपर्क  किया ह?ै

10.6.6.1 सुझाव 
•	 इससे पहले कि आप अपना महत्वपरू्ण  समय, पसैा और संसाधन अपने कारोबार में लगाएं, यह बहुत महत्वपरू्ण  ह ैकि आप अपनी कारोबार संबंधी सोच 

का सत्यापन या पुष्टि कर लें।

•	जि तने अधिक प्रश्न आप अपने आप से पछूेंगे, आप उतने ही अपने उद्यम की सफलताओ ंऔर विफलताओ ंकी हैंडलिग करने के लिए तयैार हो पाएंगे।

फुटनोट:

1.	 एक मार्गदर्शक एक विश्वसनीय और अनुभवी व्यक्ति होता ह ैजो आपको प्रशिक्षित करने और आपका मार्गदर्शन करने के लिए तयैार होता ह।ै

2.	ग्रा हक कोई ऐसा व्यक्ति होता ह ैजो माल और/या सेवाओ ंको खरीदता ह।ै

3.	 प्रतिस्पर्धी ऐसे व्यक्ति या कंपनी होती हैं जो ऐसे उत्पाद और/या सेवाओ ंकी बिक्री करते हैं जो आपके उत्पादों और/या सेवाओ ंके समान ह।ै

4.	 SWOT का अर्थ ह ैशक्तियां, कमियां, अवसर और जोखिम। अपनी कंपनी के SWOT विश्ले षण के लिए, आपको अपनी कंपनी की सभी शक्तियों और 

कमियों की सचूी तयैार करनी होगी, अपनी कंपनी के लिए उपलब्ध अवसर, और अपनी कंपनी के समक्ष आने वाले जोखिमों की सचूी बनानी होगी।

5.	 एक न्यूनतम व्यवहार्य  उत्पाद वह उत्पाद ह ैजिसमें न्यूनतम संभव विशेषताएं होती हैं, जिसे ग्राहकों को बेचा जा सकता ह,ै ताकि उस उत्पाद के संबंध 

में ग्राहकों से फीडबकै प्राप्त किया जा सके।

6.	 कोई कंपनी उस समय न लाभ न हानि (ब्रेक इवन) की स्थिति में होती ह,ै जब कंपनी के लाभ उसकी लागत के बराबर होते हैं।

7.	 काननूी अवसंरचना में, एकल स्वामित्व, साझेदारी या सीमित देयता साझेदारी हो सकती ह।ै
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8.	 दो प्रकार के कर होते हैं- प्रत्यक्ष कर जिनका भुगतान व्यक्ति या कंपनी द्वारा किया जाता ह,ै या अप्रत्यक्ष कर, जिन्हें माल और/या सेवाओ ंपर लगाया 

जाता ह।ै

9.	 दो प्रकार के बीमा होते हैं - जीवन बीमा और सामान्य बीमा जीवन बीमा में मानव जीवन को कवर किया जाता ह ैजबकि सामान्य में पशु, माल, कार 

आदि जसैी सम्पत्तियों को कवर किया जाता ह।ै



353352

प्रतिभागी पुस्तिका रोटो आर ट्िस्ट

विक्रय हेतु नहीं - केवल आंतरिक प्रसार के लिए

मीडिया एंड एंटरटनेमेंट कौशल परिषद

पता: फेडरे शन हाउस, तानसेन मार्ग , नई दिल्ली- 110001

ईमेल: mesc@ficci.com 

फोन: 91-11-23738760-70

CIN नम्बर: 00000000

कीमत:

विक्रय हेतु नहीं - 
केवल आंतरिक प्रसार के लिए


